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1 

Welcome to System Help! 

 

Introduction 

This Help is designed to provide you with information about the uses and functionality of the system. You 
can get help with such items as using the system screens and performing various task activities. 

The Help is broken down into sections that match the top menu navigation items. For example, you can 
access information about task overviews and activities related to the following categories: 
 

• The Case Section 
• The Accounting Section 
• The Calendar Section 
• The Courtroom Section 
• The Disposition Section 
• The Judicial Officers Section 
• The Person/Entity Section 
• The Reports Section 
• The Forms Section 
• The Admin Section 
• The Work Queue Section 

 

 

You can search for and access information about the system using the Table of Contents in the left-hand 
pane of this Help or using the search feature. There will be a "Show" link you can click to display the 
Table of Contents if it is hidden. 

Getting Started 

The sections below contain information that may help you navigate within this Help and become more 
familiar with the system components. 
 

• About This Help 
• About System Window Components 
• About Screen Header Components 
• About the Case Header 
• Available Field Types 
• List of Icons 
• Commonly Used Buttons 
• About the Date Selector Window 
• About System Sessions 
• About System Reports 
• About System Work Queues 
• About Keyboard Shortcuts or "Quick Keys" 
• Special Characters Supported 
• Search Feature Overview 
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• Sample Search 
• Search Business Rules 

 

 

Exiting the Help 

Click the Close button ( ) at the top right-hand corner of the window when you want to exit the Help. 
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• About System Sessions 
• About System Reports 
• About System Work Queues 
• About Keyboard Shortcuts or "Quick Keys" 
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• Special Characters Supported 
• Search Feature Overview 

• Sample Search 
• Search Business Rules 

 

 

Exiting the Help 
Click the Close button ( ) at the top right-hand corner of the window when you want to exit the Help. 

 

 

About This Help 

 

Introduction 
The purpose of the Help is to outline the activities that you might need in order to perform case 
management functions in the California courts. The Help text accomplishes this by providing you with the 
steps involved for completing these processes within the system. 

The "core" Help pages support the standard system and do not contain court specific information. Refer 
to the "My Court Information" section below for details on accessing your court specific data. 

Help Page Components 
There are several different components that are available throughout the Help pages. You can use these 
items to quickly and easily understand how the system works. 

Drop-down Images 

Task activities and overview pages contain drop-down images, usually located within a sentence or 
activity step. These are images that are hidden from view when you first open a Help page, but display (or 
expand) when you click the blue formatted text. This blue text will change to an italic style when you point 
at it with your mouse cursor. You may then click the text to display the screen capture image. 

The image will display below the text that you clicked. You can expand and collapse these images as 
many times as you like.  

Click on the blue formatted text in this sentence to view an example of a drop-down image. 
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Hyperlinks 

Most of the Help pages contain hyperlinks. These text items allow you to navigate from page to page 
without having to perform a search to find the page you want to access. Clicking on a link will take you to 
another page within the Help system. 

Help links are formatted in a blue, underlined text. This sentence contains an example of a hyperlink. 

Related Links 

The Help pages contain a "Related Links" section at the bottom of the page. This section lists other help 
topics which may be of interest to you, based on the current Help page you are viewing. 

Landing Pages 
Most screens in the system have a related Help page that gives you a brief description of each screen's 
purpose and main features. They also display screen captures and contain links to the related field 
descriptions.  

 

Field Descriptions 
The Field Descriptions section lists the fields that are available on a specific system screen. It includes 
the field name, a brief description of the field, an indicator as to whether this field is required to complete 
an activity, and an example value that may be entered into the field. Refer to the Available Field Types 
section for details. 

 

Task Overviews 
The Task Overview provides high-level information related to a task or group of tasks. It describes the 
purpose of the task(s) and can include background information, a summary of the system functionality 
related to the tasks, and any items or activities that must be done before performing these tasks. 

Links to Task Activities 

The overview includes a logical grouping of task activities that "belong" to the overview. For example, the 
Maintain Filings Overview contains two task activities related to filings: Add Filings and Update Filings. 

Links to Additional Resources 

There may be additional resources that are related to the overview. These are items that may not be 
discussed within the overview itself, but would still provide you with relevant information about the topic. 
These resources do not include the task activities and screens associated with the overview. For 
example, this section may link to a Help page that lists the types of user/system actions that will affect 
how the system works. 

 

Task Activities 
The Task Activity pages list steps that you would follow to perform a specific task. Refer to the List of 
Icons and Commonly Used Buttons sections for details on other Help components that may be used 
within the Task Activities. 
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My Court Information 

This is a hyperlink that will take you to a page that outlines information specific to your court related to a 
given task activity. It may also contain other court-specific materials, including items such as Training 
Manuals, Standard Operating Procedures, and Work Instructions. 

Step Conventions and Formatted Text 

The Help pages use certain text formatting conventions to alert you to key information. Review the 
following examples to understand the formatting difference: 
 

• Example 1 - Bolded Text: The Filing Date field defaults to the current date. 
Bolded text represents a field or screen name. These text items usually indicate that a field or 
screen requires an action to be performed or item to be selected.  

 

• Example 2 - Bracketed Bolded Text: Click the [Search] button. 
Bracketed, bolded text indicates that you are to use your mouse cursor to click on the specified 
item. The above example is for a system button, but this convention can also be used for menu 
and navigation items and tabs. 

 

 

The steps also apply a standard convention to help you access the screen that you need in order to 
perform a certain task. This convention is primarily used to navigate through the top menu tabs and the 
left navigation pane. The following examples explain these standards: 
 

• Example: Select [Case] > [Initiate Case]. 
This example represents a menu path that you must follow. The first bolded, bracketed item is a 
top menu item. Clicking on this top menu will refresh the screen and its associated left navigation 
items. You must then click on the necessary left navigation item, as indicated by the second 
bolded, bracketed item. This will take you to the screen needed to start performing your task. 

 

• Example: Select [Case] > [Records Management] > [Exhibits]. 
This example is similar to the one above, except that there is a third navigation item. In this select 
statement, the third item is a sub-item of the selected left navigation item, as seen in the left 
navigation pane. 

 

• Example: Click the [Case History] left navigation item. 
This example assumes that you are already within the context of a top menu item. This type of 
step is most commonly used when you are performing an activity within the context of a case. 
The left navigation pane already displays the available choices, which means that you just need 
to click on the item indicated in the step. 

Notes 

Many Help pages include notes or tips to provide you with helpful information related to a particular step 
or overall task. This information can clarify a step, provide additional information, or alert you to potential 
problems related to data entry or missteps in a process. Notes are usually indicated by a "note" icon. 
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Business Rules 
The Business Rules sections list all of the business rules associated with a specific task or group of tasks. 
These rules are descriptions of how your interaction with the system or the system's behavior can impact 
other system processes.  

 

Forms, Notices, and Reports 
The Forms, Notices, and Reports section provides you with a list of outputs available at the completion of 
a given task. These lists only include forms, notices and reports that are generated after you finish a task. 

 

 

Related Links 

Welcome to System Help 

 

About System Window Components 

 

Introduction 
The screens in the system follow the same overall layout and navigation. As a result, a set of standard 
window components is available on most of the screens, which allows you to easily recognize and use 
the system. 

Basic Window Components 
The following image identifies many of the standard window components. 
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System Title/Logo 

The official title/logo is a link that takes you to the system's welcome screen. Refer to the About Screen 
Header Components section for details. 

Top Menu 

These menu tabs allow you to navigate to the first level of a screen category. For example, clicking the 
Case menu tab will display the Case Search screen. 

Username 

The system will display your username in this part of the screen throughout the entire session. 

Left Navigation 

This part of the window contains a list of sub-menu items related to a top menu category. Some of these 
drill down even further, as seen in the above example (Records Management displays Physical Case 
File, Exhibits, and Pull Lists). All of these left navigation items belong to their parent menu tab. 

System Help Link 

This link opens the Help designed to support the system. A new window will open at the top right-hand 
part of the screen. Refer to the About Screen Header Components section for details. 

Contact Us Link 

This link navigates you to the Contact Us screen, where you can view contact information related to the 
system. Refer to the About Screen Header Components section for details. 

Log Out Link 

This link allows you to log out of the system and end your user session. The system will display a 
message on the screen indicating that you have successfully logged out. If you choose to exit the system 
while on a data input screen, the system will make you decide whether to continue with the logout 
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process or return to the screen to save your data. Refer to the About Screen Header Components section 
for details. 

Quick Case Search 

This component allows you to quickly open a specific case based on its case number. Refer to the About 
Quick Case Search section for details on this feature. 

Current Date 

The system will display the current date in a read-only format. 

System-Level Help Link 

This is a context-sensitive Help link that opens a page describing the system screen on which you are 
currently viewing. It is designed to give you information about what you are looking at, as well as allow 
you to search for help on activities you can perform onthat screen. 

 

 

Related Links 

Welcome to System Help 

 

About Screen Header Components 

 

Introduction 
This section covers the following screen header components: 

• Standard Header Components 
• About Case Context 
• About Quick Case Search 
• About Current Work Queue 
• About Case Task Work Queue 

 

Standard Header Components 
The following describes the standard header components that you will see on the system screens. 

System Title/Logo 

The official title/logo designed for the system. This item is a link, so clicking this header image will take 
you to the system's welcome screen.  

System Help Link 

This link opens the Welcome page of the Help system. It will display in a new window at the top right-
hand part of the screen. From here, you can navigate to the Help topic you are interested in viewing. 



Printed Documentation 

10 

Contact Us Link 

Clicking on this link opens the Contact Us screen, where you can view information on contacting 
someone to help you with the system problems you may be experiencing. 

Log Out Link 

This link allows you to log out of the system and end your user session. If you exit the system while on a 
data input screen, the system will display the following warning message: 
 

 
 

 

You can choose the "Cancel" option to return to the screen to save your data. Or you can choose the 
"OK" option to exit the system without saving. Once you exit the system, a confirmation logout screen will 
display indicating that you have successfully logged out.  

 

About Case Context 
Case Context allows you to keep a case open until you: 
 

• Close out of the case 
• Open a new case 
• Log out of the system 

 

 

This feature allows you to keep a case open while you work on other tasks. For example, you can 
schedule an event and/or record a payment while still having a case session open. 

A "Current Case" component will display at the top of the screen header once you have opened a case. It 
opens and closes from a green arrow button and contains a drop-down menu and an "exit case" button. 
However, these components only display after you expand the tab. 

The drop-down menu contains a list of all the screens that are considered as "within the context of a 
case". These are the same items that are listed in the left navigation pane under the "Case" section. This 
feature gives you the "in-a-case" function links that are available to you within any screen in the system. 

Viewing an Example 

The following images are examples of the Case Context shortcut feature and how it can be used. 
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1. This image shows the Case Context tab displayed at the top of the screen.  
 

 
 

 

2. This next image is an example of how the tab looks when you click on the green arrow button. It 
will expand to display a drop-down field and an "Exit Case" button. 
 

 
 

 

3. This last image shows the contents of the drop-down field. Selecting an item from this list will 
navigate you to the appropriate screen. 
 

 
 

About Quick Case Search 
The Quick Case Search tool provides a direct way to open a specific case based on its case number. 
This feature allows you to easily access a case without having to perform a standard case search. 

The Quick Case Search fields are located in the top right-hand corner of the screen header. It contains 
three case number text boxes, one legacy number text box, and a select button. 

Viewing an Example 

The following image is an example of the Quick Case Search tool. 
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Entering Case Numbers 

The left-most case number text box is defaulted to your 2-digit local court code. This is a display-only 
value that you cannot change. 

The next case number text box contains a 4-digit year. While this field defaults to the current year, you 
can change it so it applies to the case for which you are searching.  

The third text box is available for the 8-digit numeric portion of the case number. This field will assume 
that there are zeros in front of any entered number that is fewer than eight digits. In other words, "leading" 
zeros will be automatically included as part of the case number if you do not enter them. For example, if 
you enter a case number of "243" into the text box field, the system will read this entered number as 
"00000243". 

The fourth and final text box is only for Legacy case numbers. Any case that was not converted or 
initiated in this system will have a legacy case number. This field will clear the "Legacy #" text label once 
you place (click) the mouse cursor in the box. 

Selecting the Case 

After you enter the case number in the appropriate Quick Case Search fields and click the arrow button, 
the system will attempt to retrieve the entered case. 

If a case match is found, then the system will navigate you to the "Case Summary" screen for that case. If 
the system does not find a match, then it takes you to the "Case Search" screen and displays a "No 
Match Found" alert message. You will then have to search for the case using the available search 
parameters. 

 

About Current Work Queue 
The system uses work queues to help you complete and monitor system events and to-do items. Work 
queues provide a mechanism for accessing tasks that require your attention. Refer to the About System 
Work Queues section for details on understanding work queues. 

The Current Work Queue feature allows you to navigate directly back to a work queue in which you have 
been performing tasks. A "Current WQ" icon will display at the top of the screen header when you begin a 
set of tasks from a particular work queue. You can then access this work queue at any point during your 
system session. 

Viewing an Example 

The following image is an example of the Current Work Queue feature. 
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Changing the Work Queue Setting 

If you want to change this current work queue, then you must navigate to the default Work Queue menu 
tab and select a different work queue. The icon will then point to this new work queue instead. 

The "Current WQ" icon only displays when you begin a set of tasks, and it turns off or disappears from the 
screen when your system session ends. 

 

About Case Task Work Queue 
The Case Task Work Queue feature allows you to view and access the work queue tasks that are related 
to the case you are currently viewing. This feature is only available when you are in the context of a case. 
Refer to the About Case Context part of this topic for details. 

Viewing an Example 

The image below is an example of the Case Task Work Queue feature. It consists of an orange tab that 
displays above the left navigation pane. It also displays the number of open tasks related to that case.  
 

 
 

 

 

Clicking on the toggle button will display the three most recent work queue tasks, based on the date the 
task was sent to the work queue.  
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Accessing the Work Queue Tasks 

Clicking on either the tab itself or on the "More" button will take you to the Case Task Work Queue 
screen. Refer to the Case Task Work Queue Screen section for details about this screen. 

 

 

Related Links 

Welcome to System Help 

 

About the Case Header 

 

Introduction 
The case header displays at the top of the screen when you are performing a task within the context of a 
case. As a result, you will see this header on most of the case-related screens.  

Case Header Components 
The case header contains read-only fields that allow you to quickly identify key characteristics about the 
case. The following image is an example of a case header. 
 

 
 

 

Case Header Icons 

The case header may display a variety of different icons next to the Case Number field. These icons 
relate to the case that you are viewing and are meant to alert you to a special attribute of the case. Refer 
to the List of Icons section for details on the types of icons that you may see in the header. 

Case Header Field Descriptions 

The following table contains brief descriptions of the data fields seen in the case header. It also includes 
example values and a Yes/No indicator that lets you know if the field requires data to be entered before 
information can be saved. 
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Field Name Description Example 

Case Number A unique identification code that is assigned to a case. This is a 
read-only value. 

XX-YYYY-12345678-
CC-CT-LLL 

or 30 characters max. 

Filing Date The date when the initial filing document was filed with the 
court. This is a read-only value. 

01/15/2005 

Case Title A brief but formal title that describes the case. The title usually 
identifies the two parties in conflict. This is a read-only value. 

Johnson vs. Smith 

Case Status The current status of the case in the system. This is a read-only 
value. 

Open 

Case Category The main category of case classification used to identify a case. 
This is a read-only value. 

Probate 

Location The court location that has jurisdiction over the case. This is a 
read-only value. 

North Court 

Case Type The second level of case classification used to identify a case. 
This is a read-only value. 

Trust Proceedings 

Judicial Officer The name of the Judicial Officer that is currently assigned to the 
case. This is a read-only value. 

Judge Smith 

Case Age The age of the case. This age is based on when the initial filing 
document was submitted with the court and is counted in 
calendar days. This is a read-only value. 

120 

Department The department that will hear the case. This is a read-only 
value. 

101 

Next Event Type The name of the next expected event that is scheduled for the 
case. This is a read-only value. 

Case Management 
Conference 

Next Event Date The date when the next expected event scheduled for the case 
occurs. This is a read-only value. 

10/10/2005 

 

 

Related Links 

Welcome to System Help 

 

Available Field Types 

 

Introduction 
The input screens used in the system for saving and maintaining court data contain many different fields 
and components. Each field is designed to capture specific data in the system. 

While this section does not define each of these items, it does provide you with examples of key field 
features. 

Field Type Examples 
The following image provides examples of the field types used in the system. 
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Required Fields 

The system identifies a required field by placing a red asterisk (*) to its left. You must enter/select the 
appropriate data value into a field in order to save or continue with a process. 

Primary Search Fields 

Fields that have a red caret (^) before their names are primary search fields. These types of fields only 
display on search screens. Performing a search requires that you enter/select at least one primary search 
field or two secondary search fields. 

 

 

Related Links 

Welcome to System Help 
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My Court Information 

 

List of Icons 

 

Introduction 
The system uses a variety of icons on its screens. These icons may be within a case header, a search 
results list, or next to an open entry field, to name a few.  

The purpose of these icons is to provide you with a quick way of accessing related information or 
recognizing certain attributes or features. Many icons only appear on a screen to indicate that a condition 
exists and do not specifically identify who or what is involved. For these icons, you must investigate 
further to find the related details. 

Icon List and Descriptions 
The following table lists the available system icons and provides a brief description of how they may be 
used. 
 

 

 

Icon Title and Description 
 

 
Alert! 
This icon alerts you to a potential issue that is determined by the system. It is usually followed by 
red text that explains the warning message, but it could also display next to a field that is causing 
the issue/error. This alert usually displays when you are taking an action that the system does not 
recommend.  

 

 
Amended 
This icon indicates that a Case History entry or judgment has been amended on a case. 

 

 

Appeals 
This icon indicates that a case has been classified as an Appellate case. 

 

 
Archived 
This icon indicates that the case has been archived. 

 

 

Case Notes 
This icon indicates that there at least one case note available on the case. 

 

 

Check 
The system uses this icon to indicate a selection, usually in a table or column. For example, this 
check may indicate that an entry is confidential. The context of this icon depends on the screen on 
which it is being used. 

 

 

<Consolidated>, <Coordinated>, or <Related> 
This icon indicates that the selected case has been associated with one or more other cases. The 
type of association is indicated in the ALT tag (or text you see when you point to an icon). 

 

 

<Complex Case>, <Exceptional Case>, <Class Action> 
This icon indicates that a case is an exceptional case. The ALT tag (or text you see when you point 
to an icon) will display the one, two, or three attribute titles belonging to the case. 

 

Court Appointed/Appointable 
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This icon indicates that the court has specifically appointed a participant or court resource to the 
case. This is an attribute of the appointed person/entity. 

 

 

Discovery Referee 
This icon indicates that a discovery referee has been assigned to the case. 

 

 

Disqualified 
This icon indicates that a Judicial Officer has been disqualified for assignment to a case by the 
request of a case participant. It displays next to a Judicial Officer profile instance, within the context 
of a case. 

 

 

Document Management System (DMS) 
This icon is a link to either an image from the Document Management System or a PDF generated 
by the system. 

 

 

Document Not Available 
This icon indicates that there is no DMS image available for the selected document. 

 

 

Document Sealed 
This icon indicates that a DMS image has a security level greater than 1. 

 

 

Expired 
This icon indicates that a selected clock has a status of “expired” on a case. This categorizes the 
clock as “inactive”. 

 

 

Entered in Error 
This icon indicates that a case history/ROA entry was entered in error. It displays below an entry. 

 

 

E-file 
This icon indicates that the case was initiated through an e-filing. 

 

 

Fees Not Paid 
This icon indicates that there are fees due on the case. This may be the initial filing fee or any other 
subsequent fee required by the court. It displays in the case header. 

 

 

Fee Waiver 
This icon indicates that a person/entity has applied for an application for waiver of court fees and 
costs. This person/entity does not have to pay a portion of the required fees. 

 

 

First Appearance Fee Paid 
This icon indicates that a person/entity has paid the first appearance fee on a new case. 

 

 

<Is Confined> or <Confinement> 
This icon indicates that a person/entity is currently confined, such as in jail or prison. 

 

 

Judicial Officer Notes 
This icon indicates that the case has Judicial Officer notes available. 

 

 

Lead Attorney/Counsel 
This icon indicates that the selected attorney is a case participant’s lead attorney. It displays if there 
is more than one attorney assigned to the participant. 

 

 

Lead Person 
This icon indicates that the selected person/entity has been selected as the lead record of a 
merged group of participants (person/entities). 

 

 

Milestone Met 
This icon indicates that a milestone on a case has been met within the expected time frame. 

 

Milestone Met Late 
This icon indicates that a milestone on a case has been met later than expected.  
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Milestone Not Met 
This icon indicates that a milestone on a case has not been met. 

 

 

Missing Case File 
This icon indicates that a case file volume has been classified as “missing”. It displays in the case 
header. 

 

 

NSF 
This icon indicates that there was at least one NSF payment made on the case at some point 
during the case. 

 

 

<Other Case Number> 
This icon indicates that the selected participants or case history entries have been copied from 
another case as part of a case association (consolidation, coordination or relation). 

 

 

Pause 
This icon indicates that a selected clock has a status of “paused” on a case. This categorizes the 
clock as “active”. 

 

 

Recall Warrant 
This icon indicates that the selected warrant has been recalled. 

 

 

Recusal 
This icon indicates that a Judicial Officer has disqualified his/herself for assignment to a case. This 
recusal indicator displays next to the Judicial Officer profile instance, within the context of a case. 

 

 

Security Level 
This icon indicates the security level of the case, entry or DMS image. It will display if the security 
level is set for greater than “1”, which means that the item has security associated with it. 

 

 

Security Level - <X> 
This icon indicates the security level of the case, entry or DMS image. It will display if the security 
level is set for greater than “1”, which means that the item has security associated with it. 

 

 

Security Risk 
This icon indicates that the person/entity has been labeled as a security risk by the court. 

 

 

Something has Changed 
This icon indicates that a Case History/ROA entry has had some attribute changed. 

 

 

Special Needs 
This icon indicates that a person/entity has special needs that must be considered by the court.  

 

 

Start 
This icon indicates that a selected clock has a status of “started” on a case. This categorizes the 
clock as “active”. 

 

 

Stop 
This icon indicates that a selected clock has a status of “stopped” on a case. This categorizes the 
clock as “inactive”. 

 

 

Strike 
This icon indicates that a case history/ROA entry was stricken from the case. It displays below an 
entry that has a line striking through the text. 

 

 

Subpoenaed Record 
This icon indicates that the case has (or is associated with) one or more subpoenaed records. 

 

 

Temporary 
This icon indicates that the selected [existing] warrant is temporarily issued. 
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Related Links 

Welcome to System Help 

 

My Court Information 

 

Commonly Used Buttons 

 

Introduction 
While the system uses different button features on its screens, many screens share the same buttons. 
You will use these buttons to perform various court functions or tasks in the system. 

This section is designed to provide you with basic descriptions of some of the most commonly-used 
buttons in the system. 

List of Common Buttons 
The following table lists commonly-used buttons and their related descriptions. 
 

 

 

Button Title and Description 
 

 

Cancel Button 
This button provides a way to navigate “back” to the screen from which you came. 
This cancel feature follows a set of defined system rules: 

• Screens containing multiple tabs have different tab “views”. Canceling out 
of a tab view takes you to the previous screen, not the previous tab. 

• Canceling out of a screen does not save any newly entered data within 
the screen fields. This means that you must either choose to save your 
changes or cancel without saving. 

• The Cancel button may not display on the following types of screens: 

• Confirmation pages 

• The first page of a wizard (step) process 

• Any page that you access directly from the top menu or a left 
navigation pane 

• Screens that have multiple entry points may have Cancel buttons that do 
not return you to an originating screen due to the business process 
involved. The Cancel button may instead redirect you to the default back 
screen, which is usually a type of search screen. 
Example: After you add a filing, you are redirected to the Record Issuance 
Judgment screen. The Cancel button on this screen will actually navigate 
you to the Record Issuance Search screen, and not the Add Filing screen. 

 

Date Picker 
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 This button allows you to easily select a past, present, or future date for a date field. 
Clicking the button displays a pop-up window containing a month-view calendar, 
which defaults to the current date. Clicking a specific day (number) on the calendar 
closes the pop-up window and enters the selected date in the field. Refer to the 
About the Date Selector Window section for details on using the calendar 
picker. 

 

 

Filter Button 
This button narrows the list of results originally retrieved by a pre-determined query 
for that screen. The filter criteria that you enter/select acts as a type of search by 
limiting the list of available entries or records in order to display only a subset of 
those entries that were originally retrieved. 
This component is optional for most screens. It provides a helpful way of quickly 
narrowing a long list to find a specific record or entry. 

 

 
Additional Information Icon (+) 
This icon displays next to an item to indicate that it has other associated data. When 
you place your mouse-cursor over this icon, pop-up text may display. 

 

 

Reset Button 
This button sets the data within the form that you have manually entered or selected 
on a screen to their default values as initially rendered. As a result, some of these 
fields may be empty (or "deleted") if no default value has been defined. 

 

 

Save Button 
This button saves all entered or selected data to the system database. Depending 
on the configuration of the screen, this button may also navigate you to the invoking 
screen, which may display a confirmation message. 

 

 

Save As Button 
This button allows you to copy an existing component (entry, record, etc.) in order to 
make a new component. Clicking the “Save As” displays the component in an 
"update" or "edit” mode. You must make the necessary changes to this component 
in order to make it unique in the system.  

 

 

Search Button 
This button causes the system to display a list of results that match the entered 
search criteria. Refer to the Search Feature Overview for details on 
performing searches in the system. 

 

 

Select Button 
This button causes the system to take the selected component(s) and apply the 
necessary screen functionality to that component. This Select feature may behave 
differently, depending on the context in which it is used. For example: 

• It can open a component to display its details in read-only, add, or update 
mode. 

• It can take the selected entry and populate a different field or screen with 
that data. 

You must have chosen at least one entry from the displayed list in order for the 
system to access/open the selected component. 

 

   

Toggle Button 
This arrow button “toggles” (displays/hides) a set of fields on the screen. This 
component changes the viewing capability for a group of fields that may not be used 
as often as those on the rest of the screen. 
The fields are hidden from view when the tip of the triangle is pointing down. 
Clicking on the button displays these fields and changes the direction of the triangle 
to point upwards. Any data entered into these fields will be saved even if you hide 
them from view again. 

 

 

Quick Case Search Button 
This arrow button allows you to perform a quick case search in the system. 
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Related Links 

Welcome to System Help 

 

About the Date Selector Window 

 

Introduction 
The date selector window is available on screens where there is a date field. This option allows you to 
quickly select a past, present, or future date. 

Date Selector Window Features 
When you click on a date picker button (  ), a pop-up window containing a month-view calendar will 
display. The image below is an example of a date selector pop-up window. 

 

 

 

This window displays the current date by default. If a date has already been selected (there is a date 
already listed in the date field), then the Date Selector will open to that date with the specified day 
formatted instead of the current date. 

Selecting Months/Years 

The top of the window displays a title containing the month and year for this calendar. The "Y" arrow 
buttons allow you to choose a past or future year. The "M" arrow buttons allow you to choose a past or 
future month. When you click on any of these buttons, the window will update the month/year title as 
appropriate. 

Selecting a Date 

The current day is formatted as red, bold text. Clicking on a day date will select the highlighted date and 
close the date selector window. The selected date will then display in the appropriate date field. 



Getting Started 

23 

Otherwise, you can click the "X" button in the top right-hand corner of the window to close the window 
without selecting a date. 

 

 

Related Links 

Welcome to System Help 

 

About System Sessions 

 

Introduction 
A session is opened when you log into the system and closes when you exit or log out of the system.  

The following bullet points define the rules involved with opening, using, and maintaining system 
sessions. 
 

• Using the keyboard keystroke "Control+N" to open a new window using the same session will 
have unpredictable results in the case context. This is NOT recommended. 

 The "Control+N" shortcut is the same as following the menu path within the browser 
window. Do not use these features to control your sessions. 

 
 

 

 

• The system will allow you to open a new browser and re-log in with the same username. This will 
create two separate sessions (with two separate case contexts), so you can work on two different 
cases at the same time. 

 You can open a new browser window by using any of the following three processes: 
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o Click the  button located on your task bar. 

o Double-click the  button located on your desktop. 
o Follow the path: Start (button) > Programs > Internet Explorer. 

 

 

• If you and another user are requesting to edit the same information (or the same version of the 
data from the system database), then whomever first saves the changes to the database will 
have these changes reflected. The other person will receive a error message that says 
"Concurrency Error - The data you are trying to update has changed, please retrieve the latest 
data and try again." 

 

 

Related Links 

Welcome to System Help 

 

About System Reports 

 

Introduction 
A report is a compiled list of information pertaining to a specific function. 

Reports In The System 
The system provides two ways for you to generate/view/print reports: 
 

• Within a business process – In-process reports are reports that are generated, viewed, and 
printed inside of a business process.  At this time, the system contains only a handful of in-
process reports. 

 

• Outside of a business process – Out-of-process reports are reports that are generated, viewed, 
and printed outside of a system process.  At this time, the system contains about 60 out-of-
process reports. 

Custom Reports 
The system does not provide functionality to create, generate, view, or print custom reports. However, 
you can create compatible custom reports using Crystal Enterprise™. Refer to the Technical Architecture 
Design document for more information. 

 

 

Related Links 

Welcome to System Help 
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Manage Out-of-Process Reports Overview 

 

About System Work Queues 

 

Introduction 
A work queue is simply a group of identical tasks, for different cases, that require completion.  

For example, all tasks in the "Update Case Title" work queue require an identical action—changing of a 
case title. However, the cases requiring a title change are different. 

Purpose 
The purpose of a work queue is to help complete a "process" in a timely manner.  

For example, if a process requires the completion of four tasks, then it may have three work queues (A, B, 
and C) supporting it. The full "process" would be as follows:  
 

• After the initiation task: 
 

• Work queue A would have one task, the first task required after the initiation task.  
• The other two work queues (B and C) would be empty. 

 

 

• After completion of the task in work queue A: 
 

• Work queues A and C would be empty. 
• Work queue B would have one task, the second task required after the initiation task. 

 

 

• After completion of the task in work queue B: 
 

• Work queues A and B would be empty. 
• Work queue C would have one task, the third task required after the initiation task. 

 

 

• After the completion of the task in work queue C: 
 

• The process is complete. 
• Work queues A, B, and C would be empty of any tasks related to the recently completed 

process. 

Court-Specific Processes 
Since each court has a number of tasks that do not easily conform to a standardized process flow, work 
queue set up cannot be completely automated in the system. Even though the system provides 
functionality to set up work queues, the underlying business processes that causes tasks to end up in 
certain work queues is the responsibility of the court to define and the local administrator to set up. 
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Work Queue "Types" 
Each work queue ties to only one type of unit of work (UOW): 

• Bail Bonds 
• Case 
• Event 
• Fee 
• Filings 
• E-filings 
• Forms 
• Participant 
• Payment 

 

 

The work queue description provides users of the work queue with the information they require to 
complete the work queue tasks. For example, if a "case" work queue has a description of "Update Case 
Title," the users assigned to that work queue know that they will be directed to the screen that enables 
them to change the title of case. 

DMS Documents work queue 

Although the DMS Documents work queue looks and operates like any other work queue, it is a "fixed" 
work queue designed to support linking of stranded documents in the document management system to 
case filings or exhibits. The term "fixed" is used because the DMS Documents work queue cannot be 
created/updated/deleted using the functionality designed to create/update/delete work queues. 

 

 

Related Links 

Welcome to System Help 

Configure Work Queues Overview 

Complete Work Queue Tasks Overview 

 

My Court Information 

 

About Keyboard Shortcuts or "Quick Keys" 

 

Introduction 
The system has keyboard shortcut features or "quick keys" available for you to quickly navigate to a 
specific screen.  
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Top Menu Shortcuts 
The top menu uses quick keys that include the "Alt" key plus a letter for accessing the selected menu. 
You must then press the Enter key on the keyboard to complete the shortcut command. You can 
recognize the appropriate shortcut command by the underlined letter of a top menu navigation item. The 
following table provides you with the available top menu navigation shortcuts. 
 

 

 

Menu Menu Name Shortcut Command 

 
Case Alt + C, then press Enter 

 
Accounting Alt + A, then press Enter 

 
Calendar Alt + D, then press Enter 

 
Courtroom Alt + U, then press Enter 

 
Disposition Alt + S, then press Enter 

 
Judicial Officers Alt + J, then press Enter 

 
Person/Entity Alt + P, then press Enter 

 
Reports Alt + R, then press Enter 

 
Forms Alt + F, then press Enter 

 
Admin Alt + M, then press Enter 

 
Work Queue Alt + Q, then press Enter 

 

Tab Item Shortcuts 
Tab items within screens are counted from left to right. As a result, you can use the "Alt" key plus a "1", 
"2", etc. depending on the tab you want to access. For example, in the following image you would use the 
"Alt"+"1" (plus Enter key) to open the General Information tab, an "Alt"+"2" (plus Enter key) to open the 
Associations tab, an "Alt"+"3" (plus Enter key) to open the Position Information tab, and an "Alt"+"4" (plus 
Enter key) to open the Additional Information tab. 
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Button Shortcuts 
Dark blue buttons on the screen use the keyboard shortcut of "Alt"+"V", and then you must press the 
Enter key. In the above screen capture, this type of shortcut would apply to the "Save" button. 

However, white buttons on the screen, such as the "Cancel" button, use the shortcut keystroke of 
"Alt"+"X" and then the Enter key. 

 

Field Navigation Shortcuts 
The system uses standard Windows keystrokes to move between fields on a screen. This means that you 
can press the Tab key on your keyboard to navigate from one field to another, in a left-to-right direction. 

You can also use the keyboard shortcut "Shift"+"Tab" to move between fields in a right-to-left direction. 

 

 

Related Links 

Welcome to System Help 

 

My Court Information 

 

Special Characters Supported 

 

Introduction 
The following tables identify the special characters supported by the system in text entry boxes.  
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Editing Characters 
 

 

 

Character Description 

¶ Paragraph Sign 

 

Punctuation Characters 
 

 

 

Character Description 

´ Acute Accent 

§ Section Sign 

" Double Left Quote 

• Round Solid Bullet 

' Right Quote 

 

Law Characters 
 

 

 

Character Description 

™ Trademark 

® Registered Mark 

© Copyright Symbol 

 

Math Characters 
 

 

 

Character Description 

× Multiplication Sign 

÷ Division Sign 

¼ One Quarter 

½ One Half 

¾ Three Quarter 

¢ Cent 
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$ Dollar 

 

Letter Characters 
 

 

 

Character Description 

À Capital A, Grave 

Á Capital A, Acute 

Â Capital A, Circumflex 

Ã Capital A, Tilde 

Ä Capital A, Umlaut 

Å Capital A, Ring 

Æ capital ae  

Ç Capital C, Cedilla 

È Capital E, Grave 

É Capital E, Acute 

Ê Capital E, Circumflex 

Ë Capital E, Umlaut 

Ì Capital I, Grave 

Í Capital I, Acute 

Î Capital I, Circumflex 

Ï Capital I, Umlaut 

Ð Capital Eth, Icelandic 

Ñ Capital N, Tilde 

Ò Capital O, Grave 

Ó Capital O, Acute 

Ô Capital O, Circumflex 

Õ Capital O, Tilde 

Ö Capital O, Umlaut 

Ø Capital O, Slash 

Ù Capital U, Grave 

Ú Capital U, Acute 

Û Capital U, Circumflex 

Ü Capital U, Umlaut 

Ý Capital Y, Acute 

Þ Capital Thorn, Icelandic 

ß Small Sharp S 
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à Small A, Grave 

á Small A, Acute 

â Small A, Circumflex 

ã Small A, Tilde 

ä Small A, Umlaut 

å Small A, Ring 

æ Small ae 

ç Small C, Cedilla 

è Small E, Grave 

é Small E, Acute 

ê Small E, Circumflex 

ë Small E, Umlaut 

ì Small I, Grave 

í Small I, Acute 

î Small I, Circumflex 

ï Small I, Umlaut 

ð Small Eth, Icelandic 

ñ Small N, Tilde 

ò Small O, Grave 

ó Small O, Acute 

ô Small O, Circumflex 

õ Small O, Tilde 

ö Small O, Umlaut 

ø Small O, Slash 

ù Small U, Grave 

ú Small U, Acute 

û Small U, Circumflex 

ü Small U, Umlaut 

ý Small Y, Acute 

þ Small Thorn, Icelandic 

ÿ Small Y, Umlaut 

 

 

Related Links 

Welcome to System Help 
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Search Feature Overview 

 

Introduction 
When performing a system task, you will often begin on a page that allows you to search for data needed 
to perform the task. 

This section provides you with information and tips about how you can quickly search for and access the 
data that you need. 

Example 

Search screens share a similar format and layout throughout the system. However, the fields on each 
screen will be different, depending on the type of search the screen is designed for. 

The following image is an example of the Person/Entity Search screen before a search is performed.  
 

 
    

 

Advanced Search Option 
When you access a "search" page, you usually see the most commonly-used search fields near the top of 
the screen. However, if you click the Advanced Search toggle button, the screen will refresh and display 
additional search fields. 

The following image shows examples of advanced search fields available on the Person/Entity Search 
screen. 
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Performing a Search 
When you perform a search, you are requesting to view records that are stored in the system. The system 
will only retrieve those records that match the search criteria that you provide. This means that the data 
entered in search fields controls the number of records that the system will list in the results. The more 
search fields that you use, the more control you have over the records returned.  

For example, if you search for a person/entity named "John Smith", you may get several "John Smith" 
profile records returned in the results list.  However, if you search for "John Mark Smith", fewer records 
will be returned and you will have a greater likelihood of finding the match you need. 

Primary and Secondary Search Fields and Search Constraints 

Since the system contains thousands of records, it has been designed to prevent you from accidentally 
requesting all records when performing a search. 

Fields that have a red caret (^) before their names are primary search fields. These search criteria can be 
used alone or with other fields when performing a search. For example, a Case Number is a primary 
search field that will return only an exact match. 

All other fields are secondary fields. A secondary field requires at least one other secondary field to be 
populated in order for the search to function. 

Required Fields 

Fields that have a red asterisk (*) are required fields. The system will not perform a search unless you 
enter appropriate values in all of the required search fields. 

Returned Records 

When you perform a search, the system will return no more than 100 matching records, or 50 records per 
screen. This is the default display setting, which is configured per screen. If you cannot find the records 
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that you are searching for, try using more search fields in order to limit the number of records returned to 
you. 

Sort Order 

The order in which records are returned as part of the search results is built-in to the system's dynamic 
search feature. In general, the default sort order is ascending based on the left-most column. However, 
based on screen functionality, the default sort order may also be reverse chronological order for dates. 
Some screens support other ascending/descending sort orders based on certain column headings. 
Clicking on one of these headings will re-sort the results in that column in an ascending order. 

Entering Data - Exact Matches, Case Sensitivity, Drop-downs, and Dates 
The system uses a non-case sensitive search to find records matching the search criteria that you 
entered. These are exact matches. List boxes do not allow you to enter data. As its name suggests, you 
must select from a list of provided values. You can enter dates using the MM/DD/YYYY format, or you 
can click the Date Picker icon to view and select dates from a pop-up calendar. Refer to the Commonly 
Used Buttons and About the Date Selector Window sections for details on selecting and entering dates. 

Entering Data - Special Search Options 
If you have difficultly finding a match, try using one of the following search options: 

• Asterisk Wildcards 
• Question Mark Wildcards 
• "Sounds Like" Feature 

 

 

Asterisk* Wildcards 

Asterisk wildcards allow you to find records that have the same beginning letters/numbers, the same 
ending letters/numbers, or a run of the same letters/numbers in the middle of a word. If you do not use a 
wildcard in a word search, then the system will only return records that are an exact match. Refer to the 
following examples: 
 

• Entering Sm* in the Last Name data field returns all last names beginning with “Sm.” 
• Entering *anders in the Last Name data field returns all last names ending with “anders,” such as 

Flanders, Sanders, etc. 
• Entering J*son in the Last Name data field returns all last names beginning with “J” and ending 

with “son,” such as Johnson, Johanson, Jefferson, etc.  
 

 

When using asterisk wildcards, you must enter at least two letter/number combinations, such as “Sm,” 
“St,” etc. An entry of “S*” would not return any records. In addition, you cannot use asterisk wildcards if 
the information you are searching for requires you to use something other than a letter or a number in 
your search. An entry of “S+” would not return any records.  

Wildcard searches work only on fields that are designated for: 
 

• First Name 
• Middle Name 
• Last Name 
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• Entity Name 
• Organization Name 

 

 

Question Mark Wildcards 

Question Mark wild cards are similar to asterisk wildcards except that they represent a single 
letter/number instead of a run of letters/numbers. For example, entering "Sm?th" in the Last Name data 
field returns all last names that begin with “Sm,” end with “th," and have a single letter/number in 
between, such as “Smith" or "Smyth," etc.  

If you use an asterisk wildcard instead of a question mark wildcard, you will also get records that have 
more than one letter/number in the middle, such as “Smeath.” 

"Sounds Like" Feature 

The “sounds like” feature allows you to find records based upon how a name sounds. For example, if you 
have this option selected, searching for the last name of "Higareda" may include the last names of 
"Egareda" or "Igareda" in the search results. 

The "sounds like" feature is only available for person/entity names. When activated for a person, the 
system compares entries for the person's first, middle, and last names.  

You can apply the "sounds like" feature to your search by checking the "sounds like" checkbox. However, 
this option is not available for every search screen. 

Understanding the Difference Between Search and Filter 
The Search and Filter utilities both retrieve information from the system database. The difference 
between these two functions is the base information from which you can select for the search or filter. 

For instance, unlike a "normal" search, a filtered search operates based on additional configuration. A 
normal search for a person allows you to search for any possible name. On the other hand, searching 
work queues assigned to different court-employed people is a type of filtered search, which is based upon 
a list of names already provided through the work queue configuration. 

Task Activities 
Performing searches includes the following task activity: 

• Sample Search 

Additional Resources 
Other items related to this overview include the following: 

• Business Rules 
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The Case Section 

Initiate Cases 

Initiate Cases Overview  

 

Introduction 

Initiating a case creates and saves a case in the system.  

Starting a Case 

Case initiation begins when you submit an initial case filing with the Court. This filing may come from the 
mail, front counter, E-filing or Kiosk.  

Depending on how you receive this filing document, you will either manually complete the case data 
entries or allow the system to process the case. Refer to the E-Filing section for details on the automatic 
initiation process. 

Entering Case Information 

The case category and case type that you select will determine the field requirements and system 
validations for the case.  

In addition, some of the case initiation information may be pre-populated if the process begins from an E-
filing or kiosk submission, or the transformation of a pseudo case. 

Assigning Case Numbers 

You must indicate your case number assignment preference. You may choose to manually enter the case 
number or have the system automatically generate a number. If you manually provide a case number, the 
system must check the number format and availability. A number may be unavailable if another case 
already has this number or the number has been retired. 

Another option is to assign a reserved case number. You may use this assignment only if a reserved case 
number block has been set up for the selected case category, case type, and location. Refer to the 
Maintain Case Numbers section for details on reserving case numbers in the system. 

Adding Case Participants 

The case initiation process allows you to add participants on the case and designate their roles. 

There are different ways to add a case participant to a case. One way is to directly enter a name into the 
case participant fields. If you believe that a person/entity may already be in the system, you can also 
select a person/entity record from either the Person/Entity search results or from the Frequent Filers List. 
 Refer to the Manage Person/Entity Information section for details on searching for person/entity profiles. 

You can add more participants through case filings once the case exists in the system. Refer to the 
Maintain Case Filings section for details on creating case filings. 

If you add an attorney to the case during this process, the system will automatically associate this 
attorney with the Plaintiffs/Petitioners on the case. Since the attorney may have been incorrectly 
associated with some of the Plaintiffs/Petitioners, you must check and/or correct the participant 
associations created by the system after the case initiates. Refer to the Manage Case Participants 
section for details on updating case participant associations. 
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Checking for Vexatious Litigants 

You may choose to check the entered [plaintiff] participants against the Vexatious Litigant List. This check 
indicates whether the Court has labeled these participants as vexatious litigants. However, you may only 
perform this check if the filer is self represented. 

If the system finds a matching person/entity name, then the Vexatious Litigants - List screen will display 
with the matching entry highlighted. Otherwise, the Initiate Case screen will refresh and no changes will 
occur. Refer to the Manage Vexatious Litigants section for details on maintaining vexatious litigant 
entries. 

Entering Payor Information and NSF Lookup 

You may collect payor information for use against case related fees, such as for the initial case filing fee. 
You can also create additional case fees and record fee payments based on other filings received during 
the initiation process. This information is kept separate from the participant data since a payor may not be 
a case participant. 

The system uses these entries to verify whether the Non-Sufficient Funds List contains the payor (or 
account) information for a check payment. Refer to the Maintain NSF List section for details on accessing 
and maintaining the Non-Sufficient Funds List in the system. 

Associating Filings 

The case initiation process allows you to record additional filings that come in at case initiation.  

The system displays a list of filings that usually accompany the case initiation filing. For example, a filer 
may submit the Civil Case Cover Sheet with the complaint. This list allows you to easily record those 
filings on the case. These filings are not required but are meant to provide a "check list" of usual case 
initiation filings. 

The system will create a filing on the case for each filing that you select. It will also create an association 
between each selected document and the filer of the initial case filing. Refer to the Maintain Case Filings 
section for details on creating case filings. 

Selecting a Case Track 

You should assign a case track to the case. The track helps Courts to check the progress of the case, 
based on the selected case category and case type. 

The system will automatically assign a track to the case if a track has been established as the default for 
the case category/case type combination. Refer to the Configure Case Tracks section for details on 
creating tracks. 

Saving a Case as a Draft 

You must complete at least the following seven fields in order to successfully initiate a case: (1) Case 
Category, (2) Case Type, (3) Filing Document, (4) Case Number, (5) Case Title, (6) a participant Last 
Name or Name, and (7) the participant Role. 

If you do not have enough information to complete these items, then you may choose to save the entered 
case data as a pseudo case. This alternative to rejecting case data allows you to update and convert the 
"incomplete" case at a later time. Refer to the Manage Pseudo Cases section for details on saving and 
accessing a pseudo case. 
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Recording Payments 

Based on Court configuration, the payment screen may or may not display. This screen allows some 
Courts to maintain a separation of duties between the front counter clerk and the cashier. 

If the screen is configured to display, then you can record a payment against fees that are associated with 
the filed documents. If there are no due fees (possibly due to a fee waiver), then the system will skip the 
Record Payment screen. Refer to the Record Payments task activity for details on taking payments during 
case initiation. 

Assigning Judicial Officers/Departments 

The case initiation process allows you to assign a Judicial Officer or department to the case. The system 
will recommend a resource to the case based on configured assignment rules and resource availability. 
You may then either accept the proposed resource or select a different resource.  

If the system finds conflicts with your selection, then you are responsible for correcting these issues after 
saving the assignment.  

If there are no assignment rules configured for your Court's resources, or the rule does not include the 
"Auto Assign at Case Initiation" attribute, then the system will not recommend a resource. Refer to the 
Manage Resource Assignments and Configure Case Assignment Rules sections for details on resource 
assignments. 

Scheduling Case Events 

You have the option of scheduling the first event on the case during the initiation process. If you have 
assigned a Judicial Officer/Department resource to the case, then the system will recommend three 
available dates for the case event. You may then select one of these dates or choose another set of 
dates. 

Selecting a new date requires that you use the monthly calendar view for a specific Judicial 
Officer/Department. You can also specify the day on which the event should be scheduled.  

If the filing party made a reservation on the Court calendar prior to case initiation, then you can enter the 
reservation number and confirm the case reservation. Refer to the Schedule/Reserve Calendar Events 
section for details on the scheduling processes. 

Generating and Printing Forms and Notices 

You can also generate the case initiation forms appropriate to the new case. By selecting the "Print Case 
Initiation Forms" option, the system will generate the initiation forms related to the case. These forms then 
become available from the Generate Forms/Notices tab. At this point, you can choose to send the forms 
to a printer. 

Saving a Complete Case 

Before you finish and save the case, you must indicate whether the case initiation process is complete. 
While the case is already created in the system at this point, marking the case as complete will list it in the 
public index. 

If you do not select the "Is Case Initiation Complete" option, then the system sends the case to the 
"Cases Pending Back-Office Processing" work queue for further processing. This work queue reminds 
you that the case requires additional data entry. You may then finish the case initiation process for this 
case at a later time. Refer to the Work Queues section for details on this work queue. 
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Viewing Case Details 

After a case successfully initiates, you can view the existing case details from the Register of Actions 
(ROA) or the Case Details. You can also perform a case search to access the case.  

Refer to the Maintain Case Information section for details on searching for, accessing, and updating case 
data. 

Task Activities 

Initiating cases includes the following task activities: 

• Initiate Limited Civil Cases 
• Initiate Unlimited Civil Cases 
• Initiate Probate Cases 
• Initiate Small Claims Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Initiate Case Screen 

Initiate Case - Record Payment Screen 

Initiate Case - Summary Screen 

 

My Court Information 

 

Initiate Limited Civil Cases 

 

Introduction 

This process creates a limited civil case in the system. Limited civil cases are used, for example, within 
the Jurisdiction of the Limited Jurisdiction to get property back or to force someone to complete a 
contract. 

Only Limited Civil - Unlawful Detainer cases are automatically sealed after you save the case. 

Viewing Case Initiation Screens 

Courts may configure certain case initiation screens to display or not display. The following activity 
assumes that the case initiation screens will display during this process.  
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Task Activity 

Perform the following steps to initiate a limited civil case. 
 

1. Select [Case] > [Initiate Case]. 
Result: The Initiate Case screen displays. 

 
 

 

2. Select Limited Civil for the Case Category field value. 
3. Enter/Select data for the following required fields: 

4. Case Type 
5. Filing Date 
6. Filing Document 
7. Case Number 
8. Case Title 

 The Filing Date defaults to the current date. 

 If you manually enter a case number, this number must be available and in the correct 
format. The system will attach the appropriate county code and year automatically to this 
number. 
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 If you click the [Get Reserved Case Number] link, then the system will automatically 
enter the next available reserved number based on the selected category/case type.  

4. Enter/Select data for the other necessary fields in the header section. 
5. Enter/Select data for the following Participant fields: 

6. Last Name or Name 
7. Role 

 The “name” fields depend on the selected Category value. 

 You may either enter a name directly into the participant name fields or select a 
person/entity to add to the case. You must provide at least one participant. The system uses 
the first participant and role as the primary participant and role for the case initiation file. 

 Follow Steps 6-10 to search for an existing person/entity name. 

 Follow Steps 11-13 to select a person/entity from the Frequent Filers List. 

 Skip to Step 14 if you entered a name directly. 
 

6. Click the [Search for Existing Person/Entity] link. 
Result: The screen refreshes and displays the person/entity search fields. 
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7. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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9. Select the radio button for the person/entity to add as a case participant. 
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10. Click the [Select] button. 
Result: The screen refreshes. The selected person/entity data now displays in the participant 
fields. 

 
 

 

11. Click the [Select Frequent Filer] link to choose a person/entity from the Frequent Filers List. 
Result: The Frequent Filers screen displays. This list contains the frequent filers that belong to 
the selected case category and Court location. 

 
 

 

12. Select the radio button for the person/entity to add as a case participant. 
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13. Click the [Select] button. 
Result: The Initiate Case screen re-displays. The selected person/entity data now displays in the 
participant fields. 

 Follow Step 14 to check for vexatious litigant filers if it is a pro per case. 

 
 

 

14. Click the [Check for Vexatious Litigants] button. 
Result: If the system finds a vexatious litigant match, then the Vexatious Litigants – List screen 
will display with the matching entry highlighted. You may choose to reject the case at this point. 
Otherwise, the screen will refresh with no changes. 

 Follow Steps 15-16 to enter payor information. 
15. Click the [NSF Lookup] link. 

Result: The screen refreshes and displays the payor fields. 
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16. Enter/Select data for the necessary fields. 
 The system will perform the NSF Check if the payment method is "Check." This check 

occurs when you save the case data. 
17. Select the [Case Information] tab. 

Result: The Case Information tab highlights and displays additional case detail fields. 
 This screen will display different fields depending on the selected case category and case 

type. 
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18. Enter/Select data for the necessary fields. 
19. Click the [Next] button. 

Result: The Initiate Case – Record Payment screen displays. The entered payor information 
populates the appropriate fields. 

 This screen will only display if there are fees due on the case. Skip to Step 21 if clicking the 
[Next] button instead takes you to the Initiate Case - Summary screen. 

 The case header also displays with some of the entered case values, including the case 
number and case title. At this point, the case is created in the system but is not complete. 
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20. Enter/Select data for the necessary fields. 
 Refer to the Record Payments task activity for details on this process. 

21. Click the [Save] button. 
Result: The Initiate Case – Summary screen displays with the Officer/Department tab highlighted. 

 Follow Steps 22-23 to assign a Judicial Officer/Department to the case. 
 Follow Steps 24-26 to schedule the first event on the case. 
 Follow Steps 27-30 to print the case initiation forms and notices. 
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22. Enter/Select data for the necessary fields. 
 The system will recommend a resource based on configured assignment rules. You may 

select a (different) resource from the Assigned Resource field, if necessary. 
23. Click the [Save] button. 

Result: The screen refreshes. 
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24. Click the [Scheduling] tab. 
Result: The Scheduling tab highlights and displays calendar-related fields. 

 
 

 

25. Enter/Select data for the necessary fields. 
 Refer to the Schedule/Reserve Calendar Events section for details on scheduling the first 

case event. 
26. Click the [Schedule/Reserve] button. 

Result: The screen refreshes. 
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27. Click the [Generate Forms/Notices] tab. 
Result: The Generate Forms/Notices tab highlights. 
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28. Click the [Print Case Initiation Forms] button. 
Result: The screen refreshes and displays the appropriate case initiation forms in this tab. 

 
 

 

29. Select the checkboxes for the forms/notices to send to the printer. 
30. Click the [Print] button. 
31. Select the [Is Case Initiation Complete?] checkbox. 

 If you do not select this checkbox, the case will be sent to a work queue. 
32. Click the [Finish & Save] button. 

Result: The screen refreshes with a confirmation message. The case is saved in the system.  
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Related Links 

Initiate Cases Overview 

Initiate Case Screen 

Frequent Filers Screen 

Initiate Case - Record Payment Screen 

Initiate Case - Summary Screen 

 

My Court Information 

 

Initiate Probate Cases 

 

Introduction 

This process creates a probate case in the system. These cases handle wills, estates, conservatorships, 
and guardianships.  

Assigning Probate Investigators 

For Conservatorship cases and Guardianship cases involving an estate, the system (depending on your 
configuration) will recommend a Probate Investigator to assign to the case upon scheduling. This 
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recommendation is based on the zip code specified for the case. You can choose to override this 
assignment and select another investigator, or you can choose not to assign an investigator. 

Fiduciary Confirmation 

The system determines whether the proposed conservator, guardian, or trustee has been appointed for 
two or more unrelated Case Subjects. If so, then the system will confirm that the proposed conservator, 
guardian or trustee is registered as Private Profession Fiduciary at both the county and state level. 

Viewing Case Initiation Screens 

Courts may configure certain case initiation screens to display or not display. The following activity 
assumes that the case initiation screens will display during this process.  

Task Activity 

Perform the following steps to initiate a probate case. 
 

1. Select [Case] > [Initiate Case]. 
Result: The Initiate Case screen displays. 

 
 

 

2. Select Probate for the Case Category field value. 
3. Enter/Select data for the following required fields: 
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4. Case Type 
5. Filing Date 
6. Filing Document 
7. Case Number 
8. Case Title 

 The Filing Date defaults to the current date. 

 If you manually enter a case number, this number must be available and in the correct 
format. The system will attach the appropriate county code and year automatically to this 
number. 

 If you click the [Get Reserved Case Number] link, then the system will automatically 
enter the next available reserved number based on the selected category/case type.  

4. Enter/Select data for the other necessary fields in the header section. 
5. Enter/Select data for the following Participant fields: 

6. Last Name or Name 
7. Role 

 The “name” fields depend on the selected Category value. 

 You may either enter a name directly into the participant name fields or select a 
person/entity to add to the case. You must provide at least one participant. 

 Follow Steps 6-10 to search for an existing person/entity name. 

 Follow Steps 11-13 to select a person/entity from the Frequent Filers List. 

 Skip to Step 14 if you entered a name directly. 
 

6. Click the [Search for Existing Person/Entity] link. 
Result: The screen refreshes and displays the person/entity search fields. 
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7. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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9. Select the radio button for the person/entity to add as a case participant. 
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10. Click the [Select] button. 
Result: The screen refreshes. The selected person/entity data now displays in the participant 
fields. 

 
 

 

11. Click the [Select Frequent Filer] link to choose a person/entity from the Frequent Filers List. 
Result: The Frequent Filers screen displays. This list contains the frequent filers that belong to 
the selected case category and Court location. 

 
 

 

12. Select the radio button for the person/entity to add as a case participant. 
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13. Click the [Select] button. 
Result: The Initiate Case screen re-displays. The selected person/entity data now displays in the 
participant fields. 

 Follow Steps 14-15 to enter payor information. 

 
 

 

14. Click the [NSF Lookup] link. 
Result: The screen refreshes and displays the payor fields. 
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15. Enter/Select data for the necessary fields. 
 The system will perform the NSF Check if the payment method is "Check." This check 

occurs when you save the case data. 
16. Select the [Case Information] tab. 

Result: The Case Information tab highlights and displays additional case detail fields. 
 This screen will display different fields depending on the selected case category and case 

type. 
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17. Enter/Select data for the necessary fields. 
18. Click the [Next] button. 

Result: The Initiate Case – Record Payment screen displays. The entered payor information 
populates the appropriate fields. 

 This screen will only display if there are fees due on the case. Skip to Step 20 if clicking the 
[Next] button instead takes you to the Initiate Case - Summary screen. 

 The case header also displays with some of the entered case values, including the case 
number and case title. At this point, the case is created in the system but is not complete. 
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19. Enter/Select data for the necessary fields. 
 Refer to the Record Payments task activity for details on this process. 

20. Click the [Save] button. 
Result: The Initiate Case – Summary screen displays with the Officer/Department tab highlighted. 

 Follow Steps 21-22 to assign a Judicial Officer/Department to the case. 
 Follow Steps 23-25 to schedule the first event on the case. 
 Follow Steps 26-29 to print the case initiation forms and notices. 
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21. Enter/Select data for the necessary fields. 
 The system will recommend a resource based on configured assignment rules. You may 

select a (different) resource from the Assigned Resource field, if necessary. 
22. Click the [Save] button. 

Result: The screen refreshes. 
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23. Click the [Scheduling] tab. 
Result: The Scheduling tab highlights and displays calendar-related fields. 

 
 

 

24. Enter/Select data for the necessary fields. 
 Refer to the Schedule/Reserve Calendar Events section for details on scheduling the first 

case event. 
25. Click the [Schedule/Reserve] button. 

Result: The screen refreshes. 
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26. Click the [Generate Forms/Notices] tab. 
Result: The Generate Forms/Notices tab highlights. 
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27. Click the [Print Case Initiation Forms] button. 
Result: The screen refreshes and displays the appropriate case initiation forms in this tab. 

 
 

 

28. Select the checkboxes for the forms/notices to send to the printer. 
29. Click the [Print] button. 
30. Select the [Is Case Initiation Complete?] checkbox. 

 If you do not select this checkbox, the case will be sent to a work queue. 
31. Click the [Finish & Save] button. 

Result: The screen refreshes with a confirmation message. The case is saved in the system.  
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Related Links 

Initiate Cases Overview 

Initiate Case Screen 

Frequent Filers Screen 

Initiate Case - Record Payment Screen 

Initiate Case - Summary Screen 

 

My Court Information 

 

Initiate Small Claims Cases 

 

Introduction 

This process creates a small claims case in the system. 

Venue Confirmation 

The system determines (based on the acceptable venue locations by zip code) whether the proposed 
venue identified by the Filing Party is acceptable. This determination is based on the zip code (identified 
in the Plaintiff's claim). When a zip code is provided for a case category/type other than those listed 
above, the location will default based on the local court rules. 
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Viewing Case Initiation Screens 

Courts may configure certain case initiation screens to display or not display. The following activity 
assumes that the case initiation screens will display during this process.  

Task Activity 

Perform the following steps to initiate a small claims case. 
 

1. Select [Case] > [Initiate Case]. 
Result: The Initiate Case screen displays. 

 
 

 

2. Select Small Claims for the Case Category field value. 
3. Enter/Select data for the following required fields: 

4. Case Type 
5. Filing Date 
6. Filing Document 
7. Location 
8. Case Number 
9. Case Title 

 The Filing Date defaults to the current date. 



Printed Documentation 

70 

 If you manually enter a case number, this number must be available and in the correct 
format. The system will attach the appropriate county code and year automatically to this 
number. 

 If you click the [Get Reserved Case Number] link, then the system will automatically 
enter the next available reserved number based on the selected category/case type.  

4. Enter/Select data for the other necessary fields in the header section. 
5. Enter/Select data for the following Participant fields: 

6. Last Name or Name 
7. Role 

 The "name" fields depend on the selected Category value. 

 You may either enter a name directly into the participant name fields or select a 
person/entity to add to the case. You must provide at least one participant. 

 Follow Steps 6-10 to search for an existing person/entity name. 

 Follow Steps 11-13 to select a person/entity from the Frequent Filers List. 

 Skip to Step 14 if you entered a name directly. 
 

6. Click the [Search for Existing Person/Entity] link. 
Result: The screen refreshes and displays the person/entity search fields. 
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7. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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9. Select the radio button for the person/entity to add as a case participant. 
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10. Click the [Select] button. 
Result: The screen refreshes. The selected person/entity data now displays in the participant 
fields. 

 
 

 

11. Click the [Select Frequent Filer] link to choose a person/entity from the Frequent Filers List. 
Result: The Frequent Filers screen displays. This list contains the frequent filers that belong to 
the selected case category and Court location. 

 
 

 

12. Select the radio button for the person/entity to add as a case participant. 



Printed Documentation 

74 

13. Click the [Select] button. 
Result: The Initiate Case screen re-displays. The selected person/entity data now displays in the 
participant fields. 

 Follow Step 14 to check for vexatious litigant filers if it is a pro per case. 

 
 

 

14. Click the [Check for Vexatious Litigants] button. 
Result: If the system finds a vexatious litigant match, then the Vexatious Litigants – List screen 
will display with the matching entry highlighted. You may choose to reject the case at this point. 
Otherwise, the screen will refresh with no changes. 

 Follow Steps 15-16 to enter payor information. 
15. Click the [NSF Lookup] link. 

Result: The screen refreshes and displays the payor fields. 
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16. Enter/Select data for the necessary fields. 
 The system will perform the NSF Check if the payment method is "Check." This check 

occurs when you save the case data. 
17. Select the [Case Information] tab. 

Result: The Case Information tab highlights and displays additional case detail fields. 
 This screen will display different fields depending on the selected case category and case 

type. 
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18. Enter/Select data for the necessary fields. 
19. Click the [Next] button. 

Result: The Initiate Case – Record Payment screen displays. The entered payor information also 
displays in the appropriate fields. 

 This screen will only display if there are fees due on the case. Skip to Step 22 if clicking the 
[Next] button instead takes you to the Initiate Case - Summary screen. 

 The case header also displays with some of the entered case values, including the case 
number and case title. At this point, the case is created in the system but is not complete. 

 
 

 

20. Enter/Select data for the necessary fields. 
 Refer to the Record Payments task activity for details on this process. 

21. Click the [Save] button. 
Result: The Initiate Case – Summary screen displays with the Officer/Department tab highlighted. 
The case is now created in the system. 

 Follow Steps 22-23 to assign a Judicial Officer/Department to the case. 
 Follow Steps 24-26 to schedule the first event on the case. 
 Follow Steps 27-31 to print the case initiation forms and notices. 
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22. Enter/Select data for the necessary fields. 
 The system will recommend a resource based on configured assignment rules. You may 

select a (different) resource from the Assigned Resource field, if necessary. 
23. Click the [Save] button. 

Result: The screen refreshes. 
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24. Click the [Scheduling] tab. 
Result: The Scheduling tab highlights and displays calendar-related fields. 
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25. Enter/Select data for the necessary fields. 
 Refer to the Schedule/Reserve Calendar Events section for details on scheduling the first 

case event. 
26. Click the [Schedule/Reserve] button. 

Result: The screen refreshes. 
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27. Click the [Generate Forms/Notices] tab. 
Result: The Generate Forms/Notices tab highlights. 
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28. Click the [Print Case Initiation Forms] button. 
Result: The screen refreshes and displays the appropriate case initiation forms in this tab. 

 
 

 

29. Select the checkboxes for the forms/notices to send to the printer. 
30. Click the [Print] button. 
31. Select the [Is Case Initiation Complete?] checkbox. 

 If you do not select this checkbox, the case will be sent to a work queue. 
32. Click the [Finish & Save] button. 

Result: The screen refreshes with a confirmation message. The case is saved in the system.  
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Related Links 

Initiate Cases Overview 

Initiate Case Screen 

Frequent Filers Screen 

Initiate Case - Record Payment Screen 

Initiate Case - Summary Screen 

 

My Court Information 

 

Initiate Unlimited Civil Cases 

 

Introduction 

This process creates an unlimited civil case in the system. Unlimited civil cases are used, for example, for 
an injunction, to get property back, or to force someone to complete a contract. 

Viewing Case Initiation Screens 

Courts may configure certain case initiation screens to display or not display. The following activity 
assumes that the case initiation screens will display during this process.  
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Task Activity 

Perform the following steps to initiate an unlimited civil case. 
 

1. Select [Case] > [Initiate Case]. 
Result: The Initiate Case screen displays. 

 
 

 

2. Select Unlimited Civil for the Case Category field value. 
3. Enter/Select data for the following required fields: 

4. Case Type 
5. Filing Date 
6. Filing Document 
7. Case Number 
8. Case Title 

 The Filing Date defaults to the current date. 

 If you manually enter a case number, this number must be available and in the correct 
format. The system will attach the appropriate county code and year automatically to this 
number. 
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 If you click the [Get Reserved Case Number] link, then the system will automatically 
enter the next available reserved number based on the selected category/case type.  

4. Enter/Select data for the other necessary fields in the header section. 
5. Enter/Select data for the following Participant fields: 

6. Last Name or Name 
7. Role 

 The “name” fields depend on the selected Category value. 

 You may either enter a name directly into the participant name fields or select a 
person/entity to add to the case. You must provide at least one participant. 

 Follow Steps 6-10 to search for an existing person/entity name. 

 Follow Steps 11-13 to select a person/entity from the Frequent Filers List. 

 Skip to Step 14 if you entered a name directly. 
 

6. Click the [Search for Existing Person/Entity] link. 
Result: The screen refreshes and displays the person/entity search fields. 
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7. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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9. Select the radio button for the person/entity to add as a case participant. 
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10. Click the [Select] button. 
Result: The screen refreshes. The selected person/entity data now displays in the participant 
fields. 

 
 

 

11. Click the [Select Frequent Filer] link to choose a person/entity from the Frequent Filers List. 
Result: The Frequent Filers screen displays. This list contains the frequent filers that belong to 
the selected case category and Court location. 

 
 

 

12. Select the radio button for the person/entity to add as a case participant. 
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13. Click the [Select] button. 
Result: The Initiate Case screen re-displays. The selected person/entity data now displays in the 
participant fields. 

 Follow Step 14 to check for vexatious litigant filers if it is a pro per case. 

 
 

 

14. Click the [Check for Vexatious Litigants] button. 
Result: If the system finds a vexatious litigant match, then the Vexatious Litigants – List screen 
will display with the matching entry highlighted. You may choose to reject the case at this point. 
Otherwise, the screen will refresh with no changes. 

 Follow Steps 15-16 to enter payor information. 
15. Click the [NSF Lookup] link. 

Result: The screen refreshes and displays the payor fields. 
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16. Enter/Select data for the necessary fields. 
 The system will perform the NSF Check if the payment method is "Check." This check 

occurs when you save the case data. 
17. Select the [Case Information] tab. 

Result: The Case Information tab highlights and displays additional case detail fields. 
 This screen will display different fields depending on the selected case category and case 

type. 
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18. Enter/Select data for the necessary fields. 
19. Click the [Next] button. 

Result: The Initiate Case – Record Payment screen displays. The entered payor information 
populates the appropriate fields. 

 This screen will only display if there are fees due on the case. Skip to Step 21 if clicking the 
[Next] button instead takes you to the Initiate Case - Summary screen. 

 The case header also displays with some of the entered case values, including the case 
number and case title. At this point, the case is created in the system but is not complete. 
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20. Enter/Select data for the necessary fields. 
 Refer to the Record Payments task activity for details on this process. 

21. Click the [Save] button. 
Result: The Initiate Case – Summary screen displays with the Officer/Department tab highlighted. 

 Follow Steps 22-23 to assign a Judicial Officer/Department to the case. 
 Follow Steps 24-26 to schedule the first event on the case. 
 Follow Steps 27-30 to print the case initiation forms and notices. 
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22. Enter/Select data for the necessary fields. 
 The system will recommend a resource based on configured assignment rules. You may 

select a (different) resource from the Assigned Resource field, if necessary. 
23. Click the [Save] button. 

Result: The screen refreshes. 
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24. Click the [Scheduling] tab. 
Result: The Scheduling tab highlights and displays calendar-related fields. 

 
 

 

25. Enter/Select data for the necessary fields. 
 Refer to the Schedule/Reserve Calendar Events section for details on scheduling the first 

case event. 
26. Click the [Schedule/Reserve] button. 

Result: The screen refreshes. 
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27. Click the [Generate Forms/Notices] tab. 
Result: The Generate Forms/Notices tab highlights. 
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28. Click the [Print Case Initiation Forms] button. 
Result: The screen refreshes and displays the appropriate case initiation forms in this tab. 

 
 

 

29. Select the checkboxes for the forms/notices to send to the printer. 
30. Click the [Print] button. 
31. Select the [Is Case Initiation Complete?] checkbox. 

 If you do not select this checkbox, the case will be sent to a work queue. 
32. Click the [Finish & Save] button. 

Result: The screen refreshes with a confirmation message. The case is saved in the system.  
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Related Links 

Initiate Cases Overview 

Initiate Case Screen 

Frequent Filers Screen 

Initiate Case - Record Payment Screen 

Initiate Case - Summary Screen 

 

Initiate Legacy Cases 

Initiate Legacy Cases Overview  

 

Introduction 

Initiating a legacy case creates and saves a legacy case in the system.  

About Legacy Cases 

Legacy cases originate from a legacy system or a physical case folder. These cases must be brought into 
the system in order to perform activities on the case, such as recording filings, scheduling events, etc. 

Courts may initiate legacy cases in order to create a JCCP case or a bench recusal case. Refer to the 
Coordinate Cases section for details on initiating a JCCP case. 
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Creating Legacy Cases 

Creating a legacy case requires that you enter only a minimal amount of information in the new system. 
You may provide additional information once the legacy case is created. Refer to the Maintain Case 
Information section for details on this process. 

Creating JCCP Cases 

Creating a JCCP case involves the process of initiating a legacy case. Once created, you can coordinate 
the JCCP case with in-county or out-of-county cases for a common event or issue. Refer to the 
Coordinate Cases section for details on initiating a JCCP case. 

Assigning Case Numbers 

The system allows you to select the method for assigning a case number to the legacy case. This can be 
an automatic or manually entered case number. You can also assign a reserved case number, if there is 
one available. Refer to the Maintain Case Numbers section for details on reserving case numbers.  

You may select either this number or the legacy number as the primary identifier for the case. The system 
will use this identifier on the screens, forms, notices and reports that contain the case number field.  

Saving the Legacy Case 

Saving the legacy case prompts the system to write an entry to both the Case History and Register of 
Actions. These entries indicate that the legacy case now exists in the system.  

You can then search for and access this case using either the system or legacy case number. 

Task Activities 

Initiating a legacy case includes the following task activity: 

• Initiate Legacy Cases 
Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Initiate Legacy Case Screen 

Case Summary Screen 

 

My Court Information 

 

Initiate Legacy Cases 
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Introduction 

Initiating a legacy case creates and saves a legacy case in the system.  

Task Activity 

Perform the following steps to initiate a legacy case. 
 

1. Select [Case] > [Initiate Legacy Case]. 
Result: The Initiate Legacy Case screen displays. 
 
 

 

2. Enter/Select data for the following required fields: 
3. Case Category 
4. Case Type 
5. Case Status 
6. Case Number 
7. Case Title 
8. Legacy/JCCP Case Number 
9. Original Filing Date 

 You can choose the type of case number to assign to the case. If you select the "Manual" 
option, then you must type in the case number in the open text field.  

 If you select the Use as Primary Case Number checkbox, then the system will make the 
legacy number the primary identifier for the case. 

3. Enter/Select data for the other necessary fields. 
4. Click the [Save] button. 

Result: The Case Summary screen displays. The system assigns a case number to the legacy 
case and displays the appropriate case information in the Case Header. 

 If you selected to initiate a JCCP case, the system will instead display the Associate Cases 
- Enter Search Criteria screen. Refer to the Coordinate Cases section if you are initiating a JCCP 
case. 
 
 

 

 

 

Related Links 

Initiate Legacy Cases Overview 

Initiate Legacy Case Screen 

Case Summary Screen 
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Manage Pseudo Cases 

Manage Pseudo Cases Overview  

 

Introduction 

Managing pseudo cases involves creating, updating, and/or closing a pseudo case in the system. 

About Pseudo Cases 

Pseudo cases consist of case information that did not meet the Court requirements for becoming a "real" 
case in the system. These cases allow Courts to temporarily save this incomplete data with the intention 
that you will resume the case initiation process at a later time. 

The system assigns pseudo cases a Pseudo Case ID or confirmation number in order to identify the 
case. Pseudo cases do not receive a case number until you complete the case initiation process. 

Creating Pseudo Cases 

There are two ways you can create a pseudo case. One way is for you to directly initiate a pseudo case 
based on the lack of certain required data. Another way is for you to end the case initiation process by 
saving the incomplete data as a pseudo case. Refer to the following task activities for details on each of 
these processes. 

Pseudo Case Restrictions 

Since pseudo cases are not "real" cases, you cannot associate the accounting or calendar-related 
information with these items. As such, pseudo cases are not included in the JBSIS requirements or 
reporting. But the system will temporarily store filings and payor information, as appropriate. 

Task Activities 

Managing pseudo cases includes the following task activities: 

• Create Pseudo Cases from Case Initiation 
• Initiate Pseudo Cases 
• Search Pseudo Cases 
• Update/Reject Pseudo Cases 
• Transform Pseudo Cases 
• Close Pseudo Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Search Pseudo Case Screen 
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Initiate Pseudo Case Screen 

Initiate Pseudo Case - Summary Screen 

 

My Court Information 

 

Create Pseudo Cases from Case Initiation 

 

Introduction 

Creating a pseudo case saves incomplete case data during the case initiation process. You may then 
access the pseudo case information at a later time and update, convert, or close the pseudo case.  

Entering Case Data 

You must enter or select at least one required field from the Initiate Case screen in order to save the data 
as a pseudo case. It is recommended that you consider the amount of information entered into the 
system before choosing to save the incomplete data. Refer to the Initiate Cases section for details on 
creating a case in the system. 

Maintaining Case Data 

Since pseudo cases are not "real" cases, you cannot associate accounting or calendar-related 
information with these items. 

However, the system will save the data that you provide on the Initiate Case screen to the pseudo case. 
For example, you may associate filings with the case, select participants, or enter payor information. 
While some of these items will not display on the pseudo case screens, the system will continue to store 
this data. 

Creating Rejection Notices 

You can only attach a rejection notice to a pseudo case from the Initiate Pseudo Case screen. Saving a 
case as a draft through the case initiation process does not allow you to associate rejection notices with 
the case. Refer to the Initiate Pseudo Cases and Update/Reject Pseudo Cases task activities for details 
on creating pseudo case rejection notices. 

Task Activity 

Perform the following steps to create a pseudo case from the case initiation process. 
 

1. Select [Case] > [Initiate Case]. 
Result: The Initiate Case screen displays. 
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2. Enter/Select data for the necessary fields. 
 You must enter/select at least one required field in order to save the data as a pseudo case. 
 This includes data listed on the [Participants] and [Case Information] tabs. 

3. Click the [Save as Draft] button. 
Result: The Initiate Pseudo Case – Summary screen displays. The system saves the entered 
data from the Initiate Case screen to the pseudo case. The system also assigns a Pseudo Case 
ID or confirmation number to this case. 
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4. Record the Confirmation Number. 
 You must record this number in order to access this pseudo case in the future. 

 

 

Related Links 

Manage Pseudo Cases Overview 

Initiate Case Screen 

Initiate Pseudo Case - Summary Screen 

 

My Court Information 

 

Initiate Pseudo Cases 

 

Introduction 

Initiating a pseudo case creates and saves an incomplete case in the system. This process allows you to 
access the information at a later time and update, transform, or close the case. 

Providing Participant Information 

You must provide at least one case participant on the pseudo case. This participant may be an individual, 
business/organization, government agency, or a Trust. 
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Checking for Vexatious Litigants 

You may check if the participants who are filing the case exist on the Vexatious Litigant List. This check 
indicates whether the Court has labeled these participants as vexatious litigants. It is usually performed 
for self-represented filers (pro per).  

If the system finds a matching person/entity name, then the Vexatious Litigants - List screen will display 
with the matching entry highlighted. Otherwise, the Initiate Pseudo Case screen will refresh and no 
changes will occur.  

Adding Payor Information (NSF) 

You may also choose to enter payor information. These optional entries allow you to conduct an non-
sufficient fund (NSF) lookup for check payments before you enter additional pseudo case data.  

Creating Rejection Notices 

Depending on the Court, you may need to create a rejection notice for the pseudo case. The rejection 
notice will allow you to enter the details of why this case is at an incomplete status. You may create 
additional rejection notices every time you access and reject a pseudo case.  

This notice will be given to the filer of the pseudo case and will be used for retrieving the saved case 
information at a later time. 

Task Activity 

Perform the following steps to directly initiate a pseudo case. 
 

1. Select [Case] > [Initiate Pseudo Case]. 
Result: The Initiate Pseudo Case screen displays. 
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2. Enter/Select data for the following required fields: 
3. Pseudo Case Category 
4. Created Date 
5. Last Name or Name 
6. Role 

 The Created Date defaults to the current date. 

 You must enter at least one participant on this case. 

3. Enter/Select data for the other necessary fields. 
4. Click the [Save] button. 

Result: The Initiate Pseudo Case – Summary screen displays. The system also assigns a Pseudo 
Case ID or confirmation number to this case. 
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5. Record the Confirmation Number. 
 You must write down this number in order to access this pseudo case in the future. 

 

 

Related Links 

Manage Pseudo Cases Overview 

Initiate Pseudo Case Screen 

Initiate Pseudo Case - Summary Screen 

 

My Court Information 

 

Search Pseudo Cases 

 

Introduction 

Searching for a pseudo case allows you to search for and display pseudo cases that exist in the system.  

Pseudo Case Search Functionality 

The system performs a search based on the information that you provide. However, only pseudo cases 
with a status of “Open” will display in the search results.  

You must provide data for at least one primary search field or two secondary search fields in order to 
return a result. Providing other parameter data helps to narrow the search results and increases the 
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likelihood of finding a closer match. Refer to the Search Feature Overview for details on performing a 
search in the system. 

Using the Search Results 

The search function also provides the foundation for maintaining pseudo case information. For example, 
you must perform a pseudo case search in order to update, transform, or close a pseudo case.  

Task Activity 

Perform the following steps to search for a pseudo case. 
 

1. Select [Case] > [Search Pseudo Case]. 
Result: The Search Pseudo Case screen displays. 

 
 

 

2. Enter a Last Name or Name of a participant on the pseudo case. 
 This required field will depend on the selected Category field value, which defaults to 

"Individual." 
 Entering a Pseudo Case ID will display an exact pseudo case match. 

3. Enter/Select data for the other search parameter fields. 
 Selecting other search criteria narrows the search results and increases the likelihood of 

finding a closer pseudo case match. 
4. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 
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 From the Search Results section, you can perform the Update/Reject Pseudo Cases, 
Transform Pseudo Cases or the Close Pseudo Cases task activities. 

 

 

Related Links 

Manage Pseudo Cases Overview 

Search Pseudo Case Screen 

 

My Court Information 

 

Update/Reject Pseudo Cases 

 

Introduction 

Updating a pseudo case allows you to change existing pseudo case information. This activity also allows 
you to reject a pseudo case. 

Updating and Checking Pseudo Case Information 

You can change/update different pseudo case settings and information. For example, you can add or 
update the case participants and their related information. You may also check the entered participants 
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against the Vexatious Litigant List or compare payor entries against the Non-Sufficient Fund (NSF) 
lookup.  

Rejecting Pseudo Cases 

If you are not transforming a pseudo case into a "real" case, then you may need to create a rejection 
notice for this case. The rejection notice provides a record as to why this case remains a pseudo case. 
This notice also helps you to identify the case’s missing data or Court requirements. It is recommended 
that you generate this notice each time a pseudo case fails to become a "real" case. 

You may view PDF versions of previously generated rejection notices from the bottom of the screen. 

Task Activity 

This activity takes place within the context of a pseudo case search. Refer to the Search Pseudo Cases 
task activity for details on performing this search. 

Perform the following steps to update and reject a pseudo case.  
 

1. Click the [Pseudo Case ID] link for the pseudo case to update and/or reject. 
 This selection occurs from the Search Pseudo Case screen. 

Result: The Initiate Pseudo Case screen displays. Previously entered pseudo case data also 
displays in the appropriate fields. 
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2. Edit/Update the available fields as needed. 
 The Pseudo Case Category and Created Date are read-only fields. If a Pseudo Case 

Type has already been selected, then this field may also be read-only. 
3. Enter data for the following fields in order to reject the pseudo case: 

4. Rejection Date 
5. Rejection Reason 

 

4. Click the [Create Rejection Notice] button. 
Result: The Rejection Notice parameter screen will display. This screen allows you to enter 
additional information on the rejection notice. Clicking the [Save] button will return you to the 
Initiate Pseudo Case screen. 

5. Click the [Save] button. 
Result: The Initiate Pseudo Case – Summary screen displays. The confirmation number for the 
pseudo case remains the same. 
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Related Links 

Manage Pseudo Cases Overview 

Search Pseudo Case Screen 

Initiate Pseudo Case Screen 

Initiate Pseudo Case - Summary Screen 

 

My Court Information 

 

Transform Pseudo Cases 

 

Introduction 

Transforming a pseudo case converts pseudo case data into the case initiation format. This allows you to 
save the data as a "real" case or re-save the data as a pseudo case. 

Transform Functionality 

When you transform a pseudo case, the system will retrieve the existing pseudo case data and move it to 
the Case Initiation screen. From here, you can complete the case initiation process, which will change the 
pseudo case into a "real" case. You may also choose to partially complete the data entries and select the 
"Save as Draft" option. This will re-save the pseudo case with the same system identifier. 

A pseudo case will keep its system identifier (Pseudo Case ID) and remain "Open" until you complete the 
case initiation process. Refer to the Initiate Cases section for details on this process. 

Transform from Pseudo Case - Summary Screen 

You may also choose to transform a pseudo case from the Pseudo Case – Summary screen. This option 
displays when you have saved new or updated pseudo case information and allows you to transfer this 
data to the Initiate Case screen. 

Task Activity 

This activity takes place within the context of a pseudo case search. Refer to the Search Pseudo Cases 
task activity for details on performing this search. 

Perform the following steps to transform a pseudo case.  
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1. Click the [Transform Case] link for the pseudo case to transform. 
 This selection occurs from the Search Pseudo Case screen. The link is on the same line as 

the Pseudo Case ID of the case. 

 
 

 

2. Result: The Initiate Case screen displays with the pseudo case data entered in the appropriate 
case fields. 
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2. Continue with the Initiate Case process as necessary. 
 Refer to the Initiate Cases section for details on creating a new case. 

 

 

Related Links 

Manage Pseudo Cases Overview 

Search Pseudo Case Screen 

Initiate Case Screen 

 

My Court Information 

 

Close Pseudo Cases 
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Introduction 

Closing a pseudo case removes the record from the list of open pseudo cases. This activity prevents you 
from accessing the pseudo case by changing its status to "Closed" and making it unavailable from the 
pseudo case search results. However, closing a pseudo case does not delete the pseudo case from the 
system. 

Task Activity 

This activity takes place within the context of a pseudo case search. Refer to the Search Pseudo Cases 
task activity for details on performing this search. 

Perform the following steps to close a pseudo case.  
 

1. Select the checkboxes of the pseudo cases to close. 
 This selection occurs from the Search Pseudo Case screen. 

 
 

 

2. Enter a Close Reason. 
 This is an optional step. Examples of close reasons include "Administratively Closed" or 

"Holding Period Expired." 
3. Click the [Close Pseudo Cases] button. 

Result: The screen refreshes and no longer displays the selected pseudo case(s). The system 
also updates the status of these cases to "Closed." 
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Related Links 

Manage Pseudo Cases Overview 

Search Pseudo Case Screen 

 

Maintain Case Numbers 

Maintain Case Numbers Overview  

 

Introduction 

Maintaining case numbers involves manually reserving, releasing, and retiring case numbers in the 
system. Each of these activities affects how the system generates and assigns case numbers during the 
case initiation process. 

You must have the required security role to perform case number maintenance. 

About Case Numbers 

The system uses case numbers to uniquely identify cases throughout the California Courts. The case 
number format consists of a two-digit County code, a four-digit year code, and an eight-digit case 
identifier. For example, a case initiated within XX County in the year 2005 might look like XX-2005-
12345678. 
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Case numbers also belong to a specific location, case category, and case type(s). The end of a case 
number will contain a two-digit case category code, a two-digit case type code, and a three-digit 
jurisdiction location code. 

Identifying Case Number Availability 

When you maintain case numbers, each case number’s status will update to reflect its current use and 
availability for case assignment. While the case number status does not display on the screen, the 
reserved number list will show the quantity of numbers that are currently in use. 

Assigning Case Numbers to Cases 

Either you or the system will assign case numbers during the case initiation process. Refer to the Initiate 
Cases section for details on this process. 

Removing Case Numbers 

While the system records the updated status changes to case numbers that you release or retire, these 
changes do not display on the screen. However, you have the option to remove these number groups 
from the reserved case number list. 

You may remove groups that include both unassigned numbers and numbers currently in use. The 
removal option does not delete these numbers from the system, but only hides the selected groups from 
view.  

Task Activities 

Maintaining case numbers includes the following task activities: 

• Reserve Case Numbers 
• Release Case Numbers 
• Retire Case Numbers 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Maintain Reserved Case Numbers Screen 

 

My Court Information 

 

Reserve Case Numbers 
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Introduction 

Reserving case numbers saves a specific group of numbers for use in manual case number assignment.  

Reasons for Reserving Case Numbers 

There are several reasons why you should reserve case numbers. One reason is to provide a method for 
tracking case records. It also allows Courts to pre-order case folders. 

You must reserve numbers prior to case assignment. The system uses these numbers when you choose 
to assign a reserved number to a new case. Refer to the Initiate Cases section for details on this process. 
  

Reservation Types 

Case number reservation occurs in blocks or ranges. A block represents a specific quantity of case 
numbers. For example, you may define a block to be 50 case numbers. Blocks are automatically 
sequenced, with a system-generated start and end number. 

A range represents a sequential series of case numbers with specified beginning and end numbers. For 
example, you could reserve a range starting with the number 1-2005-80000001 and ending with 1-2005-
800000099. As a result, the system would reserve the numbers within this defined range. 

Courts may configure how many case numbers you can reserve at a time. 

Reservation Attributes 

You can only reserve case numbers for a specific case category and location. However, the reservation 
can include multiple case types that belong to the selected case category. 

Reservation Functionality 

Reserving case numbers makes these numbers unavailable for automatic assignment during case 
initiation. This means that the system cannot assign a reserved number to a case unless you select this 
option. This would prompt the system to retrieve the next available reserved case number within a 
reserved group based on the selected case category, case type(s) and location. 

If you are specifying a number range, then the entered end number must not be higher than the number 
configured for the Court. For example, if the Court has configured the highest case number to be 
99999999, then this is the highest number you may specify in a range. 

The system will also determine the availability of the numbers in the selected block or range. A number 
will be unavailable if you or another person has already manually assigned it to a case or retired it from 
another reserved group. 

Reservation Restrictions 

The system does not support the assignment of specific numbers within a reserved block or range. This 
prevents you from manually entering a reserved number in the Case Number field during case initiation. 

The system also does not support the reservation of case numbers by Judicial Officer or department. 

Task Activity 

Perform the following steps to reserve case numbers in the system. 
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1. Select [Case] > [Maintain Reserved Case Numbers]. 
Result: The Maintain Reserved Case Numbers screen displays. This screen shows a list of 
reserved case number groups. 

 
 

 

 Follow Step 2 to reserve a block of numbers. 
 Follow Step 3 to reserve a range of numbers. 

2. Enter/Select data for the following required block fields: 
 

• Quantity to Reserve 
• Case Category 
• Case Type 
• Location 

 Skip to Step 4 to reserve the block. 

3. Enter/Select data for the following required range fields: 
4. Beginning Number 
5. End Number 
6. Case Category 
7. Case Type 
8. Location 

 

4. Click the [Reserve Case Numbers] button for the appropriate block or range selection. 
Result: The Maintain Reserved Case Numbers – Confirmation screen displays. 
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5.  This screen will display a warning message if there are numbers within the selected 
reserved group that are unavailable. You may either continue with the reservation by clicking the [Yes] 
button, or you may cancel the reservation by clicking [No]. 

 
 

 

6.  If there are more than five numbers unavailable within the selected reserve group, then you 
may click the [More Unavailable Numbers] link to view the unavailable numbers in that group. 



The Case Section 

121 

 
 

 

5. Click the [Reserve More Case Numbers] link to return to the Maintain Reserved Case Numbers 
screen. This step allows you to start the reserve case number activity again. 

 

 

Related Links 

Maintain Case Numbers Overview 

Maintain Reserved Case Numbers Screen 

 

My Court Information 

 

Release Case Numbers 

 

Introduction 

Releasing case numbers "un-reserves" a selected case number group and makes these numbers 
available for automatic assignment. 

Only unassigned case numbers within the reserved group can be released. 

Release Functionality 

Once you release a case number, this number becomes available for automatic or manual case 
assignment during case initiation.  

Released case numbers will continue to display on the Maintain Reserved Case Numbers screen. This 
will occur even if there are no assigned case numbers within a released group (i.e., the quantity in use is 
zero). As a result, it is recommended that you remove the released block or range from the screen. 
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Release Restrictions 

The system does not support the release of individual (specific) case numbers. It also cannot release a 
block (or range) whose case numbers have been assigned to cases. 

In addition, you can only release case numbers that had been originally reserved. You must have a 
Supervisor security role to release the case number block or range. 

For a specific group of reserved numbers, if the quantity "In Use" is the same as the "Amount Reserved," 
then there are no available case numbers to release. 

Task Activity 

Perform the following steps to release a group of reserved case numbers. 
 

1. Select [Case] > [Maintain Reserved Case Numbers]. 
Result: The Maintain Reserved Case Numbers screen displays. 

 
 

 

2. Select the checkboxes for the reserved number groups to release. 
3. Click the [Release] button. 

Result: The screen refreshes but continues to display the released group in the reserved number 
list. However, the available numbers remaining in this selected group are now available for case 
assignment. 
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4. Select the checkboxes for the released number groups to remove from the screen list. 
5. Click the [Remove From List] button. 

Result: The screen refreshes and no longer displays the selected released group(s). 
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Related Links 

Maintain Case Numbers Overview 

Maintain Reserved Case Numbers Screen 

 

My Court Information 

 

Retire Case Numbers 

 

Introduction 

Retiring case numbers makes these numbers unavailable for future case assignment in the system. 

Retire Functionality 

You can only retire the remainder of unused or unassigned numbers in a reserved group. 

Retired case numbers will continue to display on the Maintain Reserved Case Numbers screen. This will 
occur even if there are no assigned case numbers within a retired group (i.e., the quantity in use is zero). 
As a result, it is recommended that you remove the released block or range from the screen. 

Retire Restrictions 

The system does not support the retirement of specific case numbers within a given block or range. It 
also cannot retire a block (or range) whose case numbers are currently assigned to cases. 

For a specific group of reserved numbers, if the quantity "In Use" is the same as the "Amount Reserved," 
then there are no available case numbers to retire. 

Task Activity 

Perform the following steps to retire a group of reserved case numbers. 
 

1. Select [Case] > [Maintain Reserved Case Numbers]. 
Result: The Maintain Reserved Case Numbers screen displays. 
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2. Click the checkboxes for the reserved number groups to retire. 
3. Click the [Retire] button. 

Result: The screen refreshes but continues to display the retired group in the reserved number 
list. However, this group of numbers is now marked as unavailable for future case assignment. 

 
 

 

4. Click the checkboxes for the retired number groups to remove from the screen list. 
5. Click the [Remove From List] button. 

Result: The screen refreshes and no longer displays the selected retired group(s). 
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Related Links 

Maintain Case Numbers Overview 

Maintain Reserved Case Numbers Screen 

 

Manage E-Filings 

Manage E-Filings Overview  

 

Introduction 

Accepting an e-filing is a two-step process. In the first step, you will either initiate a case and record a 
payment (if the filing is related to a new case) or add a filing and record a payment (if the filing is for an 
existing case). You may not necessarily record a payment when initiating cases and adding filings. 
Situations involving fee waivers, government filings, and no-fee documents may not require the recording 
of a payment. In the second step, you will build and send an e-filing acceptance notice. 

E-filing task activities for initiating a case, adding a filing, and recording a payment are similar to the non-
e-filing process with the following exceptions: 

• You must record a payment immediately after initiating a case or adding a filing if fees are due. 
You cannot postpone this action like you can during the standard initiate case or add filing 
actions. 
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• The Case Initiation and Add Filing screens have additional functionality to: 
• Display links to view documents associated with e-filing 
• Enable you to reject the e-filing 
• Enable you to reject individual documents attached to the e-filing (Initiate Case only) 

Task Activities 

E-filing includes the following task activities: 

• Reject an E-Filing 
• Accept an E-Filing 
• Build and Send an Acceptance Notice 
• View E-Filing Log 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Background Information 

 

 

Related Links 

Review XML Data and Documents Screen 

Reject E-Filing Screen 

View Log File - Search Screen 

 

My Court Information 

 

Reject an E-Filing 

 

Introduction 

This task activity provides information about rejecting an e-filing. 

Task Activity 

Perform the following steps to reject an e-filing. 
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays your work queues, in addition to the number of 
pending tasks, incomplete tasks and total number of tasks in each work queue. 
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2. Click the work queue name link of the e-filing work queue. 
Result: The Review XML Data and Documents screen displays. 

 
 

 

3. You can view the various documents attached to the e-filing by selecting them from the 
Additional Documents field. 
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4. Click the [Reject] button. 
Result: The Reject Filing screen displays. 

 
 

 

5. Select a case category for the first reason for rejection that you enter. 
6. Enter text related to the reason for rejection. 
7. Click the [Add Another Reason] button to add more rejection reasons. 
8. Click the [View Rejection Notice] button to view a ".pdf" copy of the rejection notice to be sent. 
9. Click the [Save] button. 

 

 

Related Links 

Manage E-Filings Overview 

Work Queue List Screen 

Review XML Data and Documents Screen 

Reject an E-Filing Screen 

 

My Court Information 

 

Accept an E-Filing 
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Introduction 

This task activity provides information about the first step in accepting an e-filing during the case initiation, 
add a filing, and record payment activities, if appropriate. 

You can view e-filing documents and reject the entire e-filing from any screens associated with this 
process. You can also reject a single document while still accepting the e-filing in the Initiate Case 
screen. Refer to the Build and Send an E-Filing Acceptance Notice task activity for more information. 

Task Activity 

Perform the following steps to accept an e-filing. 
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays your work queues in addition to the number of 
pending tasks, incomplete tasks and total number of tasks in each work queue. 

 
 

 

2. Click the [e-Filing Review] link. 
Result: The e-Filing Review Work Queue screen displays. 
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3. Select the [Radio Button] to the left of the e-filing you want to process.  
4. Click the [Save] button. 

Result: The Review XML Data and Documents screen displays. 
 You can view other documents by selecting them from the Additional Documents field. 



Printed Documentation 

132 

 
 

 

5. Click the [Proceed] button. 
Result: The Initiate Case screen displays. 
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OR 

Result: The Add Filing screen displays. 
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 Refer to the Case Initiation and Add Filings sections for details on these topics. 

6. If you are initiating a case, select the statuses of the attached documents. 
 Selecting document statuses is applicable only when you are initiating a case. 

7. To view the attached documents, click the [Associated Document Title] link. 
8. To reject the entire e-Filing, click the [Reject] button. 
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9. When you are finished initiating a case or adding a filing click the [Next] button or [Save] button, 
respectively. 
Result: The Record Payment screen displays, if fees are due for the associated filing. If not, skip 
to step 10.  

 
 

 

 When you are initiating a case, a second screen displays before the Record Payment 
screen that enables you to finish the case initiation process. Refer to the Initiate Cases section 
for more information about task activities that take place in the case initiation screens.  

 Refer to the Record Payment task activity for details about recording payments. 

10. To view the attached documents, click the associated Document Title link. 
11. To reject the whole e-filing, click the [Reject] button. 
12. When you are finished recording payments, click the [Save] button. 
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Related Links 

Manage E-Filings Overview 

Review XML Data and Documents Screen 

Initiate Case Screen 

Add Filing Screen 

Record Payment/Trust Deposit Screen 

 

My Court Information 

 

Build and Send an E-Filing Acceptance Notice 

 

Introduction 

This task activity provides information about how to build and send an e-filing acceptance notice. This is 
the second step in accepting an e-filing. 

Initiating the Screen 

You can initiate the screen associated with this task activity from one of two locations: 

• From a work queue 
• Within the context of a case 

 

 

You can initiate this task by opening your Review E-filing work queue and selecting the e-filing that you 
want to work on. The e-filing must be in a Task Status of "In-Progress." Refer to the Accept an E-Filing 
task activity for details. 

This task activity assumes that you are accessing this screen within the context of a case.  

Attach Documents to the Acceptance Notice 

When you build an e-filing acceptance notice, you have a number of options related to attaching e-filing 
documents. You can: 

• Attach the documents that were received with the e-filing. 
• Download and update documents that were received with the e-filing and attach the updated 

versions of the documents. 
• Attach other documents that were not received with the e-filing. 
• Attach no documents. 



The Case Section 

137 

Task Activity 

This task activity takes place within the context of a case. Refer to the Search Cases task activity for 
details about performing a case search. 

Perform the following steps to build and send an e-filing acceptance notice.  
 

1. Select the [Accept E-Filings] left navigation item. 
Result: The Accept E-Filing screen displays the e-filings associated with the selected case. 

 
 

 

2. Select the radio button for the e-filing that you want to accept. 
Result: The screen refreshes and displays the documents associated with the e-filing. 
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3. To leave a document unattached to the acceptance notice, make sure the associated checkbox is 
empty. 

4. To attach a document to the acceptance notice, select the [Attached to Acceptance] checkbox. 
5. To download, update, and attach a new version of a document: 

• Click the Document Name link under the E-Filing Attachments section. 
Result:  The document opens in ".pdf" format. 

• Save the file to your local computer, open in Adobe Acrobat, and make any necessary 
changes, such as the applying a file stamp. 

• Once the changes are complete, select the [Upload] button to search for and import your 
updated document into the system.   

• If the corresponding E-filing Attachment radio button is selected, the uploaded file will 
replace the original e-filing attachment as the document attached to the acceptance 
message. 

• If the additional attachment checkbox is checked, the uploaded file will be included in the 
acceptance message as an attachment but will not be stored to the DMS. 

 

6. To attach a document that was not sent with the e-filing: 

• Click the [Browse] button. 
• Find and open the document using the Windows Explorer functionality. 

Result: The document name displays in the Additional Documents section. 
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• Select the associated check box. 
 

7. Click the [Send Acceptance] button. 
 

 

Related Links 

Manage E-Filings Overview 

Accept an E-Filing Screen 

 

My Court Information 

 

View the E-Filing Log 

 

Introduction 

This task activity enables you to view a log of all e-filing transactions. 

Task Activity 

Perform the following steps to view the e-filing log. 
 

1. Select [Admin] > [E-Filing Administration]. 
Result: The View Log File - Search screen displays. 

2. Enter search criteria, as appropriate.  
3. Click the [Search] Button. 

Result: The View Log File - Search screen refreshes and displays results that match the search 
criteria. 
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Related Links 

Manage E-Filings Overview 

View Log File - Search Screen 

 

Maintain Case Filings 

Maintain Case Filings Overview  

 

Introduction 

Maintaining filings involves adding and updating case filings in the system.  

About Case Filings 

Filings always accompany a case. Participants rely on these "documents" to inform the Court of case-
related information, or to request some action from the Court. The list of available filings is configurable 
by court. 
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Attaching Documents 

If your Court has a Document Management System, you can attach and associate documents to case 
filings. By entering and/or scanning the document information, the system will associate the document 
with the selected filing type. 

You can also assign security to a document. Refer to the Secure Case Information section for details on 
this process. Refer to the Document Management System section for details on handling document 
images in the system. 

Selecting Affected Participants 

Only case participants (including interested parties) can submit filings on a case. When you enter the 
filing details, you must identify who filed the filing. This includes selecting the name of the participant(s) 
and their current roles on the case. You should also indicate whether this filing refers to another case 
participant. 

Adding New Case Participants 

You can only add participants to existing cases through the appropriate case filings. These can be filings 
as decided by the Court. 

You must search for an existing person/entity to add as a case participant. Selecting or creating this 
person/entity profile will then list this person/entity in the Participant field on the Add Filing screen. You 
must then assign a role to this new participant. 

Associating Participants in Batch 

The filing process allows you to associate the same role to multiple participants on a filing. This batch 
process associates the selected participants at the same time. 

Choosing the batch option will display a list of the participants and their assigned roles on the case. You 
have the option of filtering the participant roles to quickly select the desired participants. The system may 
list a participant multiple times if the participant has held more than one role on the case. 

You must choose the role that the selected participants will have in relation to the filing. 

Selecting Filing Attributes 

The filing attributes depend on the case and the selected filing type. You may mark the attributes that are 
appropriate to the filing, participant, and case situation. 

Associating Entries 

Filings usually relate to another filing or Case History entry. As a result, you can associate case filings to 
the Case History entry for another filing, if such a relationship is necessary. For example, you may 
associate an answer to a complaint or an updated filing to the original filing [version]. 

However, this feature is not available during the case initiation process. This is because the first case 
filing will not have a relationship with another item. 

Associating Participants 

Participant associations exist through case filings. These associations only exist for the selected case and 
only involve the relationships between participants. However, you can also create and maintain 
participant associations through a participant profile. Refer to the Manage Case Participants section for 
details on this process. 
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Rejecting Filings 

You can reject a filing for various reasons. The system will display a list of "template" or generic reasons 
from which you may select. You may also choose to either add to the generic text or replace a selected 
reason with your own text. 

In order to reject a filing, you must select a filing status of "rejected." When you save the filing, the 
selected reasons will display on the generated "notice to filing party." 

Voiding Filings 

You can also void a filing, such as for non-payment of an NSF check for fees associated with the filing. 
You must select a filing status of "voided" in order for the system to vacate the calendar events if this is a 
causal document. Refer to the Maintain Calendar Events section for details on vacating events. 

Completing and Saving Filing Entries 

Before you save the filing to the case, you must indicate whether the filing entries are complete. Marking 
the filing as complete will record a Case History entry on the case. Then you can access and update the 
filing as necessary, or view the filing entry from the Case History. 

Saving the filing will produce different results, which depend on the filing type and the screen from where 
you started the filing process. Additional business processes may be required before the system 
considers the filing process as complete. For example, you may need to record a payment for the filing, 
schedule an event, or record a disposition. 

If you do not select the "Is Filing Data Entry Complete" option, then the system sends the case to the 
"Filings to be Completed" work queue for further processing. This work queue reminds you that the filing 
is missing data entries. You may then complete the filing at a later time. Refer to the Work Queues 
section for details on this work queue. 

Task Activities 

Maintaining filings includes the following task activities: 

• Add Case Filings 
• Update Case Filings 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Add Filing Screen 

Add Filing - Associate Participants in Batch Screen 
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My Court Information 

 

Add Case Filings 

 

Introduction 

Adding a case filing creates and associates a new filing on a case. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to add a filing. Refer to the Search Cases task activity for details on performing 
a case search. 

Perform the following steps to add a filing to a case. 
 

1. Select the [Add Filings] left navigation item. 
Result: The Add Filings screen displays with the Participants and Filers tab highlighted. 
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2. Enter/Select data for the following required fields: 
3. Filing Type 
4. Filing Date 
5. Filing Document 
6. Filing Status 

 The Filing Date defaults to the current date. 

Follow Steps 3-5 to attach a document to the filing, if your court uses a document management 
system. Otherwise, skip to Step 6. 

 

3. Click the toggle button for the Attach Documents - Generate Cover Page(s) section. 
Result: The Attach Document fields display. 
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4. Enter/Select data for the following DMS fields: 
5. Document Name 
6. DMS Document Key 
7. Document Security 

 A cover page will not be generated if you use a bar code scanner.  

5. Click the [Add Document] button. 
Result: The screen refreshes and displays the document information in a table. 

 The document is now associated with the filing. 
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6. Enter/Select data for the following required fields: 
7. Filed By 
8. Participant 
9. Role 

 You must select at least one value for each of the required fields. 

7. Enter/Select data for the other necessary fields. 
 Follow Steps 8-12 to search for an existing person/entity to add as a participant. 

8. Click the [Search for Existing Person/Entity] link. 
Result: The Person/Entity Search screen displays. 
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9. Enter/Select data into the necessary search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

10. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 
 

 

11. Select the radio button of the person/entity record to add to the filing. 
12. Click the [Select] button. 

Result: The Add Filing screen re-displays and lists the selected person/entity in the Participant 
field. 

 Follow Steps 13-17 to associate participants to the filing in batch. 
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13. Click the [Associate Participants in Batch] link. 
Result: The Add Filing - Associate Participants in Batch screen displays. 
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14. Select the necessary participant filter criteria. 
 This filter tool allows you to search for participants with specific roles on the case. 

15. Click the [Filter] button. 
Result: The screen refreshes and displays only those case participants that match the selected 
filter criteria. 
 
 

 

16. Select the checkboxes for the participants to associate with the filing. 
17. Click the [Save] button. 

Result: The Add Filing screen re-displays. The selected participants are now listed in the 
appropriate fields. 
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18. Click the [Filing Attributes] tab. 
Result: The Filing Attributes tab highlights. 

 These fields will be different depending on the selected case and filing type. 
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19. Enter/Select the necessary filing attributes. 
20. Click the [Associated Entries] tab. 

Result: The Associated Entries tab highlights. This tab contains a list of the Case History entries 
for the case. 

 This tab may not display if you are coming from certain processes, such as case initiation. 
 Follow Step 21 to associate this filing with ROA entries.  
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21. Click the [Associate] link for the ROA entry to associate with the filing. 
Result: The screen refreshes and displays the entry in the Associations section. 
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22. Click the [Associated Participants] tab. 
Result: The Associated Participants tab highlights. 

 Follow Steps 23-27 to create a participant association on the case. 
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23. Select the necessary participant filter criteria. 
 This filter tool allows you to display participants with specific roles within the All Case 

Participants list box.  
24. Click the [Filter] button. 

Result: The screen refreshes and displays only those case participants that match the selected 
filter criteria in the All Case Participants list box. 

 Repeat Steps 23-24 for the second participant list, if necessary.  
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25. Select the participants to which this association applies. 
 You must select at least one participant from each of the All Case Participants list boxes. 

26. Select the Association Type. 
 This association reads from the left hand section to the right. 

27. Click the [Apply] button. 
Result: The screen refreshes and displays the association in the Summary View section. 
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Follow Steps 28-29 to reject the filing. To do this, you must also select a value of Rejected for the Filing 
Status field. 
 

28. Click the toggle button for the Rejection Reasons section. 
Result: The Rejection Reason values display. 
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29. Select the appropriate rejection reasons. 
30. Click the [Save] button to save the new filing. 

Result: The Filing Confirmation screen displays. The system saves the filing and records a filing 
entry in the Case History. Depending on your configuration, a reject notice can be printed 
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manually or by the system. 
 The confirmation screen will be different depending on the selected filing type. The system 

may navigate you to another screen for further processing, such as if the filing type required a fee 
payment. Or if you came from another process, such as case initiation, you will be returned to 
that starting screen. 

 
 

 

 

 

Related Links 

Maintain Case Filings Overview 

Add Filing Screen 

Person/Entity Search Screen 

Add Filing - Associate Participants in Batch Screen 
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My Court Information 

 

Update Case Filings 

 

Introduction 

Updating a case filing changes the attributes for a specific filing on a case. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update a filing. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to update an existing filing on a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays.  

 This screen lists the activities that have occurred on the case. It also displays a list of the 
existing case filings. 
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2. Select the necessary filter criteria. 
 This filter tool allows you to search for specific entries on the case. 

3. Click the [Filter] button. 
Result: The screen refreshes and displays only those entries that match the selected filter criteria. 
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4. Click the [Filing Details] hyperlink for the filing entry to update. 
Result: The Add Filing screen displays with the filing data in the appropriate fields. 

 
 

 

5. Enter/Select data for the necessary fields. 
 Follow Steps 6-10 to search for an existing person/entity to add as a participant. 

6. Click the [Search for Existing Person/Entity] link. 
Result: The Person/Entity Search screen displays. 
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7. Enter/Select data into the necessary search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 
 

 

9. Select the radio button of the person/entity record to add to the filing. 
10. Click the [Select] button. 

Result: The Add Filing screen re-displays and lists the selected person/entity in the Participant 
field. 

 Follow Steps 11-15 to associate participants to the filing in batch. 
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11. Click the [Associate Participants in Batch] link. 
Result: The Add Filing - Associate Participants in Batch screen displays. 
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12. Select the necessary participant filter criteria. 
 This filter tool allows you to search for participants with specific roles on the case.  

13. Click the [Filter] button. 
Result: The screen refreshes and displays only those case participants that match the selected 
filter criteria. 
 
 

 

14. Select the checkboxes for the participants to associate with the filing. 
15. Click the [Save] button. 

Result: The Add Filing screen re-displays. The selected participants are now listed in the 
appropriate fields. 
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16. Click the [Filing Attributes] tab. 
Result: The Filing Attributes tab highlights. 

 These fields will be different depending on the selected case and filing type. 
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17. Enter/Select the necessary filing attributes. 
18. Click the [Associated Entries] tab. 

Result: The Associated Entries tab highlights. This tab contains a list of the Case History entries 
for the case. 
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19. Click the [Associate] link for the ROA entry to associate with the filing. 
Result: The screen refreshes. The entry now displays in the Associations section. 
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20. Click the [Associated Participants] tab. 
Result: The Associated Participants tab highlights. 

 Follow Steps 21-25 to create a participant association on the case. 
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21. Select the necessary participant filter criteria. 
 This filter tool allows you to display participants with specific roles within the All Case 

Participants list box.  
22. Click the [Filter] button. 

Result: The screen refreshes and displays only those case participants that match the selected 
filter criteria in the All Case Participants list box. 

 Repeat Steps 21-22 for the second participant list, if necessary.  
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23. Select the participants to which this association applies. 
 You must select at least one participant from each of the All Case Participants list boxes. 

24. Select the Association Type. 
 This association reads from the left hand section to the right. 

25. Click the [Apply] button. 
Result: The screen refreshes and displays the association in the Summary View section. 
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26. Select the appropriate rejection reasons. 
 You must have selected a filing status of Rejected. 

27. Click the [Save] button. 
Result: The Filing Confirmation screen displays. The system creates an entry indicating the 
update filing event. 

 The confirmation screen will be different depending on the selected filing type. The system 
may navigate you to another screen for further processing, such as if the filing type required a fee 
payment.  
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Related Links 

Maintain Case Filings Overview 

Case History Screen 

Add Filing Screen 

Person/Entity Search Screen 

Add Filing - Associate Participants in Batch Screen 
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Maintain Case Information 

Maintain Case Information Overview  

 

Introduction 

Maintaining case information involves searching for and updating existing case information. Case 
attributes are defined from the case initiation process and other case management activities. 

Updating Case Information 

The following activities focus on updating the attributes or details of a case. These details are specific to 
the selected case category and case type. Certain updates to these values may require other case 
adjustments, such as updating appropriate fees and/or automatic case clocks. Refer to the Business 
Rules for details on the types of adjustments required for specific updates. 

However, performing other case-related activities, such as managing blocked accounts or reclassifying 
cases, will also affect certain case details. As a result, this activity extends to the other task activities that 
occur within the context of a case. 

Activities Performed Prior to Accessing Case Information 

You must conduct a case search in order to select the case on which to update case attributes.  

Task Activities 

Maintaining case information includes the following task activities: 

• Search Cases 
• Update Case Details 
• View Filing Summary 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Case Attributes Matrix  

(This is a list of the case fields that will display based on the selected case type.) 
• Case Categories and Types Matrix 

(This is a list of the available case categories and case types in the system.) 
 

 

Related Links 

Case Search Screen 

Case Summary Screen 

Case Details Screen 

 



Printed Documentation 

176 

My Court Information 

 

Search Cases 

 

Introduction 

Searching for a case searches and displays cases that currently exist in the system.  

Case Search Functionality 

The system performs a search based on field parameters that you provide. Only cases that match the 
entered search criteria will display in the results list. Refer to the Initiate Cases section for details on 
creating cases in the system.  

You must provide data for at least one primary search field or two secondary search fields in order for the 
search utility to function. Providing other parameter data helps to narrow the search results and increases 
the likelihood of finding a closer match. Refer to the Search Feature Overview for details on performing a 
search in the system. 

Secured cases are only viewable (or searchable) with the appropriate security role. 

Using the Search Results 

The search function also provides the foundation for maintaining case information. For example, you must 
perform a case search in order to access a specific case.  

Selecting the Case Number link from the search results displays the Case Summary screen for that case. 
However, selecting an archived case will instead display the Archival Details screen. 

Performing a Quick Case Search 

The Case Select utility in the screen header allows you to quickly access a case. You can use this feature 
if you know the case number you want to access. Refer to the Search Feature Overview and the About 
Case Select section for details on performing this type of case search. 

Task Activity 

Perform the following steps to search for a case. 
 

1. Select [Case] > [Case Search]. 
Result: The Case Search screen displays. 
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2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 
 The Search Results will return 50 rows per page and a maximum of 250 rows for the entire 

search. 
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4. Click the Case Number link to display the case summary information for a case. 
Result: The Case Summary screen displays. 

 If you select an archived case, then the Archival Details screen will display. 

 
 

 

 

 

Related Links 

Maintain Case Information Overview 

Case Search Screen 

Case Summary Screen 

 

My Court Information 
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Update Case Details 

 

Introduction 

Updating case details changes the attributes of an existing case. This activity allows you to add or edit the 
information used to define a specific case in the system. 

You must have a Supervisor access or above to access and modify case details. 

If you set the security of the case to a level higher than your own, then the system will display a 
confirmation message and log you out of the case. You will not have the rights to access this case in the 
future. 

Viewing Case Icons 

Some cases display one or more icons in the case header. The purpose of these icons is to alert you to 
certain case attributes or events. Courts typically consider these items as important or helpful. Refer to 
the List of Icons section for a description of the case icons. 

Updating Case Header Information 

You can update certain details located within the case header. For example, you can change the case 
security level, case title, case type, case status or location. 

However, many of these details display as read-only fields. You can change some of these values 
through other case management activities, such as reclassifying a case to change the case category or 
reassigning a resource to change the Judicial Officer/Department assigned to the case. Other values 
depend entirely on system processes. 

Updating Case Initiation Information 

You may also update the values collected from the case initiation process. These fields are specific to the 
selected case category and case type. Editing these fields may require other case adjustments. Refer to 
the Case Attributes Matrix for details on these fields. 

Updating Additional Information 

The Case Details screen will also display the existing association types for the case. While this activity 
does not allow you to consolidate or relate this case, you can coordinate an out-of-county case. This 
coordination can only occur if the selected case is a JCCP case that already belongs to a coordinated 
group. Refer to the Coordinate Cases section for details on these coordination processes. 

You can also add or remove external cross reference numbers with the case. These numbers represent 
cases that do not currently reside within the Court system, but may be relevant to the active case.  

Validating the Case Details 

The system will check your case attribute updates for accuracy and compatibility. For example, if you 
classify a case as a Complex Case, then the system will check whether the resource assigned to the 
case can hear class action cases. Other case updates may result in the adjustment of fees and/or 
automatic case clocks. Refer to the Business Rules for a list of the system validations performed when 
updating case details. 
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Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update attributes. Refer to the Search Cases task activity for details on 
performing this search. 

Perform the following steps to update the details of a case. 
 

1. Select the [Case Details] left navigation item. 
Result: The Case Details screen displays. 

 
 

 

2. Edit/Update the available fields as needed. 
 The fields on this screen will be different depending on the selected case category and case 

type. The active tab will also be different for JCCP and legacy cases. 
3. Click the [Additional Information] tab. 

Result: The Additional Information tab highlights and displays the available case associations. 
 Associations will only display if the case has been consolidated, coordinated or related at 
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an earlier time. Refer to the Coordinate Out-of-County Cases task activity for details on 
performing this type of coordination. 

 
 

 

4. Enter an external cross-reference number, if necessary. 
 Follow Steps 5-6 to remove an existing cross-reference number from the case. 

5. Select the checkboxes for the external cross-reference numbers to remove. 
6. Click the [Remove] button. 

Result: The screen refreshes and no longer displays the selected cross-reference numbers. 
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7. Click the [Save] button. 
Result: A pop-up message displays requesting confirmation. 

8. Click the [Yes] option to proceed with the changes. 
Result: The screen refreshes. The system saves the changes. 
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Related Links 

Maintain Case Information Overview 

Case Details Screen 

 

My Court Information 

 

View Filing Summary 

 

Introduction 

Displaying the Filing Summary screen shows a list of the case filings that require a disposition. 
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Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to view filing details. Refer to the Search Cases task activity for details on 
performing this search. 

Perform the following steps to display the Filing Summary for a case. 
 

1. Select the [Filing Summary] left navigation item. 
Result: The Filing Summary screen displays. 

 The following steps outline the possible activities that you may perform from this screen. 
These activities relate to the details of a specific filing document. 

 
 

 

2. Click a Filing Document link to view the filing details. 
Result: The Add Filing screen displays.  

 Refer to the Maintain Case Filings section for details on editing filing information. 
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3. Click the [Cancel] button to return to the Filing Summary screen. 
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4. Click a Status link to view the disposition status of a filing. 
 You can only view status for filings that have associated disposition information. 

Result: The Maintain Disposition - Details screen displays. 
 Refer to the Maintain Dispositions section for details on editing disposition details. 
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5. Click the [Cancel] button to return to the Filing Summary screen. 

 
 

 

6. Click a Filed By link to view a summary of the filing history. 
Result: The Filing Participant Summary pop-up screen displays. 

 
 

 

7. Click the [Close Window] button to return to the Filing Summary screen. 
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Related Links 

Maintain Case Information Overview 

Filing Summary Screen 

Add Filing Screen 

Maintain Disposition - Details Screen 

 

Maintain Case Notes 

Maintain Case Notes Overview  

 

Introduction 

Maintaining case notes involves adding, updating, and deleting notes within a case.  

Purpose of Case Notes 

You can use case notes to collect information about a case or to share case-specific comments with other 
personnel. Notes usually contain details of case events or court proceedings, a summary of observations, 
or other case related materials. 

Case Note Privileges 

Case notes are only viewable by court staff. However, the ability to access (view, add or edit) a case note 
depends on your security role.  

Case Note and Judicial Note Difference 

Selecting the “For Judicial Officers Only” attribute does not convert a case note into a Judicial Note. Refer 
to the Judicial Notes section for details on creating and updating Judicial Notes. 

Case Note Functionality 

Saving a case note records the name of the person who performed the last activity on that note. For 
example, the system saves your name when you create the note. When you change this note, the system 
will save your name during the last update. The date and time of these activities are also recorded. These 
items provide an audit trail for monitoring the case note entries. 

If there is at least one case note entered on the case, the system will display an icon on the case header. 
An additional icon will display if a note marked as “For Judicial Officers Only” exists on the case.  

The system does not record the Case History entries relating to case notes.  

Task Activities 

Maintaining case notes includes the following task activities: 

• Add Case Notes 
• Update Case Notes 
• Delete Case Notes 
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Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Case Notes Summary Screen 

Case Notes Details Screen 

 

My Court Information 

 

Add Case Notes 

 

Introduction 

Adding a case note creates a note that is attached to a case. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to add a note. Refer to the Search Cases task activity for details on performing a 
case search. 

Perform the following steps to create a case note. 
 

1. Select the [Case Notes] left navigation item. 
Result: The Case Notes Summary screen displays. 
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2. Click the [Create New] button. 
Result: The Case Note Details screen displays. The system automatically captures many of the 
case note details as read-only values. 
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3. Enter/Select data for the necessary fields. 
 You must enter data into the Notes field. 
 You must have the appropriate security role to mark a note as "For Judicial Officers Only." 

4. Click the [Save] button. 
Result: The Case Notes Summary screen re-displays with a confirmation message. 

 If the case note was selected as “For Judicial Officers Only,” then the note entry will display 
in the Judicial Officer Summary section. Otherwise, the note entry will display in the Case Notes 
Summary section. 

 
 

 

 

 

Related Links 

Maintain Case Notes Overview 

Case Notes Summary Screen 

Case Notes Details Screen 
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My Court Information 

 

Update Case Notes 

 

Introduction 

Updating a case note changes the details of a specific note on a case.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update a note. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to edit a case note. 
 

1. Select the [Case Notes] left navigation item. 
Result: The Case Notes Summary screen displays. 

 
 

 

2. Select the radio button for the note to update. 
 If you have the appropriate security access, you can view or update a note from the Judicial 

Officer Summary section. 
3. Click the [Update] button. 

Result: The Case Note Details screen displays. 
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4. Enter/Update data into the Notes field as needed. 
 These update feature allows you to add comments onto existing notes. 

5. Click the [Save] button. 
Result: The Case Notes Summary screen re-displays with a confirmation message. Details for 
the Last Update fields change to reflect the recently saved edits. 
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Related Links 

Maintain Case Notes Overview 

Case Notes Summary Screen 

Case Notes Details Screen 

 

My Court Information 

 

Delete Case Notes 

 

Introduction 

Deleting a case note removes the note from the case.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to delete a note. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to remove a case note from a case. 
 

1. Select the [Case Notes] left navigation item. 
Result: The Case Notes Summary screen displays. 
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2. Select the radio button for the note to delete. 
3. Click the [Delete] button. 

Result: The Case Notes Summary screen refreshes with a confirmation message. The previously 
selected case note no longer displays. 
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Related Links 

Maintain Case Notes Overview 

Case Notes Summary Screen 

 

Secure Case Information 

Secure Case Information Overview  

 

Introduction 

Securing case information restricts your access to certain cases or case data.  

Case information may need security assigned due to sensitive or private case information. If such 
information exists, then a Judicial Order will outline the item(s) to secure. The Order will also specify what 
security access is required to view that data. 

This overview focuses only on case level security. However, data security is closely related to role based 
security, which defines the functions or activities that you can perform in the system. Refer to the Data 
Access Overview section for details on role based security. 

Refer to the Manage Person/Entity Information section for details on securing person/entity profiles. 

Case Data Security 

You can choose data security levels that are higher than your assigned security role. However, you must 
have the same security level as the case data (or higher) to access a secured case. For example, with a 
security role of "3" you can assign a security level of "5" to a case. But after saving this setting, you would 
no longer have access to the case. You could only view the case information when you have with a 
security role of "5" or higher. 

Refer to the Data Access Overview section for details on security settings. 

Applying Security 

You can secure case information during the life of a case. Once you save a case security attribute, the 
system will check your security profile. It will then determine what type of access you have with the newly 
secured data. Depending on your role, the secure case data will be hidden, masked, or displayed. 

You can apply security levels to Case History entries, participant information, and/or an entire case.  

Task Activities 

Securing case information includes the following task activities: 

• Secure Cases 
• Secure Case History Entries 
• Secure Participant Information 
• Secure Documents and DMS Images 
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Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

 

 

My Court Information 

 

Secure Cases 

 

Introduction 

Securing an entire case defines a case-wide security level, so that you must have the appropriate security 
role to access the case data.  

Case contents inherit the security level of the case unless an Order had previously secured them. This 
allows contents to keep their individual security settings even if case security is removed at a later time. 

Refer to the Security Related Deliverable for more details on the security data filtering. 

Viewing Secured Cases 

Secured cases do not display when your security roles are lower than the assigned case setting. As a 
result, you will not know that the case exists.  

Some system screens (such as those for Accounting and Calendaring) allow you to view some case data 
so that you can complete the business operations associated with those screens. However, the system 
does not allow you to access the entire case. 

The system will display case image icons to you, but will disable them when you do not have access to 
view secured case information. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case to secure. Refer to the Search Cases task activity for details on performing a case search. 
Refer to the Initiate Cases section for details on adding security to a new case. 

Perform the following steps to add security to an existing case. 
 

1. Select the [Case Details] left navigation item. 
Result: The Case Details screen displays. 
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2. Select a value from the Security Level drop-down list. 
 This will be the security level setting assigned to the case and its contents. 

3. Click the [Save] button to save this security attribute to the case. 
Result: The screen refreshes and displays a confirmation message. You must have the 
appropriate security role now to access this case. 
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Related Links 

Secure Case Information Overview 

Case Details Screen 

 

My Court Information 

 

Secure Case History Entries 
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Introduction 

Securing Case History entries marks these entries as confidential. Case History entries usually inherit the 
security level of the case in which they reside. However, setting a Case History entry with a higher 
security level than the case will hide this entry from those with lower security levels. This means that 
although you can access a secured case, you may not have access to a secured Case History entry. 

Viewing Secured Case History Entries 

You can only view secured Case History entries when you have the appropriate security role.   

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to secure an existing Case History entry. Refer to the Search Cases task activity 
for details on performing a case search. Refer to the Manage Action Entries section for details on adding 
security to a new Case History entry. 

Perform the following steps to secure an existing Case History entry. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays. 



The Case Section 

201 



Printed Documentation 

202 

 

 

2. Click the [Short/Long Entry] link of the Case History entry to secure. 
Result: The Case History – Add Entry screen displays. 

 
 

 

3. Select a value from the Security Level drop-down list. 
 This will be the security level setting assigned to only this entry. 

4. Click the [Save] button to save this security attribute. 
Result: The screen refreshes and displays a confirmation message. Now you must have the 
appropriate security role to view this entry. 

 

 

Related Links 

Secure Case Information Overview 

Case History Screen 
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Case History - Add Entry Screen 

 

My Court Information 

 

Secure Participant Information 

 

Introduction 

You can secure case participant information or just the participant addresses in the system. Securing 
participant information only secures participant data that resides within the selected case. It does not 
secure the participant's Person/Entity record. Refer to the Manage Person/Entity Information section for 
details on securing person/entity profiles outside of a case. 

Secured participant information becomes masked to you when you do not have security access to that 
data. Masked data shows X's in place of secure case information.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to secure participant information. Refer to the Search Cases task activity for 
details on performing a case search. Refer to the Manage Case Participants section for details on 
searching for participants and maintaining participant profile information. 

Perform the following steps to secure case participant information.  
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays with the Case Participants tab active. 



Printed Documentation 

204 

 
 

 

2. Select the [Participant] link of the participant name that you want to secure. 
Result: The Participant Profile Information screen displays. 
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3. Select the [Mark as Secure] checkbox to secure the entire participant profile. 
 This step is optional. Upon saving, this profile will be masked (with X’s) when you do not 

have access to view this information. 
4. Select the [Secure] checkbox next to the address(es) and/or phone numbers to secure. 

 This step is optional. Upon saving, the selected contact information will be masked (with 
X's) when you do not have access to view this information. 

5. Click the [Save] button to save the security attribute(s) for this profile. 
Result: The screen refreshes and displays a confirmation message. Now you must have the 
appropriate security role to view the secured profile information.  
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Related Links 

Secure Case Information Overview 

Case Participants Screen 

Person/Entity Profile Screen 

 

My Court Information 
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Secure Documents and DMS Images 

 

Introduction 

Securing documents and DMS images marks these electronic entries as confidential. Refer to the 
Document Management System section for details on DMS processes. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case to secure documents and/or DMS images. Refer to the Search Cases task activity for 
details on performing a case search. 

Perform the following steps to secure a document or DMS image on a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays.  

 This screen lists the activities that have occurred on the case. It also displays a list of the 
existing case filings. 
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2. Select the necessary filter criteria. 
 This filter tool allows you to search for specific entries on the case. This is an optional 

feature. 
3. Click the [Filter] button. 

Result: The screen refreshes and displays only those entries that match the selected filter criteria. 

 
 

 

4. Click the [Filing Details] hyperlink for the filing entry to update. 
Result: The Add Filing screen displays with the filing data in the appropriate fields. 
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5. Click the toggle button for the Attach Documents - Generate Cover Page(s) section. 
Result: The Attach Document fields display. 
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6. Select the checkboxes for the DMS documents/images to secure. 
7. Select a security level from the Document Security drop-down list. 
8. Click the [Save] button. 

Result: The Filing Confirmation screen displays. You must have the appropriate security role now 
to view these documents/images. 

 

 

Related Links 
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Secure Case Information Overview 

Case History Screen 

Add Filing Screen 

 

Manage Case Participants 

Manage Case Participants Overview  

 

Introduction 

Managing case participants involves adding, updating, and/or removing case participants and their 
related profile data. 

About Case Participants 

A case participant is a person/entity who has a specific position or role to perform on a given case. For 
example, a participant may be a defendant, a minor, or an attorney. 

A participant profile record consists of both person/entity and case-related data. These profiles are 
basically the "case version" of their participant's person/entity profiles. This means that while participant 
profiles exist within the context of a case, changes to this data can affect its system-wide person/entity 
profile. Both profiles records are identified by the same CMS ID number. Refer to the Manage 
Person/Entity Information section for details on updating person/entity profiles. 

Adding Case Participants 

There are different ways to add participants to a case. Within the case initiation process, you can either 
directly enter a name into the case participant fields or select a person/entity record to add as a 
participant. Refer to the Initiate Cases section for details on these processes. 

Otherwise, you can only add participants to existing cases through the appropriate case filings. These 
may be filings as decided by the Court. The filing will prompt the system to create a participant on the 
case, which will also create a person/entity profile for the participant. This will occur even if a person/entity 
record for the same person/entity already exists in the system. Refer to the Maintain Case Filings for 
details on adding filings to a case. 

Activities Performed Prior to Managing Participants 

You must conduct a case search in order to select and access the participant profile to update, replace or 
remove. Refer to the Maintain Case Information section for details on performing this search. 

Managing Participant Associations 

Participants have case relationships with other participants on the case. These associations only exist 
within the case, and do not extend to other cases or system data. For example, there is an association 
between an attorney and a defendant.  

Since participant associations also exist within the context of a filing, most participant associations occur 
from the Add Filings screen. Refer to the Maintain Case Filings for details on this process. 

Managing Person/Entity Associations 
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Participant profiles also include associations with person/entities outside of the case. These associations 
describe a more “permanent” type of relationship than case participant associations. For example, they 
can define familial and employment relationships between person/entities, such as the relationship 
between an attorney and a law firm. These associations do not rely on a case to exist. Refer to the 
Manage Person/Entity Information section for details on creating and maintaining person/entity 
associations. 

Securing Participant Information 

You may choose to secure case participant addresses or entire participant profiles. This security only 
affects the data that resides within the selected case and does not secure the related person/entity 
profile. Refer to the Secure Case Information section for details on securing participant data. 

Task Activities 

Managing case participants includes the following task activities: 

• Create New and Replace Case Participants 
• Update Case Participant Profiles 
• Remove Participants from Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Case Participants Screen 

Case Selection - Propagate Contact Information Change Screen 

 

My Court Information 

 

Update Case Participant Profiles 

 

Introduction 

Updating a case participant changes the profile data for a specific person/entity. These changes affect 
data both inside and outside of a given case.  

Entering Participant Data 

Case participant profile contents come from their associated person/entity profile record. Depending on 
how the participant was added to the case, the profile may not contain data other than the participant 
name. 

Participant profiles do not require specific data entries. In other words, there are no required fields. 
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Providing General Information 

You may enter or edit the names and contact information related to a participant. Changes made to these 
fields will also update the person/entity profile for this participant. You can also select the names, 
addresses, phone numbers and email addresses to use for this case. 

Some field entries within the General Information tab are only available within the case. For example, 
fields such as “Fees Deferred” and “Is Minor” do not affect the person/entity profile for the participant, but 
may change system actions related to this case. 

You may also label a participant as a frequent filer, if necessary. Refer to the Manage Frequent Filers 
section for details on this type of assignment. 

Maintaining Participant Associations 

Participant associations exist through case filings. As a result, the appropriate filing creates and/or 
updates the associations within a participant profile. Refer to the Maintain Case Filings section for details 
on creating and maintaining participant associations within the context of a filing. 

You can also add associations from within the participant profile. These relationships exist only within the 
active case. To do this, you must search for and select the participant record to associate with the current 
[active] participant. 

You can also enter or change the start and end dates for participant associations within the profile. 
Providing an end date is useful when an association no longer exists within a given case. For example, if 
there ceases to be a relationship between a defendant and an attorney, then entering an end date for this 
association keeps a record of the attorney’s presence on the case. 

Maintaining Person/Entity Associations 

The participant profile also displays the person/entity associations that exist with this participant. These 
associations are external to cases. Refer to the Manage Person/Entity Information section for details on 
maintaining person/entity associations. 

You may remove a person/entity association within the participant profile. However, this process also 
deletes the association from the person/entity profile.  

Viewing Position Information 

Position types identify the Court resource roles that a person/entity may perform. The screen will display 
the position types assigned to the participant through its person/entity profile. However, since you are 
viewing this information in the context of a case, you can only assign position types that relate to the open 
case.  

Maintaining Additional Information 

You may also add or enter personal information about a participant. Some of the data helps to prepare 
Court staff in assisting the participant during Court proceedings. This information is optional and allows 
you to collect specific data to further identify the person/entity. 

Copying Changes to Other Cases 

Saving the participant profile updates certain person/entity profile data. If you entered or changed contact 
information for a participant who had at least one position type assigned, then you can choose to apply 
your updates to other active cases involving this person/entity. This option allows you to select the cases 
on which to copy these profile changes. 

Updating Case Resources and Interested Parties 
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Refer to the Manage Resource Assignments section for details on updating and maintaining resources 
assigned to the case. Refer to the Manage Interested Parties section for details on maintaining interested 
parties on the case. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update participant data. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to update a case participant profile. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. The case participants assigned to the case 
display in a list. 

 
 

 

2. Enter/Select data for the appropriate filter criteria. 
 This filter tool allows you to display participants based on their name or related roles. 

3. Click the [Filter] button. 
Result: The screen refreshes and only displays those participants that match the entered filter 
criteria. 
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4. Click the hyperlinked name of the participant to update. 
Result: The Participant Profile Information screen displays. 
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5. Enter/Update the available fields as needed. 
6. Click the [Associations] tab. 

Result: The Associations tab highlights and displays both participant and person/entity 
associations. 

 Follow Steps 7-10 to create a participant association. The participant to associate with must 
already exist on the case. 

 Follow Steps 11-12 to define or update the participant association details. 
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7. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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9. Select the radio button for the participant to associate. 
10. Click the [Select] button. 

Result: The screen refreshes and displays the participant in the Participant Associations section. 
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11. Select or update the Association Type for the participant association. 
12. Enter/Update the available fields as needed. 
13. Click the [Position Information] tab to add a participant position type to the profile. 

Result: The Position Information tab highlights. 



The Case Section 

221 

 
 

 

14. Select a position type value from the Add drop-down list. 
15. Click the [Add Position Type] button. 

Result: The screen refreshes and displays the position type and related fields. 
 Different fields will display depending on the selected position type. 

 
 

 

16. Edit/Update the available fields as needed. 
17. Click the [Additional Information] tab. 

Result: The Additional Information tab highlights. 
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18. Enter/Update the available fields as needed. 
19. Click the [Save] button to save the participant profile data. 

Result: The system navigates to the appropriate screen. 
1.  If you update the profile data and the participant profile does not have the assigned position 

types, then saving the profile will display the Case Participants screen with a confirmation 
message. 

 
 

 

2.  If you update the profile contact information and the participant profile has at least one 
position type assigned, then saving the profile will display the Case Selection – Propagate 
Contact Information Change screen. From this screen, you can choose to apply your updates to 
other active cases involving this person/entity. Follow the steps below to copy these changes to 
other participant profiles. 

20. Select the cases on which to apply the profile updates from the Case Selection – Propagate 
Contact Information Change screen. 
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21. Click the [Save] button. 
Result: The Person/Entity Search screen displays. The system copies the updated contact 
information from the active case to the selected cases. It also marks the appropriate items for 
case use within these cases. 

 
 

 

 

 

Related Links 

Manage Case Participants Overview 

Case Participants Screen 

Person/Entity Profile Screen 

Case Selection - Propagate Contact Information Change Screen 

Person/Entity Search Screen 

 

My Court Information 
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Create New and Replace Case Participants 

 

Introduction 

Using the "Create New and Replace" feature copies an existing participant record in order to create a new 
person/entity profile in the system. This new profile then replaces the original participant on the case. 

You may use this feature if the wrong person/entity record was assigned to a case. This usually occurs 
when two person/entities share similar names. You must have an Administrative security role to perform 
this activity. 

Creating a New Participant 

Choosing to "create new and replace" a case participant copies the participant profile data from the 
selected participant onto the new profile. For example, the system copies the case-specific information 
(such as case events, filings, and fees) that occurred since the participant was assigned to the case. 

The system also copies the person/entity data onto this new profile record, including the names and 
contact information belonging to the original participant. The system then identifies this record by its 
newly assigned CMS ID number. Refer to the Manage Person/Entity Information section for details on 
updating profile information. 

Saving and Replacing Participants 

Saving the new profile replaces the original participant on the case with the new person/entity. This 
process removes the original participant from the case but does not delete its person/entity record from 
the system. 

The system then maintains the case history and associations to case events through the new participant 
record.  

Transferring Fees 

If you replace a case participant who had paid at least one case related fee, then the system will 
automatically create a trust for the paid amount(s). This trust then transfers over to the newly created 
participant to give the person/entity credit for paying these monies. 

Updating Profiles 

This activity creates duplicate person/entity information in the system. While the CMS ID number for the 
profile keeps the record unique, the profile data still needs to be manually reviewed and updated to 
confirm accuracy. Refer to the Manage Person/Entity Information section for details on this process. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to create and replace a participant. Refer to the Search Cases task activity for 
details on performing a case search. 

Perform the following steps to create and replace a case participant. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. The case participants assigned to the case 
display in a list. 
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2. Enter/Select data for the appropriate filter criteria. 
 This filter tool allows you to display participants based on their name or related roles. 

3. Click the [Filter] button. 
Result: The screen refreshes and only displays those participants that match the entered filter 
criteria. 
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4. Select the radio button for the case participant to replace. 
5. Click the [Create New and Replace] button. 

Result: The screen refreshes and displays a new CMS ID number for the selected participant 
record. The system also creates a new participant (person/entity) profile for this record. 

 If the removed participant has paid fees, then an alert message will display indicating that a 
trust has been created for the amount of the paid fee(s). 
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Related Links 

Manage Case Participants Overview 

Case Participants Screen 

 

My Court Information 

 

Remove Participants from Cases 

 

Introduction 

Removing a case participant separates an existing participant from a given case. This deletes the 
association between the participant and the case so no future events occur on behalf of this participant. 



The Case Section 

229 

Removing Participant Profiles 

This activity only removes the participant profile from the case. It does not delete the person/entity record 
for the participant from the system.  

The case also keeps the Case History entries and events related to this participant, even after the 
removal. 

Participant Related Fees 

If you remove a case participant who had paid at least one case related fee, then the system will 
automatically create a trust for the paid amount(s). This allows the Court to reimburse the removed 
participant at a later time. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to remove a participant. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to remove a participant from a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. Case participants assigned to the case are 
displayed on a list. 
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2. Enter/Select data for the appropriate filter criteria. 
 This filter tool allows you to display participants based on their name or related roles. 

3. Click the [Filter] button. 
Result: The screen refreshes and only displays those participants that match the entered filter 
criteria. 

 
 

 

4. Select the radio button for the case participant to remove. 
5. Click the [Remove from Case] button. 

Result: A pop-up window displays requesting confirmation for the delete. 
6. Click the [Yes] button. 

Result: The screen refreshes with a confirmation message. The previously selected participant no 
longer displays. 

 If the removed participant has paid fees, then an alert message will display indicating that a 
trust has been created for the amount of the paid fee(s). 
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Related Links 

Manage Case Participants Overview 

Case Participants Screen 

 

Manage Case Resource Assignments 

My Court Information 

 

Add Judicial Officer/Department Resources to Cases 

 

Introduction 

Adding a Judicial Officer or department to a case assigns this resource to the case. 
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This activity allows you to create a new resource assignment on the case. You can also replace an 
existing Judicial Officer/department resource that may have been assigned during the case initiation 
process.  

Assignment Restrictions 

Use this activity to assign the following resource types: Judicial Officers, Departments, Probate Referees, 
Discovery Referees or Settlement Referees. 

Refer to the Add Court Resources to Cases task activity for details on assigning Court Appointed 
Attorney, Counsel for Incarcerated Person, Guardian ad Litem, Guardianship as Counsel for Minor, and 
Guardianship for Counsel as Parent resource types. 

Refer to the Add New ADR Resources to Cases task activity for details on assigning Arbitrators and 
Mediators. 

Changing the System Recommendation 

The system recommends a resource only if there is an available pre-configured rule. Refer to the 
Configure Case Assignment Rules section for details on creating resource rules.  

You may select a resource other than this proposed resource. However, if you choose to override this 
recommendation, there may be scheduling or recusal conflicts with the new selection. You must manually 
resolve these issues after the system saves the assignment. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to assign a Judicial Officer or department. Refer to the Search Cases task 
activity for details on performing a case search. 

Perform the following steps to add a Judicial Officer/department resource to a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Click the [Add New] button. 
Result: The Step 1: Select Resource Type screen displays.  
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4. Select data for the following required fields: 
4. Resource Type 
5. Start Date 

 

5. Click the [Next] button. 
Result:  The Step 3: Confirm Resource screen displays. 

 This screen skips to the third step in the Case Assignment Wizard. 
 Different fields will display depending upon the selected resource type. 
 A value will display in the Proposed Resource field only if there is a configured rule 

available.  
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6. Select an Assigned Resource, if necessary. 
 You may either accept or change this value. 

7. Enter/Select data for the other necessary fields. 
8. Click the [Finish & Save] button. 

Result: The Case Participants screen displays with a confirmation message. This new resource 
displays under the appropriate Position Type section. The system also generates a Notice of 
Assignment. 

 If you entered a future start date for a Judicial Officer/department resource, then its status 
will be "Pending" until this date is reached.  
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 

Step 1: Select Resource Type Screen 
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Step 3: Confirm Resource Screen 

 

My Court Information 

 

Add Court Resources to Cases 

 

Introduction 

Adding a Court resource to a case assigns this resource to the case.  

Assignment Restrictions 

Use this activity to assign the following resource types: Court Appointed Attorney, Counsel for 
Incarcerated Person, Guardian ad Litem, Guardianship as Counsel for Minor, and Guardianship as 
Counsel for Parent. 

Refer to the Add Judicial Officer/Department Resources to Cases task activity for details on assigning 
Judicial Officers, Departments, Probate Referees, Discovery Referees or Settlement Referees. 

Refer to the Add New ADR Resources to Cases task activity for details on assigning Arbitrators and 
Mediators. 

Changing the System Recommendation 

The system recommends a resource only if there is an available pre-configured rule. Refer to the 
Configure Case Assignment Rules section for details on creating resource rules.  

You may select a resource other than this proposed resource. However, if you choose to override this 
recommendation, there may be scheduling conflicts with the new selection. You must manually resolve 
these issues after the system saves the assignment. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to assign a Court resource. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to add a Court resource to a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Click the [Add New] button. 
Result: The Step 1: Select Resource Type screen displays.  
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4. Select data for the following required fields: 
5. Resource Type 
6. Assignment For 
7. Start Date 

 The Assignment For field may be a read-only value depending on the selected resource 
type. 

5. Click the [Next] button. 
Result:  The Step 2: Select Participants for Assignment screen displays. 
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6. Select the checkboxes for the participants to which this resource will be assigned. 
7. Select the checkboxes for the participant filings that will be affected. 

 This step is only available if the Assignment For value from the previous screen is "Filing." 
8. Click the [Next] button. 

Result:  The Step 3: Confirm Resource screen displays. 
 Different fields will display depending upon the selected resource type. 
 A value will display in the Proposed Resource field only if there is a configured rule 

available. 
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9. Select an Assigned Resource, if necessary. 
 You may either accept or change this value. 

10. Enter data for the other necessary fields. 
11. Click the [Finish & Save] button. 

Result: The Case Participants screen displays with a confirmation message. This new resource 
displays under the appropriate Position Type section. The system also generates a Notice of 
Assignment. 
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 

Step 1: Select Resource Type Screen 
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Step 2: Select Participants for Assignment Screen 

Step 3: Confirm Resource Screen 

 

My Court Information 

 

Add New ADR Resources to Cases 

 

Introduction 

Adding a new Arbitrator/Mediator resource to a case makes this resource available for assignment on the 
case. This activity assumes that there is a need to define a new Arbitration/Mediation (ADR) process for a 
case. 

Adding an Arbitrator/Mediator resource may or may not assign the resource to the case. This assignment 
depends on configured rules and your actions. However, you must add a resource in order to reserve its 
availability for the case. 

Defining the ADR Process 

Adding a new Arbitrator/Mediator resource allows you to define and maintain the Arbitration/Mediation 
process itself. For example, you can indicate the start date of the ADR process, the ADR hearing 
information, and whether it was court ordered. 

A case may have multiple Arbitration/Mediation processes occurring at the same time. The system allows 
you to manually maintain the status of each of these processes.  

Defining the Resource Assignment 

When adding an Arbitrator/Mediator resource, you must specify the start date and the case participants 
that are involved in this Arbitration/Mediation process. 

If there are configured assignment rules for the resource type, the system will propose resources in a 
short list that meets the case criteria. You may either accept or reject these resources. 

Viewing System Recommendations 

The system will suggest a new set of resources based on available configured assignment rules. If there 
are no rules for these resources, then the short list will be empty. Refer to the Configure Case 
Assignment Rules section for details on creating resource assignment rules. 

Rejecting ADR Resources from the Short List 

If you reject a resource from the short list, then the future short lists generated for this 
Arbitration/Mediation instance will not include this resource. Refer to the Generate New Short List task 
activity for details on creating a new short list. 

Searching for an ADR Resource 

The assignment wizard allows you to search for and add a resource that does not initially display in the 
short list. When you save this resource, the system will alert you about whether this resource has 
scheduling or assignment rule conflicts. 

Assigning an ADR Resource 
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The system assigns an Arbitrator/Mediator resource only when the resource status is set to "Assigned." 
Only one resource per ADR process may be assigned. 

If the short list contains only one name, then the system will automatically assign this resource to the 
case. Otherwise, the system will mark each resource as "Awaiting Assignment." You can either manually 
assign a resource at this point or have the system automatically assign one of these resources. Refer to 
the Auto Assign ADR Resources for details on allowing the system to automatically assign a resource.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to add an arbitrator/mediator resource. Refer to the Search Cases task activity 
for details on performing a case search. 

Perform the following steps to add a new arbitrator/mediator (process or resource) to a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 

 
 

 

3. Click the [Add New] button. 
Result: The Step 1: Select Resource Type screen displays.  
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4. Select data for the following required fields: 
5. Resource Type 
6. Assignment For 
7. Start Date 

 

5. Enter/Select data for the other necessary fields. 
 The fields listed within the ADR Hearing Information section help to define the ADR 

process. 
6. Click the [Next] button. 

Result: The Step 2: Select Participants for Assignment screen displays.  
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7. Select the checkboxes for the case participants that are involved in this ADR process. 
8. Click the [Next] button. 

Result: The Step 3: Confirm Resource screen displays.  
 Follow Steps 9-13 to add a name to the short list. 
 Follow Steps 14-15 to reject a resource name from the short list. 
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9. Click the [Search] button to search for a specific resource. 
Result: The  Person/Entity Search screen displays. The Position Type field defaults to the 
appropriate resource type. 
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10. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on this process. 

11. Click the [Search] button. 
Result: The screen refreshes to display the person/entity matches. 

 
 

 

12. Select the radio button for the person/entity to add to the short list. 
13. Click the [Select] button. 

Result: The Step 3: Confirm Resource screen re-displays with the selected name added to the 
short list.  
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14. Select the names to reject from the Short List of Arbitrators/Mediators. 
You can reject resources from this list, or change the status of a resource to "rejected." 

15. Click the [Remove] button. 
Result: The screen refreshes and no longer displays the selected names in the short list. 
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16. Click the [Finish & Save] button to add the resource(s) to the case. 
Result: The Case Participants screen displays with a confirmation message. The system lists the 
resource(s) under the appropriate position type and the Arbitrators are now "Awaiting 
Assignment." 
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Follow the steps listed below to assign one of the arbitrator/mediator resources that are "Awaiting 
Assignment." These steps assume that there is no resource currently assigned for the specified ADR 
process. 
 

1. Select Assigned from the Status field for the resource to assign. 
 This selection occurs from the Case Participants screen. 
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2. Click the [Save] button to save this resource assignment. 
Result: The screen refreshes with a confirmation message.  
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 

Step 1: Select Resource Type Screen 
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Step 2: Select Participants for Assignment Screen 

Step 3: Confirm Resource Screen 

Person/Entity Search Screen 

 

My Court Information 

 

Auto Assign ADR Resources 

 

Introduction 

Automatically assigning an Arbitrator/Mediator resource allows the system to randomly select and assign 
a resource for a given ADR process.  

Auto Assignment Restrictions 

This activity requires you to have already generated a short list for the ADR process. Within this process, 
there must be at least one resource with a status of "Awaiting Assignment" and no resources currently 
assigned. Refer to the Add New ADR Resources to Cases and Generate New Short List task activities for 
details. 

Selecting an Alternate 

If there is more than one resource with a status of "Awaiting Assignment," then the system may attempt to 
assign a backup or "Alternate" resource to the ADR process. This will only occur if the Court configured 
an assignment rule for this activity.  

If no rule exists, then you may manually select this alternate resource from the list of available resources.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to automatically assign an arbitrator/mediator resource. Refer to the Search 
Cases task activity for details on performing a case search. 

Perform the following steps to automatically assign an arbitrator/mediator resource to a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Click the [Auto Assign Resource] button to randomly assign a resource for an ADR process. 
Result: The screen refreshes and updates the status of one the resources to "Assigned."  
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 
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My Court Information 

 

Update Court Resource Assignments 

 

Introduction 

Updating a resource assignment changes the assignment data for a given resource. This activity allows 
you to update the resource type and/or the case status settings for an individual resource.  

About Resource Assignments 

Assignment updates focus on changing the details for an existing resource assignment. For example, you 
can change such items as the resource status, assignment reason and effective start/end dates. 

You may also change the certain assignment attributes for a given resource type. For instance, you can 
update the participants or filings associated with the resource. 

Resource updates only occur for the selected case. They do not affect the person/entity profile 
information for these resources. Updates also do not change how the system recommends the resource 
to the case. Refer to the Configure Case Assignment Rules section for details on configuring resource 
rules. 

Update Resource Restrictions 

Resource assignment updates depend on the resource type. For example, Judicial Officer and 
department assignments are the only types that you cannot be update without changing the resources’ 
profile information or pre-configured assignment rules.  

As a result, several of the update activities overlap with the reassigning of a resource to a case. Refer to 
the Reassign Judicial Officer/Department Resources task activity for details on updating judicial 
officer/department assignments. Refer to the Reassign Court Resources task activity for details on 
replacing a resource with a new resource. 

Applying Updates 

Updates to a resource assignment will apply to the case in only a go-forward basis. No past case data or 
events will change.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update a resource. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to update a case resource assignment. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 



The Case Section 

263 

 
 

 

3. Enter/Update the following fields as needed: 
4. Status 
5. Reason 

 

4. Click the [Save] button to save these changes. 
Result: The screen refreshes with a confirmation message.  



Printed Documentation 

264 

 
 

 

5. Click the [Edit] button for the resource type to update. 
Result: The Step 1: Select Resource Type screen displays.  

 Different fields will display in these screens depending on the selected resource type. 
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6. Edit/Update the available fields as needed. 
 Do not change the effective Start Date if it is some past event. 

7. Click the [Next] button. 
Result:  The Step 2: Select Participants for Assignment screen displays. 

 Some resource types will instead display the final screen of the wizard. Skip to Step 9 to 
display this screen. 
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8. Update data for the appropriate fields. 
9. Click the [Next] button. 

Result:  The Step 3: Confirm Resource screen displays. 
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10. Update data for the appropriate fields. 
The currently assigned resource displays in the Assigned Resource field. 

11. Click the [Finish & Save] button to save the updates to the position type. 
Result: The Case Participants screen displays with a confirmation message. 
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A rejected status cannot be assigned to the case. This status removes the possibility of this resource 
being assigned to the case. This is an update status, since the resource is not assigned at this point.  

 

 

Related Links 

Manage Resource Assignments Overview 
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Case Participants Screen 

Step 1: Select Resource Type Screen 

Step 2: Select Participants for Assignment Screen 

Step 3: Confirm Resource Screen 

 

My Court Information 

 

Reassign Judicial Officer/Department Resources 

 

Introduction 

Reassigning a Judicial Officer/department resource on a case replaces the existing case assignment with 
a new Judicial Officer/department. This new assignment takes place based on the effective start date of 
the new resource.  

Reassigning a Resource 

Resource reassignment allows you to replace an assignment with a new resource of the same resource 
type. For example, if you are reassigning a department on a case, then you must select a new 
department to replace this current assignment.  

The new resource options from which you may select do not include the current resource name or the 
previously assigned resources. 

Refer to the Reassign Resources in Batch task activity for details on reassigning Judicial 
Officer/department resources on multiple cases at the same time. 

Checking for Conflicts 

The system will check for the scheduling and/or recusal conflicts with this newly selected resource and 
the case. If the system finds a conflict, then it will display a warning message. You may choose to 
override this warning and proceed with the assignment, or you can select a different resource to assign. 

However, if you override the warning, then you must manually resolve this conflict after saving the 
reassignment. There are no work queues associated with single case reassignments. 

Saving the New Assignment 

Once the system saves the new resource assignment, it will expire the old resource on the specified start 
date and assign the new resource to the case. The system will also reassign the future calendar events 
scheduled after the start date of this new resource.  

A notice of reassignment will also generate to alert case participants of the new resource assignment. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to reassign a judicial officer/department resource. Refer to the Search Cases 
task activity for details on performing a case search. 

Perform the following steps to reassign a judicial officer/department resource on a case. 
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1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 

 
 

 

2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Click the [Reassign] button for the Judicial Officer/Department position type to reassign. 
Result: The Case Participants - Resource Reassignment screen displays. 



Printed Documentation 

272 

 
 

 

 

 

4. Enter/Select data for the following required fields: 
5. New Resource Name 
6. New Resource Date 
7. Reason 

 

5. Click the [Save] button. 
Result: The Case Participants screen displays with a confirmation message. The new resource 
assignment displays in the appropriate Position Type section. The system also generates a 
Notice of Reassignment on the specified start date. 

 The status of the new resource assignment depends on the start date. For example, if this 
is a future start date, then the new resource will have a status of "Pending" until this date occurs. 
Then the status updates to "Assigned."  
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 
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Case Participants - Resource Reassignment Screen 

 

My Court Information 

 

Reassign Court Resources 

 

Introduction 

Reassigning a resource on a case replaces an existing case resource with a new resource. This new 
assignment takes place based on the effective start date of the new resource.  

About Reassignments 

Reassignment for most court resource types follows the same steps as the resource assignment and 
resource update activities. To reassign a resource, you must choose a new resource of the same 
resource type. This new selection will disable the current case assignment based on the newly issued 
start date. 

For example, if the start date for the new resource begins today, then the system will issue an end date of 
yesterday for the old resource. Refer to the Add Court Resources to Cases task activity for more details 
on the assignment process.  

Reassignment Restrictions 

This activity focuses on reassigning most resource types. However, some resource types follow a 
different reassignment process. Refer to the Reassign Judicial Officer/Department Resources task activity 
for details on reassigning judicial officer or department resource types. Refer to the Generate New Short 
List task activity for details on reassigning arbitrator or mediator resource types. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to reassign a resource. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to reassign a case resource. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 



The Case Section 

275 

 
 

 

2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Click the [Edit] button for the resource type to reassign. 
Result: The Step 1: Select Resource Type screen displays.  

 Different fields will display in these screens depending on the selected resource type. 
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4. Edit/Update the available fields as needed. 
5. Click the [Next] button. 

Result: The Step 2: Select Participants for Assignment screen displays. 
 Some resource types will instead display the final screen of the wizard. Skip to Step 7 to 

display this screen. 
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6. Update data for the appropriate fields. 
7. Click the [Next] button. 

Result: The Step 3: Confirm Resource screen displays. 
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8. Select a new Assigned Resource for the case. 
9. Click the [Finish & Save] button. 

Result: The Case Participants screen displays with a confirmation message. The new resource 
assignment displays in the appropriate Position Type section. The system also generates a 
Notice of Reassignment on the specified start date. 
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 

Step 1: Select Resource Type Screen 
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Step 2: Select Participants for Assignment Screen 

Step 3: Confirm Resource Screen 

 

My Court Information 

 

Generate New ADR Short List 

 

Introduction 

Generating a new ADR short list prompts the system to recommend an Arbitrator/Mediator resource to 
assign to a case. 

Requesting a New Short List 

You may request a new short list if the parties on a case have rejected the ADR resources from the initial 
short list.  

Viewing System Recommendations 

The system will suggest a new set of resources based on available configured assignment rules. If there 
are no rules for these resources, then the short list will be empty. Refer to the Configure Case 
Assignment Rules section for details on creating resource assignment rules. 

In addition, the system will filter out the non-active (rejected, disposed or dismissed) resources from the 
list of assignable arbitrators/mediators. 

Checking for Conflicts 

The system performs additional checks to confirm that the recommended resources are assignable to the 
case. For example, you cannot generate a short list if there is an Arbitrator/Mediator resource (within an 
ADR process) with a status of "Assigned," "Alternate," or "Awaiting Assignment." 

Also, the short list will not contain resources that have exceeded their maximum work load limit or 
resources who are parties on the case. Refer to the Business Rules section for details on the short list 
restrictions. 

Rejecting ADR Resources from the Short List 

If you reject a resource from the short list, then the future short lists generated for this 
Arbitration/Mediation instance will not include this resource. 

Searching for an ADR Resource 

The assignment wizard allows you to search for and add a resource that does not initially display in the 
short list. When you save this resource, the system will alert you whether this resource has scheduling or 
assignment rule conflicts.   

Assigning an ADR Resource 

The system assigns an Arbitrator/Mediator resource only when the resource status is set to "Assigned." 
Only one resource per ADR process may be assigned. 
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If the short list contains only one name, then the system will automatically assign this resource to the 
case. Otherwise, the system will mark each resource as “Awaiting Assignment.” You can either manually 
assign a resource at this point or have the system automatically assign one of these resources. Refer to 
the Auto Assign ADR Resources for details on allowing the system to automatically assign a resource.   

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to generate a new short list. Refer to the Search Cases task activity for details 
on performing a case search. 

Perform the following steps to generate a new short list on a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 

 
 

 

2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Click the [Generate New Short List] button. 
Result: The Case Participants – Case Assignment/Step 3: Confirm Resource screen displays.  

 Follow Steps 4-8 to add a name to the short list. 
 Follow Steps 9-10 to reject a resource name from the short list. 



Printed Documentation 

284 

 
 

 

4. Click the [Search] button to search for a specific resource. 
Result: The Person/Entity Search screen displays. The Position Type field defaults to the 
appropriate resource type. 
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5. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on this process. 

6. Click the [Search] button. 
Result: The screen refreshes to display the person/entity matches. 

 
 

 

7. Select the radio button for the person/entity to add to the short list. 
8. Click the [Select] button. 

Result: The Case Participants – Case Assignment/Step 3: Confirm Resource screen re-displays 
with the selected name added to the short list.  
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9. Select the names to reject from the Short List of Arbitrators/Mediators. 
 You can reject resources from this list, or change the status of a resource to "rejected." 

10. Click the [Remove] button. 
Result: The screen refreshes and no longer displays the selected names in the short list. 

11. Click the [Finish & Save] button to add the resource(s) to the case. 
Result: The Case Participants screen displays with a confirmation message. The system lists the 
resource(s) under the appropriate position type. 



The Case Section 

287 

 
 

 

 

Follow the steps listed below to assign one of the arbitrator/mediator resources that are “Awaiting 
Assignment.” These steps assume that there is no resource currently assigned for the specified ADR 
process. 
 

1. Select Assigned from the Status field for the resource to assign. 
 This selection occurs from the Case Participants screen. 
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2. Click the [Save] button to save this resource assignment. 
Result: The screen refreshes with a confirmation message.  
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 

Step 3: Confirm Resource Screen 
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Person/Entity Search Screen 

 

My Court Information 

 

Reassign Resources in Batch 

 

Introduction 

Reassigning a resource in batch replaces the assigned resource on a group of cases with a new 
resource. This process allows you to reassign the same resource on multiple cases at the same time.  

Batch Restrictions 

This batch job is limited to only Judicial Officer and department resource types. 

In addition, this batch activity only occurs for reassignments on more than one case. Refer to the 
Reassign Judicial Officer/Department Resources and Reassign Court Resources task activities for details 
reassigning a resource on one case.  

Batch Resource Selections 

The newly selected resource may be a different resource type than the ones it is to replace. For example, 
a group of cases currently assigned to a mix of judicial officers and departments may be reassigned to a 
specific department.    

Batch Functionality 

The system schedules this batch job to run at night. If the new assignment is a Judicial Officer resource, 
then the system will check for recusal conflicts with the selected cases. When there are no conflicts, the 
resource statuses and start/end dates will update to reflect this reassignment, along with the future 
calendar events scheduled after this start date. The system will also generate the appropriate 
forms/notices announcing the reassignment for each case. 

However, if the system finds problems with the reassigned resource, it will record an entry in the "Cases 
with recusal conflicts during batch reassignment" work queue. You will need to resolve these issues 
before the Judicial Officer reassignment can take place on the individual cases. 

Task Activity 

This activity takes place within the context of a case search. Refer to the Search Cases task activity for 
details on performing a case search. 

Perform the following steps to reassign resources in batch. 
 

1. Select the checkboxes for the cases to reassign. 
 This selection occurs from the Case Search screen. 
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2. Click the [Reassign] button. 
Result: The Batch Resource Reassignment screen displays with the selected cases listed. 
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3. Enter/Select data for the following required fields: 
4. Assign To 
5. New Start Date 
6. Reason 

 

4. Click the [Save] button. 
Result: The Case Search Results screen re-displays with a confirmation message. 

 If the start date is in the future, the new resource will have a status of "Pending."  
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Related Links 

Manage Resource Assignments Overview 

Case Search Screen 

Batch Resource Reassignment Screen 

 

My Court Information 
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Remove Resources from Cases 

 

Introduction 

Removing a resource from a case ends the selected resource assignment with the case.  

This process only expires the resource from the selected case and does not delete the person/entity 
profile for the resource from the system. In other words, a removed resource is still available for 
assignment on other cases.  

Resource Removal Restrictions 

You may only remove resources that have a status of "Assigned" on a case. Removing an assigned 
resource changes the resource status to "Inactive." Other statuses (except for "Inactive") indicate that the 
resource is not yet assigned. These statuses may instead be "Rejected." 

You cannot change the status of the removed resource back to an "Active" or "Assigned" status on that 
particular case. However, you can assign the removed resource back to the case as a new resource. 

Resource Removal Functionality 

While there are two ways to remove a resource from a case, the resource type will determine the method 
to use. The first option is to reassign a resource, which replaces the existing assigned resource with a 
new resource. Judicial Officer and department resource types must use this option to be removed from a 
case. Refer to the Reassign Judicial Officer/Department Resources task activity within this chapter for 
details on the judicial officer/department reassignment process. 

The second option is to manually change the assigned resource status to "Inactive" on the case. Once 
you set a resource’s status to "Inactive," the will system enter an end date for this resource and remove it 
from the case. At that point, you may then assign a different resource to the case. 

The following task activity focuses on changing the status of resources to "inactive" in order to remove 
them from the case. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to remove a resource. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to remove a resource from a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Case Resources] tab. 
Result: The Case Resources tab highlights and displays the currently assigned case resources. 
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3. Select Inactive from the Status drop-down list for the resource to remove. 
4. Click the [Save] button. 

Result: The screen refreshes with a confirmation message. The removed resource now has a 
read-only status of "Inactive." The system also displays an end date for this resource. 
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Related Links 

Manage Resource Assignments Overview 

Case Participants Screen 
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Manage Interested Parties 

Manage Interested Parties Overview  

 

Introduction 

Managing interested parties involves adding, updating, and/or removing an interested party to or from a 
case. 

These activities only affect the association of the interested party on a case. They do not change the 
party’s person/entity profile record within the system. 

About Interested Parties 

An interested party is a person/entity that requests to be informed of case activities, usually through 
notices alerting them of scheduled case events. 

Interested parties do not have a position or role to perform on a case. As a result, these parties are not 
case participants or court resources. Examples of interested parties may include government agencies 
and insurance companies. 

Task Activities 

Managing interested parties includes the following task activities: 

• Add Interested Parties 
• Update Interested Parties 
• Remove Interested Parties 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Case Participants Screen 

 

My Court Information 

 

Add Interested Parties 

 

Introduction 

Adding an interested party to a case allows this party to monitor the progress of that case. 

Identifying an Interested Party 
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When a Judicial Order or statute identifies a specific person/entity as a legitimate interested party on a 
case, you can add them to the case. 

Selecting an Interested Party 

Assigning an interested party to a case requires that this party have a person/entity profile in the system. 
You must create a profile record for the party if one does not already exist. Otherwise, you may search for 
and select the person/entity to add as an interested party. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to add an interested party. Refer to the Search Cases task activity for details on 
performing a case search. 

This activity also assumes that the person/entity to select already exists in the system. Refer to the 
Manage Person/Entity Information section for details on adding a person/entity into the system. 

Perform the following steps to add an interested party to a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 
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2. Select the [Interested Parties] tab. 
Result: The Interested Parties tab highlights. 

 
 

 

3. Click the [Add New Interested Party] button. 
Result: The Person/Entity Search screen displays. 
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4. Enter/Select data into the necessary search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

5. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 
 

 

6. Select the radio button of the person/entity record to add as an interested party. 
7. Click the [Select] button. 

Result: The Case Participants screen re-displays and lists the selected person/entity CMS ID 
Number and name. 
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8. Enter an Effective Start Date for this interested party. 
 It is also recommended that you enter a Reason as to why you added this party to the 

case. 
9. Select the [Notice] checkbox to allow this party to receive case notices, if necessary. 

 The Order should reference whether or not this party is to receive case notices. This option 
will mark the party as a recipient on certain forms/notices. 

10. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Manage Interested Parties Overview 

Case Participants Screen 

Person/Entity Search Screen 

 

My Court Information 

 

Update Interested Parties 
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Introduction 

Updating an interested party changes the details of that person/entity on a given case. 

This activity only allows you to add or change the interested party reason and the effective start and end 
dates. However, it is recommended that you do not change the start date if it is some past date. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update an interested party. Refer to the Search Cases task activity for details 
on performing a case search. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 

 
 

 

2. Select the [Interested Parties] tab. 
Result: The Interested Parties tab highlights. 
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3. Enter/Update the available fields as needed. 
4. Click the [Save] button. 

Result: The screen refreshes with a confirmation message. 
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Related Links 

Manage Interested Parties Overview 

Case Participants Screen 

 

My Court Information 

 

Remove Interested Parties 

 

Introduction 



The Case Section 

307 

Removing an interested party from a case deletes the relationship with this party on the selected case. 
This activity does not delete the person/entity record for the interested party from the system. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to remove an interested party. Refer to the Search Cases task activity for details 
on performing a case search. 

Perform the following steps to remove an interested party from a case. 
 

1. Select the [Case Participants] left navigation item. 
Result: The Case Participants screen displays. 

 
 

 

2. Select the [Interested Parties] tab. 
Result: The Interested Parties tab highlights. 
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3. Select the checkboxes for the interested parties to remove from the case. 
4. Click the [Remove Interested Party] button. 

Result: The screen refreshes with a confirmation message. The previously selected party no 
longer displays. 
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Related Links 

Manage Interested Parties Overview 

Case Participants Screen 

 

Maintain Defaults 

Maintain Defaults Overview  

 

Introduction 
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You can enter, deny and vacate defaults against defendants and cross-defendants for a filing. The next 
sections of this overview will discuss:  

• When and why a default may be entered against a participant associated with a filing on a case 
• What will happen to a case participant when in default 
• When and how to deny or vacate a default 

Entering and Denying Defaults 

A default can be entered against a case participant if that case participant has a role of defendant or 
cross defendant for a filing. Entering a default against a case participant is performed when the case 
participant has failed to perform the duties required by Statute or the Court. A default must be entered 
against a defendant/cross-defendant before a Default Judgment can be entered. 

A default can be entered into the system as a result of a filing (such as the Request for Entry of Default) 
or through the recording Minutes from the Minute Capture Screen. A Register of Actions entry is created 
at the time of recording the default entry, which includes the names of the defaulted defendants/cross-
defendants. 

In some scenarios, when receiving the Request for Entry of Default filing from a case participant, you may 
determine that the Request for Entry of Default is invalid since the conditions for entering the default have 
not been met (see the "Conditions for Entering a Default" section below). In these scenarios, you may 
deny the default and provide a reason for the denial. 

Conditions for Entering a Default  

The Request for Entry of Default may be entered (otherwise it must be denied) against a defendant/cross-
defendant on a filing only if all of the following conditions have been satisfied:  

• A valid Proof of Service against the specific defendant being defaulted has been filed   
• The defendant has not filed an answer  
• A Summons must have been issued on the filing for which the participants are being defaulted 

(except in cases of amended complaints/cross-complaints) 
• A default cannot be entered on the original complaint/cross-complaint once an Amended 

complaint/cross-complaint has been filed 
• The system will verify if a motion, stipulation, or order to extend time has been filed or the 

selected defendant on the selected filing. For example, the system will verify whether the selected 
defendant has filed a demurrer on the selected filing. If one of these has occurred, then the 
system will display a warning message. The following Motions/Stipulations/Orders to extend time 
have been identified:  

o Demurrer 
o Motion to Dismiss pursuant to CCP 418.10 
o Motion to Quash Service of Summons 
o Motion to Strike 
o Motion to Transfer (CCP 396(b)) 
o Stipulation and Order to Extend Time to Plead 
o Writ of Mandate 

• The response time for an answer from the defendant has expired. The date for which you can 
enter the default will be calculated from the date of service that the individual defendant set forth 
in the Proof of Service as follows: 
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Type of Proof of Service When Default can be Entered * 

Proof of Service of 30-day Summons & Complaint – 
Personal 

31st day after date of service 

Proof of Service of 30-day Summons & Complaint – 
Substitute 

41st day after date of mailing 

Proof of Service of 5-day Summons & Complaint – Personal 6th day after date of service 

Proof of Service of 5-day Summons & Complaint – 
Substitute 

16th day after date of mailing 

Proof of Service of 5-day Summons & Complaint – All 
unknown occupants 

10th day after date of service  

Proof of Service of 10-day Summons & Complaint – 
Personal 

11th day after date of service 

Proof of Service of 10-day Summons & Complaint – 
Substitute 

21st day after date of mailing 

Proof of Service by Publication 59th day after 1st date of publication 

Proof of Service by Posting (non-Unlawful Detainer) 59th day after 1st date of posting 

Proof of Service by Posting and Mailing (Unlawful Detainer)  16th day after date of posting and mailing 

Proof of Service  - Certified Mail - Out of State 41st day after date of mailing 

Notice of Acknowledgement and Receipt 31st day after notice and acknowledgment signed 
 

*If the last day to respond is a Court Holiday or Weekend, then the time to respond is extended to the next Court Day. 

 

 

Entering a default for certain case types may involve additional conditions that must be satisfied, such as 
in the following scenarios: 

• For civil cases where a summons has been issued, the original Summons or Declaration and 
Order of Lost Summons must be filed and the time for responding has expired. 

• For Contract-Other cases, when the “Statement of Venue Required” flag is checked, then the 
Proof of Service of Statement of Venue must have been filed and the time for responding has 
expired. 

• For Personal Injury and Wrongful Death cases, when the default is entered on a Complaint or 
Cross-complaint, proof of service for statement of damages must have been filed and the time for 
responding has expired. 

Vacating Defaults 

You can vacate a previously entered default against a defendant/cross-defendant on a case. Vacating a 
default against a case participant may be performed if the defaulted case participant remedies the reason 
for default before a Default Judgment is entered on the filing. 

A default can be vacated as a result of a filing (such as an Order Setting Aside Default) or through the 
recording of Minutes from the Minute Capture screen. A Case History/Register of Actions entry is created 
at the time of recording the vacating of default, which includes the names of the defaulted 
defendants/cross-defendants. 

Task Activities 

Maintaining defaults includes the following task activities: 
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• Enter Default 
• Deny Default 
• Vacate Default 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Enter/Vacate Default Screen  

Deny/Override Default Screen 

Add Filing Screen 

 

My Court Information 

 

Enter Default 

 

Introduction 

A default can be entered against a case participant if that case participant has a role of defendant or 
cross defendant for a filing. Entering a default against a case participant is performed when the case 
participant has failed to perform the duties required by the Court. A default must be entered against a 
defendant/cross-defendant before a Default Judgment can be entered. 

A default can be entered into the system as a result of a filing or through the recording of Minutes from 
the Minute Capture screen.  

Before Entering a Default 

Refer to the Maintain Defaults Overview for an explanation of the conditions that must be met in order to 
enter a default against a case participant. You must be in the context of a case to perform this activity. 
Refer to the Search Cases task activity for details on performing a case search. 

Task Activity 

Perform the following steps to enter a default against a defendant/cross defendant. 
 

1. Select [Case] > [Add Filing]. 
Result: The Add Filing screen displays. 
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2. Enter/Select data for the following required fields: 

• Filing Type 
• Filing Date 
• Filing Document (select "Request for Entry of Default") 
• Filing Status 

 You must enter "Request for Entry of Default" for the filing document name in order to 
navigate to the enter/vacate default screen. Refer to the Maintain Case Filings section for 
details on adding a filing to a case. 

3. Click the [Save] button. 
Result: The Enter/Vacate Default screen displays. 
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4. Enter the date the 'Request for Entry of Default' was accepted from the case participant into the 
Date Default Entered/Vacated field. 

5. Select the toggle button next to the filing name for which you want to enter a default from the Pre-
Disposition tab.  

Result: The Enter/Vacate Default screen displays, with an expanded view of the defendants 
and cross-defendants for the selected filing. 
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6. Select the checkboxes for the case participant(s) that you will enter a default against.  
7. Click the [Enter Default] button. 

Result: The Deny/Override Default screen displays. 
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8. Select the toggle button next to the case participant to view the details regarding why the case 
participant is not eligible for default (none may exist).  

9. Result: The Deny/Override Default screen displays, with an expanded view of the reasons the 
case participant is ineligible for an entry of default. 
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10. Select the radio button for the participant you will enter a default against, under the "Deny" or 
"Override" column. 

 It is your choice as to whether or not to override any reasons against placing the case 
participant in default by selecting the radio button under the "Override" column. If you 
determine the Request for Entry of Default filing to be invalid based on the ineligibility of the 
case participant for an entry of default, then select the radio button under the "Deny" column. 
You may override the entry of default on one case participant and deny the entry of default on 
a separate case participant.  

10. Click the [Enter/Deny Default] button. 
Result: The Enter/Vacate Default screen displays with a confirmation message. 
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Related Links 

Maintain Defaults Overview 

Add Filing Screen 

Enter/Vacate Default Screen 

Deny/Override Default Screen 
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My Court Information 

 

Deny Default 

 

Introduction 

In some scenarios, when receiving the Request for Entry of Default from a case participant, you may 
determine that the Request for Entry of Default is invalid because the conditions for entering the Default 
have not been met. Refer to the "Conditions for Entering a Default" in the Maintain Defaults Overview. In 
these scenarios, you may choose to deny the default and provide a reason for denial.  

In other instances, you may continue with entering a default against a case participant, and the system 
will display a message as to why the default should not be entered. Refer to the Enter Default task activity 
for details on this process. 

Before Denying a Default 

You must be in the context of a case to perform this activity. Refer to the Search Cases task activity for 
details on performing a case search. 

Task Activity 

Perform the following steps to deny a default. 
 

1. Select [Case] > [Add Filing]. 
Result: The Add Filing screen displays. 
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2. Enter/Select data for the following required fields: 

• Filing Type 
• Filing Date 
• Filing Document 
• Filing Status 

 You must enter "Request for Entry of Default" for the filing document name in order to 
navigate to the enter/vacate default screen. Refer to the Maintain Case Filings section for 
details on adding a filing to a case. 

3. Click the [Save] button. 
Result: The Enter/Vacate Default screen displays. 
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4. Enter the date the "Request for Entry of Default" was accepted from the case participant into the 
Date Default Entered/Vacated textbox. 

5. Select the toggle button next to the filing name for which you want to deny a default from the Pre-
Disposition tab.  
Result: The Enter/Vacate Default screen displays, with an expanded view of the defendants and 
cross-defendants for the selected filing. 
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6. Select the checkboxes for the case participant(s) for which the default will be denied.  
 You can enter the reason for the denial of the entry of default into the Denial Reason 

textbox. The denial reason will be listed in the "Notice to Filing Party" form, which notices the 
list of participants related to the filing for which the entry of default was requested and then 
denied. 

 

7. Click the [Deny Default] button. 
Result: The Enter/Vacate Default screen displays with a confirmation message. Also, the "Notice 
to Filing Party" form is generated, which may be printed and mailed to the required case 
participants.  
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Related Links 

Maintain Defaults Overview 

Add Filing Screen 

Enter/Vacate Default Screen 

 

My Court Information 
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Vacate Default 

 

Introduction 

You can vacate a previously entered default against a defendant/cross-defendant on a case. Vacating a 
default against a case participant may be performed if the defaulted case participant remedies the reason 
for default before a Default Judgment is entered on the filing. 

A default can be vacated as a result of a filing or through the recording of Minutes from the Minute 
Capture screen.  

Before Vacating a Default 

You must be in the context of a case to perform this activity. Refer to the Search Cases task activity for 
details on performing a case search. 

Task Activity 

Perform the following steps to vacate a default. 
 

1. Select [Case] > [Add Filing]. 
Result: The Add Filing screen displays. 
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2. Enter/Select data for the following required fields: 

• Filing Type 
• Filing Date 
• Filing Document (select "Order Setting Aside Default") 
• Filing Status 

 You must enter "Order Setting Aside Default" for the filing document name in order to 
navigate to the enter/vacate default screen. Refer to the Maintain Case Filings section for 
details on adding a filing to a case. 

3. Click the [Save] button. 
Result: The Enter/Vacate Default screen displays. 
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4. Enter the date the "Order Setting Aside Default" was accepted from the case participant into the 
Date Default Entered/Vacated textbox. 

5. Select the toggle button next to the filing name for which you want to vacate a default from the 
Pre-Disposition tab.  

6. Result: The Enter/Vacate Default screen displays, with an expanded view of the defendants and 
cross-defendants for the selected filing. 
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7. Select the checkboxes for the case participant(s) for which a default will be vacated.  
8. Click the [Vacate Default] button. 
Result: The Enter/Vacate Default screen displays with a confirmation message. 
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Related Links 

Maintain Defaults Overview 

Add Filing Screen 

Enter/Vacate Default Screen 
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Maintain Fee Waiver Order 

Maintain Fee Waiver Order Overview  

 

Introduction 

Maintaining Fee Waiver Orders describes the process of recording an order on a fee waiver or fee waiver 
for additional fees when submitted by a case participant. Case participants can file a "Fee Waiver" 
application to reduce or entirely waive a their costs associated with a case. In addition, case participants 
may file an application for fee waiver specifically to cover subsequent fees that are assessed as the case 
progresses. A fee waiver order can be made by a clerk or a Judicial Officer. 

You can record a fee waiver order at the time of filing the fee waiver application. If you do not have the 
authority to grant the application, then the application will be sent to a work queue for review by a Judicial 
Officer. Once the Judicial Officer rules on the application, you can enter the order into the system. 

Once a ruling is made on the application, the applicable fee statuses will be updated. The fee waiver 
information will then be used when creating new fees for the fee waiver applicant. 

Granting and Denying Fee Waivers 

The application for fee waiver and waiver for additional fees can be: 

• Granted in Whole / by operation of law 
• Granted in Part 
• Denied in Part 
• Denied in Whole 

 

 

Fees that can be waived by the fee waiver are displayed based on the type of application, in order to 
waive the initial fees for the case or the additional fees for a case. 

If granted in part, you will have the ability to specify what has been granted to be waived. You also have 
the ability to specify whether the associated fees can be completely waived or if only a certain percentage 
of the fees can be waived. 

If denied in whole or part, you will have the ability to specify the reasons for denial. 

Fee Waiver Case Clocks 

If no order is made on the fee waiver application within five court days, then the fee waiver application will 
drop from the Judicial Officer's work queue and a task will be created in another work queue designed to 
grant the fee waiver by operation of law.  

When a fee waiver is denied, a ten-day case clock will be started for the payment of the fees associated 
with the fee waiver. If a payment is made, then the clock will be stopped. However, if the clock expires 
(since no payment is made), then the filings associated with the fees will be put into a work queue so that 
the filings can be voided.  

Scheduling Fee Waiver Events to Review Financial Status or Resolve Conflicts 

You or a Judicial Officer can determine that a hearing must be scheduled in order to resolve conflicts (if 
the application is granted in part or denied) or schedule a hearing to review the financial status of the 
applicant (if the application is granted). The Fee Waiver Order functionality supports the ability to 
schedule these hearings. 
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Impact of Fee Waiver Orders on Fees 

If a fee waiver is granted in whole or granted by operation of law for the application for fee waiver of court 
fees and costs, then the balance due of all fees with a status of "Pending Waiver" associated with the fee 
waiver applicant will be automatically adjusted to a fee amount of zero, and the fee status will be set to 
"Waived." 

If the fee waiver is granted in part and only a specific percentage of the fee amount has been waived, 
then the balance due for all fees with a status of "Pending Waiver" associated with the fee waiver 
applicant will be automatically adjusted to the new applicable amount and the fee status will be set to 
"Partially Waived." A "Partially Waived" status means that only a percentage of the fee amount is due. 

The status of the other fees not associated with the fee waiver will be set to "Due." If a fee waiver is 
denied, the fee status will be changed from "Pending Waiver" to "Due." 

You have the ability to create payment plans for fees that become "due" or that are "partially waived," 
based on the resulting fee waiver order. 

Task Activities 

Maintaining Fee Waiver Orders includes the following task activities: 

• Record Fee Waiver Order 
• Schedule Event to Review Financial Status-Resolve Conflict 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Record Fee Waiver Order Screen  

Maintain Fee Waiver Order Screen  

Add Filing Screen 

 

My Court Information 

 

Record Order on a Fee Waiver  

 

Introduction 

You record an order on a fee waiver at the time of filing the fee waiver application or as the result of a 
Judicial Officer's review. If you do not have the authority to grant the application, then the application will 
be sent to a work queue for review and the order will be generated by a Judicial Officer. Once the Judicial 
Officer rules on the application, you can enter the order into the system.  
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Before Recording an Order on a Fee Waiver 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case on which to record a fee waiver order. Refer to the Search Cases task 
activity for details on performing a case search. 

Task Activity 

Perform the following steps to record an order on a fee waiver application. 
 

1. Select [Case] > [Add Filing]. 
Result: The Add Filing screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Filing Type 
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• Filing Date 
• Filing Document (select "Fee Waiver Application" or "Application to Waive Additional 

Fees") 
• Filing Status 

 The document must be a "Fee Waiver Application" or an "Application to Waive Additional 
Fees and Court Costs" in order to record an order on the fee waiver. 

3. Select the [Filing Attributes] tab. 
Result: The Filing Attributes tab highlights and displays the appropriate information.  

 
 

 

4. Select the radio button for a reason the applicant is eligible for an order to waive fees. 
5. Select the radio button for the "Record Order" option if you want to record the fee waiver 

immediately following the acceptance of the filing. Otherwise, select the "Send for Judicial review" 
option if a Judicial Officer must review the fee waiver application before entering the order.  
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6. Click the [Save] button. 
Result: The Maintain Fee Waiver Order screen displays. 

 
 

 

7. Select the radio button for the fee waiver application for which you will enter the order. 
8. Click the [Select] button. 

Result: The Record Fee Waiver Order screen displays. 
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9. Enter/Select data for the necessary fields. 
 If the fee waiver application has been imaged and stored in the document management 

system, an icon for the fee waiver application is visible next to the label to "View Fee Waiver 
Application." Selecting this icon will render an electronic version of the fee wavier application 
for your review. 

 Select the radio button for the "Granted by Operation of Law" option if an order has not 
been recorded on the fee wavier application for a period greater than five days. 

If you choose to deny a fee wavier application, select the "Denied in Whole" or "Denied in Part" 
option and select a reason from the drop-down box or enter the reason in the "Specify 
Reason" text area.  
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 You can select the specific types of fees may be waived by selecting the [checkbox] to 
the left of the corresponding fees. If the fee waiver covers all fee categories and types, select 
every checkbox in this section of the order.  

 You or a Judicial Officer may determine that all fees that are pending waiver must be 
paid, but only for an adjusted amount. In this case, enter the adjustment percentage but do not 
enter a "%" symbol in the field.  

 Alternatively, you may determine that all fees must be paid, but will be paid over a period 
of time. In this case, you may specify a total dollar amount to be paid each month and select 
the [checkbox] to the left of "Create Payment Plan." 

 Select the checkboxes for the "Generate Order" and/or "Certificate of Mailing" options to 
generate the Order and Certificate of Mailing forms when the transaction completes.  

10. Click the [Order Complete] button. 
Result: The Record Fee Waiver Order Confirmation screen displays. 
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Related Links 

Fee Waiver Order Overview 

Add Filing Screen 

Maintain Fee Waiver Order Screen 

Record Fee Waiver Order Screen 

 

My Court Information 

 

Schedule Event to Review Financial Status or Resolve Conflict 

 

Introduction 

You or a Judicial Officer may determine that a hearing must be scheduled in order to resolve conflicts 
associated with the fee waiver application (if the application is granted in part/denied) or schedule a 
hearing to review the financial status of the applicant (if the application is granted). The Fee Waiver Order 
functionality supports the ability to schedule these hearings for a specific place and time. 

Before Scheduling an Event to Review Financial Status or Resolve Conflict 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case on which to schedule an event to review financial status or resolve conflict. 
Refer to the Search Cases task activity for details on performing a case search. 

Task Activity 

Perform the following steps to schedule an event to review the financial status or resolve conflicts 
regarding a case participant's fee waiver application.  
 

1. Select [Case] > [Add Filing]. 
Result: The Add Filing screen displays. 
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2. Enter/Select data for the following required fields: 

• Filing Type 
• Filing Date 
• Filing Document (select "Fee Waiver Application" or "Application to Waive Additional Fees 

and Court Costs") 
• Filing Status 

 The document must be a "Fee Waiver Application" or an "Application to Waive Additional 
Fees and Court Costs" in order to record an order on the fee waiver. 

3. Select the [Filing Attributes] tab. 
Result: The Filing Attributes tab highlights and displays the appropriate information.  
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4. Select the radio button for the applicant is eligible for an order to waive fees.  
5. Select the radio button for the "Record Order" option if you want to record the fee waiver 

immediately following the acceptance of the filing. Otherwise, select the "Send for Judicial review" 
option if a Judicial Officer must review the fee waiver application before entering the order.  

6. Click the [Save] button. 
Result: The Maintain Fee Waiver Order screen displays. 
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7. Select the radio button for the fee waiver application for which you will enter the order. 
8. Click the [Select] button. 

Result: The Record Fee Waiver Order screen displays. 
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9. Select the [Schedule] tab. 
Result: The Record Fee Waiver Order screen, Schedule Tab highlights and displays the 
appropriate information.  
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10. Select data for the following required fields: 
11. Scheduling Options 
12. Event Type 

 You must select the "Hearing to help resolve conflict" or "Hearing to review financial 
status" option in order to schedule the event.  

11. Click the [Order Complete] button. 
Result: The Record Fee Waiver Order Confirmation screen displays. 
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Related Links 

Fee Waiver Order Overview 

Add Filing Screen 

Maintain Fee Waiver Order Screen 

Record Fee Waiver Order Screen 
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Manage Case Action Entries 

Manage Action Entries Overview  

 

Introduction 

Managing action entries involves adding and updating Register of Actions (ROA) or Case History entries 
on a case. This can be an automatic process, which is managed by the system, or you can manually 
create and/or edit action entries on the case. The action entries on a case will look the same, regardless 
of how the entry was created or changed. 

About Case History Entries 

Case History entries, also known as action entries, represent the actions and events that occurred on a 
case. Each entry is a piece of text that records a case-related activity. The collection of the entries 
provides a "history" of case events. 

The system will automatically create an action entry based on some action performed on the case. These 
automatic action entries are recorded only if the action had been configured to write a case history entry. 
Otherwise, you can manually create/update the necessary entries. 

About ROA Entries 

The ROA is the public view of a case. These entries initially have a security level of "1," which allows the 
public to view these case details and events. Basically, these entries are a sub-set of the Case History. 

Associating Action Entries 

An action entry can relate to another entry on the case. As a result, you can add or remove associations 
between action entries, as necessary. For example, if your Court receives an opposition to a motion, you 
can associate the entry for the opposition to the entry for the motion.  

Associating action entries can be a manual or automatic process. For instance, when a minute order is 
modified, the entry for the updated minute order is automatically associated by the system with the entry 
for the original minute order. 

Updating Associated Filings or Documents 

You can update case documents that are stored electronically or associated filings from the Case History. 
Refer to the Maintain Case Filings section for details on these processes. 

Performing Additional Activities 

The system may perform additional tasks based on configured actions. For example, a newly created or 
updated action entry may generate a form or notice, update the case status, change the case security 
level, or populate a work queue. 

Task Activities 

Managing action entries includes the following task activities: 

• Batch Create Action Entries 
• Add Manual Action Entries 
• Filter Case History Entries 
• Resequence Action Entries 
• Update Action Entries 
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Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Case History Screen 

Case History - Add Entry Screen 

Batch Case History Entries Screen 

 

My Court Information 

 

Batch Create Action Entries 

 

Introduction 

Creating ROA or Case History entries in batch adds the same entry to multiple cases at one time. 

Task Activity 

Perform the following steps to batch create a case entry on multiple cases.  
 

1. Select [Case] > [Batch Case History Entries]. 
Result: The Batch Case History Entries screen displays. 
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2. Enter the Case Number or Legacy Number for the case to add an entry. 
 You can either search for a case to add to the batch list, or enter a case directly to the list. 

Skip to Step 4 to search for a case to add to the list. 
3. Click the [Add] hyperlink. 

Result: The screen refreshes and displays the entered case number in a list. 
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4. Click the [Search] hyperlink to search for a case to add. 
Result: The Case Search pop-up window displays. 

 Refer to the Search Cases task activity for details on performing a case search. 
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5. Enter/Select data for the appropriate search parameter fields. 
6. Click the [Search] button. 

Result: The pop-up window refreshes with the Search Results. 
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7. Select the checkboxes for the cases to add to the entry list. 
8. Click the [Add] button. 

Result: The pop-up window closes and re-displays the Batch Case History Entries screen. This 
screen now includes the selected cases in the entry list. 
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9. Enter/Select data for the following required fields: 
10. Entry Function 
11. Entry Type 
12. Entry Date 
13. Short Entry 

 

10. Enter/Select data for the other necessary fields. 
11. Click the [Save] button. 

Result: The screen refreshes with a confirmation message. 
 Depending on the Security Level selection, this entry will appear as either an ROA or Case 

History entry. The entry will be displayed on the ROA only if this security setting has a value of 
"1." 
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Related Links 

Manage Action Entries Overview 

Batch Case History Entries Screen 

 

My Court Information 

 

Add Manual Action Entries 

 

Introduction 

Adding an action entry allows you to manually create an ROA and/or Case History entry on a case. 

Task Activity 
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This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to view its case history. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to add a manual action entry to a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays. This screen lists the recorded entries on the case. 
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2. Click the [Add Manual Entry] hyperlink. 
Result: The Case History - Add Entry screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 
4. Entry Function 
5. Entry Type 
6. Entry Date 
7. Short Entry 

 The Entry Date defaults to the current date. 

4. Enter/Select data for the other necessary fields. 
 Selecting a Security Level other than "1" will only display the entry in the Case History, and 

not the ROA. 
5. Click the [Associations] tab. 

Result: The Associated Entries tab highlights. This tab contains a list of the entries on the case. 
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6. Click the [Associate] link for the entry to associate. 
Result: The screen refreshes and displays the entry in the Associations section. 
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7. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. This entry now displays in the Case 
History. 

 If you added a Case History entry that does not appear on the ROA, the short text for the 
entry will display in italics. 
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Related Links 

Manage Action Entries Overview 

Case History Screen 

Case History - Add Entry Screen 

 

My Court Information 

 

Filter Case History Entries 
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Introduction 

Filtering Case History entries sorts and displays only those entries that match the selected filter criteria. 
This tool is an optional feature designed to help you easily find a desired action entry on the case. You 
can apply different filters to the list of entries to control what is displayed. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to view its case history. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to filter the list of action entries on a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays. This screen lists the recorded entries on the case. 
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2. Click the [More Filter Parameters] hyperlink. 
Result: The screen refreshes with the filter parameter fields. 
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3. Enter/Select data for at least one of the filter fields. 
4. Click the [Filter] button. 

Result: The screen refreshes and displays only those entries that match the entered filter criteria. 
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Related Links 

Manage Action Entries Overview 

Case History Screen 

 

My Court Information 

 

Resequence Action Entries 

 

Introduction 

Resequencing action entries re-sorts a selected group of case history entries for a specified date.  

Selecting a Resequence Date 

This new order is based on a single entry date. The system will display a list of entries that match a 
selected date on the case. You can then choose to resequence these entries, which transfers over to the 
Case History list. 

Applying and Saving the Resequence 

Applying the resequence will sort the entries the way that you indicated. The Case History will display this 
new sort for the entry date within the entire sequenced order of entries. However, once you leave the 
resequence screen, the applied but not saved resequence will return to the original numbered order. 

Saving the resequence is the only way to keep this new entry order. Resequencing does not change the 
sequence number associated with the entry. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to view its case history. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to resequence the sort order for action entries on a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays. This screen lists the recorded entries on the case. 
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2. Enter a Resequence Date. 
 This is the date for which you want to view entries. 

3. Click the [Resequence] button. 
Result: The screen refreshes and displays only those entries that were created on the selected 
date. 

 
 

 

4. Enter a new Sequence # for those entries that you want to resequence. 
 These numbers must be positive whole numbers. 

5. Click either the [Apply] or [Save] button. 
Result: The Case History screen refreshes and lists the case entries. The entries listed for the 
selected date now appear in the order you chose. 
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Related Links 

Manage Action Entries Overview 

Case History Screen 

 

My Court Information 

 

Update Action Entries 

 

Introduction 

Updating an action entry changes the entry information on a given case. This activity relates to updating 
both manual and automatic action entries. 

Reasons for Updating Action Entries 

You should manually update an entry as necessary. However, there are only certain circumstances 
where an update can occur. For example, an entry may need additional or corrected information, or it 
may need to be removed from the case. An entry may also need to have its security level updated after it 
was created or be stricken from the Case History records. 

Update Requirements 

The Court must have received and filed an Order requiring that a specific action entry be stricken, sealed, 
or removed on or from the case. 

Correcting or Updating an Entry 

You may need to correct an entry if there was a mistake on the entry or if more information needs to be 
added. These types of updates only allow you to change certain entry fields. For example, you can 
update entry associations or change an entry name. 

Striking and Sealing Entries 

You can mark an entry as "entered in error" if it no longer applies to the case or was mistakenly added. 
This type of update does not have an Order indicating that it can be removed. As a result, this 
classification will alert you that this entry does not belong on the case. 

You can strike or update the security level of an entry if a Judicial Officer ordered such an activity. An 
entry may need to be manually sealed for a specific amount of time if this process did not occur 
automatically. 

Update Functionality 

The system will track the updates to an entry. These details will include both the old and new values of 
the corrected or changed entry attributes. You can view a summary of these details from the Update 
History tab. 
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The system will also automatically associate a new corrected entry with the previous entry. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to view its case history. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to update an ROA or Case History entry on a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays. This screen lists the recorded entries on the case. 



Printed Documentation 

370 



The Case Section 

371 

 

 

2. Click the [Short Entry] hyperlink for the entry to update. 
Result: The Case History - Add Entry screen displays with the entry data populating the 
appropriate fields. 

 
 

 

3. Enter/Update the available fields as needed. 
 Select the Strike and/or Entered in Error checkboxes, if appropriate. 

4. Select the [Associations] tab. 
Result: The Associated Entries tab highlights. This tab contains a list of the entries on the case. 

 Click the [Associate] link to associate an entry to this entry, or click the [Remove] link to 
remove an association from this entry. 
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5. Click the [Update History] tab. 
Result: The Update History tab highlights and displays the details of previous updates made to 
this entry. 
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6. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 

 The system will display an icon below the short entry indicating the type of update that you 
performed. A line will display through the short entry text for those entries that were either entered 
in error or stricken. In addition, if an entry was entered in error, then the short entry text will not 
display as a hyperlink. 
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Related Links 

Manage Action Entries Overview 

Case History Screen 

Case History - Add Entry Screen 

 

Maintain Case Clocks 

Maintain Case Clocks Overview  
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Introduction 

Maintaining case clocks involves adding and updating manual clocks on a specific case. Additional 
activities involve updating automatic clocks assigned to the case and batch updating active clocks on 
multiple cases. 

You can also record information about why certain milestones on a case had not been met or were met 
late. This information gets copied to a milestone exception report. 

About Case Clocks 

A clock is a mechanism used by the system to enforce the timeliness of actions on a case. You can 
change certain automatic clock settings on a case or create manual clocks for the case. These clock 
updates will only apply to the active case and are not system-wide changes. This means that cases 
assigned to the same track may end up having a different mix of clocks or clock behaviors. Refer to the 
Configure Automatic Case Clocks section for more information about automatic case clocks. 

Maintaining Automatic Clocks 

Automatic case clocks include both case level and participant level clocks. The system will automatically 
update these clock statuses based on configured events occurring on the case. However, you may also 
manually change these automatic clock settings. For example, you can manually change a clock status or 
update the valid number of days before the clock expires. 

These clock changes only apply to the selected case. Refer to the Configure Case Tracks section for 
details on adding clocks to tracks. Refer to the Configure Automatic Case Clocks section for details on 
creating and configuring automatic clocks.  

Maintaining Manual Clocks 

You can create manual clocks for an individual case. These clocks have no automated system action to 
start, pause, stop or restart. As a result, you are responsible for manually maintaining these clocks. 
However, the system will automatically expire a clock on its configured duration or end date if you do not 
take some other action on the clock. 

Affecting Case Participants 

For both automatic and manual clocks, you must specify whom the clock change will affect. For example, 
if you want to change the clock for a single participant on the case, then you must select this participant 
as the filter criteria. Otherwise, the action that you perform on a given clock will affect the case 
participants. 

Task Activities 

Maintaining case clocks includes the following task activities: 

• Update Automatic Case Clocks 
• Add Manual Case Clocks 
• Update Manual Case Clocks 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 
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Related Links 

Case Tracks/Clocks Screen 

Case Tracks/Clocks - Automatic Clocks Screen 

Case Tracks/Clocks - Manual Clocks Screen 

 

My Court Information 

 

Update Automatic Case Clocks 

 

Introduction 

Updating automatic case clocks changes clock statuses and/or the number of days an automatic clock is 
valid. These changes only apply to the selected case and do not affect the overall configuration of a 
clock. Refer to the Configure Automatic Case Clocks section for details on updating clock configurations. 

Reasons for Updating Automatic Clocks 

If you change the configuration of an automatic clock, it is possible that this change might not affect 
certain cases (or certain clocks). For example, if you update an expected [configured] event that already 
occurred on a case, then this case would not be affected by the update. As a result, it may be necessary 
for you to manually update an automatic clock on a case.  

Clock Status Changes 

You can pause, restart and stop automatic case clocks. However, only the system can start an automatic 
clock.  

Changing the status of a case level clock will affect the participants on the case at the same time. For 
instance, changing a clock status to "stopped" will stop this clock for the case participants. On the other 
hand, changing the status of a participant level clock will only affect those case participants assigned to 
the clock. 

Clock Status Restrictions 

If you pause an automatic clock, then the clock will remain in a "paused" status until you or a system 
action restarts or stops it. Pauses and restarts will affect the total number of days a clock will run. In these 
situations, the stop date may not be exactly the configured number of days from the start date.  

Also, a clock in a status of "stopped" cannot update to other status, since a stopped clock cannot restart.  

Updating Participant Level Clocks 

There are different ways to update a participant level clock. For example, if you enter a participant name 
as a filter parameter, then only participant level clocks assigned to this participant will display in the 
results. A status change to one of these listed clocks would then affect the clock running for only this 
participant.  

Another way to update a participant level clock is through the Edit screen. From here, you can choose to 
change the case clock status or update this status only for specific case participants. 

Task Activity 
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This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update an automatic clock. Refer to the Search Cases task activity for details 
on performing a case search. 

Perform the following steps to update an automatic clock on a case. 
 

1. Select the [Case Tracks/Clocks] left navigation item. 
Result: The Case Tracks/Clocks screen displays. This screen shows how the case is meeting its 
milestones. 

 
 

 

2. Select the [Automatic Clocks] tab. 
Result: The Automatic Clocks tab highlights and displays the automatic clocks assigned to the 
case. 
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3. Select the necessary clock filter criteria. 
 This filter tool allows you to search for specific clocks that may exist on the case.  

4. Click the [Filter] button. 
Result: The screen refreshes and displays only those automatic clocks that match the selected 
filter criteria. 
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5. Select the radio button for the automatic clock to update. 
 There are two types of updates that you can make to a manual clock. You can change 

either the status of the clock or the clock details. Both updates require that you first select the 
clock to edit. 

6. Select the [Stop], [Pause], or [Restart] button, as appropriate. 
 Changing the status of a clock uses the buttons listed below the clock list. Selecting one of 

these action buttons will refresh the screen and display the new clock status for that clock. If a 
search filter of Participant Name was used, then changing the status of the clock will only affect 
the clock for that single participant. 

 You cannot change the status of an already stopped clock. 
Result: The screen refreshes with the new status for that clock. 
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7. Click the [Edit] button. 
 You must first select the clock to edit. 
 This step allows you to change the status and/or number of days for which this clock is valid 

on participant level clocks. However, you may also change the status of a case level clock. 
Result: The Case Tracks/Clocks – Automatic Clocks screen displays. 

 If you selected a participant level clock, then the screen includes the Case Participants 
Summary View section. 
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8. Select a new Clock Status, if necessary. 
 If this is a participant clock, then this status will apply to the participants listed in the Case 

Participants Summary View section. 
9. Enter/Update the available fields as needed. 

 The Number of Days and Status fields are available for updates if it is a participant level 
clock. 

 It is recommended that you enter a reason for the edit in the appropriate field. 
10. Click the [Save] button. 

Result: The Case Tracks/Clocks screen re-displays with the Automatic Clocks tab highlighted. 
The updated overall clock status also displays for this clock. 
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Related Links 

Maintain Case Clocks Overview 

Case Tracks/Clocks Screen 

Case Tracks/Clocks - Automatic Clocks Screen 

 

My Court Information 

 

Add Manual Case Clocks 
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Introduction 

Adding a manual case clock defines a set of actions that should occur on a single, specific case. This 
type of clock helps to support the informal or ad-hoc case requirements requested by a Judicial Officer 
during a hearing or other clerical process.  

Manual clocks do not affect or change case events or participant settings. 

Clock Status Changes 

Manual clocks do not have automated system events to pause, stop or restart the clocks. While the 
system will start a manual clock based on the specified start date, you are responsible for maintaining 
these clocks. Refer to the Update Manual Case Clocks task activity for details on these activities. 

Clock Assignments 

You can create a manual clock for several purposes. As a result, these clocks can relate to either the 
case or individual case participants. For example, you can specify for which participant(s) this clock will 
be valid. Status updates only affect the clock settings for the case participant(s) assigned to that clock. 

However, if you do not assign participants to the clock, the clock will simply run for the reason that you 
provide. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update a manual clock. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to add a manual clock to a case. 
 

1. Select the [Case Tracks/Clocks] left navigation item. 
Result: The Case Tracks/Clocks screen displays. 
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2. Select the [Manual Clocks] tab. 
Result: The Manual Clocks tab highlights and displays the manual clocks that exist on the case. 
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3. Click the [Add New] button. 
Result: The Case Tracks/Clocks – Manual Clocks screen displays. 
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4. Enter/Select data for the following required fields: 
5. Clock Name 
6. Start Date 
7. End Date or Total Number of Days 
8. Clock Status 
9. Type of Days 

 You must provide either an End Date or Total Number of Days value. This value will 
determine the duration of the clock, which is the number of court or calendar days the clock will 
run before it expires. 

 If more than one participant is selected for a manual clock, then the system will not 
display the clock status for each assigned participant. Only automatic clocks have this 
capability. 

5. Click the [Save] button. 
Result: The Case Tracks/Clocks screen re-displays with the Manual Clocks tab highlighted. The 
new manual clock is now available in the clock list. 
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Related Links 

Maintain Case Clocks Overview 

Case Tracks/Clocks Screen 

Case Tracks/Clocks - Manual Clocks Screen 

 

My Court Information 

 

Update Manual Case Clocks 
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Introduction 

Updating manual case clocks changes clock statuses, clock duration, and/or (re-)assigns participants to a 
clock. These clocks do not affect or change case events or participant settings. 

Clock Status Restrictions 

Since manual clocks are not associated with automated system events, you are responsible for 
maintaining these clocks. A clock will remain in a given status until either it reaches its expiration date or 
you change its status. 

For example, a manual clock in a status of "paused" will remain in this status until you restart or stops it. 
The clock counter will also not change or increment until you have manually restarted the clock. The 
counter is the number of days since the clock was first started. 

Pauses and restarts will affect the total number of days a clock will run. In these situations, the number of 
days between the stop date and the start date may not match the total number of days configured for the 
clock to run. Also, a clock with the status of "stopped" cannot update to another status, since a stopped 
clock cannot be restarted.  

Updating Manual Clocks 

There are different ways to update a manual clock. You can select an appropriate action button to change 
the overall status of a clock. You may also change a manual clock for a single participant. For example, if 
you enter a participant name as a filter parameter, then only the manual clocks assigned to this 
participant will display in the results. A status change to one of these listed clocks would then affect the 
clock running for only this participant. 

Another way to update a manual clock is through the Edit screen. From here, you can change the clock 
start/end dates or duration. You may also change or add participants assigned to the clock. However, you 
must provide a reason for updating the clock. 

Manual Clock Actions 

If you do not take some other action on the clock, such as changing the status of a clock, then the clock 
will automatically expire/stop based on the specified time frame. When a manual clock expires, no system 
actions or case events occur.  

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to update a manual clock. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to update a manual clock on a case. 
 

1. Select the [Case Tracks/Clocks] left navigation item. 
Result: The Case Tracks/Clocks screen displays. 
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2. Select the [Manual Clocks] tab. 
Result: The Manual Clocks tab highlights and displays the manual clocks created for the case. 
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3. Select the necessary clock filter criteria. 
 This filter tool allows you to search for specific clocks that may exist on the case.  

4. Click the [Filter] button. 
Result: The screen refreshes and displays only those manual clocks that match the selected filter 
criteria. 
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5. Select the radio button for the manual clock to update. 
 There are two types of updates that you can make to a manual clock. You can change 

either the status of the clock or the clock details. Both updates require that you first select the 
clock to edit. 

6. Select the [Stop], [Pause], or [Restart] button, as appropriate. 
 Changing the status of a clock uses the buttons listed below the clock list. Selecting one of 

these action buttons will refresh the screen and display the new clock status for that clock. If a 
search filter of Participant Name was used, then changing the status of the clock will only affect 
the clock for that single participant.  

 You cannot change the status of a stopped clock. 
Result: The screen refreshes and displays the new status for that clock. 
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7. Click the [Edit] button. 
 You must first select the clock to edit. 

Result: The Case Tracks/Clocks – Manual Clocks screen displays. 
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8. Enter/Update the available fields as needed. 
9. Click the [Save] button. 

Result: The Case Tracks/Clocks screen re-displays with the Manual Clocks tab highlighted. The 
updated overall clock status also displays for this clock. 
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Related Links 

Maintain Case Clocks Overview 

Case Tracks/Clocks Screen 

Case Tracks/Clocks - Manual Clocks Screen 

 

Maintain Investigator Reports 

Maintain Investigator Reports Overview  
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Introduction 

Maintaining Investigator Reports records and updates the notes and/or comments related to an 
investigation being carried out on a probate case. 

About Investigator Reports 

Probate Investigator Reports provide a summary of case events as recorded by a Probate Investigator. 
The occurrence of certain "trigger" events starts an investigation on the case. Triggering actions may 
include one of the following: 

• An automatic case clock expired 
• An event was scheduled 
• Minutes ordered an investigator report 

 

 

For each action that occurs, the system will create a new task that requires an investigator report. You 
can access drafts of these reports through the probate investigator work queue list. These drafts of report 
tasks allow you to access and edit the report contents before finalizing it. 

Selecting Report Statuses 

The progress of an Investigator Report indicates its completion status. It also determines the system 
actions that should occur. For example, if you select a report status of "in review," this will alert your 
supervisor to review and edit the report as necessary.  

When the report is complete, you can select a status of "finalize." The system then generates a PDF 
version of the report based on the entered text. The system also automatically files the report on the case 
and associates the PDF document with the filing. 

Using Macros 

You have the option of using macros to automatically enter pre-defined text into the report. The macro 
feature reduces data entry by allowing you to quickly record standard information in an investigator report. 

You must define the text entries for investigator reports before using macros. This configuration will 
create a list of available text [macros] from which you can select. These entries are defined for either the 
Investigator Notes or Comments sections of the report. Refer to the Configure Minute Codes section for 
details on creating macro text. 

If you select a macro from the list, the system will copy or "translate" the selected text into the appropriate 
report section. This text will display at the end of the previously entered text. Then you can edit or remove 
these contents. 

Task Activities 

Maintaining Investigator Reports includes the following task activities: 

• Record Investigator Reports 
• Update Investigator Reports 

Additional Resources 

Other items related to this overview include the following:  

• Forms/Notices/Reports 
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Related Links 

Maintain Investigator Report Screen 

 

My Court Information 

 

Record Investigator Reports 

 

Introduction 

Recording an Investigator Report collects and saves notes and/or comments related to the investigation 
of a probate case. This activity also allows you to update a draft of an existing probate investigator report. 

Task Activity 

This activity takes place within the context of a work queue. Refer to the Work Queue section for details 
on maintaining work queue items. 

Perform the following steps to record an Investigator Report. 
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays. 

 
 

 

2. Select the Work Queue Title hyperlink for the probate investigator report work queue. 
Result: The Probate Investigator Work Queue screen displays. 
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3. Select the necessary work queue filter criteria. 
 This filter tool allows you to display specific investigator reports with outstanding tasks. 

4. Click the [Filter] button. 
Result: The screen refreshes and displays only those tasks that match the selected filter criteria. 

 
 

 

5. Select the radio button for the investigator report to record. 
 This selection automatically opens the case. 

6. Click the [Select] button. 
Result: The Maintain Investigator Report screen displays. 
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7. Select a Probate Report Progress value. 
 Values except for "finalize" will keep a draft of the report in the work queue. 

8. Enter the appropriate text into the Investigator Notes tab. 
 Skip to Step 13 if you are not using the macro feature for entering standard text. 

9. Click the [Add Macros] button. 
Result: The Maintain Investigator Report - Macros screen displays. 
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10. Select the [Include] radio button(s) for the text codes to add to the report. 
11. Enter data for the necessary open text fields. 
12. Click the [Translate] button. 

Result: The Maintain Investigator Report screen re-displays. The selected text is automatically 
entered in the Investigator Notes tab.  
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13. Select the [Comments] tab. 
Result: The Comments tab highlights. 
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14. Enter text for the necessary comments. 
 You can also apply configured comments using the Add Macros feature. 

15. Click the [Save] button. 
Result: The Probate Investigator Work Queue displays. 
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Related Links 

Maintain Investigator Reports Overview 

Work Queue List Screen 

Maintain Investigator Report Screen 

 

My Court Information 

 

Update Investigator Reports 

 

Introduction 

Updating an existing Investigator Report changes the notes and/or comments related to the investigation 
of a probate case. This activity also allows you to update the progress of the report. You may continue to 
save the report as a draft or finalize a completed report. 

Task Activity 

This activity takes place within the context of a work queue. Refer to the Work Queue section for details 
on maintaining work queue items. 

Perform the following steps to update an existing Investigator Report. 
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays. 
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2. Select the Work Queue Title hyperlink for the probate investigator report work queue. 
Result: The Probate Investigator Work Queue screen displays. 

 
 

 

3. Select the necessary work queue filter criteria. 
 This filter tool allows you to display specific investigator reports with outstanding tasks. 

4. Click the [Filter] button. 
Result: The screen refreshes and displays only those tasks that match the selected filter criteria. 
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5. Select the radio button for the investigator report to record. 
 This selection automatically opens the case. 

6. Click the [Select] button. 
Result: The Maintain Investigator Report screen displays. 
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7. Select a Probate Report Progress value. 
 Values except for "finalize" will keep a draft of the report in the work queue. 

8. Enter the appropriate text into the Investigator Notes tab. 
 Skip to Step 13 if you are not using the macro feature for entering standard text. 

9. Click the [Add Macros] button. 
Result: The Maintain Investigator Report - Macros screen displays. 
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10. Select the [Include] radio button(s) for the text codes to add to the report. 
11. Enter data for the necessary open text fields. 
12. Click the [Translate] button. 

Result: The Maintain Investigator Report screen re-displays. The selected text is automatically 
entered in the Investigator Notes tab.  
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13. Select the [Comments] tab. 
Result: The Comments tab highlights. 
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14. Enter text for the necessary comments. 
 You can also apply your configured comments by using the Add Macros feature.  

15. Click the [Save] button. 
Result: The Probate Investigator Work Queue displays. 
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If you selected to finalize the report, the system will generate a PDF version of the report and associate 
the filing with the case. It will also create a Case History entry indicating that report has been finalized for 
the selected event. 

 

 

Related Links 

Maintain Investigator Reports Overview 

Work Queue List Screen 

Maintain Investigator Report Screen 

 

Manage Blocked Accounts 

Manage Blocked Accounts Overview  

 

Introduction 

Managing blocked accounts involves adding, updating, and removing blocked accounts associated with a 
case. Each of these activities is a manual process since the system does not perform calculations on 
these screens.  

Blocked accounts are also not referenced by other system process. As a result, these screens may be 
used for informational or tracking purposes only.  

Cases That Use Blocked Accounts 
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Blocked accounts are specific to a participant on a case. For instance, blocked accounts usually exist for 
minors in probate cases. These accounts usually stay blocked until the child turns 18 years old. Courts 
may also order blocked accounts on civil cases where a Minor’s Compromise is entered. 

Guardians and similar roles do not have access to accounts that are not under their own name. In 
addition, it is possible that a single participant have more than one blocked account on a case. 

Creating Blocked Accounts 

The Court orders the creation of a blocked account at a hearing. This account then becomes protected by 
its associated financial institution. This means that the bank or firm will not allow the transactions to occur 
on the blocked account without a Court order. 

Based on this order, you can add a blocked account on the case for the specified participant. You must 
enter items such as the participant’s account number, the bank name, and the type of transaction. When 
adding a new blocked account, the first transaction is always a deposit.  

Other Account Transactions 

If the Court orders additional transactions on the blocked account, then you must update the account 
details. This includes  requests to the Court for a deposit, withdrawal or transfer on the account. You can 
also remove transactions in the account’s history, or remove a blocked account entirely from the case, if 
an Order requires such an activity.  

Task Activities 

Managing blocked accounts includes the following task activities: 

• Add Blocked Accounts 
• Edit Blocked Accounts 
• Remove Blocked Accounts 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Blocked Accounts Screen 

Blocked Account Details Screen 

 

My Court Information 

 

Add Blocked Accounts 

 

Introduction 

Adding a blocked account creates a financial account for a specific case participant. 
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Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to add a blocked account. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to add a blocked account to a case. 
 

1. Select the [Blocked Accounts] left navigation item. 
Result: The Blocked Accounts screen displays. 

 
 

 

2. Click the [Add New Account] button. 
Result: The Blocked Account Details screen displays. 
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3. Enter/select data for the following required fields: 
4. Participant 
5. Account Number 
6. Bank Name 

 

4. Enter/select data into the following required fields in order to enter a transaction: 
5. Operation 
6. Date Ordered 
7. Amount $ 
8. Balance $ 

 The system will not calculate changes to account balances. 

5. Click the [Save] button. 
Result: The Blocked Accounts screen re-displays with a confirmation message. The new blocked 
account now displays. 
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Related Links 

Manage Blocked Accounts Overview 

Blocked Accounts Screen 

Blocked Account Details Screen 

 

My Court Information 

 

Edit Blocked Accounts 
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Introduction 

Editing a blocked account changes the account details for a specific case participant. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to edit a blocked account. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to update a blocked account on a case. 
 

1. Select the [Blocked Accounts] left navigation item. 
Result: The Blocked Accounts screen displays. This screen shows the blocked accounts that 
exist on the case. 

 
 

 

2. Click the [Account Number] link of the blocked account to update. 
Result: The Blocked Account Details screen displays. 
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3. Enter/Update the available fields as needed. 
 Since the system does not calculate changes made to account balances, you must 

manually provide these amounts. 
 Click the [Add Another] button to create a blank row of account fields. 

4. Click the [Save] button. 
Result: The Blocked Accounts screen re-displays with a confirmation message. 
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Related Links 

Manage Blocked Accounts Overview 

Blocked Accounts Screen 

Blocked Account Details Screen 

 

My Court Information 

 

Remove Blocked Accounts 
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Introduction 

Removing a blocked account deletes an account from a case. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case on which to delete a blocked account. Refer to the Search Cases task activity for details 
on performing a case search. 

Perform the following steps to remove a blocked account from a case. 
 

1. Select the [Blocked Accounts] left navigation item. 
Result: The Blocked Accounts screen displays. 

 
 

 

2. Select the [Account Number] radio button of the blocked account to remove. 
3. Click the [Remove Account] button. 

Result: The screen refreshes and no longer displays the previously selected account. 
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Related Links 

Manage Blocked Accounts Overview 

Blocked Accounts Screen 

 

Manage Warrants 

Record Order for Issuance of Warrant 

Record Order for Issuance of Warrant Overview  

 

Introduction 

The Record Order for Issuance of Warrant describes the functionality of recording information related to 
the Order for Issuance of Warrant. A warrant may be ordered against a party as a result of a request 
initiated by a party/attorney or as a result of a decision made by a Judicial Officer. 

Once the order has been recorded, the warrant can then be issued. Refer to the Maintain Warrants 
section for details on issuing warrants.  

Task Activities 
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Recording an Order for Issuance of Warrant includes the following task activities: 

• Search Warrants 
• Record Order for Issuance of Warrant 
• Update Order for Issuance of Warrant 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Record Order for Issuance of Warrant Screen 

 

My Court Information 

 

Record Order for Issuance of Warrant 

 

Introduction 

Recording Order for Issuance of Warrant is the process of entering information related to an order.  

Task Activity 

This activity can take place within the context of a case. This activity can also come from using the top 
menu navigation. Refer to the Search Cases task activity for details on performing a case search.  

Perform the following steps to record an Order for Issuance of Warrant.  
 

1. Coming from the context of a case: 
Click the [Warrants] left navigation item. 
Result: The Maintain Warrants - Warrants & Order Details screen displays.  
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2. OR 
 
Coming from the top menu navigation: 
Select [Courtroom] > [Create/Maintain Warrants]. 
Result: The Create/Maintain Warrants - Search screen displays.   

 
 

 

2. Click the [Record Order] button.  
Result: The Record Order for Issuance of Warrant screen displays. 
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3. Enter/Select data for the following required fields: 

• Warrant Issued Against – Role 
• Warrant Issued Against – Name 
• Bail Amount $ 
• Reason for Warrant 
• Date Ordered 
• Order Status 

 

4. Click the [Save] button. 
Result: The Maintain Warrants - Warrants & Order Details screen displays with a confirmation 
message. 
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Related Links 

Record Order for Issuance of Warrant Overview 

Maintain Warrants - Warrant and Order Details Screen 

Maintain Warrant - Search Screen 

 

My Court Information 

 

Update Order for Issuance for Warrant 

 

Introduction 

Updating Order for Issuance of Warrant is the process of editing previously entered order information.  

Task Activity 

This activity can take place in the context of a warrants search. Refer to the Search Warrants task activity 
for details on this process.  

However, the activity below takes place within the context of a case. Refer to the Search Cases task 
activity for details on performing a case search.  
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Perform the following steps to update an Order for Issuance of Warrant.  
 

1. Click the [Warrants] left navigation item. 
Result: The Maintain Warrants - Warrants & Order Details screen displays.  

 
 

 

2. Select the radio button for an order.  
3. Click the [Update] button.  

Result: The Record Order for Issuance of Warrant screen displays with the appropriate 
information.  
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4. Enter/Update the available fields as needed. 
5. Click the [Save] button. 

Result: The Maintain Warrants - Warrants & Order Details screen displays with a confirmation 
message.  

 
 

 

 

 

Related Links 

Record Order for Issuance of Warrant Overview 

Maintain Warrants - Warrant and Order Details Screen 

Record Order for Issuance of Warrant Screen 

 

Maintain Warrants 

Maintain Warrants Overview  

 

Introduction 

Maintaining Warrants allows you to issue warrants and maintain information associated with a previously 
created warrant.  

In order for a warrant to be issued, the Order for Issuance of Warrant must be exist in the system. Refer 
to the Record Order for Issuance of Warrant section for details on recording orders related to warrants.   
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The system retrieves the information entered on the Order for Issuance of Warrant, and you can enter the 
remaining information for the warrant to be issued. At the time of issuing the warrant, you can also enter 
additional information for identifying the party that the warrant is being issued against. 

Task Activities 

Maintaining warrants includes the following task activities: 

• Search Warrants 
• Issue Warrant 
• Update Warrant 
• Record Order and Issue Warrant 
• Recall Warrant 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Issue Warrant - Order Information Screen 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Recall Warrant Screen 

Record Order for Issuance of Warrant Screen 

 

My Court Information 

 

Issue Warrant 

 

Introduction 

This activity allows you to issue a previously recorded Order for Issuance of Warrants.  

Task Activity 

This activity can take place in the context of a warrants search. Refer to the Search Warrants task activity 
for details on this process.  
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However, the activity below takes place within the context of a case. Refer to the Search Cases task 
activity for more details on performing a case search.  

Perform the following steps to issue a warrant.  
 

1. Click the [Warrants] left navigation item. 
Result: The Maintain Warrants - Warrants & Order Detail screen displays.  

 
 

 

2. Select the radio button for an order.  
3. Click the [Issue Warrant] button.  

Result: The Issue Warrant - Order Information screen displays.  
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4. Enter/Select data for the following required fields: 

• Warrant Status 
• Date Issued  

 The appropriate forms can be generated by selecting the Generate Warrant checkbox 
and Warrant Instruction Sheet checkbox.  

 Steps 5 and 6 depend on the button that you select. These results are not related. 

5. Click the [Save & Issue Warrant] button. 
Result: The Maintain Warrants - Warrants & Order Detail screen displays with a confirmation 
message.  

 An entry of the newly issued Warrant is displayed with status of "Issued." If this is the option 
that you selected, then this is the end of the activity. 
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6. Click the [Save] button.  
Result:  The Maintain Warrants - Warrants & Order Detail screen displays with a confirmation 
message.  

 An entry of the newly issued Warrant is displayed with status of "Ordered." 

 
 

 

 

 

Related Links 
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Maintain Warrants Overview 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Issue Warrant - Order Information Screen 

 

My Court Information 

 

Search Warrants 

 

Introduction 

This activity allows you to search for previously recorded Order for Issuance of Warrants and warrants. 
Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for previously recorded Order for Issuance of Warrants and 
warrants. 
 

1. Select [Courtroom] > [Create/Maintain Warrants]. 
Result: The Create/Maintain Warrants - Search screen displays. 

 
 

 

2. Enter data for one of the following required fields: 
3. Case Number 
4. Legacy Number 

 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Create/Maintain Warrants - Search screen refreshes with the Search Results.  
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Related Links 

Record Order for Issuance of Warrant Overview 

Maintain Warrants Overview 

Maintain Warrant - Search Screen 

 

My Court Information 

 

Update Warrant 

 

Introduction 

Updating a warrant changes the details of a previously issued warrant.   

Task Activity 

This activity can take place in the context of Create/Maintain Warrants Search. Refer to the Search 
Warrants task activity for details on this process.  

However, the activity below takes place within the context of a case. Refer to the Search Cases task 
activity for more details on performing a case search.  
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Perform the following steps to update a warrant.  
 

1. Click the [Warrants] left navigation item. 
Result: The Maintain Warrants - Warrants & Order Details screen displays.  

 
 

 

2. Select the radio button for a warrant.  
3. Click the [Update] button.  

Result: The Issue Warrant - Order Information screen displays with the appropriate information.  



Printed Documentation 

432 

 
 

 

4. Enter/Update the available fields as needed. 
 The Date Issued field is not editable.  
 The appropriate forms can be generated by selecting the Generate Warrant and Warrant 

Instruction Sheet checkboxes.  
 These fields will not be shown if the warrant selected in Step 2 had the status of "Issued." 

5. Click the [Save] button.  
Result: The Maintain Warrants - Warrants & Order Details screen displays with a confirmation 
message.  

 An entry of the newly issued Warrant is displayed with status or "Ordered." 
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Related Links 

Maintain Warrants Overview 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Issue Warrant - Order Information Screen 

 

My Court Information 

 

Record Order and Issue Warrant 

 

Introduction 

Recording and issuing a warrant describes the process of recording an Order for Issuance of Warrant and 
issuing warrant in one process.  

Task Activity 

This activity can take place within a context of a case. Refer to the Search Cases task activity for more 
details on performing a case search. This activity can also come from using the top menu navigation.  
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Perform the following steps to record and issue an Order for Issuance of Warrant.  
 

1. Coming from context of a case: 
Click the [Warrants] left navigation item. 
Result: The Maintain Warrants - Warrants & Order Details screen displays.  

 
 

 

2. OR 
 
Coming from top menu navigation:  
Select [Courtroom] > [Create/Maintain Warrants]. 
Result: The Create/Maintain Warrants - Search screen displays.   

 
 

 

2. Click the [Record Order] button.  
Result: The Record Order for Issuance of Warrant screen displays. 
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3. Enter/Select data for the following required fields: 
4. Warrant Issued Against – Role 
5. Warrant Issued Against – Name 
6. Bail Amount $ 
7. Reason for Warrant 
8. Date Ordered 
9. Order Status 

 

4. Click the [Save & Issue] button. 
Result: The Issue Warrant - Order Information screen displays.  
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5. Enter/Select data for the following required fields: 
6. Warrant Status 
7. Date Issued  

 The appropriate forms can be generated by selecting the Generate Warrant and 
Warrant Instruction Sheet checkboxes.  

1.  

6. Click the [Save & Issue Warrant] button. 
Result 1: The Maintain Warrants - Warrants & Order Details screen displays with a confirmation 
message.  

 An entry of the newly issued Warrant is displayed with status of "Issued." 
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7. OR 
 
Click the [Save] button.  
Result 2: The Maintain Warrants - Warrants & Order Details screen displays with a confirmation message.  

 An entry of the newly issued Warrant is displayed with status of "Ordered." 
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Related Links 

Maintain Warrants Overview 

Maintain Warrants - Warrant and Order Details Screen 

Record Order for Issuance of Warrant Screen 

Issue Warrant - Order Information Screen 

 

My Court Information 

 

Recall Warrant 

 

Introduction 

Recalling a warrant is the process of retracting a previously issued warrant.   

Task Activity 

This activity can take place in the context of Create/Maintain Warrants Search. Refer to the Search 
Warrants task activity for details on this process.  

However, the activity below takes place within the context of a case. Refer to the Search Cases task 
activity for more details on performing a case search.  

Perform the following steps to recall a warrant.  
 

1. Click the [Warrants] left navigation item. 
Result: The Maintain Warrants - Warrants & Order Details screen displays.  



The Case Section 

439 

 
 

 

2. Select the checkbox for a warrant.  
 The selected warrant must have the status of "Issued." 

3. Click the [Recall] button.  
Result: The Recall Warrant screen displays.  
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4. Enter data for the Date Recalled field.  
 The date is defaulted to current date.  

5. Click the [Save] button. 
Result: The Maintain Warrants - Warrants & Order Details screen displays with a confirmation 
message.  
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Related Links 

Maintain Warrants Overview 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Recall Warrant Screen 

 

Manage Bail Information 

Manage Bail Information Overview  

 

Introduction 

Managing bail involves posting and updating bail information against an issued warrant. 

About Bail 

Bail is always associated with a warrant on a case. Courts use bail as a security deposit for releasing an 
individual from custody. Bail also encourages an individual to appear in court when expected. Refer to the 
Maintain Warrants section for details on ordering and issuing warrants. 

Understanding Bail Statuses 
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You must manually update the bail record to reflect its current status. Refer to the Bail Status Change 
Description document for details on the acceptable bail status transitions, Court processes and system 
actions. 

When you record a warrant that has bail associated with it, the bail status becomes "set." The bail record 
remains in this status until a person/entity posts bail. Then the status updates to "posted." 

Subsequent bail status updates will be required due to different actions or events. Court staff can update 
the bail record as necessary. The following sections outline some of these bail status changes. 

Continuing Bail 

If the bail hearing is rescheduled to a future court date, then the Court must calendar this date and update 
the bail status accordingly. This will help the Court to track bail that must be dealt with at the time of the 
new hearing. 

Exonerating Bail 

If a bail bond is exonerated or dismissed, then the system generates a notice of exoneration. The Court 
will then send this notice to the bond agent and update the bail status to "exonerated." When the bond 
agent receives this notice, the exoneration process is considered complete. 

If a cash bail is exonerated, then the Court may choose to send a refund notice to the depositor. If this 
notice is sent, then the bail status will update to "ready to be refunded." However, those courts that do not 
send a refund notice will instead directly refund the bail amount to the depositor and update the bail 
status to "refunded." 

Forfeiting Bail 

If the participant forfeits bail, then you must update the bail status to "forfeited." This status will start an 
automatic case clock for 185 days from the date the Court sends the notice of forfeiture to the appropriate 
party.  

Within that 185 day time frame, either the bail participant must come back to Court or the bond 
agent/cash depositor must file a motion requesting the court to vacate the forfeiture. 

If the Court denies this motion or the bailee fails to appear, then the Court can take action against the 
surety/depositor. If it was a bail bond, then the Court can initiate a new case against the surety, and 
summary judgment is entered. If it was a cash bail posting, then the Court will move the bail amount to a 
revenue account. 

Reinstating Bail 

You should update the bail status to "reinstated" if the bailee comes back to court within the expected 185 
days. This status also extends or continues the bail to a future court date. 

Transferring Bail 

Some system events, such as case consolidation, may require that bail from one case transfer over and 
apply to another case. In this situation, you will need to manually move the trust record reflecting the bail 
amount from the non-lead case to the lead case. Then you can update the bail record to a status of 
"transferred." Refer to the Transfer Payment/Trust Deposit and Consolidate Cases sections for details on 
these processes. 

Task Activities 
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Maintaining bail information includes the following task activities: 

• Post Bail 
• Update Bail Information 

Additional Resources 

Other items related to this overview include the following:  

• Forms/Notices/Reports 
• Bail Status Change Description 

(This is a list of available bail transactions and possible status changes.) 
 

 

Related Links 

Issue Warrant - Order Information Screen 

 

My Court Information 

 

Post Bail 

 

Introduction 

This process allows you to record bail posted against an issued warrant. 

Post Bail Functionality 

An issued warrant is ordered by the Court and becomes enforced by the law. This is a public document 
that directs the arrest of a case participant.  

A person/entity can post bail against an issued warrant. Collecting this amount updates the initial bail 
status from "set" to "posted." This status indicates that you can schedule the court appearance event for 
whom the warrant is issued. 

However, you cannot collect bail posted against a recalled warrant. Refer to the Maintain Warrants 
section for details on issuing and recalling warrants. 

Collecting Surety/Depositor Information 

You must indicate who has assumed responsibility for paying the bail amount. This person/entity 
selection also reflects the bail posting method. For example, a surety company will submit bail bonds to 
cover the bail amount, while a depositor will provide a cash bail posting. 

Recording surety information is particularly important for situations where the participant fails to appear 
for the court event. This allows the Court to initiate a civil case against the surety company to collect the 
forfeited bond amount. 
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Checking Surety Standing 

If a surety company is posting bail, then the system will check whether this company is in good standing 
with the Court. The "Not in Good Standing" indicator is an attribute on the surety person/entity profile. If 
this attribute is selected, then the system will display a warning message when you try to save the post 
bail information.  

Creating a Trust 

Collecting a cash payment for the bail amount creates a trust in the system. This trust holds the cash 
monies for the case until the bail status updates based on court events. At that point, the bail amount may 
be recalculated due to fees, refunded, or moved to County revenue. Refer to the Bail Status Change 
Description document for details on bail status changes and bail processes. Refer to the Record 
Payment/Trust Deposit section for details on creating trusts. 

Creating a Filing 

Collecting a bond posted for the bail amount creates a filing on the case. The system associates both the 
surety agent and the surety company with this Surety Bond filing. This filing provides a record of the 
agreement for the surety company to pay the bond amount if the bail participant does not appear. 

Task Activity 

Perform the following steps to post bail against an issued warrant. 

 This activity can start from either inside or outside of a case. Consider the following options: 

• Follow Steps 1-3 if starting this activity from outside of a case. 
• Skip to Step 4 if starting this activity from inside a case. 

 

 

1. Select [Courtroom] > [Create/Maintain Warrants]. 
Result: The Create/Maintain Warrants – Search screen displays. 

 
 

 

2. Enter data into the appropriate search parameter fields. 
 Refer to the Maintain Warrants section for details on performing this search. 

3. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 If you started this activity outside of a case, then skip to Step 5. 
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Use Step 4 below if starting from inside a case. Refer to the Search Cases task activity for details on 
searching for and accessing a case. 
 

4. Select the [Warrants] left navigation item. 
Result: The Maintain Warrants – Warrant & Order Details screen displays. 

 This screen shows a list of warrants that have been ordered and/or issued on the case. 



Printed Documentation 

446 

 
 

 

5. Select the radio button for the warrant on which to post bail. 
 This warrant must have a status of "Issued." 

6. Click the [Update] button. 
Result: The Issue Warrant – Order Information screen displays. 
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7. Select the [Bail] tab. 
Result: The Bail tab highlights. 
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8. Select the value of Set from the Bail Status drop-down list. 
9. Click the [Add] button within the Surety/Depositor Information section. 

Result: The Person/Entity Search screen displays. 
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10. Enter data into the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

Otherwise, refer to the Create Person/Entity Profiles task activity for details on adding a new 
person/entity profile in the system. 

11. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 
 

 

12. Select the radio button for the person/entity to add as a surety/depositor. 
13. Click the [Select] button. 

Result: The Issue Warrant – Order Information screen re-displays. The selected person/entity is 
now listed in the Surety/Depositor Information section. 
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14. Select the appropriate Type for the surety/depositor. 
15. Enter/Select data for the other necessary fields. 
16. Click the [Save] button. 

 The confirmation screen depends on how you started this activity.  
Result 1: If you started from outside of a case, then the Create/Maintain Warrants – Search 
screen displays with a confirmation message. 

 



The Case Section 

451 

 

 

17. Result 2: If you started from inside a case, then the Maintain Warrants – Warrant & Order Details 
screen displays with a confirmation message. 

 
 

 

 

 

Related Links 

Manage Bail Information Overview 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Issue Warrant - Order Information Screen 

Person/Entity Search Screen 
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My Court Information 

 

Update Bail Information 

 

Introduction 

Updating bail information changes the status and/or details of an existing bail record. 

You can only update bail records that have been previously posted. Refer to the Post Bail task activity for 
details on this process. 

Changing the Bail Status 

You must manually update the bail record to reflect its current status. The current bail status determines 
how the status may change. For example, bail can update to the "Awaiting exoneration cost payment" 
status only if the prior status was "Forfeited." Refer to the Bail Status Change Description document for 
details on the available bail statuses and acceptable status transitions. 

Changing Surety/Depositor Information 

You can also maintain information about the surety, surety agent, depositor or property owner associated 
with the bail. This allows you to add or remove sureties/depositors from the bail record. If you choose to 
add new sureties/depositors, then you may also provide the appropriate posting information. 

Saving the Bail Record 

When you save the updates to the bail record, the system will perform additional steps, such as 
generating a notice, starting a clock, or funding the bail record. These "next steps" depend on the 
selected bail status. Refer to the Bail Status Change Description document for details on the system 
actions that may occur. 

Task Activity 

Perform the following steps to update bail information for an existing bail record. 

 This activity can start from either inside or outside of a case. Consider the following options: 

• Follow Steps 1-3 if starting this activity from outside of a case. 
• Skip to Step 4 if starting this activity from inside a case. 

 

 

1. Select [Courtroom] > [Create/Maintain Warrants]. 
Result: The Create/Maintain Warrants – Search screen displays. 
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2. Enter data into the appropriate search parameter fields. 
 Refer to the Maintain Warrants section for details on performing this search. 

3. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 If you started this activity outside of a case, then skip to Step 5. 

 
 

 

 

Use Step 4 below if starting from inside a case. Refer to the Search Cases task activity for details on 
searching for and accessing a case. 
 

4. Select the [Warrants] left navigation item. 
Result: The Maintain Warrants – Warrant & Order Details screen displays. 

 This screen shows a list of warrants that have been ordered and/or issued on the case. 
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5. Select the radio button for the warrant on which to update bail. 
 This warrant must have a status of "Issued". 

6. Click the [Update] button. 
Result: The Issue Warrant – Order Information screen displays. 
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7. Select the [Bail] tab. 
Result: The Bail tab highlights and displays bail related details. 
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8. Select the appropriate Bail Status. 
 This status depends on the bail disposition acknowledged by the Court. 

9. Enter the Status Change Date. 
10. Edit/Update the available fields as needed. 

 Follow Steps 11-16 to add another surety/depositor. 
 Follow Steps 17-18 to remove a surety/depositor from the bail record. 

11. Click the [Add] button within the Surety/Depositor Information section. 
Result: The Person/Entity Search screen displays. 
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12. Enter data into the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

Otherwise, refer to the Create Person/Entity Profiles task activity for details on adding a new 
person/entity profile in the system. 

13. Click the [Search] button. 
Result: The screen refreshes with the search results. 

 
 

 

14. Select the radio button for the person/entity to add as a surety/depositor. 
15. Click the [Select] button. 

Result: The Issue Warrant – Order Information screen re-displays. The selected person/entity is 
now listed in the Surety/Depositor Information section. 
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16. Select the appropriate Type for the surety/depositor. 
17. Select the checkboxes for the surety/depositor to remove from the bail record. 
18. Click the [Remove] button. 

Result: The screen refreshes and no longer displays the selected sureties/depositors. 
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19. Enter/Select data for the other necessary fields. 
20. Click the [Save] button. 

 The confirmation screen depends on how you started this activity.  
Result 1: If you started from outside of a case, then the Create/Maintain Warrants – Search 
screen displays with a confirmation message.  
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21. Result 2: If you started from inside a case, then the Maintain Warrants – Warrant & Order Details 
screen displays with a confirmation message. 

 
 

 

 

 

Related Links 

Manage Bail Information Overview 

Maintain Warrant - Search Screen 

Maintain Warrants - Warrant and Order Details Screen 

Issue Warrant - Order Information Screen 

Person/Entity Search Screen 
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Reclassify Cases 

Reclassify Cases Overview  

 

Introduction 

Reclassifying a case allows you to change the case category of a Limited Civil case to an Unlimited Civil 
case or vice versa. Case reclassification is usually due to changes in the jurisdictional amount for a case. 

Reclassification Restrictions 

The Courts have defined some case types that are only available for the Unlimited Civil case category 
and do not have a corresponding Limited Civil case type. The system does not allow reclassification of 
these case types, since there is no match available. 

In addition, if you change a Limited Civil case to an Unlimited Civil case, then the system will record a 
Limited Civil reclassification fee on the updated case. 

Location Options 

For Courts that hear Limited Civil and Unlimited Civil cases in different locations, the system allows you to 
specify the new location as part of the reclassification process. If you choose a new location, then the 
system will add the reclassified case to the file pull list. This list indicates that the case’s physical file 
should be moved to the new location. Refer to the Track Case Files section for details on this process. 

Resource Assignment Options 

You may also change the Judicial Officer or department assigned to the reclassified case. If you assign a 
new Judicial Officer or department, then the system will reassign future events from the current resource 
to the newly selected resource. The system will also generate the Notice of Case Reassignment. 

If the newly selected resource is a Judicial Officer, then the system will also check for recusal and 
unavailability conflicts with the participants of the reclassified case. 

Track Options 

Reclassification also allows you to assign a new case track to the case. If you choose a new track, then 
the system will stop the case clocks that are not shared between the old track and the newly selected 
track. Clocks that are shared between the two tracks will continue without interruption. 

Reclassification Requirements 

When reclassifying a case, you must provide a reclassification reason.  

Upon saving, the reclassified case will assume the characteristics of the new case category. Refer to the 
Maintain Case Information section for details on changing case types. 

Task Activities 

Reclassifying cases includes the following task activity: 

• Reclassify Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
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Related Links 

Reclassify Case Screen 

 

My Court Information 

 

Reclassify Cases 

 

Introduction 

Reclassifying a case is only available for Limited Civil and Unlimited Civil case categories. 

Task Activity 

This activity takes place within the context of a case. It requires that you perform a case search and 
select the case to reclassify. Refer to the Search Cases task activity for details on performing a case 
search. 

Perform the following steps to reclassify a case. 
 

1. Select the [Reclassify Case] left navigation item. 
Result: The Reclassify Case screen displays. 
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2. Select data for the following required fields: 
3. New Case Category 
4. New Case Location 
5. New Assigned JO/Dept. 
6. Reclassification Reason 

 Except for the reclassification reason field, the system will default the value of the 
remaining required fields to the case’s current value. You can keep or change these defaults, 
as appropriate. 

3. Click the [Save] button to reclassify this case. 
Result: The Reclassify Case screen refreshes with a confirmation message.  

 If reclassifying a Limited Civil case to an Unlimited Civil case, then the system will also 
record a reclassification fee on the case. 
 
 

 

 

 

Related Links 

Reclassify Cases Overview 
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Reclassify Case Screen 

 

Associate Cases 

Consolidate Cases 

Consolidate Cases Overview  

 

Introduction 

Consolidating cases combines two or more cases into a single case. A Court may consolidate cases if 
there are multiple cases open that cover the same issue or involve the same participants. A plaintiff or 
defendant usually starts this activity by filing the motion to consolidate with the Court. 

Consolidation Privileges 

This activity requires that a Judicial Officer first grant the motion to consolidate. You can then select the 
cases to combine. 

Selecting a Lead Case 

Within the selected group of cases, you must assign one case as the lead. This lead case will represent 
the consolidated case group as the master case. Events and activities will then take place only on the 
lead case for the duration of the consolidation. 

Checking for Recusal Conflicts 

The system will check for recusal conflicts between the Judicial Officer assigned to the lead case and the 
participants of the non-lead case(s). If a recusal conflict is found, the system will display a warning 
message. You can then choose to continue or cancel the consolidation process. 

Copying Case History Entries 

The system will display the ROA and Case History entries belonging to the non-lead case(s). This allows 
you to select entries to copy from the non-lead case(s) to the lead case. Selected entries from non-lead 
cases become Case History entries on the lead case. The system will also automatically copy over filing 
entries that have an associated fee or require a disposition. 

Managing Calendar Events 

You must also choose to vacate or move future scheduled events for the non-lead cases. Vacating a non-
lead event removes this event from the calendar. But if you move a non-lead event to the lead case, then 
the calendar will update to schedule that event for the lead case. Refer to the Maintain Calendar Events 
section for details on related calendar activities. 

It is possible that scheduling conflicts may occur based on moved non-lead events. If events are moved, 
then they are reassigned from the current Judicial Officer to the Judicial Officer assigned on the lead 
case. Moving these events also overrides the conflict checks. 

Consolidation Functionality 

Upon saving the consolidation, the system copies the participants, roles, stages and fee waiver statuses 
from the non-lead case(s) onto the lead case. The system also brings over the shared participant level 
clocks. This means that if a non-lead case and the lead case have the same participant level clock 
assigned to their track, then the system will copy this clock (and its status) onto the lead case. However, 
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these clocks must have a status of either “started” or “paused.” The other clocks, including the case aging 
clock, will stop on the non-lead case(s). Refer to the Configure Automatic Case Clocks and the Maintain 
Case Clocks sections for details on related clock processes.  

The system does not copy payment plans or accounting information from the non-lead case(s) to the lead 
case. Refer to the Maintain Case Information section for details on accessing accounting information of 
non-lead cases. 

The system will generate the appropriate consolidation notice based on the selected consolidation 
reason. It will also display a confirmation message indicating that the consolidation is complete.  

In addition, while the security of non-lead cases will transfer to the document or filing level, the lead case 
will remain at its current secure status. 

Searching and Accessing Consolidated Cases 

Future case searches performed on the lead or non-lead case(s) will display an icon indicating the 
consolidation association between these cases.  

If you choose to directly access a non-lead case, the system will display a warning message 
recommending that you do not make changes to the case. The status of this case remains 
"Consolidated." 

Separating Consolidated Cases 

Consolidated cases may deconsolidate [bifurcate] at a later time. However, deconsolidation does not 
apply to those cases involved in the “total merge” process. Refer to the Deconsolidate Cases section for 
details on this separation process. 

Task Activities 

Consolidating cases includes the following task activities: 

• Consolidate Cases 
• Consolidate Cases for All Purposes 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Associate Cases - Enter Search Criteria Screen 

Associate Cases - Consolidated Case Listing Screen 

 

My Court Information 
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Consolidate Cases 

 

Introduction 

Consolidating cases combines two or more cases into a single case.  

Task Activity 

Perform the following steps to consolidate two or more cases. 
 

1. Select [Case] > [Associate Cases]. 
Result: The Associate Cases – Enter Search Criteria screen displays. 
 
 

 

2. Enter the Case Number or Legacy Number of a case to consolidate. 
 Selecting the [Select all Related Cases] checkbox will display the cases that are related to 

the selected case in the Case List. 
3. Click the [Add to List] button. 

Result: The Case List screen now displays the entered case. 
 
 

 

4. Repeat Steps 2-3 to add cases to consolidate together into the Case List. 
5. Select the radio button for a lead case to represent the consolidated group. 
6. Click the [Consolidate] button. 

Result: The Associate Cases – Consolidated Case Listing screen displays. 
 A warning message will display if the cases to consolidate are from multiple case 

categories. You can choose to continue or cancel the consolidation process at this point. 
 
 

 

7. Select a Reason for the consolidation. 
8. Click the checkbox(es) for the Case History entries to copy from the non-lead case(s) to the lead 

case. 
 The system automatically selects those filings that have an associated fee or require a 

disposition. 
9. Select the [Future Scheduled Events] tab. 

Result: The Future Scheduled Events tab highlights and displays the future scheduled events for 
the non-lead cases. 
 
 

 

10. Select the appropriate radio button to Vacate or Move the scheduled events of non-lead cases to 
the lead case. 
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 Choosing to “Vacate” an event removes this event from the calendar. “Moving” an event 
updates the calendar to schedule the event for the lead case instead of the non-lead case. 

11. Click the [Save] button to consolidate the cases. 
 The system will check for recusal conflicts and display a warning message, if appropriate. 

Result: The Associate Cases – Enter Search Criteria screen re-displays with a confirmation 
message. 

 The lead case of a consolidated group will now be identified by an “L” icon. Both the lead 
and non-lead cases will also be identified by a “Consolidated” icon. 
 
 

 

 

 

Related Links 

Consolidated Cases Overview 

Associate Cases - Enter Search Criteria Screen 

Associate Cases - Consolidated Case Listing Screen 

 

My Court Information 

 

Consolidate Cases for All Purposes 

 

Introduction 

Consolidating cases for all purposes completely merges the case information for two or more cases into a 
single case. This “total merge” process is a permanent consolidation. As a result, this option does not 
allow the consolidated cases to separate at a later time.  

Total Merge Privileges 

You must have a Supervisor security role to perform this activity.  

Total Merge Functionality 

Selecting to permanently consolidate cases moves or copies the non-lead case data to the lead case. 
This includes the participants, filings, issuances, generated forms/notices, fees, payments, and Case 
History entries associated with the non-lead cases. 

Task Activity 

Perform the following steps to permanently consolidate cases. 
 

1. Select [Case] > [Associate Cases]. 
Result: The Associate Cases – Enter Search Criteria screen displays. 
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2. Enter the Case Number or Legacy Number of a case to consolidate. 
 Selecting the [Select all Related Cases] checkbox will display the cases that are related to 

the selected case in the Case List. 
3. Click the [Add to List] button. 

Result: The Case List screen now displays the entered case. 
 
 

 

4. Repeat Steps 2-3 to add cases to consolidate together into the Case List. 
5. Select a lead case within the list to represent the consolidated group. 
6. Select the [Total Merge of Selected Cases] checkbox. 
7. Click the [Consolidate] button. 

Result: A pop-up message displays to confirm the selection. 
8. Click the [Yes] button to continue with the consolidation of the case contents. 

Result: The Associate Cases – Enter Search Criteria screen re-displays with a confirmation 
message. The system permanently merges the selected cases and their contents together. 
 
 

 

 

 

Related Links 

Consolidated Cases Overview 

Associate Cases - Enter Search Criteria Screen 

Associate Cases - Consolidated Case Listing Screen 

 

Coordinate Cases 

Coordinate Cases Overview  

 

Introduction 

Coordinating cases connects two or more cases together through a common JCCP number. Courts may 
coordinate cases that involve the same parties or address the same issue in multiple courts across the 
state. This association includes both in-county and out-of-county cases. Refer to the Relate Cases 
section for details on associating cases within the same location. 

The coordination process allows you to select one of the involved courts as the assigned jurisdiction 
Court. This Court then becomes the location where the matters pertaining to the coordinated cases are 
heard. 
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Coordination Privileges 

This activity requires that the AOC first grant the motion to coordinate. The AOC will also assign 
jurisdiction of the issue to a specific Court. 

Judgment on Coordinated Cases 

The Court with jurisdiction over the JCCP issue may or may not enter judgment(s) on the individual 
cases. Cases where judgment is entered as part of JCCP are returned to the originating court for 
enforcement. Once this ruling occurs, the Court may then choose to disassociate the coordinated case(s). 
Refer to the Disassociate Cases section for details on this separation process. 

Task Activities 

Coordinating cases includes the following task activities: 

• Create JCCP Cases from Initiate Legacy Case 
• Coordinate In-County Cases 
• Coordinate Out-of-County Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Associate Cases - Enter Search Criteria Screen 

 

My Court Information 

 

Create JCCP Cases from Initiate Legacy Case 

 

Introduction 

If the coordination involves a new JCCP number, then the Court must first create a JCCP case. If the 
JCCP case already exists, then the Court may select the cases to coordinate with this JCCP number. 
Refer to the Initiate Legacy Cases section for details on creating legacy or JCCP cases in the system. 

Task Activity 

Perform the following steps to create a JCCP case. 
 

1. Select [Case] > [Initiate Legacy Case]. 
Result: The Initiate Legacy Case screen displays. 
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2. Enter/Select data into the following required fields: 
3. Case Category 
4. Case Type 
5. Case Status 
6. Case Number 
7. Case Title 
8. Original Filing Date 

 Refer to the Initiate Legacy Cases section for details on entering the required fields in 
order to create a new JCCP case. 

3. Enter a JCCP Case Number. 
 This will be the JCCP case. Selected cases will coordinate by referencing this number. 

4. Select the [Use as Primary Case Number] checkbox. 
5. Click the [Save] button. 

Result: The Associate Cases – Enter Search Criteria screen displays. Refer to the Coordinate In-
County Cases task activity for details on completing the coordination process. 



The Case Section 

471 

 
 

 

 

 

Related Links 

Coordinate Cases Overview 

Initiate Legacy Case Screen 

Associate Cases - Enter Search Criteria Screen 

 

My Court Information 

 

Coordinate In-County Cases 

 

Introduction 

Courts can coordinate in-county cases through the Associate Cases screen. Upon selecting the 
Coordinate option, the system copies the case participants, contact information, roles and statuses from 
the non-JCCP case(s) onto the JCCP case. The system also disposes the non-JCCP cases for the 
duration of the coordination. As a result, the system will stop the non-JCCP case age clock(s) and vacate 
future events scheduled for the non-JCCP cases.  

In-county coordinated cases continue to remain separate cases in the system. This means that filings 
may still occur on the individual non-JCCP cases, as necessary. It is recommended that you select a copy 
of the ruling itself, details of the proceedings, and related minutes to copy onto each coordinated case. 

Task Activity 

Perform the following steps to coordinate a group of in-county cases. 
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1. Select [Case] > [Associate Cases]. 
Result: The Associate Cases – Enter Search Criteria screen displays. 

 
 

 

2. Enter the Case Number or Legacy Number of an in-county case to coordinate. 
 Selecting the Select all Related Cases checkbox will display the cases that are related to 

the selected case in the Case List. 
3. Click the [Add to List] button. 

Result: The Case List screen now displays the entered case. 

 
 

 

4. Repeat Steps 2-3 to add cases to coordinate into the Case List. 
 One of these cases must be the JCCP case. 

5. Click the [Coordinate] button. 
Result: The Associate Cases – Enter Search Criteria screen re-displays with a confirmation 
message. 

 The system will now identify each of these coordinated cases using a "Coordinated" icon. 
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Related Links 

Coordinate Cases Overview 

Associate Cases - Enter Search Criteria Screen 

 

My Court Information 

 

Coordinate Out-of-County Cases 

 

Introduction 

The system does not automatically transfer out-of-county case data to the Court with the JCCP 
jurisdiction. As a result, coordinating out-of-county cases may occur in different ways.  

One way is for you to create a legacy case for the out-of-county case. This allows the case to reside 
within the coordinating court. Once this case exists in your system, you may coordinate it with the 
appropriate JCCP number. Refer to the Create JCCP Cases from Initiate Legacy Case task activity for 
details on this process. 

Another way to coordinate out-of-county data is for you to add the external case as a reference on the 
JCCP case. This will list the out-of-county case as coordinated within the context of the JCCP case.  

Task Activity 

This activity occurs within the context of a previously coordinated JCCP case. It requires that you perform 
a case search and select the JCCP case on which to coordinate with an out-of-county case. This out-of-
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county case cannot reside within your Court. Refer to the Search Cases task activity for details on 
performing a case search. 

Perform the following steps to coordinate a group of out-of-county cases. 
 

1. Select the [Case Details] left navigation item. 
Result: The Case Details screen displays. 

 
 

 

2. Select the [Additional Information] tab. 
Result: The Additional Information tab highlights. 
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3. Click the [Add New Out of County Case] button. 
Result: A blank row of fields displays in the Coordination section. 
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4. Enter the Case Number or JCCP Number of an out-of-county case to add to the coordinated 
group. 

5. Repeat Steps 3-4 to add more out-of-county cases. 
6. Click the [Save] button. 

Result: The screen refreshes with a confirmation message. This out-of-county case is now 
coordinated with the JCCP case. 
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Related Links 

Coordinate Cases Overview 

Case Details Screen 

 

Relate Cases 

Relate Cases Overview  

 

Introduction 

Relating cases associates two or more cases together within a Court. This association indicates that 
there is some commonality or relationship between these cases, such as sharing the same participant(s) 
or covering the same case issue. However, related cases continue to remain distinct [separate] cases. 

Reasons for Relating Cases 

There are several reasons why you may relate cases. One reason is to provide additional information to a 
Court. For example, a Judicial Officer may want to view the cases in which a specific participant is 
involved.  

Another reason is for tracking purposes. For instance, a Court may choose to relate cases before 
consolidating them. This extra step helps to determine whether the related cases should be a single case. 
Refer to the Consolidate Cases section for details on this process. A Court may also choose to relate 
cases for scheduling purposes.  

Relate Cases Functionality 

After you select the cases to relate, the system will list the Case History entries belonging to these cases. 
You can choose only one of these entries to copy onto the cases. It is recommended that you select the 
entry associated with the filing or motion to relate the cases. 

After you save the association, future searches performed on a related case will display an icon indicating 
a relationship with other cases. 

Other Ways to Relate Cases 

The Appeals process also relates cases. This association occurs if the Appellate Division accepts a trial 
court case. Once accepted, the system will automatically relate the Superior Court case to the Appellate 
case. Refer to the Maintain Record on Appeal section for details on this process. 

Removing the Relate Association 

Related cases may be disassociated at a later time. Refer to the Disassociate Cases section for details 
on this separation process. 

Task Activities 

Relating cases includes the following task activity: 

• Relate Cases 
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Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Associate Cases - Enter Search Criteria Screen 

Associate Cases - Related Case Listing Screen 

 

My Court Information 

 

Relate Cases 

 

Introduction 

Relating cases associates two or more cases together within a Court.  

Task Activity 

Perform the following steps to relate two or more cases together. 
 

1. Select [Case] > [Associate Cases]. 
Result: The Associate Cases - Enter Search Criteria screen displays. 
 
 

 

2. Enter the Case Number or Legacy Number of a case to relate. 
 Selecting the [Select all Related Cases] option will display the cases that have an 

association with the entered case in the Case List. 
3. Click the [Add to List] button. 

Result: The screen refreshes and displays the entered case in the Case List. 
 
 

 

4. Repeat Steps 2-3 to add the cases to relate into the Case List. 
5. Click the [Relate] button. 

Result: The Associate Cases - Related Case Listing screen displays. 
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6. Select the radio button for the Case History entry to copy to each case of the related group. 
 You can select only one entry. 

7. Click the [Save] button. 
Result: The Associate Cases - Enter Search Criteria screen displays with a confirmation 
message. 

 The system will now identify each of these related cases using a "Related" icon. 
 
 

 

 

 

Related Links 

Relate Cases Overview 

Associate Cases - Enter Search Criteria Screen 

Associate Cases - Related Case Listing Screen 

 

Disassociate Cases 

Deconsolidate Cases 

Deconsolidate Cases Overview  

 

Introduction 

Deconsolidating a case splits a non-lead case from a consolidated group of cases. This is a type of 
disassociation, although only consolidated cases can be deconsolidated. 

Deconsolidation Restrictions 

The deconsolidation activity does not apply to cases consolidated through the “total merge” process. 
These are cases that have permanently combined the case contents. Refer to the Consolidate Cases 
section for details on consolidation options. 

Deconsolidation Privileges 

This activity requires that a Judicial Officer first grant the motion to deconsolidate. Then you can select 
the case to split from the consolidated group. 

Deconsolidation Functionality 

The system will display the Case History entries recorded on the lead case since the consolidation event. 
From here, you can choose which entries to copy onto the case to be deconsolidated. 

Upon saving the deconsolidation, the system updates participant related information from the lead case 
onto the newly separated case. In other words, participants and their related items (such as roles, 
statuses, dispositions, etc.) which originally belonged to the case being deconsolidated are copied back 
to this case. This includes the changes or additions made to the participant data.  
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In addition, the system copies the filings and their updates that have occurred on the lead case to the 
deconsolidated case. 

Activities Performed After Deconsolidation 

You must manually set the status of the deconsolidated case. This status should reflect the actions that 
were taken on the lead case. You may also need to manually adjust clocks on the deconsolidated case to 
reflect the activities that took place during the consolidation event. Refer to the Manage Case Information, 
Manage Participant Information and Maintain Case Clocks sections for details on these processes. 

Task Activities 

Deconsolidating cases includes the following task activity: 

• Deconsolidate Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Disassociate Cases - Enter Search Criteria Screen 

Disassociate Cases - Case Listing Screen 

Disassociate Cases Screen 

 

My Court Information 

 

Deconsolidate Cases 

 

Introduction 

Deconsolidating a case splits a non-lead case from a consolidated group of cases. 

Task Activity 

Perform the following steps to deconsolidate a case. 
 

1. Select [Cases] > [Disassociate Cases]. 
Result: The Disassociate Cases - Enter Search Criteria screen displays. 
 
 

 

2. Enter the Case Number of one of the following: 
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• the case to deconsolidate, or 
• the consolidated group to which this case belongs. 

 

3. Click the [Search] button. 
Result: The screen refreshes and displays the Case List. This list will contain the available 
matches. 
 
 

 

4. Select the radio button for the consolidated group. 
 The lead case is identified by an icon. The Type field value is "Consolidated." 

5. Click the [Disassociate] button. 
Result: The Disassociate Cases - Case Listing screen displays. 
 
 

 

6. Select the radio button for the case to deconsolidate. 
 The lead case cannot deconsolidate from the group. Each non-lead case must be 

deconsolidated in order to separate the lead case. This will also dissolve the consolidated group. 
7. Click the [Disassociate] button. 

Result: The Disassociate Cases screen displays. 
 
 

 

8. Click the checkboxes for the Case History entries to copy from the lead case to the 
deconsolidated case. 

 The screen displays the Case History entries recorded on the lead case since the 
consolidation event. 

9. Click the [Save] button. 
Result: The Disassociate Cases - Enter Search Criteria screen displays with a confirmation 
message. This case is no longer part of a consolidated group. 

 

 

Related Links 

Deconsolidate Cases Overview 

Disassociate Cases - Enter Search Criteria Screen 

Disassociate Cases - Case Listing Screen 

Disassociate Cases Screen 
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Disassociate Cases 

Disassociate Cases Overview  

 

Introduction 

Disassociating a case “breaks” the connection between a case and an associated case or group of cases. 
These “associations” include consolidated, coordinated, or related case groups. Refer to the 
Deconsolidate Cases section for details on disassociating consolidated cases. 

Disassociation Privileges 

This activity requires that a Judicial Officer first grant a motion to disassociate. You can then select the 
case to split from the coordinated or related group, as appropriate. 

Disassociating Coordinated Cases 

If you choose to disassociate a coordinated case, then the system will display the Case History entries 
recorded on the JCCP case since the coordination event. From here, you can choose which entries to 
copy to the separated case. It is recommended that you copy items such as the coordination ruling, 
details of the proceedings, and related minutes. 

Upon saving, the system breaks the association between the selected case and the coordinated group.  

Disassociating Related Cases 

If you choose to disassociate a related case, then the system will remove the relationship between this 
case and the related group. Since related cases continue to operate as separate cases, there are no 
items that you need to copy onto the disassociated case. 

Task Activities 

Disassociating cases includes the following task activities: 

• Disassociate Coordinated (JCCP) Cases 
• Disassociate Related Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Disassociate Cases - Enter Search Criteria Screen 

Disassociate Cases - Case Listing Screen 

Disassociate Cases Screen 

 

My Court Information 
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Disassociate Coordinated (JCCP) Cases 

 

Introduction 

Disassociating a coordinated (JCCP) case breaks the connection between a case and a coordinated 
group of cases. A disassociated case no longer has a relationship with its previously associated JCCP 
case. 

Task Activity 

Perform the following steps to disassociate a coordinated case. 
 

1. Select [Case] > [Disassociate Cases]. 
Result: The Disassociate Cases – Enter Search Criteria screen displays. 

 
 

 

2. Enter the Case Number of one of the following: 
3. the case to disassociate, or 
4. the coordinated group to which this case belongs. 

 

3. Click the [Search] button. 
Result: The Case List will display with the available case matches. 
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4. Select the radio button for the coordinated group. 
 The Type field value must be “Coordinated.” 

5. Click the [Disassociate] button. 
Result: The Disassociate Cases – Case Listing screen displays. 

 
 

 

6. Select the radio button for the case to separate. 
 The JCCP case cannot be disassociated from the group. Each non-JCCP case must be 

disassociated in order to separate the JCCP case. This will dissolve the coordinated group. 
7. Click the [Disassociate] button. 

Result: The Disassociate Cases screen displays. 
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8. Select the checkboxes for the Case History entries to copy from the JCCP case to the 
disassociated case. 

 The screen displays the Case History entries recorded on the JCCP case since the 
consolidation event. 

 It is recommended that you select such items as the coordination ruling, details of the 
proceedings, and the related minutes. 

9. Click the [Save] button to disassociate the case. 
Result: The Disassociate Cases – Enter Search Criteria screen re-displays with a confirmation 
message. 

 
 

 

 

 

Related Links 
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Disassociate Cases Overview 

Disassociate Cases - Enter Search Criteria Screen 

Disassociate Cases - Case Listing Screen 

Disassociate Cases Screen 

 

My Court Information 

 

Disassociate Related Cases 

 

Introduction 

Disassociating a related case removes the relationship between a case and a related group of cases.  

Task Activity 

Perform the following steps to disassociate a related case. 
 

1. Select [Case] > [Disassociate Cases]. 
Result: The Disassociate Cases – Enter Search Criteria screen displays. 

 
 

 

2. Enter the Case Number of one of the following: 
3. Case to disassociate, or 
4. Related group to which this case belongs. 

 

3. Click the [Search] button. 
Result: The Case List will display with the available case matches. 
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4. Select the radio button for the related group. 
 The Type field value must be "Related." 

5. Click the [Disassociate] button. 
Result: The Disassociate Cases – Case Listing screen displays. 

 
 

 

6. Select the radio button for the case to separate. 
7. Click the [Disassociate] button. 

Result: The Disassociate Cases screen re-displays with a confirmation message. The system 
removes the relationship between the disassociated case and the related group. 
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Related Links 

Disassociate Cases Overview 

Disassociate Cases - Enter Search Criteria Screen 

Disassociate Cases - Case Listing Screen 

 

Appeals 

Maintain Record on Appeal 

Maintain Record on Appeal Overview  

 

Introduction 

Maintaining the record on appeal describes the activities involved in preparing of the Record on Appeal, 
building the representative document set, and saving the selection criteria for the Record on Appeal to the 
database. 

The Record on Appeal is required when submitting appealed cases to the Appellate Division or District 
Court of Appeals. The Record on Appeal represents a subset of the documents within the physical case 
file. 

The Record on Appeal will only contain page numbers, page counts, and footer information for the 
document set if all of the selected documents are scanned electronically and available in the system. If 
the number of pages for a given document is unavailable since the document has not been scanned, then 
the system will allow for the manual data entry of the number of pages for the document. This number will 
then be used when generating the document set and the Record on Appeal table of contents. 
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A Record on Appeal may be created for a Notice of Appeal filing for a case. In some instances, the 
Record on Appeal may be a supplement to a previous record on appeal, or it may apply to multiple 
Notices of Appeal. 

Unscanned Documents 

If you generate the Document Set for the Record on Appeal, and there are unscanned documents for 
which you have manually entered the expected number of pages, then the system will generate the 
document set and note the page number in the footer. 

For example, page number "50" could follow page number "30" in the table of contents and document set 
if you have manually entered an anticipated number of "20" pages for the unscanned document. 

Task Activities 

Maintaining the Record on Appeal includes the following task activities: 

• Certify Record on Appeal 
• Create Record on Appeal 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Receive Appeal Civil Case Overview 
• Submit Appeal Civil Case Overview 

 

 

Related Links 

Maintain Record on Appeal Screen 

 

My Court Information 

 

Certify Record on Appeal 

 

Introduction 

Certifying a record on appeal occurs after the correction period has been completed, just prior to 
submitting to the reviewing court. 

Task Activity 

Perform the following steps to certify a document for a record on appeal. 
 

1. Select [Case] > [Case Search]. 
Result: The Case Search screen displays. 
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2. Enter data in a primary search field or two secondary search fields and any other fields as 
appropriate. 

3. Click the [Search] button. 
Result: The Case Search Results screen displays. 
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4. Select the Case Number hyperlink for the case in which to create the record on appeal. 
Result: The Case Summary screen displays. 

 
 

 

5. Click the [Record on Appeal] left navigation item. 
Result: The Maintain Record on Appeal screen displays. 
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6. Select the checkbox for the record on appeal version you are certifying. 
7. Click the [Certify] button. 

Result: The Maintain Record on Appeal screen re-displays. 
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 The status for the selected filings should now read "Certified." 

 

 

Related Links 

Maintain Record on Appeal Overview 

Case Search Screen 

Case Summary Screen 

Maintain Record on Appeal Screen 

 

My Court Information 

 

Create Record on Appeal 
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Introduction 

Creating a record on appeal is required when you submit appealed cases to the Appellate Division or the 
District Court of Appeals. The Record on Appeal represents a subset of the documents within the physical 
case file. 

A Record on Appeal may be created for every filing of a Notice of Appeal for a case. In some instances, 
the Record on Appeal may be a supplement to a previous record on appeal, or it may apply to multiple 
Notices of Appeal. 

Task Activity 

Perform the following steps to create a record on appeal. 
 

1. Select [Case] > [Case Search]. 
Result: The Case Search screen displays. 

 
 

 

2. Enter data in a primary search field or two secondary search fields and any other fields as 
appropriate. 

3. Click the [Search] button. 
Result: The Case Search Results screen displays. 
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4. Select the case number hyperlink for the case in which to create the record on appeal. 
Result: The Case Summary screen displays. 
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5. Click the [Record on Appeal] left navigation item. 
Result: The Maintain Record on Appeal screen displays. 
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6. Select the radio button(s) for the filings to select the Notice of Appeal and the Version to add or 
update. 

7. Click the [Select] button. 
Result: The Maintain Record on Appeal screen re-displays. 
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8. Select the checkbox for the documents to add to the record on appeal. 
9. Click the [Generate Case Index] button to create a table of contents for the record on appeal. 

Result: The Case Index is generated as a PDF. 
 This creates a table of contents for the record on appeal. 

10. Click the [Generate Document Package] button. 
Result: The Record on Appeal is generated as a PDF. 

 If the case is an Unlimited Civil case, then the system will also PDF the Register of 
Actions. 

 

 

Related Links 

Maintain Record on Appeal Overview 

Case Search Screen 

Case Summary Screen 

Maintain Record on Appeal Screen 
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Receive Appeal Civil Case 

Receive Appeal Civil Case Overview  

 

Introduction 

Receiving appeals for Limited Civil cases describes the activities involved in receiving a record on appeal 
in the Appellate Division. 

These processes begin when the record on appeal is received by the clerk in the Appellate Division. The 
process ends when the remittitur is issued to the trial court, which may or may not change the judgment 
made on the case in the Trial Court. 

Refer to the Submit Appeal Civil Case section for details on certifying a record on appeal from the Trial 
Court. 

Task Activities 

Receiving an appeal for a civil case includes the following task activities: 

• Appeals to be Dismissed 
• Generate Remittitur in Appellate Cases 
• Receipt Remittitur 
• Receipt Appeal Civil Case 
• Record Opinion Cases Under Submission 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
• Maintain Record on Appeal Overview 
• Submit Appeal Civil Case Overview 

 

 

Related Links 

Cases on Appeal - Appeals to be Dismissed Screen 

Cases on Appeal - Appeal Cases: Remittitur Screen 

Cases on Appeal - Receipt Appeals Civil Case Screen 

Cases on Appeal - Receipt Remittitur Screen 

Cases on Appeal - Cases Under Submission Screen 

Create/Update Opinion Screen 

Maintain Record on Appeal Screen 
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My Court Information 

 

Appeals to be Dismissed 

 

Introduction 

Cases on appeal may be dismissed by a Judicial Officer for various reasons, such as Failure to Pay or 
Failure to File Briefs. Appeals to be dismissed must be verified as having been dismissed by a Judicial 
Officer before a Dismissal Notice may be sent to the case participants.  

Cases can only be dismissed if a date of dismissal is listed in the Cases On Appeal - Appeals To Be 
Dismissed screen. 

Task Activity 

Perform the following steps to dismiss an appeal. 
 

1. Select [Case] > [Appeals] > [To Dismiss]. 
Result: The Cases On Appeal - Appeals To Be Dismissed screen displays. 

 
 

 

2. Select the checkbox of the appeal to be dismissed. 
3. Click the [Generate Dismissal Notice] button. 

Result: The Cases On Appeal - Appeals To Be Dismissed screen refreshes with a confirmation 
message. 
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Related Links 

Receive Appeal Civil Case Overview 

Cases on Appeal - Appeals to be Dismissed Screen 

 

My Court Information 

 

Generate Remittitur in Appellate Cases 

 

Introduction 

A Judicial Officer can record an opinion and has the option publishing the opinion. The system displays 
the recorded opinion in the Cases On Appeal - Appeal Cases:Remittitur screen 15 days after the mailing 
of the opinion or publication. 

Generating a remittitur produces a PDF containing the Judicial Officer's opinion, which is printed and 
mailed to the case participants, as well as written to the Case History and to the original trial court case.  

Task Activity 

Perform the following steps to generate a remittitur. 
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1. Select [Case] > [Appeals] > [Create remittitur]. 
Result: The Cases On Appeal - Appeal Cases:Remittitur screen displays. 

 
 

 

2. Select the checkbox for the case on which to create a remittitur. 
3. Click the [Generate remittitur] button. 

Result: The Cases On Appeal - Appeal Cases:Remittitur screen refreshes with a confirmation 
message. 
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Related Links 

Receive Appeal Civil Case Overview 

Cases on Appeal - Appeal Cases: Remittitur Screen 

 

My Court Information 

 

Receipt Remitittur 

 

Introduction 

Remittiturs that are received in the trial courts from reviewing courts are listed on the Cases On Appeal - 
Appeal Cases: Remittitur screen. Receipted remititturs are removed from this list once they are 
processed. 

Task Activity 

Perform the following steps to receipt a remitittur. 
 

1. Select [Case] > [Appeals] > [Receipt Remitittur]. 
Result: The Cases On Appeal - Receipt Remittitur screen displays. 

 
 

 

2. Select the radio button for the remitittur that has been reviewed and processed to remove. 
3. Click the [Remove] button. 

Result: The Cases On Appeal - Receipt Remittitur screen refreshes with a confirmation message. 
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Related Links 

Receive Appeal Civil Case Overview 

Cases on Appeal - Receipt Remittitur Screen 

 

My Court Information 

 

Receipt Appeals Civil Case 

 

Introduction 

Receipting the record on appeal for Limited Civil cases generates a new case number for the appellant 
cases. The Record on Appeal, which may include all case-related information, filing-related information, 
and Register of Actions, is copied over to the appellate case. 

Task Activity 

Perform the following steps to receipt an appeal for a civil case. 
 

1. Select [Case] > [Appeals] > [Receipt Appeal Civil Case]. 
Result: The Cases On Appeal - Receipt Appeal Civil Case screen displays. 
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2. Select the radio button for the appeal to receipt. 
3. Click the [Accept] button. 

Result: The Cases On Appeal - Receipt Appeal Civil Case screen refreshes with a confirmation 
message. 

 
 

 

 

 

Related Links 

Receive Appeal Civil Case Overview 

Cases on Appeal - Receipt Appeals Civil Case Screen 

 

My Court Information 
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Record Opinion Cases Under Submission 

 

Introduction 

Judicial Officers may take appeals under submission for the purpose of recording an opinion about the 
case at a later time. This opinion may be published and sent to the Court Clerk and case participants. 

Task Activity 

Perform the following steps to record an opinion for a case under submission. 
 

1. Select [Case] > [Appeals] > [Under Submission]. 
Result: The Cases on Appeal - Cases Under Submission screen displays. 

 
 

 

2. Select the radio button for the case under submission in which to record an opinion. 
3. Click the [Record Opinion] button. 

Result: The Create/Update Opinion screen displays. 
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4. Enter data in the fields as appropriate. 
 If the Judicial Officer decides to publish the option, select the Publish checkbox. 

5. Click the [Save] button. 
Result: The Create Case Document screen displays. 
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6. Enter data in the appropriate fields. 
7. Click the [Save] button. 

Result: The Case Document Summary screen displays. 

 
 

 

 

 

Related Links 
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Receive Appeal Civil Case Overview 

Cases on Appeal - Cases Under Submission Screen 

Create/Update Opinion Screen 

Create Case Document Screen 

Case Document Summary Screen 

 

Create Small Claims Appeal 

Create Small Claims Appeal Overview  

 

Introduction 

Creating a small claims appeal describes the activities associated with appeals that occur for Small 
Claims cases. 

Task Activities 

Creating a small claims appeal references other task activities. Refer to the following task activities for 
details: 

• Filing Notice of Appeal 
• Notice of Hearing for Trial de Novo 

 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

 

 

Submit Appeal Civil Case 

Submit Appeal Civil Case Overview 

 

Introduction 

Submitting appeals for civil cases describes the activities involved in submitting a Limited Civil case to the 
Appellate Division, or submitting a Unlimited Civil case to the District Court of Appeals. 
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The activities defined here begin when a filing of Notice of Appeal is received on a case. The final 
process occurs when you transfer the certified case (Record on Appeal) to the Appellate Division or 
District Court of Appeals. 

Task Activities 

Submitting a civil case on appeal includes the following task activities: 

• Cases in Default 
• Certify Cases 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Maintain Record on Appeal Overview 
• Receive Appeal Civil Case Overview 

 

 

Related Links 

Cases on Appeal - Review Cases for Defaulting Appeal Screen 

Cases on Appeal - Case Certified: Submit Civil Case For Appeal Screen 

 

My Court Information 

 

Cases in Default 

 

Introduction 

Cases are reviewed from a list of case participants that are currently in default during appeals. When 
generated, the Default Notice will contain text and data specific to a case based on the reason that the 
case participant defaulted (such as failure to designate clerks transcripts, failure to pay, etc.) 

Task Activity 

Perform the following steps to generate a default notice for cases in default. 
 

1. Select [Case] > [Appeals] > [In Default]. 
Result: The Cases On Appeal - Review Cases for Defaulting Appeal screen displays. 
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2. Select the checkbox for the case on which to generate the default notice. 
3. Click the [Generate Default Notice] button. 

Result: The Cases On Appeal - Review Cases for Defaulting Appeal screen refreshes with a 
confirmation message. 
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Related Links 

Submit Appeal Civil Case Overview 

Cases on Appeal - Review Cases for Defaulting Appeal Screen 

 

My Court Information 

 

Certify Cases 

 

Introduction 

Certifying cases on appeal submits cases to the Receipt Appeals Civil Case work queue.  

This process is only performed for appellate, Limited Civil cases that are sent to the Appellate Division. 
Unlimited Civil and Probate cases will not use this process, since they are sent to the District Court of 
Appeals. Small Claims does not use this process.  

Task Activity 

Perform the following steps to certify a case. 
 

1. Select [Case] > [Appeals] > [In Default]. 
Result: The Cases On Appeal - Case Certified: Submit Civil Case for Appeal screen displays. 
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2. Select the checkbox for the cases to certify. 
3. Click the [Submit Case] button. 

Result: The Cases On Appeal - Case Certified: Submit Civil Case for Appeal screen refreshes 
with a confirmation message. 

 
 

 

 

 

Related Links 

Submit Appeal Civil Case Overview 

Cases on Appeal - Case Certified: Submit Civil Case For Appeal Screen 

 

Transfer Cases Out 

Transfer Case Out Overview  

 

Introduction 

Transferring a case out describes the activities involved in transferring the electronic data, physical case 
file, subpoenaed records and exhibits for a case out of a court location. It includes the following 
scenarios: 

• County to County Transfers (Change of Venue) 
• Location to Location Transfers 
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This activity may originate from a minute order. Refer to the Record Minutes - Code Based section for 
details on this process. When a minute order related to the transfer of a case is recorded, case transfer 
activities occur upon the finalization of the minute order. 

Case transfers may be required for the following reasons: 

• Before Commencement: An action is started in a court that lacks jurisdiction of the subject matter 
for that action (such as specifying an incorrect court). 

• After Commencement: 
• JCCP Cases 
• Case Reclassifications 
• Stipulation of Change of Venue 
• Motion to Change Venue 
• Consolidation or Coordination 
• Relocation of conservatee or minor 

 

 

Cases cannot be electronically transferred out of the State of California. This task targets activities 
relating to case transfers (out of a court location) that come as a result of a Change of Venue or location-
to-location transfers. Case Reclassification and JCCP Cases are separate task activities. Refer to the 
Receive Transferred Cases section for details on transferring a case into a court location. 

Transfers Between Courts 

Transferring electronic data for a case assumes that your court and the target court are both running on 
the same instance of the system. The system will determine if the receiving court is deployed on the same 
instance of the system as the court submitting a case transfer. If so, the system will populate the Receive 
Transferred Cases list in the receiving court. 

Associated Volumes 

The system will determine all associated volumes that contain the physical case file for the case to be 
transferred out. These associated volumes will populate the case file and volume information within the 
Case File Location Change Request screen. 

Associated Exhibits 

The system will determine all associated exhibits for the case that will be transferred out. These 
associated exhibits will populate the case and exhibit information within the Exhibit Location Change 
Request screen. 

Associated Subpoenaed Records 

The system will determine if any subpoenaed records exist for the transferred cases that have not been 
disposed. If there are associated subpoenaed records, the system will prompt you that subpoenaed 
records must also be transferred to the receipting court. 

Vacating Future Events 

If a case is being transferred from one county to another, the system will automatically vacate any future 
events for the transferred case within the submitting court. 

Change of Venue 

If an ex parte petition to transfer a case (change of venue) is granted, then the system will navigate you 
from the Grant/Deny function to the Transfer Case Out function. 
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Task Activities 

Transferring cases out includes the following task activity: 

• Transfer Case Out (within the context of a case) 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
 

 

Related Links 

Case Transfers Out Screen 

Transfer Case Out Screen 

 

My Court Information 

 

Transfer Case Out 

 

Introduction 

Transferring a case out involves transferring the electronic data, physical case file, subpoenaed records, 
and exhibits for a case from one court location to another. 

The system determines whether the transfer fee has been paid by the case participant. This depends on 
whether the transfer is location-to-location or county-to-count. If the reason for the change in venue is due 
to the plaintiff filing the case in the wrong court, then the plaintiff must pay for the transfer fees [CCP 399]. 

The system determines if the receipting court is using the same system instance as the submitting court. 
If so, then items such as case, participant, and Register of Actions data will be made visible to the 
receipting court when receiving the case. 

Transfer Fee 
The system determines whether the transfer fee has been paid by the case participant (dependant on if 
the transfer is location-to-location or county-to-county). If the reason for the change in venue is that the 
plaintiff filed the case in the "wrong court" the plaintiff must pay for the fees [CCP 399]. 

Selecting a Case to Transfer Out 

When viewing the list of cases to be transferred out, the system will pre-populate the result set with a list 
of cases to be transferred out of your location, without requiring you to enter any filter criteria. 

Task Activity 

This activity takes place in the context of a case search. Refer to the Search Cases task activity for details 
on this process. 

Perform the following steps to transfer a case out. 
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1. Select the Case Number hyperlink for the case to transfer out. 
 This selection occurs from the Search Case Results screen. 

 
 

 

2. Result: The Case Summary screen displays. 
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2. Select the [Transfer Case Out] left navigation item. 
Result: The Transfer Case Out screen displays. 
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3. Select a Court. 
4. Click the [Transfer] button. 

Result: The Physical Case File Location Change Request screen re-displays. 
 Use this screen to transfer any physical case files associated with the case. 

 
 

 

5. Click the [Next] button. 
Result: The Exhibit Location Change Request screen displays. 

 Use this screen to transfer any exhibits associated with the case. 



Printed Documentation 

520 

 
 

 

6. Click the [Next] button. 
Result: The Transfer Case Out screen displays. 

 The system will determine if any subpoenaed records exist for the transferred case that 
have not been disposed. If there are associated subpoenaed records, then the system will prompt 
you that the subpoenaed records must be transferred to the receipting court. 
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7. Select a Court. 
8. Click the [Transfer] button. 

Result: The Search Case Results screen re-displays. 

 
 

 

 

 

Related Links 

Transfer Case Out Overview 

Case Search Screen 

Case Summary Screen 
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Transfer Case Out Screen 

Case Transfers Out Screen 

Records Management - Physical Case File Location Change Request Screen 

Records Management - Exhibit Location Change Request Screen 

 

Receive Transferred Cases 

Receive Transferred Cases Overview  

 

Introduction 

Receiving transferred cases involves receiving a transferred case from another court location, including 
the following: 

• County to County Transfers 
• Location to Location Transfers (within a county) 

 

 

Transferring cases is used for location to location, intra-county transfers since the following information 
needs to be documented: 

• The movement of the physical case file 
• The movement of associated exhibits 
• The movement of subpoenaed records 
• The vacating or continuance of events in the submitting court 
• The updating of case number attributes including location 

 

 

When the receipted case is from a submitting court that is not on the same system instance as the 
receiving court, receipting the physical case file would involve the initiation of a new case within the 
system. 

Method of Receipt 

Case files that are receipted electronically are visible to you within the system. Case files that are 
receipted physically with no corresponding electronic record (as when the submitting court does not use 
the system) will be initiated as any other case within the system. 

If both the submitting and receiving courts utilize the same system instance, this process would include 
accepting or rejecting the electronic case data and the physical case file. 

Case Numbers 

When transferring cases from one county to another, the system uses the case information provided from 
the originating court, and initiates a new case within the receiving court. The system will keep the 
association between the old and new case numbers. 

Case Numbers 
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When transferring cases from one location to another within the same county, the system updates the 
location attribute of the case number. The system does not transfer any data to a new case, but provides 
visibility to the data in its current state within the original case. 

Task Activities 

Receiving transferred cases includes the following task activities: 

• Accept Transfer Case 
• Reject Transfer Case 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
 

 

Related Links 

Receive Transferred Case Screen 

Received Transfer Case Rejection Screen 

Rejected Transferred Cases Screen 

 

My Court Information 

 

Accept Transfer Case 

 

Introduction 

Accepting transferred cases involves the receiving court viewing a received case and determining if the 
information is complete and accurate so that it can be accepted. Once accepted, the system vacates any 
future events for the original case in the submitting court. 

The system determines, based on the submitting court location, if the transfer is inside or outside the 
court's jurisdictional county. This information is necessary as location-to-location transfers within a county 
do not require a new case number and will not automatically vacate the calendared events in the 
submitting court. 

When transferring cases from one county to another, the system uses the case information provided from 
the originating court and initiates a new case within the receiving court. The system keeps the association 
between the old and new case numbers. 

Case Financial/Accounting Transactions 

When transferring a case, the accounting/financial transactions for the case will not be transferred from 
one county to another. Fees may be viewed based on their respective entries in the Register of Actions 
for Change of Venue (out-of-county) transfers. For transfers from one location to another within a case, 
financial transactions, as they relate to a county and not a location within the county. 
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Cases From a Different County 

When you accept a transferred case from a different county, the system automatically creates an initial 
appearance fee in the receipting court for the filing participant. 

Task Activity 

Perform the following steps to receive a transferred case. 
 

1. Select [Case] > [Transfer Cases] > [Receive Transferred Cases]. 
Result: The Receive Transferred Case screen displays. 

 
 

 

 When viewing a list of cases to be received, the system pre-populates the result set with 
a list of cases to be transferred to your location. You may configure the results set by entering 
filter criteria. 

2. Select the radio button for the cases to accept. 
3. Click the [Accept] button. 

Result: The Receive Transferred Case screen refreshes with a confirmation message stating that 
the case transfer request was accepted. 
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Related Links 

Receive Transferred Case Overview 

Receive Transferred Case Screen 

 

My Court Information 

 

Reject Transfer Case 

 

Introduction 

Rejecting transferred cases describes the process involved when a receiving court rejects a selected 
case, including the electronic case data and the physical case file, from the submitting court. 

The system updates a "Case Rejected" flag in the system that will provide visibility to both the submitting 
and receiving courts showing that the case has been rejected. The flag will allow the receiving court to 
review rejected cases, providing visibility to actions that must be taken by the court when receipting the 
physical case file (such as forwarding the file on to the correct court). 

Task Activity 

Perform the following steps to reject a transferred case. 
 

1. Select [Case] > [Transfer Cases] > [Receive Transferred Cases]. 
Result: The Receive Transferred Case screen displays. 
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2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Filter] button. 

Result: The Receive Transferred Case screen re-displays cases submitted to your court. 

 
 

 

4. Select the radio button for the case to reject transfer.  
5. Click the [Reject] button. 

Result: The Received Transfer Case Rejection screen displays. 
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6. Enter/Select data for the following required fields: 

• Date of Rejection 
• Comments 
• Contact Name 

 

7. Click the [Save] button. 
Result: The Receive Transferred Case screen re-displays. 

 
 

 

 

 

Related Links 

Receive Transferred Cases Overview 

Receive Transferred Case Screen 
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Received Transfer Case Rejection Screen 

 

Records Management 

Mark Exhibits 

Mark Exhibits Overview  

 

Introduction 

Marking Exhibits allows you to mark exhibits in the courtroom or pre-mark exhibits for use in the 
courtroom during the hearing. 

Previously marked exhibits can be re-marked along with other updates. Refer to the Maintain Exhibits 
section for details on updating previously marked exhibits.  

Task Activities 

Marking exhibits includes the following task activity: 

• Mark Exhibits 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Mark/Maintain Exhibits - Event list Screen 

Mark Exhibit Screen 

 

My Court Information 

 

Mark Exhibits 

 

Introduction 

Marking exhibits allows you to associate an exhibit to a calendar event in the system.    

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for details on 
performing a case search.  



The Case Section 

529 

Perform the following steps to mark an exhibit.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Mark Exhibit] button.  

Result: The Mark Exhibit screen displays. 
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4. Enter/Select data for the following required fields: 

• Submitted By - Role 
• Submitted By - Name 
• Exhibit Number 
• Exhibit Description 
• Date Marked 
• Exhibit Status 

 The Exhibit Number field must be unique.  

5. Click the [Save] button. 
Result: The Mark/Maintain Exhibits - Events List screen displays with a confirmation message.  
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6.  If you want to mark additional exhibits for the event, click the [Save & Add Another] button. 
Result: The Mark Exhibit screen refreshes with a confirmation message. 
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Related Links 

Mark Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Mark Exhibit Screen 

 

Maintain Exhibits 

Maintain Exhibits Overview  

 

Introduction 

Maintaining Exhibits describes the process of re-marking, releasing, and updating previously marked 
exhibits. It also allows you to declare exhibits as lost, print exhibit list and tags, and import the exhibit list.  
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In order to maintain exhibits, marked exhibits must exist in the system. Refer to the Mark Exhibits section 
for details on marking exhibits.  

Your can re-mark a previously marked exhibit if it was marked/identified in a previous hearing and then 
re-used in another event. Re-marking an exhibit allows you to refer to the previously created exhibit and 
assign it a new exhibit number without having to re-enter the information associated with the exhibit. 

Exhibits may be released to case participants after they are marked. Releasing an exhibit is considered a 
disposition of the exhibit.  

Task Activities 

Maintaining exhibits include the following task activities: 

• Re-Mark Exhibit 
• Re-Mark Exhibits in Mass 
• Update Exhibit 
• Update Exhibit Status in Mass 
• Release Exhibit 
• Return Exhibit 
• Declare Exhibit Lost 
• Print Exhibit List 
• Print Exhibit Tags 
• Import Exhibit List 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 
• Exhibit List Example 

 

 

Related Links 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

Import Exhibit Screen 

Release Exhibit Screen 

Search and Re-Mark Exhibits Screen 

Mark Exhibit Screen 

 

My Court Information 

 



Printed Documentation 

534 

Re-Mark Exhibit 

 

Introduction 

Remarking exhibits is the process of associating a previously marked exhibit to a new event/case in the 
system.  

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for more 
details on this process.  

Perform the following steps to re-mark exhibits.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item.  
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
 Select the new event you would like to associate a previously marked exhibit with.  

3. Click the [Re-Mark Exhibit] button.  
Result: The Search and Re-Mark Exhibits screen displays. 
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4. Enter/Select data for the following required fields: 

• Case Number or Legacy Number 
• Event Date 

 

5. Click the [Search] button. 
Result: The Search and Re-Mark Exhibits screen refreshes with the search results.  
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6. Select the checkbox for an exhibit. 
7. Click the [Select] button.  

Result: The Re-Mark Exhibit screen displays with the appropriate information.  
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8. Enter/Update the available files as needed. 
9. Click the [Save] button. 

Result: The Mark/Maintain Exhibits - Events List screen displays with a confirmation message. 
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10.  If you want to re-mark additional exhibits, click the [Save & Re-Mark Another] button.  
Result: The Search and Re-Mark Exhibits screen displays with a confirmation message containing the 
previous search results. 
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Search and Re-Mark Exhibits Screen 

Mark Exhibit Screen 

 

My Court Information 

 



Printed Documentation 

540 

Re-Mark Exhibits in Mass  

 

Introduction 

Remarking exhibits in batch allows you to update basic information for previously marked exhibits in 
mass.  

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for more 
details on this process.  

Perform the following steps to re-mark exhibits in mass.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item.  
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
 Select the new event you would like to associate a previously marked exhibit with.  

3. Click the [Re-Mark Exhibit] button.  
Result: The Search and Re-Mark Exhibits screen displays. 
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4. Enter/Select data for the following required fields: 
5. Case Number or Legacy Number 
6. Event Date 

 

5. Click the [Search] button. 
Result: The Search and Re-Mark Exhibits screen refreshes with the search results.  
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6. Select the checkboxes for more than one exhibit.  
7. Enter/Select data for the following required fields: 

• Submitted By - Role 
• Submitted By - Name 
• Date Marked  

 You can also update the New Exhibit Number field.  

8. Click the [Re-Mark in Mass] button. 
Result: The Mark/Maintain Exhibits - Events List screen displays with a confirmation message.   
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Search and Re-Mark Exhibits Screen 

 

My Court Information 

 

Update Exhibit  

 

Introduction 

Updating an exhibit changes the record of a previously marked exhibit.  

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for more 
details on this process.  

Perform the following steps to update exhibit information.  
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1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 
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4. Select the checkbox for an exhibit. 
5. Click the [Update] button.  

Result: The Update Exhibit screen displays with appropriate information.  
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6. Enter/Update the available fields as needed. 
7. Click the [Save] button. 

Result: The Mark/Maintain Exhibits - Events List screen displays with a confirmation message.    
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

Mark Exhibit Screen 

 

My Court Information 

 

Update Exhibit Status in Mass 

 

Introduction 

Updating an exhibit is batch is the process of editing the status of the previously marked exhibits in mass.  

Task Activity 
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This activity takes place within a context of a case. Refer to the Search Cases activity for more details on 
this process.  

Perform the following steps to update exhibits in batch.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 



The Case Section 

549 

 
 

 

4. Select the checkboxes for more than one exhibit.  
5. Select a new Update Status.  
6. Click the [Update Status] button.  

Result: The Maintain Exhibits - Exhibit List screen refreshes with a confirmation message. 
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

 

My Court Information 

 

Release Exhibit 

 

Introduction 

Releasing an exhibit returns the exhibit to a specified party. The exhibit can be released temporarily or 
permanently.  

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for more 
details on this process.  
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Perform the following steps to release exhibits.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 



Printed Documentation 

552 

 
 

 

4. Select the checkbox for an exhibit. 
 More than one exhibit may be selected to be released. 

5. Click the [Release] button.  
Result: The Release Exhibit screen displays. 
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6. Enter/Select data for the following required fields: 

• Release To – Role 
• Release To – Name 
• Date of Release 

 The Release Temporarily checkbox can be selected for exhibits to be released for a 
temporary period of time. The Generate Receipt checkbox can be selected for receipts to be 
generated.   

7. Click the [Release] button. 
Result: The Maintain Exhibits - Exhibit List screen displays with a confirmation message.  
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

Release Exhibit Screen 

 

My Court Information 

 

Return Exhibit 

 

Introduction 

Returning an exhibit is the process of checking in a temporarily released exhibit.  

Task Activity 
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This activity takes place within a context of a case. Refer to the Search Cases task activity for more 
details on this process.  

Perform the following steps to return an exhibit.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 
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4. Select the checkbox for an exhibit. 
 The exhibit selected must have a "Temporarily Released" icon associated to it.  

5. Click the [Returned] button.  
Result: The Maintain Exhibits - Exhibit List screen refreshes with a confirmation message.  
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

 

My Court Information 

 

Declare Exhibit Lost 

 

Introduction 

Declaring an exhibit lost is the process of flagging the exhibits as lost in the system.  

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for details on 
this process.  
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Perform the following steps to declare lost exhibits.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event. 
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 
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4. Select the checkbox for the lost exhibit. 
 More than one exhibit may be selected to declare multiple exhibits as lost.   

5. Click the [Declare Lost] button.  
Result: The Maintain Exhibits - Exhibit List screen refreshes with a confirmation message.  
The "Declaration of Lost Exhibits" form is generated.  
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

 

My Court Information 

 

Print Exhibit List 

 

Introduction 

This activity allows you to print the exhibit information for a specified event.  

Task Activity 

This activity takes place within a context of a case.  Refer to the Search Cases task activity for more 
details on this process.  
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Perform the following steps to the print exhibit list.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 
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4. Select the checkbox for an exhibit. 
 More than one exhibit may be selected to print multiple exhibits.   

5. Click the [Print Exhibit List] button.  
Result: The Printer Dialog box displays and the system prints the physical exhibit list report. 

 

 

Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event list Screen 

Maintain Exhibits - Exhibit List Screen 

 

My Court Information 

 

Print Exhibit Tags 

 

Introduction 

This activity allows you to print the exhibit tag information for a specified exhibit.  
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Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases task activity for more 
details on this process.  

Perform the following steps to print exhibit tags.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event.  
3. Click the [Maintain Exhibit] button.  

Result: The Maintain Exhibits - Exhibit List screen displays. 
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4. Select the checkbox for an exhibit. 
 More than one exhibit may be selected to print multiple exhibit tags.   

5. Click the [Print Tags] button.  
Result: The Printer Dialog box is displays and the system prints the physical exhibit tag(s). 

 

 

Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event list Screen 

Maintain Exhibits - Exhibit List Screen 

 

My Court Information 

 

Import Exhibit List 

 

Introduction 
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Importing exhibits is the process of importing exhibit information into the system.  The imported exhibits 
will have the status of "Marked" in the system.  

The exhibit list to be imported must have Microsoft Excel (version 2000 and above) as the file source and 
no formulas will be allowed.  Please see the Import Exhibit - Exhibit List Example for more details.  

Task Activity 

Perform the following steps to import an exhibit list.  
 

1. Click the [Mark/Maintain Exhibits] left navigation item.  
Result: The Mark/Maintain Exhibits - Events List screen displays.  

 
 

 

2. Select the checkbox for an event. 
3. Click the [Import Exhibits] button.  

Result: The Import Exhibits screen displays. 
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4. Enter the File Name..  
 If the File Name is not known, you can search for the file by using the [Browse] button.  

5. Click the [Import] button. 
Result: The Mark/Maintain Exhibits - Events List screen refreshes with a confirmation message.  
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Related Links 

Maintain Exhibits Overview 

Mark/Maintain Exhibits - Event List Screen 

Import Exhibit Screen 

 

Create Exhibit Pull List 

Create Exhibit Pull List Overview  

 

Introduction 

You can request exhibits from your location as well as other facilities and locations that store exhibits. 
These requests supply information to the system used to create a "Pull List," which is a list of cases and 
associated exhibits required at a specific place, time and location. 

The pull list can also be created from a list of exhibits associated with an event. Refer to the Maintain 
Exhibits and Mark Exhibits sections for details on this activity. 

Requesting Exhibits 

Requests for exhibits can be made within the context of a case. This will select all exhibits associated 
with an event on the case. Requests for exhibits can also be made outside of a case, such as when a 
request involves multiple cases based on a court calendar or other criteria. 

Task Activities 

Creating an exhibit pull list includes the following task activities: 

• Add Exhibits to the Pull List 
• Search Exhibits Inside the Context of a Case 
• Search Exhibits Outside the Context of a Case 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Records Management - Search Screen  

Records Management - Exhibit Location Change Request Screen 

Mark/Maintain Exhibits - Event List Screen 
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My Court Information 

 

Add Exhibits to the Pull List 

 

Introduction 

Adding an exhibit to the pull list records a request for a list of exhibits that are required for use at a 
specific time and location. The system will then confirm the availability of the exhibit before adding it to 
the pull list.  

Exhibit Availability 

If an exhibit is unavailable for the selected date and time, then the system will alert you of this 
unavailability. However, you can still add these exhibits to the pull list. The system will also confirm that 
the requested exhibit is not already in the specified location. If it is, then the system will warn you that the 
exhibit is already in the requested location. 

Exhibit Status 

If an exhibit status is defined as "Missing," "Destroyed," "In Appeals" or "Change of Venue," then the 
system will display an error message and prevent you from completing the request. 

Task Activity 

This activity takes place in the context of an exhibit search. Refer to the Search Exhibits Outside the 
Context of a Case task activity for details on this process. 

Perform the following steps to add an exhibit to the pull list. 
 

1. Select the checkbox for the exhibit to be pulled. 
 This selection occurs from the Search Exhibits Results screen. 
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2. Click the [Add to Pull List] button. 
Result: The Exhibit Location Change Request screen displays. 
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3. Enter/Select data for the following required fields: 
o Date Needed 
o Time Needed 
o Requester's Name 
o To Location 

 The Requester's Name field automatically displays the requester's system ID. 

4. Click the [Save] button. 
Result: The Search Exhibits Results screen refreshes with a confirmation message. 

 
 

 

 

 

Related Links 

Create Exhibit Pull List Overview 

Records Management - Exhibit Location Change Request Screen 

Records Management - Search Screen 

 

My Court Information 
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Search Exhibits Inside the Context of a Case 

 

Introduction 

This activity allows you to search for exhibits within the context of a case. You can perform this type of 
search when the location change request applies to exhibits that are associated with the case that you 
are currently viewing. You can then select the exhibits that are associated with the applicable events on 
that case. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Default Search Location 

When performing a search for exhibits, the location search criteria will default to your current location. 

Exhibits in Your Location 

The system will display an error message if you attempt to add an exhibit to the pull list that is already 
stored in your location. 

Task Activity 

This activity takes place in the context of a case. It requires that you perform a case search and select the 
case on which to add a note. Refer to the Search Cases task activity for details on performing a case 
search. 

Perform the following steps to search for exhibits within the context of a case. 
 

1. Select the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Event List screen displays. 
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Related Links 

Create Exhibit Pull List Overview 

Mark/Maintain Exhibits - Event List Screen 

 

My Court Information 

 

Search Exhibits Outside the Context of a Case 

 

Introduction 

This activity allows you to search for exhibits outside the context of a case. You can perform this type of 
search when one or more exhibits apply to multiple cases that are calendared for a specific courtroom at 
a specific time. 

Refer to the Search Feature Overview for details on performing a search in the system. 
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Default Search Location 

When performing a search for exhibits, the location search criteria will default to your current location. 

Exhibits in Your Location 

The system will alert you if you attempt to add an exhibit to the pull list that is already stored in your 
location. 

Task Activity 

Perform the following steps to search exhibits outside the context of a case. 
 

1. Select [Case] > [Records Management]. 
Result: The Records Management - Search screen displays. 

 
 

 

2. Select the [Exhibit] tab. 
Result: The Exhibits tab highlights and displays the appropriate information. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Exhibits Results screen displays. 
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Related Links 

Create Exhibit Pull List Overview 

Records Management - Search Screen 

 

Track Exhibits 

Track Exhibits Overview  

 

Introduction 

Tracking exhibits changes the location of an exhibit from the Exhibit Unit to a separate courtroom, 
location, county/court, etc. and vice versa. 

This process incorporates maintaining a "Chain of Custody" during the updating of the location of the 
exhibit and defines when a change of ownership of an exhibit has occurred at a specific time and where 
the exhibits are now located. 
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Exhibits may be located to separate locations (such as a building, room, or place) within a court's 
jurisdiction. Exhibits may also be located outside of a court's jurisdiction (such as through a Change of 
Venue). 

You can update the location of an exhibit within the context of a case (selecting all exhibits associated 
with events in a case), or outside the context of a case (in the scenario where a request may span 
multiple cases based on a court calendar or any other criteria). 

Task Activities 

Tracking exhibits includes the following task activities: 

• Change Exhibit Location Inside the Context of a Case 
• Change Exhibit Location Outside the Context of a Case 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Records Management - Search Screen 

Mark/Maintain Exhibits - Event List Screen 

Records Management - Exhibit Location Change Request Screen 
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Change Exhibit Location Inside the Context of a Case 

 

Introduction 

You can change the location of an exhibit that is inside the context of a case if the location update applies 
to exhibits associated with the case that you are currently viewing. You can then select exhibits 
associated with events applicable to the case. 

Unavailable Exhibits 

The system will prompt you if the exhibits that you selected are currently unavailable. Statuses that 
indicate unavailability include "In Transit," "Destroyed" or "Courier." In addition, if the last location of the 
exhibit is "Missing," then the user ID of the previous owner for the exhibit will display. 

Exhibits Requiring Special Handling 

When locating an exhibit to the Exhibit Unit, the system will prompt you if any of the following is true: 
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• Biohazard: Item should be placed in quarantine. This is a sensitive exhibit that requires special 
handling. 

• Valuable Items: You will be prompted to place these items in the vault. 
• Weapons (firearms, knives, etc.): You will be prompted that these items require special 

handling and need to be placed in the vault. 
• Hazardous Waste Material: You will be prompted that these items require special handling 

(gloves, etc.) and need to be placed in a designated location. 
• Money: You will be prompted to place these items in the vault. 
• Narcotics: You will be prompted that these items require special handling and need to be placed 

in the vault. 
• Paraphernalia: You will be prompted that these items require special handling and need to be 

placed in the vault. 

Exhibit Change Location Details 

The Exhibit Change Location Details screen will display your system user ID, contact information, and 
location information by default. The Expected Return Date field defaults to 14 days after your request 
date. 

Task Activity 

This activity takes place in the context of an exhibit search outside the context if a case. Refer to the 
Search Exhibits Outside the Context of a Case task activity for details on this process. 

Perform the following steps to change an exhibit location. 
 

1. Select [Case] > [Records Management] > [Exhibit]. 
Result: The Records Management - Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search Exhibit Results screen displays. 
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4. Click the Case Number hyperlink of the case in which to change the location of the exhibit. 
Result: The Case Summary screen displays. 
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5. Click the [Mark/Maintain Exhibits] left navigation item. 
Result: The Mark/Maintain Exhibits - Event List screen displays.  
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6. Select the checkbox for the exhibit to change location. 
7. Click the [Maintain Exhibit] button. 

Result: The Maintain Exhibit screen displays. 
8. Select the checkboxes for the exhibits to change location. 
9. Click the [Change Location] button. 

Result: The Exhibit Change Location Details screen displays. 
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10. Enter/Select data for the following required fields: 
o Custodian Name 
o To Location 

 The "To Location" is the new location of the exhibit. 

11. Click the [Save] button. 
Result: The Search Exhibits Results screen refreshes to show the updated exhibit location 
details. 
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Related Links 

Track Exhibits Overview 

Records Management - Search Screen 

Case Summary Screen 

Mark/Maintain Exhibits - Event List Screen 

Records Management - Exhibit Location Change Request Screen 

 

My Court Information 

 

Change Exhibit Location Outside the Context of a Case 

 

Introduction 
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This activity allows you to change the location of an exhibit outside the context of a case. You can 
perform this activity when you require the exhibits which apply to multiple cases that are calendared for a 
specific courtroom at a specific time. 

The location of an exhibit is changed after an exhibit has been added to the pull list and transferred to the 
requested location. Once a transferred exhibit is received, you can update the details of the exhibit 
location within the system. 

Unavailable Exhibits 

The system will prompt you if the exhibits that you selected are currently unavailable. Statuses that 
indicate unavailability include "In Transit," "Destroyed" or "Courier." In addition, if the last location of the 
exhibit is "Missing," then the user ID of the previous owner for the exhibit will display. 

Exhibits Requiring Special Handling 

When locating an exhibit to the Exhibit Unit, the system prompts you if any of the following is true: 

• Biohazard: Item should be placed in quarantine. This is a sensitive exhibit that requires special 
handling. 

• Valuable Items: You will be prompted to place these items in the vault. 
• Weapons (firearms, knives, etc.): You will be prompted that these items require special 

handling and need to be placed in the vault. 
• Hazardous Waste Material: You will be prompted that these items require special handling 

(gloves, etc.) and need to be placed in a designated location. 
• Money: You will be prompted to place these items in the vault. 
• Narcotics: You will be prompted that these items require special handling and need to be placed 

in the vault. 
• Paraphernalia: You will be prompted that these items require special handling and need to be 

placed in the vault. 

Exhibit Change Location Details 

The Exhibit Change Location Details screen will display your system user ID, contact information, and 
location information by default. The Expected Return Date field defaults to 14 days after your request 
date. 

Task Activity 

This activity takes place in the context of an exhibit search outside the context if a case. Refer to the 
Search Exhibits Outside the Context of a Case task activity for details on this process. 

Perform the following steps to change an exhibit location. 
 

1. Select the checkbox for the exhibit location to be changed. 
 This selection occurs from the Records Management - Search screen. 
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2. Click the [Change Location] button. 
Result: The Exhibit Change Location Details screen displays. 
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3. Enter/Select data for the following required fields: 
o Custodian Name 
o To Location 

 The "To Location" is the new location of the exhibit. 

4. Click the [Save] button. 
Result: The Search Exhibits Results screen refreshes to show the updated exhibit location 
details. 
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Related Links 

Track Exhibits Overview 

Records Management - Search Screen 

 

Identify/Review Exhibits to be Destroyed 

Identify Exhibits to be Destroyed Overview 

 

Introduction 

Identifying exhibits to be destroyed describes the activities performed by the system to identify those 
exhibits that could potentially be disposed of or destroyed. This process involves updating the status of 
the physical exhibit to "Eligible for Destruction" or "Pending destruction," depending on where the exhibit 
is in its life-cycle. 

Notice of Intent to Destroy 

Identifying exhibits to be destroyed involves determining the retention time frame, which follows the final 
disposition of a case, for an exhibit belonging to a specific case category and type. Once the retention 
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time frame expires, the exhibit status is updated to "Eligible for Destruction." This allows you to generate 
and mail a "Notice of Intent to Destroy" document to all parties. Refer to the Review Cases to be 
Destroyed section for details. 

Exhibits Pending Destruction 

Once the "Notice of Intent to Destroy" is mailed to a party, sufficient time must pass in order to allow the 
party adequate time to respond to the notice. If the party does not respond within the defined time frame, 
then the system will update the status to "Pending Destruction," which identifies exhibits that you can now 
destroy. Refer to the Dispose or Destroy Exhibits section for details on this process.  

Batch Utility 

Identifying exhibits to be destroyed is accomplished through a batch utility that does not require user 
intervention. This batch utility runs based on a schedule that is defined by the system administrator (daily, 
weekly, monthly, quarterly, semi-annually, annually, etc.). 

Exhibit Retention Time Frame for Case Category and Case Type 

The exhibit retention period is configurable by case category and type. The retention period is defined as 
the amount of time an exhibit must be stored in order to allow for the notice of appeal time period to 
expire. This time frame is configurable by court. 

The following retention timelines currently exist for each case category if a Notice of Entry of Judgment 
has been recorded within the Register of Actions on a case: 

• Limited Civil exhibits: 30 days  
• Unlimited Civil exhibits: 30 days 
• Small Claims exhibits: 30 days  

 

 

The following retention timelines currently exist for each case category if a "Notice of Entry of Judgment" 
has not been recorded within the Register of Actions on a case: 

• Limited Civil exhibits: 90 days 

• Unlimited Civil exhibits: 90 days  

• Small Claims exhibits: 90 days  
 

 

The total amount of time to wait before sending the "Notice of Intent to Destroy" must be equal to the 
retention period plus any additional time that you require to review the exhibit. 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
 

 

Related Links 

Records Management - Search Screen 
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Review Exhibits to be Destroyed Overview  

 

Introduction 

Reviewing exhibits to be destroyed involves noticing an exhibit recipient of the intent to destroy an exhibit. 
You can also extend the time frame to research the exhibit or case further before noticing the exhibit 
recipient of the intent to destroy. 

Refer to the Dispose or Destroy Exhibits section for details on destroying exhibits. 

Notice of Intent to Destroy Exhibit 

A "Notice of Intent to Destroy" must be mailed to an exhibit recipient for a selected exhibit before that 
exhibit can be destroyed. Once the notice is sent, the case associated with the exhibit that must be 
destroyed will not appear within the "Review exhibits to be destroyed" function. However, the case will 
appear at a later point in time (if no remedy is taken by the exhibit recipient) within the Dispose or Destroy 
Exhibits function. 

Disposition Type 

When selecting exhibits to review for destruction, you can filter the result set by the Disposition Type, as 
some disposition types allow for less research before sending the Notice of Intent to Destroy (as with 
"Dismissed" cases). 

Exhibits to be Destroyed Results Set 

When accessing the list of cases that have associated exhibits that need to be destroyed, the system pre-
populates the result set with a list of cases that have associated exhibits within your court, without 
requiring you to select any filter criteria. 

Task Activities 

Reviewing exhibits to be destroyed includes the following task activities: 

• Extend Time Frame for Review 
• Generate Notice of Intent to Destroy Exhibits 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
 

 

Related Links 

Records Management - Exhibits Screen 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

Records Management - Extend Timeframe to Review Exhibits Screen 
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My Court Information 

 

Extend Time Frame for Review 

 

Introduction 

Extending the time frame updates the status of an exhibit associated with the selected case to "Active." It 
also extends the number of days for reviewing an exhibit before it is destroyed.  

The system allows you to enter an extension date or the number of days in which to review an exhibit. 
This extension causes the system to bypass cases associated with exhibits that are eligible for 
destruction until the extension date has expired. At that point, the system will update the exhibit status to 
"Eligible for Destruction." 

Extend the Time Frame within an Exhibit Search 

When the system saves the transaction to extend the time frame for reviewing an exhibit, it refreshes the 
information within the results set of the searched exhibits. As a result, the case containing the exhibit is 
removed from the results. 

Task Activity 

This activity takes place in the context of an exhibit search. Refer to the Search Exhibits Inside the 
Context of a Case or Search Exhibits Outside the Context of a Case task activities for details on this 
process. 

Perform the following steps to extend the time frame to review an exhibit. Follow Steps 1-2 if you are 
inside the context of a case, or skip to Step 3 if you are outside the context of a case. 
 

1. Select the checkbox for the event containing the exhibit to extend. 
 This selection occurs from the Mark/Maintain Exhibits - Event List screen. 
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2. Click the [Maintain Exhibit] button. 
Result: The Maintain Exhibits - Exhibit List screen displays. 
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OR 

1. Select [Case] > [Records Management] > [Dispose of Exhibits]. 
 Use this step if you are outside the context of a case. 

Result: The Records Management - Exhibits screen displays with the Review tab highlighted. 



Printed Documentation 

592 

 
 

 

2. Select the checkbox for the exhibit on which to extend the time frame for review. 
3. Click the [Extend Timeframe] button. 

Result: The Records Management - Extend Timeframe to Review Exhibits screen displays. 

 
 

 

4. Select the [Extension Date] radio button and enter an extension date OR  
Select the [Number of Days to Extend] radio button and enter the number of days to extend the 
time frame for review. 
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5. Click the [Save] button. 
Result: The Review Exhibits Results screen re-displays. 

 
 

 

 

 

Related Links 

Review Exhibits to be Destroyed Overview 

Mark/Maintain Exhibits - Event List Screen 

Maintain Exhibits - Exhibit List Screen 

Records Management - Extend Timeframe to Review Exhibits Screen 

 

My Court Information 

 

Generate Notice of Intent to Destroy Exhibits 

 

Introduction 
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You must mail a "Notice of Intent to Destroy" to the exhibit recipient before an exhibit may be destroyed. 
Once you have mailed the notice, the case that is associated with the exhibit to be destroyed will not 
appear on the "Review Exhibits to be Destroyed" list. The case will then only appear on the list if the 
exhibit recipient does not respond to the notice. 

Generating the Notice of Intent to Destroy Exhibits 

When you generate the "Notice of Intent to Destroy Exhibits," the system will generate one notice for each 
case participant within a party type (such as for the Plaintiff, Defendant, etc.). 

Task Activity 

This activity takes place in the context of an exhibit search. Refer to the Search Exhibits Outside the 
Context of a Case task activity for details on this process. 

Perform the following steps to generate a Notice of Intent to Destroy Exhibits. 
 

1. Select [Case] > [Records Management] > [Dispose of Exhibits]. 
Result: The Records Management - Exhibits screen displays with the Review tab highlighted. 

 
 

 

2. Select the checkbox for the exhibit on which to generate a Notice of Intent to Destroy. 
3. Click the [Generate Notice to Destroy] button. 

Result: The appropriate notice is generated. 
4. Send the notice to the appropriate exhibit recipient. 

 

 

Related Links 
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Review Exhibits to be Destroyed Overview 

Records Management - Exhibits Screen 

 

Dispose or Destroy Exhibits 

Dispose or Destroy Exhibits Overview  

 

Introduction 

The system provides the ability to dispose of or destroy exhibits. It will display a list of exhibits that have 
met specified criteria and automatically marks them with a status of "Pending Destruction." These criteria 
and statuses are used when the "Identify Exhibits to be Destroyed" batch utility is run. 

Once an exhibit status is changed to pending destruction, a "Notice of Intent to Destroy" is sent to the 
parties who submitted the exhibits. If no response is received from the submitting parties within the 
required amount of time (10 days for a response, plus 5 days for mail processing), then the system will 
update the exhibits to a status of "Pending Destruction". 

From the list of exhibits that are pending destruction, you can choose to destroy an exhibit, extend the 
time frame for reviewing an exhibit, or remove the exhibit from the list. Any of these selections will cause 
the exhibit to not appear on the Destruction List report until the system reverts the status back to 
"Pending Destruction." 

Special Handling 

If the exhibit selected for destruction requires special handling, your supervisor's name and password are 
required. The system validates that you have provided these items in order to destroy exhibits. 

Researching and Disposing of Exhibits 

If the court requires the separation of job duties between the researching and disposing of exhibits, then 
the system will confirm that the person disposing of an exhibit is not the same person that updated the 
exhibit status to "Pending Destruction."  

Task Activities 

Disposing or destroying exhibits includes the following task activities: 

• Destroy Exhibits 
• Extend Time Frame for Review 
• Release Exhibits 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 
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Records Management - Exhibits Screen 

Records Management - Dispose Exhibits Details Screen 

Records Management - Extend Timeframe to Review Exhibits Screen 

 

My Court Information 

 

Destroy Exhibits 

 

Introduction 

Once a "Notice of Intent to Destroy" is sent to the parties who submitted exhibits, and no response is 
received from the submitting parties within the required amount of time (10 days for a response, plus 5 
days for mail processing), the system will update the exhibits to a status of "Pending Destruction." 

Once the system has identified exhibits that are pending destruction, you can destroy those exhibits. 

Task Activity 

This activity takes place in the context of an exhibit search. Refer to the Search Exhibits Outside the 
Context of a Case task activity for details on this process. 

Perform the following steps to destroy an exhibit. 
 

1. Select [Case] > [Records Management] > [Dispose of Exhibits]. 
Result: The Records Management - Exhibits screen displays. 
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2. Select the [Dispose] tab. 
Result: The Dispose tab highlights and displays the appropriate information. 

3. Enter/Select data for the necessary fields. 
4. Click the [Filter] button. 

Result: The Dispose Exhibits Results screen displays. 
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 The system will return a set of results with items that match your search request. You 
can either select exhibits to dispose of from this set or enter new filter criteria to generate a 
new results set. 

5. Select the checkbox for the exhibit to dispose. 
6. Click the [Dispose of] button. 

Result: The Dispose Exhibits Details screen displays. 

 
 

 

7. Enter/Select data for the following required fields: 
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• Date of Disposition 
• Supervisor ID 
• Password 
• Comments 

 

8. Click the [Save] button. 
Result: The Dispose Exhibits Results screen refreshes to show the selected exhibit with a status 
of "Destroyed." 

 

 

Related Links 

Create Exhibit Pull List Overview 

Records Management - Exhibits Screen 

Records Management - Dispose Exhibits Details Screen 

 

My Court Information 

 

Release Exhibits 

 

Introduction 

You can release an exhibit to a case participant or to an outside agency, such as the Sheriff's Department 
(as in the case of firearms) or a medical facility (as in the case of X-rays).  

Task Activity 

This activity takes place in the context of an exhibit search. Refer to the Search Exhibits Outside the 
Context of a Case task activity for details on this process. 

Perform the following steps to release an exhibit. 
 

1. Select [Case] > [Records Management] > [Dispose of Exhibits]. 
Result: The Records Management - Exhibits screen displays. 
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2. Select the [Dispose] tab. 
Result: The Dispose tab highlights. 
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3. Select the checkbox for the exhibit to release. 
4. Click the [Release Exhibit] button. 

Result: The Release Exhibit screen displays. 

 
 

 

5. Enter/Select data for the following required fields: 

• Role 
• Date of Release 

 

6. Click the [Release] button. 
Result: The Dispose Exhibits Results screen re-displays. 
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Related Links 

Dispose or Destroy Exhibits Overview 

Records Management - Exhibits Screen 

 

Create Case File Pull List 

Create Case File Pull List Overview 

 

Introduction 

Creating a case file pull list involves recording a request in the system for a list of case files and volumes 
that are required for use at a specific time and location. These requests include information regarding the 
requested date, requester's name and contact information, return date, location, etc. 

Types of Requests 

You may receive requests from individuals who want to view a case file. These requests are not 
necessarily related to a calendared event (such as research attorneys, general public, pull list requests 
related to case transfers, etc.). 
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The Pull List 
The pull list is automatically populated from calendared events along with the identification information of 
the clerk who calendared an event, such as case files that are required for an upcoming hearing.  

Inside and Outside the Context of a Case 
Requests for case files may be made within the context of a case, which will include all associated 
volumes, or outside the context of a case, in which a request may span multiple cases based on a court 
calendar or other criteria. 

Task Activities 

Creating a case file pull list includes the following task activities: 

• Add Case File to Pull List 
• Search Case Files Inside the Context of a Case 
• Search Case Files Outside the Context of a Case 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
 

 

Related Links 

Records Management - Search Screen 

Records Management - Pull Lists Screen 

Records Management - Physical Case File Screen 

Records Management - Physical Case File Change Location Screen 

Records Management - Physical Case File Location Change Request Screen 

 

My Court Information 

 

Search Case Files Inside the Context of a Case 

 

Introduction 

This activity allows you to search for case files within the context of a case. You can perform this type of 
search when the location change request applies to volumes within a case file that are associated with 
the case that you are currently viewing. You may then select the volumes associated with the applicable 
case file. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 
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Perform the following steps to search case files within the context of a case. 
 

1. Select [Case] > [Case Search]. 
Result: The Case Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 
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4. Click the Case Number link for the case file to be pulled. 
Result: The Case Summary screen displays. 
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5. Select the [Case File] left navigation item. 
Result: The Records Management Physical Case File screen displays. 
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Related Links 

Create Case File Pull List Overview 

Case Search Screen 

Case Summary Screen 

Records Management - Physical Case File Screen 

 

My Court Information 
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Search Case Files Outside the Context of a Case 

 

Introduction 

This activity allows you to search for case files outside the context of a case. You can perform this type of 
search when a location change request applies to case files for multiple cases. For instance, you may 
require the case files associated with multiple cases that are requested for a specific courtroom at a 
specific time.  

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search case files outside the context of a case. 
 

1. Select [Case] > [Records Management]. 
Result: The Records Management Search screen displays with the Case File tab highlighted. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Case File Search Results screen displays. 
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Related Links 

Create Case File Pull List Overview 

Records Management - Search Screen 

 

Track Case Files 

Track Case Files Overview  

 

Introduction 

Tracking case files involves managing the location of physical case files within the context of a case. This 
process involves maintaining a "Chain of Custody" list when the location of a physical case file changes 
and defining who has ownership of a physical case file at a particular place, time and location.  

Case File Location 
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Case files may be relocated to any location (such as a branch, building, etc.) within a court's jurisdiction. 
They may also be relocated out of a court's jurisdiction (such as through a change of venue, etc.). 

Case File Volumes 

Along with tracking the case file (such as initial and subsequent volumes), this process also defines the 
association between volumes and the documents within the volumes. 

Inside and Outside the Context of a Case 

The location of case files may be updated within the context of a case (selecting associated volumes). If 
the location update applies to specific volumes associated with a single case, you can select the volumes 
associated with the applicable case file.  

If the location update applies to volumes in a case file outside the context of a case where a location 
change request may span multiple cases - where all case files associated with multiple cases calendared 
for a specific courtroom at a specific time are required - you work outside the context of a case.  

Task Activities 

Tracking case files includes the following task activities: 

• Change Case File Location 
• Create Case File Volume 
• Modify Case File Volume 
• Search Physical Case Files Inside the Context of a Case 
• Search Physical Case Files Outside the Context of a Case 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Records Management - Search Screen 

Records Management - Physical Case File Change Location Screen 

Records Management - Create New/Edit Physical Case File Volume Screen 

Records Management - Physical Case File Screen 
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Change Case File Location  

 

Introduction 



The Case Section 

611 

Changing a case file location updates the location of physical case files from the Records Unit to a 
separate courtroom, location, county/court, etc. It can also update these locations back to the Records 
Unit. 

Changing the location of a physical case file also maintains a "Chain of Custody" that defines who has 
ownership of a physical case file at a specific place, time and location. 

Task Activity 

This activity takes place in the context of a case file search. Refer to the Search Physical Case Files task 
activity for details on this process. 

Perform the following steps to change the location of a case file outside the context of a case. 
 

1. Select the checkbox for the case file that is to change location. 
 This selection occurs from the Case File Results screen. 

 
 

 

2. Click the [Change Location] button. 
Result: The Records Management Physical Case File Change Location screen displays. 
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3. Enter/Select data for the following required fields: 
o Custodian Name 
o To Location 

 Click the [Verify] button to verify that the case number displayed and the volume 
associated with that case number is valid. 

4. Click the [Save] button. 
Result: The Records Management Search screen refreshes with a confirmation message. 
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Related Links 

Track Case Files Overview 

Records Management - Search Screen 

Records Management - Physical Case File Change Location Screen 

 

My Court Information 

 

Create Case File Volume 

 

Introduction 

If a new physical case file is created, then a new volume number may be created within the system. 
Creating a new case file volume includes entering or updating the volume tracking number, volume 
location, ROA start date, and comments. 
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If you create a new volume for a case file, then the Case History/ROA is updated to include the date and 
time that the volume becomes effective. This means that the system will assume that documents received 
after the effective volume date are to be associated with that volume until additional volumes are created. 

If the court uses barcoding, then the volume tracking number can also be associated to the barcode 
identification number. 

Volume Numbers 

You do not need to create the volume number since the system will determine the next volume number in 
the case file series when the new volume is created.  

Deleting Volumes 

A volume cannot be deleted from the system since this would create gaps in the volume sequencing. You 
can instead note a physical case file volume as being disposed of within the Comments field. 

Task Activity 

This activity takes place in the context of a case file search. Refer to the Search Physical Case Files task 
activity for details on this process. 

Perform the following steps to add a case file volume. 
 

1. Select the checkbox for the case file on which to add a volume. 
 This selection occurs from the Case File Results screen. 
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2. Click the [Add Volume] button. 
Result: The Records Management - Create New Physical Case File Volume screen displays. 

 
 

 

3. Enter/Select data for the necessary fields. 
4. Click the [Save] button. 

Result: The screen refreshes to include the newly created volume. 
 

 

Related Links 

Track Case Files Overview 

Records Management - Create New/Edit Physical Case File Volume Screen 

 

My Court Information 

 

Modify Case File Volume 

 

Introduction 

Modifying a case file volume allows you to update the ROA start date and comments, as well as change 
the location of a case file or modify a volume for a case file. 



Printed Documentation 

616 

Updating Information 

When changing a volume for a case file, you can only update the new Register of Actions start date and 
comments. 

Task Activity 

This activity takes place in the context of a case file search. Refer to the Search Physical Case Files 
Inside the Context of a Case task activity for details on this process. 

Perform the following steps to modify a case file volume. 
 

1. Click the Volume Number hyperlink of the case file volume to update. 
 This selection occurs from the Case File Results screen. 

 
 

 

2. Result: The Records Management - Edit Physical Case File Volume screen displays. 
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2. Enter/Update the available fields as needed. 
3. Click the [Save] button. 

Result: The Records Management - Physical Case File screen re-displays. 
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Related Links 

Track Case Files Overview 

Records Management - Create New/Edit Physical Case File Volume Screen 

Records Management - Physical Case File Screen 
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Search Physical Case Files Inside the Context of a Case 
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Introduction 

This activity allows you to search for physical case files within the context of a case. You can perform this 
type of search when the location change request applies to case files that are associated with the case 
that you are currently viewing. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Manually Entering Case File Locations 

Case files may be manually entered when changing multiple case file locations, as opposed to searching 
for case files. When manually entering multiple case files or volumes, the system validates if the case 
numbers are correctly specified, and that the volumes exist before submitting the change location 
request. When entering a case file, if an asterisk is entered for the case file volume, the system will 
perform the location update for all volumes associated with the case file entered. 

Task Activity 

Perform the following steps to search for case files inside the context of a case. 
 

1. Select [Case] > [Case Search]. 
Result: The Case Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 
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4. Click the Case Number link. 
Result: The Case Summary screen displays. 
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5. Select the [Case File] left navigation item. 
Result: The Records Management - Physical Case File screen displays. 
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Related Links 

Track Case Files Overview 

Case Search Screen 

Case Summary Screen 

Records Management - Physical Case File Screen 
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Search Physical Case Files Outside the Context of a Case 

 

Introduction 

This activity allows you to search for physical case files outside the context of a case. You can perform 
this type of search when a location change request applies to case files for multiple cases. For instance, 
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you may require the case files associated with multiple cases that are requested for a specific courtroom 
at a specific time. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for case files. 
 

1. Select [Case] > [Records Management]. 
Result: The Records Management Search screen displays. 

 
 

 

2. Select the [Case File] tab. 
Result: The Case File tab highlights and displays the appropriate information. 

3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The screen refreshes with the case file search results. 
 

 

Related Links 

Track Case Files Overview 

Records Management - Search Screen 
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Identify/Review Cases to be Destroyed 

Identify Case Files to be Destroyed Overview  

 

Introduction 

Identifying case files to be destroyed describes the activities performed by the system to identify physical 
case files that may be destroyed. This process refers to the guidelines set by the Government Code 
Section 68152, which states that certain types of cases must not be destroyed. For example, case files 
cannot be destroyed if they fall within CRC 6.755, Superior Court Records Sampling Program guidelines. 

The system identifies cases for destruction and does not require user intervention. This process can be 
configured to run daily, weekly, monthly, quarterly, semi-annually, annually, etc., as determined by the 
system administrator. The system will update the status of a physical case file (if the required retention 
criterion has expired) to "Eligible for Destruction" or "Pending Destruction," as long as the final disposition 
of a case has been recorded in the system.  

Physical Case Files 

The list of physical case files associated with a case must be published in a destruction report. It must 
also be submitted to a Judicial Officer for a comprehensive order of destruction, and to historical societies 
to determine if a case file should be retained. Refer to the Review Cases to be Destroyed section for 
details. 

Associated Volumes 

The list of case files and associated volumes within a case file that must be destroyed is detailed in the 
Destroy Case Files section. 

Destruction Report 

The system determines whether a Destruction Report has been generated for the physical case file 
associated with the selected volume. The system will not flag physical case files marked as "Pending 
Destruction" unless a Destruction Report has been generated for the selected case.  

Retention Period 

The retention period refers to the amount of time a physical case file must be retained after the 
Destruction Report is generated. Once this time frame has expired, the case file status may be updated to 
"Pending Destruction."  

The retention time period is set for 30 days in order to provide adequate time for a judicial officer's 
approval and historical agencies time to respond with a request for the case file based on historical 
significance.  

Task Activities 

There are no task activities related to this overview. 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
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Related Links 

Records Management - Search Screen 

 

Review Cases to be Destroyed Overview  

 

Introduction 

Reviewing cases to be destroyed involves examining the list of cases eligible for destruction and selecting 
an option on how to handle a case. This includes extending the time frame needed to research a case file 
or retaining a case file permanently. You can also generate the "Destruction List Report," which is sent to 
a Judicial Officer for approval as well as historical societies to determine if the case file is of historical 
significance. 

Extend Time Frame for Review 

You can extend the time frame to review a case before destroying the physical case file. This allows you 
to either review the case until a specific date or to extend the review time frame by a certain number of 
days. 

Retain Case File Permanently 

You can choose to retain a case file permanently if a historical society or Judicial Officer determines that 
a case file is of historical importance, the case file is to be used for statistical sampling, or if the case file 
is of a certain size. 

Mark for Destruction 

Marking a case for destruction causes the following to occur: 

1. A destruction report is generated for the case, which is sent to a Judicial Officer for approval, as 
well as to historical societies.  

2. The system waits 30 days before updating the physical case file status to "Pending Destruction" 
to allow the Judicial Officer and historical societies enough time to request the case. 

 

 

After 30 days, the Review Cases to be Destroyed result set is populated by a batch utility that determines 
the eligibility of case files for destruction. Refer to the Identify Cases to be Destroyed section for details 
on identifying cases eligible for destruction. 

Task Activities 

Reviewing cases to be destroyed includes the following task activities: 

• Mark Case File for Destruction 
• Retain Case File Permanently 
• Review Cases Eligible for Destruction 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
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Related Links 

Records Management - Physical Case File Screen 

Records Management - Retain Physical Case File(s) Screen 
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Mark Case File for Destruction 

 

Introduction 

Marking a case for destruction generates the Destruction List report. This report is sent to a Judicial 
Officer for approval to destroy the case file. It is also sent to relevant historical societies to determine if the 
case file is of historical significance.  

After marking a case for destruction, the system waits 30 days before updating the physical case file 
status to "Pending Destruction." This allows the Judicial Officer and historical societies enough time to 
request and review the case to determine if it should be retained permanently. 

Cases that appear in the Review Physical Case File Results are populated by a batch utility that 
determines the eligibility of case files for destruction. Refer to the Identify Cases to be Destroyed section 
for details on identifying cases eligible for destruction. 

Conditions for Case File Destruction 

A case file cannot be destroyed if: 

• The retention time period for a case category and case type has not expired. 
• The case is marked for permanent retention. 
• Fewer than 30 days have passed since the case was identified in the case Destruction List report. 
• The case is already identified as "destroyed." 
• The location of the case file is "in transit" or "missing." 

 

 

If you attempt to destroy a case file, and the criteria above are not met, then an error message will appear 
stating that the case cannot be destroyed for any combination of the five reasons listed above. 

Task Activity 

This activity takes place in the context of a physical case file search. Refer to the Search Physical Case 
Files task activity for details on this process. 

Perform the following steps to extend the time frame to destroy a physical case file. 
 

1. Select the checkboxes for the physical case files to mark for destruction. 
 This selection occurs from the Records Management - Physical Case File screen. 
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2. Click the [Mark for Destruction] button. 
Result: The Records Management - Physical Case File screen refreshes. 

 The system generates the Destruction List report with a list of case files, locations, volumes, 
and the date of the final disposition. 

 
 

 

 

 

Related Links 

Review Case Files to be Destroyed Overview 
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Records Management - Physical Case File Screen 

 

My Court Information 

 

Retain Case File Permanently 

 

Introduction 

You can permanently retain a case file if a Judicial Officer or historical society determines that the case 
file is of historical significance, the case is to be used for statistical sampling, or the case file is of a certain 
size.  

Task Activity 

This activity takes place in the context of a physical case file search. Refer to the Search Physical Case 
Files task activity for details on this process. 

Perform the following steps to retain a physical case file permanently. 
 

1. Select the checkboxes for the physical case files to permanently retain. 
 This selection occurs from the Records Management - Physical Case File screen. 

 
 

 

2. Click the [Extend] button. 
Result: The Records Management - Retain Physical Case Files screen displays. 
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3. Select the [Retain Permanently] radio button. 
4. Enter/Select data for the following required fields: 

o Reason 
o Comments 

 

5. Click the [Save] button. 
Result: The Records Management - Physical Case File screen displays the updated case file. 

 
 

 

 

 

Related Links 
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Review Cases to be Destroyed Overview 

Records Management - Physical Case File Screen 

Records Management - Retain Physical Case File Screen 

 

My Court Information 

 

Review Cases Eligible for Destruction 

 

Introduction 

You can choose to work with cases in the pre-populated Review Physical Case File Results set, or you 
can search files which meet specific criteria. The Review Physical Case File Results displays all cases 
pending destruction within your location. 

Task Activity 

Perform the following steps to review the case files that are eligible for destruction. 
 

1. Select [Case] > [Records Management] > [Physical Case File]. 
Result: The Records Management - Physical Case File screen displays. 

 
 

 

2. Select one or more filter criteria, if necessary. 
3. Click the [Filter] button. 

Result: The screen refreshes and displays only those case files that match the selected filter 
criteria.  

 



The Case Section 

631 

 

Related Links 

Review Cases to be Destroyed Overview 

Records Management - Physical Case File Screen 

 

Destroy Case Files 

Destroy Case Files Overview  

 

Introduction 

Destroying case files defines the process for the destruction of physical case files. It involves the 
electronic recording of the destruction of case files and updating the Case Index with the case file 
destruction information. A Case Index is a report containing all of the wills, documents and cases for a 
given court. 

Destroying Multiple Case Files 

The system allows you to destroy multiple case files within a single transaction. 

When a Case File May Not Be Destroyed 

A case file may not be destroyed if: 

• The retention time period for the case category and case type has not expired. 
• The case is marked for permanent retention. 
• Fewer than 30 days have passed since the case was identified in the Case Destruction report. 
• The case is already identified as "Destroyed." 
• The location of the case file is "In Transit" or "Missing." 

 

 

If you attempt to destroy a case file, and the above criteria are not met, then an error message will appear 
stating that the case cannot be destroyed for any combination of the five reasons listed above. 

Task Activities 

Destroying case files includes the following task activities: 

• Extend Retention Time Frame 
• Search Physical Case Files 
• Undo Destroy Physical Case Files 

Additional Resources 

• Business Rules 
 

 

Related Links 
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Records Management - Physical Case File Screen 

Records Management - Destroy Physical Case Files Details Screen 

Records Management - Retain Physical Case File Screen 

 

My Court Information 

 

Extend Retention Time Frame 

 

Introduction 

Extending the retention time frame of a case file changes the period of time in which the case file can be 
reviewed. It also updates the status of the case file to "Eligible for Destruction" or "Retained 
Permanently." This status is based on whether the case file destruction date is extended for a period of 
time or the case file is retained permanently.  

Task Activity 

This activity takes place in the process of a physical case file search. Refer to the Search Physical Case 
Files task activity for details on this process. 

Perform the following steps to extend the time frame to destroy a physical case file. 
 

1. Select the checkboxes for the physical case files in which to extend the time frame for 
destruction. 

 This selection occurs from the Records Management - Physical Case Files screen. 
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2. Click the [Extend] button. 
Result: The Records Management - Retain Physical Case File(s) screen displays. 

 
 

 

3. You can extend the retention period in one of three ways: 
4. Select the [Extension Date] radio button and enter a calendar date for which the 

destruction of the case file will be extended. 
 This calendar date is the next time that the case file will be visible for further action.  

5. Select the [Number of Days to Extend] radio button and enter the number of days to 
extend the review period of the case file. 
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 If the selected extension date for a case file is equal to or greater than 365 days, 
then the system will prompt you to confirm that the extension date is valid.  

6. Select the [Retain Permanently] radio button and enter a reason for permanently 
retaining the case file. 

 

4. Click the [Save] button. 
Result: The Records Management - Physical Case Files screen displays the updated case file 
destruction eligibility date. 

 
 

 

 

 

Related Links 

Destroy Case Files Overview 

Records Management - Retain Physical Case File Screen 

Records Management - Physical Case File Screen 

 

My Court Information 

 

Search Physical Case Files 
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Introduction 

This activity allows you to search for case files that have a status of either "Pending Destruction" or 
"Destroyed." Refer to the Search Feature Overview for details on performing a search in the system. 

Cases to be Destroyed 

When accessing the list of case files to be destroyed, the system will automatically populate the list with 
all cases pending destruction that are within your court location, without the need for any filter criteria to 
be entered. 

Task Activity 

Perform the following steps to retrieve a set of physical case files to be destroyed. 
 

1. Select [Case] > [Records Management] > [Physical Case File]. 
Result: The Records Management - Physical Case Files screen displays. 

 
 

 

2. Select the [Destroy] tab. 
Result: The Destroy tab highlights and displays the appropriate information. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Filter] button. 

Result: The Review Physical Case Files Results screen displays. 
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Related Links 

Destroy Case Files Overview 

Records Management - Physical Case File Screen 

 

My Court Information 

 

Undo Destroy Physical Case Files 

 

Introduction 

Undoing the destruction of a physical case file updates a case file status to "Pending Destruction." You 
can use this process if an event such as a case file was selected for destruction by mistake. 

Task Activity 

This activity takes place in the context of a physical case file search. Refer to the Search Physical Case 
Files task activity for details on this process. 
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Perform the following steps to undo the destruction of a physical case file: 
 

1. Select the checkboxes for the physical case files to undo from destruction. 
 Only case files with a status of "DESTROYED" can be "undestroyed." 
 This selection occurs from the Destroy Case File Results screen. 

 
 

 

2. Click the [Undo Destroy Physical Case Files] button. 
Result: The Destroy Case File Results screen refreshes to display the updated status as 
"PENDING DESTRUCTION."  
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Related Links 

Destroy Case Files Overview 

Records Management - Physical Case File Screen 

 

Maintain Subpoenaed Records 

Maintain Subpoenaed Records Overview  

 

Introduction 

Maintaining subpoenaed records involves creating, modifying, and deleting a subpoenaed record. You 
can also associate a subpoenaed record to an event.  

Adding a Subpoenaed Record 

When adding a subpoenaed record, you must be in the context of a case. You may update a subpoenaed 
record within the context of a case, or select a subpoenaed record from the search function if you are 
outside the context of a case. 
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Task Activities 

Maintaining subpoenaed records includes the following task activities: 

• Associate a Subpoenaed Record to an Event 
• Create Subpoenaed Records 
• Delete Subpoenaed Records 
• Modify Subpoenaed Records 
• Search for Subpoenaed Records Inside the Context of a Case 
• Search for Subpoenaed Records Outside the Context of a Case 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
 

 

Related Links 

Records Management - Search Screen 

Records Management - Create/Modify Subpoenaed Record Screen 

Records Management - Subpoenaed Records Screen 

 

My Court Information 

 

Associate Subpoenaed Records to an Event 

 

Introduction 

Associating subpoenaed records to a case involves scheduling hearings on a future date for cases 
associated with a subpoenaed record. 

Task Activity 

This activity takes place in the context of a subpoenaed record search. Refer to the Search for 
Subpoenaed Records Outside the Context of a Case task activity for details on this process. 

Perform the following steps to associate a subpoenaed record. 
 

1. Select [Case] > [Records Management] > [Subpoenaed Records]. 
Result: The Records Management Search screen displays. 
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2. Select the [Subpoenaed Records] tab. 
Result: The Subpoenaed Records tab highlights and displays the appropriate information. 

 
 

 

3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Subpoenaed Records Results screen displays. 
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5. Select the radio button for the subpoenaed record to associate to an event. 
6. Click the [Modify Subpoenaed Record] button. 

Result: The Records Management - Create/Modify Subpoenaed Record screen displays. 
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7. Click the [Associated Hearing] link. 
Result: The Maintain Calendar Events - Search screen displays. 

 
 

 

8. Select a Resource Type. 
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9. Click the [Search Button] button. 
Result: The Maintain Calendar Events Results displays. 

 
 

 

10. Select the checkbox for the hearing to associate. 
11. Click the [Select] button. 

Result: The Records Management - Create/Modify Subpoenaed Record screen re-displays. 
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 The Associated Hearing field should be populated with the Calendar ID number for the 
associated hearing. 

12. Click the [Save] button. 
Result: The Records Management - Create/Modify Subpoenaed Record screen refreshes with a 
confirmation message. 
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Related Links 

Maintain Subpoenaed Records Overview 

Records Management - Subpoenaed Records Screen 

Maintain Calendar Events - Search Screen 

Records Management - Create/Modify Subpoenaed Record Screen 

 

My Court Information 

 

Create Subpoenaed Records 

 

Introduction 

You can create a subpoenaed record for a case any time before or after performing a case search. When 
creating a subpoenaed record, the system automatically associates the subpoenaed record to that case. 

Task Activity 
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This activity takes place in the context of a subpoenaed record search. Refer to the Search for 
Subpoenaed Records Outside the Context of a Case task activity for details on this process. 

Perform the following steps to create a subpoenaed record. 
 

1. Select [Case] > [Case Search]. 
Result: The Case Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 
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4. Click the Case Number link for the case on which to create a subpoenaed record. 
Result: The Case Summary screen displays. 
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5. Select the [Subpoenaed Records] left navigation item. 
Result: The Records Management - Subpoenaed Records screen displays. 
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6. Click the [Create Subpoenaed Record] button. 
Result: The Records Management - Create/Modify Subpoenaed Record screen displays. 
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7. Enter/Select data for the following required fields: 

• Subpoenaed Record Description 
• Quantity 
• Date Received 
• Location 
• Submitter's Name 
• Status 

 

8. Click the [Save] button. 
Result: The Records Management - Subpoenaed Records screen refreshes with a confirmation 
message. 



Printed Documentation 

652 

 
 

 

 

 

Related Links 

Maintain Subpoenaed Records Overview 

Case Search Screen 

Case Summary Screen 

Records Management - Subpoenaed Records Screen 

Records Management - Create/Modify Subpoenaed Record Screen 

 

My Court Information 

 

Modify Subpoenaed Records 

 

Introduction 

Modifying a subpoenaed record updates information about a subpoenaed record. 

Task Activity 

This activity takes place in the context of a subpoenaed record search. Refer to the Search for 
Subpoenaed Records Outside the Context of a Case task activity for details on this process. 

Perform the following steps to modify a subpoenaed record. 
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1. Select the radio button for the subpoenaed record to associate. 
 This selection occurs from the Records Management - Search screen. 

 

 

 

2. Click the [Modify Subpoenaed Record] button. 
Result: The Records Management - Create/Modify Subpoenaed Record screen displays. 
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3. Enter/Update the available fields as needed. 
4. Click the [Save] button. 

Result: The Records Management - Create/Modify Subpoenaed Record screen refreshes with a 
confirmation message. 
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Related Links 

Maintain Subpoenaed Records Overview 

Records Management - Create/Modify Subpoenaed Record Screen 

 

My Court Information 

 

Delete Subpoenaed Records 

 

Introduction 



Printed Documentation 

656 

Based on security access, the system will allow you to delete a subpoenaed record. Deleting a 
subpoenaed record removes the information related to a subpoenaed record from the system. For 
example, you can delete a subpoenaed record that was entered in error. 

Task Activity 

This activity takes place in the context of a subpoenaed record search. Refer to the Search for 
Subpoenaed Records Outside the Context of a Case task activity for details on this process. 

Perform the following steps to associate a subpoenaed record. 
 

1. Select [Case] > [Records Management] > [Subpoenaed Records]. 
Result: The Records Management Search screen displays. 

 
 

 

2. Select the [Subpoenaed Records] tab. 
Result: The Subpoenaed Records tab highlights and displays the appropriate information. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Subpoenaed Records Results screen displays. 

 
 

 

5. Select the radio button for the subpoenaed record to delete. 
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6. Click the [Delete] button. 
Result: The Search Subpoenaed Records Results screen refreshes and no longer displays the 
subpoenaed record. 

 
 

 

 

 

Related Links 

Maintain Subpoenaed Records Overview 

Records Management - Search Screen 

 

My Court Information 

 

Search for Subpoenaed Records Inside the Context of a Case 

 

Introduction 

This activity allows you to search for subpoenaed records within the context of a case. You can perform 
this type of search if a subpoenaed record has been associated to a case. Refer to the Search Feature 
Overview for details on performing a search in the system. 

The search function also provides the foundation for maintaining subpoenaed records. For example, you 
must perform a case search in order to update a record.  
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Disposed Calendared Events and Associated Subpoenaed Records 

When a calendared event is disposed and subpoenaed records are associated to that event, a warning 
message will display stating that the subpoenaed records should be returned to the parties. If necessary, 
you may associate the subpoenaed records to a future event. This activity will display the Events Listing 
screen. 

Subpoenaed Record Icon 

When a subpoenaed record is associated with a hearing, the calendar will display an icon showing that 
the subpoenaed record is available for the calendared event. 

Task Activity 

Perform the following steps to search for subpoenaed records within the context of a case. Refer to the 
Search Cases task activity for details on performing a case search. 

1. Select the [Subpoenaed Records] left navigation item. 
Result: The Records Management - Subpoenaed Records screen displays the subpoenaed 
records associated with the case. 
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Related Links 

Maintain Subpoenaed Records Overview 

Records Management - Subpoenaed Records Screen 

 

My Court Information 

 

Search for Subpoenaed Records Outside the Context of a Case 

 

Introduction 

This activity allows you to search for subpoenaed records outside the context of a case. You can perform 
this type of search when a location change request applies to subpoenaed records for multiple cases. For 
instance, you may require the subpoenaed records associated with multiple cases that are requested for 
a specific courtroom at a specific time. 

The search function also provides the foundation for maintaining subpoenaed records. For example, you 
must perform a subpoenaed record search in order to update a record.  

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for subpoenaed record outside the context of a case. 
 

1. Select [Case] > [Records Management]. 
Result: The Records Management Search screen displays. 
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2. Select the [Subpoenaed Records] tab. 
Result: The Subpoenaed Records tab highlights and displays the appropriate information.  

 
 

 

3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Subpoenaed Records Results screen displays. 
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Related Links 

Maintain Subpoenaed Records Overview 

Records Management - Search Screen 

 

Maintain Wills/Estate Planning Documents 

Maintain Wills/Estate Planning Documents Overview  

 

Introduction 

Maintaining wills/estate planning documents involves depositing or lodging miscellaneous wills, probate 
wills and/or estate planning documents. This includes assigning a tracking number, locating the 
document, and charging fees. 

Associating Miscellaneous Wills and Codicils With Probate Cases 

When a miscellaneous will is associated with a probate case, the will categorization will be updated to 
"Probate Will." The will is then placed into a case file volume, with the movement of the will tracked by the 
movement of the corresponding case file volume. If a will is not a part of a probate case, then the location 
of the will can be updated through the "create" or "modify" wills and estate plans function. 

Associating Codicils and Estate Plans With a Will 

Codicils and estate plans may also be associated to a will through the "create" or "modify" feature. If this 
occurs, a search for a will, codicil or estate plan will retrieve the associated documents. 

Will Records 

A will record may be deleted from the system (if entered in error) through the Delete Document feature. 
Access to this function is based on security privileges. If a will is lodged by anyone other than the State 
Bar, payment for the associated fee must be recorded before saving the transaction in the system. 

Task Activities 

Maintaining wills and estate planning documents includes the following task activities: 

• Search Wills/Estate Planning Documents 
• Create Documents 
• Associate Documents 
• Modify Documents 
• Delete Documents 

Additional Resources 

Other items related to this overview includes the following:  

• Business Rules 
• Forms/Notices/Reports 
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Related Links 

Records Management - Wills/Estate Planning Documents Search Screen 

Records Management - Create/Modify Will/Estate Planning Document Screen 

 

My Court Information 

 

Search Wills/Estate Planning Documents 

 

Introduction 

This activity allows you to search for wills and estate planning documents. Refer to the Search Feature 
Overview for details on performing a search in the system. 

Wills and Associated Documents 

If you perform a search for a will that is associated to another document (such as an estate plan or 
codicil), the system retrieves and displays the associated documents in the search results. 

Location Information 

If a will is located in a volume within a case file, the Document Location information is not required and 
those search fields will appear grayed out in the search screen. 

Task Activity 

Perform the following steps to search for wills/estate planning documents. 
 

1. Select [Case] > [Wills/Estate Plans]. 
Result: The Records Management - Wills/Estate Planning Document Search screen displays. 
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2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Records Management - Wills/Estate Planning Document Search screen refreshes 
with the Wills/Estate Planning Results. 
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Related Links 

Maintain Wills/Estate Planning Documents Overview 

Records Management - Wills/Estate Planning Documents Search Screen 

 

My Court Information 

 

Create Documents 

 



Printed Documentation 

666 

Introduction 

Creating documents involves depositing or lodging miscellaneous wills, codicils, or estate planning 
documents. When creating miscellaneous wills and/or estate planning documents, the Case Index is 
updated with the document ID number and document information. A Case Index is a report containing all 
of the wills, documents and cases for a given court. 

Lodging Wills and Fees 

A fee is charged for lodging a miscellaneous will, except when a will is lodged by the State Bar. If the 
status of the will or estate planning document is "Lodged," and the lodging agency is any agency other 
than the State Bar, then the system will create a fee for the lodging service. If the document is lodged, 
then it will be automatically marked as "Confidential." 

Document Labels 

When you save a lodged document, the system generates a Document Label form containing the 
document identification number. These document labels are then placed on the lodged document for 
identification purposes. If a will is associated to a probate case, then the system will update the Case 
History/ROA with the date and time that the association was made.  

Task Activity 

Perform the following steps to create a document. 
 

1. Select [Case] > [Wills/Estate Plans]. 
Result: The Records Management-Wills/Estate Planning Document Search screen displays. 

 
 

 

2. Click the [Create Document] button. 
Result: The Create Will/Estate Planning Document screen displays. 
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3. Enter/Select data for the following required fields: 
o Status 
o Document Category 
o Document Type 
o Subject's Name 

 

4. Click the [Save] button. 
Result: The Create Will/Estate Planning Document screen re-displays.  The Associated 
Document field should be pre-populated with the Document ID Number. 
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5. Click the [Save] button. 
Result: The Records Management - Wills/Estate Planning Document Search screen refreshes 
with a confirmation message. 
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Related Links 

Maintain Wills/Estate Planning Documents Overview 

Records Management - Wills/Estate Planning Documents Search Screen 

Records Management - Modify Will/Estate Planning Document Screen 

 

My Court Information 

 

Associate Documents 

 

Introduction 

Associating wills, codicils, and/or estate planning documents assembles a will and associates other 
related documents such as advance directives, EPA's and tenancy severance deeds. All associated 
documents are displayed during a search if the search criteria has been met. 

Wills Associated to Probate Cases 

If a miscellaneous will is associated to a probate case, the will is categorized as "Probate." The will may 
then be located to a case file volume, and the relocation of the will can be tracked by the relocation of the 
corresponding case file volume.  

If a will is not a part of a probate case, then the location of the will may be updated using the "create" or 
"modify" wills or document feature. 
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Wills Associated to Codicils and Estate Plans 

Codicils and estate plans may be associated to a will using the "create" or "modify" will for document 
features. If this occurs, a search for a will, codicil or estate plan will retrieve the associated documents.  

Task Activity 

This activity takes place in the context of a will and/or estate planning document search. Refer to the 
Search Wills/Estate Planning Documents task activity for details on this process. 

Perform the following steps to associate a document. 
 

1. Select [Case] > [Wills/Estate Plans]. 
Result: The Records Management - Wills/Estate Planning Document Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Records Management - Wills/Estate Planning Document Search screen refreshes to 
display the Wills/Estate Planning Results. 
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4. Select the radio button for the document type to associate. 
5. Click the [Modify Document] button. 

Result: The Create Will/Estate Planning Document screen displays. 
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6. Click the [Associated Document] link, located below the tracking number. 
Result: The Wills/Estate Planning Search Results screen re-displays. 
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7. Enter/Select data for the appropriate search parameter fields. 
8. Click the [Search] button. 

Result: The Wills/Estate Planning Results screen displays. 
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9. Select the radio button for the document to associate to the document selected above. 
10. Click the [Associate Document] button. 

Result: The Create Will/Estate Planning Document screen re-displays. 
 The Associated Document field should be populated with the Document ID Number. 

 
 

 

11. Click the [Save] button. 
Result: The Wills/Estate Planning Results screen re-displays. 
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Related Links 

Maintain Wills/Estate Planning Documents Overview 

Records Management - Create/Modify Will/Estate Planning Document Screen 

Records Management - Wills/Estate Planning Documents Search Screen 

 

My Court Information 

 

Modify Documents 
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Introduction 

Modifying a will or estate planning document may occur when a document must be associated to a case, 
when a decedent's date of death must be entered, or if an error was made when the document was 
created.  

You can search for an existing will or estate planning document in order to select and update a record 
from the results.  

If you modify an existing record, some data fields will be pre-populated with information that had been 
previously entered. Otherwise, if no information exists in the database for the data fields, they will be 
blank.  

Task Activity 

This activity takes place in the context of a will and/or estate planning document search. Refer to the 
Search Wills/Estate Planning Documents task activity for details on this process. 

Perform the following steps to modify a document. 
 

1. Select [Case] > [Wills/Estate Plans]. 
Result: The Records Management - Wills/Estate Planning Document Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Records Management - Wills/Estate Planning Document Search screen refreshes 
with the Wills/Estate Planning Results. 
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4. Select the radio button for the document type to modify. 
5. Click the [Modify Document] button. 

Result: The Modify Will/Estate Planning Document screen displays. 
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6. Enter/Update the available fields as needed. 
7. Click the [Save] button. 

Result: The Wills/Estate Planning Results screen refreshes. 
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Related Links 

Maintain Wills/Estate Planning Documents Overview 

Records Management - Wills/Estate Planning Documents Search Screen 

Records Management - Modify Will/Estate Planning Document Screen 

 

My Court Information 

 

Delete Documents 
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Introduction 

Based on security roles, the system will allow you to delete documents. When deleting a will or estate 
plan document from the database, the system records the following information: 

• Your system User ID 
• Date and time (of the deletion) 

Task Activity 

This activity takes place in the context of a will and/or estate planning document search. Refer to the 
Search Wills/Estate Planning Documents task activity for details on this process. 

Perform the following steps to delete a document. 
 

1. Select [Case] > [Wills/Estate Plans]. 
Result: The Records Management - Wills/Estate Planning Document Search screen displays. 

 
 

 

2. Enter/Select data for the necessary fields. 
3. Click the [Search] button. 

Result: The Records Management - Wills/Estate Planning Document Search screen refreshes 
with the Wills/Estate Planning Results. 
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4. Select the radio button for the document to delete. 
5. Click the [Delete Document] button. 

Result: The Wills/Estate Planning Results refreshes and no longer displays the selected 
document. 
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Related Links 

Maintain Wills/Estate Planning Documents Overview 

Records Management - Wills/Estate Planning Documents Search Screen 
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The Accounting Section 

Manage Cashier Sessions 

Manage Cashier Session Overview  

 

Introduction 

A cashier session is a collection of transactions for an individual cashier. A session is a defined period of 
time, such as a day, morning, or afternoon when you do cashiering activities.  

Task Activities 

Managing cashier sessions includes the following task activities: 

• Open a Cashier Session 
• Manage a Cashier Session 
• Close a Cashier Session 
• Balance a Cashier Session 
• View Associated Receipts 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Balance Cashier Session Screen 

Manage Cashier Sessions - Open Session Screen 

Manage Cashier Sessions - Search Screen 

View Associated Receipts Screen 

 

My Court Information 

 

Open a Cashier Session 
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Introduction 

In order for you to enter cashiering transactions, you must open a cashier session. Opening a cashier 
session involves entering the starting balance or "cash on hand" for the cash drawer into the system.  

You can only have one cashier session per person open at a time. This helps with the reconciliation 
process between the amount of monies in the cashier drawer and the amount recorded in the cashiering 
session. 

Task Activity 

Perform the following steps to open a cashier session. 
 

1. Select [Accounting] > [Manage Cashier and Supervisor Sessions]. 
Result: The Manage Cashier Session Open Session screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Starting Amount 
• Location 
• Division 

 

3. Click the [Open Session] button. 
Result: The Manage Cashier Session Open Session screen refreshes. 
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 The system validates that you do not have other cashier sessions open before allowing 
you to open a cashier session.  

 Check that your cashiering session is open by reviewing the record within the cashiering 
session table on the Manage Cashier Sessions screen. This table should display cashiering 
session information including the Cashier Name, Open Date, Time (which should match the 
current date and time), Close Date and Time (which will not be populated until the cashiering 
session is closed), and the Cashier Session Status, which should be "Open." 

 If the Starting Amount is incorrect, go back to the Manage Cashier Session screen by 
clicking the [Cancel] button and then re-enter the Starting Amount. This will override the 
previous starting amount. However, you can only change the starting amount if no previous 
payment transactions have been processed. 

 

 

Related Links 

Manage Cashier Sessions Overview 

Manage Cashier Sessions - Open Session Screen 

 

My Court Information 

 



Printed Documentation 

686 

Manage a Cashier Session 

 

Introduction 

Managing a cashier session is a supervisor function associated with searching for and accessing multiple 
cashiering sessions. These may be open, closed, or balanced sessions. You can also view associated 
receipts. 

This function is necessary if you are not available to close a cashiering session, or if your supervisor 
needs to open a previously closed or unbalanced cashiering session.  

Task Activity 

This task activity assumes that the Accounting Supervisor is already logged into the system and has 
identified a cashier session to close, balance, or view associated receipts. 

Perform the following steps to manage (multiple) cashier sessions.  
 

1. Select [Accounting] > [Manage Cashier and Supervisor Sessions]. 
Result: The Manage Cashier Sessions Open Session screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields: 
o Cashier Name 
o Location 
o Open Date From and To 
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o Balance Date From and To 
o Session Status 
o Division 

 The Court and Location fields refer to the court where the cashiering session was 
initiated. The Unit refers to the branch of the court where the cashiering is taking place (such 
as Probate, Small Claims, Family Law, etc.). 

3. Click the [Search] button. 
Result: The Manage Cashier Sessions - Search Results screen displays. 

 
 

 

4. Select the radio button to the left of the cashiering session that must be closed, balanced, or to 
view associated receipts. 

5. Click the [Close Session] button to close the cashier session. 
Result: The Manage Cashier Sessions - Search Results screen refreshes to show the Status 
changed to "Closed." 



Printed Documentation 

688 

 
 

 

6. Click the [Balance] button to balance the cashier session. 
Result: The Balance Cashier Session screen displays. 
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7. Click the [View Associated Receipts] to see the receipts of payment transactions associated 
with a cashier session. 
Result: The View Associated Receipts screen displays. 
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Related Links 

Manage Cashier Session Overview 

Manage Cashier Sessions - Open Session Screen 

Manage Cashier Sessions - Search Screen 

Balance Cashier Session Screen 

View Associated Receipts Screen 

 

My Court Information 

 

Close a Cashier Session 

 

Introduction 

The system allows cashiering sessions open and close multiple times, as long as the session does not 
have a status of "Balanced" and the session is being re-opened on the same day. You must close your 
cashier session at the end of your workday.  

You may choose to close a cashier session at any time during the day without balancing the session. 
Refer to the Balance a Cashier Session task activity for details on this process. In addition, you can only 
close your own cashier sessions. However, if you have Accounting Supervisor security privileges, then 
you can close any cashier session within the system. 

Cashiering sessions are closed automatically at 12:00 AM every business day in accordance with AOC 
Guidelines for cashiering [AOC Guidelines for Closing Cashing Sessions]. 

Task Activity 

Perform the following steps to close a cashier session. 
 

1. Select [Accounting] > [Manage Cashier and Supervisor Sessions]. 
Result: The Manage Cashier Session Open Session screen displays. 
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 The radio button to the left of your cashiering session will be automatically selected, 
since the system recognizes which cashier session you have open. 

2. Click the [Close Session] button. 
Result: The Manage Cashier Session Open Session screen refreshes to show the cashier status 
as "Closed." 
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Related Links 

Manage Cashier Sessions Overview 

Manage Cashier Sessions - Open Session Screen 

 

My Court Information 

 

Balance a Cashier Session 

 

Introduction 

Balancing the cashier session is a mandatory task that occurs at the end of each business day. It involves 
the reconciliation of the monies within the system and the physical cash drawer. The amount of monies 
must be reconciled for each payment method (such as for cash, check, credit, etc.). 

Only closed cashiering sessions may be balanced. In addition, only the person that opened the session or 
someone with Accounting Supervisor security privileges can balance the session. This process includes 
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the generation of the "Daily Balance Report," which is used to report the findings of the Balance Cashier 
process. 

The system supports "Blind Balancing," which means that you will not have visibility to the system totals 
for each payment type for a cashiering session. If the total you submit does not match the total in the 
system, you will be given more attempts to review the cash drawer totals and re-enter the amounts into 
the system. The number of attempts that you have to reconcile the cash drawer with the system will be 
stipulated by your court. 

Cash Drawer Reconciliation 

Possible reasons that a cashier drawer may not reconcile with the system include: 

• Incorrect cash is tendered by the customer, resulting in a surplus or deficit of cash in the cash 
drawer. 

• An incorrect check amount is recorded into the payment transaction. This could occur if the 
numbers for the check amount are transposed, or if the customer entered the wrong amount on 
the check. 

• An incorrect payment method is specified for a payment type. For example, you may have 
accidentally entered a "check" payment method type, when the customer has instead tendered 
cash. 

Task Activity 

Perform the following steps to balance a cashier session. 
 

1. Select [Accounting] > [Manage Cashier and Supervisor Sessions]. 
Result: The Manage Cashier Session Open Session screen displays. 
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 The radio button to the left of your cashiering session will be automatically selected, 
since the system recognizes which cashier session you have open. 

2. Click the [Balance] button. 
Result: The Balance Cashier Session screen displays. 

 
 

 

3. Count the amounts in the cashier drawer for each payment method. Enter the total amount for 
each payment method into the appropriate fields. 

 If there is no amount for a payment method, enter "0.00". Be sure to include both the dollars 
and cents. 

4. Click the [Save] button. 
Result: The system will alert you that your cashier session has balanced successfully and 
generate the Daily Balance and Cashier Report. 
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 The system determines whether there are any discrepancies in the total drawer amounts 
based on the reconciliation report. If so, you can re-enter the totals up to three times. 

 

 

Related Links 

Manage Cashier Sessions Overview 

Manage Cashier Sessions - Open Session Screen 

Balance Cashier Session Screen 

Balance Cashier Session - Third Attempt Screen 

 

My Court Information 
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View Associated Receipts 

 

Introduction 

Viewing associated receipts describes the steps required to display receipts associated to a particular 
cashier session. 

If you are a supervisor, you will have access to view any cashier's receipts. Otherwise, you will only have 
access to your own receipts. 

Task Activity 

This activity takes place in the context of a cashier session search. Refer to the Manage Cashier Session 
task activity for details on this process. 

Perform the following steps to view associated receipts. 
 

1. Select the radio button of the cashier session to view its receipts. 
 This selection occurs from the Manage Cashier Session Search Results screen. 

 
 

 

2. Click the [View Associated Receipts] button. 
Result: The View Associated Receipts screen displays. 
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Related Links 

Manage Cashier Session Overview 

View Associated Receipts Screen 

 

Maintain Fees 

Maintain Fees Overview  

 

Introduction 

Maintaining fees within the system involves adding, maintaining, searching, adjusting and/or canceling 
fees. Fees are monies due resulting from services provided by the court. Fees can be related to filings, 
sanctions, returned checks, and miscellaneous services.  

Refer to the Configure Fee Schedule section for details on configuring the fee schedule. Refer to the Fee 
Waivers section for details on related fee waiver information. 

Fee Types 

Non case-related fees include fees associated with creating certified copies of a filing, such as a 
complaint. On the other hand, case-related fees are those fees that are associated with a case, such as 
filing fees, motion fees, or trust deposits. 
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Fees Automatically Generated by the System 

When the system creates a fee, an entry is made into the Register of Actions. An associated fee is also 
generated within the system based on the court’s Fee Schedule. 

Task Activities 

Maintaining fees includes the following task activities: 

• Search Fees 
• Create Case-Related Fees 
• Create Non Case-Related Fees 
• Adjust Fees 
• Cancel Fees 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Accounting Search Screen 

Adjust Fees Screen 

Cancel Fees Screen 

Case Related Fees Screen 

Non Case Related Fees Screen 

Record Payment/Trust Deposit Screen 

 

My Court Information 

 

Search Fees 

 

Introduction 

This activity allows you to search for case-related fees that have been assessed for a party in a case. 

Task Activity 

Perform the following steps to search for fees. 
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1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Fees] tab. 
Result: The Fees tab highlights and displays the appropriate information. 

 
 

 

3. Enter/Select data for at least the following search fields: 
• Participant Name 
• Case Number 
• Legacy Number 

 

4. Enter/Select data for other search parameter fields, as necessary. 
5. Click the [Search] button. 

Result: The Search Fees Results screen displays. 
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Related Links 

Maintain Fees Overview 

Accounting Search Screen 

 

My Court Information 

 

Create Case-Related Fees 
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Introduction 

In addition to automatically creating fees when certain activities happen, such as the court accepting a 
filing, the system allows you to manually create a case-related fee within the context of a case. An 
example of a manually created fee involves creating a trust for a customer or agency. 

Task Activity 

Perform the following steps to create a case-related fee. 
 

1. Select [Accounting] > [Fee Management and Record Payment] > [Create Case Related 
Fees]. 
Result: The Case Related Fees screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Fee Category 
• Fee Type 
• Fee Amount 
• Quantity 
• Fee Due Date 

 

 The Balance Due and Status (fee waiver status) will be automatically populated based 
on your entries to other fields. 

 Based on the Fee Category and Type, the Fee Amount will automatically populate if a 
Fee Schedule Amount exists for the Fee Category/Fee Type combination. Otherwise, if no 
corresponding Fee Schedule Amount exists, you must manually enter the fee amount. 
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3. Click the [Record Payment] button. 
Result: The Record Payment/Trust Deposit screen displays. 

 
 

 

 To add additional fees, click the [Add Fee] button.  
 To remove unwanted fees, select the checkbox to the left of the fee that will be removed 

and click the [Remove Fee] button. 

4. Enter/Update the available fields as needed. 
5. Click the [Save] button. 

Result: The Payment Confirmation and Receipt displays. 
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6. Click the [Print Receipt] button. 
Result: The Payment Confirmation and Receipt generates. 
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 Case-related fees that are saved will create entries in the Case History with a status of 
"Due," "Partially Waived," "Waived," etc., based on the fee waiver status. Cases involving 
pending fee waivers will not have a balance due for these fees until the fee waiver is revoked, 
partially waived, or fully waived. 

 Click the [Record Payment] button to proceed to the Recording Payment screen. Do 
this if the customer wants to pay for fees immediately after recording the fees in the system. 
Because creating fees and payments are separate transactions within the system, fees may be 
created without immediately accepting the monies due from the customer. 

 

 

Related Links 

Maintain Fees Overview 

Case Related Fees Screen 
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Record Payment/Trust Deposit Screen 

 

My Court Information 

 

Create Non Case-Related Fees 

 

Introduction 

Creating non case-related fees is the process of capturing the fees incurred for services. This may 
include such activities as creating printed copies of a filing or certifying copies of a filing.  

Non case-related fees are not written to the Case History. 

Task Activity 

Perform the following steps to create a non case-related fee. 
 

1. Select [Accounting] > [Fee Management and Record Payment] > [Create Non Case-Related 
Fees]. 
Result: The Non Case Related Fees screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Fee Category 
• Fee Type 
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• Name 
• Fee Amount $ 
• Quantity 

 

 The Fee Amount and Balance Due will be automatically populated based on the Fee 
Schedule configuration and the Quantity entered. If the Fee Amount does not populate 
automatically (as no corresponding Fee Schedule Amount exists), then the Fee Amount must 
be manually added. 

 Although the Payor Name is not listed as a required field, it must be entered if the fee 
type is a type of Trust, since the payor may become the recipient of any funds disbursed from 
the Trust. 

 

3. Click the [Record Payment] button. 
Result: The Record Payment/Trust Deposit screen displays. 

 
 

 

 To add additional fees, select [Add Fee]. To remove unwanted fees, select the fee 
checkbox to the left of the fee and click the [Remove Fee] button. 
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4. Enter/Update the available fields as needed. 
5. Click the [Save] button. 

Result: The Payment Confirmation and Receipt displays. 

 
 

 

 

 

Related Links 

Maintain Fees Overview 

Non Case Related Fees Screen 

Record Payment/Trust Deposit Screen 
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My Court Information 

 

Adjust Fees 

 

Introduction 

Fees must be adjusted one at a time. Adjusting multiple fees at the same time would cause complications 
in determining which of the fees should be adjusted and by what amount. 

Adjusting fees provides the ability to reduce the amount owed by a customer for a fee. You can adjust the 
fee amount if one of the following has occurred: 

• The fee is incorrect in the fee schedule. 
• A new fee schedule applies that has not been updated within the system. 
• A fee is incorrectly entered into the system. 
• A Judicial Officer orders a reduction of a fee amount.  

Task Activity 

This activity takes place in the context of a fee search. Refer to the Search Fees task activity for details 
on this process. 

Perform the following steps to adjust a fee. 
 

1. Select the checkbox for the fee to be adjusted. 
 This selection occurs from the Fee Search Results screen. 
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2. Click the [Adjust Fee] button. 
Result: The Adjust Fees screen displays. 
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3. Enter/Select data for the following required fields: 

• Reason 
• Adjusted Amount Due 
• Supervisor ID 
• Password 

 

4. Click the [Print Form/Save] button. 
Result: The Accounting Search screen re-displays. The Adjust Fees form is displayed.  

 To print this form, select File > Print from your browser menu.  
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Related Links 

Maintain Fees Overview 

Adjust Fees Screen 

Accounting Search Screen 

 

My Court Information 

 

Cancel Fees 

 

Introduction 

Canceling fees allows you to remove any amount owed for a fee. Fees may be cancelled if the fee is 
incorrectly assessed for the case, was entered in error, the customer refused to continue the transaction, 
or is a part of the void payment process. 

If a fee is cancelled, the court may revoke the services associated with the fee. For example, if the fee 
related to a complaint is cancelled because a customer chooses not to pay for the filing, the 
corresponding complaint would be cancelled from the system. 
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Task Activity 

This activity takes place in the context of a fee search. Refer to the Search Fees task activity for details 
on this process. 

Perform the following steps to cancel a fee. 
 

1. Select the checkbox for the fee to be adjusted. 
 This selection occurs from the Search Fees Results screen. 

 
 

 

2. Click the [Cancel Fee] button. 
Result: The Cancel Fees screen displays. 
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3. Enter/Select data for the following required fields: 

• Reason 
• Supervisor ID 
• Password 

 

4. Click the [Print Form / Save] button. 
Result: The Accounting Search screen re-displays. The Cancel Fees form is displayed.  

 To print this form, select File > Print from the browser menu. 
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Related Links 

Maintain Fees Overview 

Cancel Fees Screen 

Accounting Search Screen 

 

Record Payments and Trust Deposits 

Record Payments and Trust Deposits Overview  

 

Introduction 

Recording payments and trust deposits describes how the system captures payments recorded for case-
related fees (fees associated with filings and motions) or non case-related fees (such as miscellaneous 
fees associated with preparing copies or certifying documentation), or how to establish a trust. 

Since the system supports the creation of a trust, customers can deposit monies with the court to be 
applied to future court fees. The customer must stipulate the case number the trust will be established for, 
as well as contact information including name, address, and phone number. This information is required if 
monies are returned to the customer from the trust. 
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Task Activities 

Recording payments and trust deposits includes the following task activities: 

• Search Payments 
• Record Payments 
• Void Payments 
• Search Trusts 
• Create a Trust 
• Create a Trust Deposit From Overpayment 
• Replenish a Non-Interest Bearing Trust 
• Deactivate Draw Down Account 
• Transfer Payment to Case 
• Transfer Payment to Trust 
• Verify NSF 
• View NSF List 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Accounting Search Screen 

Calculate Interest Detail/Show Trust Deposit History Screen 

Deactivate Draw Down Account Screen 

Deposit Trust Screen 

Record Payment/Trust Deposit Screen 

Transfer To Trust Screen 

Verify NSF Screen 

View NSF List Screen 

Void Payment Screen 

Void Payment Confirmation and Receipt Screen 

 

My Court Information 
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Search Payments 

 

Introduction 

This activity allows you to search for payments in the system. Refer to the Search Feature Overview for 
details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a payment. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Payments] tab from the menu bar. 
Result: The Payments tab highlights and displays the payment search criteria. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Payments Results screen displays. 
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Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

 

My Court Information 

 

Record Payments 

 

Introduction 

The system provides the ability to record payments against fees associated with services provided by the 
court. The creation of a fee and the recording of a payment for a fee are treated as two distinct 
transactions. This means that the fee may be created at a different time and place than the recording of 
payment for that fee.  

Recording payments for fees occurs within the Record Payment screen. This screen allows you to view 
fees that are outstanding for a party or case, as well as other details regarding each fee. You can record 
payment for case-related fees (associated with filings, motions, etc.) and non case-related fees (such as 
creating printed copies of a filing and/or certifying copies for a filing). 

You must also select which fees are to be paid as stipulated by the customer. You can also capture 
payment information such as the payor organization (if the payor is a business, such as a law firm), the 
payor’s name, the payment method, amount, payor address, check number, form of identification and 
identification number, comments, and trust deposits for overages. 

Task Activity 

Perform the following steps to record a payment for a fee. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 
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3. Enter data in a primary search field or two secondary search fields and any other fields as 
appropriate. 

4. Click the [Search] button. 
Result: The Search Fees Results screen displays. 



Printed Documentation 

720 

 
 

 

5. Select the checkbox for the fee on which to record payment. 
6. Click the [Record Payment] button. 

Result: The Record Payment/Trust Deposit screen displays. 
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7. Enter/Select data for the necessary fields. 
8. Click the [Add Non-Case Related Fee] button to enter any miscellaneous fees incurred by the 

customer for non case-related services provided by the court. 
9. Select the checkbox to the left of any fees that should be deleted. 
10. Click the [Remove] button. 
11. Select the [Receipt for each case] and/or [Manual Receipt No.] checkboxes to create a unique 

receipt number for each case and/or create a receipt manually. 
12. Click the [Verify NSF] button to search the non-sufficient funds list for a matching payor name.  

 If the payor name matches to a name provided within the NSF list, the Verify NSF list 
displays and requires further action from the Accounting Clerk/Cashier. Otherwise, if no match is 
found, then you are notified that “No match exists”, and a status bar at the bottom of the Payment 
Information table will display "NSF Verified." 

13. Click the [Finish & Save] button. 
Result: The Payment Confirmation and Receipt generates. 
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Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

Record Payment/Trust Deposit Screen 

 

My Court Information 
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Void Payments 

 

Introduction 

Voiding a payment involves reversing the payment for a fee. Voiding a payment may be required for a 
variety of reasons and requires supervisor approval. Voiding payments can occur as a cashiering function 
or accounting function, depending on the reason for the void, and whether the payment and void payment 
transactions occur within the same cashiering session. 

When you void a payment you can cancel all fees associated with the voided payment. The court will 
revoke any services associated with the cancelled fees. If you do not cancel the fees associated with the 
voided payment, the status of the fees will revert to the status before payment (such as due, partially 
waived, or government deferral). The system allows you to create a void payment receipt if the customer 
requests one. 

Reasons for Voiding Payment 

• If an incorrect payment document (such as an unsigned check) is received. 
• If payment was recorded for a given set of fees, but the monies associated with the payment 

were not physically received from the customer. 
• If the customer requests a refund for payments made in a payment transaction for fees. 
• If the payment transaction contains incorrect information such as an incorrect payment method, 

incorrect fee, incorrect miscellaneous fees and quantities, incorrect party type (such as plaintiff or 
defendant) or incorrect party name, etc. 

• The Void Payment function is used during the transfer payment process. 
• A valid reason exists to reverse a payment (and disperse the monies back to the party) for a 

previously filed document in scenarios such as duplicate payments, payments made for the same 
fees by both parties in a case or by multiple individuals within a party, etc. 

• An NSF check is returned to the court. 
Task Activity 

Perform the following steps to void a payment. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 
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2. Select the [Payments] tab. 
Result: The Payments tab highlights and displays the appropriate information. 

 
 

 

3. Enter data in a primary search field or two secondary search fields and any other fields as 
appropriate. 

4. Click the [Search] button. 
Result: The Search Payments Results screen displays. 
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5. Select the payment radio button to be voided from the Search Payment Results. 
6. Click the [Void] button. 

Result: The Fee Details/Void Payment screen displays. 
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7. Enter/Select data for the following required fields: 

• Reason 
• Authorizing ID 
• Password 

 

8. Click the [Finish & Save] button. 
Result: A pop-up displays confirming that you want to void the payment. Click [OK] to proceed.  
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9. A pop-up displays confirming that you want to create a trust for good payment. Click [OK] to 
proceed. 
Result: The Void Payment Confirmation and Receipt displays. 

 
 

 

9. Click the [Print Acknowledgement Form] button to print the acknowledgement form from your 
browser. 

10. Click the [Print Receipt] button to print the receipt from your browser. 
 

 

Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

Void Payment Screen 

Void Payment Confirmation and Receipt Screen 
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My Court Information 

 

Search Trusts 

 

Introduction 

This activity allows you to search for trusts in the system. Refer to the Search Feature Overview for 
details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a trust. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Trusts] tab. 
Result: The Trusts tab highlights and displays the Trust search criteria. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Trust Results screen displays. 
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Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

 

My Court Information 
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Create a Trust 

 

Introduction 

Creating a trust refers to monies deposited into a holding account (or "in suspense") to be applied against 
fees associated with services provided by the court. 

To establish a Trust, the system uses a two-step process for generating fees and recording payments for 
fees. The first step in the process is that a "Trust" fee category and type must be recorded. Trusts are 
also created automatically as part of the Record Payment process, if the Trust is used to capture an 
overpayment made by a customer who pays with a check. If the Trust is not used for the payment of 
subsequent fees within a time period specified by the court, trust monies will be refunded to the payor 
during a disbursement process. 

The second step is to record payment for the Trust. Once payment has been recorded for the Trust and 
monies are accepted from the customer, funds may be dispersed from the Trust to pay subsequent court-
related fees. A trust within the system can be interest-bearing or not. 

Task Activity 

Perform the following steps to create a trust. 
 

1. Select [Accounting] > [Fee Management and Record Payment] > [Create Case Related 
Fees]. 
Result: The Case Related Fees screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Fee Category 
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• Fee Type 
• Fee Amount $ 
• Quantity 
• Fee Due Date 

 To create a Trust, select "Trust Deposit" from the Fee Category drop-down list. This will 
filter the Fee Types associated with the "Trust" category. Select the appropriate Trust from the 
Fee Type drop-down list. 

4. Click the [Record Payment] button. 
Result: The Record Payment/Trust Deposit screen displays. 

 
 

 

5. Enter/Select data for the necessary fields. 
6. Click the [Add Non-Case Fee] button to enter any miscellaneous fees incurred by the customer 

for non case-related services provided by the court. 
Result: The Non-Case Related Fees screen displays. 
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7. Select the checkbox to the left of any fees that should be deleted. 
8. Click the [Remove] button. 
9. Click the [Verify NSF] button to search the non-sufficient funds list for a matching payor name.  

Result: The Verify NSF screen displays. 

 
 

 

10. Select the [Receipt for each case] and/or [Manual Receipt No.] checkboxes to create a unique 
receipt number for each case and/or create a receipt manually. 

 If the payor name matches a name on the NSF list, the Verify NSF list displays; requiring 
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approval to accept payment. If no match is found, you will be notified that “No match exists” and a 
status bar at the bottom of the Payment Information table will display "NSF Verified." 

11. Click the [Finish & Save] button. 
Result: The Payment Confirmation and Receipt generates. 

 
 

 

12. Click the [Print Receipt] button to print the receipt. 
 

 

Related Links 

Record Payments and Trust Deposits Overview 

Case Related Fees Screen 

Record Payment/Trust Deposit Screen 

Non Case Related Fees Screen 
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Verify NSF Screen 

 

My Court Information 

 

Create a Trust Deposit For Overpayment 

 

Introduction 

If a payment amount is greater than the fee amount, you can create a trust deposit to allocate the 
difference. This can be a general overage account or a specific trust fund. This process only applies when 
the total fees due is less than the amount paid by the customer via a check payment. 

Task Activity 

This activity takes place in the context of a recording a payment. Refer to the Record Payment task 
activity for details on this process. 

Perform the following steps to create a trust deposit from overpayment. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Fees] tab. 
Result: The Fees tab highlights and displays the appropriate information. 
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3. Enter data in a primary search field or two secondary search fields and any other fields as 
appropriate. 

4. Click the [Search] button. 
Result: The Search Fees Results screen displays. 

 
 

 

5. Select the checkbox for the fee to record payment against. 
6. Click the [Record Payment] button. 

Result: The Record Payment/Trust Deposit screen displays. 
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7. Enter/Select data for the necessary fields. 
8. Click the [Add Non-Case Related Fee] button to enter any miscellaneous fees incurred by the 

customer for non case-related services provided by the court. 
9. Select the checkbox to the left of any fees that should be deleted. 
10. Click the [Remove] button. 
11. Click the [Verify NSF] button to search the non-sufficient funds list for a matching payor name.  
12. Select the [Receipt for each case] and/or [Manual Receipt No.] checkboxes to create a unique 

receipt number for each case and/or create a receipt manually. 
 If the payor name matches a name on the NSF list, then the Verify NSF list will display. 

You would then require approval of payment from an Accounting Supervisor. Otherwise, if no 
match is found, you will be notified that “No match exists” and a status bar at the bottom of the 
Payment Information table will display "NSF Verified." 

12. Click the [Finish & Save] button. 
Result: The Payment Confirmation and Receipt generates. 
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Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

Record Payment/Trust Deposit Screen 

 

My Court Information 
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Replenish a Non-Interest Bearing Trust 

 

Introduction 

Replenish a non-interest bearing trust describes the process of depositing money into an existing, non-
interest bearing trust account. Deposits are only allowed into non-interest bearing trusts (this is handled 
through the fee schedule). 

This task activity does not cover the actual process of recording a payment against a trust fee, which is 
the initial creation of the trust. 

Task Activity 

This activity takes place in the context of a trust search. Refer to the Search Trusts task activity for details 
on this process. 

Perform the following steps to replenish a non-interest bearing trust account. 
 

1. Select the checkbox for the trust account in which to deposit money. 
 This selection occurs from the Search Trust Results screen. 
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2. Click the [Deposit] button. 
Result: The Deposit Trust screen displays. 
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3. Enter a Trust Amount. 
4. Click the [Save] button. 

Result: The Search Trust Results screen re-displays. 
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Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

Deposit Trust Screen 

 

My Court Information 
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Deactivate Draw Down Account 

 

Introduction 

Deactivating a draw down account is the process of disabling trust accounts used to pay for court-related 
fees and services. 

Task Activity 

This activity takes place in the context of a Trust search. Refer to the Search Trusts task activity for 
details on this process. 

Perform the following steps to deactivate a draw down account. 
 

1. Select the checkbox for the trust account that has the draw down account to deactivate. 
 This selection occurs from the Search Trust Results screen. 
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2. Click the [Deactivate] button. 
Result: The Deactivate Draw Down Account screen displays. 

 
 

 

3. Select a Reason. 
4. Click the [Save] button. 

Result: The Search Trust Results screen re-displays. 
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Related Links 

Record Payments and Trust Deposits Overview 

Deactivate Draw Down Account Screen 

Accounting Search Screen 

 

My Court Information 
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Transfer Payment to Case 

 

Introduction 

Transfer to case describes the activities associated with transferring an original payment for a set of fees 
(either related or not related to a case) to pay for a different set of fees. 

Task Activity 

This activity takes place in the context of a payment search. Refer to the Search Payments task activity 
for details on this process. 

Perform the following steps to transfer a payment to a case. 
 

1. Select the radio button of the payment to transfer to a case. 
2. Click the [Transfer to Case] button. 

Result: The Accounting Search screen displays. 

 
 

 

3. Enter/Select data for the appropriate search parameter fields. 
 Use this screen to search for the case to which the payment is to be transferred. 

4. Click the [Search] button. 
Result: The Search Fees Results screen displays. 
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5. Select the checkbox for the case on which to apply the payment. 
6. Select the [Record Payment] button. 

Result: The Record Payment/Trust Deposit screen displays. 
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7. Enter/Select data for the necessary fields. 
8. Click the [Save] button. 

Result: The Payment Confirmation and Receipt screen displays. 
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Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

Record Payment/Trust Deposit Screen 

 

My Court Information 

 

Transfer Payment to Trust 

 

Introduction 

Transfer to trust describes the activities associated with transferring an original payment for a trust 
deposit (either related or not related to a case) to serve as a trust deposit for a different case or 
participant. 
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Task Activity 

This activity takes place in the context of a payment search. Refer to the Search Payments task activity 
for details on this process. 

Perform the following steps to transfer a payment to a trust. 
 

1. Select the radio button for the payment to transfer to a trust account. 
 This selection occurs from the Search Payments Results screen. 

 
 

 

2. Click the [Transfer to Trust] button. 
Result: The Transfer to Trust screen displays. 
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3. Enter/Select data for the necessary fields. 
4. Click the [Next] button. 

Result: The Record Payment/Trust Deposit screen displays. 
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5. Select the [Record Payment] tab. 
Result: The Record Payment tab highlights and displays the appropriate information. 

 
 

 

6. Enter/Select data for the necessary fields. 
7. Click the [Save] button. 

Result: The Payment Confirmation and Receipt screen displays. 



The Accounting Section 

753 

 
 

 

 

 

Related Links 

Record Payments and Trust Deposits Overview 

Accounting Search Screen 

Transfer To Trust Screen 

Record Payment/Trust Deposit Screen 

 

My Court Information 
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Verify NSF 

 

Introduction 

Verify NSF describes the activities associated with determining whether or not a check can be accepted 
from a potential payor. These activities include verifying whether the payor's name is listed on the NSF 
list, requesting your supervisor's approval if necessary, and either accepting or rejecting the check as 
payment. 

Task Activity 

This activity takes place in the context of recording a payment. Refer to the Record Payment task activity 
for details on this process. 

Perform the following steps to verify NSF. 
 

1. Click the [Verify NSF] button. 
 This selection occurs from the Record Payment/Trust Deposit screen. 
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2. Result: The Verify NSF screen displays. 

 
 

 

2. Review the NSF list for name of the payor.  
3. Click the [No Match] button if no match is found. 

Result: The Record Payment/Trust Deposit screen re-displays. Continue with the payment by 
check. 
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4.  If the payor's name appears on the NSF list, and the payor wishes to make payment other 
than by check, click the [Change Payment Method] button.  
Result: The Record Payment/Trust Deposit screen re-displays. Proceed using a method of payment other 
than check. 
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4. Click the [Override NSF] button to accept payment by check if the payor's name is found on the 
NSF list. 
Result: The Record Payment/Trust Deposit screen re-displays. Proceed with the payment by 
check. 

 You must obtain your supervisor's approval to override NSF. 
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Related Links 

Record Payments and Trust Deposits Overview 

Record Payment/Trust Deposit Screen 

Verify NSF Screen 

 

My Court Information 

 

View NSF List 
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Introduction 

View NSF List describes the activities associated with reviewing payor names on the NSF list and 
searching for a specific payor name. 

Task Activity 

This activity takes place in the context of recording a payment by check. Refer to the Record Payment 
task activity for details on this process. 

Perform the following steps to view the NSF list. 
 

1. Click the [View NSF List] button. 
 This selection occurs from the Record Payment/Trust Deposit screen. 

 
 

 

2. Result: The View NSF List screen displays. 
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2. Select a letter of the alphabet from the list provided. 
Result: The View NSF List screen refreshes to display only payor names that begin with the 
selected letter. 

 
 

 

 

 

Related Links 

Record Payments and Trust Deposits Overview 
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Record Payment/Trust Deposit Screen 

View NSF List Screen 

 

Calculate Interest 

Calculate Interest Overview  

 

Introduction 

The system calculates interest that is accrued by an interest-bearing trust deposit for a specified period of 
time using the Compound Interest Method. This means that the interest accrued by a trust deposit will 
include interest calculated on interest. Through the fee schedule, the system will alert you if a trust 
deposit is interest bearing or non-interest bearing.  

Interest can be calculated at the same time a disbursement is created or at a later time.  

This activity does not include the process of maintaining interest rates. This activity is performed by a 
system administrator. 

Where This Information is Saved 

Once the accrued interest is calculated for an interest-bearing trust, the Accrued Interest Form is 
generated and saved as a PDF file, which is then attached to the Case History as a DMS filing.  

How Interest is Calculated 

To calculate the interest on an interest-bearing trust, the system uses the current trust balance, the date 
that the money was deposited, and the effective interest rates for that time period.  

Task Activities 

Calculating interest includes the following task activity: 

• Calculate Interest 
Additional Resources 

Other items related to this overview include the following: 

• Forms/Notices/Reports 
• Configure Fee Schedule 

 

 

Related Links 

Accounting Search Screen 

Calculate Interest Screen 

Calculate Interest Detail/Show Trust Deposit History Screen 
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My Court Information 

 

Calculate Interest 

 

Introduction 

The system calculates interest that is accrued by an interest-bearing trust deposit for a specified period of 
time using the Compound Interest Method. Based on the selected trust type, the system will verify 
whether it is an interest-bearing trust.  

The system will then display the total interest accrued for the time period specified, as well as the case 
number (if applicable). If interest is calculated during the creation of a disbursement, then the system will 
display the Accrued Interest Form in a PDF format within a pop-up window. Once you review and confirm 
the details of the Accrued Interest Form, the form can be printed and saved in the database. 

Pre-Conditions to This Activity 

The interest rates for the period of time that the account has been accruing interest must be entered by a 
system administrator. 

Trust Account Information 

Calculating interest for trust accounts occurs within the Accounting Search screen. The Accounting 
Search screen allows you to view which trusts are interest-bearing, as well as other details regarding 
trusts, such as trust amount, accrued interest, and total trust amount. 

Non Interest-Bearing Trusts 

The system displays an alert if the selected trust is non-interest bearing and will confirm whether or not 
you want to proceed with the interest calculation. If you continue with this process, then the system will 
retrieve the effective interest rates for the trust from the deposit date to the current date and apply these 
rates to the current balance. 

The system is only configured to alert you that a non interest-bearing trust has been selected. You may 
proceed with the interest calculation after this alert has displayed. 

Task Activity 

This activity takes place in the context of a trust search. Refer to the Search Trusts task activity for details 
on this process. 

Perform the following steps to calculate interest. 
 

1. Select the checkbox for the trust on which you want to calculate interest. 
 This selection occurs from the Trusts tab on the Accounting Search screen. 
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2. Click the [Calculate Interest] button. 
Result: The Calculate Interest screen displays. 
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Related Links 

Calculate Interest Overview 

Accounting Search Screen 

Calculate Interest Screen 

 

Manage Payment Plan 

Manage Payment Plan Overview  

 

Introduction 

A participant may seek to defer payment of fees. If the court determines that the participant is unable to 
pay in full, a payment plan may be established in which the participant is allowed to make installment 
payments for monies owed to the court. Maintaining a payment plan involves creating and modifying a 
payment plan based on a court order.  

Refer to the Maintain Fees section for details on creating fees. 

Number of Payment Plans 

Only one payment plan may exist for each combination of case number and participant name. 

Task Activities 

Maintaining a payment plan includes the following task activities: 

• Search Payment Plans 
• Create Payment Plan 
• Modify Payment Plan 
• Deactivate Payment Plan 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Manage Payment Plan Screen 

Accounting Search Screen 

Deactivate Payment Plan Screen 
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My Court Information 

 

Search Payment Plans 

 

Introduction 

This activity allows you to search for payment plans. Refer to the Search Feature Overview for details on 
performing a search in the system. 

Task Activity 

Perform the following steps to search for a payment plan. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Payment Plan] tab.  
Result: The Payment Plan tab highlights to displays the appropriate information. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Accounting Search screen refreshes with the Search Payment Plan Results. 
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Related Links 

Manage Payment Plan Overview 

Accounting Search Screen 

 

My Court Information 

 

Create Payment Plan 

 

Introduction 

You can create a payment plan for customers who are ordered to pay the balance of fees due in 
installments. The terms and conditions for payment plans are configurable. As a result, the Court may 
revoke a payment plan and begin the debt collection process any time a debtor fails to meet a payment 
deadline.  

Applying Overpayments 

When creating a payment plan, you can choose to apply any overpayment to the next installment 
payment. This would move it to the next due date, but would leave the end date unchanged. Or you can 
apply the overpayment to the remaining balance, which leaves the next due date unchanged but moves 
the end date.  

Multiple Payment Plans 

Although a payment plan may relate to multiple cases, only one payment plan may be assigned to each 
combination of case number and participant name. 

Task Activity 

This activity takes place in the context of a fee search. Refer to the Search Fees task activity for details 
on this process. 

Perform the following steps to create a payment plan. 
 

1. Select the checkbox for the fee on which to add to the payment plan. 
 This selection occurs from the Search Fees Results screen. 
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2. Click the [Add to Payment Plan] button. 
Result: The Manage Payment Plan screen displays. 
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3. Enter/Select data for the following required fields: 
o Installment Amount $ 
o Frequency 
o Start Date 
o Reason 

 

5. Click the [Save] button. 
Result: The Search Payment Plan Results screen displays to show the added payment plan. 
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Related Links 

Manage Payment Plan Overview 

Manage Payment Plan Screen 

Accounting Search Screen 

 

My Court Information 

 

Modify Payment Plan 

 

Introduction 

Modifying a payment plan includes specifying the start date, payment frequency (weekly, bi-weekly, semi-
monthly, monthly, yearly), and installment amount (or the number of installments). It also includes adding 
or removing fees that belong to the same participant. These fees may relate to multiple cases. 



The Accounting Section 

771 

A payment plan can be changed by configuring the installment amounts (or installment amounts that 
vary) instead of using the defaulted equal installments. An installment can be partially paid.  

Payment Plan Balance 

After a payment plan modification, the system verifies that the total payment plan balance remains the 
same. For example, a payment plan can be modified even if some installments have already been paid. 
You must then specify the number of installments remaining, or set a new start date.  

Associated Fees 

The fees associated with a payment plan can be adjusted or cancelled. This automatically updates the 
payment plan by adjusting the end date and the amount of the last installment, if appropriate. The 
frequency and default installment amount will not be changed by the system, but may be updated later. 

Task Activity 

This activity takes place in the context of a payment plan search. Refer to the Search Payment Plans task 
activity for details on this process. 

Perform the following steps to modify a payment plan. 
 

1. Select the radio button of the payment plan to modify. 
 This selection occurs from the Search Payment Plans Results screen. 
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2. Click the [Details/Modify] button. 
Result: The Manage Payment Plan screen displays. 

 
 

 

3. Enter/Select data for any necessary fields. 
4. Select the [Custom Installments] tab. 

Result: The Custom Installments tab highlights and displays the appropriate information.  
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5. Enter/Select data for any necessary fields. 
6. Select the [Participant Details] tab. 

Result: The Participant Details tab highlights and displays the appropriate information. 

 
 

 

7. Enter/Select data for any necessary fields. 
8. Click the [Save] button. 

Result: The Search Payment Plans Results screen displays to show the modified payment plan. 
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Related Links 

Manage Payment Plan Overview 

Accounting Search Screen 

Manage Payment Plan Screen 

 

My Court Information 

 

Deactivate Payment Plan 

 

Introduction 

Deactivating a payment plan can be done for several reasons, including: 

• If the payment plan was created in error, or 
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• If the payor wishes to pay the full amount owed.  
 

 

Deactivating a payment plan removes fees from installment status. However, the status and fee amounts 
will remain due and do not change. 

Task Activity 

This activity takes place in the context of a payment plan search. Refer to the Search Payment Plans task 
activity for details on this process. 

Perform the following steps to deactivate a payment plan. 
 

1. Select the radio button of the payment plan to deactivate. 
 This selection occurs from the Search Payment Plans Results screen. 

 
 

 

2. Click the [Deactivate] button. 
Result: The Deactivate Payment Plan screen displays. 
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3. Select a Reason. 
4. Click the [Save] button. 

Result: The Search Payment Plans Results screen refreshes and shows the selected payment 
plan deactivated.  

 
 

 

 



The Accounting Section 

777 

 

Related Links 

Manage Payment Plan Overview 

Accounting Search Screen 

Deactivate Payment Plan Screen 

 

Create Disbursements 

Create Disbursement Overview  

 

Introduction 

Creating a disbursement allows disbursements to be made to one or more payees in reference to the 
original payment transaction.   

Disbursements to payees may only be made against monies in a trust account. Funds in a trust account 
can be disbursed to one or multiple payees, not necessarily the trust holder, as when third party deposits 
monies with the court. If the trust being disbursed is interest bearing, then the interest accrued can be 
calculated through the disbursement date. Refer to the Calculate Interest section for details on this 
process.  

Funds in a trust account can be partially disbursed - with partial amounts left in the trust - or disbursed in 
full. For payments made by check, disbursements can be made based on local court policy regarding 
payment clearance.  

Issuing and Tracking Checks 

The process of issuing and tracking checks lies outside of the system and is not detailed here.   

Task Activities 

Creating a disbursement includes the following task activity: 

• Create Disbursement 
Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

Accounting Search Screen 

Create Disbursement Screen 
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My Court Information 

 

Create Disbursement 

 

Introduction 

Creating disbursements allows these disbursements to be paid from a trust account for either case-
related or non case-related payments. 

If the trust payment was made by check, then the system will verify that the disbursement date meets the 
local court policy regarding the number of days that have passed since the original trust payment was 
received. If the trust deposit was created as the result of a voided payment, then the disbursement date 
will be based on the original payment date. 

Where a Disbursement is Made 

The Create Disbursement screen may be accessed from either the Accounting Search screen or within 
the context of a case from the Case Search screen. 

Updating a Trust Account 

After a disbursement is processed, the system automatically updates the trust account details as 
appropriate. 

Trusts Marked for Escheatment 

When a disbursement is created from a trust account which has been marked for Escheatment, the 
system allows the option to set the reason for disbursement to "Escheatment." If the trust is fully 
disbursed, the trust status will be set to "Escheated."  

This reason is available only when the selected trust has a status of Marked for Escheatment. Refer to 
the Maintain Escheatment section for details on this process. 

Task Activity 

This activity takes place in the context of a Trust search. Refer to the Search Trusts task activity for 
details on this process. 

Perform the following steps to create a disbursement. 
 

1. Select the checkbox of the trust to disburse. 
 This selection occurs from the Trusts tab on the Accounting Search screen. 
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2. Click the [Create Disbursement] button. 
Result: The Create Disbursement screen displays. 
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3. Select the [Disbursement Details] tab. 
Result: The Disbursement Details tab highlights and displays the disbursement payee 
information.  

4. Enter/Select data for the following required fields: 
5. Reason 
6. Category/Payee 
7. C/O - Attention/To Address 
8. Disbursement Amount $ 

 If the reason for disbursement is escheatment, then the system will verify that the Notice 
of Unclaimed Funds has been generated and that the escheat date has passed. The 
disbursement will not be created if the notice has not been generated or if the escheat date 
has not passed. 

5. Click the [Add] button to create additional disbursement payees. 
6. Click the [Remove] button to delete a payee. 
7. Click the [Calculate Interest] button to calculate the interest on the disbursement amount. 
8. Click the [Save] button. 

 

 

Related Links 

Create Disbursement Overview 
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Accounting Search Screen 

Create Disbursement Screen 

 

Maintain Disbursements 

Maintain Disbursements Overview  

 

Introduction 

A disbursement is the distribution of monies from a trust. Maintaining disbursements involves updating an 
existing disbursement record with check information (such as the check number) after a check has been 
processed, cancelling an existing disbursement as needed (such as when a check has not been cashed), 
and assigning/unassigning a refund number. 

The process of issuing and tracking checks against recorded disbursements lies outside of the system 
and is not described here. 

Canceling a Disbursement 

A disbursement can be cancelled with appropriate authorization if it was recorded in error or if the 
disbursement check has not been cashed. Once a check is issued against a recorded disbursement, the 
disbursement can be manually updated with the check information. A disbursed trust payment, whether 
partial or in full, cannot be voided. It requires that all related payments must first be cancelled. After 
canceling a disbursement, the system updates the Case History with the date, cancelled amount, reason 
for cancellation, clerk's name, payee and trust information. 

Voided Payments 

Disbursements to payees can only be made against monies in a trust account. This means that when a 
voided payment is to be refunded, it must first be automatically or manually transferred to a trust. A 
disbursed trust payment, whether partially paid or paid in full, cannot be voided until all related 
disbursements are first cancelled. At that point, the trust payment may then be voided. 

Task Activities 

Maintaining disbursements includes the following task activities: 

• Search Disbursements 
• Assign/Unassign a Refund Number 
• Update Disbursements 
• Cancel Disbursements 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Forms/Notices/Reports 
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Related Links 

Accounting Search Screen 

Cancel Disbursement Screen 

Update Disbursement Screen 

 

My Court Information 

 

Search Disbursements 

 

Introduction 

This activity allows you to search for disbursements in the system. Refer to the Search Feature Overview 
for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a disbursement. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Disbursements] tab. 
Result: The Disbursements tab highlights and displays the disbursements search criteria. 
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Disbursements Results screen displays. 
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Related Links 

Maintain Disbursements Overview 

Accounting Search Screen 

 

My Court Information 

 

Assign/Unassign a Refund Number 

 

Introduction 

Assigning or unassigning a refund number creates/removes a sequential, court-generated number to a 
trust disbursement. The system automatically generates the refund numbers for you to assign to a trust 
disbursement.  

Task Activity 

This activity takes place in the context of a disbursement search. Refer to the Search Disbursements task 
activity for details on this process. 

Perform the following steps to assign/unassign a refund number to a trust disbursement. 
 

1. Select the checkboxes of the disbursements on which to assign refund numbers. 
 This selection occurs from the Search Disbursements Results screen. 
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2. Click the [Assign/Unassign Refund Number] button. 
Result: The Search Disbursements Results screen refreshes to display a refund number 
assigned to the trust disbursement. 
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 If a refund number has already been assigned to a trust disbursement, performing the 
steps above will unassign the refund number. 

 

 

Related Links 

Maintain Disbursements Overview 

Accounting Search Screen 

 

My Court Information 

 

Update Disbursements 
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Introduction 

Updating a disbursement allows you to manually update disbursement information including the 
disbursement type, disbursement number, date of issuance, check clearance date, and check status. 

Task Activity 

This activity takes place in the context of a disbursement search. Refer to the Search Disbursements task 
activity for details on this process. 

Perform the following steps to update a disbursement. 
 

1. Select the checkbox of the disbursement to update. 
 This selection occurs from the Search Disbursements Results screen. 

 
 

 

2. Click the [Update Disbursement] button 
Result: The Update Disbursement screen displays. 
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3. Select the [Disbursement Details] tab. 
Result: The Disbursement Details tab highlights and displays the disbursement payee 
information.  
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4. Enter a Disbursement Reason. 
5. Click the [Save] button. 

Result: The Update Disbursement screen re-displays. 

 
 

 

 

 

Related Links 

Maintain Disbursements Overview 

Accounting Search Screen 

Update Disbursement Screen 

 

My Court Information 

 

Cancel Disbursements 

 

Introduction 

The system allows you to cancel a disbursement if one of the following has occurred: 
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• The disbursement was recorded in error. 
• The disbursement check has not been cashed within a specified period of time. 

 

 

The process of issuing checks against recorded disbursements is tracked outside of the system. 
However, once checks are issued, disbursement check information in the system can be updated, 
including the check number, check issuance date, check clearance date, and check status. 

Trust Payments 

A disbursed trust payment, whether a partial payment or a payment in full, cannot be voided. All related 
disbursements must be cancelled first. 

Task Activity 

This activity takes place in the context of a disbursement search. Refer to the Search Disbursements task 
activity for details on this process. 

Perform the following steps to cancel a disbursement. 
 

1. Select the checkbox of the disbursement to cancel. 
 This selection occurs from the Search Disbursement Results screen. 
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2. Click the [Cancel Disbursement] button. 
Result: The Cancel Disbursement screen displays. 

 
 

 

3. Select a reason for cancellation from the Reason dropdown list. 
4. Click the [Save] button. 

Result: The Search Disbursement Results screen displays.  
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 The Disbursement Status now reads "CANCELLED." 

 

 

Related Links 

Maintain Disbursements Overview 

Accounting Search Screen 

Cancel Disbursement Screen 

 

Maintain Collections 

Maintain Collections Overview  
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Introduction 

Maintaining collections includes referring overdue fees to the collection process, recording a payment 
from a collection agency, and canceling or adjusting fees currently in collections. If the fees are case-
related, then the system will update the Case History with the new information.  

You also have the ability to apply additional fees which have resulted from a late payment or collection 
process. 

Fees may be referred to collections at any time by the accounting office or the courtroom even if the fees 
have not been marked for collections. Also, to cover expenses incurred in the collections process, an 
additional fee may be charged to the participant. 

Generating Notices 

Maintaining collections also covers the process of generating notices regarding unpaid fees. 

OSC Hearing 

Maintaining Collections also covers the process of submitting fees to a work queue so that an OSC 
Hearing can be scheduled. If an OSC Hearing is not scheduled, then you must cancel the fee, adjust the 
fee, or change the payment due date to prevent it from being re-added to the OSC Hearing work queue. 
Each night the system performs the following tasks related to collections:  

• Generates the Delinquent Payment Notice to participants regarding fees that are overdue. 
• Populates the work queue to allow you to schedule an OSC Hearing for unpaid fees. 
• Marks fees that are overdue for collections. 

Reporting Fees to Collections 

If a fee is adjusted and the fee status is “Referred to Collections,” then the system will track this fee 
information in a report that can be submitted to collection agencies. If a fee status is updated to “Referred 
to Collections,” then it will also appear on this report. This activity only covers recently adjusted fees and 
does not discuss the process of reporting newly referred or previously referred fees to a collection 
agency. Refer to the Maintain Fees section for details on this process. 

Task Activities 

Maintaining collections includes the following task activities: 

• Search Overdue Fees 
• Refer to Collections 
• Return from Collections 
• Record Payment From a Collection Agency 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

Accounting Search Screen 
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Select Collections Agency Screen 

 

My Court Information 

 

Search Overdue Fees 

 

Introduction 

This activity allows you to search for overdue fees. Refer to the Search Feature Overview for details on 
performing a search in the system. 

Task Activity 

Perform the following steps to search for overdue fees. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [Collections] tab. 
Result: The Collections tab highlights and displays the appropriate information.  
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3. Enter/Select data for the appropriate search parameter fields. 
4. Click the [Search] button. 

Result: The Search Collections Results screen displays. 
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Related Links 

Maintain Collections Overview 

Accounting Search Screen 

 

My Court Information 

 

Refer to Collections 
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Introduction 

When fees due to the court are not paid on time, the court is responsible for their recovery. The court may 
then refer these unpaid fees to a collection agency. However, certain criteria must be met in order for this 
referral to occur. For example, the minimum dollar amount, type and age of the fee must be met.  

The court also processes payments from collection agencies and adjusts accounts that currently have 
fees assessed.  

Determining Overdue Fees 

Every night the system determines which overdue fees should be referred to collections. You can then 
review the Collection Report to see the fees that have been marked for collections and confirm that the 
referral is valid.  

A fee must have a status of "Due" or "Marked for Collections" before it can be referred to collections. 
Fees may be referred to collections from the Accounting Office or Courtroom, even if the fees have not 
yet been marked for collections. 

Additional Costs 

Additional costs may be incurred by the court to collect overdue fees. To offset these costs, an additional 
fee may be assessed to a participant. This additional fee is configured by the court.  

Collection Agency Commissions 

Commissions charged by collection agencies to cover costs are not deducted from recorded payments. 
They are instead distributed to a special bucket that you can override. If a collection agency successfully 
recovers a fee, whether partially paid or paid in full, the payment must be recorded as a regular payment.  

Adjusted or Cancelled Fees 

If a fee is referred to collections and later adjusted or cancelled, then that fee will be included in a 
separate section of the Collections Report. The status of fees that are “Marked for Collections” can be 
changed when the fee is paid, adjusted, cancelled, or referred to collections.  

Payments made for due fees are not applied to fees that are “Referred to Collections” or “Marked for 
Collections.” Participants must resolve overdue fees referred to collections directly with the collection 
agency, unless the court is configured to accept payments for fees that have been referred to collections. 

Task Activity 

This activity takes place in the context of a fee search. Refer to the Search Fees task activity for details 
on this process. 

Perform the following steps to refer a fee to collections. 
 

1. Select the checkboxes for the fees to refer to collections. 
 This selection occurs from the Search Fees Results screen. 
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2. Click the [Refer to Collections] button. 
Result: The Select Collections Agency screen displays. 

 
 

 

3. Select a collection agency from the Collection Agency Name drop-down list. 
 This drop-down list only appears if your court refers overdue fees to more than one 

collection agency. 
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4. Click the [Save] button. 
Result: The Search Fees Results screen displays. 

 
 

 

 The status of the fee should now read "Referred to Collections." 

 

 

Related Links 

Maintain Collections Overview 

Accounting Search Screen 

Select Collections Agency Screen 
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My Court Information 

 

Return From Collections 

 

Introduction 

When a court-approved collection agency is not successful in recovering fees, the responsibility of 
collecting those fees is then returned back to the court. The court may then adjust or cancel the fee as 
appropriate, or pursue other collection methods.  

Task Activity 

This activity takes place in the context of a search for fees that have been referred to collections. Refer to 
the Search Overdue Fees task activity for details on this process. 

Perform the following steps to return a fee from collections. 
 

1. Select the checkboxes for the fees to return from collections. 
 This selection occurs from the Search Collections Results screen. 
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2. Click the [Return from Collections] button. 
Result: The Search Fees Results screen displays. 

 
 

 

 The status of the fee should now read "Marked for Collections." This status will allow you 
to resubmit the fees for collection to a different agency (if your court uses more than one 
agency.) 

 

 

Related Links 

Maintain Collections Overview 

Accounting Search Screen 
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My Court Information 

 

Record Payment From a Collection Agency 

 

Introduction 

Recording a payment from a collection agency involves applying monies against fees due (either partial 
or in full) that have been collected by a collection agency. Fees that are paid and are part of a payment 
plan will be applied to all of the fees in a payment plan. Payments made by checks that are more than the 
total balance due will alert you to create a trust deposit and transfer the excess amount. 

Generating Alerts 

Fees recovered by a collection agency, whether partially paid or paid in full, must be recorded as a 
regular payment. The system can be configured to allow some users to record these regular payments. 
The system can also be configured to display alerts showing that a collected payment has been recorded. 

Task Activity 

This activity takes place in the context of a search for overdue fees. Refer to the Search Overdue Fees 
task activity for details on this process. 

Perform the following steps to record a payment from a collections agency. 
 

1. Select the checkbox for the fee in which to record the payment. 
 This selection occurs from the Search Collections Results screen. 
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2. Click the [Record Payment] button. 
Result: The Record Payment/Trust Deposit screen displays. 
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3. Select the checkbox for the fee on which to record a payment. 
4. Enter/Update the available fields as needed. 
5. Click the [Finish & Save] button. 

Result: The Accounting Search screen displays with a payment confirmation message. The 
payment receipt is produced. 
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 The status of the fee should now be "Paid" if it was paid in full. 

 

 

Related Links 

Maintain Collections Overview 

Accounting Search Screen 

Record Payment/Trust Deposit Screen 

 

Maintain NSF List 

Maintain NSF List Overview 

 

Introduction 

Maintaining the NSF List includes adding and updating name entries when checks are returned from the 
bank due to non-sufficient funds, closed accounts, invalid signatures, and/or stopped payments.  

The NSF List is populated when a payor submits a payment by check to the court that is returned by the 
bank. NSF entries contain the payor’s information and specific information regarding checks that have 
been returned unpaid. While you can add first-time NSF payors to this list, you can also update a payor's 
status. Requests for the payor to be removed from the NSF list can also be processed by the court.  
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Status Changes 

The court may configure the system to update a payor's status from "Warning" to "Reject" after a payor 
commits a certain number of NSF transactions. A status of "Reject" will alert you to stop accepting checks 
from the payor. 

NSF Transaction Fees 

Payors are charged a fee as the result of an NSF transaction. If the payor is excused from paying that fee 
for any reason, the fee may be cancelled. The amount of these fees varies and is configurable by the 
court. Refer to the Maintain Fees section for details on related fee processes. 

If the payor information is not available from the original payment transaction, you can get this information 
during the void payment process. This process occurs when the payor’s check is returned from the bank. 
Refer to the Void Payment task activity for details on voiding payments. 

Task Activities 

Maintaining the NSF List includes the following task activities: 

• Search NSF List 
• Add Payors to NSF List 
• Remove Payors From NSF List 
• Add Checks to NSF List 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Maintain NSF Screen 

Accounting Search Screen 

Override NSF Screen 

 

My Court Information 

 

Search NSF List 

 

Introduction 

This activity allows you to search for NSF List-related information and information for a given payor. Refer 
to the Search Feature Overview for details on performing a search in the system. 
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Task Activity 

Perform the following steps to search the NSF List. 
 

1. Select [Accounting] > [Search]. 
Result: The Accounting Search screen displays. 

 
 

 

2. Select the [NSF List] tab from the menu bar. 
Result: The NSF List tab highlights and displays the payor search criteria. 

 
 

 

3. Enter/Select data for the appropriate search parameter fields. 
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4. Click the [Search] button. 
Result: The Maintain NSF List screen displays. 

 
 

 

 

 

Related Links 

Maintain NSF List Overview 

Accounting Search Screen 

Maintain NSF Screen 

 

My Court Information 

 

Add Payors to the NSF List 
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Introduction 

Adding a payor to the NSF List occurs when the bank returns a payor's check for reasons such as non-
sufficient funds, no account, stop payment, or a closed account. When a payor’s name is recorded on the 
NSF List, a Returned Check Notice must be issued.  

Refer to CODE OF CIVIL PROCEDURE SECTION 411.20. 

Task Activity 

This activity takes place in the context of a payor search. Refer to the Search NSF List task activity for 
details on this process. 

Perform the following steps to add a payor to the NSF list. 
 

1. Click the [Add Payor] button. 
 This selection occurs from the Maintain NSF List screen. 

 
 

 

2. Result: The Maintain NSF List screen refreshes with the Add Payor information. 
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2. Enter/Select data for the following required fields: 
o Payor Type 
o Payor Name 
o Address Type 
o Check # 
o Check Amount $ 
o Check Returned Date 
o Payment Transaction # 
o City/State 
o Postal Code 

 

3. Click the [Save] button. 
Result: The Maintain NSF List screen refreshes to show the added payor. 
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Related Links 

Maintain NSF List Overview 

Accounting Search Screen 

Maintain NSF Screen 

 

My Court Information 

 

Remove Payors from the NSF List 
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Introduction 

You can change the status of a payor on the NSF List at any time as long as you have the appropriate 
security role and have received the necessary approvals. 

A payor may submit a request to be removed from the NSF List. It is recommended that you review the 
validity of this request as well as the payor's information regarding specific NSF checks before processing 
the request. 

When you remove a "Warning" or "Reject" status from a payor’s name, a status of "Removed" appears on 
the NSF List next to the payor’s name. This indicates that payments by check may be accepted from a 
payor. 

Task Activity 

This activity takes place in the context of a NSF List search. Refer to the Search NSF List task activity for 
details on this process. 

Perform the following steps to remove a payor from the NSF list. 
 

1. Select the radio button of the payor to remove from the NSF List. 
 This selection occurs from the Maintain NSF List screen. 
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2. Click the [Remove Payor] button. 
Result: The Maintain NSF List - Remove Payor screen displays. 

 
 

 

3. Select the appropriate reason from the Reason drop-down list. 
4. Click the [Save] button. 

Result: The Maintain NSF List screen refreshes to show that the payor status has been updated 
to "Removed." 
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Related Links 

Maintain NSF List Overview 

Accounting Search Screen 

Maintain NSF Screen 

 

My Court Information 

 

Add Checks to the NSF List 
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Introduction 

When a check presented to the court is not honored by the bank, the payor’s name may be placed on the 
NSF List. This placement may be due to such events as insufficient funds, no account, stop payment, or a 
closed account. 

Once on the NSF List, additional information can be captured about a payor and returned checks. The 
Returned Check Notice is sent when adding a returned check to a new or existing payor name on the 
NSF List.  

Task Activity 

This activity takes place in the context of a NSF List search. Refer to the Search NSF List task activity for 
details on this process. 

Perform the following steps to add additional check information to a payor's name that is already on the 
NSF list. 
 

1. Select the radio button for the payor account on which to add a check. 
 This selection occurs from the Maintain NSF List screen. 

 
 

 

2. Click the [Details] button. 
Result: The Maintain NSF List screen refreshes with the payor details. 
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3. Click the [Add Check] button. 
Result: The Details section refreshes to allow new check data to be entered. 
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4. Enter/Select data for the following required fields: 
5. Check Returned Date/Check Number 
6. Check Amount/Payment Transaction # 

 

5. Click the [Save] button. 
Result: The Details section refreshes to show the added check. 
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Related Links 

Maintain NSF List Overview 

Maintain NSF Screen 

View NSF List Screen 
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Override NSF Screen 

 

Maintain Escheatment 

Maintain Escheatment Overview  

 

Introduction 

The court is required to report when money in a trust account has been abandoned or unclaimed. Before 
a trust account can be considered abandoned or unclaimed, three years of account inactivity must have 
elapsed, and the court must make a diligent effort to locate the trust depositor. After 30 months have 
elapsed, the system will mark the funds for escheatment. You must then mail a "Notice of Unclaimed 
Funds" to the intended recipient and report the funds marked for escheatment to a newspaper of general 
circulation. If the intended recipient has not successfully retrieved the funds marked for escheatment, 
then the court will mark the account for disbursement. The state may then claim the funds through a 
process called "escheatment."  

If the funds are successfully retrieved by the trust depositor, then the funds that are marked for 
escheatment may be disbursed without any delay. If the funds are not retrieved by the trust depositor and 
the court has exhausted all of the required process steps, the funds can be escheated.  

Task Activities 

Maintaining escheatment includes the following task activity: 

• Notice of Unclaimed Funds 
Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Accounting Search Screen 

 

My Court Information 

 

Notice of Unclaimed Funds 
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Introduction 

When a trust account has been inactive for 30 months, it is marked for escheatment. These trusts are 
then added to the Trusts to Escheat work queue for you to investigate further. Once this investigation 
period is completed, you can perform such steps as generating a Notice of Unclaimed Funds and/or 
publishing the unclaimed funds to a newspaper. 

A Notice of Unclaimed Funds informs the trust recipient that the trust in question will be escheated unless 
a claim is filed with the court on or before the scheduled escheatment date [Government Code 50050-
50056]. 

Task Activity 

This activity takes place in the context of a trust search. Refer to the Search Trusts task activity for details 
on this process. 

Perform the following steps to generate a Notice of Unclaimed Funds. 
 

1. Select the checkboxes for the trusts on which to generate the Notice of Unclaimed Funds. 
 This selection occurs from the Search Trust Results screen. 
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2. Click the [Gen. Notice of Unclaimed Funds] button. 
Result: The Notice of Unclaimed Funds displays. 
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 The system verifies whether the Notice of Unclaimed Funds has already been generated 
for the selected trust. If already generated, then the system will display an error message 
indicating that the notice has already been sent. 

3. Print and mail the Notice of Unclaimed Funds to a newspaper of general circulation for 
publication.  
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Related Links 

Maintain Escheatment Overview 

Accounting Search Screen 

 

Override Distribution 

Override Distribution Overview  

 

Introduction 

Overriding a distribution allows you to manually override the default fee distribution bucket for an 
individual payment. Fee distribution buckets are used for the allocation of monies paid to the court to be 
distributed to various agencies, funds, and programs.  

This activity should only when the fee schedule is incorrect. 

Distributions 

Manually overriding a distribution does not change the dollar amounts in the fee schedule, it only modifies 
the associated payment distribution. The Case History is updated with the new, manually overridden 
distribution information, including the transaction date, the reason for override, the clerk's name, and 
payment-related information.  

Task Activities 

Overriding a distribution includes the following task activity: 

• Override Distributions 
Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

Accounting Search Screen 

Override Distribution Screen 

 

My Court Information 
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Override Distribution 

 

Introduction 

You can override the distributions for an individual payment once the system saves the payment 
information and the initial distribution buckets have been calculated and saved. The distribution override 
does not update the configured amounts in the fee distribution schedule. It only changes the associated 
payment distribution transactions. 

Task Activity 

This activity takes place in the context of a payment search. Refer to the Search Payments task activity 
for details on this process. 

Perform the following steps to override a distribution. 
 

1. Select the radio button for the desired payment to override. 
 This selection occurs from the Search Payments Results screen. 
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2. Click the [Override Distribution] button. 
Result: The Override Distribution screen displays and highlights the Fee Details tab. 

 
 

 

3. Click the [Display Distribution] button. 
Result: The screen refreshes with the fee distribution amounts. 
4. To update a fee distribution bucket, select the appropriate radio button and re-configure the 

distribution dollar amount as appropriate. 
 When updating a fee distribution bucket, a reason for that procedure must be selected 

from the Reason drop-down list. 
5. Click the [Save] button. 

Result: The Override Distribution screen re-displays. 
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Related Links 

Override Distribution Overview 

Accounting Search Screen 

Override Distribution Screen 
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The Calendar Section 

Schedule/Reserve Calendar Events 

Schedule/Reserve Calendar Events Overview  

 

Introduction 

Scheduling/Reserving calendar events allows you to schedule and/or reserve events on a court's 
calendar based on pre-configured resource allocation rules, resource unavailability information, and 
scheduling rules.  

In order to schedule/reserve events on the calendar, resource allocation rules and unavailability 
information must be pre-configured in the system.  Refer to the Configure Resource Allocation Rules and 
Configure Resource Unavailability Information sections for details on configuring a resource's scheduling 
preferences.  

Scheduling rules are pre-configured in the system. Refer to the Configure Scheduling Rules section for 
details on configuring scheduling rules.  

The Judicial Officer recusal information has been entered into the system. Refer to the Manage Judicial 
Officers section for more information on Judicial Officer functionality.  

This functionality also describes the process of scheduling one event for one case, and batch scheduling 
of multiple events for a single case, or a single event type on multiple cases.  

Scheduled calendar events can be rescheduled/reassigned along with other updates to the event. Refer 
to the Maintain Calendar Events section for details on updating calendar events.  

System Conflict Checks 

When scheduling/reserving an event, you can enter a specific date/time for the calendar event, or request 
the system to suggest a date/time combinations based on the pre-configured scheduling rules, resource 
allocation rules, and resource unavailability information. 

The system performs conflict checks during the process of validating the event date/time and alerts you to 
existing conflicts.  

The following conflict checks are performed for the following scheduling/reserving event options:  
 

 

 

Scheduling Options Conflict Checks  

1 case, 1 event 1. Judicial Officer recusal check   
2. Check resource allocation rules 
3. Check resource unavailability information 
4. Check scheduling rules   

1 case, multiple events 1. Judicial Officer recusal check   
2. Check resource allocation rules 
3. Check resource unavailability information 
4. Check scheduling rules   
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Multiple cases, 1 event  1. Judicial Officer recusal check    
2. Check resource allocation rules  
3. Check resource unavailability information 

 

If multiple scheduling rules apply to the scheduling of an event, the most specific and granular rule will be 
used. For example, rules specific to an event will override rules specific to that calendar type only, which 
will override rules defined at the level of the case category or case type.  

Conflict Messages 

If the specified date/time does not have conflicts with pre-set business rules and is acceptable, the 
system will not suggest three possible date/time combinations for the event. 

If you do not specify a date/time for the event, then the system will suggest up to three possible date/time 
combinations for the event.  

If there is a conflict with the requested date/time combination or if no date was entered, then the system 
will suggest up to three possible date/time combinations that the event can be scheduled on based on 
pre-configured business rules.  

These three date/time combinations are the first available date/times on or after the requested date or the 
current date if no date was entered, that satisfy the scheduling rules, resource allocation rules and 
resource unavailability information.  

If the suggested date/time combinations are not acceptable, you can enter a new date/time in order for 
the system to return three new date/time combinations.  

Override Option 

You can bypass the scheduling conflict checks by using the "override" option. The only scheduling item 
that cannot be overridden is a Judicial Officer recusal conflict.  

Task Activities 

Schedule/Reserve Calendar Events includes the following task activities: 

• Calendar Day/Month View 
• Schedule/Reserve an Event 
• Schedule Events - One Event on Multiple Cases 
• Schedule Events - Multiple Events on One Case 
• Error Process - Schedule/Reserve an Event 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Schedule/Reserve Calendar Event Screen 
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Calendar Month View Screen 

Calendar Day View Screen 

Calendar Events Listing Screen 

 

My Court Information 

 

Calendar Day/Month View  

 

Introduction 

Checking the calendar day/month views allows you to see a specific resource's calendar. You can 
navigate to schedule an event by clicking the [Schedule an Event] hyperlink.  

Task Activity 

Perform the following steps to view the day/month calendar for a specific resource.  
 

1. Select [Calendar] > [Calendar Day View]. 
Result: The Day View screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 
3. Resource Type 
4. View by JO/Mediator/Temp. Judge 



Printed Documentation 

830 

 The calendar can also be filtered by the "View by Department" option by entering data for 
the Location and Department fields. The Division and Department fields are filtered depending 
on your selection of the Location field. The Division field is optional.  

3. Click the [View] hyperlink.  
Result: The Day View screen displays. 

 
 

 

4. Click the [Month View] hyperlink.   
Result: The Month View screen displays. 



The Calendar Section 

831 

 
 

 

5. Click the [Day View] hyperlink.  
Result: The Day View screen displays. 
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6. Click the [Time Details] hyperlink. 
Result: The Events Listing screen displays. 
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Related Links 

Schedule/Reserve Calendar Events Overview 

Calendar Day View Screen 

Calendar Month View Screen 

Calendar Events Listing Screen 

 

My Court Information 

 

Schedule/Reserve an Event  

 

Introduction 

Scheduling/Reserving an event sets an event on a court's calendar based on pre-configured business 
rules.  

Task Activity 

Perform the following steps to schedule/reserve one event on a single case.  
 

1. Select [Calendar] > [Schedule/Reserve Calendar Event]. 
Result: The Schedule/Reserve Calendar Event screen displays. 
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2. Enter a Case Number or Legacy Number.  
3. Click the [Add] button.  
4. Enter/Select data for the following required fields: 

5. Scheduling Options 
6. Calendar Type 
7. Event Type 
8. Resource Type 
9. Department 

 The Case Number or Legacy Number is required if the Scheduling Option is "Schedule."  

 The event can also be scheduled to a department by entering data for the Location and 
Department fields. The Division and Department fields are filtered depending on your selection 
of the Location field. The Division field is optional.  

 If the Resource Type field is selected, the Name field is filtered and required.  

 If the Night Court checkbox if selected, the Event Time field is disabled and the system 
will assume to check the rules after 5:00 pm.  

5. Click the [Schedule/Reserve] button. 
Result: The Schedule/Reserve Calendar Event - Confirmation screen displays. 
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 If the Override Conflict Check? checkbox is selected, then the system will overlook the 
scheduling related rules except the recusal conflict and schedule/reserve the event on the 
calendar.  

 

 

Related Links 

Schedule/Reserve Calendar Events Overview 

Schedule/Reserve Calendar Event Screen 

 

My Court Information 

 

Schedule/Reserve Events - One Event Type on Multiple Cases 

 

Introduction 

Scheduling/Reserving events in batch is the process of scheduling one event type for multiple cases. This 
gives you the flexibility of scheduling one event on multiple cases at the same time.  

Task Activity 

Perform the following steps to schedule/reserve an event on multiple cases.  
 

1. Select [Calendar] > [Schedule/Reserve Calendar Event]. 
Result: The Schedule/Reserve Calendar Event screen displays. 
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2. Enter a Case Number or Legacy Number.  
3. Click the [Add] button.  

 Repeat Steps 2-3 to add as many cases as needed.  
4. Enter/Select data for the following required fields: 

5. Scheduling Options 
6. Calendar Type 
7. Event Type 
8. Resource Type 
9. Department 

 The Case Number or Legacy Number is required if the Scheduling Option is "Schedule."  

 The event can also be scheduled to a department by entering data for the Location and 
Department fields. The Division and Department fields are filtered depending on your selection 
of the Location field. The Division field is optional.  

 If the Resource Type field is selected, then the Name field is filtered and required.  

 If the Night Court checkbox if selected, then the Event Time field is disabled and the 
system will assume to check the rules after 5:00 pm.   
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5. Click the [Schedule/Reserve] button. 
Result: The Schedule/Reserve Calendar Event - Confirmation screen displays. 

 
 

 

 When scheduling in batch, multiple events cannot be scheduled for multiple cases at the 
same time. 

 

 

Related Links 

Schedule/Reserve Calendar Events Overview 

Schedule/Reserve Calendar Event Screen 

 

My Court Information 

 

Schedule/Reserve Events - Multiple Events on One Case 

 

Introduction 

Scheduling/Reserving events in batch is the process of scheduling multiple events for one case. It gives 
the flexibility of scheduling multiple types of events on one case simultaneously.  

Task Activity 

Perform the following steps to schedule/reserve multiple events on a single case.   
 

1. Select [Calendar] > [Schedule/Reserve Calendar Event]. 
Result: The Schedule/Reserve Calendar Event screen displays. 
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2. Enter a Case Number or Legacy Number.   
3. Click the [Add] button.  
4. Enter/Select data for the following required fields: 

5. Scheduling Options 
6. Calendar Type 
7. Event Type (select more than one) 
8. Resource Type 
9. Department 

 The Case Number or Legacy Number is required if the Scheduling Option is "Schedule."  

 The event can also be scheduled to a department by entering data for the Location and 
Department fields. The Division and Department fields are filtered depending on your selection 
of the Location field. The Division field is optional.  

 If the Resource Type field is selected, then the Name field is filtered and required.  

 If the Night Court checkbox if selected, then the Event Time field is disabled and the 
system will assume to check the rules after 5:00 pm.   

5. Click the [Schedule/Reserve] button. 
Result: The Schedule/Reserve Calendar Event - Confirmation screen displays. 
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Related Links 

Schedule/Reserve Calendar Events Overview 

Schedule/Reserve Calendar Event Screen 

 

My Court Information 

 

Error Process - Schedule/Reserve an Event 

 

Introduction 

This activity outlines the process of resolving possible errors that can occur at the time of 
scheduling/reserving an event.  

Task Activity 

This activity takes place within the context of scheduling/reserving an event. Refer to the 
Schedule/Reserve an Event task activity for details on this process.  

Perform the following steps to resolve the error message.  
 

1. View the possible error message on the Schedule/Reserve Calendar Event screen. 
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2. Perform one of the following steps: 
3. Select the radio button for one of the suggested dates, OR 
4. Select the radio button for "Use Date Below." 

 

3. If "Use Date Below" has been selected, enter data for the following fields:  
4. Event Date 
5. Event Time 

 

4. Click the [Schedule/Reserve] button. 
 Depending on conflict checks done by the system and the information you entered, there 

are two possible outcomes.  
Result #1: If you enter data that has a conflict, then the Schedule/Reserve Calendar Event screen 
refreshes with an error message and the process steps above should be repeated.  
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5. Result #2: If you enter data that has no conflicts, then the Schedule/Reserve Calendar Event - 
Confirmation screen displays.  
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Related Links 

Schedule/Reserve Calendar Events Overview 

Schedule/Reserve Calendar Event Screen 

 

Maintain Calendar Events 

Maintain Calendar Events Overview  

 

Introduction 

Maintaining calendar events allows you to reschedule, reassign, extend, flag for no further continuance, 
confirm a reserved event, restore, vacate, and delete existing calendar events.   

In order to maintain calendar events, scheduled events must exist in the system. Refer to the 
Schedule/Reserve Calendar Events section for details on scheduling/reserving events on the calendar.  

Confirm Event 

Confirming a calendar event allows you to change the status of the event from reserved to scheduled.  

Reschedule Event 

Rescheduling a calendar event moves a calendar event from the original date/time to a new date/time.  

Reassign Event 

Reassigning a calendar event allows you to change the court resource assignment associated with an 
event. Refer to the Manage Resource Assignments section for details on reassigning a court resource 
from the case itself. If the Judicial Officer is reassigned, then the system will check for recusal conflicts 
that the Judicial Officer may have with the cases on the events that are being reassigned. 

Extend Event 

Extending an existing event results in a new date/time being set for the next session. This is not 
considered a new event in the system (such as trial). Extending an event is different from rescheduling an 
event in that rescheduling results in a new event being created, while extending results in the same event 
being extended to another date/time. 

Flag Event for No Further Continuance 

No further continuance allows you to flag events so that they cannot be rescheduled again. 

Restore Event 

Restoration of calendar events allows you to change the status of previously "vacated" events to 
"scheduled" again. 
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Vacate Event 

Vacating calendar events allows you to remove previously "scheduled" events off the calendar.  

Delete Event 

Events may also be deleted from the calendar if they were scheduled in error or were reserved but never 
scheduled.  

System Conflict Checks 

When rescheduling/reassigning an event, you can enter a specific date/time for the calendar event. You 
can also request the system to determine three possible date/time combinations based on the pre-
configured scheduling rules, resource allocation rules, and resource unavailability information. 

The system performs conflict checks when it validates the event date/time and it will alert you of an 
existing conflict.  

The following conflict checks are performed for the following rescheduling/reassigning event options: 
 

 

 

Rescheduling/Reassigning Options Conflict Checks  

1 case, 1 event 1. Recusal Check   
2. Check resource allocation rules 
3. Check resource unavailability information 
4. Scheduling rules 

1 case, multiple events 1. Recusal Check   
2. Check resource allocation rules 
3. Check resource unavailability information 
4. Scheduling rules 

Multiple cases, 1 event  1. Recusal Check   
2. Check resource allocation rules  
3. Check resource unavailability information 

 

You can bypass these conflicts by using the "override" option. Refer to the Schedule/Reserve Calendar 
Events section for details on handling conflict messages and using override options.  

Task Activities 

Maintaining calendar events includes the following task activities: 

• Search Calendar Events 
• Search Calendar Events - Context of a Case 
• Reschedule/Reassign an Event 
• Reschedule/Reassign Events - One Event Type on Multiple Cases 
• Reschedule/Reassign Events - Multiple Events on One Case 
• Confirm an Event 
• Flag an Event - No Further Continuance 
• Extend an Event 
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• Restore an Event 
• Vacate an Event 
• Delete an Event 
• Error Process - Reschedule/Reassign Events 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Maintain Calendar Events - Search Screen 

Maintain Case Calendar Events Screen 

Reschedule/Reassign Calendar Event Screen 

 

My Court Information 

 

Search Calendar Events 

 

Introduction 

This activity allows you to search for scheduled events in the system.  

Task Activity 

Perform the following steps to search for a scheduled event.  
 

1. Select [Calendar] > [Maintain Calendar Events]. 
Result: The Maintain Calendar Events Search screen displays. 
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2. Select a Resource Type. 
3. Enter/Select data for the appropriate search parameter fields. 
4. Click [Search] button. 

Result: The Maintain Calendar Events Search screen refreshes with the Search Results.  
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Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

 

My Court Information 

 

Search Calendar Events - Context of a Case 

 

Introduction 

This activity allows you to search for scheduled events that belong to a specific case.  

Task Activity 

This activity takes place within a context of a case. Refer to the Search Cases activity for details on this 
process.  

Perform the following steps to search for a scheduled event.  
 

1. Select the [Case Calendar Events] left navigation item.  
Result: The Maintain Case Calendar Events screen displays. 
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 The search results can be filtered by Event Begin Date and Event End Date field 
combination or Filter Criteria field.   

 

 

Related Links 

Maintain Calendar Events Overview 

Maintain Case Calendar Events Screen 

 

My Court Information 

 

Reschedule/Reassign an Event 

 

Introduction 

Rescheduling an event allows you to move a calendar event from one date/time to a new date/time. 
Reassigning an event changes the court resource associated with the event.  
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Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events 
and Search Calendar Events - Context of a Case task activities for details on this process.  

Perform the following steps to reschedule/reassign an event to new time and different court resource.  
 

1. Select the checkbox for an event from the maintain calendar events search results.  

 
 

 

2. Click the [Reschedule/Reassign] button.  
Result: The Reschedule/Reassign Calendar Event screen displays with appropriate information. 
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3. Enter/Select data for the following required fields: 

• Resource Type 
• Event Date 
• Event Time 
• Department 

 You cannot change the Calendar Type field. 

 If Resource Type field is selected, then the Name field is filtered and required.  

 The event can also be re-scheduled to a department by entering data for the Location 
and Department fields. The Division and Department fields are filtered depending on your 
selections of the Location field. The Division field is optional.  

3. Click the [Reschedule/Reassign] button. 
Result: The Reschedule/Reassign Calendar Event - Confirmation screen displays. 
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 You can choose to only reschedule the event by only updating the Event Date and Event 
Time fields.  

 You can choose to only reassign the event by updating Resource Type and Name fields 
combination or Location, Division, and Department fields combination. 

 

 

Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

Reschedule/Reassign Calendar Event Screen 

 

My Court Information 

 

Reschedule/Reassign Event - One Event Type on Multiple Cases 

 

Introduction 

Rescheduling/Reassigning in batch is the process of updating multiple events at the same time. 

Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events 
and Search Calendar Events - Context of a Case task activities for details on this process.  
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Perform the following steps to reschedule/reassign one event on multiple cases.  
 

1. Select the checkboxes for one event type related to multiple cases. 
 This selection occurs from the Maintain calendar events search results. 

 
 

 

2. Click the [Reschedule/Reassign] button.  
Result: The Reschedule/Reassign Calendar Event screen displays with appropriate information. 
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3. Enter/Select data for the following required fields: 
4. Resource Type 
5. Event Date 
6. Event Time 
7. Department 

 You cannot change the Calendar Type field. 

 The Name field is filtered and required if a Resource Type value is selected.  

 The event can also be re-scheduled to a department by entering data for the Location 
and Department fields. The Division and Department fields are filtered depending on your 
selections of the Location field. The Division field is optional. 

4. Click the [Reschedule/Reassign] button. 
Result: The Reschedule/Reassign Calendar Event - Confirmation screen displays. 
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 You can choose to only reschedule the event by only updating the Event Date and Event 
Time fields.  

 You can choose to only reassign the event by only updating Resource Type and Name 
fields combination or Location, Division, and Department fields combination.    

 

 

Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

Reschedule/Reassign Calendar Event Screen 

 

My Court Information 

 

Reschedule/Reassign Events - Multiple Events on One Case 

 

Introduction 

Rescheduling/Reassigning multiple events allows you to update multiple events on one case at the same 
time. 

Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events 
and Search Calendar Events - Context of a Case task activities for details on this process.  
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Perform the following steps to reschedule/reassign multiple events on a single case.  
 

1. Select the checkboxes for more than one event type related to the same case. 
 This selection occurs from the Maintain calendar events search results. 

 
 

 

2. Click the [Reschedule/Reassign] button.  
Result: The Reschedule/Reassign Calendar Event screen displays with appropriate information. 
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3. Enter/Select data for the following required fields: 
4. Resource Type 
5. Event Date 
6. Event Time 
7. Department 

 You cannot change the Calendar Type field. 

 The Name field is filtered and required if a Resource Type value is selected.  

 The event can also be re-scheduled to a department by entering data for the Location 
and Department fields. The Division and Department fields are filtered depending on your 
selections of the Location field. The Division field is optional.  

4. Click the [Reschedule/Reassign] button. 
Result: The Reschedule/Reassign Calendar Event - Confirmation screen displays. 
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 You can choose to only reschedule the event by only updating the Event Date and Event 
Time fields.  

 You can choose to only reassign the event by only updating Resource Type and Name 
fields combination or Location, Division, and Department fields combination.  

 

 

Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

Reschedule/Reassign Calendar Event Screen 

 

My Court Information 

 

Confirm an Event 

 

Introduction 

Confirming an event allows you to change the status of an event from "Reserved" to "Scheduled."  

Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events - 
Context of a Case task activity for details on this process.  
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Perform the following steps to confirm a reserved event.  
 

1. Select the checkbox for an event from the Maintain Case Calendar Events screen. 
 The selected event must have a status of "Reserved." 

 
 

 

2. Click the [Confirm Event] button. 
Result: The Maintain Case Calendar Events Confirmation screen displays with confirmation 
message. 

 The event status is updated to "Scheduled."  
 Events that have been previously reserved without a Case Number can be confirmed 

through the Schedule/Reserve Calendar Event screen. 
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Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

Maintain Case Calendar Events Screen 

 

My Court Information 

 

Flag an Event -- No Further Continuance  
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Introduction 

You can flag an event with "No Further Continuance" so that it cannot be rescheduled. Flagged events 
can only be rescheduled through the override option.   

Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events 
and Search Calendar Events - Context of a Case task activities for details on this process.  

Perform the following steps to flag an event for no further continuance.  
 

1. Select the checkbox for an event from the maintain calendar events search results. 

 
 

 

2. Click the [No Further Continuance] button. 
Result: The No Further Continuance pop-up screen displays. 
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3. Enter/Select data for the following required fields: 
4. Date Ordered 
5. No Further Continuance 

 

4. Click the [Save] button.  
Result: The Maintain Calendar Events Search screen displays with a confirmation message. The 
selected event's NFC column indicator is displayed.  
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Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

 

My Court Information 

 

Extend an Event 
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Introduction 

Extending an event allows you to continue an event that extends over multiple days. This process is 
different from rescheduling an event since it results in the same event being extended to another 
date/time for the next session of that same event.  

Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events - 
Context of a Case task activity for details on this process.  

Perform the following steps to extend an event.  
 

1. Select the checkbox for an event from the Maintain Case Calendar Events screen. 
 The selected event must have a status of "Heard." 

 
 

 

2. Click the [Extend] button.  
Result: The Reschedule/Reassign Calendar Event screen displays with appropriate information. 



The Calendar Section 

863 

 
 

 

3. Enter/Select data for the following required fields: 
4. Event Date 
5. Event Time 

 You cannot change the Calendar Type field.  

4. Click the [Reschedule/Reassign] button. 
Result: The Reschedule/Reassign Calendar Event - Confirmation screen displays. 
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Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

Reschedule/Reassign Calendar Event Screen 

 

My Court Information 

 

Restore an Event  

 

Introduction 

Restoring an event allows you to change the status of previously "Vacated" event to "Scheduled."  

Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events 
and Search Calendar Events - Context of a Case task activities for details on this process.  

Perform the following steps to restore an event.  
 

1. Select the checkbox for an event from the Maintain calendar events search results. 
The selected event must have a status of "Vacated." 
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2. Click the [Restore] button. 
Result: The Maintain Calendar Events - Search screen displays with a confirmation message. 

 The event status is updated to "Scheduled."  
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Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

 

My Court Information 

 

Vacate an Event 

 

Introduction 

Vacating a calendar event allows you to remove an event from the calendar. Vacated events can be 
restored back to the calendar.  
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Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events 
and Search Calendar Events - Context of a Case task activities for details on this process.  

Perform the following steps to vacate an event.  
 

1. Select the checkbox for an event from the Maintain calendar events search results. 
 The selected event must have a status of "Scheduled." 

 
 

 

2. Click the [Vacate] button. 
Result: The Maintain Calendar Events - Search screen displays with a confirmation message. 

 The event status is updated to "Vacated."  
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Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 

 

My Court Information 

 

Delete an Event 

 

Introduction 

Deleting an event allows you to remove an event record from the system.  

You can delete events from the calendar if the events were scheduled in error or were reserved but never 
confirmed. Events deleted from the system cannot be restored back to the calendar. 
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Task Activity 

This activity takes place in the context of calendar events search. Refer to the Search Calendar Events - 
Context of a Case task activity for details on this process.  

Perform the following steps to delete an event.  
 

1. Select the checkbox for an event from the Maintain Case Calendar Events screen.  
 The selected event must have a future event date. 

 
 

 

2. Click the [Delete] button. 
Result: The Maintain Case Calendar Events Confirmation screen displays. 

 The event is no longer displayed in the search results.  
 

 

Related Links 

Maintain Calendar Events Overview 

Maintain Calendar Events - Search Screen 
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My Court Information 

 

Error Process - Reschedule/Reassign Events  

 

Introduction 

This activity outlines the process of resolving possible errors that can occur at the time of rescheduling or 
reassigning an event.  

Task Activity 

This activity takes place within the context of rescheduling/reassigning an event. Refer to the 
Reschedule/Reassign an Event task activity for more details on this process.  

Perform the following steps to resolve the error message.  
 

1. View the possible error message on the Reschedule/Reassign Calendar Event screen.  
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2. Perform one of the following steps: 
3. Select the radio button for one of the suggested dates, OR 
4. Select the radio button for "Use Date Below." 

 

3. If "Use Date Below" has been selected, enter data for the following fields:  
4. Event Date 
5. Event Time 

 

4. Click the [Reschedule/Reassign] button. 
 Depending on conflict checks performed by the system and the information you entered, 

there are two possible outcomes.  
Result #1: If you enter data that has a conflict, then the Reschedule/Reassign Calendar Event 
screen refreshes with an error message and the process steps above should be repeated. 
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5. Result #2: If you entered data that has no conflicts, then the Reschedule/Reassign Calendar 
Event - Confirmation screen displays.  

 
 

 

 

 

Related Links 

Maintain Calendar Events Overview 

Reschedule/Reassign Calendar Event Screen 

 

Finalize Calendars 

Finalize Calendar Overview  

 

Introduction 

Finalizing a calendar assigns a sequential calendar number to each calendar event. The calendar to 
finalize can be selected from specified range elements including Calendar View, Calendar Type, Date 
Range, Time Range, or Department(s).  

The calendar numbers become the permanent ID number by which the event is referred to and will be 
displayed on the calendar when it is viewed/printed.  

The same calendar number is displayed with the event for every future displaying/printing of the finalized 
calendar. Calendars that are finalized will not have the calendar numbers re-sequenced by the system for 
future displaying/printing. Refer to the Display/Print Calendar section for details on this process.  

Once a calendar has been finalized, additional events scheduled to the calendar are considered "Add-
ons." An “add-on” calendar will display/print the events added to the calendar after the calendar has been 
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finalized. Refer to the Schedule/Reserve Calendar Events section for details on scheduling/reserving 
events.  

Task Activities 

Finalizing calendars includes the following task activity: 

• Finalize Calendar 
Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Finalize Calendar Details Screen 

 

My Court Information 

 

Finalize Calendar 

 

Introduction 

The process of finalizing the calendar assigns sequential calendar number to each scheduled event on 
the specified calendar.  

Task Activity 

Perform the following steps to finalize a calendar.  
 

1. Select [Calendar] > [Finalize Calendar]. 
Result: The Finalize Calendar screen displays. 
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2. Enter/Select data for the following required fields: 

• Location 
• Department 
• Calendar Date 
• Start Calendar Number From 

 

3. Click the [Finalize] button. 
 Events that have been assigned calendar numbers through the finalize process are not re-

sequenced during calendar reprints. 
4. Result: The Finalize Calendar Confirmation screen displays. 

 
 

 

 

 

Related Links 

Finalize Calendar Overview 

Finalize Calendar Details Screen 
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Display/Print Calendars 

Display/Print Calendar Overview 

 

Introduction 

Displaying or printing a calendar allows you to view and print informal drafts, finalized, or add-on 
calendars. You can specify the calendar to view and print for a Judicial Officer and/or Department by 
selecting a pre-configured calendar view, a specific date/date range, and a time range.  

For specific calendar views to be viewed/printed, pre-configured calendar views must first exist in the 
system. Refer to the Configure Calendar Views section for details on configuring calendars.  

The "final" calendar will display/print events with sequential calendar numbers. Refer to the Finalize 
Calendar section for details on finalizing calendar events.  

The “add-on” calendar will display/print the events added to the calendar after the calendar has been 
finalized. Refer to the Schedule/Reserve Calendar Events section for details on scheduling/reserving 
events.  

Task Activities 

Displaying/Printing calendars includes the following task activities: 

• Display Calendar 
• Print Calendar 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Display/Print Calendar - Details Screen 

 

My Court Information 

 

Display Calendar 

 

Introduction 

Displaying the calendar allows you to view and print the scheduled events for a specified calendar. You 
can choose to view the "finalized," "add-on," or entire calendar.  
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Task Activity 

Perform the following steps to display a calendar.  
 

1. Select [Calendar] > [Display/Print Calendar]. 
Result: The Display/Print Calendar screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Location  
• Calendar Date Range - From 
• Calendar Template 
• Calendar Time Range or Calendar Type  
• Filter Criteria  

 The Filter Criteria field is defaulted to "All."  

3. Click the [Print Preview] button. 
 You can only view one calendar at a time.  

Result: The Display/Print Calendar screen displays in a new window.  



The Calendar Section 

877 

 
 

 

 The system will re-sequence the Calendar No. field for calendars that have not been 
finalized every time the calendar is run.  

 

 

Related Links 

Display/Print Calendar Overview 

Display/Print Calendar - Details Screen 

 

My Court Information 

 

Print Calendar 

 

Introduction 

Printing a calendar allows you to print the scheduled events for a specified calendar. You can print the 
"finalized," "add-on," or entire calendar.  

Task Activity 

Perform the following steps to print a physical calendar. 
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1. Select [Calendar] > [Display/Print Calendar]. 
Result: The Display/Print Calendar screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 
3. Location 
4. Calendar Date Range - From 
5. Calendar Template 
6. Calendar Time Range or Calendar Type  
7. Filter Criteria 

 The Filter Criteria field is defaulted to "All."  

3. Click the [Print] button. 
 You may have to specify the printer at this time. 

 If calendars are being printed for multiple departments or the location/division, then the 
Calendar Template field value must be set to "Summary." 

Result: The Printer Dialog box displays and calendar is printed. 

 

 

Related Links 

Display/Print Calendar Overview 

Display/Print Calendar - Details Screen 
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The Courtroom Section 

Maintain Check-In Information 

Maintain Check-In Information Overview 

 

Introduction 

Maintaining check-in information allows you to capture and update details of a scheduled event, including 
the attendance information for the case parties. In order for the check-in information to be recorded, the 
events must be scheduled and exist in the system.  

The check-in functionality provides the ability to capture/update information about an event prior to its 
scheduled hearing. For courts that do not have a check-in process, the system will provide the ability to 
capture attendance information at the time of recording minutes.  

This attendance information will also be available to you during the Record Minutes activity, in which the 
previously recorded check-in information will be displayed. At the time of recording minutes, you can 
override the displayed attendance information or capture the attendance information of the participants 
that are actually present during the event. This will then be printed on the minutes. Refer to the Record 
Minutes - Code Based section for details on recording minutes.  

Task Activities 

Maintaining check-in information includes the following task activities:  

• Add Check-In Information 
• Edit Check-In Information  

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Courtroom - Check-In Screen 

 

My Court Information 
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Add Check-In Information 

 

Introduction 

Adding the check-in information records the attendance information and other details of a scheduled 
event.  

Printing Forms/Notices 

You can print forms and notices during the check-in process by selecting a form and clicking the [Print 
Form] button. 

Task Activity 

This activity takes place in the context of a minutes search. Refer to the Search Minutes task activity for 
details on this process.  

Perform the following steps to add check-in information. 
 

1. Select the checkbox for an event to add information. 
 This selection occurs from the create/maintain minutes search results. 
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2. Click the [Check-in] button. 
 Depending on the Case Category of the event for which the check-in information is being 

recorded, different data fields will be displayed.  
Result #1: The Check-In - Civil/Probate screen displays. 

 
 

 

3. Result #2: The Check-In - Small Claims screen displays.  
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3. Enter/Select the attendance and other details of the scheduled event. 
 If a party has multiple events scheduled for the same date/time/department on multiple 

cases, then the system will consider the party checked-in for the events (for the same 
date/time/department) if you select the [All Events] checkbox related to the party. 

 If a case has multiple events scheduled for the same date and time and department, then 
the participants will be considered checked-in for the events on the case (for the same 
date/time/department) even if you only choose one event for which to record check-in 
information. 

4. Click the [Save] button.  
 The appropriate check-in screen displays with a confirmation message.  

Result #1: The Check-In - Civil/Probate screen displays. 

 
 

 

5. Result #2: The Check-In - Small Claims screen displays.  
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Related Links 

Maintain Check-In Information Overview 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Courtroom - Check-In Screen 

 

My Court Information 

 

Edit Check-In Information 

 

Introduction 

Editing the check-in information updates the attendance information and other details of a scheduled 
event.  
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Task Activity 

This activity takes place in the context of a minutes search. Refer to the Search Minutes task activity for 
details on this process.  

Perform the following steps to edit check-in information.  
 

1. Select the checkbox for an event to edit. 
 This selection occurs from the create/maintain minutes search results.  

 

2. Click the [Check-in] button. 
 Depending on the Case Category of the event for which the check-in information is being 

recorded, different data fields will be displayed.  
Result #1: The Check-in - Civil/Probate screen displays. 
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3. Result #2: The Check-in - Small Claims screen displays. 

 

3. Enter/Update the available fields as needed. 
 If a party has multiple events scheduled for the same date/time/department on multiple 

cases, then the system will consider the party checked-in for the events (for the same 
date/time/department) if you select the [All Events] checkbox related to the party. 

 If a case has multiple events scheduled for the same date and time and department, then 
the participants will be considered checked-in for the events on the case (for the same 
date/time/department) even if you only choose one event for which to record check-in 
information. 
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4. Click the [Save] button.  
 The appropriate check-in screen displays with a confirmation message. Forms and notices 

can be printed during the check-in process by selecting a form and clicking the [Print Form] 
button. 
Result #1: The Check-in - Civil/Probate screen displays. 

 

5. Result #2: The Check-in - Small Claims screen displays. 
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Related Links 

Maintain Check-In Information Overview 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Courtroom - Check-In Screen 

 

Record Minutes - Code Based 

Record Minutes - Code Based Overview  

 

Introduction 

The Record Minutes - Code Based allows you to record or update minutes for scheduled events. You can 
record minutes through the use of Minutes codes (text/action). However, in order to record minutes, 
scheduled events must exist in the system. Refer to the Schedule/Reserve Calendar Events section for 
details on event scheduling.  

The Minutes codes and macros to be used in recording minutes must be pre-configured. Refer to the 
Configure Codes and Configure Minute Macros sections for details on these processes.  

In addition, the header/footer information to be printed on the minutes form as well as the staff to 
department assignment has been pre-configured. Refer to the Configure Minutes Header/Footer and 
Configure Department Resources sections for details on configuring these items.  

If the minutes are sent for Judicial Officer review or sent for Judicial Officer electronic signature, the 
Judicial Officer may review the minutes. Refer to the Judicial Notes section for details on understanding 
Judicial Officer functionality.  

The finalized minutes can also be amended. Refer to the View/Amend Minutes section for details on 
amending the finalized minutes. The minutes can be recorded as pre-work for an event prior to the event. 
However, you cannot finalize the minutes until the event has taken place.  

Use of Minute Codes in Minutes 

Recording minutes is done through the use of codes in the system. Codes can either be text-based or 
action-based. Each code has associated text that will be translated into the minutes.  

Text codes translate into pre-configured text and do not require the system to take an action. Action 
codes require the system to perform an action(s) such as scheduling an event or updating a party status. 
When using action codes, the system may require values to be specified for the input parameters in order 
for the system to perform the action(s) associated to the code.  

Minute codes can also include text boxes that you can specify. The system will not perform an action 
based on these text boxes.   
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Code Execution Process 

When minutes are "finalized," the system will validate the minute entry codes and input parameter 
combinations. If the minute codes execute successfully, then you will have the ability to generate 
additional forms (if required).  

While executing the codes in batch, the system will not prompt you to correct errors. If the system finds an 
error while executing the minute codes for an event, it will flag the minutes associated with the event as 
being in error and move on to the next event/case, if processing multiple minutes simultaneously.  Once 
the system has executed the codes for the events/cases, a confirmation message will be displayed with 
the status of the minutes associated with each case. 

If the minutes were not finalized due to an error, you will have the ability to select and correct the event 
that was in error. The system will return you to the appropriate screen and display the minutes only for 
that particular event, including an error message that indicates what code produced the error. After 
correcting the error, you may request the system to "finalize" the minutes.  

If minutes were created for multiple events, then the confirmation message will be displayed for the 
multiple events that were successfully finalized.  

Finalize Only/Finalize Minutes  

Finalize Minutes:  If you have completed the minutes and want the system to create minutes, then you 
can request that the system finalize and create the minutes. If this action is requested, then the system 
will execute the codes, finalize the minutes, create a Case History/ROA entry, create a PDF document 
and link the minutes to the Case History/ROA entry.  

Finalize Only:  If this action is requested, then the system will finalize the minutes, create a Case 
History/ROA entry, and create a PDF document. However, it will not link the minutes to the Case 
History/ROA entry. This provides you with the ability to associate an image of the minutes to the Case 
History/ROA entry including attachments using the court's Imaging/Document Management System 
(external to the system).  

Judicial Officer Review/Judicial Officer Signature 

Send for Judicial Review: If the minutes are saved with the status of "Send for Judicial Officer Review," 
then the system will not execute the codes associated with the minutes. It will instead update the status of 
the minutes to allow for them to appear in a Judicial Officer work queue. This provides the Judicial Officer 
with the ability to review the text translation of the minutes and approve or provide feedback on them. 
Minutes are sent to the Judicial Officer that was specified as the hearing officer related to the minutes.  

The Judicial Officer will then send the minutes back to the Courtroom Clerk. If the Judicial Officer 
approves the minutes, then the Clerk will "finalize" the minutes. However, if the Judicial Officer has 
additional feedback on the minutes, then the Clerk will incorporate the feedback and either send them 
back for Judicial review or finalize the minutes (based on the business process of the court). Additionally, 
if the Judicial Officer authorizes the use of electronic signature for the minutes, the "finalized" minutes will 
also include the electronic signature.  

Send for J.O. electronic signature:  If the minutes are saved with the status of "Send for Judicial Officer 
Electronic Signature," then the  system will execute the codes associated with the minutes and update the 
status of the minutes to allow for the minutes to appear in the Judicial Officer work queue. This allows the 
Judicial Officer to attach an electronic signature. Refer to the Judicial Notes section for details on 
understanding Judicial Officer functionality. 

Status of Minutes 

Minutes can be saved with the following statuses in the system:  
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STATUS RESULTING ACTIONS 

Save as Draft 1. Minutes information saved. 

Finalize Minutes 1. Minutes information saved. 
2. System executes the actions associated to the minute codes 
(for code based minutes) 
3. Writes Case History/ROA entry associated with each minute 
code (if applicable). 
4. Finalizes the minutes in PDF format. 
5. Writes the Case History/ROA entry for the creation of the 
minutes. 
6. Creates a link between the minutes (PDF format) and the 
Case History/ROA entry. 
7. Send minutes for deferred printing (if necessary) 
8. Display Confirmation Screen which provides the ability to 
open and print the finalized minutes. 

Finalize Only 1. Minutes information saved. 
2. System executes the actions associated to the minute codes 
(for code based minutes). 
3. Writes Case History/ROA entry associated with each minute 
code (if applicable). 
4. Creates the minutes in PDF format. 
5. Writes the Case History/ROA entry for the creation of the 
minutes. 
6. Send minutes for deferred printing (if necessary) 
7. Display Confirmation Screen which provides the ability to 
open and print the finalized minutes." 

Send Minutes for Judicial Review 1. Minutes information saved. 
2. Updates the status to make minutes available to a Judicial 
Officer Work Queue for reviewing minutes.   
3. The "Review Probate Notes" work queue is updated for use 
by the Judicial Officer, with a status of "Review/Approval 
Required." 

Send Minutes for Judicial Officer Electronic 
Signature 

1. Minutes information saved. 
2. System executes the actions associated to the minute codes 
(for code based minutes). 
3. Writes Case History/ROA entry associated with each minute 
code (if applicable). 
4. Updates the status of minutes to make it available to a 
Judicial Officer Work Queue for recording electronic signature. 
5. The "Probate Notes" For E-Signature" Work Queue is 
updated for use by the Judicial Officer, with a status of ""E-
Signature Required." 

 

 If the selected status is "Finalize Minutes," "Finalize Only," or "Send for Electronic Signature," then 
you will have the ability to generate additional forms once the minutes codes have executed successfully. 
  

Task Activities 

Recording Minutes - Code Based includes the following task activities: 
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• Search Minutes 
• Record Minutes for One Event 
• Record Minutes for Multiple Events/Multiple Cases 
• Finalize Multiple Minutes 
• Search Non-Calendar Event Minutes 
• Record Non-Calendar Event Minutes 
• Update Non-Calendar Event Minutes 
• Error Process - Record Minutes 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

Maintain Non-Event Minutes - Search Screen 

 

My Court Information 

 

Search Minutes 

 

Introduction 

This activity allows you to search for scheduled events and recorded minutes in the system. Refer to the 
Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for scheduled events.  
 

1. Select [Courtroom] > [Create/Maintain Minutes]. Courtroom_-_Create_Maintain_Minutes_-
_Search.gif 
Result: The Create/Maintain Minutes – Search screen displays. 
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2. Select data for the following required fields: 

• Date 
• Location 
• Department 

 The Division and Department fields are filtered depending on your selected Location 
value. The Division field is an optional field.  

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button.  

Result: The Create/Maintain Minutes – Search Results screen refreshes with the Search Results.  
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Related Links 

Record Minutes - Code Based Overview 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

 

My Court Information 

 

Record Minutes for One Event 
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Introduction 

Recording minutes for one event allows you to create minutes for a scheduled event on a case. This 
activity describes how to search for minute codes as well as how to preview the content of a minute order 
during the process of recording minutes.  

Task Activity 

This activity takes place in the context of a minutes search. Refer to the Search Minutes task activity for 
details on this process.  

Perform the following steps to record minutes for one scheduled event on a case.  
 

1. Select the checkbox for an event from the create/maintain minutes search results. 

 
 

 

2. Click the [Code-Based Minutes] button.  
Result: A new window opens and the Maintain Minutes - Code-Based Minutes Entry screen 
displays. 
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3. Click the [Capture Minute Orders] section.   
 The appropriate information in the Staff Assigned and Participant Check-in section can be 

entered/updated.  
4. Click the [Magnifying Glass] icon. 

 This is an optional step.   
Result: The Search Codes pop-up screen displays.  
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5. Enter/Select data for at least one of the following fields:  
6. Case Category 
7. Case Type 
8. Code Name 
9. Code Type 
10. Code Description 

 

6. Click the [Search] button. 
Result: The Search Codes pop-up screen refreshes with the search results.  
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7. Select the checkbox for a minute code.  
8. Click the [Select]  button.  

Result: The Search Codes pop-up screen closes and the Maintain Minutes - Code-Based Minutes 
Entry screen displays with selected code information.  

 The required Input Parameters and Code Descriptions display appropriate fields 
depending on the code selected.  
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9. Click the [Preview] button. 
Result: The Preview Content pop-up screen displays with the text translation minute codes. Close 
out of the pop-up screen before proceeding to the next step.  
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10. Select a status from the Save field.  
 You can indicate that the minute order is available for deferred printing by selecting the 

[Send for Deferred Printing] checkbox. Likewise, a draft version of the minute order can be 
printed at the time by selecting the [Event] field clicking the [Print Draft] button.  

11. Click the [Save] button. 
 The window closes and displays one of two possible outcomes:  

12. Result #1: If the status of "Finalize Minutes," "Finalize Only" or "Send Minutes for Judicial Officer 
Electronic Signature" have been selected, the Maintain Minutes - Select Forms screen displays.  
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13. Result #2: If the status of "Save as Draft" or "Send Minutes for Judicial Review" have been 
selected, the Maintain Minutes - Confirmation screen displays and the activity ends here.  

 
 

 

12. Select the necessary forms to be generated.  
13. Click the [Next] button.   

Result: The Maintain Minutes - Confirmation screen displays. 
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Related Links 

Record Minutes - Code Based Overview 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

My Court Information 

 

Record Minutes for Multiple Events/Multiple Cases 

 

Introduction 

Recording minutes in batch allows you to record minutes for multiple scheduled events on one case or 
multiple scheduled events for multiple cases.  

This process allows for one minutes instance to be created for multiple events on one case. It also 
provides the flexibility of recording minutes for multiple events on multiple cases.  
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Assumptions for Recording Minutes - Multiple Events/Multiple Cases 

If minutes are created for multiple events on multiple cases, then the participant check-in information 
cannot be recorded while recording minutes. However, the check-in information can be recorded for each 
case prior to recording minutes in batch. This information will be retrieved and displayed in the minutes.  

If minutes are created for multiple events on a single case, then the system will create a single minutes 
instance. Otherwise, if minutes are created for multiple events on multiple cases, then the system will 
create the minutes for each event. During this process, it is assumed that the codes apply to the cases for 
which minutes are being created. 

Task Activity 

This activity takes place in the context of a minutes search. Refer to the Search Minutes task activity for 
details on this process.  

Perform the following steps to record minutes for multiple events on one case or multiple events on 
multiple cases.  
 

1. Select the checkboxes for more than one event on either a single case or multiple cases. 
 This selection occurs from the create/maintain minutes search results. 
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2. Click the [Code-Based Minutes] button.  
Result: A new window opens and the Maintain Minutes - Code-Based Minutes Entry screen 
displays. 

 
 

 

3. Click the [Capture Minutes] section.  
 The appropriate information in the Staff Assigned and Participant Check-in section can be 

entered/updated.   
4. Enter/Update the available fields as needed.  

 The required Input Parameters and Code Descriptions display appropriate fields 
depending on the selected code. Only certain codes are available to you when minutes are 
recorded for multiple events/multiple cases.  

5. Select a status from the Save field. 
 You may add an additional indicator to denote the minutes as available for deferred printing 

by selecting the [Send for Deferred Printing] field. A draft version of the minutes can be printed 
by selecting the [Event] field clicking the [Print Draft] button.  

6. Click the [Save] button. 
 The MOCS client application closes and displays one of two possible outcomes:  

7. Result #1: If the status of "Finalize Minutes," "Finalize Only" or "Send Minutes for Judicial Officer 
Electronic Signature" have been selected, the Maintain Minutes - Select Forms screen displays.  
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8.  The "Order After Hearing" is the only form available when recording minutes on multiple 
events/multiple cases.  

9. Result #2: If the status of "Save as Draft" or "Send Minutes for Judicial Review" have been 
selected, the Maintain Minutes - Confirmation screen displays and the activity ends here.  

 
 

 

7. Select the necessary forms to be generated.  
8. Click the [Next] button.   

Result: The Maintain Minutes - Confirmation screen displays with confirmation text.  
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Related Links 

Record Minutes - Code Based Overview 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

My Court Information 

 

Finalize Multiple Minutes 

 

Introduction 

Finalizing minutes in batch allows you to finalize multiple minutes at the same time.  

Task Activity 

Perform the following steps to finalize multiple minutes.  
 

1. Select the checkboxes for more than one event from the create/maintain minutes search results. 
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2. Click the [Finalize] button.  
Result: The Maintain Minutes - Select Forms screen displays.  

 
 

 

3. Select the necessary forms to be generated.  
4. Click the [Next] button.   

Result: The Maintain Minutes - Confirmation screen displays.  
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Related Links 

Record Minutes - Code Based Overview 

Create/Maintain Minutes - Search Screen 

Create/Maintain Minutes - Search Results Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

My Court Information 

 

Search Non-Calendar Event Minutes 

 

Introduction 

This activity allows you to search for previously recorded minutes for non-calendar events. These minutes 
will be instead tied to the case number.  

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for previously recorded non-calendar minutes.  
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1. Select [Courtroom] > [Create/Maintain Non-Event Minutes]. 
Result: The Maintain Non-Event Minutes - Search screen displays. 

 
 

 

2. Enter data for one of the following required fields: 
3. Case Number 
4. Legacy Number 

 

3. Click the [Search] button. 
Result: The Maintain Non-Event Minutes - Search screen refreshes with the Search Results.  
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Related Links 

Record Minutes - Code Based Overview 

Maintain Non-Event Minutes - Search Screen 

 

My Court Information 

 

Record Non-Calendar Event Minutes 

 

Introduction 

Recording minutes for non-calendar events allows you to create minutes that are not tied to a calendared 
event. These minutes will be instead tied to the case number.  

Task Activity 

Perform the following steps to record non-calendar event minutes.  
 

1. Select [Courtroom] > [Create/Maintain Non-Event Minutes]. 
Result: The Maintain Non-Event Minutes Search screen displays. 

 
 

 

2. Enter data for one of the following required fields: 
3. Case Number 
4. Legacy Number 

 

3. Click the [Code-Based Minutes] button.  
Result: A new window opens and the Maintain Non-Event Minutes - Code Based Minutes Entry 
screen displays. 
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4. Click the [Capture Minute Orders] section.   
 The appropriate information in the Staff Assigned and Participant Check-in section can be 

entered/updated.   
5. Enter/Update the available fields as needed.  

 The required Input Parameters and Code Descriptions display appropriate fields 
depending on the selected code.  

6. Select a status from the Save field.  
 You can indicate that the minutes is available for deferred printing by selecting the [Send 

for Deferred Printing] checkbox.  
7. Click the [Save] button. 

 The window closes and displays one of two possible outcomes:  
8. Result #1: If the status of "Finalize Minutes," "Finalize Only" or "Send Minutes for Judicial Officer 
Electronic Signature" have been selected, the Maintain Minutes - Select Forms screen displays.  
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9. Result #2: If the status of "Save as Draft" or "Send Minutes for Judicial Review" have been 
selected, the Maintain Minutes - Confirmation screen displays and the activity ends here.  

 
 

 

8. Select the necessary forms to be generated.  
9. Click the [Next] button.   

Result: The Maintain Minutes - Confirmation screen displays.  
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Related Links 

Record Minutes - Code Based Overview 

Maintain Non-Event Minutes - Search Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

My Court Information 

 

Update Non-Calendar Event Minutes 

 

Introduction 

Updating minutes for non-calendar events allows you to edit previously recorded minutes that are not tied 
to a calendared event. These minutes will be instead tied to the case number.  

Task Activity 

This activity takes place in the context of a non-calendar event minutes search. Refer to the Search Non-
Calendar Event Minutes task activity for details on this process.  

Perform the following steps to update non-calendar event minutes.   
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1. Select the radio button for an event from the maintain non-event minutes search results.  

 
 

 

2. Click the [Update] button.  
Result: A new window opens and the Maintain Non-Event Minutes - Code Based Minutes Entry 
screen displays. 
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3. Click the [Capture Minute Orders] section.   
 The appropriate information in the Staff Assigned and Participant Check-in section can be 

entered/updated.   
4. Enter/Update the available fields as needed.   

 The required Input Parameters and Code Descriptions display appropriate fields 
depending on the selected code.  

5. Select a status from the Save field.  
 You may add an additional indicator to denote the minute order as available for deferred 

printing by selecting the [Send for Deferred Printing] field.  
6. Click the [Save] button. 

 The window closes and displays one of two possible outcomes:  
7. Result #1: If the status of "Finalize Minutes," "Finalize Only" or "Send Minutes for Judicial Officer 
Electronic Signature" have been selected, the Maintain Minutes - Select Forms screen displays.  

 
 

 

8. Result #2: If the status of "Save as Draft" or "Send Minutes for Judicial Review" have been 
selected, the Maintain Minutes - Confirmation screen displays and the activity ends here.  
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7. Select the necessary forms to be generated.  
8. Click the [Next] button.   

Result: The Maintain Minutes - Confirmation screen displays.  

 
 

 

 

 

Related Links 

Record Minutes - Code Based Overview 

Maintain Non-Event Minutes - Search Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

My Court Information 

 

Error Process - Record Minutes 

 

Introduction 

This activity describes the process of resolving possible errors that can occur when you save the minutes 
in the "Finalize Only" or "Finalize Minutes" status. These statuses initiate the minutes codes to execute in 
the system.   
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Task Activity 

This activity takes place within the context of recording minutes for an event. Refer to the Record Minutes 
for One Event task activity for details on this process.  

Perform the following steps to resolve the error message.  
 

1. View the possible error message on the Maintain Minutes - Confirmation. 

 
 

 

2. Click on the [Error] hyperlink.  
Result: The MCS client application launches in a new window. The Maintain Minutes - Code-
Based Minutes Entry screen displays with the codes in error highlighted.  
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3. Enter/Update the available fields as needed.  
 The required Input Parameters and Code Descriptions display appropriate fields 

depending on the code selected.   
4. Select a status from the Save field.  
5. Click the [Save] button. 

 The window closes and displays one of three possible outcomes:  
6. Result #1: If the minute codes have an error in executing the Maintain Minutes - Confirmation 

screen refreshes with an error message and the process steps should be repeated.  
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7. Result #2: If the status of "Finalize Minutes," "Finalize Only" or "Send Minutes for Judicial Officer 
Electronic Signature" have been selected, the Maintain Minutes - Select Forms screen displays. 

 
 

 

8. Result #3: If the status of "Save as Draft" or "Send Minutes for Judicial Review" have been 
selected, the Maintain Minutes - Confirmation screen displays and the activity ends here. 
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Related Links 

Record Minutes - Code Based Overview 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

View/Amend Minutes 

View/Amend Minutes Overview  

 

Introduction 

Viewing or amending minutes allows you to view or update previously finalized minutes. You can append 
text to existing minutes or create new minutes and save it as amended minutes. Both of these instances 
will create new minutes that are separate instances and will not update the existing original minutes. You 
can also view previously finalized minutes for a case.   

In order for you to view/amend minutes, finalized minutes must exist in the system. Refer to the Record 
Minutes - Code Based section for details on recording minutes. 

The Minutes codes to be used in amending minutes must be pre-configured. Refer to the Configure 
Codes section for details on configuring minute codes.  
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Retrieving Previously Entered Minutes   

When you open previously finalized minutes to update, the system will display the previously entered 
minutes codes. The codes are locked and displayed in read-only format so that the system does not 
execute the same codes again. However, you will have the ability to delete the associated text with 
previously entered codes, insert new codes between previously entered codes, and add new codes. 

Amending Minutes  

The amended minutes will be created based on text from previously entered codes, if these codes were 
not deleted.  

Only newly added/inserted action codes will be executed by the system. Previously entered codes will not 
be executed, but will be a part of the text in the new amended minutes, if they are not deleted. Deleting a 
locked action code will not cause the system to undo the update/action previously executed by the 
system. 

You will have the ability to configure a text code to retrieve specific language associated with amended 
minutes.  

Status of Amended Minutes  

The new instance of the amended minutes can have the following statuses:  
 

 

 

STATUS RESULTING ACTIONS 

Save as Draft Clerk 1. Minutes information saved. 

Finalize Minutes 1. Minutes information saved. 
2. System executes the actions associated to the minute codes 
(for code based minutes) 
3. Writes Case History/ROA entry associated with each minute 
code (if applicable). 
4. Finalizes the minutes in PDF format. 
5. Writes the Case History/ROA entry for the creation of the 
minutes. 
6. Creates a link between the minutes (PDF format) and the Case 
History/ROA entry. 
7. Send minutes for deferred printing (if necessary) 
8. Display Confirmation Screen which provides the ability to open 
and print the finalized minutes. 

Finalize Only 1. Minutes information saved. 
2. System executes the actions associated to the minute codes 
(for code based minutes). 
3. Writes Case History/ROA entry associated with each minute 
code (if applicable). 
4. Creates the minutes in PDF format. 
5. Writes the Case History/ROA entry for the creation of the 
minutes. 
6. Send minutes for deferred printing (if necessary) 
7. Display Confirmation Screen which provides the ability to open 
and print the finalized minutes." 

Send Minutes for Judicial Review 1. Minutes information saved. 
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2. Updates the status to make minutes available to a Judicial 
Officer Work Queue for review.  
3. The "Review Minutes" work queue is updated for use by the 
Judicial Officer, with a status of "Review/Approval Required." 

Send Minutes for Judicial Officer 
Electronic Signature  

1. Minutes information saved. 
2. System executes the actions associated to the minute codes 
(for code based minutes). 
3. Writes Case History/ROA entry associated with each minute 
code (if applicable). 
4. Updates the status of minutes to make it available to a Judicial 
Officer Work Queue for recording electronic signature. 
5. The "Minutes For E-Signature" Work Queue is updated for use 
by the Judicial Officer, with a status of "E-Signature Required." 

Task Activities 

Viewing/Amending Minutes includes the following task activities: 

• Search Amended Minutes 
• Amend Minutes 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

View/Amend Minutes - Search Screen 

Maintain Minutes - Confirmation Screen 

Maintain Minutes - Select Forms Screen 

 

My Court Information 

 

Search Amended Minutes 

 

Introduction 

Search amended minutes describes how to search for the finalized minutes associated with a case. 
Original and amended minutes for an event will be available to you.  

Task Activity 

Perform the following steps to search for finalized minutes.  
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1. Select the [Courtroom] > [View/Amend Minutes].  
Result: The View/Amend Minutes – Search screen displays. 

 
 

 

2. Enter data for one of the following required fields:  
3. Case Number 
4. Legacy Number 

 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button.  

Result: The View/Amend Minutes – Search refreshes with the Search Results. 
 You can click on the Minutes hyperlink to view the previously captured minutes. 
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Related Links 

View/Amend Minutes Overview 

View/Amend Minutes - Search Screen 

 

My Court Information 

 

Amend Minutes 

 

Introduction 

Amending minutes allows you to update previously finalized minutes in the system. 

This activity describes how to amend minutes and save them with the status of "Finalize Minutes."  

Task Activity 

This activity takes place in the context of a minutes search. Refer to the Search Amended Minutes task 
activity for details on this process.  

Perform the following steps to amend minutes. 
 

1. Select the radio button for an event from the view/amend minutes search results.  
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2. Click the [Amend Minutes] button.  
Result: A new window opens and the Maintain Minutes - Code-Based Minutes Entry screen 
displays with appropriate information.  
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3. Click the [Capture Minutes] tab section. 
 The previously entered codes are locked and not editable.  

4. Enter/Update the available fields as needed.  
 The required Input Parameters and Code Descriptions display appropriate fields 

depending on the code selected.   
5. Select a status from the Save field.  

 You can add an additional indicator to indicate that the minutes as available for deferred 
printing by selecting the [Send for Deferred Printing] checkbox.  

6. Click the [Save] button. 
 The window closes and displays one of two possible outcomes:  

7. Result #1: If the status of "Finalize Minutes," "Finalize Only" or "Send Minutes for Judicial Officer 
Electronic Signature" have been selected, the Maintain Minutes - Select Forms screen displays.  
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8. Result #2: If the status of "Save as Draft" or "Send Minutes for Judicial Review"  have been 
selected, the Maintain Minutes - Confirmation screen displays and the activity ends here.  

 
 

 

7. Select the necessary forms to be generated.  
8. Click the [Next] button.   

Result: The Maintain Minutes - Confirmation screen displays.  
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Related Links 

View/Amend Minutes Overview 

View/Amend Minutes - Search Screen 

Maintain Minutes - Select Forms Screen 

Maintain Minutes - Confirmation Screen 

 

Maintain Verdicts 

Maintain Verdicts Overview  

 

Introduction 

You can record a verdict associated with a Jury Trial on a case. A verdict must be recorded in the system 
prior to the judgment being rendered. The verdict can then be included as a part of the Minute and the 
judgment. You can search, record or update a verdict as required.  

In order to record a verdict, an event on which the verdict will be recorded must first exist within the 
system. 

Task Activities 

Maintaining verdicts includes the following task activities: 

• Search Verdict 
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• Record Verdict 
• Update Verdict 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Maintain Verdicts - Search Screen  

Record Verdict - Details Screen  

 

My Court Information 

 

Search Verdicts 

 

Introduction 

This activity allows you to search for verdicts on any case for which a Jury Trial event has occurred. The 
search results will only display events on the case for Jury Trials. You can search for verdicts on a case in 
order to review the verdict (before it is incorporated within a minute order) or to update a verdict as 
necessary. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a verdict. 
 

1. Select [Courtroom] > [Create/Maintain Verdicts]. 
Result: The Create/Maintain Verdicts- Search screen displays. 
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2. Enter data for at least one of the following required fields: 

• Case Number  
• Legacy Number 

 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Create/Maintain Verdicts- Search screen refreshes with the search results. 
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Related Links 

Maintain Verdicts Overview 

Maintain Verdicts - Search Screen 

 

My Court Information 

 

Record Verdict 

 

Introduction 

You can record a verdict in the system for a Jury Trial event. A verdict must be recorded prior to the 
judgment being rendered. In order to record a verdict, a Jury Trial event on which the verdict will be 
recorded must exist within the system. The system will only allow a verdict to be recorded if the type of 
event is "Jury Trial." 

Task Activity 

Perform the following steps to record a verdict. 
 

1. Select the radio button for the event on which to record a verdict. 
 This selection occurs from the search results of the Create/Maintain Verdicts - Search 

screen.  
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2. Click the [Record Verdict] button. 
Result: The Record Verdict - Details screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 

• Verdict Name 
• Date Verdict Recorded 
• Verdict Description 

 The Date Verdict Recorded field is defaulted to the date on the Minute/event date. The 
Verdict Name field is defaulted to "Verdict." 

4. Click the [Save] button. 
Result: The Create/Maintain Verdicts- Search screen displays with a confirmation message. 
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Related Links 

Maintain Verdicts Overview 

Maintain Verdicts - Search Screen 

Record Verdict - Details Screen 

 

My Court Information 

 

Update Verdict 

 

Introduction 

You can update a verdict recorded for a Jury Trial on a case by searching for and selecting the verdict to 
update. Refer to the Search Verdicts task activity for details on searching and recording verdicts. 

Task Activity 

Perform the following steps to update a verdict. 
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1. Click the [Verdict Name] link of the verdict you want to update. 
 This selection occurs from the search results of the Create/Maintain Verdicts - Search 

screen.  

 
 

 

2. Result: The Record Verdict - Details screen displays with the information pre-populated. 
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2. Enter/Update the data for the following required fields, as necessary: 

• Verdict Name 
• Date Verdict Recorded 
• Verdict Description 

 

3. Click the [Save] button. 
Result: The Create/Maintain Verdicts - Search screen displays with a confirmation message. 

 
 

 

 

 

Related Links 

Maintain Verdicts Overview 

Maintain Verdicts - Search Screen 

Record Verdict - Details Screen 

 

Maintain Sanctions 

Maintain Sanctions Overview  
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Introduction 

A sanction might be ordered against a participant/attorney as result of not meeting certain guidelines set 
forth by the court. It can also be ordered as a result of a court-initiated order or as a result of a request 
made by a participant/attorney. Depending on the party initiating the request, the participant/attorney 
against whom the sanction is ordered can be directed to pay the sanction amount to the court or to 
another participant/attorney. If the participant/attorney is ordered to pay the sanction amount to the court, 
then a Fee will be created in the system to allow the system to track the payment of the fee. 

Adjusting Sanction Fees 

You should not adjust the fee associated with a sanction from the accounting functions within the system. 
In order to change the sanction amount imposed on a participant/attorney, it must be changed from within 
the record sanctions function. Performing this activity will cause the associated fee to be adjusted to the 
new sanction amount. 

Sanction fees in an amount greater than $1,000 will cause the system to confirm whether the reporting 
requirements to the California State Bar apply (for Non-Discovery matters), as per B&P 6086.7. If you 
determine that the sanction must be reported to the State Bar Association, the system will generate the 
"Report to State Bar Association" form. 

Vacating and Suspending Sanctions 

In some cases, a sanction may need to be vacated or suspended. The court does not track vacated 
sanctions (for example, a sanction entered in clerical error). However, the court does track suspended 
sanctions, which occur when an order is made where the sanction does not have to be paid. 

If the sanction is payable to the court, then at the time of vacating/suspending the sanction the associated 
fees will be cancelled. If a payment was recorded against this sanction, then the payments received will 
be transferred to a trust deposit for the participant against whom the sanction was ordered. 

Task Activities 

Maintaining sanctions includes the following task activities: 

• Record Sanction 
• Search Sanctions 
• Update Sanction 
• Suspend Sanction 
• Vacate Sanction 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Maintain Sanctions - Search Screen  

Record Sanctions Screen  
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My Court Information 

 

Search Sanctions 

 

Introduction 

This activity allows you to search for sanctions that have been previously recorded on a case and have 
not been vacated. Refer to the Search Feature Overview for details on performing a search in the system. 

The search function also provides the foundation for maintaining sanctions. For example, you must 
perform this search in order to update, vacate, or suspend a sanction. 

Task Activity 

Perform the following steps to search for sanctions. 
 

1. Select [Courtroom] > [Maintain Sanctions]. 
Result: The Create/Maintain Sanctions - Search screen displays. 

 
 

 

2. Enter data for at least one of the following required fields: 

• Case Number 
• CMS ID Number 

 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Create/Maintain Sanctions - Search screen refreshes with the Search Results. 
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 Searching for sanctions using a case participants "CMS ID Number" will retrieve all 
sanctions entered against the case participant, even across multiple cases.  

 

 

Related Links 

Maintain Sanctions Overview 

Maintain Sanctions - Search Screen 

 

My Court Information 

 

Record Sanction 

 

Introduction 

You can record a sanction against one or multiple participants in a case. In order to record a sanction, the 
sanctioned participant/attorney must be associated with the case on which the sanction is ordered.  

Refer to the Manage Person/Entity Information and Manage Case Participants sections for details on 
entering a new participant into the system and associating the participant with the selected case.  

Task Activity 

Perform the following steps to record a sanction. 
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1. Select [Courtroom] > [Maintain Sanctions]. 
Result: The Create/Maintain Sanctions - Search screen displays. 
 

 
 

 

2. Click the [Record Sanction] button. 
Result: The Record Sanctions screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 

• Sanction Against 
• Sanction Amount $ 
• Sanction Amount Payable To (Role) 
• Sanction Amount Payable To (Name) 
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• Sanction Due Date 
 If Court is entered for the "Sanction Amount Payable To" field, then the system will 

record a sanction fee in the amount of the sanction against the specified participant/attorney.  

If this sanction fee is greater than $1,000, then you must confirm whether the reporting 
requirements to the California State Bar apply (for Non-Discovery matters), as per B&P 
6086.7.  

If you determine that the sanction must be reported to the State Bar Association, then select 
"Yes".The system will then generate the "Report to State Bar Association" form. 

 

4. Click the [Save] button. 
Result: The Create Maintain Sanctions- Search screen displays with a confirmation message. 

 
 

 

 

 

Related Links 

Maintain Sanctions Overview 

Maintain Sanctions - Search Screen 

Record Sanctions Screen 
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My Court Information 

 

Update Sanction 

 

Introduction 

You may be required to update a sanction if it was entered incorrectly, against the wrong case 
participant/attorney, payable to the wrong entity, recorded in the wrong amount, or ordered by the court. 

If the sanction is for the wrong amount, it is important that you do not adjust the fee through the 
Accounting module. You must reduce the sanction amount through the update sanction function. 
Updating the sanction amount will cause the fee to be adjusted to the newly entered sanction amount.  

Before Updating a Sanction 

Before you can suspend a sanction, you must first perform a sanction search. Refer to the Search 
Sanctions task activity for details on this process. 

Task Activity 

Perform the following steps to update a sanction. 
 

1. Select the radio button for the sanction you want to suspend. 
 This selection occurs from the search results of the Create/Maintain Sanctions - Search 

screen.  

 
 

 

2. Click the [Select] button. 
Result: The Record Sanctions screen displays. 
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3. Update the data for the following required fields as necessary: 

• Sanction Against 
• Sanction Amount $ 
• Sanction Amount Payable To (Role) 
• Sanction Amount Payable To (Name) 
• Sanction Due Date 

 

4. Click the [Save] button. 
Result: The Create/Maintain Sanctions - Search screen displays with a confirmation message. 
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Related Links 

Maintain Sanctions Overview 

Maintain Sanctions - Search Screen 

Record Sanctions Screen 

 

My Court Information 

 

Suspend Sanction 

 

Introduction 

Suspending a sanction will cause the sanction to remain on the case, but it will suspend or cancel any 
monies due for the sanction if the sanction was payable to the court. If the case participant/attorney for 
whom the sanction was levied against has already paid the sanction fee, then the payment for the 
sanction will be voided and the monies will be transferred to a trust. These monies may then be disbursed 
back to the case participant/attorney, if so requested.  
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Before Suspending a Sanction 

Before you can suspend a sanction, you must first perform a sanction search. Refer to the Search 
Sanctions task activity for details on this process. 

Task Activity 

Perform the following steps to suspend a sanction. 

1. Select the radio button for the sanction you want to suspend. 
 This selection occurs from the search results of the Create/Maintain Sanctions - Search 

screen.  

 
 

 

2. Click the [Suspend] button. 
Result: The Create/Maintain Sanctions - Search screen displays with a confirmation message. 
The status of the sanction is updated to "Suspended" in the system. 
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Related Links 

Maintain Sanctions Overview 

Maintain Sanctions - Search Screen 

 

My Court Information 

 

Vacate Sanction 

 

Introduction 

Vacating a sanction will cause the sanction to be removed entirely from the case. Any monies due for the 
sanction will then be cancelled if the sanction was payable to the court. If the case participant/attorney the 
sanction was made against has already paid the fee, then the payment will be voided and the monies will 
be transferred to a trust. These monies may then be disbursed back to the case participant/attorney at 
their request.  

Before Vacating a Sanction 

Before you can suspend a sanction, you must first perform a sanction search. Refer to the Search 
Sanctions task activity for details on this process. 
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Task Activity 

Perform the following steps to vacate a sanction. 
 

1. Select the radio button for the sanction you want to suspend. 
 This selection occurs from the search results of the Create/Maintain Sanctions - Search 

screen.  

 
 

 

2. Click the [Vacate] button. 
Result: The Name of Create/Maintain Sanctions - Search screen displays with a confirmation 
message. The record of the sanction is removed from the system. 
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Related Links 

Maintain Sanctions Overview 

Maintain Sanctions - Search Screen 

 

Maintain Tentative Rulings 

Maintain Tentative Rulings Overview  

 

Introduction 

You can create or update Tentative Rulings related to a scheduled event. You can record Tentative 
Rulings through the use of free-form text entry (text-based) or through the use of minute codes (code-
based) using the MCS client application.  

In order for the Tentative Rulings to be entered, scheduled events must first exist in the system. Once an 
event is scheduled, the appropriate Research Attorney’s work queue will be populated. Refer to the Work 
Queues section for details on completing work queue tasks.  

Depending on the business process of the courts, you may finalize and publish the Tentative Rulings or 
send it for Judicial Review. If the Tentative Rulings have not been finalized and published, then a draft 
version can be printed at anytime. Otherwise, the Tentative Rulings are accessible through the Case 
History. 

If the Tentative Rulings are sent for Judicial Officer review, the Judicial Officer may provide comments 
relating to the Tentative Rulings and send the input back to you for follow-up work. Refer to the Judicial 
Notes section for details on understanding Judicial Officer functionality.  

You can update Tentative Rulings any time before a scheduled event is heard. Tentative Rulings may 
always be accessed from the related courtroom event, even if the event is continued to a future date. 

Text-Based Tentative Rulings 

You can record and format Tentative Rulings information within the free-form entry text field of the 
Tentative Rulings/Research Text sections.  

Code-Based Tentative Rulings 

You can record Tentative Rulings information by using Minutes codes through the MCS client application. 
The MCS client is a separate application that will be launched when you select to record code-based 
Tentative Rulings. The Minutes codes to be used in recording of Tentative Rulings must be pre-
configured. Refer to the Configure Codes section for details on configuring codes.  

If the Tentative Rulings are created using the code-based feature, the text translation of the codes will be 
stored as the Tentative Rulings. However, the codes will also be stored as minute codes and will be 



Printed Documentation 

946 

considered work-up for Minutes. Also, codes are only stored and not executed. They will only be 
executed when the minutes associated with the event are finalized.  

If you retrieve this event to create minutes, then these entered codes will be retrieved and displayed. You 
will then have the ability to finalize these minutes, which will cause the system to perform the actions 
related to the codes as well as convert the text associated with the codes into the Minutes for the event. 
You will also have the ability to enter new codes or delete previously entered codes during this process.  

Judicial Officer Review 

Once the Tentative Rulings are sent for Judicial Officer Review, the associated event will be made 
available in the Judicial Officer's work queue for reviewing Tentative Rulings. This associated event will 
be dropped from the Research Attorney’s work queue.  

For text-based Tentative Rulings, the Judicial Officer will have the ability to add Judicial Notes related to 
the Tentative Rulings and have the ability to enter/update the Tentative Rulings/Research Text sections.  

For code-based Tentative Rulings, the text translation of the codes of the Tentative Rulings will display to 
the Judicial Officer in read-only mode. The Judicial Officer will not have the ability to change previously 
created Tentative Rulings saved by other users, but can update the Research Text/Comments sections 
by writing comments in the Judicial Notes section. 

Once the Tentative Rulings are done being reviewed, the Judicial Officer can either choose to finalize and 
publish the Tentative Rulings or send it back to you for follow-up work. If the Tentative Rulings are sent 
back, you can make the necessary updates to the Tentative Rulings by reviewing the non-editable 
Judicial Officer Notes section.  

Status of Tentative Rulings  

Tentative Rulings can be saved with the following statuses in the system:  
 

 

 

STATUS RESULTING ACTIONS 

Save as Draft 1. Tentative Rulings information is saved. 

Send Tentative Rulings for Judicial Review 1. Tentative Rulings information is saved.   
2. Tentative Rulings are available to the assigned Judicial 
Officer Work Queue for review.  

Publishing 1. Tentative Rulings information is saved.  
2. Tentative Rulings will be available for posting to the 
internet or other external systems. 
3. A PDF format of the Tentative Ruling is created.  
4.  A Case History/ROA entry is made signifying that the 
Tentative Rulings were created with a link to the PDF. 
5. Based on the configuration of the work queues, the 
scheduled events with “Published” Tentative Rulings will 
remain/drop from the work queue. 

Further Action Required 1. Tentative Ruling available to the Research Attorney’s 
Work Queue for follow-up on the comments made by the 
Judicial Officer.  Refer to Maintain Judicial Notes for more 
information on this functionality.  
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 The Tentative Rulings section will be made available for publishing once the status is updated to 
"Published," while the Research Text section will only be used for internal purposes.  

Based on configuration of the work queues, the scheduled events with “Published” Tentative Rulings will 
remain/drop from the Research Attorney’s work queue. Tentative Rulings marked as "Published" will be 
made available for printing on the calendar.  

Task Activities 

Maintaining Tentative Rulings includes the following task activities:  

• Record Tentative Rulings - Text- Based 
• Record Tentative Rulings - Code-Based 
• Edit Tentative Rulings 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Maintain Tentative Rulings Screen 

 

My Court Information 

 

Record Tentative Rulings - Text-Based 

 

Introduction 

Recording Tentative Rulings is the process of gathering and entering information about a scheduled 
event. You will have the ability to record information in the Tentative Rulings/Research Text sections.  

The activity below outlines the use of recording Tentative Rulings by free-form (text) entry. 

Task Activity 

This activity takes place within a context of a work queue. Refer to the Work Queues section for details on 
this process.  

Perform the following steps to record Tentative Rulings information. 
 

1. Select the radio button for an event in the Tentative Rulings Work Queue. 
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2. Click the [Select] button. 
Result: The Maintain Tentative Rulings screen displays. 
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3. Enter free-form text in the appropriate Tentative Rulings and Research Text tabs.  
4. Select a status from the Save field.  

 You can select an additional indicator to denote the Tentative Rulings as available for 
posting by selecting the [Available for Posting] field.  

5. Click the [Save] button. 
Result: The Tentative Rulings Confirmation screen displays. 

 The Edit Tentative Rulings in free-from (text) based has the same process steps as 
Record Tentative Rulings. The previously recorded Tentative Rulings information will be 
displayed to you in the appropriate sections.  

 

 

Related Links 

Maintain Tentative Rulings Overview 

Maintain Tentative Rulings Screen 

 

My Court Information 

 

Record Tentative Rulings - Code-Based  

 

Introduction 

Recording Tentative Rulings involves gathering and entering information about a scheduled event. You 
will have the ability to record information in the Tentative Rulings/Research Text sections.  

The activity below outlines the Record Tentative Rulings by the use of Minutes codes through the MCS 
application. This will include the process of previewing the text translation of the codes.   

Task Activity 

This activity takes place within a context of a work queue. Refer to the Work Queues section for details on 
this process.  

Perform the following steps to record Tentative Rulings information.  
 

1. Select the radio button for an event in the list of events in the Tentative Rulings Work Queue. 



Printed Documentation 

950 

 
 

 

2. Click the [Select] button. 
Result: The MCS client application launches in a new window. The Maintain Tentative Rulings - 
Code-Based screen displays. 

 
 

 

3. Enter/Update the available fields as needed.  
4. Date 
5. Codes 
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 The required Input Parameters and Code Descriptions display appropriate fields 
depending on the selected code.  

4. Click the [Preview] button.  
Result: The Preview Content pop-up screen displays with the text translation minute codes.  

 
 

 

5. Select the a status from the Save field.  
6. Click the [Save] button. 

Result: The MCS client application closes and the Tentative Rulings Confirmation screen 
displays. 

 

 

Related Links 

Maintain Tentative Rulings Overview 

 

My Court Information 
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Edit Tentative Rulings 

 

Introduction 

Editing Tentative Rulings allows you to update previously recorded Tentative Rulings information about a 
scheduled event.  

The system will retrieve the previously recorded Tentative Rulings information and display it the original 
mode that you captured. This can be either code-based or text-based. You also have the ability to update 
information in the Tentative Rulings/Research Text sections.  

The activity below outlines Edit Tentative Rulings by the use of Minutes codes through the MCS 
application. 

Task Activity 

This activity takes place within a context of a work queue. Refer to the Work Queues section for details on 
this process.  

Perform the following steps to edit Tentative Rulings information.  

1. Select the radio button for an event in the list of events in the Tentative Rulings Work Queue. 

 
 

 

2. Click the [Select] button. 
Result: The MCS client application launches in a new window. The Maintain Tentative Rulings - 
Code-Based Entry screen displays. 
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3. Enter/Update the available fields as needed.  
 The required Input Parameters and Code Descriptions display appropriate fields 

depending on the selected code.  
4. Click the [Preview] button.  

Result: The Preview Content pop-up screen displays with the text translation minute codes.  
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5. Select the a status from the Save field.  
6. Click the [Save] button. 

Result: The MOCS client application closes and the Tentative Rulings Confirmation screen 
displays. 

 

 

Related Links 

Maintain Tentative Rulings Overview 

Maintain Tentative Rulings Screen 

 

Maintain Probate Notes 

Maintain Probate Notes Overview 
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Introduction 

You can create or update Probate Notes related to a scheduled event in a Probate Case. You can record 
Probate Notes through free-form text entry and through the use of Probate Notes macros. However, the 
Probate Note macros must be pre-configured. Refer to the Configure Minute Macros section for details on 
this process.  

In order for the Probate Notes to be entered, scheduled events must first exist in the system. Once a 
Probate Case event is scheduled, the appropriate Probate Examiner’s work queue will be populated. 
Refer to the Work Queues section for details on completing work queue tasks.  

Depending on the business process of the courts, you may finalize and publish the Probates Notes or 
send it for Judicial Review in which the Judicial Officer will finalize and publish the Probate Notes. If the 
Probate Notes have not been finalized and published, then a draft version can be printed at anytime. 
Otherwise, the notes are accessible through the Case History. 

If the Probate Notes are sent for Judicial Officer review, then the Judicial Officer will have the ability to 
update the Probate Notes in order to fix defects, add additional inputs, and finalize and publish the 
Probate Notes. Refer to the Judicial Notes section for details on understanding Judicial Officer Probate 
Notes functionality. You will not receive the comments back from the Judicial Officer for follow-up work.  

You can update Probate Notes any time before a scheduled event is heard. Probate Notes can be 
accessed from the related courtroom event, even if the event is continued to a future date.  

Text-Based Probate Notes 

You can record and format Probate Notes information within the free-form entry text field of the Probate 
Notes/Comments/Research Text sections.   

Use of Macros in Probate Notes 

At the time of recording Probate Notes, you may use macros that consist of pre-defined text as a way to 
reduce data entry. If you choose to use macros, the system will retrieve a list of macros available for 
recording Probate Notes information. Only those macros designated as Probate Notes will be available 
for use. Probate Notes macros do not perform system actions such as scheduling an event. Refer to the 
Configure Codes section for details on configuring codes.  

When using macros, you will have the ability to include or remove text codes from the list to be translated 
into text. You will also have the ability to enter text in the fields associated with the pre-configured codes. 

Based on the pre-configuration of each code, the system will translate each code into either the Probate 
Notes section or Comments section. Codes that are pre-configured to be available for publishing will be 
translated into the Probate Notes section. Codes pre-configured not to be available for publishing will be 
translated into Comments section. In addition, codes that are not pre-configured to belong to the 
Comments section or the Probate Notes section will be displayed in the Comments section by default. 

For both Probate Notes/Comments sections, the translated text will be appended to the previously 
entered text. You can update the Research Text as a free-form field.  

Judicial Officer Review 

Once the Probate Notes are sent for Judicial Officer Review, the associated event will be made available 
in the Judicial Officer's work queue for reviewing Probate Notes. This associated event will drop/remain 
on the Probate Examiner’s work queue depending on the work queue configuration.  

The Judicial Officer will have the ability to add Judicial Notes related to the Probate Notes and have the 
ability to enter/update information in the Probate Notes/Comments/Research Text sections. Once the 
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Judicial Officer is done reviewing the Probate Notes they will have the ability to finalize and publish the 
Probate Notes.   

Status of Probate Notes 

The Probate Notes can be saved with the following statuses in the system:  
 

 

 

STATUS RESULTING ACTIONS 

Save as Draft 1. Probate Notes information is saved. 

Send for Judicial Officer Review 1. Probate Notes information is saved.   
2. Probate Notes are available to the assigned Judicial Officer 
Work Queue for review.  

Publishing 1. Probate Notes information is saved.  
2. Probate notes will be available for posting to the internet or 
other external systems. 
3. A PDF format of the Probate Notes is created.  
4.  A Case History/ROA entry is made signifying that the 
Probate Notes were created with a link to the PDF. 
5. Based on the configuration of the work queues, the scheduled 
events with “Published” Probate Notes will remain/drop from the 
work queue. 

 

 The Probate Notes section will be made available for publishing once the status is updated to 
"Published," while the Comments/Research Text section will be used for internal purposes.  

Based on configuration of the work queue, the scheduled events with “Published” Probate Notes will 
remain/drop from the Probate Examiner’s work queue.   

Probate Notes marked as "Published" will be made available for printing on the calendar.  

Task Activities 

Maintaining Probate Notes includes the following task activities:   

• Record Probate Notes 
• Edit Probate Notes 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Maintain Probate Notes Screen 
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Maintain Probate Notes - Macros Screen 

 

My Court Information 

 

Record Probate Notes 

 

Introduction 

Recording Probate Notes involves gathering and entering information related to a scheduled event on a 
Probate Case. You will have the ability to enter free-form text in the Probate Notes/Comments/Research 
Text sections.  

Task Activity 

This activity takes place within a context of a work queue. Refer to the Work Queues section for details on 
this process.  

In the activity below, the optional use of macros will be incorporated within the process steps. This will 
include the process of previewing the text translation of the macros.   

Perform the following steps to record Probate Notes information. 
 

1. Select the radio button for an event in the Probate Notes Work Queue.  

 
 

 

2. Click [Select] button. 
Result: The Maintain Probate Notes screen displays. 
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3. Enter free-form text in the appropriate Probate Notes, Comments, and Research Text tabs. 
 If the work queue is configured to first display the macros, then the system will provide you 

with the ability to first select the appropriate macro and then work on the Probate Notes in free-
form entry (text) mode. 

4. Click [Add Macros] button. 
Result: The Maintain Probate Notes - Macros screen displays. 
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5. Select data from the Select Macros field.  
Result: The Maintain Probate Notes - Macros screen refreshes with the loaded information.  

 
 

 

6. Click the [Translate] button.  
Result: The Maintain Probate Notes screen re-displays with text translation of the macros loaded 
into the appropriate sections.  
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7. Select a status from the Save field.  
 You can add an additional indicator to identify the progress of the Probate Notes by 

selecting data from the Probate Notes Progress field.  
8. Click the [Save] button. 

Result: The Probate Notes Confirmation screen displays. 
 

 

Related Links 

Maintain Probate Notes Overview 

Work Queue Screen 

Maintain Probate Notes Screen 

Maintain Probate Notes - Macros Screen 
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My Court Information 

 

Edit Probate Notes 

 

Introduction 

Editing Probate Notes changes the previously recorded Probate Note information related to a scheduled 
event on a Probate Case.  

Task Activity 

This activity takes place within a context of a work queue. Refer to the Work Queues section for details on 
this process.  

Perform the following steps to record Probate Notes information.  
 

1. Select the radio button for an event from the Probate Notes Work Queue. 

 
 

 

2. Click [Select] button. 
Result: The Maintain Probate Notes screen displays with previously entered information. 
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3. Update the appropriate text within the Probate Notes/Comments/Research Text sections. 
 The system will retrieve previously recorded text that you have saved. Depending on the 

configuration of the work queue, the system will either display the macros or the Probate Notes in 
free-form (text) entry mode.  

4. Select a status from the Save field. 
 You can add an additional indicator to identify the progress of the Probate Notes by 

selecting data from the Probate Notes Progress field. 
5. Click [Save] button. 

Result: The Probate Notes Confirmation screen displays. 
 

 

Related Links 

Maintain Probate Notes Overview 

Work Queue Screen 

Maintain Probate Notes Screen 
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Change Default Staff for Minutes 

Change Default Staff for Minutes Overview  

 

Introduction 

Changing the default staff for minutes allows you to set the default staff for a specific department and 
date. This information will be displayed on the header of the minutes for events held in the specified 
department on the requested date, and is used at the time of recording minutes. However, in order for the 
default staff to be changed, the staff information must first exist in the system.  

This activity will override the assignments for a specific department and date that have been set when 
configuring and assigning court resources to departments. Refer to the Configure Department Resources 
section for details on this process.  

The change to the default staff information is associated with the event and becomes available for use at 
a later time. For example, if minutes are created a few days after an event occurred, then the system will 
populate the staff to the values set for the day that the event was heard (using the specified department 
and date).  

When recording minutes for an event, you can override the displayed staff information with the details 
about the staff that are actually present during the event. Refer to the Record Minutes - Code Based 
section for details on recording minutes.  

Task Activities 

Changing the default staff for minutes includes the following task activity:  

• Change Default Staff for Minutes  
Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Change Default Staff for Minutes Screen 

 

My Court Information 

 

Change Default Staff for Minutes 
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Introduction 

This activity allows you to change the default staff information for events identified for a specific 
department and date.  

Task Activity 

Perform the following steps to change the default staff for minutes.  
 

1. Select the [Courtroom] > [Change Default Staff for Minutes]. 
Result: The Change Default Staff for Minutes screen displays. 

 
 

 

2. Select data for the following required fields: 

• Date 
• Location 
• Department 

 The Division and Department fields are filtered depending on your selected Location 
value. The Division field is optional.  

3. Enter/Select the data for at least one of the remaining screen fields.  
 In order to change the default staff, you must select information associated with at least 

one staff member must be selected or an error message will display.  

4. Click the [Save] button.  
Result: The Change Default Staff for Minutes Confirmation screen displays. 
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Related Links 

Change Default Staff for Minutes Overview 

Change Default Staff for Minutes Screen 
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The Disposition Section 

Maintain Judgments 

Maintain Judgments Overview  

 

Introduction 

The system supports recording, entering and amending judgments, including calculating judgment 
awards. Judgments can be recorded and entered as part of minutes, recorded and entered outside the 
minutes functionality, or recorded through the minutes and enter the judgment at a later time.  

As part of the judgment, the system will allow you to include the verdict (if applicable), who the judgment 
was for and against, the amount of any awards, and any detailed instructions such as judgment stays and 
ability to pay in installments. The system will also allow you to print any applicable forms associated with 
the judgment. 

A judgment can have one or more associated judgment awards. If several judgments are rendered, there 
can be multiple associated judgment awards, each detailing out a specific amount that the judgment 
debtor(s) owes the judgment creditor(s). 

Refer to the Record Minutes - Code Based section for details on recording a judgment through the 
minutes functionality 

Recording Judgments 

You can record a judgment that is rendered by the Court (including default judgment and judgment on 
verdict) as well as the Clerk's default judgment. Judgments can be recorded as a result of a filing, as part 
of a Minute process or as a result of a Judicial Officer ruling. If the judgment is recorded through a filing, 
then the system will navigate you from the filing screen to the Record/Enter judgment screen. 

Entering Judgments 

A judgment can be entered as part of minutes or outside the minutes functionality at the same time 
judgment information is recorded. You can also enter judgments using the Minute functionality within the 
Courtroom section of the application. Refer to the Record Minutes - Code Based section for details on this 
process. 

Once a judgment is entered, you can update the pre-judgment costs, attorney fees, amount payable to 
the court, post-judgment amount payable to the court, interest and costs, and stay information. If you 
need to make any other changes, then the judgment must be amended. 

When a judgment is entered, the system will update the status of the selected defendants/cross-
defendants on the related filing(s). Based on the status of the participants on the filing, the system will 
update the status of the filing according to the JBSIS disposition hierarchy.   

Amending Judgments 

Once a judgment is entered, most changes must be made by amending the judgment. You can update 
previously entered judgment information, including adding or removing participants related to the 
judgment, as well as updating the judgment award information. You can also update the sub-type of the 
judgment but not the type of disposition. 

The request to amend a judgment may be entered as a result of a filing or as part of minutes. 
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Task Activities 

Maintaining Judgments includes the following task activities: 

• Search Judgments 
• Record a Judgment 
• Enter/Update a Judgment 
• Amend a Judgment 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Record/Enter Disposition - Search Screen 

Record/Enter Judgment Screen 

Calculate Judgment Award Screen 

View/Amend Judgment - Search Screen 

View/Amend Judgment Screen 

 

My Court Information 

 

Search Judgments  

 

Introduction 

This activity allows you to search for previously recorded judgments or entered dismissals in the system. 
Refer to the Search Feature Overview for details on performing a search in the system. 

The search function also provides the foundation for maintaining judgments. For example, you must 
perform this search in order to enter a judgment outside of Minutes or record a judgment. 

However, refer to the View/Amend Judgment - Search for details on searching for and viewing previously 
entered judgments. 

Task Activity 

Perform the following steps to search for a previously entered or recorded judgment. 
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1. Select [Disposition] > [Record/Enter Disposition]. 
Result: The Record/Enter Disposition - Search screen displays. 

 
 

 

2. Select a Case Number. 
3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Record/Enter Disposition - Search Results screen displays. 

 
 

 

 

 

Related Links 

Maintain Judgments Overview 

Record/Enter Disposition - Search Screen 
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My Court Information 

 

Record a Judgment 

 

Introduction 

You can record a judgment as a result of a filing, as a result of a Judicial Officer ruling outside the 
courtroom, or as part of minutes. The following process describes how record a judgment outside the 
Minute process. 

Refer to the Record Minutes - Code Based section for details on recording a judgment within a minute 
order. 

Recording a Judgment from a Filing 

If you are recording a judgment as a result of a filing and you have entered the filing details, then the 
system will take you to the Record/Enter Judgment screen where you can enter the judgment details. 

Recording a Judgment from a Judicial Officer Ruling Outside the Courtroom 

If you are recording a judgment as a Judicial Officer ruling outside the courtroom, at the Record/Enter 
Disposition - Search screen, you must select the Case Number, Type of Disposition (Judgment) and Sub-
Type of Disposition.  

Task Activity 

Perform the following steps to record a judgment. 
 

1. Select [Disposition] > [Record/Enter Disposition]. 
Result: The Record/Enter Disposition - Search screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Case Number 
• Type of Disposition 
• Sub-type of Disposition 

 

3. Click the [Record Disposition] button. 
Result: The Record/Enter Judgment screen displays with the Record Judgment tab highlighted. 



The Disposition Section 

971 

 
 

 

4. Select the Sub-type of Disposition from the drop-down list, if you need to change the judgment 
sub-type. 

5. Select the toggle button to expand the filing document and role(s) on which to record a judgment. 
Result: The Record/Enter Judgment screen expands. 
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6. Select the Judgment For and Judgment Against for the appropriate case participants. 
 You must select participants for both of these fields in order to record a judgment award. 

7. Select the [Record Judgment Amount] button. 
Result: The Calculate Judgment Award screen displays.   



The Disposition Section 

973 

 
 

 

8. Enter/Select data for the necessary fields. 
9. Click the [Next] button. 

Result: The Record/Enter Judgment screen displays. 
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10. Select the [Summary] tab. 
Result: The Summary tab highlights and displays the appropriate information. 
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11. Enter/Select data for the necessary fields. 
12. Select the [Record Judgment] button. 

Result: The Record/Enter Disposition - Search screen displays with a confirmation message. 
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Related Links 

Maintain Judgments Overview 

Record/Enter Disposition - Search Screen 

Record/Enter Judgment Screen 

Calculate Judgment Award Screen 

 

My Court Information 

 

Enter/Update a Judgment 

 

Introduction 

After a judgment is recorded, either through minutes or outside the minutes functionality, it can then be 
updated with additional details or entered into the system. Entering a judgment can update (typically 
dispose) the status of filings and potentially the entire case. Based on the entered judgment information, 
the system will automatically perform the status updates mentioned above. 

Once a judgment is entered, you can update the pre-judgment costs, attorney fees, amount payable to 
the court, post-judgment amount payable to the court, interest and costs, and stay information. If other 
updates are needed, then the judgment must be amended. Refer to the Amend a Judgment task activity 
for details on this process. 

Task Activity 

Perform the following steps to enter a judgment. 
 

1. Select [Disposition] > [Record/Enter Disposition]. 
Result: The Record/Enter Disposition - Search screen displays. 
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2. Enter a Case Number or Legacy Number. 
3. Click the [Search] button. 

Result: The Record/Enter Disposition - Search Results screen displays. 

 
 

 

4. Select the radio button for the Recorded Judgment you want to enter. 
5. Select the [Select] button. 

Result: The Record/Enter Judgment screen displays. 
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6. Select/update data for the necessary fields. 
 Select the [Record Judgment Amount] button if you need to update any information 

regarding the judgment award, including any payment to the court. 
7. Select the [Record/Enter Judgment Summary] tab. 

Result: The Record/Enter Judgment tab highlights and displays the appropriate information. 

 
 

 

8. Select/update data for the necessary fields. 
 You can select the forms that you generated when the judgment is entered into the 

system. 

9. Select the [Enter Judgment] button. 
Result: The Enter Disposition - Confirmation screen displays. 
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 The screen will display updated case information as well as details related to the filing on 
which the select judgment was entered. If you select the [Vacate Future Events] button, then 
you will be taken to Maintain Calendar Events screen where you must manually select the 
events to be vacated. 

 

 

Related Links 

Maintain Judgments Overview 

Record/Enter Disposition - Search Screen 

Record/Enter Judgment Screen 

Enter Disposition - Confirmation Screen 

 

My Court Information 

 

Amend a Judgment 
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Introduction 

The system supports amending a judgment either through minutes or through the amend judgment steps 
described below. 

Task Activity 

Perform the following steps to amend a judgment. 
 

1. Select [Disposition] > [View/Amend Judgment]. 
Result: The View/Amend Judgment - Search screen displays. 

 
 

 

2. Enter data for one of the following required fields: 

• Case Number  
• Legacy Case Number 

 

3. Click the [View Summary] button. 
Result: The View/Amend Judgment screen displays. 

 
 

 

4. Select the toggle button to expand the details of the judgment you want to amend. 
Result: The View/Amend Judgment screen displays the judgment details. 
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5.  If you do not want to amend a judgment but need to make updates to the post-judgment 
award information, select the Total Amount hyperlink to update the details of the judgment award on the 
Calculate Judgment Award screen. 



Printed Documentation 

982 

 
 

 

5. Select the radio button for the judgment to be amended. 
6. Click on the [Amend Judgment] button. 

7. Result: The Record/Enter Judgment Summary tab displays with the previously entered 
information. 
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 To view a history of amended judgments on the case, select the [View History] button. 

7. Select the radio button for the judgment award to update. 
8. Click the [Update] button. 

Result: The Record/Enter Judgment screen displays with the Record Judgment tab highlighted 
and previously entered information available. 
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9. Click on the [Record Judgment Amount] button. 
10. Enter/Update the available fields as needed. 
11. Click the [Next] button. 

Result: The View/Amend Judgment screen displays. 
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12. Click the [Amend Judgment] button. 
Result: The screen refreshes with a confirmation message. 

 

 

Related Links 

Maintain Judgments Overview 

View/Amend Judgment - Search Screen 

View/Amend Judgment Screen 

Calculate Judgment Award Screen 

 

Maintain Dispositions 

Maintain Dispositions Overview  
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Introduction 

You can vacate and update the disposition status of a previously entered disposition. A disposition may 
be updated for a participant, filing or case. Based on security privileges, you may have the ability to 
update the case disposition status as well as the stage of the case.  

For Civil and Small Claims cases, the case disposition status as well as the stage of the case is needed 
for reporting to the Judicial Branch Statistical Information System (JBSIS). For Probate cases, the stage 
of the case at the time of entering the disposition and the disposition status of the initiating petition is also 
required for JBSIS reporting. Vacating and updating the disposition status can also cause an update to 
JBSIS information. 

Updating the Disposition Status 

A disposition sub-type is a further classification of a disposition. For example, you may have a judgment 
for a disposition but a summary judgment for the disposition sub-type. You can update the sub-type of 
disposition on the participant, the filing or the case. You have the ability to update to the sub-type of 
disposition but not the type of disposition.  

At the time of updating the disposition, you will also need to specify whether changing the disposition is 
required as a result of an Order or as a result of a clerical error. This information will be used when 
reporting to JBSIS. 

The system makes an entry in the Case History/Register of Actions indicating that the disposition has 
been updated.  

Vacating Dispositions 

You can vacate a disposition against a selected participant on the case. At the time of vacating the 
disposition, you will need to specify whether the change is being made as a result of an Order or as a 
result of a clerical error. If you request to vacate a disposition, then the system will associate a newly 
entered Case History/Register of Actions entry with the previous entry for the disposition you vacated.  

If you choose to vacate or set aside the disposition for selected case participants, then the system will 
update the status of the selected participants to "Active." Based on the updates to the participant status, 
the system updates the filing status from disposed (for Judgments / Dismissals) to "Active." The status will 
be set to "Active" only if the previous status was "Judgment/Dismissal." Based on the updates to the filing 
status, the system updates the case status from disposed (Judgment/Dismissal) to "Active." The status 
will be set to "Active" only if the previous status was "Judgment/Dismissal."  

Task Activities 

Maintaining dispositions includes the following task activities: 

• Maintain Case Disposition 
• Update Filing/Participant Disposition 
• Vacate Filing/Participant Disposition 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
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Related Links 

Maintain Disposition - Search Screen  

Maintain Disposition - Details Screen  

Enter Disposition - Confirmation Screen 

 

My Court Information 

 

Maintain Case Dispositions 

 

Introduction 

Based on security privileges, you may have the ability to update the case disposition status as well as the 
stage of the case.  

Task Activity 

Perform the following steps to maintain a disposition on a case. 
 

1. Select [Disposition] > [Maintain Disposition]. 
Result: The Maintain Disposition - Search screen displays. 

 
 

 

2. Enter the Case Number or Legacy Number for the Order on Petition search fields. 
3. Click the [Maintain Disposition] button. 

Result: The Maintain Disposition - Details screen displays. 
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4. Select the desired case disposition status from the case disposition status drop-down list.  
 You may specify if the update to the case disposition status is necessary due to clerical 

error by selecting the [Clerical Error] checkbox. This is necessary for reporting to the Judicial 
Branch Statistical Information System (JBSIS).  

 

5. Click the [Update Case Disposition Status] button.  
6. Result: The Maintain Disposition - Details screen displays with a confirmation message. 
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 You may change the disposition status of the case to "Active," even if all of the 
underlying filings on the case are disposed.  

 

 

Related Links 

Maintain Dispositions Overview 

Maintain Disposition - Search Screen 

Maintain Disposition - Details Screen 

 

My Court Information 

 

Update Filing/Participant Dispositions 

 

Introduction 

You can update the disposition type or sub-type on the participant, the filing or the case. You have the 
ability to update to the sub-type of disposition but not the type of disposition. At the time of updating the 
disposition, you will also need to specify whether changing the disposition is required as a result of an 
Order or as a result of a clerical error. This information will be used when reporting to JBSIS. 
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The system makes an entry in the Case History/Register of Actions indicating that the disposition has 
been updated.  

Task Activity 

Perform the following steps to maintain a disposition on a filing or participant in a case. 
 

1. Select [Disposition] > [Maintain Disposition]. 
Result: The Maintain Disposition - Search screen displays. 

 
 

 

2. Enter the Case Number or Legacy Number search fields. 
3. Click the [Maintain Disposition] button. 

Result: The Maintain Disposition - Details screen displays. 
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4. Select the checkbox for the filing document for which the disposition status will be updated.  
 You can select the toggle button to the right of the filing to see the disposition status of 

the associated participants.  

1. Result: The Maintain Disposition - Details screen displays with the filing participants visible under 
the selected filing. 
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 You may update or vacate the disposition status of all filings on the case by selecting the 
checkbox to the left of "Check All." If you are updating the disposition status of a filing and do 
not want to update the disposition status of case participants associated with a filing, skip to 
step 7. 

 

5. Select the checkbox for the filing participant for which the disposition status will be updated. 
6. Select the toggle button above the [Update Disposition Status] button to select the desired 

disposition status for the selected filing/participants. 
7. Click the [Update Disposition Status] button. 

Result: The Maintain Disposition - Details screen displays with a confirmation message. 
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Related Links 

Maintain Dispositions Overview 

Maintain Disposition - Search Screen 

Maintain Disposition - Details Screen 

 

My Court Information 

 

Vacate Filing/Participant Dispositions 

 

Introduction 

You can vacate a disposition for a selected participant on the case. At the time of vacating the disposition, 
you will need to specify whether the change is being made as a result of an Order or as a result of a 
clerical error. If you request to vacate a disposition, the system will associate a newly entered Case 
History/Register of Actions entry with the previous entry for the disposition you vacated.  
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If you choose to vacate or set aside the disposition for selected case participants, then the system will 
update the status of the selected participants to "Active." Based on the updates to the participant status, 
the system updates the filing status from disposed (for Judgments / Dismissals) to "Active." The status will 
be set to "Active" only if the previous status was "Judgment/Dismissal." Based on the updates to the filing 
status, the system updates the case status from disposed (Judgment/Dismissal) to "Active." The status 
will be set to "Active" only if the previous status was "Judgment/Dismissal."  

Task Activity 

Perform the following steps to maintain a disposition on a filing or participant in a case. 
 

1. Select [Disposition] > [Maintain Disposition]. 
Result: The Maintain Disposition - Search screen displays. 

 
 

 

2. Enter the Case Number or Legacy Number search fields. 
3. Click the [Maintain Disposition] button. 

Result: The Maintain Disposition - Details screen displays. 
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4. Select the checkbox for the filing document for which the disposition status will be vacated.  
 You can select the toggle button to the right of the filing to see the disposition status of 

the associated participants.  

1. Result: The Maintain Disposition - Details screen displays, with the filing participants visible under 
the selected filing. 
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 You may vacate the disposition status of all filings on the case by selecting the checkbox 
to the left of "Check All." If you are updating the disposition status of a filing and do not want to 
vacate the disposition status of case participants associated with a filing, skip to step 7. 

 

5. Select the checkbox for the filing participant for which the disposition status will be vacated. 
6. Select the toggle button above the [Update Disposition Status] button to select the desired 

disposition status for the selected filing/participants. 
7. Click the [Vacate Disposition Status] button. 

Result: The Maintain Disposition - Details screen displays with a confirmation message. 
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Related Links 

Maintain Dispositions Overview 

Maintain Disposition - Search Screen 

Maintain Disposition - Details Screen 

 

Record Order on Petition 

Record Order on Petition Overview  

 

Introduction 

You can enter information related to the granting, denying, dismissing or taking a petition off a calendar 
within the system. The order to grant or deny a petition might be entered as a result of a filing or as a part 
of a Minute. Granting, denying or dismissing a petition will update the disposition status of the petition, 
and in some scenarios, close the case. 
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Depending on the business process of the court, you might use the minute codes to grant or deny 
petitions when recording minutes. For these scenarios, the signed Minute or the Order after Hearing will 
be deemed the order of the court. 

Otherwise, you might only make text entries in the minutes to indicate that the petition has been granted. 
In this case, the formal order will be received by the court as a filing. Once the filing is submitted, you will 
enter the order on the petition by selecting the applicable petition for the case. 

The system determines if the petition is dispositive (for civil cases) or if the petition is the initiating 
document (for probate cases). In civil cases, the system will update the disposition status of the selected 
petition to disposed. In probate cases, the system will update the role of the participants based on the 
order (such as when petition for guardianship is granted, the role of a proposed guardian may be 
changed to Guardian).  

The system also determines and maintains the stage of the case at the time of the disposition for the 
petition. For probate cases, the disposition on the initial petition will be reported to Judicial Branch 
Statistical Information System (JBSIS). If a petition is disposed, then a Case History entry will be created 
to indicate this information. If the case closes as a result of the order on petition, then an entry will be 
written in the Case History/Register of Actions to indicate that the case has been closed.  

Granting and Denying Petitions that Close a Case 

In civil cases, the system determines whether there are any other filings on the case. If this petition was 
the only non-disposed filing on the case, the system will also update the disposition status of the case. 
Additionally, the case status is updated to reflect that the case has been disposed. The system also 
determines and maintains the stage of the case at the time of the disposition of the case.  

For probate cases, you may select to grant or deny a petition. You will have the ability to specify whether 
the order on the petition also closes the case. If you choose to close the case, you must also specify the 
reason for closing the case. The applicable reasons for closing a probate case include: 

• Change of venue 
• Approval of final distribution 
• Approval of no assets 
• Order terminating Conservatorship 
• Order terminating Guardianship 
• Approval of final accounting with no successor appointed 
• Operation of Law (Person Only).  

 

 

If the system determines that the order on the petition closes the case, it will update the status of the case 
to closed. At the time of closing the case, the system will also check if there are any outstanding petitions 
on the case. If so, the system will generate a message stating that the case cannot be closed.  

Order to Grant/Deny: List of Associated Petitions 

Based on the type of petition filed by the case participant, you will be navigated to the Grant/Deny Order 
on Petition screen, where you may grant, deny, dismiss or take an order of calendar. The following is a 
list of petition types that may be filed by a participant. 
 

• Compromise - Judgment 
• Decree Changing Name 
• Decree Changing Name (Change of 

• Order for Final Discharge 
• Order for Probate 
• Order for Reappointment of Conservator 
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Name of Minor by Guardian) 
• Decree Changing Name and Gender 
• Ex Parte Application for Order Declaring 

Information on Affidavit of Voter 
Registration Confidential, Declaration, 
Points and Authorities, Order 

• Order After Hearing on Petition for 
Injunction Prohibiting Harassment 
(CLETS) 

• Order After Hearing on Petition of 
Employer for Injunction Prohibiting 
Violence or Threats of Violence Against 
Employee (CLETS) (Workplace 
Violence) 

• Order Appointing Guardian of Minor 
• Order Appointing Probate Conservator 
• Order Appointing Temporary Guardian or 

Conservator 
• Order Approving Compromise of Minor's 

Claim 
• Order Authorizing Conservator to Give 

Consent for Medical Treatment 
• Order Determining Entitlement to 

Distribution 
• Order Determining Petition Does Not 

Violate No Contest Clause 
• Order for Preliminary Distribution 
• Order Fixing Residence Outside the 

State of California 

• Order Granting Vexatious Litigant 
Permission to Proceed 

• Order on Final Accounting 
• Order on Status of Administration 
• Order on Waiver of Accounting 
• Order on Final Distribution 
• Order on Writ of Mandate 
• Order Removing Trust from Continuing 

Court Jurisdiction 
• Order Removing Trustee 
• Order Settling Current Account of 

Guardian/Conservator  
• Order Terminating Guardianship 
• Order Terminating Trust 
• Order Terminating Proceedings   
• Order to Deposit Money into Blocked 

Acct. 
• Orders to Increase Bond 
• Out of County Abstract 
• Permanent Injunction 
• Tax Collector - Rev and Tax Code (RTC) 

 

Dismissing Petitions 

A dismissal might be entered as a result of a filing (request for dismissal), or as a part of a Minute 
(dismissals entered by the court's own motion). Unlike judgments, dismissals are entered at the same 
time as they are recorded. When entering a dismissal for an order on a petition, the system will validate 
that the dismissal cannot be granted due to anyone of the following business rules: 

• For probate cases - a case initiating petition and petitions required by statute cannot be 
dismissed.  

• If the petition has been granted/denied, then a dismissal cannot be recorded against this petition. 
• If there are fees with balance due against a participant on a petition, then a dismissal should not 

be entered against this petition.  
 

 

Depending on the type of petition being dismissed, you will have the ability to specify the list of forms (if 
any) to be generated.  

Task Activities 

Recording an Order on Petition includes the following task activities: 

• Search Order on Petition 
• Record Order on Petition 
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Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Record Order on Petition - Search Screen  

Record Order on Petition Screen  

 

My Court Information 

 

Search Order on Petition 

 

Introduction 

This activity allows you to search for an order on petition. Refer to the Search Feature Overview for 
details on performing a search in the system. 

The search function also provides the foundation for maintaining order on petition information. For 
example, you must perform this search in order to grant, deny, dismiss or take an order on petition off a 
calendar.  

Task Activity 

Perform the following steps to search for an Order on Petition. 
 

1. Select [Disposition] > [Record Order on Petition]. 
Result: The Record Order on Petition - Search screen displays. 
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2. Enter a Case Number or Legacy Number in the appropriate search fields. 
3. Click the [Search] button. 

Result: The Record Order on Petition - Search screen refreshes with the Search Results. 
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Related Links 

Record Order on Petition Overview 

Record Order on Petition - Search Screen 

 

My Court Information 

 

Record Order on Petition 

 

Introduction 

You can enter information related to the granting, denying, dismissing or taking a petition off calendar 
within the system. The order to grant or deny a petition can be entered as a result of a filing or as a part of 
Minutes. Granting, denying or dismissing a petition will update the disposition status of the petition, and in 
some scenarios, close the case. 

Before Granting or Denying an Order on Petition 

This activity takes place within the context of a case. It is assumed that you have performed one of the 
following activities before granting, denying, dismissing or taking the petition off calendar: 

• Filed a petition in the system based on the list of petitions provided in the Record Order on 
Petition section. Filing one of these petition types will navigate you to the Order on Petition details 
screen.  

• Performed an Order on Petition search and selected the petition on which to update. Refer to the 
Search Order on Petition task activity for details on this process. 

Task Activity 

Perform the following steps to grant/deny an Order on Petition. 
 

1. Select the radio button for the petition you want to record an order. 
 This selection occurs from the search results of the Record Order on Petition - Search 

screen.  
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2. Click the [Record Order] button. 
Result: The Record Order on Petition screen displays. 
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3. Select the radio button for one of the following options: 

• Granted 
• Denied 
• Dismissed 
• Taken off Calendar 

 If entering an order on a petition in a probate case, you will also be able to select a 
checkbox in order to close the case, and specify the reason for closing the case. 

4. Click the [Save] button. 
Result: The Record Order on Petition - Search screen displays with a confirmation message. 

 
 

 

 

 

Related Links 

Record Order on Petition Overview 

Record Order on Petition - Search Screen 

Record Order on Petition Screen 
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Request to Pay Judgment to Court 

Request to Pay Judgment to Court Overview  

 

Introduction 

If a judgment is awarded to the plaintiff in a Small Claims case, then the defendant may make a request 
to pay the total judgment amount due for the award directly to the court. This request will be entered into 
the system when the defendant files the "Request to Pay Judgment to Court (SC145)" filing with the court. 
Once you indicate that this filing has been received, you will be automatically navigated to the 
View/Amend judgment screen where you can record the judgment amount on the selected award as 
payable to court. You can be navigated directly to the Record Payment screen in order to record payment 
for the amount payable to court. 

Judgment Satisfactions 

When recording payment for an award that is payable to the court, the system may update the status of 
the associated judgment award to "Fully Satisfied" based on the payment method. If the payor pays the 
amount of the award with a payment method other than check, then the selected judgment award is 
updated to "Fully Satisfied" when the payment transaction is complete.  

If the payment method used to record payment for the judgment award is a check, then the system will 
not update the judgment award status to "Fully Satisfied." However, a batch job will be run nightly to 
determine if the status of the judgment needs to be updated. If the check was not returned, the system 
will update the status of the corresponding judgment award to "Fully Satisfied" on the 31st day after the 
payment was posted. The system will also generate the Certificate of Satisfaction of Judgment form and 
send it to a work queue for printing. If the check is returned within 30 days of posting the payment, the 
system will void the payment and the fee for the judgment award will revert to a status of "Due."  

Refer to the Maintain Judgment Satisfaction section for more information regarding the satisfaction of 
judgments. 

Warrants 

The system will verify whether there are any warrants with a status of "issued" against the judgment 
debtor. If there are any warrants with this status, then the system will flag those warrants for recall. Refer 
to the Maintain Warrants section for more information on how to recall warrants.  

Task Activities 

Requesting to pay judgment to the Court includes the following task activity: 

• Request to Pay Judgment to Court 
Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 
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Related Links 

View/Amend Judgment Screen  

Calculate Judgment Award Screen 

Pay Judgment Award to Court Screen 

 

My Court Information 

 

Request to Pay Judgment to Court 

 

Introduction 

If a judgment is awarded to the plaintiff in a Small Claims case, then the defendant may make a request 
to pay the total judgment amount due for the award directly to the court. This request will be entered into 
the system when the defendant files the "Request to Pay Judgment to Court (SC145)" filing with the court. 
Once you indicate that this filing has been received, you will be automatically navigated to the 
View/Amend judgment screen where you can record the judgment amount on the selected award as 
payable to court. You can be navigated directly to the Record Payment screen in order to record payment 
for the amount payable to court. 

Before Paying Judgment to Court 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected a case for which to enter the request to pay judgment to court. Refer to the Search 
Cases task activity for details on performing a case search. 

Task Activity 

Perform the following steps to mark a judgment award as payable to the court. 
 

1. Select [Case] > [Add Filing]. 
Result: The Add Filing screen displays. 
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2. Enter/Select data for the following required fields: 

• Filing Type 
• Filing Date 
• Filing Document (select "Request to Pay Judgment to Court") 
• Filing Status 

 You must enter "Request to Pay Judgment to Court" for the filing document name in 
order to be navigated to the View/Amend Judgment screen. Refer to the Maintain Case Filings 
section for details on adding a filing to a case. 

3. Click the [Save] button. 
Result: The View /Amend Judgment screen displays. 
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4. Select the toggle button next to the judgment associated to the award you want to make payable 
to the court. 
Result: The View /Amend Judgment screen displays with an expanded view of a judgment on the 
selected case. 
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5. Click the [Total Amount] link. 
Result: The Calculate Judgment Award screen displays. 
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6. Click the [Pay Judgment Award to Court] button. 
Result: The Pay Judgment Award to Court screen displays. 
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7. Enter/Update the available fields as needed. 
8. Click the [Save] button. 

Result: The Calculate Judgment Award screen displays with a confirmation message. 
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 The Record Payment screen appears when selecting the [Save] button on this screen. 
Refer to the Record Payment task activity for details on recording payments. 
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Related Links 

Request to Pay Judgment to Court Overview 

Add Filing Screen 

View/Amend Judgment Screen 

Calculate Judgment Award Screen 

Pay Judgment Award to Court Screen 

 

Maintain Judgment Satisfaction 

Maintain Judgment Satisfaction Overview  

 

Introduction 

You can enter or update the status of a judgment award. This process may update the status of a 
judgment or the status of a case based on the satisfaction of all judgments within that case. A case may 
contain one or multiple judgments, based on the number of dispositive filings in the case (such as the 
number of complaints and cross complaints, etc.). Each judgment may contain multiple awards (such as 
an award for one or multiple plaintiffs and defendants for a judgment).  

The status of a judgment is maintained at the judgment award level, at the judgment level and at the case 
level. The status of a judgment can be: (1) Fully Satisfied, (2) Partially Satisfied or (3) Unsatisfied.  

Satisfied Judgments 

Updating a judgment award status to "Fully Satisfied" means that the judgment debtor has paid the 
judgment creditor required monies or has performed required duties as ordered by the court within the 
judgment.  

If all awards on a judgment have a status of "Fully Satisfied," then the status of that Judgment will be 
updated to "Fully Satisfied." If all of the judgments on a case have a status of "Fully Satisfied" and the 
case has a disposition status of "Judgment" (for instance, all dispositive filings on the case have been 
disposed), then the status of the case will be "Judgment Satisfied." 

The judgment award status may be updated automatically to "Judgment Satisfied" based on a case 
participant's request to pay judgment to court. This can occur if the case participant files a "Request to 
Pay Judgment to Court," and then pays the award in full.  

Additionally, you may update the case disposition status to "Judgment Satisfied" even if all judgments on 
the case have not been satisfied. This is useful in complex or large cases in which many judgments may 
occur on the case requiring satisfaction, and the case needs to be disposed quickly.  

Unsatisfied Judgments 

A judgment award status is "Unsatisfied" until the judgment debtor has paid the judgment creditor 
required monies or has performed required duties as stipulated by the court. A judgment will retain a 
status of "Unsatisfied" until all related judgment awards have been satisfied. A case's disposition status 
will remain as "Unsatisfied" until all judgments on the case have been satisfied, or until the case 
disposition status is manually updated to "Judgment Satisfied."  
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Updating a judgment award status from "Fully Satisfied" to "Unsatisfied" may cause the judgment level 
status to change to "Unsatisfied" if the current status of the judgment is "Judgment Satisfied."  

If the judgment status is updated to "Unsatisfied," then the case status will change back to the previous 
case status if the case status is currently "Judgment Satisfied." 

Partially Satisfied Judgments 

A judgment award status can be updated to "Partially Satisfied" if the judgment debtor has paid the 
judgment creditor part of the required monies or has performed some of the required duties as stipulated 
by the court. A judgment will remain in a status of "Unsatisfied" until all related judgment awards have 
been fully satisfied. 

Updating a judgment award status from "Fully Satisfied" to "Partially Satisfied" will cause the judgment 
status to change to "Unsatisfied" if the current status of the judgment is "Judgment Satisfied." If the 
judgment status is updated to "Unsatisfied," then the case status will change back to the previous status if 
the case status is currently "Judgment Satisfied." 

Conditions for Updating Judgment Status 

The judgment status of an award will be updated in the following situations-  

• If a writ is returned as "Fully Satisfied," then the status of the applicable judgment awards will be 
updated to "Fully Satisfied." If the writ is returned "Partially Satisfied," then the status of the 
applicable judgment awards will be updated to "Partially Satisfied." If the writ is returned 
"Unsatisfied" then the status of the applicable judgment awards will be updated to "Unsatisfied."  

• If a "Request to Pay Judgment to Court" is entered successfully (and the corresponding payment 
to court is good), then the status of the applicable judgment award is updated to "Fully Satisfied." 
Refer to the Request to Pay Judgment to Court section for details on paying a judgment to the 
court. 

• If an Acknowledgement of Satisfaction of Judgment (either in full or partial) has been filed, then 
the status of the applicable judgment awards are updated appropriately to either "Fully Satisfied" 
or "Partially Satisfied." 

• If a Clerk's Certificate of Satisfaction of Judgment is issued, then the status of the applicable 
judgment award is updated to "Fully Satisfied." 

 

 

The judgment award status can be updated as a result of a successful filing of an Acknowledgement of 
Satisfaction of Judgment or issuance of a Clerk's Certificate of Satisfaction of Judgment. The judgment 
award status may also be updated as a result of a returned writ. Depending on whether the writ is 
returned Fully Satisfied, Partially Satisfied, or Unsatisfied the status of the applicable judgment award will 
be updated to "Fully Satisfied," "Partially Satisfied," or "Unsatisfied," appropriately. 

Task Activities 

Maintaining judgment satisfaction includes the following task activity: 

• Maintain Judgment Satisfaction 
Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
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Related Links 

View/Amend Judgment - Search Screen  

View/Amend Judgment Screen  

 

My Court Information 

 

Maintain Judgment Satisfaction 

 

Introduction 

You may enter or update the status of a judgment award, which in turn will update the status of a 
judgment, or the status of a case based on the satisfaction of all judgments within that case. A case may 
contain one or multiple judgments, based on the number of dispositive filings in the case, (i.e. the number 
of complaints and cross complaints, etc.). Each judgment may contain multiple awards (e.g. an award for 
one or multiple plaintiffs and defendants for a judgment).  

The status of a judgment is maintained at the judgment award level, at the judgment level and at the case 
level. The judgment status can be: (1) Fully Satisfied, (2) Partially Satisfied or (3) Unsatisfied.  

Task Activity 

Perform the following steps to maintain a judgment satisfaction. 
 

1. Select [Disposition] > [View/Amend Judgment]. 
Result: The View/Amend Judgment - Search screen displays. 
 
 

 

2. Click the [View Summary] button. 
Result: The View/Amend Judgment screen displays. 
 
 

 

3. Select the toggle button next to the judgment associated with the award for which you want to 
update the status to "Fully Satisfied," "Partially Satisfied," or "Unsatisfied."  
Result: The View/Amend Judgment screen displays, with an expanded view of a judgment on the 
selected case. 
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4. Select the appropriate judgment and judgment award status from the Judgment Satisfied drop-
down list. 

5. Click the [Amend Judgment] button. 
Result: The View/Amend Judgment screen displays with a confirmation message. 
 
 

 

 

 

Related Links 

Maintain Judgment Satisfaction Overview 

View/Amend Judgment - Search Screen 

View/Amend Judgment Screen 

 

Dismiss Complaints/Cross-Complaints 

Dismiss Complaints/Cross-Complaints Overview  

 

Introduction 

You can dismiss a case participant, party, filing or entire case within the system. You can also dismiss 
filings that are petitions, or dispositive filings such as Complaints and Cross-Complaints. Refer to the 
Record Order on Petition task activity for details on dismissing a petition. 

When entering a dismissal, you can generate the Dismissal Form, which notifies the case participants of 
the dismissal entered on the case. The dismissal might be entered as a result of a filing (request for 
dismissal), or as a part of Minutes (dismissals entered on the court's own motion or resulting from the 
granting of a dispositive motion). When entering a dismissal, the following rules must be satisfied: 

• There is no outstanding Bench Warrant for the selected case participant  
• There is no Motion for Transfer pending on the case 
• There is no Judgment entered fully disposing the case 
• The case has not been transferred out of County or reclassified to another Court 
• Class action cases cannot be dismissed without a Court Order 
• There are no pending appeals on the case 
• There is no Stay Order on the case 

 

 

If the applicable court rules have not been satisfied, then the system will display a warning message 
indicating why the dismissal cannot be entered. You can determine whether the warning message should 
be overridden in order to continue with entering the dismissal information.  

When entering a dismissal at the case, filing or participant level, the information regarding the disposition 
is recorded and made available to the Judicial Branch Statistical Information System (JBSIS). 
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Dismissing Cases 

The system updates the disposition status of the case based on the disposition status of all dispositve 
filings on the case. This status will be automatically calculated based on the highest disposition status (by 
JBSIS hierarchy) of the filings associated with the case. The system also determines and maintains the 
stage of the case at the time of its disposition. The case status is also updated to reflect that the case has 
been disposed. 

If a case is disposed, an entry will be written in the Case History/ROA to indicate that the case has been 
disposed with a disposition status calculated based on the JBSIS hierarchy. The following table defines 
how the status of a case is updated when the case disposition status is updated: 
 

 

 

Case Category Case Disposition Status Case Status 

Limited and Unlimited Civil  Judgment Post Judgment 

Limited and Unlimited Civil  Dismissal Dismissed 

Small Claims Judgment Judgment Enforcement Stayed 

Small Claims Dismissal Dismissed 

 

In addition, you have the option to dispose the case but skip the dismissal of all of the flings on the case. 
Refer to the Maintain Dispositions section for details on directly updating the case disposition status for a 
selected case. 

Dismissing Filings 

Based on the case category and type, you can also enter the dismissal at the filing level. Dismissing the 
filling automatically updates the status of all participants associated to the filing to "Dismissed". If the filing 
is the last dispositive filing on the case without a status of "Dismissed", when the status of that filing is 
updated to "Dismissed" the case disposition status will be updated to "Dismissed" as well.  

In Limited and Unlimited Civil cases, you can only enter a dismissal for filings that are petitions. For all 
other dispositive types of filings (such as complaints and cross-complaints), you must first dismiss all of 
the participants on the filing, which will update the filing disposition status automatically. In Probate cases, 
you can only dismiss filings. The following filings are classified as either Complaints or Cross-Complaints: 
 

• Appeal on the Award of Labor 
Commissioner 

• Application for Entry of Judgment on 
Sister-State Judgment 

• Complaint 
• Complaint - Amended  
• Complaint in Interpleader 
• Complaint in Intervention 
• Confession of Judgment 

• Cross Complaint - Amended  
• Cross-Complaint 
• EDD State Judgments 
• Out of County Abstract 
• Request for and Entry of Labor Board 

Judgment 
• Summary Judgment on Bail Bond Forfeiture 
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If a filing is disposed, then the Case History entry will indicate that the filing has been disposed with a 
disposition status calculated based on the JBSIS hierarchy. If any filing on a case has already been 
disposed, and you want to dismiss the filing, you must first vacate the disposition on the filing before 
entering the dismissal.  

Dismissing Case Participants 

When dismissing case participants from a filing, the system will update the status of these case 
participants as "Dismissed" for the selected case. If all case participants associated with the Complaint or 
Cross-Complaint are dismissed from the case, then the filing disposition status is updated to "Dismissed" 
as well.  

When multiple participants associated with a filing each have different statuses, the status of the 
associated filing will be automatically calculated based on the highest disposition status (as determined 
by JBSIS hierarchy) of the participants associated with the filing. 

If a participant is dismissed from a filing on a case, then the Case History Entry will indicate that the 
participant has been disposed with a status of "Dismissed." 

If you are working within a Small Claims case, you can only dismiss participants and will not have the 
ability to directly dismiss the associated filing.  

Task Activities 

Dismissing complaints/cross-complaints includes the following task activities: 

• Dismiss Complaints/Cross-Complaints 
Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Maintain Disposition - Search Screen  

Enter Dismissal Screen  

Record/Enter Disposition - Search Screen 

 

My Court Information 

 

Dismiss Complaints/Cross-Complaints 
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Introduction 

You can dismiss a case participant, party, filing or entire case within the system. You may dismiss filings 
that are petitions or dispositive filings such as complaints and cross-complaints. When entering a 
dismissal at the case, filing or participant level, the information regarding the disposition is recorded and 
made available to the Judicial Branch Statistical Information System (JBSIS).  

Based on the business rules for entering a dismissal on a case, you may or may not be able to enter the 
dismissal at the case, filing, party or participant level. Refer to the Dismiss Complaints/Cross-Complaints 
section for details on entering a dismissal for cases, filings and participants. 

Before Dismissing a Case Participant or Filing 

Filing one of the following documents will navigate you directly to the enter dismissal screen: 

• Request for Dismissal with Prejudice - Entire Action 
• Request for Dismissal with Prejudice - Party 
• Request for Dismissal without Prejudice - Entire Action 
• Request for Dismissal without Prejudice - Party 

Task Activity 

Perform the following steps to dismiss a complaint or cross-complaint. 
 

1. Select [Disposition] > [Record/Enter Disposition]. 
Result: The Record/Enter Disposition - Search screen displays. 
 
 

 

2. Enter/Select data for the following required fields: 

• Case Number 
• Type of Disposition 
 You must select "Dismissal" for the Type of Disposition value in order to enter a dismissal on 
the case. 

3. Click the [Record Disposition] button. 
Result: The Enter Dismissal screen displays. 
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4. Enter/Select data for the following required fields: 

• Sub-Type of Disposition 
• With Prejudice / Without Prejudice 
• Date Entered 

 You may dismiss the case by selecting the checkbox to the left of "Check All," which 
dismisses all dispositive filings and all associated case participants on the case. If you are 
dismissing a filing and do not want to enter the dismissal at the party or participant level, skip 
to step 8. 

5. Select the checkbox for the filing to be dismissed.  
 You may select the toggle button to the right of the filing to see the associated parties. If 

you choose to dismiss a filing, all case participants associated with the filing will be dismissed. 

6. Result: The Enter Dismissal screen refreshes with the parties visible under the selected filing. 
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6. Select the checkbox for the party to be dismissed. 
 You may select the [dropdown arrow] to the right of the case participants to see the 

associated participants for each party. 

7. Result: The Enter Dismissal screen displays, with the parties visible under the selected filing. 
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7. Select the [Checkbox] to the left of the case participants to be dismissed. 
8. Click the [Enter Dismissal] button. 

Result: The Record/Enter Disposition - Search screen displays with a confirmation message.  
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Related Links 

Dismiss Complaints/Cross-Complaints Overview 

Record/Enter Disposition - Search Screen 

Enter Dismissal Screen 
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The Judicial Officers Section 

Chamber View 

Chamber View Overview  

 

Introduction 

The chamber view allow you to easily access calendars for a specific place and time, as well as your "To 
Do" items and Reports that are applicable to your court. From the chamber view, you can select a specific 
calendar, access event details within the calendar, and view case details for each scheduled event.  

Selecting Reports 

Based on your court's configuration, a predefined set of reports are available to you. These reports may 
be generated at any point in time. Reports may require input parameters such as dates, departments, etc. 
In this case, you will be navigated to the reporting screen where you can enter this information before 
generating the report. 

Selecting "To Do" Items 

The chamber view provides easy access to view your "To-Do" items, such as reviewing proposed orders, 
tentative rulings or cases under submission, as well as displaying statistics on what items have never 
been viewed before and pending items. 

Viewing the Monthly Calendar 

You can also view your calendar for current, previous or future months. This is helpful for planning time 
for personal calendars, determining workload, and viewing what will be occurring on your calendar for 
future weeks. You can select a specific day from the month calendar to drill-down to the specific 
calendars and events to be called on that day. The monthly calendar view allows you to see the number 
of events scheduled and allotted at specific points during each day. 

Events Listing 

The events listing allows you to view event details for a specific calendar. You will see calendar type 
information, such as Case Management Conference Calendar, Probate Calendar, Trial Calendar, etc. 
You can also view information regarding specific events within the calendar, such as the case number 
and title, the event name and an indicator as to whether or not you have previously viewed any probate 
notes or tentative rulings associated with the event.  

Selecting the Case Number link from the Events Listing will allow you to access the contents of a case. 
Once in the "context" of a case, you can view summary information regarding the case, as well as: 

• Blocked Accounts 
• Future Events on the Case 
• Case Associations and Consolidations 
• Case Notes 
• Case Participants 
• Case Documents 
• Exhibits and Subpoenaed Records 
• Filings 
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• Register of Actions 
 

 

Based on the case category of Probate, Civil or Small Claims, selecting the Event Link from the Events 
Listing will allow you to access any tentative rulings (for Civil cases) or probate notes (for Probate Cases), 
or the Case Summary (for Small Claims cases) associated with the event. Once you have reviewed the 
probate notes/tentative rulings, you may mark as "Viewed." The "Viewed" indicator in the Events Listing 
provides a way to filter events that have already been viewed during the course of a calendar. 

You may also filter the hearings displayed within the Events Listing based on other criteria as well, such 
as the Pre-Hearing status, the Request Status or the Calendar Number.  

Pre-Hearing Status 

The pre-hearing status will differ based on the case category, since probate cases, small claims and civil 
cases each have their own set of pre-hearing statuses. The following is a list of pre-hearing statuses by 
case category and a brief description: 

• Probate Cases: A Probate Examiner will select the pre-hearing status for probate cases prior to 
submitting the probate notes for your review. Probate Event Recommendations include: 

o Pre-Approved 
o Must Be Heard 
o Call and Grant 
o Review Complete 

 

• Civil Cases: The pre-hearing status options for Limited and Unlimited Civil cases are based on 
whether a tentative ruling exists for the case event. If a tentative ruling exists, then the tentative 
ruling available will display in the pre-hearing status. Otherwise, this column will be blank. 

o Ready - A "Ready" status means that all required parties are checked in and the 
hearing is ready to be called. 

o Submitted on Tentative - A status of "Submitted on Tentative" means that the 
attorneys for the case participants have agreed to the tentative ruling. The hearing 
may be called, but there are no anticipated objections to be heard in open court. 

o No Appearance - A "No Appearance" status means that one or multiple required 
case participants are not present for the hearing. 

 

• Small Claims Cases: The pre-hearing status options are for Small Claims cases are determined 
based on whether or not a Proof of Service has been filed with the court. If any Proof of Service 
has been filed for the event, then "Proof of Service Filed" will display for the pre-hearing status. If 
no "Proof of Service" has been filed with the court, then the pre-hearing status will be blank.  

Request Status 

The request status refers to any requests made by the case participant. The request status is determined 
by the Courtroom Clerk during the Check-In process through the Minutes. The following is a list of request 
statuses and a brief description:  
 

• Request for Priority: A case participant may make a request for priority, so that their hearing 
may be called earlier in the calendar. 

• No Appearance: The clerk may specify "No Appearance" for the request status if one or more 
case participants are not present for their hearing.  

• Request for Second Call: A case participant may make a request for a second call if they wish 
to have their hearing called at the end of the calendar. 
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Task Activities 

The Chamber View Overview includes the following task activities: 

• View Reports from the Chamber View 
• View "To Do" Items from the Chamber View 
• View Calendars within the Chamber View 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Chamber View - Day View Screen  

Chamber View - Month View Screen  

 

 

My Court Information 

 

View Reports from the Chamber View 

 

Introduction 

You can view reports which have been designated by your court as relative to all Judicial Officers from 
the reports section of the Chamber View.  

Task Activity 

Perform the following steps to view reports from the chamber view. 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 
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2. Click the [Report Name] link. 
Result: The desired report appears in a new window.  

 You have access to a predefined set of reports based on your court's configuration. To 
see all reports available to your court, select the [Reports] menu link in the top menu bar. 

 

 

Related Links 

Chamber View Overview 

Chamber View - Calendar: Day View Screen 

 

My Court Information 

 

View "To Do" Items from the Chamber View 

 

Introduction 

The "To-Do" list is a collection of different categories of tasks (i.e. Work Queue items) that require you to 
take action to complete a given task. Judicial Officer "To-Do" lists may include activities for reviewing and 
signing proposed orders, tentative rulings, probate notes, cases under submission, etc. 
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Task Activity 

Perform the following steps to view an item from the "To Do" list. 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the ["To Do" List Item] link. 
Result: The desired report appears in a new window.  

 You have access to a predefined set of "To Do" lists based on your personal setup in the 
system. 

 The "To Do" list displays statistics on pending items and which items have never been 
viewed.  

 

 

Related Links 

Chamber View Overview 

Chamber View - Calendar: Day View Screen 

 

My Court Information 
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View Calendars within the Chamber View 

 

Introduction 

The chamber view provides you with the ability to see your calendar, which will display the current day's 
events.  

Task Activity 

Perform the following steps to view calendars from the chamber view. 
 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the [Calendar Name] link. 
Result: The Chamber View screen displays with an expanded view of the selected calendar. 
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 You can also view calendars for different dates. To view the calendar for a different date, 
select the link for the desired day from the Month Calendar in the top-right corner of the 
screen. 

 In addition, you can select to see a month view of the calendar by clicking the [Month] 
link. 
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Related Links 

Chamber View Overview 

Chamber View - Calendar: Day View Screen 

Chamber View - Calendar: Month View Screen 

 

Review Judicial To-Do List 

Review Judicial To Do List Overview  

 

Introduction 

You can access "To Do" items based on the configuration of your court and your court's procedures. 
These "To Do" items relate to many activities, such as reviewing orders, probate notes or tentative 
rulings, etc. The chamber view provides easy access to these items and displays statistics on what items 
are new and pending (pending items may have been previously viewed but not completed). The following 
are descriptions for types of To Do items that you can access as a Judicial Officer. 

Proposed Orders / Orders for e-Signature 

Based on the procedures of your court, Proposed Orders may be sent to you for review, approval and e-
signature at the request of the Courtroom Clerk. When the request is made, an item is added to your To 
Do list. You may access proposed orders requiring your input from the To-Do list. While reviewing a 
proposed order, you can enter instructions for the clerk or notes that you can refer to at any time. You can 
also choose to approve the order or to remit the order back to the Courtroom Clerk for further action. The 
following is a list of instructions you can select to provide the Courtroom Clerk with instructions for further 
action: 

• Approved, Approved with Electronic Signature or Further Action Required - The clerk may 
send you a proposed order with a status of "Send Minutes for Judicial Review." If the minutes 
were created using codes or text, then the text translation will be presented to you in a read-only 
format. In this case, you can indicate any necessary changes in the Judicial Officer notes section 
of the proposed order.  

When you are finished reviewing the minutes, you can select to approve the minutes (with or 
without an electronic signature) or send them back to the clerk for additional updates. Based 
on your selection, the proposed order will be sent back to the submitting clerk with instructions 
to approve or modify the order. If you select to approve the order with an electronic signature, 
then your signature will appear on the court order when the form is generated. 

 

• Add e-Signature - The clerk may send you a proposed order with a status of "Send Minutes for 
Judicial Officer Electronic Signature". These orders will appear in a separate To Do list, 
specifically designed for orders that only require an electronic signature. You may choose a 
Minute from your To Do list and select generate an electronic signature.  

When you select the option to attach an electronic signature to a proposed order, the form for 
the order will be created and a Case History entry is generated for the associated order. 
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Probate Notes 

Based on your court's procedures, a Probate Examiner within your court may send you Probate Notes for 
review. These probate notes are also available to you associated with a case event based on a finalized 
Court Calendar. At any time before the associated hearing, a Probate Examiner may send probate notes 
to you for your review. When this action occurs, a new task will appear in your To Do items for reviewing 
probate notes.  

While reviewing probate notes, you can perform one of the following actions:  
 

• Save - While reviewing the probate notes, you may choose to add additional notes that you may 
refer to during the hearing. If you create any Judicial notes corresponding to the probate notes, 
you must save the notes before exiting the screen. Any changes or additions to probate notes 
become part of the public record.  

• Mark as Viewed - While reviewing a series of probate notes within a finalized calendar, marking 
the note as "Viewed" will update an indicator on the note that it has been viewed in preparation 
for the hearing. This is useful if you wish to view which probate notes have and have not been 
reviewed for a finalized calendar. 

 

• Available for Posting - You can choose to make the probate notes available for posting to the 
internet or other external systems. If you select this option, the probate notes are finalized in an 
Adobe PDF format and a Case History entry is created associated to the generated document. 

Tentative Rulings 

Based on your court's procedures, a Research Attorney within your court may send you Tentative Rulings 
for review. When the Research Attorney requests that you review a tentative ruling, an item is added to 
your To Do list. You may access tentative rulings requiring your input from the To-Do list. While reviewing 
a tentative ruling, you may enter instructions for the Research Attorney or notes you can refer to at any 
time. You may also choose to remit the order back to the Research Attorney for follow-up work. The 
following is a list of instructions you can select to provide the Research Attorney with instructions for 
further action: 

• Further Action Required - If a Research Attorney sends you a tentative ruling with a status of 
"Send TR for Judicial Review," the tentative ruling will be available in your "To Do" item list. If the 
ruling was created using text or codes, the text translation will be presented to you in a read-only 
format. You can indicate any changes necessary on either the Research Text or Judicial Officer 
Notes sections of the tentative ruling.  

When you are finished reviewing the tentative ruling, you can send them back to the Research 
Attorney for additional changes by selecting the "Further Action Required" option.  

 

• Available for Posting - You can make the tentative ruling available for posting to the Internet or 
other external systems. If you select this option, the tentative rulings are finalized in an Adobe 
PDF format and a Case History entry is created associated to the generated document 

Cases Under Submission 

When hearing a matter on a case, you can choose to take the matter under submission. In the event that 
this occurs, the Courtroom Clerk will indicate that the matter has been taken under submission, and a 
task will appear in your "Review Cases Under Submission" To Do list.  

The "Review Cases Under Submission" To Do list provides you with a list of matters currently under 
submission for each of your cases. This list of cases under submission provides you with the name of 
each matter under submission, the date the matter was taken under submission and the number of days 
that have elapsed since the matter was taken under submission.  
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A task will be removed from your "Review Cases Under Submission" To Do list if a Minute is generated 
removing the matter from under submission. 

Task Activities 

Reviewing the Judicial To Do List includes the following task activities: 

• Review Probate Notes 
• Review Tentative Rulings 
• Review Proposed Orders 
• Review Orders for e-Signature 
• Review Cases Under Submission 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Chamber View - Calendar: Day View Screen 

Chamber View - Calendar: Month View Screen 

Judicial Notes on Probate Notes Screen  

Judicial Notes on Proposed Order Screen  

Judicial Notes on Tentative Rulings Screen  

 

My Court Information 

 

Review Probate Notes 

 

Introduction 

Based on your court's procedures, a Probate Investigator within your court may send you Probate Notes 
for review. These probate notes are also available to you associated with a case event based on a 
finalized Court Calendar. At any time before the associated hearing, a Probate Investigator may send 
probate notes to you for your review. When this action occurs, a new task will appear in your To Do items 
for reviewing probate notes. 

Task Activity 

Perform the following steps to review probate notes. 
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1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the [Review Probate Notes] link. 
Result: The Review Probate Notes screen displays. 
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3. Select the radio button for the case you wish to review the probate notes for.  
4. Click the [Select] button. 

Result: The Judicial Notes on Probate Notes screen displays. 

 
 

 

 Select an option from the Probate Event Recommendation drop-down list to make an 
event recommendation for the probate hearing. Your recommendation will be available to you 
while reviewing the summary probate note information on the day of the event. Refer to the 
Bench View section for details on probate event recommendations as they relate to the Bench. 

 Selecting the [Next] and [Previous] buttons will navigate you through the list of probate 
notes that need to be reviewed within the "Review Probate Notes" To-Do list. 
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5. Click the toggle button next to the Probate Notes - Comments label, to review or enter comments 
on the probate notes. 
Result: The Judicial Notes on Probate Notes screen displays with an expanded view of the 
probate comments.  
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6. Click the toggle button next to the Probate Notes - Judicial Officer Notes label, to review or enter 
Judicial Notes on the probate notes. 
Result: The Judicial Notes on Probate Notes screen displays with an expanded view of the 
Judicial Officer notes.  
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You may select an expiration date for the Judicial Officer notes. Refer to the Judicial 
Notes section for details on expiring Judicial Officer notes. 

7. Select the [Research Text] tab to review any research text associated with the probate note.  
Result: The Judicial Notes on Probate Notes screen displays with the Research Text tab 
highlighted.  

 
 

 

8. Select the [Probate Notes] tab navigate back to the Probate Notes.  
Result: The Judicial Notes on Probate Notes screen displays with the Probate Notes tab 
highlighted.  
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9. Click the [Save] button. 
Result: The Chamber View screen displays with one less item in the Review Probate Notes To-
Do list. 

 
 

 

 

 

Related Links 

Review Judicial To Do List Overview 

Chamber View - Calendar: Day View Screen 

Judicial Notes on Probate Notes Screen 

 

My Court Information 

 

Review Tentative Rulings 

 



The Judicial Officers Section 

1043 

Introduction 

Based on your court's procedures, a Research Attorney within your court may send you Tentative Rulings 
for review. When the Research Attorney requests that you review a tentative ruling, an item is added to 
your To Do list. You may access tentative rulings requiring your input from the To-Do list. While reviewing 
a tentative ruling, you may enter instructions for the Research Attorney or notes you can refer to at any 
time. You may also choose to remit the order back to the Research Attorney for follow-up work.  

Task Activity 

Perform the following steps to review tentative rulings. 
 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the [Review Tentative Rulings] link. 
Result: The Tentative Rulings Work Queue screen displays. 
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3. Select the radio button for the tentative ruling you want to review/approve.  
4. Click the [Select] button. 

Result: The Judicial Notes on Tentative Rulings screen displays. 
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 Selecting the [Next] and [Previous] buttons will navigate you through the list of tentative 
rulings that need to be reviewed within the "Tentative Rulings" To-Do list. 

5. Select the [Research Text] tab to review the research text associated with the tentative ruling. 
Result: The Judicial Notes on Proposed Order screen displays, with the Research Text tab 
highlighted.  
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6. Select the [JO Notes] tab to create/review Judicial Officer notes associated to the tentative 
ruling. 
Result: The Judicial Notes on Proposed Order screen displays with the JO Notes tab highlighted.  
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7. Select an appropriate action from the Next Action drop-down list. 
 The action you select from the Next Action drop-down list will dictate what further action 

the Research Attorney will take regarding the selected tentative ruling. Refer to the Review 
Judicial To Do List Overview for a list of available actions and their meanings. 

8. Click the [Save] button. 
Result: The Chamber View screen displays with one less task in the "Review Tentative Rulings" 
To Do list. 
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Related Links 

Review Judicial To Do List Overview 

Chamber View - Calendar: Day View Screen 

Judicial Notes on Tentative Rulings Screen 

Judicial Notes on Proposed Order Screen 

 

My Court Information 

 

Review Proposed Orders 

 

Introduction 

Based on the procedures of your court, Proposed Orders may be sent to you for review, approval and e-
signature at the request of the Courtroom Clerk. When the request is made, an item is added to your To 
Do list. You can access proposed orders requiring your input from the To-Do list. While reviewing a 
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proposed order, you may enter instructions for the clerk or notes you can refer to at any time. You can 
also choose to approve the order or to remit the order back to the Courtroom Clerk for further action. 

Task Activity 

Perform the following steps to review proposed Orders. 
 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the [Review Proposed Orders] link. 
Result: The Proposed Order - Review and Approval screen displays. 
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3. Select the radio button for the order you wish to review/approve.  
4. Click the [Select] button. 

Result: The Judicial Notes on Proposed Order screen displays. 
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5. Select the [JO Notes] tab. 
Result: The Judicial Notes on Proposed Order screen displays with the JO Notes tab highlighted.  



Printed Documentation 

1052 

 
 

 

6. Select an appropriate action from the Next Action drop-down list. 
 The action you select from the Next Action drop-down list will dictate what further action 

the Courtroom Clerk will take regarding the selected proposed order. Refer to the Judicial To 
Do List Overview for a list of available actions and their meanings. 

7. Click the [Save] button. 
Result: The Chamber View screen displays with one less task in the "Review Proposed Orders" 
To Do list. 
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Related Links 

Review Judicial To Do List Overview 

Chamber View - Calendar: Day View Screen 

Judicial Notes on Proposed Order Screen 

 

My Court Information 

 

Review Orders for e-Signature 

 

Introduction 

Based on the procedures of your court, Proposed Orders may be sent to you for review, approval and e-
signature at the request of the Courtroom Clerk. When the request is made, an item is added to your To 
Do list. You may access proposed orders requiring your input from the To-Do list. While reviewing a 
proposed order, you may enter instructions for the clerk or notes you can refer to at any time. You may 
also choose to approve the order or to remit the order back to the Courtroom Clerk for further action. 
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Task Activity 

Perform the following steps to review Orders for e-Signature. 
 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the [Orders for eSignature] link. 
Result: The Proposed Order - Attach e-Signature screen displays. 
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3. Select the radio button for the order on which to attach an e-Signature.  
4. Click the [Select] button. 

Result: The Proposed Order for Signature screen displays. 
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5. Select the [JO Notes] tab. 
Result: The Proposed Order for Signature screen displays with the JO Notes tab highlighted.  



The Judicial Officers Section 

1057 

 
 

 

6. Click the [Attach e-Signature] button. 
Result: The Chamber View screen displays with one less task in the Orders for eSignature To Do 
list. 
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Related Links 

Review Judicial To Do List Overview 

Chamber View - Calendar: Day View Screen 

 

My Court Information 

 

Review Cases Under Submission 

 

Introduction 

The "Review Cases Under Submission" To-Do list provides you with a list of matters currently under 
submission for each of your cases. This list of cases under submission provides you with the name of 
each matter under submission, the date the matter was taken under submission and the number of days 
that have elapsed since the matter was taken under submission.  

To complete the task, select the desired case and enter an order for the event that was taken under 
submission. This action will remove the task from your To-Do list.  
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Task Activity 

Perform the following steps to review cases under submission. 
 

1. Select [Judicial Officers] > [Chamber View]. 
Result: The Chamber View screen displays. 

 
 

 

2. Click the [Review Cases Under Submission] link. 
Result: The Cases Under Submission Work Queue screen displays. 
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3. Select the Case Number link for the case under submission you want to enter a ruling for. 
Result: The Case Summary screen displays. 
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4. After reviewing the case, you can request that a Courtroom Clerk generate Minutes, removing the 
matter from under submission. Once the Minutes are generated and finalized, the task will be 
removed from your "To Do" item list.  

 

 

Related Links 

Review Judicial To Do List Overview 

Chamber View - Calendar: Day View Screen 

Case Summary Screen 
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Review Finalized Calendars 

Review Finalized Calendars Overview  

 

Introduction 

A finalized calendar is a grouping of scheduled events with finalized hearing dates and times. The 
purpose of the finalized calendar is to provide you with case information (such as probate notes, tentative 
rulings or a case overview) in preparation of a hearing for that case.  

Once a calendar is finalized, you can view all of the hearings and cases associated with that calendar. 
You will have access to review the probate notes, tentative rulings or case summaries for finalized 
calendars where you are the assigned Judicial Officer. As you review each case, you can mark the 
underlying probate note or tentative ruling as reviewed. Once you have reviewed all of the events from 
the finalized calendar, the finalized calendar will be removed from the list of calendars you need to 
review. 

Task Activities 

Reviewing finalized calendars includes the following task activity: 

• Review Finalized Calendars 
Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Bench View - Events Listing Screen 

Case Summary Screen 

Judicial Notes on Probate Notes Screen  

Judicial Notes on Tentative Rulings Screen  

 

My Court Information 

 

Review Finalized Calendars 
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Introduction 

A finalized calendar is a grouping of scheduled events with finalized hearing dates and times. The 
purpose of the finalized calendar is to provide you with case information (such as probate notes, tentative 
rulings or a case overview) in preparation of a hearing for that case. 

Task Activity 

Perform the following steps to review finalized calendars. 
 

1. Select [Judicial Officers] > [Chamber View] > [Finalized Calendars]. 
Result: The Finalized Calendar screen displays. 

 
 

 

2. Select the radio button for the finalized calendar you want to review. 
3. Click the [Select] button. 

Result: The Events Listing screen displays. 
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 The Viewed column on the events listing screen is checked if you have previously 
viewed the probate note, tentative ruling or case summary for that hearing. Once all events in 
a finalized calendar have been viewed, the finalized calendar will be removed from the list of 
finalized calendars you have to review. 

 

4. Click the [Event] link. Based on the case category associated with the event (e.g. Small Claims, 
Civil or Probate) one of the following screens will display: 
Result 1: The Judicial Notes on Probate Notes screen displays for Probate cases. 
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5. Result 2: The Judicial Notes on Tentative Rulings screen displays for Civil cases. 

 
 

 

6. Result 3: The Case Summary screen displays for Small Claims cases.  
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 When accessing probate notes and tentative rulings, you can make recommendations 
that you can review at the time of the hearing on the bench.  

 When accessing probate notes and tentative rulings, click the [Mark as Viewed] button 
to indicate that you have reviewed the information in preparation for the hearing. You may 
navigate through all of the probate notes and tentative rulings for each hearing in the finalized 
calendar by using the [Back], [Next] and [Go To Calendar] buttons. 
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Related Links 

Review Finalized Calendars Overview 

Bench View - Events Listing Screen 

Judicial Notes on Probate Notes Screen 

Judicial Notes on Tentative Rulings Screen 

Case Summary Screen 

 

Bench View 

Bench View Overview  

 

Introduction 

The Bench View provides easy access to calendars for a specific department and time. From the bench 
view, you can select a specific calendar, access events within the calendar, and view case details for 
each event.  

Calendar Calculator 

The purpose of the calendar calculator is to provide you with future dates to choose from when 
scheduling an event. These dates may be 15, 30, 60, 75, 90 or 120 days in the future and are based on 
the current date. You can also extend a scheduled event by selecting any future calendar date. You may 
choose between court days and calendar days (court days do not include Saturday and Sunday). You 
can navigate your calendar or the calendar for a specific department by selecting from the Monthly 
Calendars available to you.  

Viewing the Monthly Calendar 

You may also view your calendar for the current, previous or future months. This is helpful for determining 
workload, and viewing what will occur on your calendar for future weeks. You can select a specific day 
from the month calendar to drill-down to the specific calendars and events to be called on that day. The 
monthly calendar view allows you to see the number of events scheduled and allotted at specific points 
during each day. 

Events Listing 

The events listing allows you to view event details for a specific calendar. You will see information 
regarding the calendar such as the type of calendar (such as Case Management Conference Calendar, 
Probate Calendar, Trial Calendar, etc.). You can also view information regarding specific events within 
the calendar, such as the case number and title, the event name and an indicator as to whether or not 
you have previously viewed any probate notes or tentative rulings associated with the event.  

Selecting the Case Number link from the Events Listing will allow you to access the contents of a case. 
Once in the "context" of a case, you may view summary information regarding the case, as well as: 

• Blocked Accounts 
• Future Events on the Case 
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• Case Associations and Consolidations 
• Case Notes 
• Case Participants 
• Case Documents 
• Exhibits and Subpoenaed Records 
• Filings 
• Register of Actions 

 

 

Based on the case category (e.g. Probate, Civil or Small Claims), selecting the Event Link from the 
Events Listing will allow you to access any tentative rulings (for Civil cases) or probate notes (for Probate 
Cases), or the Case Summary (for Small Claims cases) associated with the event. Once you have 
reviewed the probate notes / tentative rulings, you may mark as "Viewed." The "Viewed" indicator in the 
Events Listing provides a way to filter events that have already been viewed during the course of a 
calendar. 

You can also filter the hearings displayed within the Events Listing based on other criteria as well, such 
as the Pre-Hearing status, the Request Status or the Calendar Number.  

Pre-Hearing Status 

The pre-hearing status will differ based on the case category, since probate cases, small claims and civil 
cases each have their own set of pre-hearing statuses. The following is a list of pre-hearing statuses by 
case category and a brief description: 

• Probate Cases: A Probate Examiner will select the pre-hearing status for probate cases prior to 
submitting the probate notes for your review. Probate Event Recommendations include: 

o Pre-Approved 
o Must Be Heard 
o Call and Grant 
o Review Complete 

 

• Civil Cases: The pre-hearing status options for Limited and Unlimited Civil cases are based on 
whether a tentative ruling exists for the case event. If a tentative ruling exists, then the tentative 
ruling available will display in the pre-hearing status, otherwise this column will be left blank. 

o Ready - A "Ready" status means that all required parties are checked in and the 
hearing is ready to be called. 

o Submitted on Tentative - A status of "Submitted on Tentative" means that the 
attorneys for the case participants have agreed to the tentative ruling. The hearing 
may be called, but there are no anticipated objections to be heard in open court. 

o No Appearance - A "No Appearance" status means that one or multiple required 
case participants are not present for the hearing. 

 

• Small Claims Cases: The pre-hearing status options are for Small Claims cases are determined 
based on whether or not a Proof of Service has been filed with the court. If any Proof of Service 
has been filed for the event, then "Proof of Service Filed" will display for the pre-hearing status. If 
no "Proof of Service" has been filed with the court, then the pre-hearing status will be blank.  

Request Status 

The request status refers to any requests made by the case participant. The request status is determined 
by the Courtroom Clerk during the Check-In process through the Minute. The following is a list of request 
statuses and a brief description:  



Printed Documentation 

1070 

• Request for Priority: A case participant may make a request for priority, so that their hearing 
may be called earlier in the calendar. 

• No Appearance: The clerk may specify "No Appearance" for the request status if one or more 
case participants are not present for their hearing.  

• Request for Second Call: A case participant may make a request for a second call if they wish 
to have their hearing called at the end of the calendar. 

Task Activities 

The Bench View Overview includes the following task activities: 

• Calculate Future Event Dates 
• View Calendars from the Bench 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Bench View - Calendar: Month View Screen 

Bench View - Calendar: Day View Screen 

Bench View - Events Listing Screen 

 

My Court Information 

 

Calculate Future Event Dates 

 

Introduction 

The purpose of the calendar calculator is to provide dates to choose from when scheduling a future event. 
These dates may be 15, 30, 60, 75, 90 or 120 days in the future and are based on the current date. You 
can also extend a scheduled event by selecting any future calendar date. You may choose between court 
days and calendar days (court days do not include Saturday and Sunday). You may easily navigate your 
calendar or the calendar for a specific department by selecting from the Monthly Calendars available on 
the Bench View. 

Task Activity 

Perform the following steps to calculate a future event from the bench view. 
 

1. Select [Judicial Officers] > [Bench View]. 
Result: The Bench View screen displays. 



The Judicial Officers Section 

1071 

 
 

 

2. Select the Court Days or Calendar Days radio button. 
3. Enter a valid date into the Date field or a number into the Set To field. 
4. Click the [Calculate] button. 

Result: The Bench View screen refreshes. 
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 The date field will be set to the current date when you open the Bench View. 

 

 

Related Links 

Bench View Overview 

Bench View - Calendar: Day View Screen 

 

My Court Information 

 

View Calendars from the Bench 

 

Introduction 

The Bench View provides a view to department calendars for use while on the bench. The purpose of the 
Bench View is to allow you easy access to calendars for a specific place and time. From this view, you 
can select a specific calendar and access events within the calendar.  

Task Activity 

Perform the following steps to view calendars from the bench. 
 

1. Select [Judicial Officers] > [Bench View]. 
Result: The Bench View screen displays. 
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 You can select to see the calendars of different departments for a selected date. To view 
the calendar for a different department, select the View by Department drop-down and click 
the [View] button.  

 You can also select to see calendars for different dates. To view the calendar for a 
different date, select the link for the desired day from the Month Calendar in the top-right 
corner of the screen. 

 Additionally, you can select to see a month view of the calendar by clicking the [Month] 
link. 

2. Click the [Calendar Name] link. 
Result: The Bench View - Events Listing screen displays, replacing the calendar day view. 
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Related Links 

Bench View Overview 

Bench View - Calendar: Day View Screen 

Bench View - Events Listing Screen 

 

Manage Judicial Notes 

Manage Judicial Notes Overview  
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Introduction 

You can enter notes for a case within the system. Judicial Officer notes may be shared with other Judicial 
Officers, relay instructions to Courtroom Clerks, or remain private. The system provides features for 
formatting of the text font and size, indentations, un-do, bold, italics, underline and a spell checker. 

You can choose to expire any note you create within the system. Upon the note's expiration, the note will 
be deleted from the system and will not be able to be viewed by you or anyone else in your court. You 
may choose to expire your notes automatically, in which case the note will expire a specific number of 
days after the disposition of the case, based on your court's configuration. You can also select a specific 
future date for the expiration of a note.  

When creating a case-level note, you can choose personnel from your court that will be able to view the 
note. The system will allow you to share information you enter regarding the case with other Judicial 
Officers, or provide instruction to selected court personnel.  

Task Activities 

Managing case-level judicial notes includes the following task activities: 

• Create Case-Level Judicial Notes 
• Update Case-Level Judicial Notes 
• Delete Case-Level Judicial Notes 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Judicial Officer Case Notes Screen  

Judicial Officer Notes - Create/Update Note Screen 

 

My Court Information 

 

Create Case-Level Judicial Notes 

 

Introduction 

You can enter notes for any case within the system. The system provides features for formatting of the 
text font and size, indentations, un-do, bold, italics, underline and a spell checker. 

When creating a note, you can choose specific personnel from your court to view the note. This will allow 
you to share information you enter regarding the case with other Judicial Officers, or provide instruction to 
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selected court personnel. If you do not select individuals to view your notes, then only you can access 
them. 

Before Creating Judicial Notes 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case on which to create a judicial note. Refer to the Search Cases task activity 
for details on performing a case search. 

Task Activity 

Perform the following steps to create a judicial note. 
 

1. Select [Judicial Officers] > [Case Search] > [Case Notes]. 
Result: The Case Notes screen displays. 

 
 

 

2. Click the [Create New] button. 
Result: The Judicial Officer - Create Notes screen displays. 
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3. Select the None, Automatic or Manual radio button for the note expiration date.  
 Selecting None for the expiration date will cause the note to be retained within the 

system permanently until otherwise specified. Selecting Automatic will cause the note to 
expire some amount of time (as configured by your court) after the disposition of the case. You 
must enter a valid date in the Expiration Date field if you select a Manual expiration of the 
notes.  

 

4. Select the toggle button next to the Security Rights Added label in order to set security for this 
note. 
Result: The Judicial Officer - Create Notes screen displays with an expanded view of the 
personnel that have access to the note. 
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5. Click the [Set Security] button. 
Result: The User Administration - Search User screen displays. 

 
 

 

 Clicking the Set Security button will navigate you to a screen that allows you to search 
for and add view privileges to system users that you want to have access to your note.  If you 
do not choose to Set Security on the note, the default security access is that only you may 
view your note.  

 

6. Enter/Select the search criteria for at least one of the following fields: 

• User ID 
• Account Status 
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• Court Location 
• User Last Name 

 

7. Click the [Search] button. 
Result: The User Administration - Search User screen displays with the result set visible at the 
bottom of the screen.  

 
 

 

8. Select the checkboxes for the court employees that should have access to the note. 
9. Click the [Select] button. 

Result: The Judicial Officer - Create Notes screen displays with the selected users in the 'Security 
Rights Added' table. 
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10. Enter the note into the Notes field.  
11. Click the [Save] button.  

Result: The Case Notes screen displays with a confirmation message. The newly created note is 
now visible in the Judicial Officer Notes table. 
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Related Links 

Manage Judicial Notes Overview 

Judicial Officer Case Notes Screen 

Judicial Officer Notes - Create/Update Note Screen 

 

My Court Information 

 

Update Case-Level Judicial Notes 

 

Introduction 

You can edit existing case-level notes in the system. The system provides features for formatting of the 
text font and size, indentations, un-do, bold, italics, underline and a spell checker. 
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Before Creating Case Documents 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case on which to update a judicial note. Refer to the Search Cases task activity 
for details on performing a case search. 

Task Activity 

Perform the following steps to update a judicial note. 
 

1. Select [Judicial Officers] > [Case Search] > [Case Notes]. 
Result: The Case Notes screen displays. 

 
 

 

2. Select the radio button for the note you want to update. 
3. Click the [Update] button. 

Result: The Judicial Officer - Edit/Update Notes screen displays with the screen populated with 
the information from the note.  
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4. Enter/Update the available fields as needed.  
5. Click the [Save] button.  

Result: The Case Notes screen displays with a confirmation message. The newly updated note is 
now visible in the Judicial Officer Notes table. 
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Related Links 

Manage Judicial Notes Overview 

Judicial Officer Case Notes Screen 

Judicial Officer Notes - Create/Update Note Screen 

 

My Court Information 

 

Delete Case-Level Judicial Notes 

 

Introduction 

You can delete case-level notes within the system. Once you delete a note, it will no longer be available 
within the system. 
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Before Creating Case Documents 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case on which to delete a judicial note. Refer to the Search Cases task activity 
for details on performing a case search. 

Task Activity 

Perform the following steps to delete a judicial note. 
 

1. Select [Judicial Officers] > [Case Search] > [Case Notes]. 
Result: The Case Notes screen displays. 

 
 

 

2. Select the radio button for the case note you want to delete. 
3. Click the [Delete] button. 

Result: The Case Notes screen displays with a confirmation message.  
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Related Links 

Manage Judicial Notes Overview 

Judicial Officer Case Notes Screen 

 

Manage Case Documents 

Manage Case Documents Overview  

 

Introduction 

You can record information in the system that can be used to generate forms. You may generate one of 
the following types of forms: 

• Opinions and Judgments 
• Statements of Decision 
• Ruling on Submitted Matter 
• Engrossed Settled Statement 
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• Order on Petition or Writs 
• Notice of Decision 
• Order Ruling on Motion 

 

 

If you select a form type of "Other," then you can enter the form name as you would like it to appear. 
When creating case documents, the system provides formatting features including text font and size, 
indentations, un-do, bold, italics, underline and a spell checker. You may choose to save a document as a 
draft, in which case no form will be generated. If you choose to publish the case document, a form will be 
generated and associated with a Register of Actions entry. You may also attach an e-Signature with a 
generated form.  

Task Activities 

Managing case documents includes the following task activities: 

• Create Case Documents 
• Update Documents 
• Delete Case Documents 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Case Document Summary Screen  

Create Case Document Screen  

 

My Court Information 

 

Create Case Documents 

 

Introduction 

When creating case documents, the system provides formatting features including text font and size, 
indentations, un-do, bold, italics, underline and a spell checker. You may choose to save a document as a 
draft, in which case no form will be generated. If you choose to publish the case document, a form will be 
generated and associated with a Register of Actions entry. You may also attach an e-Signature with a 
generated form.   
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Before Creating Case Documents 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case you wish to create a case document for. Refer to the Search Cases task 
activity for details on performing a case search. 

Task Activity 

Perform the following steps to create a case document. 
 

1. Select [Judicial Officers] > [Case Search] > [Create Case Document]. 
Result: The Case Document Summary screen displays. 
 
 

 

2. Click the [Create Document] button. 
Result: The Create Case Document screen displays. 
 
 

 

3. Select a Document Type.  
 If you select a document type of "Other,'' enter the document name into the Or field. 

4. Select a Next Action from the drop-down list. You may choose to save a document as a draft, 
and no form will be generated. If you choose to publish the case document, a form will be 
generated and associated with a case history entry. You may also attach an e-Signature with a 
generated form.  

5. Click the [Save] button. 
Result: The Case Document Summary screen displays with the new case document visible in the 
Case Document Summary history.  
 
 

 

 

 

Related Links 

Manage Case Documents Overview 

Case Document Summary Screen 

Create Case Document Screen 

 

My Court Information 

 



The Judicial Officers Section 

1089 

Update Case Documents 

 

Introduction 

You can select and make changes to an existing case document. Updating a case document will not 
change any previously generated versions of the selected form for the case document, but it will create a 
new form and associate it with a new Register of Actions entry.  

Before Updating Case Documents 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case document you wish to update. Refer to the Search Cases task activity for 
details on performing a case search. 

Task Activity 

Perform the following steps to update case document. 
 

1. Select [Judicial Officers] > [Case Search] > [Create Case Document]. 
Result: The Case Document Summary screen displays. 
 
 

 

2. Select the radio button for the case document you want to update. 
3. Click the [Update Document] button. 

Result: The Update Case Document screen displays. 
 
 

 

4. Update the Document Type, if necessary. 
5. Select a Next Action from the drop-down list. 

 You may choose to save a document as a draft and no form will be generated. If you choose 
to publish the case document, a form will be generated and associated with a case history 
entry. You may also attach an e-Signature with a generated form.  

6. Click the [Save] button. 
Result: The Case Document Summary screen displays.  
 
 

 

 

 

Related Links 

Manage Case Documents Overview 
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Case Document Summary Screen 

Create Case Document Screen 

 

My Court Information 

 

Delete Case Documents 

 

Introduction 

You may delete any document associated with a case. Deleting a document from a case will not remove 
any previously created forms or case history entries associated with the document. 

Before Deleting Case Documents 

This activity takes place within the context of a case. It is assumed that you have performed a case 
search and selected the case document you wish to delete. Refer to the Search Cases task activity for 
details on performing a case search. 

Task Activity 

Perform the following steps to delete a case document. 
 

1. Select [Judicial Officers] > [Case Search] > [Create Case Document]. 
Result: The Case Document Summary screen displays. 
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2. Select the radio button for the case document you want to delete. 
3. Click the [Delete Document] button. 

Result: The Case Document Summary screen displays with a confirmation message. The 
selected case document is now removed from the list. 

 
 

 

 

 

Related Links 

Manage Case Documents Overview 

Case Document Summary Screen 
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The Person/Entity Section 

Manage Person/Entity Information 

Manage Person/Entity Information Overview  

 

Introduction 

Managing person/entity information involves creating, updating, and/or securing a person/entity profile in 
the system. 

About Person/Entity Profiles 

A person/entity profile record consists of information relating to a unique person, entity, government 
agency or Trust. The system saves this information outside the context of a case, at the Court level. 

Person/entity records help Courts to track and organize various data elements for a given person/entity. 
The case participants, Court resources, and interested parties have person/entity profiles in the system.  

Accessing Person/Entity Information 

The Person/Entity screens allow you to directly create and access person/entity information in the system. 
However, you may also create person/entity information from other processes, such as by entering a 
case participant name into the Initiate Case screen. This entry automatically creates a person/entity 
record with related data collected from the case initiation process. The updates made to the participant 
record automatically update the participant’s person/entity record in the system. 

Many other processes and screens also use person/entity searches and data to complete specific 
activities. View the Person/Entity Search screen for a list of these processes. 

Activities Performed Prior to Managing Profiles 

You must conduct a person/entity search in order to select a person/entity profile to update or secure. 
However, it is recommended that you also conduct this search prior to creating a person/entity profile in 
the system. This helps to check whether a given person/entity already exists, which may reduce the risk 
of entering a duplicate profile record.  

Defining Person/Entity Associations 

A person/entity profile may have a relationship with another person/entity record. As a result, you can 
create associations between person/entities.  

These associations describe a more “permanent” type of relationship than case participant associations. 
For example, they can define familial and employment relationships between person/entities, such as the 
relationship between an attorney and a law firm. These associations do not rely on a case to exist.  

On the other hand, participant associations only exist within a case, and do not extend to other cases or 
system data. Refer to the Manage Case Participants section for details on these types of associations. 

There are three person/entity association types that you may create for a given person/entity profile. 
These relationships may include: 

• A person and another person 
• A person and an entity 
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• An entity and another entity 
Identifying Vexatious Litigants 

Based on an Order, you can label a person/entity as a vexatious litigant in the system. Refer to the Add 
Vexatious Litigant Entries task activity for details on adding a person/entity record to the Vexatious 
Litigant List. 

Task Activities 

Managing person/entity information includes the following task activities: 

• Search Person/Entity Profiles 
• Create Person/Entity Profiles 
• Update Person/Entity Profiles 
• Secure Person/Entity Profiles 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

 

 

My Court Information 

 

Search Person/Entity Profiles 

 

Introduction 

Searching for a person/entity searches and displays person/entity profile records that currently exist in the 
system.  

Person/Entity Search Functionality 

The system performs a search based on field parameters that you provide. Only person/entity profiles 
that match the entered search criteria will display in the results list. Refer to the Create Person/Entity 
Profiles task activity for details on adding a person/entity profile to the system.  

You must provide data for at least one primary search field or two secondary search fields in order for the 
search utility to function. Providing other parameter data helps to narrow the search results and increases 
the likelihood of finding a closer match. Refer to the Search Feature Overview for details on performing a 
search in the system. 
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Using Advanced Search Fields 

You must have the appropriate security roles to use advanced search fields. These fields help to limit the 
search results based on more personal person/entity attributes.  

Using the Search Results 

The search function also provides the foundation for maintaining person/entity profile information. For 
example, you must perform a person/entity search in order to update a person/entity record or maintain 
person/entity associations.  

From the Search Results section, you can perform the Secure Person/Entity Profiles or the Update 
Person/Entity Profiles task activities. 

Task Activity 

Perform the following steps to search for a person/entity profile record. 
 

1. Select [Person/Entity] > [Person/Entity Search]. 
Result: The Person/Entity Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
 The CMS ID Number is the only value that will return an exact person/entity match. 

3. Click the [Search] button. 
Result: The screen refreshes with the Search Results. 
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You can quickly view the details of person/entity profile from the Search Results. Follow the steps below 
to view this information.  
 

1. Click the person/entity name link to display its profile details. 
Result: The Person/Entity - Information pop-up window displays. 
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2. Click the [Close Window] button to return to the Search Results. 
 

 

Related Links 

Manage Person/Entity Information Overview 

Person/Entity Search Screen 

Person/Entity Confirmation Screen 

 

My Court Information 

 

Create Person/Entity Profiles 

 

Introduction 

Creating a person/entity profile record saves information about a specific person/entity directly in the 
system. This activity takes place outside the context of a case. 

Providing General Information 

Creating a person/entity profile involves collecting data about the person/entity. This data helps to identify 
the person/entity record. For example, you can save multiple names for a single person/entity. However, 
the name type depends on the selected person/entity category. Other attributes that you may save 
include contact information and email addresses. 

You may also label a person/entity as a frequent filer, if necessary. Refer to the Manage Frequent Filers 
section for details on this type of assignment. 

Creating Person/Entity Associations 

You may create associations with the person/entity. These associations occur between two 
person/entities. For example, a person-to-entity association exists between an Attorney and a law firm.  

A person/entity may have multiple person/entity associations. You must search for and select the 
person/entity record to associate with the active profile. 

Assigning Position Information 

You may assign one or more position types to a person/entity. These types identify the Court resource 
roles that this person/entity may perform. The system will use these attributes to recommend appropriate 
resources during the case assignment process. 

Refer to the Configure Case Assignment Rules and Manage Resource Assignments sections for details 
on setting up resource rules and assignments. 
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Providing Additional Information 

You may also provide additional information about a person/entity. This information is optional and allows 
you to collect specific data to further identify the profile. 

Saving the Profile 

When you save person/entity profile, the system will assign a CMS ID number to the profile record. You 
can use this number in order to search for and access this profile record in the future. 

Task Activity 

Perform the following steps to create a person/entity profile record directly in the system. 
 

1. Select [Person/Entity] > [Person/Entity Search]. 
Result: The Person/Entity Search screen displays. 

 
 

 

2. Click the [Add New Person/Entity] button. 
Result: The Person/Entity Profile screen displays. 
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3. Select a Category for the person/entity. 
 This selection will change the Additional Name fields. It defaults to "Person." 

4. Enter a Last Name or Name data for the person/entity. 
 The type of name depends on the selected person/entity category. 

5. Edit/Update the available fields as needed. 
 Follow Steps 6-8 to add an address and/or phone number. 

6. Click the [Add Another] button to add an address for this person/entity. 
Result: The Edit Contact Information pop-up window displays. 
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7. Edit/Update the available fields as needed. 
8. Click the [Save] button. 

Result: The Person/Entity Profile screen re-displays. The new address and/or phone number(s) 
display as read-only data. 
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9. Click the [Associations] tab. 
Result: The Associations tab highlights. 

 Follow Steps 10-15 to create a person/entity association. The person/entity to associate 
with must already exist in the system. 

 
 

 

10. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing this search. 

11. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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12. Select the radio button for the person/entity to associate. 
13. Click the [Select] button. 

Result: The screen refreshes and displays the person/entity in the Person/Entity Associations 
section. 

14. Select an Association Type. 
15. Edit/Update the available fields as needed. 
16. Click the [Position Information] tab. 

Result: The Position Information tab highlights. 
 Follow Steps 17-19 to assign a position type to the person/entity. 
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17. Select a position type value from the Add drop-down list. 
18. Click the [Add Position Type] button. 

Result: The screen refreshes and displays the position type and related fields.  
 Different fields will display depending on the selected position type. 
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19. Enter/Select data for the necessary fields. 
20. Click the [Additional Information] tab. 

Result: The Additional Information tab highlights and displays miscellaneous person/entity fields. 

 
 

 

21. Edit/Update the available fields as needed. 
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22. Click the [Save] button. 
Result: The Person/Entity - Confirmation screen displays. 

 
 

 

 

 

Related Links 

Manage Person/Entity Information Overview 

Person/Entity Search Screen 

Person/Entity Profile Screen 

Edit Contact Information Pop-Up Screen 

Person/Entity Confirmation Screen 

 

My Court Information 

 

Update Person/Entity Profiles 

 

Introduction 

Updating a person/entity profile changes the existing profile details for a specific person/entity. This 
activity allows you to add, edit, or remove profile information and associations. 

Activities Performed Prior to Updating 

You must conduct a person/entity search in order to select a person/entity profile to update.  
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Updating Associations 

You may choose to update or remove person/entity associations if the wrong association was created or 
an association no longer exists. 

Impacting Case Data 

Some person/entity updates may impact certain case data. For example, if you delete an address from a 
profile record, you may also choose to remove this address instance from the cases that reference it. If 
you do not remove this address from the cases, then the address is marked as “inactive” on these cases, 
and it will not be available for selection on future cases. 

Task Activity 

This activity takes place within the context of a person/entity search. Refer to the Search Person/Entity 
Profiles task activity for details on performing this search. 

Perform the following steps to update a person/entity profile record. 
 

1. Select the radio button for the person/entity to update. 
 This selection occurs from the Person/Entity Search screen. 

 
 

 

2. Click the [Select] button. 
Result: The Person/Entity Profile screen displays. 
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3. Enter/Update the available fields as needed. 
4. Click the [Associations] tab. 

Result: The Associations tab highlights and displays the relationships for this person/entity. 
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5. Edit/Update the available fields as needed. 
 Follow Steps 6-7 to remove a person/entity association from the profile. 

6. Select the checkboxes for the associations to remove. 
7. Click the [End Association] button. 

Result: The screen refreshes with a confirmation message. The selected associations no longer 
display. 



Printed Documentation 

1110 

 
 

 

8. Click the [Position Information] tab. 
Result: The Position Information tab highlights and displays the positions held by this 
person/entity. 
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9. Enter/Update the available fields as needed. 
 Follow Steps 10-12 to assign a position type to the person/entity. 

 Follow Steps 13 to remove a position type. 

10. Select a position type value from the Add drop-down list. 
11. Click the [Add Position Type] button. 

Result: The screen refreshes and displays the position type and related fields.  
 Different fields will display depending on the selected position type. 
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12. Enter/Select data for the necessary fields. 
13. Click the [End Position] button for the position type to remove from the profile. 

Result: The screen refreshes and no longer displays the position type. 
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14. Click the [Additional Information] tab. 
Result: The Additional Information tab highlights and displays miscellaneous information about 
this person/entity. 

 
 

 

15. Enter/Update the available fields as needed. 
16. Click the [Save] button. 

Result: The Person/Entity - Confirmation screen displays. 
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Related Links 

Manage Person/Entity Information Overview 

Person/Entity Search Screen 

Person/Entity Profile Screen 

Person/Entity Confirmation Screen 

 

My Court Information 

 

Secure Person/Entity Profiles 

 

Introduction 

Securing a person/entity profile restricts your access to certain profile data or to the entire record.  

About Person/Entity Profile Security 

You can secure person/entity addresses or profiles for the cases in which a person/entity has an active 
case participant role. You may select the cases on which to secure the profile data. However, this activity 
is only available for person/entities with position types of “Existing Case Participants.” 

These activities take place outside the context of a case. As a result, the security applied to a 
person/entity will affect its profile across the system. In addition, if you choose to secure a profile, the 
system automatically secures the addresses for that profile. 



The Person/Entity Section 

1117 

Activities Performed Prior to Securing 

You must conduct a person/entity search in order to select a person/entity profile to secure.  

Viewing Secured Profile Data 

Secured person/entity profile information becomes masked to you when you do not have security access 
to that data. Masked data replaces secure case information with X’s. Refer to the Secure Case 
Information section for details on securing participant profiles within a case. 

Task Activity 

This activity takes place within the context of a person/entity search. Refer to the Search Person/Entity 
Profiles task activity for details on performing this search. 

Perform the following steps to secure person/entity information. 
 

1. Select the radio button for the person/entity to secure. 
 This selection occurs from the Person/Entity Search screen. 

 
 

 

2. Click the [Secure Person/Entity] button. 
Result: The Edit Security Level screen displays. 
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3. Select one or more of the following security checkboxes: 

• Secure Person/Entity 
• Secure Address 

 

4. Select the checkboxes for the cases that will be impacted by the person/entity security. 
 The Applicable Cases section lists cases in which this person/entity has a participant role. 

5. Click the [Save] button. 
Result: The Person/Entity Search screen re-displays. 
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Related Links 

Manage Person/Entity Information Overview 

Person/Entity Search Screen 

Edit Security Level Screen 

 

Manage Judicial Officers 

Manage Judicial Officers Overview  

 

Introduction 

Managing Judicial Officer information involves creating and updating a Judicial Officer profile in the 
system. 

About Judicial Officer Profiles 

A Judicial Officer profile stores non-personal information about a specific Judicial Officer. In other words, 
these profiles do not collect the addresses or contact information for the individual. The information 
instead focuses on case assignment details and scheduling restrictions. 

For example, you can specify the locations where a Judicial Officer is available and the case categories 
that this person may hear. You can also identify the blanket recusal conflicts involving the Judicial Officer.  

You must have the appropriate security roles to search for and view Judicial Officer data. 

Using Judicial Officer Profiles 

A Judicial Officer profile must exist in the system to be considered as an available Court resource. The 
system will then use the profile information to appropriately schedule events and assign cases for the 
Judicial Officer. Refer to the Configure Assignment Rules and Manage Resource Assignments sections 
for details on these processes. 

Resource Allocation 

You have the option of configuring the calendar preferences for a Judicial Officer. This configuration 
defines the various calendar and/or event types that are available for the Judicial Officer on a given day. 
However, refer to the Configure Resource Allocation section for details on this process. 

Resource Unavailability 

You may also configure the Court days and time of day that this Judicial Officer will be unavailable. These 
Court "dark days" or unavailable times affect the way an event is scheduled for a Judicial Officer. 
However, you must refer to the Configure Resource Unavailability section for details on this process. 
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Task Activities 

Managing Judicial Officers includes the following task activities: 

• Search Judicial Officers 
• Create Judicial Officer Profiles 
• Update Judicial Officer Profiles 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Manage Judicial Officers - Search Screen 

Manage Judicial Officers Screen 

 

My Court Information 

 

Search Judicial Officers 

 

Introduction 

This activity allows you to search for Judicial Officer profile records that currently exist in the system.  

Judicial Officer Search Functionality 

The system performs a search based on field parameters that you provide. Only Judicial Officer profiles 
that match the entered search criteria will display in the results list. Refer to the Create Judicial Officer 
Profiles task activity for details on adding a Judicial Officer profile to the system.  

The search function also provides the foundation for maintaining Judicial Officer profile information. For 
example, you must perform a Judicial Officer search in order to update a Judicial Officer record. Refer to 
the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a Judicial Officer profile record. 
 

1. Select [Person/Entity] > [Manage Judicial Officers]. 
Result: The Manage Judicial Officers screen displays. 
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2. Enter/Select data for the appropriate search parameter fields. 
 You must provide data for at least one primary search field or two secondary search fields. 

Providing other parameter data helps to narrow the search results and increases the likelihood of 
finding a closer match. 

 The CMS ID Number is the only value that will return an exact Judicial Officer match. 
3. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 
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 From the Search Results section, you can perform the Update Judicial Officer Profiles 
task activity. 

 

 

Related Links 

Manage Judicial Officers Overview 

Manage Judicial Officers - Search Screen 

 

My Court Information 

 

Create Judicial Officer Profiles 
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Introduction 

Creating a Judicial Officer profile saves information about a specific Judicial Officer in the system. This 
profile acts as the “person/entity” record for the individual. 

Providing General Information 

The Judicial Officer profile collects both the name and type of Judicial Officer. The type defines the title 
held by the individual, such as “Judge” or "Commissioner." You may also specify the locations where the 
Judicial Officer is available and the case categories that this person may hear. 

The profile can also store the electronic signature of the Judicial Officer. The system can then attach this 
signature file to the appropriate forms, notices, and orders.  

Adding Blanket Recusals 

You can also identify the blanket recusal conflicts involving the Judicial Officer. This activity allows you to 
select the case participants and their related cases that have recusal issues with the Judicial Officer. 
Recusals saved to the profile will affect the future scheduling of case events for this resource. 

Entering an end date will prompt the system to change the recusal status to “Complete” on that date.  

Resource Allocation and Unavailability 

Refer to the Configure Resource Allocation and Configure Resource Unavailability sections for details on 
performing these processes. 

Saving the Profile 

Saving the profile will generate a CMS ID number to identify the Judicial Officer. The system will also 
consider these resource settings when assigning cases to Judicial Officers and performing load balancing 
events. 

Task Activity 

Perform the following steps to create a Judicial Officer profile record. 
 

1. Select [Person/Entity] > [Manage Judicial Officers]. 
Result: The Manage Judicial Officers screen displays. 
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2. Click the [Add New Judicial Officer] button. 
Result: The Judicial Officer screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 

• Last Name 
• Type 

 

4. Enter/Select data for the other necessary fields. 
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5. Click the [Save] button to save the data from the General Information tab. 
 You must save the data on this tab before moving to another tab. 

Result: The screen refreshes with a confirmation message. 

 
 

 

6. Click the [Blanket Recusals] tab. 
Result: The Blanket Recusal tab highlights. 

 Follow Steps 7-10 to add a recusal entry to the profile. 
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7. Enter/Select data for the appropriate search parameter fields within the Add New Recusals 
section. 

 You must provide data for at least one primary search field or two secondary search fields. 
Providing other parameter data helps to narrow the search results and increases the likelihood of 
finding a closer match. 

 The CMS ID Number is the only value that will return an exact person/entity match. 

8. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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9. Select the radio button for the person/entity to include as a recusal. 
10. Click the [Select] button. 

Result: The screen refreshes and displays the participant name and case in the Blanket Recusals 
section. 
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11. Enter data for the other necessary fields. 
 You can enter a Reason or End Date for the recusal. 

12. Click the [Save] button to save the recusal to the profile. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Manage Judicial Officers Overview 

Manage Judicial Officers Screen 

Person/Entity Search Screen 

 

My Court Information 

 

Update Judicial Officer Profiles 
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Introduction 

Updating a Judicial Officer profile changes the existing profile details for a specific Judicial Officer.  

Activities Performed Prior to Updating 

You must conduct a Judicial Officer search in order to select a judicial officer profile to update.  

Updating Recusals 

You may choose to add or update a recusal entry. You may also end a recusal, which removes the 
recusal from the profile.  

Task Activity 

This activity takes place within the context of a Judicial Officer search. Refer to the Search Judicial Officer 
Profiles task activity for details on performing this search. 

Perform the following steps to update a Judicial Officer profile record. 
 

1. Select the radio button for the Judicial Officer profile to update. 
 This selection occurs from the Manage Judicial Officers - Search screen. 
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2. Click the [Select] button. 
Result: The Judicial Officer screen displays with the saved profile data. 

 
 

 

3. Enter/Select data for the necessary fields. 
4. Click the [Save] button to save the data from the General Information tab. 

 You must save the data on this tab before moving to another tab. 
Result: The screen refreshes with a confirmation message. 
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5. Click the [Blanket Recusals] tab. 
Result: The Blanket Recusal tab highlights. 
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 Follow Steps 6-9 to add a recusal entry to the profile. 

 Follow Steps 10-11 to remove a recusal from the profile. 

6. Enter/Select data for the appropriate search parameter fields within the Add New Recusals 
section. 

 You must provide data for at least one primary search field or two secondary search fields. 
Providing other parameter data helps to narrow the search results and increases the likelihood of 
finding a closer match. 

 The CMS ID Number is the only value that will return an exact person/entity match. 

7. Click the [Search] button. 
Result: The screen refreshes with the search results. 
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8. Select the radio button for the person/entity to include as a recusal. 
9. Click the [Select] button. 

Result: The screen refreshes and displays the participant name and case in the Blanket Recusals 
section. 
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10. Select the checkbox for the recusal to remove from the profile. 
11. Click the [End Recusal] button. 

Result: The screen refreshes with a confirmation message. The recusal no longer displays. 
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12. Enter/Update the available fields as needed. 
13. Click the [Save] button. 

Result: The screen refreshes with a confirmation message. 
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Related Links 

Manage Judicial Officers Overview 

Manage Judicial Officers - Search Screen 

Manage Judicial Officers Screen 

Person/Entity Search Screen 

 

Manage Frequent Filers 

Manage Frequent Filers Overview  
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Introduction 

Managing frequent filers involves adding and/or removing person/entity profiles to or from the Frequent 
Filers List. 

About Frequent Filers 

Frequent filers are person/entities that file with the Court regularly. Adding person/entities to the Frequent 
Filers List allows you to easily select these profiles whenever they initiate a case. 

Changing Frequent Filer Attributes 

Labeling a person/entity as a frequent filer requires you to specify the location(s) and/or case 
category(ies) to which this filer applies. You may update these attributes to include additional or different 
locations and/or case categories, if necessary. 

Selecting a Frequent Filer 

While maintaining the Frequent Filers List occurs outside of a case, you may select a frequent filer as a 
case participant during the case initiation process. Refer to the Initiate Cases section for details on adding 
a frequent filer to a case. 

Task Activities 

Managing Frequent Filers includes the following task activities: 

• Add/Remove Frequent Filer Entries 
• Display the Frequent Filers List 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Frequent Filers Screen 

Person/Entity Search Screen 

Person/Entity Profile Screen 

Person/Entity - Confirmation Screen 

 

My Court Information 

 

Add/Remove Frequent Filer Entries 
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Introduction 

Adding a person/entity record to the Frequent Filers List labels this person/entity as a frequent filer in the 
system. Likewise, removing a person/entity from the Frequent Filers List deletes this status for the 
selected person/entity. 

Task Activity 

This activity occurs within a person/entity profile. Refer to the Search Person/Entity Profiles task activity 
for details on searching for and accessing person/entity records. 

Perform the following steps to add or remove a person/entity profile to (or from) the Frequent Filers List. 
 

1. Select the radio button for the person/entity record to add/remove from the list. 
 This selection occurs from the Person/Entity Search screen. 

 
 

 

2. Click the [Select] button. 
Result: The Person/Entity Profile screen displays. 
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3. Enter/Select data for the necessary profile fields. 
 Refer to the Manage Person/Entity Information section for details on maintaining profile 

information. 
4. Click to select or clear the [Is Frequent Filer] checkbox. 

 Choose the appropriate action to add or remove this person/entity from the Frequent Filers 
List. 

 If removing the person/entity from the list, then skip to Step 6. 

5. Select the Location(s) and/or Case Category(s) to which this filer applies. 
 You must choose at least one location or case category. 

6. Click the [Save] button. 
Result: The Person/Entity – Confirmation screen displays. The system saves/removes this 
person/entity to (or from) the Frequent Filers List. 
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Related Links 

Manage Frequent Filers Overview 

Person/Entity Search Screen 

Person/Entity Profile Screen 

Person/Entity Confirmation Screen 

 

My Court Information 

 

Display the Frequent Filers List 

 

Introduction 

Displaying the Frequent Filers List shows the person/entity records assigned to this status within the 
system. 

Filtering Frequent Filer Entries 

You may filter the Frequent Filers List in order to view person/entity records for a specific location and/or 
case category. 

Task Activity 

Perform the following steps display the Frequent Filers List. 
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1. Select [Person/Entity] > [Frequent Filers]. 
Result: The Frequent Filers screen displays. 
 
 

 

2. Select one or more filter criteria, if necessary. 
 The list contains the frequent filers in the system. Choosing a location and/or case category 

will filter the list results. 
3. Click the [Filter] button. 

Result: The screen refreshes and displays only those frequent filers that match the selected filter 
criteria. 

 You can also sort the list based on the column headers. This organizes the list in ascending 
order.  
 
 

 

 

 

Related Links 

Manage Frequent Filers Overview 

Frequent Filers Screen 

 

Manage Vexatious Litigants 

Manage Vexatious Litigants Overview  

 

Introduction 

Managing vexatious litigant entries involves adding, updating, and/or removing person/entity profiles to or 
from the Vexatious Litigant List.  

Identifying a Vexatious Litigant 

If an Order identifies a specific person/entity as having behavior(s) consistent with Code of Civil 
Procedure Section 391(b), then you can add this person/entity to the Vexatious Litigants List. This label 
will then indicate to court staff that one or more Courts have prohibited this person/entity from filing new 
litigation without first obtaining leave of the presiding judge. 

Maintaining the Vexatious Litigant List 

The AOC distributes the official Vexatious Litigant List to Courts at regular intervals. It is each Court’s 
responsibility to keep the system’s information consistent with the issued hard-copy version. You can 
identify these changes by comparing the system’s current list with the newly issued list. 
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Checking for Vexatious Litigants 

While maintaining the Vexatious Litigant List occurs outside of a case, you may only check case 
participants against this List during the case initiation process. This allows Courts to reject initial case 
filings submitted by this litigant. Refer to the Initiate Cases section for details on performing this vexatious 
litigant check. 

Task Activities 

Managing vexatious litigants includes the following task activities: 

• Add Vexatious Litigant Entries 
• Update Vexatious Litigant Entries 
• Remove Vexatious Litigant Entries 

Additional Resources 

There are no other resources related to this overview.  

 

 

Related Links 

Vexatious Litigants - List Screen 

Vexatious Litigants - Details Screen 

 

My Court Information 

 

Add Vexatious Litigant Entries 

 

Introduction 

Adding a person/entity record to the Vexatious Litigants List labels this person/entity as a vexatious 
litigant in the system.  

Task Activity 

This activity occurs within the context of a person/entity search. Refer to the Manage Person/Entity 
Information for details on searching for person/entity records.  

Perform the following steps to add a person/entity profile to the Vexatious Litigant List. 
 

1. Select the radio button for the person/entity record referenced in the Order. 
 This selection occurs from the Person/Entity Search screen. 
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2. Click the [Add to Vexatious Litigants List] button. 
Result: The Vexatious Litigants - Details screen displays. 

 
 

 

3. Enter/Select data for the necessary fields. 
 These are the Order details for this vexatious litigant entry. 

4. Click the [Save] button. 
Result: The system checks the entered information and displays the appropriate warnings. If 
there are no conflicts, then the Vexatious Litigants - List screen displays with a confirmation 
message. 
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Related Links 

Manage Vexatious Litigants Overview 

Person/Entity Search Screen 

Vexatious Litigant - Details Screen 

 

My Court Information 

 

Update Vexatious Litigant Entries 

 

Introduction 

Updating a vexatious litigant entry changes the Order information for an existing vexatious litigant record. 
While Courts must manually update this list, updates require a Court Order or Amendment. 

Task Activity 

Perform the following steps to update a vexatious litigant entry.  
 

1. Select [Person/Entity] > [Vexatious Litigants]. 
Result: The Vexatious Litigants - List screen displays. 

 
 

 

2. Click the letter of the person/entity’s name from the alphabet menu. 
 The list is alphabetized by the last name of a person, or the first name of an entity. 

Result: The screen refreshes and displays the names that begin with this letter. 
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3. Click the [Name] link of the desired vexatious litigant entry to update its details. 
Result: The Vexatious Litigants - Details screen displays. 

 
 

 

4. Enter/Update the Order details for this vexatious litigant entry as needed. 
5. Click the [Save] button. 

Result: The Vexatious Litigants - List screen re-displays with a confirmation message. 
 

 

Related Links 

Manage Vexatious Litigants Overview 

Vexatious Litigants - List Screen 

Vexatious Litigants - Details Screen 
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My Court Information 

 

Remove Vexatious Litigant Entries 

 

Introduction 

Deleting a vexatious litigant entry removes the selected person/entity name from the Vexatious Litigant 
List. This activity requires a Court Order before you can remove an entry. 

Task Activity 

Perform the following steps to remove a person/entity from the Vexatious Litigants List. 
 

1. Select [Person/Entity] > [Vexatious Litigants]. 
Result: The Vexatious Litigants - List screen displays. 

 
 

 

2. Click the letter of the person/entity’s name from the alphabet menu. 
 The list is alphabetized by the last name of a person, or the first name of an entity. 

Result: The screen refreshes and displays the names that begin with this letter. 
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3. Click the radio button for the vexatious litigant entry to remove. 
4. Click the [Remove from Vexatious Litigants List] button. 

Result: The screen refreshes with a confirmation message. The previously selected vexatious 
litigant no longer displays in the list. 

 
 

 

 

 

Related Links 

Manage Vexatious Litigants Overview 

Vexatious Litigants - List Screen 
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The Reports Section 

Manage Out-of-Process Reports Overview 

 

Introduction 
Out-of-process reports are reports that are generated, viewed, and printed outside of a system process. 
At this time, the system contains about 60 out-of-process reports. 

Dates 
When working with out-of-process reports, the user interface that enables you to retrieve reports, create 
reports, and schedule reports has both a start and end date. Although you can enter a start and end date 
for all out-of-process report task activities, the system only uses these dates when retrieving saved 
reports. 

Understand the Differences Between "Saved" Reports 
When you generate and save a report using the Create Report task, a record of that report is saved in 
both the system and the Crystal Enterprise report archive. Because these two records are linked, you are 
able to retrieve these records using the Retrieve Report task. 

However, when a report is generated and saved as a result of a report schedule, a record of that report is 
only stored in the Crystal Enterprise report archive. Therefore, you can only access these "types" of 
saved reports using Crystal Enterprise. 

Refer to Crystal Enterprise documentation for more information. 

Batch Generation 
When you schedule a report to print, you are actually defining a batch process that runs based on the 
schedule's parameter settings.  

This process is similar to setting up other batch processes. However, batch processes related to running 
reports are configured when you schedule a report, whereas all other batch processes are requested by 
local administrators and scheduled by Central Administrators. Refer to the Schedule Batch Jobs section 
for details on this process. 

About Printing 
Generate and retrieve reports 

When you run or retrieve a report, the report displays within a browser window. You can print what you 
see in the browser window by using the browser's Print option. You can also export the report to a 
selected file format, such as ".pdf" or ".doc," etc., and print the report using the corresponding application. 
You export the report by clicking the appropriate icon displayed in the browser above the report 
information. 

Schedule a report 

When you schedule a report to generate, the system uses the printer defined with your batch printer 
parameter settings. 
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Task Activities 
Maintaining out-of-process reports includes the following task activities:  

• Create a Report 
• Retrieve a Saved Report 
• Schedule a Report 
• Configure Printers 

Additional Resources 
Other items related to this overview include the following: 

• Business Rules 
• About System Reports 

 

 

Related Links 

Run Reports Screen 

Run Reports - Create Report Screen 

Run Reports - Retrieve Report Screen 

Run Reports - Schedule Report Screen 

 

My Court Information 

 

Create a Report 

 

Introduction 
The Create a Report task enables you to: 

• Generate, view, and print a report 
• Generate and save a report 

Create View Only Reports or Publish and View Later 
When you create a report, you have two options: View or Publish.  
 

 

 

View Report Publish Report 

When you select View, the system generates and When you select Publish Report, the system generates 
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displays the report in a browser window. You can print 
the displayed report using the browser's print 
functionality. However, when you close the browser, you 
close the report. No copies of the report are saved. 

the report but does not display it in a browser window. To 
view the saved report, you must retrieve it using the 
Retrieve Report functionality. 

Filter Criteria 
Filter criteria is specific to the Report Name. 

Task Activity 
Follow this procedure to generate, view and print a report or generate and save a report. 

1. Select [Reports] > [Run Reports]. 
Result: The Run Reports screen displays. 

 
 

 

2. Select the [Create Report] radio button. 
3. Select data for the following required fields: 

• Category 
• Report Name 

 

4. Click the [Submit] button. 
Result: The Run Reports - Create Reports screen displays. 
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5. Enter a personalized name for the report being generated. 
6. Enter report filter criteria as appropriate. 
7. To generate and save the report, click the [Publish Report] button. 

Result: The system saves the report. To view the report, use the Retrieve Report functionality. 
OR 

8. To generate, view, and print the report, click the [View Report] button. 
Result: The report displays on the screen. Use the appropriate options/icons to print the report. 

 

 

Related Links 

Manage Out-of-Process Reports Overview 

Run Reports Screen 

Run Reports - Create Reports Screen 

 

My Court Information 
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Retrieve a Saved Report 

 

Introduction 
Retrieving a saved report allows you to search for saved reports that you generated and saved using the 
Create a Report task activity. 

Saved Reports You Cannot Retrieve 
Even though scheduled reports are generated and saved, you cannot retrieve them using this task. You 
must retrieve these reports using Crystal Reports.  

Returned Records 
The maximum number of records returned after a search is 100 records, displaying 50 records on each 
page. This is true even when more records meet your search criteria. Selecting a date range enables you 
to control the records returned to you and may help to reduce the number of records you retrieve. 

Data Access Privileges 
Data access privileges assigned to you affect your ability to retrieve saved reports. Generally, you retrieve 
reports that you generated and saved. Access to data and reports is based upon access rights assigned 
by your local administrator. 

Generate a Transmission File 
The [Generate a Transmission File] button enables you to transmit statistical report data from the 
system to the AOC for any retrieved reports that are JBSIS compliant. 

JBSIS is an electronic statistical reporting system that defines and collects summary information for each 
major case processing area of the court and makes court data available via the JBSIS data warehouse. 
Refer to the http://www2.courtinfo.ca.gov/jbsis/ website for more information. 

Task Activity 
Perform the following steps to retrieve reports that you generated and saved using the Create a Report 
task. 

1. Select [Reports] > [Run Reports]. 
Result: The Run Reports screen displays. 



Printed Documentation 

1154 

 
 

 

2. Select the [Retrieve Report] radio button. 
3. Enter/Select the following required fields: 

• Category 
• Report Name 

 

4. Enter a start and end date to indicate a range of dates in which the reports you want to retrieve 
were generated and saved. 

5. Click the [Submit] button. 
Result: The Run Reports - Retrieve Report screen displays. 

 
 

 

6. To view a report, select the radio button of the report you want to view and click the [View 
Report] button. 
Result: The report displays on the screen. Use the appropriate options/icons to print the report. 
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7. To transmit statistical report data to the AOC, select the radio button of the JBSIS compliant 
report and click the [Generate a Transmission File] button. 
Result: The system displays a "File Sent" message when the transmission is complete. 

 If you select a report that is not JBSIS compliant, the [Generate a Transmission File] 
button will be inactive. 

 

 

Related Links 

Manage Out-of-Process Reports Overview 

Run Reports Screen 

Run Reports - Retrieve Report Screen 

 

My Court Information 

 

Schedule a Report 

 

Introduction 
The Schedule a Report task enables you to pre-define the various times a specific report prints and 
where it prints. 

Editing and Deleting of Scheduled Reports 
The system only supports setting up of report schedules. Editing and deleting of report schedules and 
retrieving of saved scheduled reports must be performed in Crystal Enterprise. 

Refer to the Technical Architecture document for more information. 

Filter Criteria 
Filter criteria is specific to the Report Name. 

Schedule Criteria 
Schedule criteria are specific to the Frequency setting.  

For example, if you select "weekly" as the frequency, the schedule criteria requires you to enter the day in 
which the weekly report will run along with the time of day the report will run. The "hourly" frequency 
setting has schedule criteria that requires you to enter the day and time the hourly report will run along 
with the details about how often the report runs: every 1 hour, every 3 hours, every 5 hours and 30 
minutes, etc. 
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Selecting a Printer 
By entering a printer name you are not only indicating that the report should print at the same time it is 
generated and saved but you are indicating where the report should print. If you do not enter a printer 
name in the corresponding Printer field, you are indicating to the system that the report should be 
generated and saved at the scheduled time but not printed.  

You must have your printers configured properly before you can select them in this screen. Refer to the 
Configure Printers task activity for details on this process. 

Task Activity 
Perform the following steps to schedule a report to run automatically. 

1. Select [Reports] > [Run Reports]. 
Result: The Run Reports screen displays. 

 
 

 

2. Select the [Schedule Report] radio button. 
3. Enter/select the following required fields: 

4. Category 
5. Report Name 

 

4. Click the [Submit] button. 
Result: The Run Reports - Schedule Report screen displays. 
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5. Enter report filter criteria, as appropriate. 
6. Select a frequency. 

Result: The screen refreshes (not shown) and displays schedule criteria according to the selected 
frequency. 

7. Enter a printer name if you want the report to print when it is generated. 
8. Click the [Schedule Report] button. 

 

 

Related Links 

Manage Out-of-Process Reports Overview 

Run Reports Screen 

Run Reports - Schedule Report Screen 

Configure Printers Screen 
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The Forms Section 

Manage Forms, Notices, and Document Sets 

Manage Forms, Notices, and Document Sets Overview 

 

Introduction 

This section provides information about preparing forms, notices, and document sets so that they can be 
used in your court system. 

Form, Notice, and Document Set Selection 

When selecting a form, notice, or document set to generate, or print, you select them all from the same 
list. You differentiate them by their titles/names. 

This documentation refers to forms and/or notices as "forms/notices." When including document sets, 
they are all referred to as "documents." 

Form/Notice Templates 

The system provides you with a set number of form/notice templates to choose from when customizing 
your forms/notices. This section assumes you are familiar with these form/notice templates. 

Task Activities 

Preparing documents to court specifications includes the following task activities: 

• Manage Forms/Notices 
• Edit Configurable Text 
• Manage Document Sets 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Background Information 
• In-Process Form, Notices and Document Sets Overview 
• Out-of-Process Forms/Notices and Document Sets Overview 

 

 

Related Links 

Define Forms Screen 

Define Forms - Update Form Screen 

Define Document Sets Screen 

Define Document Sets - Select Form Screen 
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Configure Editable Text Table Screen 

 

In-Process Forms, Notices, and Document Sets Overview  

 

Introduction 

In-process forms/notices and document sets are documents that are generated, viewed, and printed from 
inside a system process. The system supports two different types of in-process forms/notices and 
document sets: 

• Ones associated with case clocks  
• Ones associated with action entries 

Case Clocks 

You can configure a case clock to batch print documents when the case clock expires or when it is close 
to expiring.  

Configuring forms/notices and document sets to batch print at/near the time of a case clock expiration 
works in conjunction with the "Case Clock Expiry" batch process, which searches for expired or near 
expired cases and prints any associated documentation. 

When the system batch prints documents resulting from expired or near expired case clocks, system 
users will not prompted to select document recipients or document parameter information. Document 
recipients are pre-selected by local administrators and document parameter information is extracted from 
the associated case information, when available. Refer to the Maintain Case Clocks section for details on 
this process. 

Action Entries 

Documents can generate at virtually any point within a process providing the appropriate action entries 
are defined. Refer to the Manage Action Entries section for details.  

Task Activities 

Since action entries determine when documents generate within a process, it is not possible to list all of 
the potential task activities. However, the system comes with a standard list of pre-configured action 
entries which are reflected throughout the task activities in this documentation. 

Listed below is a high-level process that highlights what a user can expect if a given case activity is 
configured to generate documents. 

1. A user performs an action entry configured to generate documents. 
2. The system determines the effective version based on filing date of the action entry, not the 

system date. 
3. If a version is not available, the system prompts the user to print the appropriate documents out-

of-process. 
4. If a version is available, the system prompts the user to select the document recipients.  
5. The system prompts the user to enter document parameter information. 
6. The system generates and prints the documents according to the configured print options: 

• Print without preview 
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• Preview in browser 
• Defer to work queue 
• Print in batch 
• No printing 

 

7. No other immediate action is required of the user except if the documents preview in browser. 
When documents display in a browser window, users can print the documents using the browser 
Print option. 

 When the system batch prints documents, system users are not prompted to select 
document recipients or document parameter information. Document recipients are pre-
selected by local administrators and document parameter information is extracted from the 
associated case information, when available. 

Print options 

Document generation resulting from an action entry has five print options. They are selected when action 
entries are defined.  

• Print Without Preview – This option generates documents and prints them directly to the user's 
desktop default printer. Users will have to select participants and enter document parameter 
information but they will not see the final documents in a browser screen. 

 

• Preview in Browser – This option generates documents and displays them in a browser window. 
Users have the option to print using the browser's Print option. 

 

• Defer to Work Queue – This option generates documents but does not display or print them. 
Using Entry Action configuration for work queues, the system creates a work queue task in the 
appropriate work queue. Users print the generated documents when performing the work queue 
task. 

 

• Print in Batch - This option generates documents but does not display or print them immediately. 
Documents print when the associated batch job runs. 

 

• No Printing - This option generates documents but does not display or print them. Documents 
can later be retrieved using the Retrieve Form/Notice Document Set task activity and printing 
using the browser's Print option. 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Background Information 

 

 

My Court Information 

 

Manage Forms/Notices 
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Introduction 

Once defined, forms/notices are available for: 

• Defining of document sets 
• Configuring in-process forms/notices 
• Managing form/notices outside of a process, including: 

• Generating forms/notices 
• E-mailing forms/notices 
• Retrieving forms/notices 

Field Information 

The following contains additional information about the fields you see during this process. This 
information is intended to assist you in your configuration selections. 
 

• Form Template Name – The Form Template Name displays only after you have created your 
form. It is added by the system and identifies the underlying "*.mdf" template used to support the 
selected form/notice. 

 

• Form Name – The Form Name represents one of the various form/notice "templates" provided by 
the system. 

 

• Form Description – The Form Description provides additional information about the form/notice 
that may not be apparent by reading the form name. 

 

• Effective Start and End Dates – The Effective Start Date indicates when the form/notice is 
available in the list of available forms/notices. The Effective End Date indicates when the 
form/notice is no longer available in the list of available forms/notices. 

 

• Form Category – The Form Category value enables filtering of forms/notices when users are 
looking for the form/notice to generate, print, etc. 

 

• File Copy – The File Copy indicator specifies if an additional copy of a form/notice should print 
when the print option is activated—one-to-many copies for the intended purpose and one copy for 
the case file. 

 

• Write to Case History – The Write to Case History Indicator specifies if a copy of the form/notice 
is saved and written to a Case History/Register of Action entry when the form is 
generated/printed. If set to "No," the system will not keep a record of the report after it is 
generated/printed. 

 

• Possible Recipients – When a form/notice is generated, a list of possible recipients displays. 
This list appears in the Select Form Recipients screen and the user must indicate the participants 
that will/will not receive a copy of the form/notice.  
A Name/Address header is coded into each form/notice template and the system automatically 
personalizes the form/notice output according to the user's selections. The information you enter 
in these fields affects what the user sees when making these participant selections. 

 

• Role – Only the participants in the selected roles appear in the list of possible recipients. If the 
Role check box is clear, then the By Default and Display Participants Only fields are not 
applicable. 

x 
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• By Default – The By Default indicator specifies if the participants in the role are automatically 
included in the list of persons who will receive the form/notice. 

 

• Display Participants – The Display Participants Only field determines if all case participants are 
displayed as possible form/notice recipients or only those considered as "current" participants are 
displayed. 
Current participants are determined by the effective start and end dates assigned to the 
participant in the case participant profile information. 

 

When users generate a form/notice or document set, they have the opportunity to either accept or change 
the following settings:  Display Current or All Participants and the File Copy Indicator. 

Task Activity 

Perform the following steps to manage the forms/notices customized for your court. 
 

1. Select [Admin] > [Forms Administration] > [Define Forms]. 
Result: The Define Forms screen displays. 

 
 

 

2. To update a form, select the radio button associated with a form/notice and click the [Update] 
button. 
Result: The Define Forms - Update Form screen displays. 
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3. When adding a form/notice, select a template from the Form Template Name drop-down list.  
4. Enter/update the following required fields: 

• Form Name 
• Form Description 
• Effective Start Date 
• Form Category 
• File Copy 
• Write to Case History 

 

5. Enter/Update the other available fields as needed. 
6. Click the [Save] button. 
7. If the form/notice has configurable text, you will see a [Edit Configurable Text] button at the 

bottom of the screen. If you want to edit the configurable text, do not click the [Save] button. 
Instead, click the [Edit Configurable Text] button. 
Result: The Edit Configurable Text screen displays. Refer to the Edit Configurable Text task 
activity to continue with this process. 

8. To remove a form/notice, select the radio button associated with a form/notice and click the 
[Remove] button. 

 

 

Related Links 

Manage Forms, Notices and Document Sets Overview 

Define Forms Screen 

Define Forms - Update Form Screen 

 

My Court Information 

 

Edit Configurable Text 

 

Introduction 

Configurable text is text that is court specific and affects all copies of a selected form/notice. The two 
ways to access the necessary screen are defined below. 

Using the Define Forms/Notices Task Activity 

When a form/notice has associated configurable text, you see a [Edit Configurable Text] button at the 
bottom of the Define Forms screen. If you know how the configurable text should read, you can click this 
button to save your form/notice and start this task activity. 
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Using the System Menu Tree 

If you do not know how the configurable text should read at the time you define a form/notice, you can 
return at a later time to enter this information using the system menu tree: [Admin] > [Forms 
Administration] > [Configure Editable Text Table]. 

Task Activity 

Perform the following steps to update the configurable text associated with a form/notice. 
 

1. Select [Admin] > [Forms Administration] > [Configure Editable Text Table]. 
OR 
From within the Define Forms screen, click the [Edit Configurable Text] button. 
Result: The Configure Editable Text Table screen displays. 

 
 

 

2. Select form or notice from the Form Name drop-down list. 
Result: The Configure Editable Text Table screen refreshes and displays the sections of the 
form/notice that contains editable text. 
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3. Enter/Update the editable text as appropriate.  
4. Click the [Save] button. 

 

 

Related Links 

Manage Forms, Notices and Document Sets Overview 

Configure Editable Text Table Screen 

 

My Court Information 

 

Manage Document Sets 

 

Introduction 

Document sets are available for: 

• Configuring in-process forms/notices 
• Managing form/notices outside of a process, including 

• Generating forms/notices 
• E-mailing forms/notices 
• Retrieving forms/notices 
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Save As 

The [Save As] button enables you to create a new document set using an existing one.  

Updates and Versions 

When you update a document set, use the [Update] button to access the screen that enables you to 
make changes.  

When you first create a document set, you will have only one version and therefore will not be able to use 
the [Update Version] option. However, once you update the Effective End Date on a document set, you 
can create a new version of the same document set. You need to use the [Update Version] button to 
access the screens enabling changes to the document set versions. 

Out of Process Indicator 

The out of process indicator specifies if the document set is available to generate outside of a process. 

Effective Start and End Dates 

The Effective Start Date indicates when the document set is available in the list of available 
forms/notices/document sets. The Effective End Date indicates when the document set is no longer 
available in the list of available forms/notices/document sets. 

Task Activity 

Perform the following steps to view, add, update, and remove document sets defined for your court.  
 

1. Select [Admin] > [Forms Administration] > [Active Documents]. 
Result: The Define Document Sets screen displays. 

 
 

 

2. To remove a document set, click the Remove link associated with the document set being 
deleted. 
Result: The system removes the document set from the list of available document sets. 
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3. Consider the following options: 
4. To add a new document set click the [Add New] button. 
5. To copy an existing document set, select the radio button associated with the document 

set being copied and click the [Save As] button. 
6. To update an existing document set, select the radio button associated with the document 

set being updated, and click the [Update] button or the [Update Version] button. 
7. Result: For all of these actions, the Define Document Sets - Select Forms screen displays. 

 
 

 

 

4. Select/Update the following required fields: 

• Document Set Name 
• Document Set Description 
• Out-of-Process Indicator 
• Effective Start Date 
• Category 
Result: All documents sets that are part of the selected category display in the Forms Available 
box.  

5. Use the Add> and <Remove links to move forms/notices between the Forms Available box and 
the Document Set Forms box. 

6. Continue this process using the appropriate categories until the document set is completely 
defined. 

7. Click the [Save] button. 
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Related Links 

Manage Forms, Notices and Document Sets Overview 

Define Document Sets Screen 

Define Document Sets - Select Forms Screen 

 

Manage Out-of-Process Forms 

Manage Out-of-Process Forms, Notices and Document Sets Overview 

 

Introduction 

Out-of-process forms/notices and document sets are documents that are generated, retrieved, viewed, 
printed, and e-mailed outside of a system process.  

Task Activities 

Out-of-process documents include the following task activities:  

• Generate a Form/Notice or Document Set 
• Retrieve a Form/Notice or Document Set 
• Configure E-Mail Options (Local Administrator) 
• Email Forms/Notices or Document Sets to Case Participants 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Background Information 

 

 

Related Links 

Generate Form/Notice Screen 

Select Form Recipients Screen 

Configure Email Options Screen 

Email Form Notice Screen 

Select Email Recipients Screen 

 

My Court Information 
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Generate a Form/Notice or Document Set 

 

Introduction 

This task activity allows you to generate documents outside of a system process.  

Unavailable Forms/Notices and Document Sets 

Since some forms/notices and document sets use contextual data that is entered in screens leading up to 
the form/notice generation, not all forms/notices and document sets are available for out-of-process 
generation. 

Print Options 

Generating out-of-process forms/notices and document sets has three print options: 
 

• Print Without Preview – This option generates the form/notice or document set and prints it 
directly to the user's computer's default printer without displaying them in a browser window. 

 

• Preview in Browser – This option generates the form/notice or document set and displays it in a 
browser window. The user can print the displayed results using the browser Print option. 

 

• Defer to Work Queue – This option generates documents but does not display or print them. 
Using Entry Action configuration for work queues, the system creates a work queue task in the 
appropriate work queue. Users print the generated documents when performing the work queue 
task. 

 

 

Typically, once you generate a form/notice or document set, the system will save a copy so that a user 
can retrieve it at a later date. However, the configuration options associated with defining a form/notice 
will determine whether or not a copy will be saved. 

Task Activity 

Perform the following steps to generate out-of-process forms/notices and document sets. 
 

1. Select the [Forms] top navigation item. 
Result: The Generate Form/Notice screen displays. 
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2. Select the form/notice/document set Category. 
Result: The screen refreshes and displays an additional field that allows you to select a 
form/notice or document set from the selected category. 

 
 

 

3. Select the form/notice or document set from the Form/Notice Name field. 
Result: The screen refreshes again and displays a section for input values specific to the selected 
form/notice or document set. 

 
 

 

4. Enter/Select data values as appropriate. 
5. Select the appropriate Print Option. 
6. Click the [Generate Form/Notice] button. 

Result: The Select Form Recipients screen displays. 
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7. Use the Add> and <Remove links to transfer names to and from the Possible Recipients and 
Form Recipients boxes. 

 You must first select a name from the appropriate recipient box. 
8. Click the [Save] button. 

 

 

Related Links 

Manage Out-of-Process Forms, Notices and Document Sets Overview 

Generate Form/Notice Screen 

Select Form Recipients Screen 

 

My Court Information 

 

Retrieve a Form/Notice or Document Set 

 

Introduction 

This task activity allows you to find and print forms/notices and/or document sets that have been already 
generated for a case. 
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Task Activity 

This task activity takes place within the context of a case. Refer to the Search Cases task activity for 
details on performing a case search. 

Perform the following steps to find and print forms/notices and/or document sets that are already 
generated for a case. 
 

1. Select the [Case History] left navigation item. 
Result: The Case History screen displays. 

 
 

 

2. Find the appropriate form/notice or document set and click the associated document icon. 
Result: The document opens in a browser window. 

3. Use the browser Print option to print the displayed documents. 
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Related Links 

Manage Out-of-Process Forms, Notices and Document Sets Overview 

Case History Screen 

 

My Court Information 

 

Email Forms/Notices and Document Sets to Case Participants 

 

Introduction 

When you email documents to case participants, you are responsible for selecting the email recipients 
and attaching the correct documentation. All other information is populated as specified: 
 

• From Name – Configured by local administrator. 
 

• Subject – Derived from the case you are working in. 
 

• Email Introduction Text – Configured by local administrator. 
 

• Email Text – Derived from the case you are working in and organized according to a system-
supplied template. 

 

 

You will not see case participant names who do not have an e-mail address defined in the system. 

Task Activity 

This task activity takes place within the context of a case. Refer to the Search for a Case task activity for 
details about performing a case search. 

Perform the following steps to email forms/notices and document sets to case participants. 
 

1. Select the [Email Form Notice] left navigation item. 
Result: The Email Form Notice screen displays. 
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2. Select the checkboxes for the forms/notices and/or document sets that you want to email.  
3. Click the [Select Recipients] button to continue. 

Result: The Select Email Recipients screen displays. 
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4. Use the Add> and <Remove links to move recipient names between the Possible Recipients box 
and the Email Recipients box. 

 You must first select a name from the appropriate recipient box. 
5. Click the [Send] button. 

 

 

Related Links 

Manage Out-of-Process Forms, Notices and Document Sets Overview 

Email Form Notice Screen 

Select Email Recipients Screen 
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The Admin Section 

Application Administration 

Reference Table Manager 

Reference Table Manager Overview  

 

Introduction 

The term "Reference Tables" refers to tables within the system that may be configured to meet the needs 
of your court. You can configure reference table values through the Reference Table Manager.  

When configuring reference tables, you can create, update or expire reference table values. Since 
reference tables are pre-defined and already exist in the system, you cannot create new reference tables. 

In addition, you cannot add, edit or expire values from non-configurable reference tables (such as system 
tables). Non-configurable reference tables contain values that are used to support overall system 
functionality. You will be able to view both configurable and non-configurable reference tables from the 
Reference Table Manager, but you will not have access to modify non-configurable reference table 
values. 

Reference Table Relationships 

The system contains pre-defined relationships between tables, such as case and filing data. In the event 
that a pre-defined relationship exists between two different sets of data, you can create a new reference 
table relationship. Reference Table Relationships allow you to relate two separate pieces of data 
together. For example, you can create a relationship between a specific division and a specific court 
location. These relationships can also be created with an effective date range to help manage the 
creation and deletion of relationships. 

When creating a Reference Table relationship, you will specify the parent table and the child table. The 
child table will contain one or multiple values that are related to the parent table. 

Parent Tables and Value Attributes 

Some reference tables may have parent tables. Parent tables contain values that may be associated to 
one or many reference table values. For example, multiple fee types may be associated to a fee category, 
which would make the fee category a parent table of fee type. When adding and updating values within 
the system, you will be required to specify the parent table value if the selected Reference Table is 
associated to a parent table.  

Each reference table may contain different types of attributes. Attributes are additional data that may be 
assigned to a reference table value. When adding or updating a value to a reference table value, you may 
be required to enter data for any attributes associated to the reference table.  

Task Activities 

The Reference Table Manager includes the following task activities: 

• Add Reference Table Values 
• Search Reference Table Values 
• Update Reference Table Values 
• Expire Reference Table Values 
• Edit Reference Table Descriptions 
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• Create Reference Table Relationships 
• Expire Reference Table Relationships 

Additional Resources 

Other items related to this overview includes the following:  

• Reference Table Manager Reference Materials 
• Business Rules 
• Forms/Notices/Reports 

 

 

Related Links 

Add Reference Relationships - Select Rows Screen 

Add Reference Relationships - Select Tables Screen  

Maintain Reference Tables - Add/Update Value to Table Screen 

Maintain Reference Tables - Edit Table Description Screen 

Maintain Reference Tables - Search for Values in Table Screen 

Maintain Reference Tables - Table Listing Screen 
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Search Reference Table Values 

 

Introduction 

This activity allows you to search for records within a reference table. It also provides the foundation for 
maintaining reference table values. For example, you must perform this search in order to add, expire or 
update table values. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a Reference Table value. 
 

1. Select [Admin] > [Application Administration] > [Maintain Reference Tables]. 
Result: The Table Listing screen displays. 
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2. Click the [Reference Table Name] link for the table for which you want to search values. 
Result: The Search for Values in Table screen displays. 
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3. Select a Filter value. 
4. Enter/Select data for other search parameter fields, as necessary. 
5. Click the [Search] button. 

Result: The Search for Values in Table screen displays. 

 
 

 

 

 

Related Links 

Reference Table Manager Overview 

Maintain Reference Tables - Table Listing Screen 

Maintain Reference Tables - Search for Values in Table Screen 
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Add Reference Table Values 

 

Introduction 
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You can add values to a reference table. This process will cause these values to become available in 
screens that use the associated values from the reference table. Refer to the Reference Table Manager - 
Additional Materials for details on reference tables and their use. 

Task Activity 

Perform the following steps to add a value to a reference table. 
 

1. Select [Admin] > [Application Administration] > [Maintain Reference Tables]. 
Result: The Table Listing screen displays. 

 
 

 

2. Click the [Reference Table Name] link for the table you wish to add a value to. 
Result: The Search for Values in Table screen displays. 
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3. Click the [Add New Value] button. 
Result: The Add Value to Table screen displays. 
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4. Enter/Select data for the following required fields: 

• Code 
• Description 
• Value in Parent Table 
• Effective Start Date 

 

5. Click the [Save] button. 
Result: The Table Listing screen displays. 

 
 

 

 

 

Related Links 

Reference Table Manager Overview 

Maintain Reference Tables - Table Listing Screen 

Maintain Reference Tables - Search for Values in Table Screen 

Maintain Reference Tables - Add/Update Value to Table Screen 

 

My Court Information 
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Update Reference Table Values 

 

Introduction 

You can update values in a reference table. Updating values in a reference table will cause these values 
to change in screens that use the associated values from the reference table. Refer to the Reference 
Table Manager - Additional Materials for details on Reference Tables and their use. 

Activities Performed Before Performing "Update"  

This activity takes place after performing a search for a reference table value within a selected reference 
table. Refer to the Search Reference Table Values task activity for details on performing this search. 

Task Activity 

Perform the following steps to update a Reference Table value.  
 

1. Select the [Description] link for the reference table value you wish to update. 
 This selection occurs from the search results of the Search for Values in Table screen.  

 
 

 

2. Result: The Update Values screen displays. 
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2. Enter data for the following required fields: 

• Code 
• Description 
• Value in Parent Table 
• Effective Start Date 

 

3. Click the [Save] button. 
Result: The Search for Values in Table screen displays. 
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Related Links 

Reference Table Manager Overview 

Maintain Reference Tables - Add/Update Value to Table Screen 

Maintain Reference Tables - Search for Values in Table Screen 
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Expire Reference Table Values 

 

Introduction 

You can expire values in a reference table. Expiring values in a reference table will cause these values to 
no longer be available in screens that use the associated value. Refer to the Reference Table Manager - 
Additional Materials for details on Reference Tables and their use. 

Activities Performed Before Expiring a Value 
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This activity takes place after performing a search for a reference table value within a selected reference 
table. Refer to the Search Reference Table Values task activity for details on performing this search. 

Task Activity 

Perform the following steps to expire a Reference Table value. 

1. Select the [Description] link for the reference table value you wish to expire. 
 This selection occurs from the search results of the Search for Values in Table screen.  

 
 

 

2. Result: The Update Values screen displays. 
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2. Enter the date you want the reference table value to expire into the Effective End Date field. 
3. Click the [Save] button. 

Result: The Search for Values in Table screen displays. 
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Related Links 

Reference Table Manager Overview 

Maintain Reference Tables - Search for Values in Table Screen 

Maintain Reference Tables - Add/Update Value to Table Screen 
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Edit Reference Table Descriptions 

 

Introduction 

You can edit the description of a Reference Table. Each reference table contains a description accessible 
by only System Administrators. 

Task Activity 

Perform the following steps to edit a Reference Table description. 
 

1. Select [Admin] > [Application Administration] > [Maintain Reference Tables]. 
Result: The Table Listing screen displays. 
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2. Click the [Reference Table Name] link for the table you want to update. 
Result: The Search for Values in Table screen displays. 
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3. Click the [Update] link. 
Result: The Edit Table Description screen displays. 

 
 

 

4. Enter/Update the description for the Table Description field. 
5. Click the [Save] button. 

Result: The Table Listing screen displays, with an updated description for the selected reference 
table. 
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Related Links 

Reference Table Manager Overview 

Maintain Reference Tables - Table Listing Screen 

Maintain Reference Tables - Search for Values in Table Screen 

Maintain Reference Tables - Edit Table Description Screen 
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Create Reference Table Relationships 

 

Introduction 

Reference Table Relationships allow you to relate two separate pieces of data. For example, you can 
create a relationship between a specific division and a specific court location. These relationships can 
also be created with an effective date range to help manage the creation and deletion of the relationships.  

Task Activity 



The Admin Section 

1195 

Perform the following steps to create a Reference Table relationship. 
 

1. Select [Admin] > [Application Administration] > [Add Reference Table Value 
Relationships]. 
Result: The Add Reference Table Value Relationships screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Child Table 
• Parent Table 

 

3. Click the [Next] button. 
Result: The Select Values screen displays. 
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4. Enter/Select data for the following required fields: 

• Child Table Value 
• Parent Table Value 
• Begin Date 
• Filter 

 

5. Click the [Add/Update Relationship] button. 
Result: The Select Values screen displays. 



The Admin Section 

1197 

 
 

 

 

 

Related Links 

Reference Table Manager Overview 

Add Reference Relationships - Select Tables Screen 

Add Reference Relationships - Select Rows Screen 
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Expire Reference Table Relationships 

 

Introduction 

Reference Table Relationships allow you to relate two separate pieces of data. For example, you can 
create a relationship between a specific division and a specific court location. These relationships can 
also be created with an effective date range to help manage the creation and deletion of the relationships. 
You may expire a reference table relationship by entering a date for the End Date of the relationship. 

Task Activity 
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Perform the following steps to expire a reference table relationship.  
 

1. Select [Admin] > [Application Administration] > [Add Reference Table Value 
Relationships]. 
Result: The Add Reference Table Value Relationships screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Child Table 
• Parent Table 

 

3. Click the [Next] button. 
Result: The Select Values screen displays. 
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4. Enter the date you want the reference table relationship to expire into the End Date field of the 
selected Parent Table Value and Child Table Value relationship. 

5. Click the [Add/Update Relationship] button. 
Result: The Select Values screen displays.  
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Related Links 

Reference Table Manager Overview 

Add Reference Relationships - Select Tables Screen 

Add Reference Relationships - Select Rows Screen 

 

Information Audit Trail 

Information Audit Trail Overview 

 

Introduction 

The audit trail provides functionality to search for, view, and print information about system changes 
made to a case. For example: 

• Name of updated field 
• Old and new field values 
• Date change was made 
• User ID of the person who made the change 
• Computer ID that identifies the computer used to make the change 

Audited Fields and Exceptions 

Audited fields are a non-configurable setting in the system. This means field changes that are tracked 
within the system are pre-defined and cannot be changed.  

Accounting 

Accounting changes are not tracked in the audit trail because all financial transactions are saved in the 
database and may be searched for and viewed within the Accounting section. 

Reference and Lookup Tables 

Changes made in the reference and lookup tables are not tracked in the audit trail, since these tables 
have start and end dates that indicate when the associated functionality is in effect, and the records are 
not actually changed. When changes are made, they indicate the expiration of one record and the start of 
another. Therefore, all records are saved and not changed, and create their own audit trail. 

Printing 

Although it is not a required step, the system does provide functionality to print your audit trail search 
results from an ".html" page. 

Task Activities 
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Viewing the audit trail includes the following task activity: 

• Search the Information Audit Trail 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

Information Audit Trail - Search Screen 
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Search the Information Audit Trail 

 

Introduction 

This activity allows you to search for audit trail information. Refer to the Search Feature Overview for 
details on performing a search in the system. 

Task Activity 

Perform the following steps to search for and print audit trail information. 
 

1. Select [Admin] > [Application Administration] > [Information Audit Trail]. 
Result: The Information Audit Trail - Search screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields.  
 When searching by date range, the range cannot exceed 30 days. 

3. Click the [Search] button. 
Result: The Information Audit Trail - Search screen refreshes with the Search Results. 
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 Click the [Print All Results] button to create a report displaying the search results. 

 

 

Related Links 

Information Audit Trail Overview 

Information Audit Trail - Search Screen 

 

Printing 

Printing Overview  

 

Introduction 

This section provides information about configuring printers that are used to print: 

• Both in-process and out-of-process forms/notices and document sets 
• Both in-process and out-of-process reports 

Printer Options 

All reports, forms, notices, and document sets, regardless of how they are generated, will print to the 
user's desktop default printer, with one exception - documents/reports printed in batch.  

Batch printing generated reports 

Reports that print at the same time they are generated use the printer specified when the report batch 
was scheduled. The source of the printer selection list comes from the printers defined in Configure 
Printers screen. 
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Batch printing associated with an action entry or case clock expiration 

Documents that batch print as the result of an action entry or a case clock expiration use printer routing 
information to determine the correct printer to use. The source of the printer selection list provided during 
printer routing configuration comes from the printers defined in the Configure Printers screen. 

Task Activities 

Printing of reports, forms, notices, and document sets include the following task activities: 

• Configure Printers 
• Configure Batch Print Routing 

Additional Resources 

Other items related to this overview include the following:  

• Manage Action Entries Overview 
• Batch Scheduling and Printing Background Information 
• Schedule a Report 

 

 

Related Links 

Configure Printers Screen 

Configure Batch Print Routing Screen 

 

My Court Information 

 

Configure Printers 

 

Introduction 

You can configure printers so they are available when: 

• Users schedule reports to generate in batch and want them to print when they are generated. 
• Printer mapping criteria is defined for forms/notices and document sets that batch print. 

Assumptions 

This task activity assumes that printers are defined in Crystal Enterprise™ when printers are used to print 
reports and Adobe® Central Pro Output Server when printers are used to batch print forms/notices and 
document sets. 

Task Activity 

Perform the following steps to configure printers. 
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1. Select [Admin] > [Application Administration] > [Configure Printers]. 
Result: The Configure Printers screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Court Location 
• Friendly Printer Name 
• Printer Address 

 

3. Click the [Save] button. 
4. To add another printer, click the [Add Another] button and enter the required fields. 
5. Click the [Save] button. 
6. To remove a printer, select the check boxes associated with the printers to be removed and click 

the [Remove] button. 
 Follow this process until all printers are added. 

 

 

Related Links 

Printing Overview 

Configure Printers Screen 

 

My Court Information 

 

Configure Batch Print Routing 
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Introduction 

You can define printer routing information for a particular form/notice or document set that batch prints 
from either the ROA or a case clock.  

This information identifies the specific printer to be used when documents being printed in batch meet the 
defined conditions. For example, when printing "this" form with "this" case category and "this" case type, 
etc., use "this" printer. 

Task Activity 

Perform the following steps to define the printer routing information.  
 

1. Select [Admin] > [Application Administration] > [Configure Batch Print Routing]. 
Result: The Configure Batch Print Routing screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 
3. Form 
4. Case Category 
5. Case Type 
6. Court Location  
7. Printer 

8.  

3. Click the [Save] button. 
4. To add another record, click the [Add Another] button and enter the required fields. 
5. Click the [Save] button. 
6. Follow this process until all routing records are added. 
7. To remove a routing record, select the check boxes associated with the routing records to be 

removed and click the [Remove] button. 
 Follow this process until all routing records are added. 
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Related Links 

Printing Overview 

Configure Batch Print Routing Screen 

 

My Court Information 

 

Configure Email Options 

 

Introduction 

When documents are e-mailed to case participants, the email contains the following configured 
information: 

• Sender information 
• Introduction text 

 

 

The system extracts information from the associated case and uses a system-supplied template to 
populate the body of the email. The introduction text that you configure includes any information that is 
not included in the template. Typically, the introduction text has a "Do Not Reply to This Email" message 
since replying to the email is not possible. 

Task Activity 

Perform the following steps to configure email options for forms/notices and document sets. 
 

1. Select [Admin] > [Application Administration] > [Configure Email Options]. 
Result: The Configure Email Options screen displays. 
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2. Enter Sender information. 
 You can enter either the court's email address or the court name in the Sender field. 

3. Enter Email Body Text, if needed. 
4. Click the [Save] button. 

 

 

Related Links 

Out-of-Process Forms, Notices and Document Sets Overview 

Configure Email Options Screen 

 

Case Administration 

Configure ROA Entries 

Configure ROA Entries Overview  

 

Introduction 

Configuring Register of Action (ROA) entries defines the text and additional actions that need to be 
recorded when an action takes place on the case. 

Only local System Administrators may perform ROA configuration processes. 

About Case History Entries 
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Case History entries, also known as action entries, represent the actions and events that occurred on a 
case. Each entry is a piece of text that records a case-related activity. This collection of entries provides 
you with a "history" of case events. 

About ROA Entries 

The ROA is the public view of a case. These entries initially have a security level of "1," which allows the 
public to view these case details and events. Basically, these entries are a sub-set of the Case History. 

Configuring Entries 

You must configure case history/ROA entries prior to system use. This means that a Court must provide 
the system with configured entries for each case type before it can write entries to the ROA/Case History. 
These configure entries apply to both the ROA and the Case History, since the ROA is a subset of the 
Case History. 

Configuring a history entry records the basic information about the entry. For example, an entry consists 
of both short and long entries. These entries are the standard, static text that the system uses to describe 
a case action that occurred. Additional parameters can be combined with this static text. You must also 
specify which case categories and case types can use this entry, and when this entry can be executed in 
the system. 

Defining Causal Actions 

You must select the action that prompts the system to record the selected case history entry. A causal 
action is defined by a function, a system action, and optionally a parameter. 

For example, if you select an entry function of "filing," you can then choose a causal action of "filed" and a 
parameter value of "Proof of Service." This selection indicates that the filing of the Proof of Service filing 
document should record a history entry. 

Setting Automated Logic 

The automated logic component allows you to select what system actions should occur based on the 
entry. You can apply different logic for each case type that you select.  

You should record automated logic in order to execute certain actions based on the creation of an entry. 
For example, you can choose to have an entry automatically update the security level and/or status of an 
entire case. You can also have an entry generate and display/print a form. 

You can also configure an entry to start a series of "next steps" that may accompany a business process. 
For example, the recording of an entry may send a task to a work queue. This task would direct you to a 
specific screen and request you to record a payment, schedule an event, or update case participant 
information in order to complete a certain process. 

Entry Validations 

The configured case history/ROA entries in the system must be unique. A unique entry is defined by its 
function, type, causal action, parameter, effective dates, case category(ies) and case type(s). 

Task Activities 

Configuring ROA History entries includes the following task activities: 

• Configure ROA Entries 
• Update ROA Entries 
• Save As New ROA Entries 

Additional Resources 



The Admin Section 

1209 

There are no other resources related to this overview.  

 

 

Related Links 

Add ROA History Entries Screen 

List ROA History Entries Screen 

 

My Court Information 

 

Configure ROA Entries 

 

Introduction 

Adding a history entry defines a set of actions and parameters that the system uses to execute the 
appropriate action entry for a given case event. 

Task Activity 

Perform the following steps to configure case history entries. 
 

1. Select [Admin] > [Case Administration] > [Add ROA History Entries]. 
Result: The Add ROA History Entries screen displays. 
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2. Enter/Select data for the following required fields: 
3. Entry Name 
4. Entry Function 
5. Effective Date Start 
6. Entry Type 

 If you select the Write Case History Entry option, then you must provide the appropriate 
Short Entry text. 

 If you choose a parameter to be included in the short entry or long entry, then the system 
will combine this standard text with information collected from the case. For example, if you 
select a short entry parameter of "Hearing Scheduled for ((Event Date))," an entry on the case 
will display as "Hearing Scheduled for 05/27/2004." 

3. Enter/Select data for the other necessary fields within the Entry Information section. 
4. Click the toggle button for the appropriate case category. 

 You can also Select All of the case types for a specific case category. 
Result: The screen refreshes and displays the case types listed for the selected case category. 
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5. Select the checkboxes for the case types to which this entry refers. 
 Each case type selection will produce a separate section on the Automated Logic tab. 

6. Select the [Causal Actions] tab. 
Result: The Causal Actions tab highlights. 
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7. Select data for the following required fields: 
8. Action 
9. (Parameter) 

 The Action field is populated based on the selected Entry function. 

8. Click the [Add Another Causal Action] button if necessary. 
 This option allows you to select more causal actions for the entry. Additional causal actions 

may be necessary if two actions in the system can cause the same entry. 
Result: The screen will refresh and display another row of action and parameter fields. 

9. Click the [Automated Logic] tab. 
Result: The Automated Logic tab highlights. 
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10. Enter/Select data for the necessary fields. 
 These fields allow you to define what system actions should occur after recording the 

selected entry. 
11. Click the [Save] button. 

Result: The List ROA History Entries screen displays with a confirmation message. 
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Related Links 

Configure ROA Entries Overview 

Add ROA History Entries Screen 

List ROA History Entries Screen 

 

My Court Information 

 

Update ROA Entries 

 

Introduction 

Updating an ROA history entry changes the configuration settings for an ROA entry. A system 
administrator can update an entry only while the newly changed entry remains unique to the system.  

Changing ROA Entry Settings 

You can change many different entry settings. For example, you can add or update the case types that 
use this entry or redefine the causal actions. You can also add or change the available automatic logic 
assigned to the entry. However, refer to the Configure ROA History Entries task activity for details on 
adding a new entry to the system.  
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Task Activity 

Perform the following steps to update the configuration of a ROA History entry. 
 

1. Select [Admin] > [Case Administration] > [List ROA History Entries]. 
Result: The List ROA History Entries screen displays. 

 
 

 

2. Click the [Entry Name] hyperlink for the entry to update. 
Result: The Add ROA History Entries screen displays. 
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3. Enter/Update the available fields as needed. 
4. Select the [Causal Actions] tab. 

Result: The Causal Actions tab highlights. 
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5. Enter/Update the available fields as needed. 
6. Click the [Automated Logic] tab. 

Result: The Automated Logic tab highlights. 
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7. Enter/Update the available fields as needed. 
8. Click the [Save] button. 

Result: The List ROA History Entries screen displays with a confirmation message. This screen 
will list the appropriate changes made to the entry. 
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Related Links 

Configure ROA Entries Overview 

List ROA History Entries Screen 

Add ROA History Entries Screen 

 

My Court Information 

 

Save As New ROA Entries 

 

Introduction 

Using the “Save As” feature allows an existing ROA configuration to be used as a “template” for a new 
ROA entry. Changes made to the ROA configuration only apply to this new entry and do not change the 
selected template. 

Required Entry Changes 

After selecting a template entry, you must change at least one parameter to make the entry unique. 
Otherwise, this “new” ROA entry will be an exact copy of the template, and the system does not support 
duplicate entries. 
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Task Activity 

Perform the following steps to save a configured ROA entry as a new entry. 
 

1. Select [Admin] > [Case Administration] > [List ROA History Entries]. 
Result: The List ROA History Entries screen displays. 

 
 

 

2. Click the [Entry Name] hyperlink for the entry to update. 
Result: The Add ROA History Entries screen displays. 
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3. Change at least one of the following data fields: 
4. Entry Function 
5. Effective Date Start 
6. Effective Date End 
7. Entry Type 
8. Causal Action 
9. Parameter 

 A unique entry is defined by its function, type, causal action, parameter, effective dates, 
case category(ies) and case type(s). 

4. Enter/Select data for the other necessary fields. 
5. Select the [Causal Actions] tab. 

Result: The Causal Actions tab highlights. 
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6. Enter/Select data for the necessary fields. 
7. Click the [Automated Logic] tab. 

Result: The Automated Logic tab highlights. 
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8. Enter/Select data for the necessary fields. 
 These fields allow you to define what system actions should occur after recording the 

selected entry. 
9. Click the [Save As] button. 

Result: The List ROA History Entries screen displays with a confirmation message. This screen 
will list the appropriate changes made to the entry. 
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Related Links 

Configure ROA Entries Overview 

List ROA History Entries Screen 

Add ROA History Entries Screen 

 

Configure Case Assignment Rules 

Configure Case Assignment Rules Overview  

 

Introduction 

Configuring case assignment rules defines a set of criteria that the system will follow when recommending 
a resource to a case. You must have a System Administrator security role to perform rule configuration 
activities. 

About Assignment Rules 

An assignment rule is an algorithm that the system follows when proposing a resource to be assigned to 
a case. A case resource is a person/entity involved with helping to process a case to completion. 
Assignment rules come into effect either during case initiation or in case management activities. 
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Courts can only configure assignment rules for the following six resource types: Judicial Officers, 
Departments, Arbitrators, Mediators, Court Appointed Attorneys and Probate Investigators. 

You can configure assignment rules for a given location, case category, and case type combination. 
However, this configuration also depends on the selected resource type. For example, the required field 
selections for a Judicial Officer resource rule are more complex than those for a Probate Investigator rule. 

About Case Distribution 

Each resource type has its own method of assignment. These methods help to evenly and fairly distribute 
resources of the same type to cases. 

For example, some resource types require that you choose either a rotational or random method of 
assignment. A Rotational assignment is similar to a sequential selection. The system will follow a virtual 
“list” of resources and always propose the “next” resource on the list to a case. For random assignments, 
the system will arbitrarily propose a resource based on the list of resources that qualify. A Random 
assignment, on the other hand, is similar to a weighted percentage. 

Activities Performed Prior to Configuring a Rule 

You must conduct an assignment rule search in order to select a rule to update or use as a template. 
However, it is recommended that you also conduct this search prior to creating an assignment rule in the 
system. This helps to check whether a given rule already exists, which may reduce the risk of entering a 
duplicate assignment rule.  

Rule Validations 

The system rules must be unique. A unique case assignment rule is defined by its resource type, case 
category(ies), case type(s), location(s), and effective start and end dates. 

Date ranges for assignment rules are exclusive. This means two rules that share the same attributes 
cannot overlap the dates in which they are effective. 

Once saved, the rule will become available from the Search Case Assignment Rules screen and go into 
effect at the specified start date. 

Task Activities 

Configuring case assignment rules includes the following task activities: 

• Search Case Assignment Rules 
• Add Case Assignment Rules 
• Update Case Assignment Rules 
• Save As New Assignment Rules 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Configure Case Assignments - Search Case Assignment Rules Screen 

Configure Case Assignments - Add Assignment Rule Screen 
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Configure Case Assignments Screen 

 

My Court Information 

 

Search Case Assignment Rules 

 

Introduction 

Searching for a case assignment rule searches and displays rules that currently exist in the system. You 
must have a  System Administrator security role to have access to the search and related rule 
configuration screens. 

Rule Search Functionality 

The system performs a search based on field parameters that you provide. Only configured case 
assignment rules that match the entered search criteria will display in the results list. Review the Add 
Case Assignment Rules task activity for details on creating and configuring a rule. 

The search function also provides the foundation for maintaining case assignment rule information. For 
example, you must perform a case assignment rule search in order to update rules or save an existing 
rule as a new rule.  

Task Activity 

Perform the following steps to search for a case assignment rule. 
 

1. Select [Admin] > [Case Administration] > [Configure Case Assignments]. 
Result: The Configure Case Assignments – Search Case Assignment Rules screen displays. 
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2. Select data for the following required fields: 
3. Resource Type 
4. Filter Criteria 

 Selecting other filter criteria, such as the rule name and case category, narrows the 
search results and increases the likelihood of finding a closer rule match. 

3. Click the [Search] button. 
Result: The screen refreshes with the Search Results. 

 
 

 

 From the Search Results, you can perform the Update Case Assignment Rules or the 
Save as New Assignment Rules task activities. 

 

 

Related Links 

Configure Case Assignment Rules Overview 

Configure Case Assignments - Search Case Assignment Rules Screen 

 

My Court Information 

 

Add Case Assignment Rules 

 

Introduction 
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Adding a case assignment rule creates a set of assignment criteria for a resource type. These criteria 
provide guidelines for the system to follow when recommending the selected resource type to a case. 

Methods for Configuring Resource Types 

The method and requirements for adding a new assignment rule depend on the resource type. For 
example, the "Method of Selection" for some resource types requires you to choose either a rotational or 
random distribution method. Other resource types may also require you to select assignments either by 
case number or by a distribution percentage.  

If you select the Recommend at Case Initiation checkbox for a given resource type, the system will 
propose a resource that matches the case criteria during the case initiation process. The resources with 
this option include: Judicial Officers, Departments, Court Appointed Attorneys, and Probate Investigators. 

Rule Start Dates 

Case assignment rules require a start date. However, providing an end date is optional. The date range 
affects the rule filter criteria and also determines when and for how long the system may use this rule. 
The search filter uses the date range in relation to the current date.  

Task Activity 

Perform the following steps to configure a case assignment rule. These steps are broken down based on 
the selected resource type. 
 

1. Select [Admin] > [Case Administration] > [Configure Case Assignments]. 
Result: The Configure Case Assignments – Search Case Assignment Rules screen displays. 

 
 

 

2. Click the [Add Assignment Rule] button. 
Result: The Configure Case Assignments – Add Assignment Rule screen displays. 
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3. Enter/Select data for the following required fields: 
4. Resource Type 
5. Case Category 
6. Location 

 Not selecting a Case Type from the list will automatically assign every case type 
(belonging to the selected category) to this new rule. 

4. Click the [Next] button. 
Result: The Configure Case Assignments - [Resource Type] screen displays. 

 This screen will be different depending on the selected resource type. Refer to the 
following options: 

• Follow Steps 5-7 for Court Appointed Attorneys and Probate Investigators. 
• Follow Steps 8-12 for Arbitrators and Mediators. 
• Follow Steps 13-17 for Judicial Officers and Departments. 

 

5. Review the Configure Case Assignments – [Court Appointed Attorney/Probate Investigator] 
screen. 
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6. Enter data into the following required fields: 
7. Rule Name 
8. Start Date 

 

7. Skip to Step 18 to save this resource rule. 
8. Review the Configure Case Assignments – [Arbitrator/Mediator] screen. 
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9. Enter data into the following required fields: 
10. Rule Name 
11. Start Date 

 

10. Select either a Rotational or Random method of assignment. 
11. Choose a method of selection. 

 If choosing a set number of assignable arbitrators/mediators, enter the number value in the 
appropriate field. 

12. Skip to Step 18 to save this resource rule. 
13. Review the Configure Case Assignments – [Judicial Officer/Department] screen. 

 This screen displays the Judicial Officers/departments available for the selected case 
category(ies) and location(s). Refer to the Configure Department Resources and Manage Judicial 
Officers sections for details on assigning Judicial Officers and departments to Court locations. 

 
 

 

14. Enter/Select data into the following required fields: 
15. Rule Name 
16. Start Date 
17. Method of Assignment 
18. Type of Case 

 Follow Steps 15-17 if you select a “Random” method of assignment. Otherwise, skip to 
Step 18. 

15. Select an assignment type. 
 Assign by either a case percentage or by case number.  

16. Enter a new percentage for the resource(s). 
 Only perform this step if the Assign By Case % option was selected. 
 The system will automatically calculate an equal distribution for empty percentage fields 

when saving this rule. 
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17. Select the case number attribute for assigning cases to the resource. 
 Only perform this step if the Assign by Case # option was selected. 
 Select the number value(s) if choosing the Ends In option. 

18. Click the [Finish & Save] button. 
Result: The screen refreshes with a confirmation message. This rule will now go into effect for 
new case resource assignments. 

 

 

Related Links 

Configure Case Assignment Rules Overview 

Configure Case Assignments - Search Case Assignment Rules Screen 

Configure Case Assignments - Add Assignment Rule Screen 

Configure Case Assignments Screen 

 

My Court Information 

 

Update Case Assignment Rules 

 

Introduction 

Updating a case assignment rule changes an existing set of assignment rule criteria. You must have a 
System Administrator security role to update a rule while the changed rule remains unique to the system.  

Reasons for Updating a Rule 

A case assignment rule may require changes due to load leveling events or Court policies. This allows 
you to change the applicable case types or the weighted distribution percentage for a rule, as necessary. 
Other updates, such as changing the number of arbitrators recommended by the system for a certain 
case type, may also occur. 

System Overrides - Judicial Officer Load Balancing 

While updating assignment rules allows you to change rule configurations, situations exist where the 
system may override these rules. For instance, Judicial Officer resource rules may occasionally require a 
"catch-up" or load balancing activity to allow for equitable case distribution. The system will run a batch 
job to "automatically" perform Judicial Officer load balancing. This process then overrides the configured 
case assignment rule for Judicial Officers until these resources have equal case distribution.  

Task Activity 

This activity takes place within the context of an assignment rule search. Refer to the Search Case 
Assignment Rules task activity for details on performing this search. 

Perform the following steps to edit case assignment rule configuration. 
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1. Select the radio button for the assignment rule to update. This selection occurs from the 
Configure Case Assignment Rules - Search Case Assignment Rules screen. 

 
 

 

2. Click the [Update] button. 
Result: The Configure Case Assignments – Add Assignment Rule screen displays. 

 
 

 

3. Enter/Update the available fields as needed. 
 Fields except for Case Type(s) are listed as read-only values. 
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4. Click the [Next] button. 
Result: The Configure Case Assignments – [Resource Type] screen displays. 

 This screen will be different depending on the selected resource type. 

 
 

 

5. Enter/Update the available fields as needed. 
 For Judicial Officer or department resource types, selecting the Assign By Case % 

option will display blank fields for the new distribution percentages. A new value entered in 
these fields will replace the current percentage displayed for that resource. You must re-enter 
a percentage into the new Percentage field if previously held percentages are to be carried 
over. 

 When you save the rule, the system will equally distribute the remaining percentage 
among those Judicial Officers/departments that did not have a percentage specifically stated. 

6. Click the [Finish & Save] button. 
Result: The screen refreshes with a confirmation message. Updates to this rule go into effect in a 
go-forward basis. 
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Related Links 

Configure Case Assignment Rules Overview 

Configure Case Assignments - Search Case Assignment Rules Screen 

Configure Case Assignments - Add Assignment Rule Screen 

Configure Case Assignments Screen 

 

My Court Information 

 

Save As New Assignment Rules 

 

Introduction 

Using the "Save As" feature allows an existing assignment rule to be used as a "template" for a new rule. 
Changes made to these rule parameters only apply to this new rule and do not change the selected 
template. 

Required Rule Changes 
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After selecting a template rule, you must change at least one rule setting to make the new rule unique. 
Otherwise, this "new" rule will be an exact copy of the template, and a duplicate rule validation will occur 
in the system. 

Task Activity 

This activity takes place within the context of an assignment rule search. Refer to the Search Case 
Assignment Rules task activity for details on performing this search. 

Perform the following steps to save a rule as a new assignment rule. 
 

1. Select the radio button for the rule to be used as a template. 
 This selection occurs from the Configure Case Assignment Rules - Search Case 

Assignment Rules screen. 

 
 

 

2. Click the [Save As] button. 
Result: The Configure Case Assignments – Add Assignment Rule screen displays. 
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3. Change at least one of the following data fields: 
4. Resource Type 
5. Case Category 
6. Location(s) 

 

4. Click the [Next] button. 
Result: The Configure Case Assignments – [Resource Type] screen displays. 

 This screen will be different depending on the selected resource type. 
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5. Enter/Select data for the necessary fields. 
6. Click the [Save] button. 

Result: The screen refreshes and displays a confirmation message. 

 
 

 

 

 

Related Links 

Configure Case Assignment Rules Overview 

Configure Case Assignments - Search Case Assignment Rules Screen 

Configure Case Assignments - Add Assignment Rule Screen 

Configure Case Assignments Screen 

 

Configure Automatic Case Clocks 

Configure Automatic Case Clocks Overview  

 

Introduction 

Configuring case clocks defines the action settings and events for an automatic case clock.  Refer to the 
Maintain Case Clocks section for details on maintaining both automatic and manual clocks. 

You must have the System Administrator security role to perform clock configuration processes. 

About Case Clocks 
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A clock is a mechanism used by the system to enforce timeliness of actions on a case. Certain actions on 
a case require the case participants to perform the next action within a specified number of days. Clocks 
are used to inform you that an expected action has not occurred, or that a new action may be required. 

Clocks start when certain defined actions occur and stop when the defined clock completing action takes 
place. For example, a clock starting action may be the appointment of an arbitrator, and the clock 
stopping action may be the filing of the arbitrator award. Clocks can also be paused and restarted. 

Clocks track the number of days in which a completing action should occur. If a completing action does 
not occur within the expected time frame, then the system will perform an action to alert you of this issue. 
This action depends on the event(s) configured for when a clock “expires.” For example, you may 
configure an expired clock to generate a report or schedule an event. 

Activities Performed Prior to Configuring a Clock 

You must conduct a case clock search in order to select an automatic clock to update or use as a 
template. It is also recommended that you conduct this search prior to creating a new clock in the system. 
This helps to check whether a given clock already exists, which may reduce the risk of entering a 
duplicate clock.  

Clock Validations 

Clocks in the system must be unique. A unique case clock is defined by its name and effective start and 
end dates. 

Assign Clocks to Tracks 

You will assign clocks to cases through track configuration. Refer to the Configure Case Tracks section 
for details on this process. 

Task Activities 

Configuring automatic case clocks includes the following task activities: 

• Search Case Clocks 
• Add Automatic Case Clocks 
• Update Automatic Case Clocks 
• Save As New Case Clocks 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Configure Case Clocks - Search Case Clocks Screen 

Configure Case Clocks Screen 

Configure Case Clocks - Add/Edit Action Screen 
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My Court Information 

 

Search Case Clocks 

 

Introduction 

Searching for a case clock searches and displays clocks that currently exist in the system. This activity 
includes both active and inactive clocks. You must have a System Administrator security role to access 
the search and related clock configuration screens. 

Clock Search Functionality 

The system performs a search based on field parameters that you provide. Only configured case clocks 
that match the entered search criteria will display in the results list. Refer to the Add Automatic Case 
Clocks task activity for details on creating and configuring a case clock. 

You must select a filter criteria in order for the search utility to function. Providing other parameter data 
helps to narrow the search results and increases the likelihood of finding a closer match. Refer to the 
Search Feature Overview for details on performing a search in the system. 

Using the Search Results 

The search function also provides the foundation for maintaining case clock information. For example, 
you must perform a case clock search in order to update a clock’s configured settings or save an existing 
clock as a new clock.  

Task Activity 

Perform the following steps to search for an automatic case clock. 
 

1. Select [Admin] > [Case Administration] > [Configure Case Clocks]. 
Result: The Configure Case Clocks – Search Case Clocks screen displays. 
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2. Select a Filter Criteria for the search. 
 This field limits the types of clocks returned in the search results. 

3. Enter/Select the other necessary filter criteria. 
4. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 

 
 

 

 From the Search Results section, you can perform the Update Automatic Case Clocks or 
Save as New Case Clocks task activities. 

 

 

Related Links 

Configure Automatic Case Clocks Overview 

Configure Case Clocks - Search Case Clocks Screen 

 

My Court Information 

 

Add Automatic Case Clocks 

 

Introduction 
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Adding an automatic case clock defines a set of actions that must occur on a case. These configured 
settings allow you to schedule required case activities to occur in a timely manner. 

Configure a Case Level Clock 

An automatic clock may be set at the case level. The configured actions for a case level clock apply to the 
participants on a given case at the same time. Basically, case level clock actions affect the activities of an 
entire case. 

Configure a Participant Level Clock 

The other configuration option is to set an automatic clock at the participant level. Participant level clocks 
apply to each case participant individually. In other words, the system will assign this clock to each 
participant on the case. As a result, the system actions defined by the clock must then happen in relation 
to each case participant. 

For example, if one of the participants performs an action that triggers a clock starting action, then this 
participant level clock will start for only this participant. 

Define Clock Actions 

Several different action types may exist on a clock. These include starting, stopping, pausing, and 
restarting actions.  

A clock action consists of four components: a function, an action type, a parameter type, and a parameter 
value. For example, you may configure a specific clock to start when a “Proof of Service” filing document 
is filed with the Court. In this scenario, the function is “Filing”, the action is “Filed”, the parameter type is 
“Filing Document”, and the parameter value is “Proof of Service”. 

A clock may also include multiple actions of the same type. For example, if you define two or three 
different starting actions for a clock, then the system will start the clock when those actions occur. It is 
also possible that the completing action of one clock may be the defined starting action of another clock. 

Define Clock Duration 

Clock configuration includes defining the clock’s effective start date and duration. The duration is the 
number of days that a clock has to complete a stopping action after a start action has occurred. If the 
stopping action does not occur before the configured duration, then the clock expires. 

Clock Exception and Expiry Warning Actions 

It is recommended that you configure exception actions for a clock. These actions define what the system 
should do if this clock expires on a case. For instance, an expired or overdue clock could populate a work 
queue, generate a form, or schedule an event in order to inform you of this issue. These configured 
events would occur through a nightly batch job, which searches and finds expired clocks.  

You can also configure clock expiry warning actions, which alert you that the clock on a specific case is 
about to expire.  

Task Activity 

Perform the following steps to configure a case clock. 
 

1. Select [Admin] > [Case Administration] > [Configure Case Clocks]. 
Result: The Configure Case Clocks – Search Case Clocks screen displays. 
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2. Click the [Add Case Clock] button. 
Result: The Configure Case Clocks screen displays. 
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3. Enter/Select data for the following required fields: 
4. Clock Name 
5. Clock Type 
6. Effective Date Type 
7. Effective Start Date 

 Follow Steps 4-6 to add clock actions. These actions may be defined as starting, 
pausing, restarting, and stopping events (or triggers). 

4. Click the [Add New] button. 
Result: The Configure Case Clocks – Add/Edit Action screen displays. 
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5. Enter/Select data for the following required fields: 
6. Action Type 
7. Function 
8. Action 
9. Parameter Type 
10. Parameter Value 

 

6. Click the [Save] button. 
Result: The Configure Case Clocks screen re-displays. The new action item is now available in 
the Actions section. 
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7. Enter/Select data for the following required fields: 
8. Number of Days to Complete Stopping Action 
9. Type of Days 

 The type of days occurs either from the starting action or prior to the event. These are 
based on calendar or court days. Select the appropriate frame of reference. 

8. Select the appropriate exception action(s) for the clock. 
 This selection will determine which additional exception action fields will require data entry. 

9. Enter the Expiry Warning Number of Days. 
 This entry tells the system when to display a warning message to you indicating that the 

clock is about to expire. 
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10. Select the appropriate expiry warning action(s) for the clock. 
 This selection will determine which additional expiry warning fields will require data entry. 

11. Click the [Save] button. 
Result: The screen refreshes with a confirmation message.  

 At this point, the clock becomes available from the Search Case Clocks screen and you can 
assign it to a case track. 

 
 

 

 

 

Related Links 

Configure Automatic Case Clocks Overview 
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Configure Case Clocks - Search Case Clocks Screen 

Configure Case Clocks Screen 

Configure Case Clocks - Add/Edit Action Screen 

 

My Court Information 

 

Update Automatic Case Clocks 

 

Introduction 

Updating a case clock changes the configuration settings for an automatic clock. You must have the 
System Administrator security role to update a clock while the newly changed clock remains unique to the 
system.  

Changing Clock Components 

You can change many different clock settings. For example, you can add or update the clock duration, 
exception actions, and/or expiry warning actions. You may also add, update or remove clock actions. 
However, refer to the Add Automatic Case Clocks task activity for details on adding a new action to a 
clock.  

You also have the option of updating a clock that is assigned to multiple cases. Refer to the Batch Update 
Active Clocks section for details on updating a group of active clocks. 

When Changes Go Into Effect 

Some clock updates require that you perform additional changes on the impacted cases. For example, if 
you update the duration of an automatic clock, then you must also change this duration for the cases on 
which this clock is assigned. Refer to the Maintain Case Clocks section for details on this process. 

Some clock updates may only affect cases in a go-forward basis. For example, a new clock action for a 
clock that has already started on a case will not affect this particular case. The action will only occur if it 
happens after the clock configuration was updated. 

The system will instantly apply the clock changes to those cases where this clock has not yet started.  

Task Activity 

This activity takes place within the context of a clock search. Refer to the Search Case Clocks task 
activity for details on performing this search. 

Perform the following steps to edit a case clock. 
 

1. Select the radio button for the clock to update. 
 This selection occurs from the Configure Case Clocks - Search Case Clocks screen. 
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2. Click the [Update] button. 
Result: The Configure Case Clocks screen displays. 
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3. Enter/Update the available fields as needed. 
 Follow Steps 4-7 to update a clock action entry. 

 Refer to the Add Automatic Case Clocks task activity for details on adding an action to a 
clock. 

4. Select the radio button for the action entry to update. 
5. Click the [Edit] button. 

Result: The Configure Case Clocks – Add/Edit Action screen displays. 
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6. Enter/Update the available fields as needed. 
7. Click the [Save] button to save the action updates to the clock. 

Result: The Configure Case Clocks screen re-displays. 
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8. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Automatic Case Clocks Overview 

Configure Case Clocks - Search Case Clocks Screen 

Configure Case Clocks Screen 

Configure Case Clocks - Add/Edit Action Screen 
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My Court Information 

 

Save As New Case Clocks 

 

Introduction 

Using the “Save As” feature allows an existing case clock to be used as a “template” for a new clock. 
Changes made to the clock settings only apply to this new clock and do not change the selected 
template. 

Required Clock Changes 

After selecting a template clock, you must change at least one clock setting to make the new clock 
unique. Otherwise, this “new” clock will be an exact copy of the template, and the system does not 
support duplicate clocks.  

Task Activity 

This activity takes place within the context of a clock search. Refer to the Search Case Clocks task 
activity for details on performing this search. 

Perform the following steps to save a clock as a new case clock. 
 

1. Select the [Clock Name] option of the clock to use as a template. 
 This selection occurs from Configure Case Clocks – Search Case Clocks screen. 

 
 

 

2. Click the [Save As] button. 
Result: The Configure Case Clocks screen displays. 
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3. Change at least one of the following data fields: 
4. Clock Name 
5. Clock Type 
6. Effective Date Type 
7. Effective Start Date 

 A unique case clock is defined by its name and its effective start and end dates. 

4. Enter/Select data for the necessary fields. 
5. Click the [Save] button to save this new clock. 

Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Automatic Case Clocks Overview 

Configure Case Clocks - Search Case Clocks Screen 

Configure Case Clocks Screen 
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Configure Case Tracks 

Configure Case Tracks Overview  

 

Introduction 

Configuring case tracks defines clock and milestone settings for specific case categories and case types. 
You must have a System Administrator security role to perform track configuration activities. 

About Case Tracks 

A track is a monitoring mechanism used by Courts to check the progress of a case. Tracks compare 
where a case should be based on expected milestone and clock events with where the case is currently. 
However, tracks do not impact or change case events. 

A case can belong to only one track at a given time. Refer to the Initiate Cases and Maintain Case 
Information sections for details on assigning a case to a track. 

About Case Milestones 

Milestones provide guidelines for identifying the key activities that should happen on a case. Each 
milestone also has an expected time frame as to when it should be complete. Milestones are specific to a 
track and may be based on local Court rules, policies or statutes. 

Case History entries will indicate when configured milestones have been met on a case. It is possible for 
a milestone [action or entry] to be “met” multiple times on a case. That is, the Case History entry 
referenced by a milestone may occur more than once during the life of a case. As a result, the system 
considers the milestone “met” upon the first such occurrence on the case. 

About Case Clocks 

A track also consists of one or more case clocks. A clock is a mechanism to support the timely completion 
of case activities. Clocks consist of a set of system actions or activities that a case is expected to meet 
and define the number of days to complete these activities. Clock actions can also trigger other system 
events to occur. For example, a clock action may generate a form or schedule an event. 

Refer to the Configure Automatic Case Clocks and Maintain Case Clocks sections for details on related 
clock processes. 

Activities Performed Prior to Configuring a Track 

You must configure an automatic case clock prior to adding the clock to a track. 

You must also conduct a case track search in order to select a track to update or use as a template. 
However, it is recommended that you also conduct this search prior to creating a new track in the system. 
This helps to check whether a given track already exists, which may reduce the risk of entering a 
duplicate track. 

Track Validations 

The tracks in the system must be unique. A unique case track is defined by its track name, case category, 
case type, and effective start and end dates. 

Task Activities 

Configuring case tracks includes the following task activities: 
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• Search Case Tracks 
• Add Case Tracks 
• Update Case Tracks 
• Save As New Case Tracks 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Configure Case Tracks - Search Case Tracks Screen 

Configure Case Tracks - Update Case Track Information Screen 

Configure Case Tracks - Add/Edit Milestone Screen 

Configure Case Tracks - Clock Listing Screen 

 

My Court Information 

 

Search Case Tracks 

 

Introduction 

Searching for a case track searches and displays tracks that currently exist in the system. You must have 
a System Administrator security role to access the search and related track configuration screens. 

Track Search Functionality 

The system performs a search based on field parameters that you provide. Only configured case tracks 
that match the entered search criteria will display in the results list. Refer to the Add Case Tracks task 
activity for details on creating and configuring a case track. 

You must select a filter criteria in order for the search utility to function. Providing other parameter data 
helps to narrow the search results and increases the likelihood of finding a closer match. Refer to the 
Search Feature Overview for details on performing a search in the system. 

Using the Search Results 

The search function also provides the foundation for maintaining case track information. For example, you 
must perform a case track search in order to update a track’s configured settings or save an existing track 
as a new track.  

Task Activity 

Perform the following steps to search for a case track. 
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1. Select [Admin] > [Case Administration] > [Configure Case Tracks]. 
Result: The Configure Case Tracks – Search Case Tracks screen displays. 

 
 

 

2. Select a Filter Criteria for the search. 
 Selecting other filter criteria, such as the track name, case category, and/or case type, 

narrows the search results and increases the likelihood of finding a closer track match. 
3. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 

 
 



Printed Documentation 

1260 

 

 From the Search Results section, you can perform the Update Case Tracks or Save as 
New Tracks task activities. 

 

 

Related Links 

Configure Case Tracks Overview 

Configure Case Tracks - Search Case Tracks Screen 

 

My Court Information 

 

Add Case Tracks 

 

Introduction 

Adding a case track to the system assigns a collection of milestones and clocks to a track. These tracks 
help to monitor a case’s progress in meeting expected events and timelines.  

Since every case belongs to a track, you should configure case tracks prior to case assignment. Cases 
are assigned to tracks during case initiation. Refer to the Initiate Cases section for details on this process. 

Configuring Tracks 

Adding a track involves defining the track’s attributes. For example, you must provide a track name and 
identify the case category(ies) and case type(s) to which this track applies. You can also specify a track 
as the default track used at case initiation. This attribute allows the system to automatically assign this 
track to a new case. However, this option is limited to only one track for a given case category/case type 
combination. 

Adding Case Milestones 

Additional attributes include assigning case milestones to a track. Milestones provide guidelines as to 
what events should occur on a case and how long each event should take. These ideal timeline 
standards help Courts to monitor the progress and performance of a case assigned to that track.  

Adding Case Clocks 

Clocks assigned to a track can schedule certain actions on a case to occur in a timely manner. This 
assignment also indicates that the clock is “valid” for the cases that belong to this track. Multiple tracks 
may have the same case clock(s) assigned. Refer to the Configure Automatic Case Clocks and Maintain 
Case Clocks sections for details on related case clock activities. 

Task Activity 

Perform the following steps to configure a case track. 
 

1. Select [Admin] > [Case Administration] > [Configure Case Tracks]. 
Result: The Configure Case Tracks – Search Case Tracks screen displays. 
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2. Click the [Add Case Track] button. 
Result: The Configure Case Tracks – Update Case Track Information screen displays. 
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3. Enter/Select data for the following required fields: 
4. Track Name 
5. Case Category 
6. Case Type 
7. Start Date 

 

4. Click the [Add New] button within the Milestones tab. 
Result: The Configure Case Tracks - Add/Edit Milestone screen displays. 

 This option allows you to create a milestone for this track. 
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5. Enter/Select data for the following required fields: 
6. Milestone 
7. Function 
8. Case History Entry 
9. Expected Number of Days 

 

6. Click the [Save] button. 
Result: The Configure Case Tracks – Update Case Track Information screen re-displays. The 
new milestone is now available in the Milestone Summary section. 
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7. Select the [Clocks] tab. 
Result: The Clocks tab highlights. 
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8. Click the [Add Another] button. 
 This option allows you to assign existing automatic clocks to the track.  

Result: The Configure Case Tracks - Clock Listing screen displays. 
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9. Select the clock Filter Criteria. 
10. Click the [Filter] button. 

Result: The Clock Listing only displays configured automatic clocks that match the selected filter 
criteria. 

 If the clock does not display within the search results list using the “All Clocks” filter criteria, 
then the desired clock may not exist.  
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11. Select the checkboxes for the automatic clocks to add to the track. 
12. Click the [Select] button. 

Result: The Configure Case Tracks – Update Case Track Information screen re-displays. The 
newly assigned clocks are now available in the List of Clocks on Track section. 
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13. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Case Tracks Overview 

Configure Case Tracks - Search Case Tracks Screen 

Configure Case Tracks - Update Case Track Information Screen 

Configure Case Tracks - Add/Edit Milestone Screen 

Configure Case Tracks - Clock Listing Screen 

 

My Court Information 
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Update Case Tracks 

 

Introduction 

Updating a case track changes the configuration settings for a track. For example, you may change the 
case category(ies), case type(s), milestones and/or automatic clocks associated with the track. 

You must have a System Administrator security role to update a track while the newly changed track 
remains unique to the system.  

When Changes Go Into Effect 

Certain track changes will occur upon saving the update. For example, the system will immediately apply 
updates to existing milestone information for the cases that belong to this track. These updates may 
include changing a milestone name, extending a milestone’s expected number of days, or deleting a 
milestone entirely from the track. 

The system will apply updates to the track information including changing the assigned case clocks. 

However, some track changes do not occur right away. For instance, adding a new milestone to a track 
will trigger a batch job to be run in the evening. This new milestone will be applied to the existing cases 
belonging to this track on the following day. 

Task Activity 

This activity takes place within the context of a track search. Refer to the Search Case Tracks task activity 
for details on performing this search. 

Perform the following steps to edit case track configuration. 
 

1. Select the radio button for the track to update. 
 This selection occurs from the Configure Case Tracks - Search Case Tracks screen. 
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2. Click the [Update] button. 
Result: The Configure Case Tracks – Update Case Track Information screen displays. 

 
 

 

3. Enter/Select data for the necessary fields. 
 Follow Steps 4-7 to edit a milestone on the track. 

 Follow Steps 8-11 to edit the available automatic clocks on the track. 
 

4. Select the radio button for the milestone to update. 
 Refer to the Add Case Tracks task activity for details on adding a milestone to a track. 

5. Click the [Edit] button. 
Result: The Configure Case Tracks – Add/Edit Milestone screen displays. 
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6. Enter/Select data for the necessary fields. 
7. Click the [Save] button to save the milestone updates to the track. 

Result: The Configure Case Tracks – Update Case Track Information screen re-displays. 
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8. Select the [Clocks] tab. 
Result: The Clocks tab highlights and lists the automatic clocks assigned to the track. 

 Refer to the Add Case Tracks task activity for details on adding a clock to a track. 



Printed Documentation 

1274 

 
 

 

9. Edit/Update the start and/or end dates for the clock(s), as needed. 
 Follow Steps 10-11 to remove an automatic clock from the track. 

10. Select the checkboxes for the clocks to remove. 
11. Click the [Remove] button. 

Result: The screen refreshes and no longer displays the selected clock(s). 
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12. Click the [Save] button to save the track updates. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Case Tracks Overview 

Configure Case Tracks - Search Case Tracks Screen 

Configure Case Tracks - Update Case Track Information Screen 

Configure Case Tracks - Add/Edit Milestone Screen 

 

My Court Information 

 

Save As New Case Tracks 
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Introduction 

Using the “Save As” feature allows an existing case track to be used as a “template” for a new track. 
Changes made to the track settings only apply to this new track and do not change the selected template. 

Required Track Changes 

After selecting a template track, you must change at least one track setting to make the new track unique. 
Otherwise, this "new" track will be an exact copy of the template, and the system does not support 
duplicate tracks. 

Task Activity 

This activity takes place within the context of a track search. Refer to the Search Case Tracks task activity 
for details on performing this search. 

Perform the following steps to save a track as a new case track. 
 

1. Select the radio button for the track to use as a template. 
 This selection occurs from the Configure Case Tracks - Search Case Tracks screen. 

 
 

 

2. Click the [Save As] button. 
Result: The Configure Case Tracks – Update Case Track Information screen displays. 
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3. Change at least one of the following data fields: 
4. Track Name 
5. Case Category 
6. Case Type(s) 
7. Start Date 

 

4. Enter/Select data for the other necessary fields. 
5. Click the [Save] button. 

Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Case Tracks Overview 

Configure Case Tracks - Search Case Tracks Screen 

Configure Case Tracks - Update Case Track Information Screen 

 

Configure Additional Filings 

Configure Additional Filings Overview  

 

Introduction 
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Configuring additional filings defines a list of filing documents that usually accompany an initial case filing. 
While these filings are not required in order to complete the case initiation process, they provide a 
"checklist" of filings that a filer may submit during case initiation. 

These additional filings must be defined for a specific case category/case type - initial filing combination. 

Task Activities 

Configuring additional filings includes the following task activities: 

• Configure Additional Filings 
• Update Additional Filings 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Configure Additional Filings Screen 

 

My Court Information 

 

Configure Additional Filings 

 

Introduction 

Configuring additional filings adds a document to the list of documents that may accompany an initial 
case filing. You must define these additional filings for a specific case category/case type - initial filing 
combination. 

Task Activity 

Perform the following steps to add a configured filing to the system. 
 

1. Select [Admin] > [Case Administration] > [Configure Additional Filings]. 
Result: The Configure Additional Filings screen displays. 
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2. Click the [Add Additional Filings] button. 
Result: The screen refreshes with the Additional Filings section. 

 
 

 

3. Select data for the following required fields: 
4. Case Category 
5. Case Type 

 You may select more than one case type. 
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4. Enter/Select data for the following required fields within the Additional Filings section: 
5. Filing Type 
6. Filing Document 
7. Case Initiating Filing 
8. Effective Start Date 

 Click the [Add Another] button to add more filings for the selected case category and 
case type. The screen will refresh with a blank set of filing fields.  

5. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 

 
 

 

 

 

Related Links 

Configure Additional Filings Overview 

Configure Additional Filings Screen 

 

My Court Information 

 

Update Additional Filings 

 

Introduction 
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Updating additional filings changes filings that are available for a selected case category/case type - initial 
filing combination. You can edit the start and end dates for an existing filing, or add a new filing to the 
selection. 

Removing Filings 

The only way to remove a filing is by changing or entering an end date equal to or greater than today's 
date for the filing. The system does not accept past dates. Once you save this new end date, the system 
will no longer list the filing on the case initiation screens. 

Task Activity 

Perform the following steps to filter and update a configured filing. 
 

1. Select [Admin] > [Case Administration] > [Configure Additional Filings]. 
Result: The Configure Additional Filings screen displays. 

 
 

 

2. Select data for the following required fields: 
3. Case Category 
4. Case Type 

 You may select more than one case type. 

3. Click the [Filter] button. 
Result: The screen refreshes with the Additional Filings section. 

 This screen will contain a list of the filings that have been configured for the selected case 
category and case type(s). 
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4. Enter/Update the available fields as needed: 
5. Effective Start Date 
6. End Date 

 These are the only fields that you can change for existing configured filings. 

 Click the [Add Another] button to add more filings for the selected case category and 
case types. The screen will refresh with a blank set of filing fields.  

5. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Additional Filings Overview 

Configure Additional Filings Screen 

 

Batch Update Active Clocks 

Batch Update Active Clocks Overview  

 

Introduction 

Updating clocks in batch changes the number of days for which a specific clock is valid for a selected 
group of cases. This process allows you to change the same clock on multiple cases at one time.  

Only System Administrators may perform batch updates. Local Administrators can request the update 
and Central Administrators can review and schedule the update. 

Batch Restrictions 

This batch job is limited to only active automatic clocks. These are clocks that have a status of either 
"Started" or "Paused" on a case. As a result, if a clock has expired or not yet started on a case, then this 
new duration cannot apply to this clock. 
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You must change the configuration of a clock in order for a new duration to update on the cases that 
contain this clock. Refer to the Configure Automatic Case Clocks section for details on changing a clock’s 
valid number of days at the system level. 

In addition, this batch job is designed for making clock updates on more than one case at the same time. 
You will select the cases that will be impacted by this active clock. Refer to the Maintain Case Clocks 
section for details on changing a clock’s duration for a single case. 

Task Activities 

Batch updating active clocks includes the following task activity: 

• Batch Update Active Clocks 

Additional Resources 

There are no other resources related to this overview.  

 

 

Related Links 

Batch Update Active Clocks Screen 
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Batch Update Active Clocks 

 

Task Activity 

Perform the following steps to batch update active clocks.  
 

1. Select [Admin] > [Case Administration] > [Batch Update Active Clocks]. 
Result: The Batch Update Active Clocks screen displays. 
 
 

 

2. Select a Clock Name. 
3. Select a Case Category, if necessary. 
4. Click the [Filter] button. 

Result: A list of cases that contain the selected [active] clock displays. 
 
 

 

5. Select the checkboxes for the cases that will be impacted by the new clock duration. 



The Admin Section 

1287 

6. Click the [Edit] button. 
Result: The Edit Clock Information screen displays. 
 
 

 

7. Enter data into the following required fields: 
8. Total Number of Days 
9. Comments 

 This is the new number of days allowed for completing the clock’s stopping action. This 
new duration can extend or reduce the current expiration time frame. 

8. Click the [Save] button to run the batch job. 
Result: The Batch Update Active Clocks screen re-displays with a confirmation message. The 
system updates this clock for the selected cases. 
 
 

 

 

 

Related Links 

Batch Update Active Clocks Overview 

Batch Update Active Clocks Screen 

Edit Clock Information Screen 

 

Case Archive 

Case Archive Overview  

 

Introduction 

Archiving is a two-step process where records are archived in the system and then later purged. This 
process moves records from the "live" system tables to "history" tables. History tables are identical to the 
live tables but are unaffected by system functionality. When records are removed from the history tables, 
they are saved to fixed-length flat record text files and then deleted from the system entirely. These files 
are stored in a directory on a UNIX® file system accessible by the Oracle® database server and can later 
be transferred to long-term storage media. 

Exceptions 

When a case is archived, the system maintains a "skeleton" record of the case which allows you to 
retrieve basic case information, when needed. The "skeleton" record consists of the following fields: 

• Case Number 
• Filing Date 
• Disposition 
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• Disposition of Case Data 
• Judgment 
• Satisfaction 
• Physical Case File Information 

• Volume 
• Building 
• Room 
• Place 
• Sub-Place 

• Participant Names 
• Participant Roles 

Process Information 

The following process information highlights the steps involved in archiving a case: 

1. Define archive rules, which determine when cases are eligible for archive. 
2. View the list of cases eligible for archive and individually select those to be flagged for archive. 
3. Archive batch process searches for case records flagged for archive and archives them. Refer to 

the Schedule Batch Jobs section for details on creating and scheduling batch jobs in the system. 

Retrieve an Archived Case 

Retrieval of an archived case requires running an archive restore script.  

The following occurs when an archived case is restored: 

• The restore script marks the case record with a restoration date. This restoration date prevents 
the record from being eligible for another archive within 30 days after it is restored. 

• A case history entry is logged for the restored case. 
 

 

 A UNIX system administrator is typically the person responsible for retrieving an archived case. 
Refer to the system Technical Architecture Design document for more information and details related to 
this activity. 

Archive Case Documents 

The case archive functionality does not archive any associated case documents stored in either the 
internal file system or the external document management system (DMS). Archiving of case documents is 
a separate process and is determined by the Archive Method selection made when a case is marked for 
destruction. Each court defines its own case documents archive methods by setting values in the 
ARCHIVAL METHOD reference table. 

How a user performs the selected destruction/archive method is beyond the scope of this documentation. 

Task Activities 

Case archive includes the following task activities: 

• Define Case Archive Eligibility Requirements 
• Mark Eligible Cases for Archive 

Additional Resources 
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Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

Archive Eligible Cases Screen 

Configure Archive Rules Screen 

 

My Court Information 

 

Define Case Archive Eligibility Requirements 

 

Introduction 

Before you can archive a case, you must define the rules that determine when/if cases are eligible for 
archive. 

Task Activity 

Perform the following steps to define archive eligibility rules. 
 

1. Select [Admin] > [Case Administration] > [Configure Case Archive Rules]. 
Result: The Configure Archive Rules screen displays. 
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2. Enter/Select data for the following required fields: 

• Physical Case File Status 
• Case Category 
• Case Type 
• Number of Days 
• After Case Status 

 

3. Click the [Save] button. 
4. To add another rule, click the [Add Another] button and repeat this process.  
5. To delete a rule, select the check box associated with the rule and click the [Remove] button. 
6. Click the [Save] button after adding or deleting rules. 

 

 

Related Links 

Case Archive Overview 

Configure Archive Rules Screen 

 

My Court Information 

 

Mark Eligible Cases for Archive 

 

Introduction 

The case archive process requires you to view cases that are eligible for archive and select the ones you 
want to archive. 

Marking cases for archive does not archive the record, but it flags case records that need to be archived. 
The archive batch process actually archives the case records. 

Task Activity 

Perform the following steps to define case records eligible for archive and mark the ones that need to be 
archived. 
 

1. Select [Admin] > [Case Administration] > [Archive Eligible Cases]. 
Result: The Archive Eligible Cases screen displays. 
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 This screen returns a maximum of 2500 records. 

 To view more information about the case before you select it for archive, click the case 
link. When you are finished reviewing case details, return to this screen. 

2. Select the checkbox associated with each case you want to archive. 
3. Click the [Archive] button. 

 

 

Related Links 

Case Archive Overview 

Archive Eligible Cases Screen 

 

Accounting Administration 

Configure Fee Schedule Overview 

 

Introduction 

The fee schedule is the complete listing of fees and distribution of monies for services provided by the 
court. Fees can be related to such items as filings, sanctions, returned checks, and miscellaneous 
services. Only a System Administrator can configure the fee schedule.  
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Configuring the fee schedule involves configuring a fee category, fee type, case category, case type, fee 
waiver category, and the distribution buckets. A fee schedule can be specified for a case category, case 
type, filing document and/or issuance type. 

Task Activities 

Configuring the fee schedule includes the following task activities: 

• Search Fees in the Fee Schedule 
• Configure Fee Distribution Buckets 
• Add Fees to the Fee Schedule 
• Update an Existing Fee in the Fee Schedule 
• Save As a New Fee in the Fee Schedule 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

Configure Fee Schedule - Search Screen 

Configure Fee Buckets Screen 

 

My Court Information 

 

Search Fees in the Fee Schedule 

 

Introduction 

This activity allows you to search for fees listed in the Fee Schedule. Only those fees that have been 
previously created and that match the entered search criteria will display in the search results. Refer to 
the Create Case-Related Fees and Create Non Case-Related Fees task activities for details on creating 
fees. 

The system searches for both "Active" and "Expired" fees, depending on the selected fee status. It will 
retrieve the appropriate fee details including distribution bucket information. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search fees. 
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1. Select [Admin] > [Accounting Administration] > [Configure Fee Schedule]. 
Result: The Configure Fee Schedule Search screen displays. 

 
 

 

2. Select data for the following required fields: 
o Fee Category 
o Fee Type 
 Select the [Case Related] checkbox if you are searching for case-related fees. Or select 

the [Inactive Fees] checkbox if you are searching for fees that are no longer in the active fee 
schedule. 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Search Fees Results screen displays. 
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Related Links 

Configure Fee Schedule Overview 

Configure Fee Schedule - Search Screen 

 

My Court Information 

 

Configure Fee Distribution Buckets 

 

Introduction 

A fee distribution bucket is a general ledger account used for the allocation of monies paid to the court 
that is later distributed to various agencies, funds, and programs. Once you add or update a fee, the 
option to configure fee distribution buckets becomes available. When adding a new fee, the bucket 
information is blank. When updating an existing fee, the distribution bucket information is populated with 
the previously configured information. 
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When you save at least one distribution bucket for the selected fee, the system will verify that the sum of 
the configured buckets is equal to the fee amount. 

If you select to add a new fee or use the "Save As" feature, then a new fee record as well as one or more 
bucket records are saved to the system database. 

Task Activity 

This activity takes place in the context of a fee search within the Fee Schedule. Refer to the Search Fees 
in the Fee Schedule task activity for details on this process. 

Perform the following steps to configure fee distribution buckets: 
 

1. Select the radio button for the fee in which to configure the distribution buckets. 
2. Click the [Update] button. 

Result: The Configure Fee Schedule Update screen displays. 

 
 

 

3. Click the [Configure Buckets] button. 
Result: The Configure Buckets screen displays. 
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4. Select a bucket from the Bucket drop-down list. 
5. Enter a fee amount in the Amount field to apply to the distribution bucket, or enter the % of Total 

Amount of the fee for sales tax calculation. 
 Entering a value in the Amount field will automatically calculate the % of Total Amount. 

Likewise, entering a value in the % of Total Amount field will automatically calculate the Amount. 
6. Click the [Add] button to add another bucket. 
7. Select the checkbox of a Bucket to remove and click the [Remove] button. 
8. Click the [Save] button once all of the necessary fee distribution buckets have been configured. 

 

 

Related Links 

Configure Fee Schedule Overview 

Configure Fee Buckets Screen 

 

My Court Information 

 

Add Fees to the Fee Schedule 

 

Introduction 

Adding a new fee creates a fee in the Fee Schedule. This activity can be performed as long as the new 
fee is unique to the system. A unique fee is defined by its case category, case type, fee category, fee 
type, fee waiver category, and type of issuance. 
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A fee search is required to determine if the fee already exists in the Fee Schedule. If the fee does not 
display within the search results list, then it can be added as a new fee.  

Upon saving, the system will verify if the newly created fee is a copy of another fee. If no duplicate fees 
are found, then the system will save and display the new fee in the Fee Schedule. However, if there is a 
duplicate fee, then the system will display an alert to reconfigure the newly created fee to make it unique 
to the system. 

Fee Configuration 

A fee can be specified for a case category, case type, filing document and/or issuance type. The 
configuration of a fee includes: 

• Defining the fee category and fee type 
• Associating the new fee to a filing document or issuance (if applicable) 
• Defining a fee amount based on criteria such as the number of parties filing, whether the 

participant is a frequent filer (Small Claims), Estate Value Range/Demand Amount (Probate/Civil 
respectively), etc. 

• Defining if a fee type is a First Appearance Fee 
• Identifying if a trust is interest-bearing or non interest-bearing 
• Specifying the distribution of accounts 
• Indicating if the fee type will be reported to the AOC  

Task Activity 

This activity takes place in the context of a fee search. Refer to the Search Fees in the Fee Schedule task 
activity for details on this process. 

Perform the following steps to add a fee. 
 

1. Select the radio button for the fee to add to the Fee Schedule. 
 This selection occurs from the Configure Fee Schedule - Search screen. 
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2. Click the [Add] button. 
Result: The Configure Fee Schedule Add screen displays. 
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3. Enter/Select data for the following required fields: 

• Fee Category 
• Fee Type 
• Effective Date 

 If the case category is Probate, then the Estate Value Range may be entered. 
Otherwise, this field is disabled. Also, if the case category is Probate, an Additional % may be 
entered. 

4. Click the [Configure Buckets] button. 
Result: The Configure Buckets screen displays. 
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5. Select the Bucket drop-down list to update the distribution bucket. 
6. Enter a new value in the Amount field to update the dollar amount for a bucket, or update the % 

of Total Amount. 
 Entering a value in the Amount field will automatically calculate the % of Total Amount. 

Likewise, entering a value in the % of Total Amount field will automatically calculate the Amount. 
7. Click the [Add] button to add and configure a fee distribution bucket. 
8. Select the checkbox of a Bucket to remove and click the [Remove] button. 
9. Click the [Save] button. 

 

 

Related Links 

Configure Fee Schedule Overview 

Configure Fee Buckets Screen 

 

My Court Information 

 

Update an Existing Fee in the Fee Schedule 

 

Introduction 

The System Administrator can update any fee attribute as long as the newly changed fee remains unique 
in the system. A unique fee is defined by the combination of case category, case type, fee category, fee 
type, fee waiver category, type of issuance, and effective dates that do not overlap. 
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The System Administrator must first perform a fee search in order to select a fee to update. If the fee 
does not display within the search results list, then the desired fee may not exist. In this situation, the 
System Administrator should consider adding this new fee. Refer to the Add Fees to the Fee Schedule 
task activity for details on this process. 

Upon saving, the system will verify if the newly created fee is unique within the system. If it is, then the 
system will save and display the new fee in the Configure Fee Schedule Search Results screen. 
However, if there is a duplicate fee, then the system will alert the System Administrator to re-configure the 
newly created fee to make it unique. 

Updated Fees and Cases 

All updates to a fee will apply to new cases to which the fee is assigned.  Cases where this fee has been 
previously assessed will not be impacted. 

Task Activity 

This activity takes place in the context of a fee search within the Fee Schedule. Refer to the Search Fees 
task activity for details on this process. 

Perform the following steps to configure a fee schedule. 
 

1. Select the radio button of the fee to update. 
2. Click the [Update] button. 

Result: The Configure Fee Schedule Update screen displays. 
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3. Enter/Update the available fields as needed. 
 If the case category is Probate, the Estate Value Range may be entered. Also, if the case 

category is Probate, an Additional % may be entered. 
4. Click the [Configure Buckets] button. 

Result: The Configure Buckets screen displays. 

 
 

 

5. Select the Bucket drop-down list to update the distribution bucket. 
6. Enter a new value in the Amount field to update the dollar amount for a bucket, or update the % 

of Total Amount. 
 Entering a value in the Amount field will automatically calculate the % of Total Amount. 

Likewise, entering a value in the % of Total Amount field will automatically calculate the Amount. 
7. Click the [Add] button to add a add and configure a fee distribution bucket. 
8. Select the checkbox of the bucket to remove and click the [Remove] button. 
9. Click the [Save] button once all of the necessary fee distribution buckets have been updated. 

 

 

Related Links 

Configure Fee Schedule Overview 

Configure Fee Buckets Screen 

 

My Court Information 

 

Save As a New Fee in the Fee Schedule 
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Introduction 

Using the "Save As" feature allows an existing fee to be used as a "template" for a new fee. Changes 
made to the fee only apply to this new fee and do not change the selected template. 

Required Changes 

After selecting a template fee, you must change at least one fee setting to make the new fee unique. 
Otherwise, this "new" fee will be an exact copy of the template, which is not allowed in the Fee Schedule. 

In addition, since the existing fee must be configured with an expiration date, the effective date for the 
new fee must not overlap the effective date of the old "template" fee.  

Activity Requirements 

A search for fees in the Fee Schedule must be performed in order to select a fee to use as a template. If 
the fee searched for does not display within the search results list, then this fee may not exist. In this 
situation, you should consider adding a new fee. Refer to the Add Fees to the Fee Schedule task activity 
for details on this process. 

Task Activity 

This activity takes place in the context of a fee search. Refer to the Search Fees in the Fee Schedule task 
activity for details on this process. 

Perform the following steps to save a fee as a new fee in the Fee Schedule. 
 

1. Select the radio button of the fee to use as a template. 
2. Click the [Save As] button. 

Result: The Configure Fee Schedule Save As screen displays. 
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3. Enter/Update the available fields as needed. 
 If the case category is Probate, the Estate Value Range may be entered. Also, if the case 

category is Probate, an Additional % may be entered. 
4. Click the [Configure Buckets] button. 

Result: The Configure Buckets screen displays. 
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5. Select the Bucket dropdown list to update the distribution buckets. 
6. Enter a new value in the Amount field to update the dollar amount for a bucket, or update the % 

of Total Amount. 
 Entering a value in the Amount field will automatically calculate the % of Total Amount. 

 Likewise, entering a value in the % of Total Amount field will automatically calculate the Amount. 
7. Click the [Add] button to add and configure a fee distribution bucket. 

 At least one bucket must be present and configured before saving. 
8. Select the checkbox of the bucket to remove and click the [Remove] button. 
9. Click the [Save] button. 

 

 

Related Links 

Configure Fee Schedule Overview 

Configure Fee Buckets Screen 

 

Calendar Administration 

Configure Resource Allocation Rules 

Configure Resource Allocation Rules Overview  

 

Introduction 

Configuring resource allocation rules establishes the availability and calendaring related scheduling 
preferences of a court’s resources including Court, Divisions, Departments, Judicial Officers, Mediators, 
and Temporary Judges.  

Resource allocation rules define the various calendar types and/or event types that court resources may 
be available for on a given day and/or time. Information about recommended case event scheduling limits 
can also be set through this process.  

If no resource allocation rules are configured, it assumed that the resource is not available. If no rules 
have been configured for a specific court resource, then the rules set up for the entire court can be used 
when scheduling an event. The system recognizes these rules as the "default" allocation rules.  

The configuration of court dark days and other resource unavailable days can also be set in the system. 
Refer to the Configure Resource Unavailability section for details on setting unavailability information.  

The configuration of scheduling related business rules can also be set in the system. Refer to the 
Configure Scheduling Rules section for details on defining scheduling rules.  

Use of Resource Allocation Rules  

Resource allocation rules will be used by the system when scheduling a calendar event. However, when 
scheduling an event, the existing resource allocation rules may be overridden, if necessary.  
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The functionality of scheduling an event is described in detail in the Schedule/Reserve Calendar Event. 
Refer to the Schedule/Reserve Calendar Events section for details on scheduling/reserving events.  

Task Activities 

Configuring resource allocation rules includes the following task activities: 

• Search Resource Allocation Rules 
• Add Resource Allocation Rules 
• Update Resource Allocation Rules 
• Save As New Resource Allocation Rules 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Configure Resource Allocation - Search Screen 

Configure Resource Allocation - Add/Update/Save Screen 

 

My Court Information 

 

Search Resource Allocation Rules 

 

Introduction 

This activity allows you to search for existing resource allocation rules in the system. Refer to the Search 
Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for existing resource allocation rules.  
 

1. Select [Admin] > [Calendar Administration] > [Configure Resource Allocation]. 
Result: The Configure Resource Allocation - Search screen displays. 



The Admin Section 

1307 

 
 

 

2. Select data for the Resource Type field. 
 Depending on the Resource Type selected, the fields will be filtered and 

enabled/disabled. For Resource Type values of "Division" or "Department," these fields will 
become available and required. 

3. Click the [Search] button. 
Result: The Configure Resource Allocation - Search screen refreshes with the Search Results. 

 
 

 

 Entering the most known data into the fields before initiating the search will produce the 
best results. The search results are then sortable by the search result column hyperlinks.  
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Related Links 

Configure Resource Allocation Rules Overview 

Configure Resource Allocation - Search Screen 

 

My Court Information 

 

Add Resource Allocation Rules 

 

Introduction 

Adding resource allocation rules is the process of configuring a new set of availability and scheduling 
preference information for a specific court resource.  

Task Activity 

Perform the following steps to add a set of resource allocation rules.  
 

1. Select [Admin] > [Calendar Administration] > [Configure Resource Allocation]. 
Result: The Configure Resource Allocation - Search screen displays. 

 
 

 

2. Click the [Create New] button.  
Result: The Configure Resource Allocation - Add New/Update/Save As screen displays. 
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3. Enter/Select data for the following required fields: 
4. Resource Type 
5. Calendar Type 
6. Frequency  
7. Cal. Time 
8. Effective Date  

 The Filter Criteria field is disabled in add mode.  

The Edit radio button is defaulted for each row.  

Depending on the Resource Type selected, the appropriate fields will be filtered, 
enabled/disabled, and become mandatory.   

4. Click the [Save] button. 
Result: The Configure Resource Allocation - Confirmation screen displays. 

 

 

Related Links 

Configure Resource Allocation Rules Overview 

Configure Resource Allocation - Search Screen 

Configure Resource Allocation - Add New/Update/Save As Screen 

 

My Court Information 
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Update Resource Allocation Rules 

 

Introduction 

Updating resource allocation rules changes an existing set of resource allocation rules. This includes 
updating defined parameters of an existing set of resource allocation rule, adding new rules, or deleting 
existing rules. 

Task Activity 

This activity takes place in the context of Configure Resource Allocation Rules search. Refer to the 
Search Resource Allocation Rules task activity for more details on this process.  

Perform the following steps to update a set of resource allocation rules.  
 

1. Select the radio button for a resource allocation rule to update. 
 This selection occurs from the list of resource allocation rules search results.  

 
 

 

2. Click the [Update] button.  
Result: The Configure Resource Allocation - Add New/Update/Save As screen displays with 
appropriate information.  
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3. Enter/Update the available fields as needed.  
 The Filter Criteria field is defaulted to "Active." You can select various filters to get a 

different view of the existing rules.   

The Edit radio button is defaulted for each row.  

Because you are editing an existing record, the Resource Type, Name, Location, Division, 
Department fields are not editable.  

4. Click the [Add New Row] button.   
Result: The Configure Resource Allocation - Add New/Update/Save As screen refreshes with a 
new row added.   

 
 

 

5. Select the [Delete] radio button for a specific rule/row to delete.  
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6. Click the [Save] button. 
Result: The Configure Resource Allocation - Confirmation screen displays with confirmation 
message.  

 

 

Related Links 

Configure Resource Allocation Rules Overview 

Configure Resource Allocation - Search Screen 

Configure Resource Allocation - Add New/Update/Save Screen 

 

My Court Information 

 

Save As New Resource Allocation Rules 

 

Introduction 

Using the "Save As" feature allows an existing set of resource allocation rules to be used as a "template" 
for a new set of resource allocation rules. Changes made to these rule parameters only apply to this new 
set of rules and do not change the selected template. 

Required Changes 

After selecting a template set of rules, you must change at least one rule setting to make the new set 
unique. Otherwise, this "new" set of resource allocation rules will be an exact copy of the template, which 
is not allowed in the system. 

You cannot change the Resource Type for a scheduling rule using this process. In addition, the "Save As" 
feature is not available for Resource Type of "Court."  

Task Activity 

This activity takes place in the context of a resource allocation rule search. Refer to the Search Resource 
Allocation Rules task activity for more details on this process.  

Perform the following steps to save as/copy a set of resource allocation rules.  
 

1. Select the radio button for a resource allocation rule to use as a template. 
 This selection occurs from the list of resource allocation rules search results.  
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2. Click the [Save As] button.  
Result: The Configure Resource Allocation - Add New/Update/Save As screen displays with the 
appropriate information.  

 
 

 

3. Enter/Update the available fields as needed.  
 The Filter Criteria field is defaulted to "Active." You can select various filters to get a 

different view of the existing rules.  

The Edit radio button is defaulted for each row.  

The Resource Type field is not editable.  

The Original JO/Temp Judge/Med. Name, Original Location, Original Division, or Original 
Department fields are shown depending on the Resource Type.   
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4. Click the [Save] button. 
Result: The Configure Resource Allocation - Confirmation screen displays. 

 

 

Related Links 

Configure Resource Allocation Rules Overview  

Configure Resource Allocation - Search Screen 

Configure Resource Allocation - Add New/Update/Save Screen 

 

Configure Resource Unavailability Information 

Configure Resource Unavailability Rules Overview  

 

Introduction 

Configuring Resource Unavailability establishes a court’s “dark days,” which are the calendar dates that 
the court will be unavailable for scheduling, as well as unavailability information for resources including 
Court, Divisions, Departments, Judicial Officers, Mediators, and Temporary Judges.  

The system defaults weekends and nights as unavailable unless otherwise configured by the court.   

The configuration of court availability and calendaring related scheduling preferences of a court’s 
resources can also be set in the system. Refer to the Configure Resource Allocation Rules section for 
details on defining allocation rules.  

The configuration of scheduling related business rules can also be set in the system. Refer to the 
Configure Scheduling Rules section for details on defining scheduling rules.  

Use of Resource Unavailability Information  

Resource unavailability information will be used by the system when scheduling a calendar event. 
However, the existing resource unavailability information may be overridden, if necessary.  

The functionality of scheduling an event is described in detail in the Schedule/Reserve Calendar Event. 
Refer to the Schedule/Reserve Calendar Events section for details on scheduling/reserving events. 

Task Activities 

Configuring resource unavailability rules includes the following task activities: 

• Search Unavailability Information 
• Add Unavailability Information 
• Update Unavailability Information 
• Save As New Resource Unavailability Information 

Additional Resources 

Other items related to this overview include the following:  
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• Business Rules 
 

 

Related Links 

Configure Resource Unavailability - Search Screen 

Configure Resource Unavailability - Add/Update/Save Screen 

 

My Court Information 

 

Search Resource Unavailability Information 

 

Introduction 

This activity allows you to search for resource unavailability information that currently exists in the system. 
Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for resource unavailability information.  
 

1. Select [Admin] > [Calendar Administration] > [Configure Resource Unavailability]. 
Result: The Configure Resource Unavailability - Search screen displays. 

 
 

 

2. Select data for the Resource Type field. 
 Depending on the Resource Type selected, the appropriate fields will be filtered and 
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enabled/disabled. For Resource Type values of "Division" or "Department," these fields will 
become available and required. 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Configure Resource Unavailability - Search screen refreshes with the Search 
Results. 

 
 

 

 Entering the most known data into the fields before initiating the search will produce the 
best results. The search results are sortable by the search result column hyperlinks. 

 

 

Related Links 

Configure Resource Unavailability Information Overview 

Configure Resource Unavailability - Search Screen 

 

My Court Information 

 

Add Unavailability Information 

 

Introduction 

Adding resource unavailability information is the process of configuring a new set of resource 
unavailability information for a specific court resource. 
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Task Activity 

Perform the following steps to add a set of resource unavailability information.  
 

1. Select [Admin] > [Calendar Administration] > [Configure Resource Unavailability]. 
Result: The Configure Resource Unavailability Information - Search screen displays. 

 
 

 

2. Click the [Create New] button.  
Result: The Configure Resource Unavailability Information - Add New/Update/Save As screen 
displays. 
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3. Select data for the Resource Type field.  
 Depending on the selected Resource Type, the appropriate fields will be filtered, 

enabled/disabled, and become required. 
4. Enter/Select data for the following required fields: 

5. Unavailable Start Date 
6. Unavailable End Date 

 The Start Time/End Time fields are mandatory if the Block Entire Day checkbox is not 
selected.  

The Filter Criteria field is disabled in add mode.  

The Edit radio button is defaulted for each row.  

5. Click the [Save] button. 
Result: The Configure Resource Unavailability - Confirmation screen displays. 

 

 

Related Links 

Configure Resource Unavailability Information Overview 

Configure Resource Unavailability - Search Screen 

Configure Resource Unavailability - Add New/Update/Save Screen 

 

My Court Information 

 

Update Unavailability Information 

 

Introduction 

Updating resource unavailability information allows you to change a set of resource unavailability 
information. This includes updating an existing set of resource unavailability information, adding new 
information, or deleting existing information. 

Task Activity 

This activity takes place in the context of a resource unavailability search. Refer to the Search 
Unavailability Information task activity for more details on this process.  

Perform the following steps to update a set of resource unavailability information.   
 

1. Select the radio button for the resource unavailability information to update. 
 This selection occurs from the list of resource unavailability information search results.  
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2. Click the [Update] button.  
Result: The Configure Resource Unavailability Information - Add New/Update/Save As screen 
displays with the appropriate information. 

 
 

 

3. Enter/Update the available fields as needed.   
 The Filter Criteria is defaulted to "Active." You can select various filters or enter data in 

the Unav. Start Date and Unav. End Date fields to get a different view of the existing 
information. 
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The Edit radio button is defaulted for each row.  

Because you are editing an existing record, the Resource Type, Name, Location, Division, 
Department fields are not editable.  

4. Click the [Add New Row] button.   
Result: The Configure Resource Unavailability Information - Add New/Update/Save As screen 
refreshes with a new row added.  

 
 

 

5. Select the [Delete] radio button for a specific rule/row to delete.  
6. Click the [Save] button. 

Result: The Configure Resource Unavailability - Confirmation screen displays. 
 

 

Related Links 

Configure Resource Unavailability Information Overview 

Configure Resource Unavailability - Search Screen 

Configure Resource Unavailability - Add New/Update/Save Screen 

 

My Court Information 

 

Save As New Resource Unavailability Information 

 



The Admin Section 

1321 

Introduction 

Using the "Save As" feature allows an existing set of resource unavailability information to be used as a 
"template" for a new set of resource unavailability information. Changes made to these parameters only 
apply to this new set of resource unavailability information and do not change the selected template. 

Required Changes 

After selecting a template set of information, you must change at least one setting to make the new set 
unique. Otherwise, this "new" set of resource unavailability information will be an exact copy of the 
template, which is not allowed in the system. 

You cannot change the Resource Type for a set of resource unavailability information using this process. 

Task Activity 

This activity takes place in the context of a resource unavailability search. Refer to the Search 
Unavailability Information task activity for more details on this process.  

Perform the following steps to update a set of resource unavailability information.   
 

1. Select the radio button for the resource unavailability information to use as a template. 
 This selection occurs from the list of resource unavailability information search results.  

 
 

 

2. Click the [Save As] button.  
Result: The Configure Resource Unavailability Information - Add New/Update/Save As screen 
displays with the appropriate information. 
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3. Enter/Update the available fields as needed.   
 The Filter Criteria is defaulted to "Active." You can select various filters or enter data in 

the Unav. Start Date and Unav. End Date fields to get a different view of the existing 
information. 

The Edit radio button is defaulted for each row.  

The Resource Type field is not editable.  

The Original JO/Temp Judge/Med. Name, Original Location, Original Division, or Original 
Department fields are shown depending on the Resource Type.   

4. Click the [Save] button. 
Result: The Configure Resource Unavailability - Confirmation screen displays. 

 

 

Related Links 

Configure Resource Unavailability Information Overview 

Configure Unavailability Information Search 

Configure Resource Unavailability - Add New/Update/Save Screen 
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Configure Scheduling Rules 

Configure Scheduling Rules Overview  

 

Introduction 

Configuring Scheduling Rules establishes the court's scheduling related business rules within the system. 
 These rules can be specified for a case category, case type, calendar type, and/or event type. 
 Scheduling information, including time standards, department assignments for specific calendar types 
and event types, and prior actions that need to occur on the case can also be configured. 

The configuration of court availability and calendaring related scheduling preferences of a court’s 
resources can also be set in the system. Refer to the Configure Resource Allocation Rules section for 
details on setting allocation rules.  

The configuration of court dark days and other resource unavailable days can also be set in the system. 
Refer to the Configure Resource Unavailability section for details on setting unavailability information.  

Use of Scheduling Rules 

These rules will be used by the system when scheduling a calendar event. In cases where multiple rules 
seem to apply to the scheduling of an event, the most granular (basic) rule will be used. The system will 
choose the most specific rule based on the following hierarchy (with Event Type being most specific and 
having highest hierarchy):  

• Case Category 
• Case Type 
• Calendar Type 
• Event Type.  

 

 

More than one rule cannot be defined with identical values at the same level of hierarchy. Therefore, the 
rule that has the highest level of hierarchy matching the criteria of the event will be applied.   

The functionality of scheduling an event is described in detail in the Schedule/Reserve Calendar Event. 
Refer to the Schedule/Reserve Calendar Events section for details on scheduling/reserving events. 

Task Activities 

Configuring scheduling rules includes the following task activities: 

• Search Scheduling Rules 
• Add Scheduling Rule 
• Update Scheduling Rule 
• Save As New Scheduling Rule 
• Delete Scheduling Rule 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
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Related Links 

Configure Scheduling Rules - Search Screen 

Configure Scheduling Rules - Add/Update/Save Screen 

 

My Court Information 

 

Search Scheduling Rules 

 

Introduction 

This activity allows you to search for scheduling rules that currently exist in the system. Refer to the 
Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for scheduling rules.  
 

1. Select [Admin] > [Calendar Administration] > [Configure Scheduling Rules]. 
Result: The Configure Scheduling Rules - Search screen displays. 

 
 

 

2. Select a Case Category value. 
 The Filter Criteria field is defaulted to "Active." Depending on the selected Case Category, 

the Case Type, Calendar Type, Event Type fields will be filtered.  
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3. Click the [Search] button. 
Result: The Configure Scheduling Rules - Search screen refreshes with the Search Results. 

 
 

 

 Entering the most known data into the fields before initiating the search will produce the 
best results. The search results are then sortable by the search result column hyperlinks. 

 

 

Related Links 

Configure Scheduling Rules Overview 

Configure Scheduling Rules - Search Screen 

 

My Court Information 

 

Add Scheduling Rule 

 

Introduction 

Adding a scheduling rule allows you to create a scheduling related business rule in the system.   

Task Activity 

Perform the following steps to add a scheduling rule.  
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1. Select [Admin] > [Calendar Administration] > [Configure Scheduling Rules]. 
Result: The Configure Scheduling Rules - Search screen displays. 

 
 

 

2. Click the [Add New] button.  
Result: The Configure Scheduling Rules - Details screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 
4. Rule Name 
5. Case Category 
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6. Effective Date 
 New information for the Rule Name and Effective Date fields must be entered. The 

entered combination of Rule Name and Effective date must be unique.  

The Case Type, Calendar Type, Event Type are filtered depending on the Case Category 
selected.  

If "Calendar" is selected for the Type of Days field, the system will consider weekend days. If 
"Working" is selected for the Type of Days field, the system will not consider weekend days.  

Additional optional fields may be entered to make the rule more specific.  

4. Click the [Save] button. 
Result: The Configure Scheduling Rules - Confirmation screen displays.  

 

 

Related Links 

Configure Scheduling Rules Overview 

Configure Scheduling Rules - Search Screen 

Configure Scheduling Rules - Add New/Update/Save Screen 

 

My Court Information 

 

Update Scheduling Rule 

 

Introduction 

Updating a scheduling rule is the process of changing the details of an existing scheduling rule. During 
the updating process, the Case Category, Case Type, Calendar Type, Event Type fields are not editable.  

Task Activity 

This activity takes place in the context of a scheduling rule search. Refer to the Search Scheduling Rules 
task activity for more details on this process.  

Perform the following steps to update a scheduling rule.   
 

1. Select the radio button for the scheduling rule name to update. 
 This selection occurs from the list of scheduling rule search results.  
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2. Click the [Update] button.  
Result: The Configure Scheduling Rules - Details screen displays with appropriate information. 

 
 

 

3. Enter/Update the available fields as needed.   
 The combination of Rule Name and Effective Date fields must be unique. The Case 

Category, Case Type, Calendar Type, Event Type fields are not editable. 

4. Click the [Save] button. 
Result: The Configure Scheduling Rules - Confirmation screen displays.  
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Related Links 

Configure Scheduling Rules Overview 

Configure Scheduling Rules - Search Screen 

Configure Scheduling Rules - Add New/Update/Save Screen 

 

My Court Information 

 

Save As New Scheduling Rule 

 

Introduction 

Using the "Save As" feature allows an existing scheduling rule to be used as a "template" for a new rule. 
Changes made to these rule parameters only apply to this new rule and do not change the selected 
template. 

Required Changes 

After selecting a template rule, you must change at least one rule setting to make the new rule unique. 
Otherwise, this "new" rule will be an exact copy of the template, and a duplicate rule validation will occur 
in the system. 

You cannot change the Resource Type for a scheduling rule using this process. 

Task Activity 

This activity takes place in the context of a scheduling rule search. Refer to the Search Scheduling Rules 
task activity for more details on this process.  

Perform the following steps to update a scheduling rule.   
 

1. Select the radio button for the scheduling rule name to use as a template. 
 This selection occurs from the list of scheduling rule search results.  
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2. Click the [Save As] button.  
Result: The Configure Scheduling Rules - Details screen displays with the appropriate 
information. 

 
 

 

3. Enter/Update the available fields as needed.  
 The combination of Rule Name and Effective Date fields must be unique.   

4. Click the [Save] button. 
Result: The Configure Scheduling Rules - Confirmation screen displays.  
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Related Links 

Configure Scheduling Rules Overview 

Configure Scheduling Rules - Search Screen 

Configure Scheduling Rules - Add New/Update/Save Screen 

 

My Court Information 

 

Delete Scheduling Rule 

 

Introduction 

Deleting a scheduling rule allows you to remove an existing scheduling rule from the system. 

Task Activity 

This activity takes place in the context of a scheduling rule search. Refer to the Search Scheduling Rules 
task activity for more details on this process.  

Perform the following steps to delete a scheduling rule.  
 

1. Select the radio button for the scheduling rule name to delete. 
 This selection occurs from the list of scheduling rule search results .  
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2. Click the [Update] button.  
Result: The Configure Scheduling Rules - Details screen displays with appropriate information 

 
 

 

3. Click the [Delete] button.  
Result: The Configure Scheduling Rules - Confirmation screen displays.  

 The deleted scheduling rule is no longer shown as part of the search results.  

 

 

Related Links 

Configure Scheduling Rules Overview 

Configure Scheduling Rules - Search Screen 

Configure Scheduling Rules - Add New/Update/Save Screen 

 

Configure Calendar Views 

Configure Calendar Views Overview  

 

Introduction 

Configuring calendar views describes the process of configuring various calendar formats to be used in 
the courts. This allows each court to define the data elements that make up the calendar and also their 
relative placement in the view. Once a calendar view has been defined, it can be used by the court as 
needed.  
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During the process of configuring a view, you will choose a specific template (such as a summary 
template) and then select the fields that need to be shown on that template. These fields will be selected 
from a list of calendar related fields that are pre-defined in the system. Hence, a template, along with the 
relevant data elements and their sequences, and a unique calendar view name will constitute a calendar 
view.  

In order for calendar views to be configured, calendar templates must exist in the system. There will be 
four base design templates available. These templates define the look and feel of the calendar, such as 
the summary calendar posted outside a department, which is different from the detailed calendar that is 
used by a Judicial Officer during an actual courtroom event.  

The calendar can be viewed and printed. Refer to the Display/Print Calendar section for details on 
viewing and printing calendar views. The calendar can also be finalized by the court. Refer to the Finalize 
Calendar section for details on this process. 

Use of Calendar Templates  

During the process of configuring a view, you must select a specific template and then select the fields 
that need to be shown on that template. These fields will be selected from a list of calendar related fields 
pre-defined in the system.  

A calendar view is composed of a base template and relevant data elements. The calendar view can be 
named by your discretion and saved in the system.  

The system will also allow for multiple views to be configured using a single base template. However, the 
calendar view name must be unique.   

Task Activities 

Configuring calendar views includes the following task activities: 

• Search Calendar Views 
• Add Calendar View 
• Update Calendar View 
• Save As New Calendar View 
• Delete Calendar View 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Configure Calendar View - Search Screen 

Configure Calendar View - Details Screen 

Configure Calendar View - Detail Template Screen 

Configure Calendar View - Summary Template Screen 

Configure Calendar View - Headers, Footers and Sorting Screen 
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My Court Information 

 

Search Calendar Views 

 

Introduction 

This activity allows you to search for calendar views that currently exist in the system.  

Task Activity 

Perform the following steps to search for calendar views.  
 

1. Select [Admin] > [Calendar Administration] > [Configure Calendar View]. 
Result: The Configure Calendar View - Search screen displays. 

 
 

 

2. Select data for the Calendar Template field.  
 The Calendar View is an optional field to narrow the search results.  

3. Click [Search] button. 
Result: The Configure Calendar View - Search screen refreshes with the Search Results. 
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 Entering the most known data into the fields before initiating the search will produce the 
best results. These results are sortable by the search result column hyperlinks.  

 

 

Related Links 

Configure Calendar Views Overview 

Configure Calendar View - Search Screen 

 

My Court Information 

 

Add Calendar View 

 

Introduction 

Adding a calendar view is the process of creating a new calendar view using one of the base design 
templates.  

Task Activity 

Perform the following steps to add a calendar view. 
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1. Select [Admin] > [Calendar Administration] > [Configure Calendar View]. 
Result: The Configure Calendar View - Search screen displays. 

 
 

 

2. Click the [Add New] button.  
Result: The Configure Calendar View - Details screen displays.  

 
 

 

3. Enter data for the following required fields: 

• Calendar View Name 
• Calendar Template  
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 The Calendar View Name  field must be a unique name.  

4. Click the [Next] button.  
 Depending on the Calendar Template selected, different screens will be displayed.  

Result #1: If "Detailed Template" is selected, then the Configure Calendar View - Detail Template 
screen displays.  

 
 

 

5. Result #2: If "Summary Template" is selected, then the Configure Calendar View - Summary 
Template screen  displays.  
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5. Select at least one data field.  
6. Click the [Next] button.  

Result: The Configure Calendar View - Headers, Footers and Sorting screen displays.  

 
 

 

7. Select data for the Sort 1 criteria.  
 You can add additional filters by selecting the Sort 2, Sort 3 fields. You can also select 
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additional optional fields in the First Page Header, Subsequent Page Headers, Footer 
sections. 

8. Click the [Finish & Save] button. 
Result: The Configure Calendar View - Confirmation screen displays. 

 The Preview screen displays in a new pop-up window.  

 
 

 

 

 

Related Links 

Configure Calendar Views Overview 

Configure Calendar View - Search Screen 

Configure Calendar View - Details Screen 

Configure Calendar View - Detail Template Screen 

Configure Calendar View - Summary Template Screen 

Configure Calendar View - Headers, Footers and Sorting Screen 

 

My Court Information 

 

Update Calendar View 

 

Introduction 

Updating a calendar view is the process of changing the look and feel and the data elements of an 
existing calendar view. The calendar view name and base template cannot be changed during an update 
mode.   
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Task Activity 

This activity takes place in the context of calendar views search. Refer to the Search Calendar Views task 
activity for more details on this process.  

Perform the following steps to update a calendar view. 
 

1. Select the radio button for a calendar view to update. 
 This selection occurs from the list of calendar view search results.  

 
 

 

2. Click the [Update] button.  
Result: The Configure Calendar View - Details screen displays with the appropriate information.  
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3. Enter/Update the available fields as needed.  
 The Calendar View and Calendar Template is not editable.   

4. Click the [Next] button.  
 Depending on the Calendar Template selected, different screens will be displayed.  

Result #1: If "Detailed Template" is selected, then the Configure Calendar View - Detail Template 
screen displays.  



Printed Documentation 

1342 

 
 

 

5. Result #2: If "Summary Template" is selected, then the Configure Calendar View - Summary 
Template screen displays.  
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6. Select/Update the available fields as needed.  
7. Click the [Next] button.  
Result: The Configure Calendar View - Headers, Footers and Sorting screen displays.  

 
 

 

8. Select/Update data for the Sort 1 criteria.  
 You can add/update additional filters by selecting the Sort 2, Sort 3 fields. You can also 
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select/update additional optional fields in the First Page Header, Subsequent Page Headers, Footer 
sections.  
9. Click the [Finish & Save] button. 
Result: The Configure Calendar View - Confirmation screen displays. 
10. The Preview screen displays in a new pop-up window.  

 
 

 

 

 

Related Links 

Configure Calendar Views Overview 

Configure Calendar View - Search Screen 

Configure Calendar View - Details Screen 

Configure Calendar View - Detail Template Screen 

Configure Calendar View - Summary Template Screen 

Configure Calendar View - Headers, Footers and Sorting Screen 

 

My Court Information 

 

Save As New Calendar View 

 

Introduction 

Using the "Save As" feature allows an existing calendar view to be used as a "template" for a new 
calendar view. Changes made to the calendar view only apply to this new view and do not change the 
selected template. 
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Required Changes 

After selecting a template calendar view, you must change at least the calendar name to make the new 
view unique. Otherwise, this "new" view will be an exact copy of the template, which is not allowed in the 
system. 

Task Activity 

This activity takes place in the context of Configure Calendar Views search. Refer to the Search Calendar 
Views task activity for details on this process.  

Perform the following steps to save a calendar view as a new calendar view. 
 

1. Select the radio button for a calendar view to use as a template. 
 This selection occurs from the list of calendar view search results.  

 
 

 

2. Click the [Save As] button.  
Result: The Configure Calendar View - Details screen displays with appropriate information.    
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3. Enter/Update the available fields as needed.  
 The Calendar View Name field must be a unique name or the system will prompt you 

with an error message. The Calendar Template is not editable.  

4. Click the [Next] button.  
 Depending on the Calendar Template selected, different screens will be displayed.  

Result #1: If "Detailed Template" is selected, then the Configure Calendar View - Detail Template 
screen displays.  
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5. Result #2: If "Summary Template" is selected, then the Configure Calendar View - Summary 
Template screen displays. 
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5. Select/Update the available fields as needed.  
6. Click the [Next] button.  

Result: The Configure Calendar View - Headers, Footers and Sorting screen displays.  

 
 

 

7. Select/Update data for the Sort 1 criteria.  
 You can add/update additional filters by selecting the Sort 2, Sort 3 fields. You can also 
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select/update additional optional fields in the First Page Header, Subsequent Page Headers, 
Footer sections. 

8. Click the [Finish & Save] button. 
Result: The Configure Calendar View - Confirmation screen displays with a confirmation 
message. 

9. The Preview screen displays in a new pop-up window.  

 
 

 

 The [Save As] button creates a new calendar view by copying a similar existing calendar 
view. 

 

 

Related Links 

Configure Calendar Views Overview  

Configure Calendar View - Search Screen 

Configure Calendar View - Details Screen 

Configure Calendar View - Detail Template Screen 

Configure Calendar View - Summary Template Screen 

Configure Calendar View - Headers, Footers and Sorting Screen 

 

My Court Information 

 

Delete Calendar View 

 

Introduction 
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Deleting a calendar view is the process of removing an existing calendar view from the system.   

Task Activity 

This activity takes place in the context of calendar views search. Refer to the Search Calendar Views task 
activity for more details on this process.  

Perform the following steps to delete a calendar view.  
 

1. Select the radio button for a calendar view to delete. 
 This selection occurs from the list of calendar view search results.  

 
 

 

2. Click the [Delete] button.  
Result: The Configure Calendar View - Confirmation screen displays.  

 The deleted calendar view is no longer shown as part of the search results.  

 

 

Related Links 

Configure Calendar Views Overview 

Configure Calendar View - Search Screen 
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Minutes Administration 

Configure Minute Codes 

Configure Minute Codes Overview  

 

Introduction 

Courtroom personnel record the minutes of a hearing within the Minute Order Capture screen. Code-
based minutes allow you to take advantage of pre-defined wording and provide you with the ability to 
customize content and to trigger actions related to other functions within the system by using the 
available minute codes.  

These codes may cause an action to occur in the system, such as creating a fee or scheduling an event. 
Refer to the Function Actions Overview section for details on these actions. Minute codes may also cause 
pre-configured text to be recorded in the minutes, such as instructions by the court for a case participant 
to perform a specific task. This task describes the activities related to creating both code and text-based 
minute codes. 

Configuring Minute Codes 

Minute codes that require the system to do something, such as scheduling an event or updating a party's 
status, are called action-based codes. You can select existing system actions and relate them to a 
particular code. These codes might require values (for the input parameters associated with the actions- 
e.g. such as a fee amount field when generating an action related to fees) to be specified by the user at 
the time of using the code in order for the system to perform the actions associated to the code.  

Codes can also include text fields. The values for these text fields will be provided by Courtroom 
personnel while entering minutes. The system will not perform any action based on these text fields.  

You also have the ability to assign case categories and case types to each code. This classification does 
not prevent you from using the code while recording minutes for a different case category or case type. 
However, it helps during the search process to select the correct code when entering minutes. 
Additionally, at the time of minute entry, if a code is used for a different case category/case type than 
what has been configured, the system will display a warning message. 

Before Configuring a Minute Code 

In order to configure a code that will trigger a system action, the system action must already exist in the 
system. Refer to the Action Code List for a list of available actions in the system. 

Task Activities 

Configuring minute codes includes the following task activities: 

• Search Minute Codes 
• Create Minute Codes 
• Save As New Minute Codes 
• Update Minute Codes 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
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• Action Code List 
 

 

Related Links 

Configure Codes - Configure Parameters Screen  

Configure Codes - Functions and Actions Screen  

Configure Codes - Search Screen  

Configure Codes - Text Screen  

 

My Court Information 

 

Search Minute Code 

 

Introduction 

This activity allows you to search for minute codes. This search is helpful if you want to update an existing 
code or copy an existing code and modify it to create a new code, using the "Save As" functionality. 

Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a minute code. 
 

1. Select [Admin] > [Minutes Administration] > [Configure Codes]. 
Result: The Configure Codes - Search screen displays. 
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2. Select either a Case Category or Case Type. 
3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Configure Codes - Search screen refreshes with the Search Results. 

 
 

 

 From the search results, you can Update a Minute code or "Save As" a New Minute 
code.  
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Related Links 

Configure Minute Order Code Overview 

Configure Codes - Search Screen 

 

My Court Information 

 

Create Minute Codes 

 

Introduction 

You can create a minute code that will perform an action within the system and write an entry into the 
minute and Case History/Register of Actions, based on your court's configuration. 

Before Creating a Minute Code 

If you choose to create a new Minute code, you must first verify that a similar minute code does not 
already exist with the exact same values and parameters assigned. If a similar minute code already 
exists, you may choose to use the system's Save As functionality to save time. Searching for previously 
entered codes also validates that a duplicate action does not get assigned to two different codes.  

Task Activity 

Perform the following steps to create a minute code. 
 

1. Select [Admin] > [Configure Codes]. 
Result: The Configure Codes - Search screen displays. 
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2. Click [Add New Code]. 
Result: The Configure Codes - Functions and Actions screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 
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• Code Name 
• Code Description 
• Code Type 
• Case Category 
• Case Type (Not selecting a case type will select all case types for the case category) 
• Effective Date 

 

 If selecting "text" for the Code Type, the available function actions at the bottom of the 
screen will appear grayed out, as a text based minute code will not cause any actions to occur 
in the system. You will also proceed to step 7 when you click the [Next] button. 

 Selecting a case category and type will allow the code to be identified when performing a 
search of all codes for a specific case category and type. 

 Click the [Add Row] button to add additional function actions as necessary. 
 

4. Click the [Next] button. 
Result: The Configure Codes - Configure Parameters screen displays. 

 
 

 

5. Enter/Select data for the function/action parameters based on the selected function/actions from 
the previous screen (shown previously in step 3). 

 Parameters are necessary to indicate how a defined function/action should work. For 
example, you can create an action code that uses a function/action for creating a fee, but you 
must specify the following parameters: 

o The party that must pay the fee  
o The type of fee  
o The fee amount  
o When the fee will be due  
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You may specify default or assigned values for function/action parameters. If you assign a 
value of "default" to a function/action parameter, then the system initially displays this value in 
the Minute but allows it to be modified. If you assign a value of "assigned" to a function/action 
parameter, then the value is fixed and the you will not have the ability to modify this within the 
minutes. 

6. Click the [Next] button. 
Result: The Configure Codes - Text screen displays. 

 
 

 

7. Enter the data for the Minute Text field.  
 The data entered in this field will be displayed in the minutes when the configured code is 

selected. You may choose to enter parameters within the minutes text for each of the 
parameters available for the selected function actions. 

To enter a parameter within the Minutes text field, enter the parameter number for the desired 
parameter (e.g. entering "<1>", would cause the value for the parameter associated with <1> 
to appear when the minutes are recorded).  

Optionally, you may choose to enter information into the Case History/Register of Actions as 
well, using the same parameter values available to you when populating the Minutes Text field. 

For example, if the following parameters existed for the "Create Fee" function action: 

o The party that must pay the fee (e.g. Plaintiff) 
o The type of fee (e.g. Proof Of Service Fee) 
o The fee amount (e.g. $100.00) 
o When the fee will be due (e.g. 06/05/2006) 

And you configured the function/action text as: 

"The <1> must pay for the <2> in the amount of <3> by <4>." 

The text in the Minute would be recorded as: 
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"The Plaintiff must pay for the Proof Of Service Fee in the amount of $100.00 by 
06/05/2006."  

You do not have to specify every parameter listed within the Parameters Table to appear in the 
Minute or Case History/Register of Actions Text. 

 Selecting "Minutes Only" from the Configure Codes- Text screen header will cause the 
text codes only to be entered into the minutes and not the Case History/Register of Actions. 
You may also specify if the configured code may be used in probate notes by selecting the 
"Probate Notes" checkbox. This option is only available to you when selecting text based 
codes. 

 

8. Click the [Finish and Save] button. 
Result: The Configure Codes - Confirmation screen displays. 

 
 

 

 

 

Related Links 

Configure Minute Order Code Overview 

Configure Codes - Search Screen 

Configure Codes - Functions and Actions Screen 

Configure Codes - Configure Parameters Screen 

Configure Codes - Text Screen 

 

My Court Information 
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Update Minute Code 

 

Introduction 

You can update a previously configured minute code by performing a minute code search and selecting a 
minute code to update. This activity may be necessary if the original code was configured incorrectly, or if 
new function actions, function action parameters or other changes are required. 

Activities Performed Before Performing "Update"  

In order to use the Update feature, the minute code must exist in the system. If the minute code cannot 
be found in the search results, consider retrying the search with different search parameters.   

It is assumed that you have performed a minute code search before performing an update. Refer to the 
Search Minute Codes task activity for details on performing a minute code search. 

Task Activity 

Perform the following steps to update an existing minute code. 
 

1. Select the radio button for the Minute code you wish to use as a template. 
 This selection occurs from the search results of the Configure Codes - Search screen.  

 
 

 

2. Click the [Update] button. 
Result: The Configure Codes - Functions and Actions screen displays, with the information 
defaulted to the values of the selected code. Make any necessary changes to the selected 
functions and actions. 
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3. Click the [Next] button. 
Result: The Configure Codes - Configure Parameters screen displays, with the information 
defaulted to the values of the selected minute code and specified function/actions. Make any 
necessary changes to the selected function/action parameters. 
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 This screen allows you to configure parameter values (default or assigned) related to 
action codes. You will not be navigated to this screen if the code is a text based code.  

4. Click the [Next] button. 
Result: The Configure Codes - Text screen displays with the information defaulted to the text from 
the selected minute code and specified function/action parameters text. Make any necessary 
changes to the minute and/or Case History/Register of Actions text. 

 
 

 

5. Click the [Finish and Save] button. 
Result: The Configure Codes - Confirmation screen displays. 
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Related Links 

Configure Minute Order Code Overview 

Configure Codes - Search Screen 

Configure Codes - Functions and Actions Screen 

Configure Codes - Configure Parameters Screen 

Configure Codes - Text Screen 

 

My Court Information 

 

Save As New Minute Codes 

 

Introduction 

Using the "Save As" feature allows an existing minute code to be used as a "template" for a new minute 
code. Changes made to the minute code only apply to this new minute code and do not change the 
selected template. 

Required Minute Code Changes 

After selecting a template minute code, you must change at least the minute code name to make the new 
minute code unique. Otherwise, this "new" minute code will be an exact copy of the template, which is not 
allowed in the system. 

Activity Requirements 

In order to use the [Save As] button, a Minute code must exist in the system to use as a template. Refer 
to the Create Minute Codes task activity for details on configuring a new minute code in the system. 

This activity takes place after performing a search for a template minute order code. It is assumed that 
you have performed a minute code search. Refer to the Search Minute Codes activity for details on 
performing a minute code search. 

Task Activity 

Perform the following steps to save an existing minute code as a new minute code. 
 

1. Select the radio button for the Minute code you wish to use as a template. 
 This selection occurs from the search results of the Configure Codes - Search screen.  
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2. Click the [Save As] button. 
Result: The Configure Codes - Functions and Actions screen displays, with the information 
defaulted to the values of the selected code. Make the required adjustments to the code name, 
type (i.e. action or text) and/or the functions and actions for the new minute code you wish to 
create.  

 
 



Printed Documentation 

1364 

 

 This screen allows you to configure code types and functions and actions related to 
action codes. You must change at least the code name to configure the new minute code.  

3. Click the [Next] button. 
Result: The Configure Codes - Configure Parameters screen displays, with the information 
defaulted to the values of the selected minute code and specified function/actions. Make any 
necessary adjustments to the parameters and minute code template.  

 
 

 

 This screen allows you to configure parameter values (default or assigned) related to 
action codes. You will not be navigated to this screen if the code is a text based code. 

4. Click the [Next] button. 
Result: The Configure Codes - Text screen displays, with the information defaulted with text from 
the selected Minute Code template. Make any necessary changes to the minute text and/or Case 
History/Register of Actions text. 
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5. Click the [Finish and Save] button. 
Result: The Configure Codes - Confirmation screen displays. 

 
 

 

 

 

Related Links 

Configure Minute Order Code Overview 

Configure Codes - Search Screen 

Configure Codes - Functions and Actions Screen 
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Configure Codes - Configure Parameters Screen 

Configure Codes - Text Screen 

 

Configure Minute Macros 

Configure Minute Macros Overview 

 

Introduction 

You can configure macros within the system to define what specific minute codes will pre-populate the 
minute Order Capture Screen when recording minutes. These macros are used when recording 
information regarding a Courtroom Hearing or Court Order. Macros provide you with a pre-defined subset 
of minute codes to create specific text within minutes, or a way to perform specific actions in the system 
(such as scheduling an event or the creating a fee).  

Configuring Macros 

Macros can be used with probate notes and/or minutes. Macros associated with probate notes are 
available when capturing information regarding a probate case. Minute macros are available when 
recording minute information for an event or a Judicial Officer's order. The order in which you select the 
minute codes will determine the order in which they will display in the Minute Order Capture Screen. 

Before Configuring Macros 

Before you can add a minute code to a macro, the code must be configured within the system. Refer to 
the Configure Minute Overview section for details on configuring minute codes. 

Task Activities 

Configuring minute macros includes the following task activities: 

• Create Minute Macro 
• Search Minute Macro 
• Save As New Minute Macro 
• Update Minute Macro 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Configure Macro - Search Screen  

Configure Macro - Select Code Screen  

 

My Court Information 
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Search Minute Macro 

 

Introduction 

This activity allows you to search for an existing macro based on case category, case type or macro type. 
Refer to the Search Feature Overview for details on performing a search in the system. 

Task Activity 

Perform the following steps to search for a minute macro. 
 

1. Select [Admin] > [Minutes Administration] > [Configure Macro]. 
Result: The Configure Macro - Search screen displays. 

 
 

 

2. Enter/Select data for at least one of the following required search fields: 
3. Case Category  
4. Macro Type 

 

3. Enter/Select data for other search parameter fields, as necessary. 
4. Click the [Search] button. 

Result: The Configure Macro - Search screen refreshes with the Search Results. 
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 From the search results, you can Update a minute code or use the Save As feature to 
create a new minute code.  

 

 

Related Links 

Configure Minute Order Macro Overview 

Configure Macro - Search Screen 

 

My Court Information 

 

Create Minute Macros 

 

Introduction 

You can configure a minute macro and associate it with multiple case categories and case types. When 
you record minutes for a case, the macro will be available to you based on the selected case category 
and case type.  

Task Activity 

Perform the following steps to configure a minute macro. 
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1. Select [Admin] > [Minutes Administration] > [Configure Macro]. 
Result: The Configure Macro - Search screen displays. 

 
 

 

2. Click the [Add New Macro] button. 
Result: The Configure Macro - Select Code screen displays. 

 
 

 

3. Enter/Select data for the following required fields: 

• Macro Name 
• Macro Type 
• Macro Description 
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• Case Category 
• Case Type 
• Effective Date 

 Entering an effective date dictates that the Courtroom Clerk will not have access to the 
minutes macro until the inputted date. Entering an end date for a minutes macro means that 
the Courtroom Clerk will not be able to use the macro after the end date elapses.  

4. Enter/Select data for the following required fields in the Macro - Select Code Results: 

• Case Category 
• Select Code 

 The order of the Action Codes within the result set will determine the order in which the 
Action Codes appear in the minutes. Selecting the "Add Row" link to the left of any record 
within the results set will insert a record before the selected row.  

5. Click the [Save] button. 
Result: The Configure Macro - Confirmation screen displays. 

 
 

 

 

 

Related Links 

Configure Minute Order Macro Overview 

Configure Macro - Search Screen 

Configure Macro - Select Code Screen 

 

My Court Information 
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Update Minute Macro 

 

Introduction 

You can update an existing minute macro by searching for the macro and selecting the macro you wish to 
update. You may want to update a macro if the original macro was configured incorrectly, or if new action 
codes, case category or case type associations are required.   

Activities Performed Before Performing "Update" 

You must perform a macro search before using the "Update" feature. Refer to the Search Minute Macro 
task activity for details on performing this search. 

Task Activity 

Perform the following steps to update a minute Macro. 
 

1. Select the radio button for the minute macro you wish to update. 
 This selection occurs from the search results of the Configure Macros - Search Results 

screen.  

 
 

 

2. Click the [Update] button. 
Result: The Configure Macro - Select Code screen displays, with the information defaulted to the 
values of the selected macro.  
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 The Configure Macro - Select Code screen allows you to update the case category, type 
and action codes associated with the existing macro. Make the required adjustments to the 
macro type (i.e. probate or minutes) and/or the selected action codes for the macro you wish to 
update.  

3. Click the [Save] button. 
Result: The Configure Macro - Confirmation screen displays. 

 
 

 

 

 

Related Links 
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Configure Minute Order Macro Overview 

Configure Macro - Search Screen 

Configure Macro - Select Code Screen 

 

My Court Information 

 

Save As New Minute Macro 

 

Introduction 

Using the "Save As" feature allows an existing minute macro to be used as a "template" for a new minute 
macro. Changes made to the minute macro only apply to this new minute macro and do not change the 
selected template. 

Required Rule Changes 

After selecting a template minute macro, you must change at least the minute macro name to make the 
new minute macro unique. Otherwise, this "new" minute macro will be an exact copy of the template, 
which is not allowed in the system. 

Activity Requirements 

In order to use the "Save As" feature, a usable minute macro must already exist in the system to use as a 
template. Refer to the Create Minute Codes task activity for details on configuring a new minutes macro. 

You must also perform a macro search before using the "Save As" feature. Refer to the Search Minute 
Macro task activity for details on performing this search. 

Task Activity 

Perform the following steps to "Save As" a new minute macro. 
 

1. Select the radio button for the minutes macro you wish to use as a template. 
 This selection occurs from the search results of the Configure Macros - Search Results 

screen.  
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2. Click the [Save As] button. 
Result: The Configure Macro - Select Code screen displays, with the screen defaulted to the 
values of the selected Minutes macro.  

 
 

 

 The Configure Macro - Select Code screen allows you to configure the case category, 
type and action codes associated with the macro. Make the required adjustments to the macro 
type (i.e. probate or minutes) and/or the selected action codes for the new Minutes Macro you 
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wish to create. At a minimum, you must change the macro name in order to configure the new 
macro.  

3. Click the [Save] button. 
Result: The Configure Macro - Confirmation screen displays. 

 
 

 

 

 

Related Links 

Configure Minute Order Macro Overview 

Configure Macro - Search Screen 

Configure Macro - Select Code Screen 

 

Configure Minute Header 

Configure Minute Header Overview  

 

Introduction 

You can configure the Minute Header to change what data is shown on a printed Minute form. Certain 
fields must always be visible on the minute form, such as: 

• Calendar Time 
• Case Number 
• Case Title 
• Clerk 
• Court Title 
• Date 
• Department  
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• Judicial Officer Presiding 
• Page Number 

Task Activities 

Configuring minute headers includes the following task activity: 

• Configure Minute Header 

Additional Resources 

There are no other resources related to this overview. 

 

 

Related Links 

Configure Minute Header Screen 

 

My Court Information 

 

Configure Minute Header 

 

Introduction 

You can configure the minute header to change the data that is shown on a printed minute form. 

Task Activity 

Perform the following steps to configure the Minute header. 
 

1. Select [Admin] > [Minutes Administration] > [Configure Minute Header]. 
Result: The Configure Minute Header screen displays. 
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2. Select to hide or display Minute Header data on the first page of the Minute for the following 
fields: 

• Bailiff/Court Attendant 
• Case Category 
• Case Initiation Date 
• Case Type 
• Causal Document 
• Clerk  
• Court Location 
• Date Field 
• Electronic Recording Monitor 
• Event Type 
• Moving Party 
• Reporter 

 

3. Select to hide or display Minute Header data on the footer of the Minute for the following fields: 

• Calendar Number 
• Court Department 
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4. Click the [Save] button. 
Result: The Configure Minute Header screen displays with the updated information. 

 
 

 

 

 

Related Links 

Configure Minute Header Overview 

Configure Minute Header Screen 

 

Security/User Administration 

Data Access 

Data Access Overview  

 

Introduction 
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Data access privileges enable the local administrator to define specific types of case-related information a 
selected user can and cannot see: 

• Secured Addresses 
• Secured Participants 
• Documents 
• Case Histories 
• Case Categories 

Secured Addresses 

When a user initiates a case or adds a case filing, they can designate a case participant's address as 
confidential. When a case participant's address is designated as confidential, only users who have the 
Secured Addresses option selected will be able to see the address when looking at or working with the 
associated case for which the address was secured. System users who do not have this option selected 
may see other case-related information, but will not see the participant's address. 

A case participant's address can be designated as confidential from the following locations in the system: 

• Case participant profile information associated with a case 
• Case participant profile information associated with a payment plan 

Secured Participants 

A case participant can be designated as confidential (within the context of a case) from the following 
location in the system: 

• Case participant profile information associated with a case 
 

 

When a participant is designated as confidential, only users who have the Secured Participants option 
checked will be able to see the participant's name when looking at or working with the associated case for 
which the participant was secured. 

Masking of Secured Addresses and Secured Participants 

When a user does not have access to a secured address and is working within the context of a case, they 
will see the participant's name but the address field will be empty. 

When a user does not have access to a secured participant and is working within the context of a case, 
the name field will be populated but the information will be covered with X's: XXXXXXXXXX. 

Understand Security Access Levels for Documents, Case Histories, and Case Categories 

Documents, case histories, and case categories are all rated with a security access level ranging from 1 
to 9, with 1 being the lowest level of security access, and 9 being the highest. If a user has a security 
setting of 2 for case histories, the user will not be allowed to see case histories that are secured with a 
rating of 3 or higher. 

Case Histories 

Security levels are set on case history entries when a case history record is added to a case. 

Case Categories 
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Security levels are set on case categories when a case is initiated for a given case category. However, an 
individual case may have its security level automatically updated if configured to do so as the result of an 
entry action. 

Documents 

Security levels are set on documents when a case is initiated and case filings are associated with the 
case. 

High Profile Case Security 

When a selected user needs access to a case that has a security setting that is higher than their case 
category security setting allows, they can be given access by a system administrator to the case by way 
of the case number or legacy number. When their work with the case is complete, access to the case can 
be reversed by removing the case or legacy number from the high profile cases section. 

Task Activities 

Data access privileges include the following task activities: 

• Manage User Roles 
• Manage Data Access Privileges 
• Copy Roles and Data Access Privileges 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Security Background Information 
• Role Definitions 

 

 

Related Links 

Copy User Screen 

View User Screen 

Search User Session Screen 

 

My Court Information 

 

Manage User Roles 

 

Introduction 

This task activity provides local administrators instructions to manage user roles. 

Definition 
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A role is a pre-defined group of menu options and page functionality that is assigned to a system user by 
a local administrator. Ultimately, a user's roles define the areas in the system in which the user can work.  

Pre-Defined Roles 

User roles are pre-defined. 

Task Activity 

Perform the following steps to assign roles to or remove roles from a system user. 
 

1. Select [Admin] > [User Administration] > [Search User]. 
Result: The Search User screen displays. 

 
 

 

2. Enter/Select data in the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search User screen refreshes and displays user IDs matching the search criteria. 
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4. Click the User ID hyperlink for the user whose roles you want to update. 
Result: The View User screen displays. 

 
 

 

5. Click the [Access Roles] tab. 
Result: The Access Roles tab highlights and displays the appropriate information. 
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6. Scroll through the list of roles and select the check boxes for the roles you want the selected user 
to have. 

7. Clear any checkmarks to remove role access. 
8. Click the [Save] button. 

 

 

Related Links 

Data Access Overview 

Search User Session Screen 

View User Screen 

 

My Court Information 
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Manage Data Access Privileges 

 

Introduction 

This task activity provides local administrators instructions to manage user data access privileges. 

Task Activity 

Perform the following steps to manage data access privileges assigned to a selected user. 
 

1. Select [Admin] > [User Management] > [Search User]. 
Result: The Search User screen displays. 

 
 

 

2. Enter/select data for the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search User screen refreshes and displays user IDs matching the search criteria. 
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4. Click the User ID hyperlink for the user whose data access privileges you want to update. 
Result: The View User screen displays. 

 
 

 

5. Click the [Data Access] tab. 
Result: The Data Access tab highlights and displays in the appropriate information. 
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6. Select the [Secured Addresses] and/or [Secured Participants] checkboxes according to the 
appropriate privileges.  

7. Update the security level access settings for: 

• Documents 
• Case Histories 
• Limited Civil Cases 
• Unlimited Civil Cases 
• Probate Cases 
• Small Claims Cases 

 

8. To add high profile cases, enter the Case Number or Legacy Number and click the [Add] 
button. 

9. To remove high profile cases, select the appropriate case number or legacy number checkboxes 
and click the [Remove] button. 

10. Click the [Save] button. 
 

 

Related Links 

Data Access Overview 
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Search User Session Screen 

View User Screen 

 

My Court Information 

 

Copy Roles and Data Access Privileges 

 

Introduction 

Since it is likely that a group of users at a court will need identical security access, the system provides a 
feature that enables the local administrator to copy the roles and data access privileges from one user 
and assign them to other users needing identical roles and data access privileges. 

Task Activity 

Perform the following steps to copy the user roles and data access privileges of one user and assign 
them to another user. 
 

1. Select [Admin] > [User Administration] > [Search User]. 
Result: The Search User screen displays. 

 
 

 

2. Enter/Select data in the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search User screen refreshes and displays user IDs matching the search criteria. 
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4. Click the User ID hyperlink for the user whose roles and data access privileges you want to copy. 
Result: The View User screen displays with the [Profile] tab in the foreground. 

 
 

 

5. Click the [Save As] button. 
Result: The Copy User screen displays all users who do not have any assigned roles or data 
access privileges. 
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6. Select the checkboxes for users who will receive the same roles and data access privileges as 
the user selected in the beginning of this task activity. 

7. Click the [Save] button. 
 

 

Related Links 

Data Access Overview 

Search User Session Screen 

View User Screen 

Copy User Screen 

 

Manage Users 

Manage Users Overview  

 

Introduction 

User setup and configuration is the first step in the security setup process. The configuration of user roles 
and user data access privileges follow this step. 

Create a User 

Only a central administrator can create system users. Additionally, the system user must exist in the 
Active Directory before the central administrator can add the user to the system. The central administrator 
must know the user's Active Directory User ID to create the user in the system since both IDs must 
match.  
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Different Processes and Screens for Different Administrators 

Both central administrators and local administrators can update user profile information. However, the 
process and screens are different for each administrator. The main differences are: 

• The Search User screen reserved for central administrators allows searching across all courts. 
• The Search User screen reserved for local administrators allows searching within the court to 

which the local administrator is assigned. 
• The screen that the central administrator accesses for updates (Update User Profile) only allows 

updates. 
• The screen the local administrator accesses for updates (View User Profile) allows updates as 

well as other tasks such as assigning roles, data access, etc. 
 

 

User roles affect what menu options a user sees. Therefore, only users with the Central Administrator role 
will see the menu option to activate the Search User screen reserved for central administrators. Only 
users with the Local Administrator role will see the menu option to activate the Search User screen 
reserved for local administrators. 

Delete/Inactivate Users 

The system does not provide functionality to delete users. However, user access may be disabled by 
setting/changing the user's account status when the user ID is created/updated, respectively. 

Task Activities 

User management includes the following task activities: 

• Create a User (Central Administrator) 
• Update a User Profile (Central Administrator) 
• Update a User (Local Administrator) 
• View/Terminate a User Session 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Background Information 

 

 

Related Links 

Search User Session Screen 

Create User Profile Screen 

Update User Profile Screen 

View User Screen 

Search User Screen (Central Administrator) 

Search User (Local Administrator) Screen 



The Admin Section 

1391 

 

My Court Information 

 

Create a User (Central Administrator) 

 

Introduction 

This task activity provides instruction for a central administrator to create a user. 

Assumptions 

This task activity assumes you are a central administrator and have received the user's User ID from the 
Active Directory administrator. 

Task Activity 

Perform the following steps to create a user. 

1. Select [Admin] > [User Management] > [Create User]. 
Result: The Create User Profile screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Court 
• User ID 
• First Name 
• Last Name 
• Account Status 

 

3. Enter any other information as appropriate. 
4. Click the [Save] button. 
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Related Links 

Manage Users Overview 

Create User Profile Screen 

 

My Court Information 

 

Update User Profile (Central Administrator) 

 

Introduction 

This task activity provides instructions to update a user profile (from the central administrator 
perspective). The central administrator is responsible for adding users to the system as well as editing 
user profiles, as necessary. 

Task Activity 

Perform the following steps to update a user's profile: 
 

1. Select [Admin] > [User Management] > [Search User (Central Admin)]. 
Result: The Search User screen displays. 

 
 

 

2. Enter/Select data for the appropriate search parameter fields. 
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3. Click the [Search] button. 
Result: The Search User screen refreshes and displays user IDs matching the search criteria. 

 
 

 

4. Click the User ID hyperlink for the user whose profile you want to update. 
Result: The Update User Profile screen displays. 

 
 

 

5. Update the user information as appropriate. The following required fields must have values: 

• Court 
• User ID 
• First Name 
• Last Name 
• Account Status 
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6. Click the [Save] button. 
 

 

Related Links 

Manage Users Overview 

Search User Screen (Central Administrator) 

Update User Profile Screen 

 

My Court Information 

 

Update User Profile (Local Administrator) 

 

Introduction 

This task activity provides instructions to update a user profile (from the local administrator perspective).  

Task Activity 

Perform the following steps to update a user's profile. 
 

1. Select [Admin] > [User Administration] > [Search User]. 
Result: The Search User screen displays. 
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2. Enter/select data in the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search User screen refreshes and displays user IDs matching the search criteria. 

 
 

 

4. Click the Name hyperlink for the user whose profile you want to update. 
Result: The View User screen displays. 

 
 

 

5. Update user information as appropriate. The following required fields must have values: 

• First Name 
• Last Name 
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• Account Status 
 

6. Click the [Save] button. 
 

 

Related Links 

Manage Users Overview 

Search User Session Screen 

View User Screen 

 

My Court Information 

 

View/Terminate a User Session 

 

Introduction 

This task activity provides the local administrator instructions to: 

• View user session information 
• User ID 
• Time Left 
• IP Address 
• MAC Address 

 

• Terminate a user session 
 

 

Session termination ends all sessions for users logged in using the terminated user ID. 

Task Activity 

Perform the following steps to terminate a user session. 
 

1. Select [Admin] > [User Administration] > [Manage Session]. 
Result: The Search User Session screen displays system users logged into the system. 
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2. If you cannot find the user ID of the person you are looking for, enter a User ID and click the 
[Search] button. 

3. Select the checkboxes for all user IDs whose system access you want to terminate. 
4. Click the [Terminate] button. 

 

 

Related Links 

Manage Users Overview 

Search User Session Screen 

 

Participant Administration 

Merge or Split Person/Entity Records Overview  

 

Introduction 

Managing person/entity records allows you to merge and/or split person/entity profile records in the 
system. Refer to the Manage Person/Entity Information section for details on maintaining person/entity 
profile data. 

You can only perform these activities outside of a case. However, a newly merged or split record may still 
affect case information. Only future case transactions and proceedings will change, as these activities do 
not update past or pending case data. 



Printed Documentation 

1398 

You must have the required security role to perform the merge and split activities. 

About Merging Records 

You may merge multiple person/entity records together if records exist for the same person/entity. This 
activity combines the profiles into a single record. Courts may use this "clean-up" activity to eliminate 
duplicate person/entity records. 

Merging records is a different process than associating person/entity records. The merge activity only 
occurs with unique profile records that you created for the same individual or entity. Associating 
person/entity records adds relationships from one record to other person/entity records.  

About Splitting Records 

You can split a person/entity record if it was mistakenly merged with another record. This activity 
separates the previously merged person/entity record and restores it to its original, pre-merged state.  

Task Activities 

Merging/Splitting person/entity records includes the following task activities: 

• Merge Person/Entity Records 
• Split Person/Entity Records 

Additional Resources 

Other items related to this overview include the following:  

• Business Rules 
 

 

Related Links 

Merge Person/Entity - Search Screen 

Merge Person/Entity - Merge List Screen 

Split Person/Entity - Search Screen 

Split Person/Entity - Split List Screen 

 

My Court Information 

 

Merge Person/Entity Records 

 

Introduction 

Merging person/entity records combines two or more profiles into a single record. A Court may choose to 
merge person/entity records if there are multiple records available for the same person/entity. The system 
would then point to only one record for accessing the profile data used by this person/entity. 
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Activities Performed Prior to Merging 

Selected records to merge may include different names and/or contact information. As a result, this 
process requires that a supervisor manually confirm that these records belong to the same person/entity 
before merging. 

Selecting a Lead Record 

You must conduct a person/entity search in order to select the records to merge. Refer to the Manage 
Person/Entity Information section for details on performing this search. Within the selected group of 
records, you must assign one profile as the lead. This lead record will represent the merged person/entity 
group as the master record.  

Merge Functionality 

Merging the selected records will associate the profile information from the non-lead records with the lead 
record. 

The system will copy over the profile information that can have multiple entries (such as names, contact 
information, etc.) from the non-lead records to the lead record. However, information that is singular by 
nature (such as height, weight, etc.) instead becomes “associated” with the lead record. In other words, 
the lead record will reference these types of data from the non-lead records.  

The future searches performed on the non-lead records will now only return the lead person/entity record. 

Handling Case Information 

The system does not automatically update merged person/entity data used within a case. For example, if 
you merge a case participant named "A" with a case participant named "B," and you select "A" as the 
lead record, then the system will not change the name "B" to "A" on the case. However, the CMS ID for 
the "B" record will change to match the lead record. 

The merge function maintains each record’s previous associations with cases and other person/entities. 
For example, if an existing case participant profile becomes merged, then the case related transactions 
(filings, fees, etc.) will continue to be associated with the case participant and not the lead participant 
record of the merged group. This allows you to split the record(s) at a later time and restore the case data 
back to its original, pre-merged state. Refer to the Split Person/Entity Records task activity for details on 
the splitting process. 

Handling Merged Case Participant Records 

If you merge person/entity records that are participants on the same case, then the case will only show 
the lead person/entity profile of the merged group. 

After the merge, filings and other case transactions will still occur on each person/entity profile, as 
necessary. However, you can only access the non-lead case data through the lead record. In other 
words, the pre-merge data is associated with the original records to allow for a potential split. The post-
merge data is associated only with the lead record. 

Merge Restrictions 

Merging a person/entity record that has a position type of “Private Professional Fiduciary (PPF)” requires 
additional system checks. These checks will alert you if the system discovers that this person/entity is 
used on more than one case as an unregistered PPF.  

You may also choose to copy the lead PPF record information onto the probate cases that are associated 
with the PPF record. However, this activity will not allow you to split the records at a later time. 
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Task Activity 

Perform the following steps to merge person/entity records. 
 

1. Select [Admin] > [Participant Administration]. 
Result: The Merge Person/Entity screen displays. 

 
 

 

2. Enter/Select data into the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing 

person/entity searches. 
3. Click the [Search] button. 

Result: The screen refreshes with the search results. 
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4. Select the radio button for the person/entity record to add to the merge list. 
 You may select only one record at a time. 

5. Click the [Add To Merge List] button. 
Result: The Enter Person/Entity Information - Merge List screen displays. The list now contains 
the selected record. 
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6. Repeat Steps 2-5 to add another person/entity record to the list. 
 The Merge List must contain at least two records. 

7. Select one of the person/entity records to be the “Lead” record. 
 This record will represent the merged group as the master record. 

8. Click the [Merge] button. 
Result: The screen refreshes with a confirmation message. The selected “lead” record is now 
identified by an icon. 
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Related Links 

Merge or Split Person/Entity Records Overview 

Merge Person/Entity - Search Screen 

Merge Person/Entity - Merge List Screen 

 

My Court Information 

 

Split Person/Entity Records 

 

Introduction 

Splitting a person/entity record separates a record from a merged person/entity group. A Court may 
choose to split a person/entity record if you mistakenly merged one of the profiles. Refer to the Merge 
Person/Entity Records task activity for details on the merging process. 

If the merged group only contains one person/entity record after the split, then the system will dissolve the 
merged group. In this situation, no records will display in the Split List. 
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Selecting the Record to Split 

You must conduct a person/entity search in order to select the record to split. Refer to the Manage 
Person/Entity Information section for details on performing this search. You must then select the lead 
record of the merged group to display the associated person/entity profiles. You may then choose the 
record to split from the group. 

Splitting the Lead Record 

Splitting the lead record requires you to select a new lead for the merged group. The system will then 
associate the profile information (names, addresses, etc.) from the remaining non-lead records with this 
new lead record. 

Split Functionality 

Splitting the selected record removes the associations with the merged group. This split record then 
resumes its original, pre-merge state as a separate record.  

If two case participants had been merged and then split, then the pre-merge case data goes back to the 
original participant. Post-merge data will only go to the lead. 

If the merged group only consisted of two records, then the system will also dissolve the group once the 
split occurs. This will make both of these profiles distinct person/entity records. 

Task Activity 

Perform the following steps to split a person/entity record from a merged group. 
 

1. Select [Admin] > [Participant Administration]. 
Result: The Merge Person/Entity screen displays. 

 
 

 

2. Select the [Split Person/Entity] left navigation item. 
Result: The Split Person/Entity screen displays. 
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3. Enter/Select data into the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing 

person/entity searches. 
4. Click the [Search] button. 

Result: The screen refreshes with the search results. 

 
 

 

5. Select the radio button for the merged person/entity record. 
 This merged record should contain the person/entity record to split and is identified by a 

"lead" icon. You may select only one record. 
6. Click the [Select] button. 

Result: The Enter Person/Entity Information - Split List screen displays. The list now contains the 
records that belong to the merged group. 
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7. Select the radio button for the person/entity record to split from the merged group. 
8. Select one of the person/entity records to be the new "Lead" record, if necessary. 

 Only perform this step if splitting the current lead record from the merged group. 
9. Click the [Split] button. 

Result: The screen refreshes with a confirmation message. The split record no longer displays in 
the Split List. 

 
 

 

 

 

Related Links 

Merge or Split Person/Entity Records Overview 

Merge Person/Entity - Search Screen 

Split Person/Entity - Search Screen 
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Split Person/Entity - Split List Screen 

 

Department Administration 

Configure Department Resources Overview  

 

Introduction 

Configuring department resources defines the Court resources associated with a specific department. 
These activities also identify the effective dates for which a resource is available.  

About Departments 

Setting department assignments helps you to determine resource availability when scheduling case 
events for a specific department/location. The system considers these assignments as "associations," 
since a resource may belong to more than one department and/or location. 

The system will apply these associations if you choose to configure assignment rules for a department. 
This type of assignment rule would only affect those resources that have been previously associated with 
this department. 

Activities Performed Prior to Configuring a Department Resource 

Your Court must provide the system with a list of available departments and their respective locations 
before you can associate resources with a department. 

You must also conduct a department search in order to select a department to configure, update or use 
as a template.  

Department Validations 

The departments in the system must be unique. A unique department is defined by its name and location. 

Task Activities 

Configuring department resources includes the following task activities: 

• Search Departments 
• Add Department Resources 
• Update Department Resources 
• Save As New Department Resources 

Additional Resources 

There are no other resources related to this overview.  

 

 

Related Links 

Configure Department - Search Screen 
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Configure Department Screen 

 

My Court Information 

 

Search Departments 

 

Introduction 

Searching for a department searches and displays the available departments for a specific location. You 
must have a System Administrator security role to access the search and related department 
configuration screens. 

Department Search Functionality 

The system performs a search based on field parameters that you provide. Only those departments that a 
Court created in the system will display in the results list. 

You must select values for the required fields in order for the search utility to function. Refer to the Search 
Feature Overview for details on performing a search in the system. 

Using the Search Results 

This search function also provides the foundation for maintaining department information. For example, 
you must perform a search in order to update the resources associated with a department or save the 
configured resources from a department to another. 

Task Activity 

Perform the following steps to search for a Court department. 
 

1. Select [Admin] > [Department Administration]. 
Result: The Configure Department – Search screen displays. 
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2. Select data for the following required fields: 
3. Location 
4. Department 

 Selecting a Division will help to narrow the results. 

3. Click the [Search] button. 
Result: The screen refreshes with the Search Results. 
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 From the Search Results section, you can perform the Update Department Resources or 
Save as New Department Resources task activities. 

 

 

Related Links 

Configure Department Resources Overview 

Configure Department - Search Screen 

 

My Court Information 

 

Add Department Resources 

 

Introduction 

Adding a resource to a department associates or assigns a Court resource to a specific department within 
a given location.  

Associating a Resource 

A resource must exist in the system before you can associate it with a department. The person/entity 
profile record for the resource must also identify the position type(s) held by the resource. 

You may either select an existing resource from the person/entity search results, or create a new 
person/entity profile to add to the department. Refer to the Manage Person/Entity Information section for 
details on creating and maintaining person/entity records. 

Associating Judicial Officers 

You may also associate Judicial Officers with a department. The Judicial Officer profile must also exist in 
the system before you can add it to a department. Refer to the Manage Judicial Officers section for 
details on creating and maintaining Judicial Officer profile records. 

Sorting the Department Calendar 

When configuring a department, you may define the sort type for department calendar events. Depending 
on your choice, the system will display the calendar events scheduled for the department in this selected 
hierarchical order. 

Task Activity 

Perform the following steps to add [associate] a resource to a department.  
 

1. Select [Admin] > [Department Administration]. 
Result: The Configure Department – Search screen displays. 
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2. Click the [Add New] button. 
Result: The Configure Department screen displays. 
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3. Select data for the following required fields: 
4. Location 
5. Department 

 Follow Steps 4-5 to associate a Judicial Officer with the department. 

 Follow Steps 6-10 to associate other resources. 

4. Click the [Associate Judicial Officer] button. 
Result: The Manage Judicial Officers - Search screen displays. 

 Refer to the Manage Judicial Officers section for details on searching and selecting Judicial 
Officers. 
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5. Click the [Cancel] button to return to the Configure Department screen. 
 If you selected Judicial Officers, click the [Select] button to have this screen display them in 

the Assigned Court Resources section. 
6. Click the [Associate Other Resources] button. 

Result: The Person/Entity Search screen displays. 
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7. Enter/Select data for the appropriate search parameter fields. 
 Refer to the Search Person/Entity Profiles task activity for details on performing 

person/entity searches. 
8. Click the [Search] button. 

Result: The screen refreshes with the Search Results. 

 
 

 

9. Select the radio button for the person/entity record to associate with the department. 
 You may select only one record at a time. 

10. Click the [Select] button. 
Result: The Configure Department screen re-displays. The new resource is now available in the 
Assigned Court Resources section. 



The Admin Section 

1415 

 
 

 

11. Enter an Effective Start Date for this resource. 
12. Enter/Select data for the other necessary fields. 

 You may provide additional information, such as availability details for the resource and/or 
the calendar sort method(s). 

13. Click the [Save] button. 
Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Department Resources Overview 

Configure Department - Search Screen 

Configure Department Screen 

Manage Judicial Officers - Search Screen 

Person/Entity Search Screen 
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My Court Information 

 

Update Department Resources 

 

Introduction 

Updating a department resource changes the assignment information for a Court resource within a 
department.  

Changing Resource Settings 

You may choose to change the effective start and end dates for a given resource or associate additional 
resources to the department. You may also change the calendar sort criteria for a department, which 
changes how you view the events scheduled for a particular department. 

If necessary, you may also remove a resource from a department. 

Task Activity 

This activity takes place within the context of department search. Refer to the Search Departments task 
activity for details on performing this search. 

Perform the following steps to edit the resource(s) for a specific department. 
 

1. Select the radio button for the department to update. 
 This selection occurs from the Configure Department - Search screen. 
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2. Click the [Update] button. 
Result: The Configure Department screen displays. 

 
 

 

3. Enter/Update the available fields as needed. 
 You may also associate a new resource with this department or remove a resource from 

this department.  
4. Select the checkboxes for the resources to remove from the department. 
5. Click the [Remove Resource] button. 

Result: The screen refreshes and no longer displays the selected resource. 
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6. Click the [Save] button to save the changes. 
Result: The screen refreshes with a confirmation message. The Date of Last Change field also 
updates to reflect the current date. 
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Related Links 

Configure Department Resources Overview 

Configure Department - Search Screen 

Configure Department Screen 

 

My Court Information 

 



The Admin Section 

1421 

Save As New Department Resources 

 

Introduction 

Using the "Save As" feature allows the resource(s) configured for a department to be used as a 
"template" for another department. Changes made to the resource associations only apply to the newly 
configured department and do not change the selected department. 

Required Department Changes 

You may only use this activity to add resources to a department that has not been previously configured 
to include resources.  

After selecting a template department, you must change the location and/or department name in order to 
identify this unique department. If you choose a department that already has an associated resource, 
then the system will display an error message and require you to select a different department. 

Task Activity 

This activity takes place within the context of a department search. Refer to the Search Departments task 
activity for details on performing this search. 

Perform the following steps to save the resources of one department to another department. 
 

1. Select the radio button for the department to use as a template. 
 This selection occurs from the Configure Department - Search screen. 

 
 

 

2. Click the [Save As] button. 
Result: The Configure Department screen displays. 
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3. Change at least one of the following data fields: 
4. Location 
5. Department 

 

4. Enter/Update the available fields as needed. 
5. Click the [Save] button to save the resources to this new department/location. 

Result: The screen refreshes with a confirmation message. 
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Related Links 

Configure Department Resources Overview 

Configure Department - Search Screen 

Configure Department Screen 

 

Batch Administration 

Schedule Batch Jobs Overview  
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Introduction 

The process of scheduling a batch job has two steps: 

1. Local administrator requests scheduling of a batch job. 
2. Central administrator reviews request and schedules the batch job accordingly. 

 

 

To initiate a batch job, the local administrator must send a request to the central administrator. This 
request contains all of the details about the batch job setup. When the administrator reviews the request, 
all request details are visible and may be accepted as is or changed where appropriate. 

Task Activities 

Scheduling batch jobs includes the following task activities: 

• Request Scheduling of a Batch Job 
• Schedule a Batch Job 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• Batch Scheduling and Printing Background Information 

 

 

Related Links 

Configure Batch Print Routing Screen 

Configure Printers Screen 

Court Request Summary Screen 

Request Scheduling Screen 

Review and Schedule Court Request Screen 

 

My Court Information 

 

Request Scheduling of a Batch Job 

 

Task Activity 

Perform the following steps to request scheduling of a batch job. 
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1. Select [Admin] > [Batch Administration] > [Request Scheduling (Local Admin)]. 
Result: The Request Scheduling screen displays. 

 
 

 

2. Enter/Select data for the following required fields: 

• Select Job to Perform 
• Request Frequency of Job 

 Once you select a job to perform, the screen refreshes and displays the configurable 
parameters associated with the selected batch job. You are required to enter values for these 
fields. 

3. Enter special instructions related to the selected frequency and comments about the batch job, if 
necessary. 

4. Select the Ignore Job on Court Holiday checkbox if you do not want the batch job to run on 
court holidays. 

5. Click the [Save] button. 
 

 

Related Links 

Schedule Batch Jobs Overview 

Request Scheduling Screen 

 

My Court Information 
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Schedule a Batch Job 

 

Task Activity 

Perform the following steps to schedule batch jobs. 
 

1. Select [Admin] > [Batch Administration] > [View Batch Request (Central Admin)]. 
Result: The Court Request Summary screen displays. 

 
 

 

2. Select the radio button for the request you want to work with. 
3. Click the [Select] button. 

Result: The Review and Schedule Court Request screen displays. 
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4. Review and update, if necessary, the requested batch schedule information. 
5. Click the [Save] button. 

 

 

Related Links 

Schedule Batch Jobs Overview 

Court Request Summary Screen 

Review and Schedule Court Request Screen 

 

V3/Kiosk Administration 

My Court Information 

 

Configure Home Screen Message 
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Introduction 

This process allows you to configure the text message that displays on the system home screen. You 
have the ability to display configured text for the entire system and/or for only your specific court. 

Task Activity 

Perform the following steps to configure the home screen message. 
 

1. Select [Admin] > [V3 and Kiosk Configuration] > [V3 Home Screen Message]. 
Result: The V3 Home Screen Message screen displays. 

 
 

 

2. Enter/Update data within the System Wide Message open text field. 
 Any text displayed in this field will display on the Home screen. 

3. Format the text as necessary, using the e-WebEdit Pro toolbar. 

 
 

 

4. Enter/Update data within the Court Wide Message open text field. 
 Any text displayed in this field will display on the home screen for only your court. 

5. Format the text as necessary, using the e-WebEdit Pro toolbar. 
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6. Click the [Submit] button. 
Result: The screen refreshes. 

 

 You can check your message text and formatting using the following steps: 

1. Click the California Case Management System - V3 logo/title in the screen header. 
Result: The Welcome screen displays. 

 
 

 

2. View the System Wide Message and Court Wide Message text at the top of the screen. 
 

 

Related Links 

V3 Home Screen Message Screen 

 

My Court Information 

 

Configure Contact Information 
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Introduction 

This process allows you to configure the text message that displays on the Contact Us screen. This 
information will display above the system search component on that screen. 

Task Activity 

Perform the following steps to configure the Contact Us text. 
 

1. Select [Admin] > [V3 and Kiosk Configuration] > [V3 Contact Us Screen Information]. 
Result: The V3 Contact Us Screen Information screen displays. 

 
 

 

2. Enter/Update data within the open text field. 
 Any text displayed in this field will display on the Contact Us screen. 

3. Format the text as necessary, using the e-WebEdit Pro toolbar. 
 This configuration screen also allows you to create hyperlinks and email links for your 

contact text. 

 
 

 

4. Click the [Submit] button. 
Result: The screen refreshes. 

 

 You can check your message text and formatting using the following steps: 

1. Click the Contact Us link in the screen header. 
Result: The Contact Information screen displays. 
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2. View the contact text displayed above the system search component. 
 

 

Related Links 

V3 Contact Us Screen Information Screen 

 

My Court Information 

 

Configure Kiosk Home Text 

 

Introduction 

This process allows you to configure the text located on the kiosk home screen. This text is configurable 
by court. 

Task Activity 

Perform the following steps to configure the kiosk text. 
 

1. Select [Admin] > [V3 and Kiosk Configuration] > [Kiosk Court Config]. 
Result: The V3 Kiosk Court Config screen displays. 
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2. Enter/Update data within the open text field. 
 Any text displayed in this field will display on the Login screen. 

3. Format the text as necessary, using the e-WebEdit Pro toolbar. 

 
 

 

4. Click the [Submit] button. 
Result: The screen refreshes. 

 

 

Related Links 

V3 Kiosk Court Config Screen 
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The Work Queue Section 

Complete Work Queue Tasks 

Complete Work Queue Tasks Overview  

 

Introduction 

This overview provides information about completing a work queue task.  

Work Queue Assignment 

Local administrators are responsible for assigning both users and work queue supervisors to a work 
queue during work queue creation. Once a work queue is created, work queue supervisors assigned to 
that work queue can update user access, as appropriate. 

After a work queue is created, local administrators can still update user and work queue supervisor 
access. They may also copy the work queues assigned to one user and apply them to newly created 
users at the same time they give those new users roles and data access privileges. 

Supervisor roles 

Local administrators cannot designate users as work queue supervisors unless they are assigned to the 
Maintain Work Queue - Supervisor role as part of the security set up process. 

Work Queue Access 

Anytime a user/work queue supervisor logs into the system, they see their work queues along with 
system wide messages, court-specific messages, and a three-month static calendar on their Welcome 
page. Once they move off of their Welcome page, they can access their work queues by selecting the 
[Work Queue] > [Work Queue List] menu option. 

Work Queue Task Assignment 

The specific method of task assignment is determined by the local administrator during work queue 
creation. Work queue tasks are assigned to users in one of two ways: 
 

• By a work queue supervisor – When the local administrator selects this option for task 
assignment, all tasks within the associated work queue are manually distributed to individual 
users by the work queue supervisor in the associated work queue screen. 

 

• Round-robin fashion – When the local administrator selects this option for task assignments, all 
tasks within the associated work queue are automatically and equally distributed among the 
assigned work queue users.  

Work Queue Re-assignment 

Regardless of how a task is assigned to a user it does not mean that only that selected user can 
complete the work queue tasks. A work queue supervisor can re-assign the task at any time. Also, even 
though a task is assigned to a user, nothing prevents another user from completing the same work queue 
task.  
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Once another user starts a task assigned to different user, the system automatically re-assigns the task to 
the person working on the task. However, if the status is "In Progress," then the system will warn you 
before reassigning. 

Two Ways to Complete Work Queue Tasks 

Work queues can either be completed automatically or manually. Manual completion requires the user to 
explicitly click the [Complete Tasks] button from inside the work queue once the associated task has 
been completed. Automatic completion happens once the user activates the selected landing screen and 
completes the associated task. 

However, work queues are configured for only one method. Completion types are determined by the local 
administrator during work queue creation. Work queues have two different completion types:  

Landing Screen Links 

Automatic completion 

Task selection in an automatic completion work queue takes users to the appropriate landing screens to 
complete the work queue task. 

Manual completion 

Work queues that are manually completed may or may not have a landing screen link which takes users 
to the appropriate landing screen to complete the work queue tasks. 

Whether the task has an associated landing screen link is determined by the local administrator during 
work queue creation. However, users need to understand that even though a link may take them to the 
appropriate page from which to perform the work queue tasks, they still have to return to the work queue 
to manually indicate completion of the task. 

Deferred Printing Work Queues (Forms and Notices) 

Forms and notices work queues are always manual work queues. Therefore, instead of directing you to 
the landing screen where you can print the form/notice a [Print] and [Print Preview] button may be 
inside the work queue to assist you with task completion. 

Work Queues Within the Context of a Case 

In addition to completing work queue tasks from the manual/automatic work queues previously 
mentioned, you can also complete work queue tasks within the context of a case. When inside the 
context of a case, the header portion of the UI displays the total number of work queue tasks pending 
against the case. You can click the associated work queues button to see a list of all work queues, both 
manual and automatic, for the selected case. And if you go to a completing screen from within the case it 
displays a tally of any specific tasks related to the same screen. 

Work Queue Task Priority 

Work queue tasks may have one of four priorities: 

• Low 
• Medium 
• High 
• Critical 
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Work Queue Task Status 

Work queue tasks may have one of five statuses: 
 

• Pending – Pending tasks are new and waiting for completion. 
 

• In-Progress –  In-progress tasks are ones where a user has selected the task and has been 
directed to the associated landing screen. In-Progress applies only to automatic completion work 
queues or manual work queues with landing screens. 

 

• Complete – Tasks are completed. Only work queue supervisors can see completed tasks. 
Completed tasks stay in the work queue supervisor's queue for a configured number of days after 
completion. Leaving completed tasks in the work queue supervisor's queue provides them with 
the opportunity to change the task status, if needed. 

 

• Incomplete – Incomplete tasks are ones that were adjusted by work queue supervisor after 
noticing the task was not completed correctly. 

 

• Cancelled – Cancelled tasks have been cancelled. 
Cancel a Work Queue Task 

Work queue tasks can be cancelled in one of two ways: 
 

• By a canceling action – Canceling actions are actions that cause a work queue task to be 
cancelled. Cancel actions are defined by the local administrator during work queue creation and 
are transparent to system users. 

 

• By a work queue supervisor – A work queue supervisor may, at any time, cancel a work queue 
task.  

Naming Conventions and Effective Dates 

Work queues must be discrete entities. However, they do not have to have unique names. Two work 
queues may share the same name but may have different effective dates, thereby making them unique. 

Effective dates are set by the local administrator during work queue creation and are helpful when certain 
tasks need to be separated from other similar tasks. For example, if a case is nearing a statute of 
limitations, setting effective dates on the associated work queues may help to expedite completion of 
these tasks. Effective dates are transparent to the system user unless they are included in either the work 
queue name or description.  

Work Queue Screens 

A work queue's screen appearance has four possible variations. What you see depends upon the type of 
task being completed and your security roles. 

• Automatic completion tasks for non-work queue supervisors 
• Automatic completion tasks for work queue supervisors 
• Manual completion tasks for non-work queue supervisors 
• Manual completion tasks for work queue supervisors 
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Differences between automatic and manual completion screens 

Work queue screens for automatic completion tasks have radio buttons that enable you to select a single 
record before clicking the [Select] button, which takes you to the appropriate landing screen to complete 
the task. 

Work queue screens for manual completion tasks have check boxes that enable you to select one or 
more records before clicking the [Complete Task] button, which confirms completion of the selected 
tasks. 

Two additional variations exist for manual completion screens. They are: 

• If the unit of work is = Form, the screen displays a print button. 
• If a landing screen is configured, a button that takes you to the landing screen displays on the 

screen.  
 

 

Differences between user's and work queue supervisor's work queues screens 

User work queues and work queue supervisor work queue screens are essentially the same, except work 
queue supervisors can also: 

• Update the list of users assigned to a work queue 
• Update task statuses 
• Update task priorities 
• Reassign tasks 

 

 

Filtering work queue tasks 

Standard search criteria are common for all work queues. Advanced search criteria are specific to the 
work queue's unit of work (UOW). 

Work queues and displayed fields 

The fields you see when viewing tasks in a work queue are determined by the local administrator during 
the work queue creation process. 

Task Activities 

Completing a work queue task includes the following task activities: 

• Complete Automatic Work Queue Tasks 
• Complete Manual Work Queues Tasks 
• Complete Work Queue Tasks Within the Context of a Case 
• Supervisor-Related Work Queue Functions 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• About System Work Queues 
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Related Links 

Work Queue List Screen 

Work Queue Screen 

Case Task Work Queue Screen 

Add/Update Work Queue - Assign User Screen 

 

My Court Information 

 

Complete Automatic Work Queue Tasks 

 

Introduction 

Automatic work queue tasks can be completed from one of three locations: 

• Work queue list displayed on the Welcome screen when you log in to the system 
• Work queue list activated by the [Work Queue] > [Work Queue List] menu option 
• Work queue task list accessed within the context of a case 

 

 

This task activity assumes you are accessing your work queue list by way of the menu option. Task 
procedures are the same when accessing the work queue list from the Welcome screen, only you do not 
follow the initial menu path. 

Refer to the Complete Work Queue Tasks Within the Context of a Case task activity for details on 
completing a work queue tasks within the context of a case. 

Task Activity 

Perform the following steps to complete an automatic work queue task.  
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays your work queues in addition to the number of 
pending tasks, incomplete tasks and total number of tasks in each work queue. 
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2. Click the work queue name link of the automatic work queue. 
Result: The Work Queue screen for the work queue you selected displays. 

 This screen capture is only a sample of what an automatic work queue screen looks like. 

 
 

 

3. Select the radio button for the task to be completed. 
4. Click the [Select] button. 

Result: The system opens the appropriate screen that enables you to complete the task. 
5. Complete the task. 

 

 

Related Links 

Complete a Work Queue Task Overview 
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Work Queue List Screen 

Work Queue Screen 

 

My Court Information 

 

Complete Manual Work Queues Tasks 

 

Introduction 

Manual work queue tasks can be completed from one of two locations: 

• Work queue list displayed on the Welcome screen when you log in to the system 
• Work queue list activated by the [Work Queue] > [Work Queue List] menu option 
• Work queue task list accessed within the context of a case 

 

 

This task activity assumes you are accessing your work queue list by way of the menu option. Task 
procedures are the same when accessing the work queue list from the Welcome screen, only you do not 
follow the initial menu path. 

Refer to the Complete Work Queue Tasks Within the Context of a Case task activity for details on 
completing work queue tasks within the context of a case. 

Task Activity 

Perform the following steps to complete a manual work queue task.  
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays your work queues in addition to the number of 
pending tasks, incomplete tasks and total number of tasks in each work queue. 
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2. Click the work queue name link of the manual work queue. 
Result: The Work Queue screen for the work queue you selected displays. 

 
 

 

 This screen capture is only a sample of what a manual work queue screen looks like. 

 You may not see the landing screen link if your local administrator did not configure it to 
display in the work queue screen.  

3. Determine the task(s) that need to be completed. 
4. Go to the appropriate screen(s). You may click a landing screen link if one is available to you. 
5. Complete the task(s). 
6. Return to Work Queue screen using the same steps you used to first access the screen. 
7. Select the check boxes associated with the task(s) you completed. 
8. Click the [Complete Tasks] button. 

 

 

Related Links 

Complete a Work Queue Task Overview 

Work Queue List Screen 

Work Queue Screen 

 

My Court Information 
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Complete Work Queue Tasks Within the Context of a Case 

 

Introduction 

This task activity provides instructions about completing a work queue task within the context of a case. 

Task Activity 

This task activity takes place within the context of a case. Refer to the Search Cases task activity for 
details about performing a case search. 

Perform the following steps to complete a work queue task within the context of a case. 
 

1. Locate the work queue task bar in the header portion of any screen within the context of a case. 

 
 

 

2. Click the yellow-gold portion of the header bar labeled, "Case Task Work Queue." 
Result: The Case Task Work Queue screen displays.  

 
 

 

 Automatic completion tasks are displayed first. Manual completion tasks are displayed 
after the automatic completion tasks.  

 Task completion takes place just as if you were in a work queue outside of the context of 
a case. That is, manual completion task may have links to screens where you complete the 
task, but you still have to manually mark the task as complete. 
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3. Select a manual completion task screen link. 
OR 
Select a task and click the [Select] button. 
Result: The screen where the task needs to be performed displays.  

 
 

 

4. Perform the required work queue task. 
 Note that the screen displays the work queue tasks related to the selected screen. You can 

also perform these tasks by clicking the associated links. 
 

 

Related Links 

Complete Work Queues Tasks Overview 

Case Task Work Queue Screen 

 

My Court Information 

 

Supervisor-Related Work Queue Functions 

 

Introduction 

This task activity provides information to work queue supervisors about changing task statuses, changing 
who the task is assigned to, and writing any comments about the work queue task. 

You can also perform work queue tasks from this screen. Refer to the appropriate task activity for more 
information. 
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Task Activity 

Perform the following steps to change details about a work queue task. 
 

1. Select [Work Queue] > [Work Queue List]. 
Result: The Work Queue List screen displays your work queues in addition to the number of 
pending tasks, incomplete tasks and total number of tasks in each work queue. 

 
 

 

2. Click the work queue name link of the work queue. 
Result: The Work Queue screen for the work queue you selected displays. 

 
 

 

3. Update the work queue information, as appropriate. 
4. To change the users who have access to this work queue, click the [Manage Work Queue 

Users] button. 
Result: The Add/Update Work Queue - Assign User screen displays. 
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5. Update user information, as appropriate. 
6. Click the [Save] button. 

Result: The system returns you to the Work Queue screen. 
7. Click the [Save] button. 

 

 

Related Links 

Complete Work Queues Tasks Overview 

Work Queue List Screen 

Work Queue Screen 

Add/Update Work Queue - Assign User Screen 

 

Configure Work Queues 

Configure Work Queues Overview  
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Introduction 

This overview provides information to local administrators responsible for configuring work queues. 
General information that also applies to the work queue configuration task can be found in the Work 
Queue Overview and the Complete a Work Queue Overview sections. 

Assumptions 

The process of setting up work queues has the following inherent assumptions: 

• You have an in-depth knowledge of how your court system works, which includes but is not 
limited to: 

 

• You understand the "big picture" in terms of the various court system life cycles/process 
flows 

• You understand units of work 
• You understand the actions 
• You know all of the possible tasks that can take place within your court system and how 

they related to each unit of work 
• You know what tasks follow and precede other tasks 
• You know the criteria by which tasks should be filtered 
• You know the system screens where these tasks are performed 

 

• You have pre-designed process flow documents highlighting the work queues that are needed. 
Work Queue/Work Queue Task Creation 

Work queue tasks are pointers to places in the system where court-related tasks are performed. An actual 
task does not exist in the system, which would prevent it from being completed outside of the work queue. 
If someone completes the action related to an entry in a work queue, the system simply marks the task as 
complete. 

It is configuration data, which you define, that creates a work queue and ultimately controls the tasks, i.e., 
task pointers that appear in a work queue. 

For instance, you know that once a single court-related task is completed, two other tasks cascade as a 
result and must also be completed. However, the third task cannot be performed until the second task is 
completed.  

Therefore, you are dealing with three tasks but only two are logged within work queues:  The one to be 
performed after the initiating task and the final task to be performed after the completion of the second 
task.  

To configure work queues to handle this scenario you need to know: 

• The tasks needing to be completed 
• The tasks preceding the tasks to be completed 
• The filter criteria enabling separation of work queues/work queue tasks 
• The screens where these tasks are performed 

 

 

With these ingredients, your configuration resembles the following formulas, which ultimately result in 
work queue tasks. 
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• Initiating Task + Filter Criteria + Completing Task = Pointer to Screen to Perform Task #2. 
 

• Completion of Task #2 + Filter Criteria + Completing Task = Pointer to Screen to Perform Task 
#3. 

 

 

An even more simplistic "if/then" formula is: 

• If someone does "this" action under "these" circumstance, then someone needs to "this new 
action" under "these other circumstances." 

Work Queue/Work Queue Task Creation Example 

Let's assume after initiating a case, the following tasks must be completed: 

• Assign resources to a case 
• Secure participant information for all cases under J. Smith, Judicial Officer 

 

 

To support these activities, you need two work queues.  

Canceling actions are not included in these examples since they are not vital to the creation of work 
queues. However, canceling actions are responsible for tasks being removed from a work queue and do 
affect the tasks that users see in a work queue. 

Vital configuration data 

The following table lists and describes information that is vital to the creation of these two example work 
queues and ultimately the tasks that later appear in these work queues.  
 

 

 

Configuration 
Element 

Importance 

Work Queue Name and 
Description 

The work queue name and description informs the assigned users about what they need 
to do when performing a task found in the work queue. 

Entry Actions The entry action acts as the next task trigger. Without an entry action, the system will not 
initiate calculations to determine if work queue entries are necessary. 

Completing Actions The completing action identifies the action a user must perform along with any 
circumstances surrounding the action.  

Landing Screen The landing screen identifies where the completion action takes place. 

Filter criteria The filter criteria enables the system to weed out records that do not need to appear in 
the task queue. Coupled with the entry action information and the completing action 
information, the system is now able to track and create a work queue task. 

 

 

 

Vital configuration data applied 

This next table lists the same configuration elements in the preceding table but provides example settings 
that enable successful creation of the two required work queues used in this example. 
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Configuration Element Work Queue 1 Work Queue 2 

• Work Queue Name 
and Description 

Assign Resources 
This work queue stores tasks that 
enable you to assign court resources to 
a case after it has been initiated. 

Secure participants for J. Smith, Judicial 
Officer 
This work queue stores tasks that enable 
you to secure information about participants 
involved in cases allocated to J. Smith, 
Judicial Officer. 

• Entry Action Initiate a Case Assign Resource 

• Completing Action Assign Resource Secure Case Participant 

• Landing Screen Case Participants Screen Participant Profile Information Screen (From 
within a case) 

• Filter Criteria None specified.  
All cases that are initiated require 
resource assignment. 

J. Smith, Judicial Officer 
The only cases that appear in this work 
queue are cases allocated to J. Smith, 
Judicial Officer. 

 

 

 

Configuration results 

The results of this configuration data are as follows: 

• All newly initiated cases appear in Work Queue #1, requiring users to assign resources 
• Only cases allocated to J. Smith, Judicial Officer, appear in Work Queue #2, requiring users to 

secure participant information 
Work Queue Configuration – A Wizard Process 

The configure work queue task activity is part of a "wizard" process. This means you will access a number 
of screens, one after the other, in order to complete the process of setting up/updating a work queue. If 
you exit the process before clicking the [Save] button located on the last screen of the wizard process, 
the system will not save any of your changes.  

Following is a list of topics you will encounter during the work queue configuration process. It is 
recommended you have all relevant information ready since the system will not save your entries if you 
end the process before finishing all of the wizard steps: 
 

• Enter basic information related to the work queue: 
 

• Unit of work (UOW) 
• Work queue name 
• Work queue description 
• Completion type (automatic or manual) 
• Assignment method (manual or round-robin) 
• Effective dates 

 

• Enter filter criteria, specific to a selected unit of work, that determine how the system sorts 
information that will/will not be reflected as a work queue task 
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• Identify the data fields, which are specific to a selected unit of work that can be seen by the user 
in the work queue 

• Select the users who have access to the work queue 
• Designate the users who will act as work queue supervisors (Only users who have the Maintain 

Work Queue - Supervisor role are eligible.) 
• Identify the entry actions 
• Identify the completing actions (Configured for automatic-completion tasks only.)  
• Identify the associated landing screen (Optional for manual-completion tasks.) 
• Identify canceling tasks, if any (Optional for both automatic and manual completion tasks.) 

Add and Update Work Queues 

The add and update task activities are almost identical. Therefore, instruction for adding and updating 
work queues are merged in the corresponding task activity. The only differences between the two 
processes are: 
 

 

 

Add Work Queue Process Update Work Queue Process 

• Local administrator accesses the Search Work 
Queues screen. A search is not necessary but 
can be performed to avoid entering duplicate 
records. 

• Local administrator clicks the [Add new Work 
Queue] button to access the Add/Update Work 
Queue - Basic Information screen. 

• The Add/Update Work Queue - Basic 
Information screen accepts input values for all 
fields. 

• Local administrator accesses the Search Work 
Queues screen and performs a search to find the 
specific work queue to update. 

• Local administrator clicks [View] button after 
selecting the appropriate work queue from the 
search results to access the Add/Update Work 
Queue - Basic Information screen. 

• The Add/Update Work Queue - Basic 
Information screen accepts input values for only 
some of the fields. Fields like Unit of Work and 
Work Queue Name cannot be changed. 

 

 

Screens Data Fields Controlled by Units of Work 

Since work queues apply to nine different types of units of work, the data fields you see throughout the 
screens in this wizard process vary based upon the selected unit of work.  

Refer to the screen's Field Definitions for definitions and data entry examples. 

Filter Criteria 

When you assign filter criteria to a work queue during the work queue configuration wizard process, you 
encounter a "sub" process that enables you to: 

• Add filter criteria to the approved list of filter criteria 
• Remove filter criteria from the approved list of filter criteria 

 

 

Procedures for this sub process are not included in the corresponding Configure Work Queue task 
activity. In the task activity, you are only prompted to add/update filter criteria information, as appropriate. 
You add and remove filter criteria by selecting values from a drop-down list, and clearing the associated 
check boxes, and clicking the respective buttons:  [Add] and [Delete]. 
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"And/Or" Operators 

The system uses both "and" and "or" operator values between filter criteria entries. This means when you 
enter multiple filter criteria, you should read the expected results as: This criterion and this criterion or this 
criterion and this criterion are considered when filtering tasks for work queues.  

Display Attributes 

When assigning display attributes during the work queue configuration wizard process, you are actually 
specifying the data field elements users see when viewing tasks in the selected work queue. 

The list provided to you for your selections is dependent on the selected unit of work. The minimum 
recommended list includes the following columns:  Assigned To, Priority, Status, and Comments. 
Completion Date, Completion Reason, and Cancellation Reason are only displayed to the work queue 
supervisor even if selected for non-supervisor users. 

Display order 

The display order determines the sequence that fields display from left to right. For every selected 
checkbox, you must specify a display order, starting with the number 1 and continuing on sequentially 
until all selected attributes are accounted for.   

Sort order 

The default sort order determines order (A-Z or Z-A) that records are returned to the user when looking at 
tasks in the work queue. Users will be able to sort on fields individually on work queue screens. 

Assign Users to Work Queues 

When you assign users to a work queue during the work queue configuration wizard process, you 
encounter a "sub" process that enables you to: 
 

• Search for the appropriate users 
• Add users to your list of approved users for the work queue 
• Remove users from your list of approved users for the work queue 

 

 

Procedures for this sub process are not included in the corresponding Configure Work Queue task 
activity. In the task activity, you are only prompted to add/update user information as appropriate. The 
search portion of the screen works like any other search screen. You add and remove users by selecting 
and clearing the associated check boxes and clicking the respective buttons:  [Add to Selected User 
List] and [Remove from Selected User List]. 

Assign Supervisors to Work Queues 

When you assign users to act as a supervisor of a work queue, only users who are assigned to the 
Maintain Work Queue - Supervisor role will appear in the list of potential supervisors.  

Procedures to select and remove users as supervisors are not included with the Configure Work Queue 
task activity. You are only prompted to add/update supervisor information as appropriate. The Select 
Supervisors to Manage Work Queue section displays two windows, each containing a list of names. The 
window on the left is a list of potential supervisors for the work queue and the window on the right is a list 
of actual supervisors for the work queue. You move names across the two windows using the [Add] and 
[Remove] buttons. 
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Assign Entry, Completing, and Canceling Actions 

When you assign entry, completing, and canceling actions, you do so by selecting from a list of possible 
actions. In some instances you must provide additional information for entry, completing and canceling 
actions so they can execute successfully. Therefore, when you select these actions, the screen refreshes 
and displays two additional fields: Parameter Type and Parameter Value. As with the action field itself, 
you select pre-defined values from drop-down lists to further define the action. 

For example, Initiate Case is an action that requires no parameter values. You would simply select the 
Initiate Case action. However, the Assign Resource action provides a Resource Type parameter that 
enables you to refine this particular action to the type of resource, such as Mediator, Judicial Officer, 
etc. Leaving these fields empty indicates you want the associated action to include all parameter types 
and values. 

Additionally, when you assign entry, completing, and canceling actions to a work queue during the work 
queue configuration wizard process, you encounter a "sub" process that enables you to: 

• Add actions to the approved actions list 
• Remove actions from the approved actions list 

 

 

Procedures for this sub process are not included in the corresponding Configure Work Queue task 
activity. In the task activity, you are only prompted to add/update action information, as appropriate. You 
add and remove users by selecting and clearing the associated check boxes and clicking the respective 
buttons:  [Add Action] and [Delete Action]. 

And/Or operators 

The system uses an "or" operator value and not an "and" operator value between action entries. This 
means when you enter multiple actions, you should read the expected results as: This action or this 
action or this action can be an entry, completing or canceling action, etc.  

Viewing Work Queues Assigned to Users 

If you are unsure of the work queues assigned to various users, you can access the View User screen, 
providing you have the appropriate roles, and view a consolidated list of work queues assigned to 
individual system users. 

Task Activities 

Configure a Work Queue Overview includes the following task activities: 

• Add/Update a Work Queue 
• View Work Queues Assigned to a User 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
• About System Work Queues 
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Related Links 

Search Work Queues Screen  

Add/Update Work Queue - Basic Information Screen 

Add/Update Work Queue - Filter Criteria Screen 

Add/Update Work Queue - Display Attributes Screen 

Add/Update Work Queue - Assign User Screen 

Add/Update Work Queue - Assign Supervisor Screen 

Add/Update Work Queue - Entry Actions Screen 

Add/Update Work Queue - Completing Actions Screen 

Add/Update Work Queue - Canceling Actions 

Review Work Queue Summary Screen 

 

My Court Information 

 

Add/Update a Work Queue 

 

Introduction 

This task activity provides instructions to add or update a work queue.  

Task Activity 

Perform the following steps to add or update a work queue. 
 

1. Select [Admin] > [Application Administration] > [Configure Work Queues]. 
Result: The Search Work Queues screen displays. 

2. Enter/Select data in the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search Work Queues screen refreshes and displays the work queues matching your 
search criteria. 
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4. If you are adding a work queue, click [Add New Work Queue]. If you are updating a work queue, 
select the radio button for the work queue to update and select the [View] button. 
Result: The Add/Update Work Queue - Basic Information screen displays. 

 
 

 

5. Enter/Update basic information as appropriate and click the [Next] button. 
Result: The Add/Update Work Queue - Filter Criteria screen displays. 
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6. Enter/Update filter criteria as appropriate and click the [Next] button. 
Result: The Add/Update Work Queue - Display Attributes screen displays. 
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7. Enter/Update display attribute information as appropriate and click the [Next] button. 
Result: The Add/Update Work Queue - Assign User screen  displays. 
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8. Enter/Update user information as appropriate and click the [Next] button. 
Result: The Add/Update Work Queue - Assign Supervisor screen displays. 
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9. Add/Remove user names to/from the approved supervisors list and click the [Next] button. 
Result: The Add/Update Work Queue - Entry Actions screen displays. 

 
 

 

10. Add/Update entry actions as appropriate and click the [Next] button. 
 One of two things may happen at this point depending upon the Completion Type you 

entered in the "basic information" screen at the beginning of this process.  
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Result #1: If you selected Manual, the Add/Update Work Queue - Landing Screen displays, 
since you do not see the Completing Actions screen, skip the next step where you define the 
landing screen. 

Result #2: If you selected Automatic, the Add/Update Work Queue - Completing Actions 
screen displays, go to the next step. 

 
 

 

11. Add/Update completing actions as appropriate and click the [Next] button. 
Result: The Add/Update Work Queue - Landing Screen displays. 
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12. Add/Update landing screen information as appropriate and click the [Next] button. 
Result: The Add/Update Work Queue - Canceling Actions screen displays. 

 
 

 

13. Add/Update canceling actions as appropriate and click the [Next] button. 
Result: The Review Work Queue Summary screen displays. 
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14. Click the [Save] button to save the work queue information as displayed. Click the [Cancel] 
button to end the process without saving your additions or updates. 

 

 

Related Links 

Configure Work Queues Overview 

Search Work Queues Screen  

Add/Update Work Queue - Basic Information Screen 

Add/Update Work Queue - Filter Criteria Screen 

Add/Update Work Queue - Display Attributes Screen 

Add/Update Work Queue - Assign User Screen 

Add/Update Work Queue - Assign Supervisor Screen 

Add/Update Work Queue - Entry Actions Screen 

Add/Update Work Queue - Completing Actions Screen 

Add/Update Work Queue - Canceling Actions 

Review Work Queue Summary Screen 

 

My Court Information 

 

View Work Queues Assigned to a User 

 

Introduction 

This task activity provides instructions on how to view the work queues assigned to a selected user.  

Task Activity 

Perform the following steps to view the work queues assigned to a user. 
 

1. Select [Admin] > [User Administration] > [Search User]. 
Result: The Search User screen displays. 

2. Enter/Select data in the appropriate search parameter fields. 
3. Click the [Search] button. 

Result: The Search User screen refreshes and displays user IDs matching your search criteria. 
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4. Click the Name hyperlink of the user whose data access privileges you want to update. 
Result: The View User screen displays. 

 
 

 

5. Select the [Work Queue(s) Assigned to User] tab. 
Result: The Work Queues Assigned to User tab highlights and displays in the foreground. 



Printed Documentation 

1462 

 
 

 

 

 

Related Links 

Configure Work Queues Overview 

Security Background Information 

View User Screen 

 

Document Management System 

Document Management System Overview  

 

Introduction 

The system has two places where documents can be stored: 

• Internal system file store 
• External document management system (e.g. FileNet® Image Manager) 

 

 

Documents generated in the system and e-filed documents 

Documents that are generated in the system or e-filed can be stored in either the internal system file store 
or the external document management system. The DMS_IND system setting determines, per court, 
where these documents are stored. 

Scanned documents 
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Documents that are scanned into the system can only be stored in the external document management 
system.  

Assumptions 

The remaining topics discuss linking documents stored in the external document management system to 
case file information stored in the system.  

These topics assume the FileNet Image Manager system is the external document management system 
being used and that it is properly installed and setup to use the DMS API provided with the system. 

Linking Documents to Case Files 

The system supports four ways to link documents in an external document management system to case 
files in the system. 

• Documents e-filed and linked automatically 
• Documents scanned with a cover sheet and linked automatically 
• Documents scanned with a barcode and linked automatically 
• Documents scanned without a cover sheet or barcode and linked manually by a user using 

system functionality 
 

 

Following are high-level process steps that represent each of the four ways of linking documents to case 
files. General information regarding what is expected from system users is also included. 

The following process steps are intended to provide you with a high-level understanding of how the 
system works with the external document management system. These steps do not attempt to convey 
any technical details. 

Linking Data 

The term "linking data" represents: a Document Name, a Document Key, and a Document ID. Both 
systems use this linking data to match documents to case filing or exhibits. Linking data may also be 
referred to as document metadata. 

Documents E-Filed and Linked Automatically 

This example highlights when documents are e-filed and linked automatically. 

1. User accepts an e-filing. 
 Refer to the Accept an E-Filiing task activity. 

2. Document linking data is associated with the system case filing and stored in the external 
document management system by way of the e-file XML document. 
Result: Linking complete. 

Documents Scanned With a Cover Sheet and Linked Automatically 

This example highlights when documents are scanned with a cover sheet and linked automatically. 

1. User adds a filing or exhibit. 
 Refer to the Add Case Filings or Add Exhibits to the Pull List task activity. 

2. While adding a filing or exhibit the user adds document linking data without providing a document 
key. 
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Result: The system prints a cover page that contains the linking data with an auto-generated 
document key and a scannable barcode representing all of the linking data. 

3. The physical document and the cover page are scanned into the external document management 
system.  

4. A stand-alone batch application monitors the external document management system for any 
unlinked documents.  

5. When unlinked documents are found, the batch application sends the document linking data to 
the system where it is matched with identical linking data in the system.  
Result: Linking complete. 

Documents Scanned With a Barcode and Linked Automatically 

This example highlights when documents are scanned with a barcode and linked automatically. 

1. User adds a filing or exhibit. 
 Refer to the Add Case Filings or Add Exhibits to the Pull List task activity. 

2. While adding a filing or exhibit the user receives the physical document that has been barcoded. 
The user enters document linking data, including the document key, according to the data 
supplied with the barcode.  

3. The physical document and barcode are scanned into the external document management 
system.  

4. A stand-alone batch application monitors the external document management system for any 
unlinked documents.  

5. When unlinked documents are found, the batch application sends the document linking data 
(from the barcode) to the system where it is matched with identical linking data.  
Result: Linking complete. 

Documents Scanned Without a Cover Sheet or Barcode and Linked Manually by a 
User Using System Functionality 

This example highlights when documents are scanned without a cover sheet or barcode and are 
manually linked to a filing or exhibit by a user using system functionality. 

1. User adds a filing or exhibit. 
 Refer to the Add Case Filings or Add Exhibits to the Pull List task activity. 

2. User does not include any document linking information. 
3. Documents are scanned into the external document management system indicating it is a system 

document needed to be linked with a system case file or exhibit. 
4. A stand-alone batch application monitors the external document management system for any 

unlinked documents. 
5. When unlinked documents are found, the batch application sends the document linking data, 

which was keyed in by person who scanned the documents, to the system where it does not find 
a match. 

6. The system places a record of this document in the DMS Documents work queue list. 
7. A user looks at the scanned document through a link to the external document management 

system and searches for the appropriate case filing or exhibit. 
8. Once the case filing or exhibit is located the user associates it with the document. 

Result: Linking complete. 
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DMS Documents Work Queue 

Although the DMS Documents work queue looks and operates like any other work queue, it is a non-
configurable work queue designed to support linking of stranded documents in the document 
management system to case filings or exhibits. The term "non-configurable" is used because the DMS 
Documents work queue cannot be created/updated/deleted using the functionality designed to 
create/update/delete work queues. 

Task Activities 

The document management system includes the following task activities: 

• Manage Document Linking Data 
• Manually Link a Document to Case Filing or Exhibit 

Additional Resources 

Other items related to this overview include the following: 

• Business Rules 
 

 

Related Links 

DMS Document Link Search Screen 

DMS Document Work Queue List Screen 

 

My Court Information 

 

Manage Document Linking Data 

 

Introduction 

This task activity enables you to: 

• View documents attached to a case filing or exhibit 
• Add document linking data that ties a document to a case file or exhibit 

Task Activity 

This task activity takes place within the context of a case. This means you can see the left navigation 
pane that displays the additional Case options. The easiest way to get within the context of a case is to 
perform a search for a case and click the case link to view the case summary. Refer to the Search Cases 
task activity for details about performing a case search. 

This task activity also includes the Attached Documents section of the screen that is seen when adding a 
case file or exhibit. The introductory steps take you to the respective screens, but the remaining steps 
focus on the Attached Documents section which is identical for both case filings and exhibits. 
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Perform the following steps to view documents attached to a case filing or exhibit and/or add document 
linking data to a case file or exhibit. 
 

1. Select the [Add Filings] left navigation item. 
Result: The Add Filing - Enter Filing Information screen displays. 

OR 

1. Select the [Mark/Maintain Exhibit] left navigation item. 
Result: The Mark/Maintain Exhibit - Event List screen displays. 

2. Select an exhibit record and click the [Mark Exhibit] button. 
Result: The Mark Exhibit screen displays. 

2. Locate the Attach Document bar. 

 
 

 

3. Click the toggle button located on the right hand side of the bar. 
Result: The Attached Documents section of the screen opens displaying any existing attached 
documents and spaces to add new linking data. 

 
 

 

4. View a document by clicking the DMS icon associated with one of the listed documents. 
Result:  The document management system displays the document. 

5. To add document linking information and generate an associated cover sheet: 
o Enter the following required data: 

 Document Name 
 Document Security 

 Do not enter a DMS Document Key. 
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o Click the [Add Another Document] button. 
Result: The system displays the document linking information with the other documents 
attached to the case filing or exhibit. 

o Select the checkboxes for all documents you want to generate and print cover sheets 
for. 

o Click the [Save] button. 
 

 

6. To add document linking information from a pre-barcoded document: 
o Enter/select the following required data: 

 

 Document Name 
 DMS Document Key 
 Document Security 

 

 

o Click the [Add Another Document] button. 
o Enter a Document Name and a Document Key. Select a Document Security level. 
o Click the [Add Another Document] button. 

Result: The system displays the document linking information with the other documents 
attached to the case filing or exhibit. 

o Click the [Save] button. 
 

 The system generates document key IDs and prints cover sheets for all documents that do not have 
a document key and have their associated check boxes selected.  

 

 

Related Links 

Document Management System Overview 

DMS Document Link Search Screen 

DMS Document Work Queue List Screen 

 

My Court Information 

 

Manually Link a Document to Case Filing or Exhibit 

 

Introduction 

This task activity allows you to manually link DMS documents to a case filing or exhibit. 
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Task Activity 

Perform the following steps to manually link documents to a case filing or exhibit. 
 

1. Select [Work Queue] > [DMS Documents Work Queue]. 
Result: The DMS Documents Work Queue List screen displays. 

 
 

 

 If you are unsure about any document, click the DMS Document ID link to view an image 
of the document (not shown). 

2. Select the radio button associated with the DMS document you want to link. 
3. Click the [Select] button. 

Result: The DMS Document Link Search screen displays. This screen allows you to search for 
case filings and exhibits to find the right one to link to the document. 

 
 

 

4. Select either Filing or Exhibit from the Document Association drop-down list. 
5. Enter any other search criteria, as appropriate. 
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6. Click the [Search] button. 
Result: The DMS Document Link Search screen refreshes and displays all records matching your 
search criteria. 

 
 

 

 

7. Select the radio button of the case filing or exhibit to be linked to the selected document. 
8. Click the [Associate DMS Link] button. 

 

 

Related Links 

Document Management System Overview 

DMS Document Link Search Screen 

DMS Document Work Queue List Screen 
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Glossary 

# 
2nd Call: An indicator that marks when an event is requested for second roll call. 

A 
According to Proof: An indicator to select whether a Memorandum of Cost is filed with the court and has 

the applicable attorney fees. 

Account Number: The account number that identifies a trust or blocked account. 

Account Status: An indicator that marks whether a user's access to the system will be enabled or 
disabled upon creation. 

Accrued Interest $: The amount of money that has accrued on a trust deposit. 

Action: Something done by a user or the system that causes a system response. Examples include Entry 
Actions, Completing Actions, and Canceling Actions. 

Action Type: The type of action that defines how a clock should behave once a trigger activates the 
clock. Action types include starting, stopping, pausing and restarting actions. 

Active Military Duty: A checkbox indicator that marks a person/entity as being on active military duty. 

Activity: The type of transaction that occurred on the fee. 

Actual Number of Days: The number of calendar days that the case took to meet a milestone. 

Additional Attachment: A checkbox indicator that allows the user to include multiple files in the e-filing 
acceptance message. 

Additional Attribute Name: The name of an attribute that is associated with the reference table value. 
Attributes are pre-determined, additional data elements available based on the reference table 
value. 

Additional Display Attributes: These fields are additional display attributes that have been configured to 
appear for the work queue. These additional fields include: Completed By, Completion Date, 
Probate Notes Progress, Document Counter, Comments, etc. 

Adjusted Amount Due $: The amount due to the Court for fees based on fee waivers or other court 
orders. 

Adjusted Fee $: The amount of money due which overrides the original fee amount. 

Adjusted Sanction Amount $: The amount of money due which overrides the original sanction amount. 

ADR Type: A classification of an alternative dispute resolution process that was entered on the case. 
This represents a type of arbitration or mediation. 

Advanced Filter Criteria: These fields are additional filter criteria fields used for narrowing down the 
work queue task list to the tasks of interest. These fields include: Judicial Officer, Location, 
Division, Department, etc. 

Allowed Judicial Officer: A selection to indicate another Judicial Officer name that can substitute for the 
selected Judicial Officer. 

Alternate Arbitrator: If all other resources are inactive, rejected or alternates, the user can update the 
status of a single arbitrator to "assigned". 

Amended #: A data entry field that marks the filing as having an amended number. 
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Amount Received: The amount of money tendered for a selected payment method (e.g., $100.00 for a 
check). 

Amount Reserved: The quantity of case numbers reserved in a block or range instance (group). 

Appearance Status: An indicator as to whether or not the case participant is present for the hearing. 
Options include Pending, Ready, and No Appearance. 

Appearance Type: The type in which the attorney participated in the scheduled event. Options include 
In-Person and Telephonic. 

Appears as Manual Case History Entry: A checkbox indicator that marks the entry as a manual entry. 

Appointment Start Date: The date when a resource became assigned to a case. 

Appt. End Date: The date when the resource became removed from the case. 

Assign By Case #: An indicator that allows you to select a case number as the assignment method. 
 Either the Assign by Case % or the Assign by Case # must be selected if the Method of 
Assignment value is "Random". This field is only available for Judicial Officer and Department. 

Assign By Case %: An indicator that allows you to enter a percentage distribution as the assignment 
method.  Either the Assign by Case % or the Assign by Case # must be selected if the Method of 
Assignment value is "Random". This field is only available for Judicial Officer and Department. 

Assigned Department: A selection to indicate the department within the location where a Judicial Officer 
is assigned. 

Assigned Judicial Officer: The name of the Judicial Officer that is currently assigned to the 
location/department combination. 

Assigned Zip Code: The postal code in which a person/entity is assigned to perform work. 

Assigned/Default Values: When specifying a value for a parameter, when the parameter is displayed 
within the Minutes, the configured value may be defaulted or assigned to the parameter. 
Assigned values may not be changed by the Courtroom Clerk when entering minutes. 

Assignment Method: The method by which tasks will be assigned to the workers in the work queue. 
Work queues utilize either manual or round robin (automatic) task assignment. 

Assignment Type: The type of assignment related to a resource. Options include Case or Filing. 

Associated Case Type: A selection to indicate the type of case association entries to filter. This listing 
contains the consolidated, coordinated, or related case numbers applicable to the case. If the 
current case is a consolidated case or a JCCP case, the drop down shows a list of the cases that 
are associated with the case. 

Associated Department(s): The departments that are associated with the person/entity. 

Associated Documents: A list of documents associated with an event. 

Associated Event: The calendared event associated to an exhibit or Case History/ROA entry. 

Associated Hearing: The event for which the record was subpoenaed. 

Associated Participant: The name of the participant that is associated with a filing or with a party. 

Association Type: A selection to indicate the type of relationship between the participants. Examples 
include: Attorneys and firms, persons compromising a family unit, or duplicate person/entity 
records. 

Attorney Name (Other): A text box that allows attorneys not displayed in the attorney name drop-down 
field to be entered. 

Auto Assign: A checkbox indicator that marks the resource rule as the default rule used at case 
initiation. This field is only available for Judicial Officer and Department resources. 
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Availability Status: The availability of the exhibit or the case file. 

Available for posting: A checkbox that indicates to the system that the tentative ruling or probate note is 
ready to be published. 

B 
Balance Due: The amount currently due. Equals Adjusted Amount or Installment Amount (if fee is paid 

through a payment plan). 

Balance Due Total: The total amount due to the Court for all provided services. 

C 
Calendar Component: The standard component within the chamber view used to calculated a desired 

calendar date, based on the type of day selected, either court of calendar day. 

Calendar Date: A parameter to specify a calendar to be finalized. 

Calendar Days: Calendar days include both business days and non-business days from Monday to 
Sunday. (See Court Days) 

Calendar Name: A field is used to specify a Calendar Name on the calendar view first page header. 

Calendar Number: This field is used to specify the sequence of display for the Calendar Number on the 
calendar (same as sequence number). 

Calendar Template: This field is used to specify the format in which the calendar is to be displayed. The 
system supports three different design templates. 

Calendar Time: This field is used to specify the sequence of display for the Calendar Time on the 
calendar view first page header. 

Calendar Type: An attribute of a scheduling rule. Examples include Law & Motion, Settlement 
Conference, and Trial. 

Calendar View: A specific set of data elements selected to format the public calendar, the daily list 
calendar, and the courtroom calendar. 

Calendared Event: A specific association of a case to a calendar day and time. 

Case Age: The age of the case. This age is based on when the initial filing document was submitted with 
the court and is counted in calendar days. 

Case Category: The main category of case classification used to identify a case. Examples include Civil, 
Small Claims and Probate. 

Case Disposition Type: The type of disposition that occurred on the case, including Summary 
Judgment, Stipulated Judgment, Dismissal, and Judgment. 

Case File Location: The physical location where the case file is stored. The four-tier format is: Building, 
Room, Place, and Sub-Place. 

Case Information: A calendar that displays key information including case category, case type, case 
track, case status, and case title. 

Case Initiating Filing: The filing that started the case. 

Case Number: This field displays the unique identification code associated with the work queue task 
listed. The V3 format is a 2-digit county code, a 4-digit year code, and an 8-digit case identifier 
(XX-YYYY-ZZZZZZZZ). 

Case Participant: Any person or entity involved with a case. 
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Case Short Title: A brief title that describes the case as the last name of the first plaintiff and first 
defendant, or the name of the petitioner. 

Case Status: The current status of the case in the system. Options include: Pending, Arbitration, 
Mediation, Stayed, Appeal, Closed, Voided, Consolidated, Dismissed, Judgment, Trial, Trial De 
Novo. 

Case Title: The formal title that describes the case. The title usually identifies the two parties in conflict or 
the name of the petitioner. 

Case Track: The name of the track to which the case belongs. Courts can configure unique tracks with 
milestones that cases are expected to meet as well as clocks to track performance of a specific 
case. 

Case Type: The second level of case classification used to identify a case, including Unlawful Detainer, 
Harassment, Business Tort, Guardianship, etc. 

Cashier: A clerk who is authorized to receipt payments. 

Causal Document: A document associated to a calendar event, such as a motion, or a document that 
triggers an action, such as a petition. 

Certification Number: The AOC registration number for an Interpreter. 

Clerical Error Checkbox: An indicator as to whether or not a previous case disposition status was 
entered in error due to data entry. Checking this checkbox means that the case disposition status 
is being updated from a previous disposition status that was entered in error. 

Clock Name: The is one component for defining and identifying a unique case clock. 

Clock Status: The current behavior or status of the clock on the case. This status is based on configured 
events occurring on the case, and includes Started, Stopped, Paused, and Restarted. 

Clock Type: A classification used for defining a clock's behavior which determines how case participants 
may be affected by a configured clock action. Types include case level clocks or participant level 
clocks. 

CMS ID Number: The unique identification code that is assigned to a person/entity profile in the system. 

Collection Address: The case participant's address for purpose of collection notices. 

Collections Agency Name: The name of a collection agency where fees are referred. 

Completion Due: This field displays the date by which the task should be completed 

Completion Type: This field displays the method of completing tasks assigned to the work queue. Work 
queues utilize either automatic or manual task completion. 

Confidential: A Case History entry with a security level of more than one (not visible to the public). 

Confidential Case Volume: A checkbox indicator as to whether the case file volume, as a whole, is 
considered confidential. 

Configurable: A system parameter or feature that can be turned on or off at the time of installation. 

Confinement: An attribute of a person. The system stores this as free-form text. 

Contact Name: The name of a contact in the event a transferred case is rejected. 

Coordinated Case Number: The unique identification code that is assigned to a JCCP (coordinated) 
case. 

Courier: A yes/no indicator as to whether a courier company was responsible for the transfer of the 
physical case file. 

Courier Company: The courier company whose employee took physical possession of the case file. 



Glossary 

1475 

Courier Contact Information: The name and contact information of the courier who physically took 
receipt of the case file. 

Courier Name: The name of the courier who physically took receipt of the case file. 

Court Appointable: A yes/no indicator that shows whether an attorney is on the panel of court appointed 
attorneys. 

Court Days: The days a court is open for business. 

Court ID: The two digit county code of a court. 

Court Ordered to ADR: A checkbox indicator that marks an assignment as ordered by the Court. This 
field is available for Arbitrator and Mediator resource types. 

Court Title: The name of the court, synonymous with the county name. 

Create Payment Plan Checkbox: An indicator specifying whether or not to create a payment plan so the 
fee waiver applicant may pay for fees over time. Checking this checkbox will cause a payment 
plan to be generated. 

Current %: The current percentage stored as the assignment distribution for a resource. This may be a 
system-calculated value or a value that you enter. This field is only available for Judicial Officer 
and Department resource types. 

Current Assigned JO/Dept.: The name of the Judicial Officer or department resource that is currently 
assigned to the case. This is a display-only value. 

Current Location: The court building where an exhibit or file is located. 

Current Resource: The current name of the Judicial Officer or department resource that is assigned to 
the case. 

Custodian: The individual within the court who is responsible for the physical case file. 

Custodian Contact Information: Contact information for the individual who is responsible for the case 
file. 

Custodian Name: The name of the individual who took physical possession of the case file. 

D 
Date Needed: The date that an exhibit is needed in the new location, included on the pull list. 

Date of Destruction: The date the case file is planned to be physically destroyed. 

Date of Rejection: The date on which the rejection for the receipt of a case during case transfer 
processes or efiling process. 

Days Elapsed: The number of days since the appeal case has been submitted. 

Department: Designator of a specific courtroom. 

Disassociate: The process of removing a participant added to a case or a merged group, or removing a 
case previously related to another case. 

Disbursement Amount: The amount of money disbursed from a trust to a payee. 

Disbursement Number: A numeric identifier used for identifying a disbursement within the system. 

Disposed Checkbox: A checkbox indicator as to whether the case being searched for has already been 
disposed. 

Disposition Date: The date when an exhibit, filing, or case was disposed. 

Disposition Eligibility Date: The date that an exhibit retention period has elapsed. 
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Disposition Status: The disposition status of the case participant associated with the selected filing, or a 
case disposition status as defined by JBSIS, or the disposition status of the subpoenaed record. 

Disposition Type: The type of disposition that occurred on the case, including summary judgment, 
judgment, stipulated judgment, or dismissal. 

Division: A group of departments used to specify the court location on which to search for resource 
allocation rules.This field is required if Location is selected and the resource type specified is 
Division. 

DMS: Document Management System. In courts that have imaging, clicking on the DMS icon displays an 
image of the document in a pop-up window. 

DMS Document ID: A unique identifier used by the document managment system (DMS). 

DMS Document Key: A unique identifier used by the document management system (DMS). 

DMS Document Name: The document name in the document management system (DMS). 

Document Category: The type of will or estate planning document submitted to the court, including 
Miscellaneous Will, Probate Will and Estate Plan. 

Document ID Number: A unique identifier for any document on deposit or filed with the court. 

Document Name: The name of a document on deposit or filed with the court. 

Document Security: The security level assigned to a document. (See Security Level) 

Document Set: An association of documents, including judgment forms, record on appeal, ADR notices, 
and Unlawful Detainter Packet. 

Document Text: The text that will appear in the case document and on the form when the item is 
generated. 

Document Type: The name assigned to a document, such as Probate Will, Miscellaneous Will, Codicil, 
etc. 

Drawer Amount: Total amount in the drawer at the end of a cashier session to be balanced against the 
system. It does not include the starting amount. 

E 
Element: A data field. 

Eligibility Date: The date on which an exhibit or physical case file may be destroyed. 

End Date: The date a system component will expire within the system. 

End Number: The ending number that defines a range of reserved case numbers. 

End Time: The unavailability end time associated with the listed resource unavailability rule. 

Entered in Error Checkbox: A checkbox indicator that marks an entry as having been entered in error. 

Entity: A non-person in the system, such as a corporation, organization, trust or DBA. 

Entry Action - Action: The type of action that will result in tasks being added to a work queue, including 
minute codes and ROA/Case History entries. 

Entry Action - Parameter Type: A work queue configuration attribute, which includes Event Type and 
Filing Name. 

Entry Action - Parameter Value: A work queue configuration attribute, which includes Trial and Answer. 

Entry Function: Tthe function or category that an entry belongs to. Includes Fees, Scheduling, and 
Filings. 
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Entry Name: The name assigned to an action entry. 

Event: The name of a specific hearing within a calendar. 

Event Date: The date associated with an event in the system.   

Event Information: Information that includes the Case Header, Event Type, Event Status, Event Date, 
Event Time, Event Department, and Moving Party. 

Event Notes: A text area used to specify any additional comments to be made on the event being 
rescheduled/reassigned. 

Event Status: The event status that the calendar event is currently in, including Trailed, Mistrial, Heard, 
Extended and Scheduled. 

Event Time: The time when the event is scheduled to take place. 

Event Type: The type of event that can be scheduled, including Trial, Pre-Trial Conference, Case 
Management Conference, OSC Hearing, Arbitration Hearing, etc. 

Exceptional Case: A checkbox indicator that marks a legacy case as exceptional for purposes of case 
management. 

Exceptional Reason: An open text field available for providing the reason for the legacy case as being 
exceptional. 

Exhibit Disposition: The mannger of disposition of an exhibit, including Released, Remarked, Pending, 
and Destroyed. 

Exhibit Location: A four-tier hierarchy describing the location of an exhibit, including Building, Room, 
Place and Sub-Place. 

Exhibit Number: A unique number to identify an exhibit.  The exhibit number can not exceed 10 
characters. 

Exhibit Status: The status of the exhibit, including Marked, Marked & Admitted, Marked & Not Admitted, 
Marked & Withdrawn, and Marked & Admitted as Redacted. 

Exhibit Type: A category type in which the exhibit falls under, including Valuable, Bulky, Firearm, etc. 

Existing List of Supervisors: A list of supervisor names that have been assigned to the work queue. At 
least one supervisor must be assigned to a work queue. 

Expected Number of Days: The number of days from the start of a case that the milestone is expected 
to be met. This number is based on the case aging clock and is counted in calendar days. 

Expected Return Date: The date that the requester of the case file is expected to return it to its primary 
storage location. 

Expiration Date: The date that a system component is set to expire. 

Expiry Warning Number of Days: The number of days prior to the expiration of the clock when the 
system will issue an alert. 

Extension Date: The date that the physical case file will be retained by the court until. 

F 
Fee Category: A classification given to multiple fee types that share the same characteristics, including 

Fee, Trust, Assessment, Fine, Sanction, Penalty, and Miscellaneous. 

Fee Due Date: The date a fee is due, which defaults to the current date. 

Fee Type: Type of fee (related to a filing or miscellaneous fee) associated with services provided by the 
court, including filing fees, jury fees, and non-case related fees. 
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Fees Deferred Checkbox: A checkbox indicator that defers fees for the person/entity to defer fees in 
cases where they are acting in their official government capacity. 

Fees Due: A display field that indicates if there are fee remaining for the case. 

FEIN Number: The Federal Employee Identification Number for an entity. This field is not available if the 
selected person/entity category is "person". 

File Copy Checkbox: A checkbox indicator specifying whether or not you want to generate an extra copy 
of the form for the case file. Checking this checkbox means that you want to generate the extra 
copy. 

Filed By: The name of the person/entity who filed a document. 

Filed by Category: A classification of the case participant who filed a filing (role). 

Filer Email: The email address of the Filer.  This is the email address that will be used for future 
correspondence with the Filer. 

Filing Disposition Status: The disposition status of the selected filing. The filing disposition status is 
determined by any judgments or dismissals entered on the filing, and the status will be reported 
by JBSIS hierarchy. 

Filing ID: A unique system identifier used to identify a filing. 

Filing Status: The status of the case filing, including Rejected, Voided, Active, and Disposed. 

Filing Type: A classification of filings that have the same characteristics, including Motion, Petition, and 
Ex Parte Request. 

Filter: The means by which lists, views, and search results can be narrowed based on criteria provided 
by the user. 

Filter Criteria: A selection used to specify the criteria by which to filter the available screen data, 
including case number, case category, and case type. 

Firm: The most recent law firm associated with the person/entity. 

Form Category: Identifies at a high level, the "type" of form/notice available for inclusion into a document 
set. 

Form Recipients: A list of case participants that have been chosen to receive the selected form. 

Form Template: A template used to derive the formatting and content within a form. 

Franchise Site Number: The franchise site number for an entity, used as a data element in the 
Person/entity tab. 

Friendly Printer Name: User- friendly name used to identify printers. 

From Starting Action: An indicator as to the number of days that the system must reference to 
determine if a specific event has occurred. If this value is selected as the frame of reference, then 
the system will count forward from the starting action. This is a positive day count. 

G 
Government Agency: A public entity whose fees are deferred per Government Code Section 6103 (for 

example, local/state/federal agencies). 

Guardian Ad Litem Checkbox: A checkbox indicator marks the attorney as participating on cases for 
guardian ad litems. 

Guardianship as Counsel for Minor Checkbox: A checkbox indicator marks the attorney as 
participating on cases for guardianship as counsel for a minor. 
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Guardianship as Counsel for Parent Checkbox: A checkbox indicator marks the attorney as 
participating on cases for guardianship as counsel for a parent. 

H 
Has Special Needs: A checkbox indicator and free-form text that marks the person/entity as having 

some type of special need, such as ADA accommodations. 

Held Until Date: The date for which an order remains in the "Held" status.The date in which a warrant 
cannot be issued until.   

Home Address: The home address of the person for which the warrant is being issued against. 

I 
ID Type: The types of identification in the possession of the person/entity, including Passport, Drivers 

License, etc. 

In Use: The quantity (number) of reserved case numbers that are currently assigned to cases. These 
numbers are unavailable for case assignment. 

Incapable of Voting: A data element in the Person/Entity profile that shows whether the person has 
been determined by the court to be incapable of voting. 

Investigator Notes: An open text field available for providing notes about the probate investigation. 

IP Address: A virtual identifier that indicates the Electronic Filing Service Provider (EFSP) location on a 
TCP/IP network. 

Is Case Initiation Complete? Checkbox: A checkbox indicator that marks a case as being complete in 
the system. This would then allow the case data to be available to the public ROA and index, 
unless the security level excludes the public. 

Is Confined Checkbox: A checkbox indicator that marks a person/entity as being currently confined in 
jail. This field enables the Confinement text field. 

Issuance Status: The status of the previously issued issuances (writs), including Rescinded, Held, and 
Held Until. 

Issuance Type: The list of the names associated with the type of issuance being recorded, including 
Abstracts and Writs.   

J 
JO Notes: A text area in which notes regarding the tentative rulings could be entered by a judicial officer. 

Job: The name of a batch utility. Batch utilities are programs that are executed by the system based on a 
frequency defined by the system administrator. Batch utilities are used to update multiple records 
in the system at one time, and are usually performed du 

Job Description: The description of a batch utility you wish to execute at a future point in time. Batch 
utilities are programs that are executed by the system based on a frequency defined by the 
system administrator. Batch utilities are used to update multiple records in 

Judgment Status: The status of the judgment. A judgment status is determined due actions taken by 
case participants to satisfy the judgment. Includes: Fully Satisfied, Partially Satisfied, Unsatisfied. 

Judicial Officer Notes: Notes entered by the Judicial Officer regarding the probate notes, tentative 
rulings, or proposed orders. (same as JO Notes) 

Judicial Officer Presiding: The name of the Judicial Officer presiding over the event. 
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Judicial Officer Type: The type of Judicial Officer resource, including Judge, Commissioner, Judge Pro 
Tem. 

L 
Landing Screen: The screen to which the user will be routed when a work queue task is selected. 

Language: The language spoken by the person/entity. 

Last Event Date: The date when the last event was completed for the case. 

Last Event Type: The name of the last event that was completed for the case. 

Last Role on Case: An indicator to display the case participants who have had that role as their last 
(most recent) role on the case. Either the "All Roles on Case" or "Last Role on Case" option must 
be selected if a Role filter value is chosen.An indicator that filters the associated participant list to 
display only the last role held by the participant on the case. 

Last Update By: The name of the person who made the last update to the note. 

Last Update Date: The date that indicates when the last update was made to the note. 

Last Update Time: The time when the last update was made to the note. 

Lead: The selected lead case of a consolidated group of cases. A lead can also apply to a person/entity 
profile designated as the "master" record of a merged group of profiles. 

Lead Attorney checkbox: A checkbox indicator that marks the attorney as the lead attorney. 

Lead Case Number: The unique identification code for the selected lead case of a consolidated group. 

Leading Document Type: The first document included in the e-filing extracted from the e-filing XML 
provided by EFSP. 

Legacy Case Number: The unique identification code used to add a specific legacy (pre-CCMS) case to 
the system. This number originates from the legacy system or physical file folder. 

Legacy Source: The name of the legacy system in which this case resides. The open text field is 
required if the selected source is "Other". Examples include "JCCP, Bench Recusal" etc. 

Locate in Case File: An indicator as to whether the item is stored in a case folder. 

Location: The name of the Court location. 

Long Entry: An open text field available for entering the standard, static text that the system uses to 
describe this case entry. 

M 
MAC Address: Hardware identifier that indicates the selected user's computer location on a network. 

Macro Code: An abbreviated description for a group of Minute codes configured for use within a Minute. 

Macro Description: A description for a group of Minute codes configured for use within Minutes. 

Macro Type: A classification of a macro. Macro types may be 'Probate' or 'Minutes'. 'Probate' codes are 
available when recording probate notes. 'Minutes' codes are available when recording minutes 
within a Minute. 

Make Available for Posting Checkbox: A checkbox indicator specifying whether or not the probate 
notes should be available for posting to an external environment such as the Internet. Selecting 
this checkbox means that the probate notes may be posted to an external environment. 



Glossary 

1481 

Manual Receipt Number: A unique identifier for a transaction payment, payment for fees pertaining to a 
party, payment for fees pertaining to a case, or both. The first two digits of the receipt number 
refer to the court where the receipt is processed. 

Mark as Secure Checkbox: A checkbox indicator that marks the participant profile information as 
secured only within the context of the selected case. This field is only viewable within the context 
of a case. 

Mark Volume as Confidential Checkbox: A checkbox to indicate whether the entire volume should be 
considered confidential. 

Maximum Number of Active Cases: The highest number of cases that a court appointed attorney can 
be assigned. 

Method of Assignment: A selection to indicate how the system will select a resource.  Methods may be 
rotational or random. This field is only available for Judicial Officer and Department resource 
types. 

Milestone: The name of a configured milestone set for the track. It is a guideline as to what events 
should occur on a case that is assigned to this track. Examples include: Proof of Service, 
Appointment of Arbitrator, Judgment on Award, etc. 

Minute Code: The configured codes used for creating minutes.  Minute codes are abbreviated text of a 
court decided action such as record judgment, schedule events, etc. They can be configured to 
only do the minute order, or also onto the Case History/ROA. 

Minute Code Type: A classification of a code. Code types may be "Action" or "Text". Action codes trigger 
events to occur within the system. 'Text' codes cause pre-configured text to appear within 
Minutes or the Case History / Register of Actions. 

Minute Text: The configured text that will be displayed within the Minutes when a given code is selected. 
The Minute text may be comprised of static text and variables (based on available action code 
parameters). 

Minutes Only Checkbox: A checkbox indicator specifying whether or not the configured code will only be 
available within the Minutes. Checking the checkbox will mean that the selected code will not be 
available for probate notes and other functions within the system. 

Mode of Generation: A selection to indicate the method for generating the selected form, including 
Scheduled Printing, Automatic, Print. 

Month View: This area displays the calendar month view for the month corresponding to the currently 
selected day. 

Move Indicator: An indicator that will move the future scheduled event for the non-lead case onto the 
lead case. 

N 
Native American Ancestry Checkbox: A checkbox indicator that marks a person/entity as having Native 

American ancestry. 

New Assigned JO/Dept.: A reclassification detail that defaults to the currently assigned Judicial Officer 
or department but contains a list of the Judicial Officers/Departments in the selected court. 

Next Action: Instructions to Courtroom Clerks for the further processing and handling of a case 
document, such as publishing and generating the case document form. 

Next Event Date: The date when the next expected event scheduled for the case occurs. 

Night Court Checkbox: This checkbox is used to suggest the use of night court for the event. If this field 
is checked, the "Event Time" will be disabled, the system will only return date and time options for 
night court through allocation rules that have a start time of greate 
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No Appearance Checkbox: A check box, if selected, indicates that no event participants have appeared 
for the  scheduled event. (See No Show Checkbox) 

No Bail Checkbox: The checkbox to indicate no bail is allowed.   

No Show Checkbox: A check box, if selected, indicates that the party did not show up for the scheduled 
event. (See No Appearance Checkbox) 

Non-Monetary Transactions: Transactions that are not reflected in the cash drawer, including Voids and 
Transfers. 

Non-PI Checkbox: A checkbox indicator that marks whether an arbitrator/mediator can provide services 
for Non-Personal Injury cases. 

Not in Good Standing Checkbox: A checkbox indicator marks a Surety Company or Bond Agent as not 
in good standing with the Court. 

Notes: An open text field available for entering  relevant case notes. 

Notice Checkbox: A checkbox indicator that marks the party as receiving court notices. 

NSF Verified: Shows whether Non-Sufficient Fund (NSF) verification has been carried out successfully 
on the check. 

Number of Sides +: A manner of creating a short list of ADR providers based on the number of sides in a 
case. 

O 
Order Status: The status of the fee waiver order or the issuance of warrant, which includes Granted in 

Whole, Granted in Part, Denied. 

Original Balance Due: Amount due for a fee(s) before adjustment. 

Original Filing Date: The date in which the legacy case was first filed in the legacy system. This is not 
the date of case initiation. 

Original Payment Transaction Date: The date the original payment transaction was accepted. 

Original Sanction Amount: The amount of money originally due by the sanctioned case participant on a 
case before adjustment. 

Other Attendees: Additional event participants (usually not associated with the case or the event) to be 
checked in for the scheduled event. 

Other Authorized Party: An additional authorized party associated with the event participant. (For Small 
Claims only) 

Out of County Checkbox: A checkbox indicator that marks the participant as an out-of-county resident. 
This field is only viewable within the context of a case. 

Out of Process: Identifies if the document set is available for generation outside of the context of a case 
(out-of-process). 

Override Conflict Checks? Checkbox: This checkbox is used to indicate the option to override 
conflicting event times and resource allocation rules while rescheduling/reassigning the event. 

P 
Pager: The pager number of the contact to whom the rejection related issue could be communicated. 

Participant: The name of a person/entity who is directly involved with a case. Includes parties, attorneys, 
guardian ad litem, minors, Assignees, Decendents, Executors, Administrators, Creditors, etc. 



Glossary 

1483 

Participant Role: The role of a case participant on a case, including Plaintiff, Defendant, Petitioner, etc. 

Participant Type: An identifier about the person/entity who owns the exhibit, including Person, Entity, 
Government Agency, and Trust. 

Parties Checked In Checkbox: A check box, if selected, indicates that the event participants have been 
checked in for the scheduled event. 

Password: The system password of the person authorized to use the system or to authorize certain 
activities. 

Payee Name: The name of a person/entity that a trust has been disbursed to. 

Payment in Installments Checkbox: A checkbox indicator specifying whether or not the judgment will 
be paid in installments.  Checking this checkbox means that the payments made by the judgment 
debtor will be received by the judgment creditor or court in installments over a period of time. 

Payment Method: Includes Check, Cash, Credit Card, Debit Card, Money Order, Electronic Fund 
Transfer, etc. 

Payment Plan Number: A unique system identifier used to identify a payment plan. 

Payment Plan Status: An indicator as to where a payment plan is in its life-cycle. Payment plans can be 
active or inactive. 

Payment Status: An indicator as to where a payment is in its life-cycle. Payments can have a status of 
void if the payment has been voided. Includes: Paid, Partially Paid, Waived, Partially Waived, 
Govt or Non-Govt Deferral, Recovered. 

Payment Transaction Number: A numeric system identifier generated for a payment transaction. 

Payor Check Number: A unique system identifier for a check used in a payment transaction that has 
been identified as NSF. 

Payor ID Type: The type of identification a payor used when making a payment transaction, including 
Passport, Drivers License, or other government issued ID. 

Person: An individual in the system. 

Personalized Report Name: Identifies the unique report name given to the report when it was generated 
and saved. 

Physical Case File Status: The lifecycle status of the physical case file, including: Eligible for 
Destruction, Pending Destruction, Active, Not to be Destroyed, Destroyed. 

Populate: To fill fields with data, as in bringing over data from one screen to another. 

Position Type: The type of resource assigned to the person/entity, such as Arbitrator or PPF. 

Pre-Hearing Status: Pre-Hearing statuses may be specified within probate notes, tentative rulings or 
Small Claims actions. The pre-hearing status is a way of filtering calendar events based on an 
action you intend to take during the hearing. 

Previous Case Actions: This field is used to specify the prior actions on the case pulled from the case 
history. 

Previous Value: The value or entry attribute that belonged to the entry before the update was made. This 
is a display-only value. 

Primary Location: Identifies the court building where the user works. 

Primary Sort: A selection to indicate the first sort criteria that will be used when viewing the department 
calendar. 

Print Time: The time for when the system should schedule the print job for the selected form. 

Printer Address: Printer IP address or UNC path name. 
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Prior to Event: An indicator as to the number of days that the system must reference to determine if a 
specific event has occurred. If this value is selected as the frame of reference, then the system 
will count back from the specified event. This is a negative day count 

Priority: This field displays the priority level assigned to the work queue task to help the worker see 
which tasks require immediate attention. 

Probate Event Recommendation: The recommended action to take during the probate hearing. This 
indicator displays as a Pre-Hearing status when viewing the hearing from the bench and calendar 
views. 

Probate Notes: A text area in which notes can be entered by a probate examiner. 

Probate Notes Progress: The state or recommended outcome of the probate note. 

Probate Referee Checkbox: A checkbox indicator that marks whether an attorney can provide services 
as a probate referee. 

Professional License Number: The professional license number for the person. Examples include Bar 
Association Number, Medical Bond License Number, etc. 

Proposed Resource: The system recommended resource that matches the assignment criteria. This 
field contains a resource name only if there are configured assignment rules available. 

Pseudo Case: A draft case, created at a kiosk or front desk and not yet accepted by the clerk. 

Pseudo Case Category: The main category of case classification used to identify a pseudo case. This is 
a display-only value. 

Pseudo Case ID: The system generated identifier that is assigned to the pseudo case, which is also 
referred to as the pseudo case “Confirmation Number”. 

Pseudo Case Type: A selection to indicate the second level of case classification used to identify a 
pseudo case. 

Q 
Quantity to Reserve: The quantity (number) of case numbers that are to be reserved in an instance 

(group). This field pertains only to block reservations. 

R 
Random Indicator: An indicator that assigns resources by randomly selecting from a list of available 

resources of the appropriate type. Either a rotational or random method of selection must be 
chosen. This field is not available for Judicial Officer and Department resourc 

Receipt Acknowledgement Date: The date that the court received a receipt from the bank for the 
account set up. 

Receipt Field: An image that indicates whether a receipt was filed on the account. 

Receipt for each case Indicator: Indicator to generate a distinct receipt number for every case within the 
payment transaction. 

Receipt Number: A unique system identifier used to identify a payment in a numeric, whole integer 
format. 

Receipt Status: The status of the payment receipted (i.e. active or void) 

Received from the State Bar: An indicator as to whether a will was received from the State Bar 
Association. 
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Recommend at Case Initiation Checkbox: A checkbox indicator that allows the system to recommend a 
resource at case initiation. This field is only available for Court Appointed Attorney and Probate 
Investigator resource types. 

Record on Appeal: The version number of the Record on Appeal. 

Record Payment Checkbox: A checkbox indicator that marks the Record Payment screen as being 
triggered to display once this entry is recorded. 

Reference Table: Reference tables are available for configuration in the system. The values within a 
reference table appear in the system for search, data entry, etc. 

Refund Number: A unique numeric system identifier used to identify a refund. 

Registered Checkbox: A checkbox indicator that searches for PPF's that are registered. 

Registered with AOC Checkbox: A checkbox indicator that searches for interpreters that are registered 
with the Administrative Offices of the Court. 

Registration Number: The registration number for a Legal Document Assistant. 

Relationship to Case Subject: The association an appointed person has with a case subject. 

Release Temporarily Checkbox: The checkbox to indicate an exhibit was released temporarily. 

Remaining balance greater than zero: An indicator use to specify whether or not a trust has a 
remaining balance greater than zero. A zero balance will cause disbursed and escheated trusts 
not to be available in the search results. 

Remittitur Status: The current status of the remittitur. 

Renewal Date: The date a judgment was renewed for a selected case. 

Report Due Date: The date when the report is scheduled to be submitted. 

Reporter Number: The system-assigned reporter number for a person/entity labeled as a "Court 
Reporter". 

Request Frequency of Job: The amount of time in between occurrences that a batch utility will execute 
in a period of time; such as monthly, weekly, daily, etc. 

Request Status: The request status is captured by the courtroom clerk when entering check-in 
information into a Minute. The request status refers to priority or trailing requests made by case 
participants to determine at which point in the calendar their hearing is called. 

Researcher: The individual responsible for the exhibits analysis prior to disposal. 

Resequence Date: The date for which the resequence will apply. If this date was entered in the 
Resequence Date field on the Case History screen, it will be defaulted to that entered value. The 
entries listed to be resequenced were recorded on this date.The date for which the entry 
resequence will apply. 

Reservation Number: This field is used to specify the system generated number associated to a 
reserved event on which to search for calendar events in the system for the purpose of restoring, 
vacating, deleting, or rescheduling / reassigning these events. 

Reset Counter Checkbox: A checkbox indicator that tells the system to set the Number of New Docs 
Filed value to zero. This counter increments for each document that is filed on the case. 

Resource Name: This field displays the name of the resource associated with the resource type. 

Resource Position: A selection to indicate the type of resource or court role held by a person/entity on a 
case. 

Resource Type: Resource types include: Judicial Officer, Department, Arbitrator, Mediator, Court 
Appointed Attorney, Probate Referee, Counsel for Incarcerated Person, Guardian Ad Litem, 
Settlement Attorney, and Guardianship for Counsel as Parent. 
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Retire Reason: An open text field available for providing a description of why a case number instance is 
to be retired. 

ROA Entries Checkbox: A checkbox indicator that filters and displays only ROA entries in the list. 

ROA Number: The system number used to identify an ROA entry. This number will only exist for those 
entries which are viewable on the ROA. 

Role: The role the person/entity has as a participant on a case. Examples include: Plaintiff, Defendant, 
etc. 

Role Assignment Checkbox: Checkbox that identifies if the selected user has (checked) or does not 
have (unchecked) the selected role. 

Rotational: The assignment of resources by rotating through a list of available resources of the 
appropriate type. Either a rotational or random method of selection must be chosen. 

Rule: Rules can be configured for the assignment of resources, such as Judicial Officers, Departments, 
and Arbitrators. The system provides the ability to specify the case category, case type, location, 
assignment method and distribution. 

S 
Sales Tax: The total sales tax due for the payment transaction and is required for tangible goods sold by 

the court. 

Sanction Type: Examples include Discovery and Conduct. 

Schedule Event Checkbox: A checkbox indicator that causes an expired clock to schedule an event on 
the court calendar. 

Schedule/Reserve Calendar Event Checkbox: A checkbox indicator or action that marks the 
Schedule/Reserve Calendar Event screen as being triggered to display once this entry is 
recorded. 

Scheduling Note: An open text field available for providing relevant notes or comments about events 
scheduled for the case. 

Scheduling Options: This field is used to select the desired scheduling option - "Scheduled" or 
"Reserved".  Based on the selection, the event status will be updated accordingly. 

Secondary Sort: A field to enter the second sort criteria that will be used when executing a search and 
viewing the results. 

Secure Checkbox: A checkbox indicator that marks the selected address/phone number as secured only 
within the context of this case. This field is only viewable within the context of a case. 

Security Level: The security level you wish to assign to a system component. The security level will 
determine which system users will be able to access the document once it is linked with data 
within the system. Security levels may be set between 1 and 9. 

Sender: Identifies the origin of the e-mail, usually the formal name of the court (Los Angeles Superior 
Court). 

Sequence Number: An field for entering the new sequence number for the entry. This must be a positive 
whole number. (same as Calendar Number) 

Session Date: The date the cashier session was opened. 

Session Status: The status of the cashier session (i.e., Open, Closed, Balanced, Unbalanced). 

Short Entry: The short version of the standard, static text that the system uses to describe this 
associated ROA entry. 
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Short List: A list of proposed arbitrator or mediator names based on the configured rules. This field is 
blank if the court has not configured assignment rules for arbitrators/mediators. This list does not 
contain arbitrators or mediators that were previously assigned or short-listed. 

Sounds Like Checkbox: A checkbox indicator that will display similar sounding results in the results list. 

Source: The external source referenced by a legacy case number. 

Special Appearance Checkbox: A checkbox, if is selected, indicates that the other party specified is 
specially appearing. Note: This individual will not be associated to the list of participants on the 
case in participant management and doesn't indicate legal jurisdiction on the case 

Special Handling: Additional special handling instructions for the exhibit.   

Special Needs: An open text field available for describing what special needs this person/entity is 
requesting under the ADA. 

Specific Department: This field is used to indicate the specific department of the court location on which 
to add the scheduling rule or in which the event type is heard. 

Stage: The status of a case at a particular point in time, including Active, Dismissal, Answered, Before 
Trial, After Court Trial. 

Start Date: The start date specified for a system event or component. 

Starting Amount: The amount of cash-on-hand given to the Accounting Clerk/Cashier by the Accounting 
Supervisor to place in the cash drawer. This money will be used to give customer’s change when 
recording payment transactions. The starting amount will also be used when determining the total 
monies collected during the cashiering session to balance against the System totals for each 
payment method. 

Strike Checkbox: A checkbox indicator that marks the entry as being stricken from the case. An entry 
can be marked as stricken or entered in error, but cannot be deleted for security purposes. 

Sub-type of Disposition: A further classification of disposition entered on a case. While a disposition 
may be entered as 'Dismissal', the disposition sub-type provides more information, such as 
'Before Jury Trial - Entry of Court Order Dismissal'. Disposition sub-types are used 

Sub Type of Judgment: A further classification of disposition entered on a case. While a disposition may 
be entered as 'Judgment', the disposition sub-type provides more information, such as 'Summary 
Judgment'. Disposition sub-types are used for JBSIS tracking. 

Submitted on Tentative Checkbox: A check box, if selected, indicates that the parties have submitted to 
the tentative ruling for the scheduled event. 

Suggested Number of Days to Complete Task: This field is used to specify the suggested number of 
days in which a work queue task should be completed. 

System Amount: The total of what was posted in the system for each payment method or non-monetary 
transactions. 

T 
Table Description: A brief description that describes in summary the functional purpose of the values 

within the selected reference table. 

Table Name: The name of the reference table you want to add an additional reference table value to. 

Taken Off Calendar: One possible action that may be entered on a petition. Taking a petition off 
calendar means that the event associated to the petition will be taken of calendar and not heard. 

Task Status: This field displays the status of the work queue task, including Pending, In Progress, 
Incomplete or Complete. 
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Temporary Judge Indicator: A yes/no indicator that shows whether the attorney can perform as a temp 
judge. 

Tertiary Sort: A field to enter the third sort criteria that will be used when executing a search and viewing 
the results. 

Text Translation: A brief description for a minute code.  If pre-configured, the minute text is displayed on 
the minutes  form when generated. 

Time Block: A duration of time in which a resource is unavailable for scheduling. 

Time Left: The amount of remaining idle time, in terms of seconds, that a user has before the system 
automatically logs them out. 

To Do List: A list of work queue items where you have specifically been assigned a task. This list may 
differ by Judicial Officer, and what activities are assigned to you. Selecting an item from the 'To 
Do' list navigates you to the tasks associated to that 'To Do' l 

Total Merge of Selected Cases Checkbox: A checkbox indicator that permanently consolidates the 
cases in the list upon selecting the Consolidate button. 

Track: The name of the track assigned to the case, containing milestones to be met. 

Transaction Date: The date when the transaction was entered/recorded into the system. 

Transaction Number: A unique identifier for a payment transaction that represents payment for one or 
more fees. 

Transaction Type: A classification given to a transaction that occurs on a trust, including receipts, voids, 
disbursements. 

Triggering Action: An action that triggers a system response. Examples include recording minutes, 
scheduling an event, initiating a case, etc. 

Trust Number: A numeric system identifier used to identify an established trust. 

Trust Status: An indicator of where a trust is in its life-cycle. Trusts can be disbursed, escheated, active, 
etc. 

Trust Type: A classification given to trusts that share similar characteristics. Examples include Draw-
down Accounts, Jury Fee Deposit, Court Deposit, etc. 

Type of Days: A selection to indicate what category of days either a clock or scheduling rule counts 
before expiring. These may be calendar or court days. 

Type of Disposition: A classification of disposition entered on a case. Dispositions fall into broad 
categorizations for judgments and dismissals and are used for JBSIS tracking purposes as well. 

U 
Unavailable End Date: The last day that a resource is unavailable. 

Unavailable Start Date: The first day that a resource becomes unavailable. 

Unit of Work: The category that describes the type of work queue task. Examples include Case, Event, 
Fee, Payment, Filing, Forms, E-Filing, Participant and Bail Bonds. 

Use as Default at Case Initiation Checkbox: A checkbox indicator that allows the system to 
automatically assign a track to the selected case category/case type(s) combination. Only one 
track per case category/case type combination may be selected as the default. 

Use as Primary Case Number Checkbox: A checkbox indicator that marks a legacy case number as 
the primary number used throughout the system. 
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User's Signature File: A field available for selecting the electronic signature file to be attached to the 
necessary court filings in place of the Judicial Officer's handwritten signature. 

User ID: Identifies the system user ID of the person logged in to the system. 

V 
Valuable Items: A yes/no indicator as to whether the exhibit is of value. 

Variance Amount: An overage or shortage for each payment method (Drawer Amount - System Amount 
= Variance). Hidden for a cashier until the Drawer Amount is frozen after a number of attempts. 

Variance Amount Subtotal: The variance between system and drawer totals. 

Verdict Name: A name provided by a Judicial Officer or Courtroom Clerk for a verdict entered on a Jury 
Trial event. 

View By Department - Division: This field is used to specify the division of the court location on which to 
view the calendar events and resource allocation rules. 

View By Department - Location: This field is used to specify the court name (or physical location of 
where a court performs business) on which to view the calendar events and resource allocation 
rules. 

View by JO/Mediator/ Temp. Judge: This field is used to specify the name of the resource on which to 
view the calendar events and resource allocation rules. 

View Case Participants Checkbox: A checkbox indicator that marks the Case Participants screen as 
being triggered to display once this entry is recorded. 

Viewed: Whether or not the court documentation (e.g. probate notes for Probate cases, tentative rulings 
for Civil cases or the case summary for Small Claims cases) has been viewed prior or during the 
hearing. 

Volume Number: A display field for the new case file volume.  This is populated based on the previous 
case file number. 

Volume Start Date: The date when the first files/documents were stored in the physical case file. 

W 
Warrant Held Until: The date that warrant should be held until. 

Warrant Issued Against: The person whom the warrant is issued against. 

Warrant Status: The status of the warrant being issued. Examples include: Vacated/Rescinded, 
Returned with Service, Returned without Service, Recalled, and Quashed. 

Work Queue Completion Type: This field is used to specify the method of completing tasks in the work 
queue. Work queues utilize either automatic or manual task completion. 

Worker/ Supervisor: The user's work queue role. That is, it identifies if the user has worker-related 
privileges or supervisor-related privileges for the specified work queue. 

Writ Requested Against:  Displays the list of the Judgment Debtors on the selected judgment 
award(s).Displays the list of the people affected by a selected judgment award(s) or an ordered 
sanction. 

Write Case History Entry Checkbox: A checkbox indicator that marks an entry as appearing on the 
Case History. 
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